Copyright © 2005, 2010 Oracle and/or its affiliates. All rights reserved.

The Programs (which include both the software and documentation) contain proprietary information; they are provided under a license agreement containing restrictions on use and disclosure and are also protected by copyright, patent, and other intellectual and industrial property laws. Reverse engineering, disassembly, or decompilation of the Programs, except to the extent required to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems in the documentation, please report them to us in writing. This document is not warranted to be error-free. Except as may be expressly permitted in your license agreement for these Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose.

If the Programs are delivered to the United States Government or anyone licensing or using the Programs on behalf of the United States Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS
Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the Programs, including documentation and technical data, shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement, and, to the extent applicable, the additional rights set forth in FAR 52.227-19, Commercial Computer Software--Restricted Rights (June 1987). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently dangerous applications. It shall be the licensee’s responsibility to take all appropriate fail-safe, backup, redundancy and other measures to ensure the safe use of such applications if the Programs are used for such purposes, and we disclaim liability for any damages caused by such use of the Programs.

The Programs may provide links to Web sites and access to content, products, and services from third parties. Oracle is not responsible for the availability of, or any content provided on, third-party Web sites. You bear all risks associated with the use of such content. If you choose to purchase any products or services from a third party, the relationship is directly between you and the third party. Oracle is not responsible for: (a) the quality of third-party products or services; or (b) fulfilling any of the terms of the agreement with the third party, including delivery of products or services and warranty obligations related to purchased products or services. Oracle is not responsible for any loss or damage of any sort that you may incur from dealing with any third party.

Oracle, JD Edwards, and PeopleSoft are registered trademarks of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.
Contents

Chapter 1: What’s New in This Release

Chapter 2: Overview of Life Sciences
About Siebel Pharma 25
About Siebel Medical 26
About Siebel Clinical 28
Product Modules and Options 29
Business Functions of Screen Tabs in Siebel Life Sciences 29

Chapter 3: Getting Started with Life Sciences
About Getting Started with Life Sciences 35
Administrative Setup Tasks for Life Sciences 36
About the My Team’s Filter 41
Using Assignment Manager in Siebel Life Sciences 41
Predefined Assignment Objects 42
Contact Assignments in Siebel Life Sciences 43
Contact Denormalization Mode in Siebel Life Sciences 43
Setting Up Mobile Web Clients for Position Rollup 44

Chapter 4: Managing Contacts in Life Sciences
About Managing Contacts in Life Sciences 47
Scenario for Managing Contacts 47
Process of Managing Contacts 48
Setting Up Primary Specialties 48
Removing Contact Records 49
Administering Bricks 50
Creating a Contact (End User) 52
Specifying the Best Time to Call (End User) 54
Indicating Affiliations Between Contacts (End User) 55
Contents

Indicating Affiliations Between a Contact and an Account 55
Viewing Pre-Call Information (End User) 56
Tracking Documentation Associated with a Contact (End User) 58
Other Tasks for Managing Contacts 59

Chapter 5: Administering and Managing Accounts in Life Sciences

About Administering and Managing Accounts in Life Sciences 61
About Account Hierarchies 62
About Bricks 62
Scenario for Accounts 63
Process of Managing Accounts 63
Specifying a Competitor 64
Deleting an Account 64
Generating Account Hierarchies 65
Associating a Brick with an Account Address 67
Entering an Account (End User) 67
Specifying an Account Profile (End User) 68
Viewing Account Hierarchies in Roll-up Views (End User) 69
Creating Category Information for an Account (End User) 71
Indicating an Affiliation Between an Account and a Contact (End User) 71
Indicating Affiliations Between Accounts (End User) 72
Creating Subaccounts (End User) 73
Viewing Pre-Call Information (End User) 75
Viewing Departments and Contacts (End User) 75
Tracking Documentation Associated with Accounts (End User) 76
About Configuring the Generate Hierarchy Button 77

Chapter 6: Managing Products for Life Sciences

About Managing Products for Life Sciences 79
How Siebel Life Sciences Stores Product Information 80
Scenario for Managing Products 80
Process of Managing Products  81
Defining External Products  81
Defining Internal Products  82
Specifying Additional Product Information  90
Defining Price Lists  91
Managing Competitor Information  93
Defining Decision Issues  94
Adding Products to Catalogs  95
  Creating the Product Catalog  96
  Creating a Product Category  96
  Adding Products to Catalogs and Categories  97
  Adding Access Groups to Catalogs and Categories  97
Capturing Product Hierarchies for Medical Handheld  98
Viewing Product Information (End User)  99
Creating a Product Change Request (End User)  99
Configuring Lot Numbers for Other Products  100

Chapter 7: Planning Calls in Pharma
About Planning Calls in Pharma  101
Tools for Planning Calls  102
Scenario 1: Users Set Up Personal Lists  103
Scenario 2: Users Create Target Lists  103
Scenario 3: Users Define Route Plans  104
Scenario 4: Users Create Activities  105
Process of Planning Calls  106
Creating a Personal List (End User)  106
Creating and Applying Target Lists (End User)  107
About Defining a Route Plan (End User)  108
Creating a Route (End User)  109
Adding Accounts to a Route (End User)  110
Using a Route to Schedule Calls (End User)  112
About Creating Activities  112
Creating a General Activity (End User)  113
Contents

Creating a General Activity in the Calendar (End User) 114
Setting Up a Meeting (End User) 115
Creating a Contact Call (End User) 117
Creating an Account Call (End User) 119
About Features for Call Planning Specific to the Japanese Pharmaceutical Market 122
  Visit Timeline During the PMS Period 123
Managing the PMS and Pre-Explain PMS Features 123
  Enabling a Product for PMS 124
  Scheduling Calls for Pre-Explain PMS 124
  Scheduling Calls for PMS 124
  Viewing or Editing PMS Account Products 125
  Viewing Upcoming Pre-Explain PMS and PMS Calls for All Accounts 125
  Viewing All Missed Calls for Account Contacts 125
  Viewing All Account and Contact Level Attachments for a PMS Call 126
Managing the PID Feature 126
  Creating a Package Insert 126
  Scheduling a Call for PID 127
  Viewing All Upcoming PID Calls for All Accounts 127

Chapter 8: Managing Pharma Samples
About Managing Pharma Samples 129
About Samples Transactions 130
About Samples and Lot Numbers 132
About Scenarios for Managing Samples 133
Scenario 1: Administrator Establishes a Master Inventory 134
Scenario 2: Administrator and End Users Establish a Master Inventory 135
Scenario 3: Users Transfer Samples to One Another 137
Prerequisites for Managing Samples 137
About Samples Transactions 137
Defining Lot Numbers for Samples 138
Establishing an Initial Inventory 141
Managing Inventory Tracking and Reconciliation Without Lot Numbers 143
Creating a Samples Transfer 145
Monitoring Samples Activities 147
Adjusting a Past Samples Transaction 149
Checking Electronic Signatures 151
About Establishing an Initial Inventory Count (End User) 152
Creating a Samples Order (End User) 153
Acknowledging Receipt of a Samples Transfer (End User) 154
Adjusting an Inventory Count (End User) 155
Recording Thefts and Losses (End User) 155
Reconciling an Inventory Period (End User) 155

Chapter 9: Recording Calls in Pharma
About Recording Calls in Pharma 161
About the Submit Button 161
About Electronic Signature Capture 165
Scenario for Recording Calls 166
Process of Recording Calls 167
(Optional) Recording Marketing Responses in Contact Calls 167
Recording and Submitting Contact Calls 168
Recording a Contact Call for a Different Contact at the Time of Signature Capture 170
Recording and Submitting Account Calls 172
Remaking Electronic Signatures 174
Configuring the Submit Button 175
Configuring the Sign Button 176
Marking Package Insert Delivery and Post Market Surveillance Calls as Complete 182
  Marking a PID Call as Complete 182
  Marking a PMS Call as Complete 183

Chapter 10: Creating Smart Calls
About Creating Smart Calls 185
Scenario for Smart Calls 185
Administering Smart Calls 187
Creating a Smart Call (End User) 189
About Applying a Smart Call Template to a Call  190

Chapter 11: Managing Managed Care Accounts
About Managed Care in Siebel Life Sciences  193
Scenario for Managed Care  196
Process of Using Siebel Managed Care  196
Entering Health Plan and Formulary Information  197
Associating Contact Information with Health Plans  199
Creating a Business Plan for a Managed Care Organization  200
Entering Formulary Information for Managed Care Business Plans  201
Performing Business and SWOT Analysis for a Managed-Care Business Plan  202
Associating Contacts and Accounts with Managed-Care Business Plans  203
Setting Objectives for the Managed-Care Business Plan  204

Chapter 12: Managing Accounts Contacts in Life Sciences
About Japanese Pharmaceutical Market Features for Accounts Contacts  205
About Accounts Contacts  206
Configuring Workflows for Accounts Contacts  207
  Activating Workflows for Accounts Contacts  207
  Enabling Server Components for Accounts Contacts  207
Managing Accounts Contacts  208
  Loading and Distributing Accounts Contacts Targeting Data  208
  Creating a New Targeting Period  209
  Creating Accounts Contacts Targeting Product Data  210
  Generating Column Maps for Display of Product Attribute Fields  211
  Activating the New Accounts Contacts Targeting Data  212
  Creating Account-Contact Target List Records Manually  213
Creating Accounts Contacts Call Detail Records  213
Planning Calls in the Weekly Call Planning Screen (End User)  214
Reporting a Call in the Weekly Call Planning Screen  216
Deleting Multiple Calls in the Accounts Contacts Call Planning Screen  216
Switching to Reporting Mode in the Accounts Contacts Call Planning Screen  217
Displaying Calls Created by Other Representatives  217
Chapter 13: Analyzing Syndicated Data
About Analyzing Syndicated Data 219
Scenario for Analysis 219
Process of Analysis 220
Defining Payer and Plan Information 220
Importing Syndicated Data Files (End User) 221
Analyzing Brick-Level Syndicated Data (End User) 222
Working with Sales, Rx, and Call Data (End User) 223
Views in the Analysis Screen 224

Chapter 14: Tracking Time Off Territory
About Tracking Time Off Territory 227
Scenario for Time Off Territory 227
Process of Tracking Time Off Territory 228
Creating a Time Off Territory Record (End User) 228
Submitting a Time Off Territory Record (End User) 229
Viewing Time Off Territory Charts (End User) 229
Configuring Time Off Territory 230

Chapter 15: Managing MedEd Events
About Managing MedEd Events 231
MedEd Terminology 232
About MedEd Event Types 232
Scenario for MedEd Events 233
Process of Managing MedEd Events 233
Establishing Funds for MedEd Plans 234
Creating Master MedEd Plans 236
Creating a MedEd Activity Template 237
MedEd Lists of Values 238
Administering MedEd Literature 239
Designating MedEd Event Speakers 240
Setting Up a MedEd Plan (End User) 240
Setting Up MedEd Events (End User) 242
Tracking Costs of MedEd Activities (End User) 244
About Designating MedEd Event Speakers (End User) 246
Setting Up Sessions Within a MedEd Event (End User) 246
Inviting and Registering Prospective MedEd Attendees (End User) 249
Generating Correspondence for MedEd Event Invitees (End User) 250
Scheduling Calls to an Invitee (End User) 250

Chapter 16: Setting and Achieving Objectives
About Setting and Achieving Objectives 253
Scenario for Objectives 254
Process of Objectives 254
Creating an Objective 255
Creating Recommended Activities for an Objective 256
Targeting Accounts to an Objective 258
Loading Actual Amount Fields Using EIM 258
Reviewing Objectives (End User) 258
Charting Objectives 259

Chapter 17: Importing Data into Life Sciences
Scenario for Importing Data 262
Process of Importing Data 262
Importing Data with Siebel EIM 262
Importing, Extracting, and Routing Syndicated Data 269
About Summary Records 272
Extracting Data for Mobile Users 272
Troubleshooting Syndicated Data Loading 279
Views Requiring Syndicated Data Import 279
Data Loading Matrix for Syndicated Data 281
Importing Syndicated Data Files (End User) 284

Chapter 18: Setting Up and Carrying Out a Clinical Trial
About Setting Up and Carrying Out a Clinical Trial 285
Contents

Scenario for Clinical Trials  286
Process of Managing Clinical Trials  287
Creating a Clinical Program  288
Setting Up a Protocol  289
Tracking and Revising Team Assignment History  291
  Automatically Assign Team Members to a Protocol Using the Position Rolldown Button  291
  Remove Team Members from the Team of a Protocol  292
Creating and Revising Protocol Versions  292
Setting Up Regions  293
  Automatically Assign Team Members Using the Position Rollup and Rolldown Buttons  294
  Creating Region Assignment Team History  295
Defining a Subject Visit Template  295
Creating an Account and Contacts (End User)  298
Creating a Site (End User)  300
  Automatically Assign Team Members to a Site Using the Position Rollup Button  302
  Creating Site Assignment Team History  302
  Removing Team Members from the Team of a Site  303
Creating a Subject and Setting Up Visits and Visit Activities (End User)  303
Applying Protocol Amendments (End User)  307
  Rules for Applying Protocol Amendments  308
  Rules for Deleting Visits Deemed Non-applicable by Early Termination  309
About Subject Enrollment Information Roll-Up  310
Monitoring Subject Status and Enrollment Rates (End User)  311

Chapter 19: Managing Sites and Clinical Contacts
About Managing Sites and Clinical Contacts  313
Scenario for Managing Sites and Clinical Contacts  314
Process of Managing Site and Contact Information  315
Creating a Clinical Protocol Site Template  316
Creating Contact and Account Assessment Templates  316
Maintaining Contact and Account Information  317
Associating Contracts with a Site  317
Creating and Managing Site Visits  318
Creating and Updating Site, Contact, and Account Records (End User) 319
Capturing Different Types of Addresses for Each Site (End User) 320
Assigning Employees to the Site Team (End User) 320
Creating Site Activity Plans (End User) 321
Applying Protocol Site Activity Templates 322
Tracking and Adding Documents at Sites (End User) 323
Creating Documentation Tracking Activities 324
Creating CRF Tracking Activities 325
Tracking Case Report Forms (CRFs) 326
Creating Site Correspondence Activities 327
 Tracking Business Partner Correspondence 328
Adding Notes to a Site 329
Assessing Investigators and Hospitals or Other Contacts and Accounts (End User) 329

Chapter 20: Setting Up and Making Subject Activity Payments
About Setting Up and Making Subject Activity Payments 331
Scenario for Payments 332
Process of Setting Up and Making Payments 333
Setting Up Standard Payment Amounts in the Subject Visit Template 333
Setting Payment Exceptions for a Site (End User) 334
Marking Subject Activities Completed (End User) 335
Generating Ad Hoc Payments for Sites (End User) 335
Adjusting Payment Amounts and Generating Payments for Sites 336
Generating Final Payments for Sites (End User) 337

Chapter 21: Administering and Using Clinical Trip Reports
About Administering and Using Clinical Trip Reports 339
Scenario for Managing Clinical Trip Reports 339
Process of Administering Clinical Trip Reports 340
Creating a Trip Report Template 341
Selecting a Trip Report Template Before a Site Visit (End User) 341
Completing a Trip Report After a Site Visit (End User) 343
Approving Trip Reports 345

Chapter 22: Managing Clinical Projects
About Managing Clinical Projects 347
Scenario for Managing Clinical Projects 347
Process of Managing Clinical Projects 348
Creating a Project Activity Template 349
About Setting Up Employee Profiles 349
Setting Up Position Types and Rate Lists for Billing 350
Creating a Project (End User) 351
Associating People and Accounts with Projects (End User) 351
Creating Activities and Tasks for a Project (End User) 353
Monitoring Project Costs (End User) 354
Managing Risk (End User) 354
About Views in the Projects Screen 355

Chapter 23: Capturing Adverse Events and Complaints
About Adverse Events and Complaints Management 357
About Capturing Adverse Events and Complaints 360
Scenario for Capturing and Escalating Adverse Events and Complaints 362
Process of Capturing and Escalating Adverse Events and Complaints 363
Confirming Standard Setup for Service Requests 364
Setting Up Codes 365
Setting Up Lot Numbers for Medical Products 369
Capturing Adverse Events and Complaints as Service Requests (End User) 369
Escalating Adverse Events and Complaints as Product Issues (End User) 371
Adding Complaint-Specific Information to Product Issues (End User) 372
About Configuring Adverse Events and Complaints Capture 373

Chapter 24: Investigating Adverse Events and Complaints
About Investigating Adverse Events and Complaints 375
Scenario for Complaint Investigation 376
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process of Adverse Events and Complaints Investigation</td>
<td>377</td>
</tr>
<tr>
<td>Creating Product Issue Assessment Templates</td>
<td>377</td>
</tr>
<tr>
<td>Creating Product Issue Activity Templates</td>
<td>377</td>
</tr>
<tr>
<td>Reviewing and Editing the Product Issues (End User)</td>
<td>378</td>
</tr>
<tr>
<td>Creating Multiple Product Issues Related to One Service Request (End User)</td>
<td>383</td>
</tr>
<tr>
<td>Creating Product Issue Activity Plans (End User)</td>
<td>384</td>
</tr>
<tr>
<td>Assessing if a Product Issue Is Reportable (End User)</td>
<td>385</td>
</tr>
<tr>
<td>Completing Adverse Events and Complaints Reviews (End User)</td>
<td>385</td>
</tr>
<tr>
<td>About Configuring Create Related PI and Review Complete Buttons</td>
<td>386</td>
</tr>
<tr>
<td>LS Medical Product Issue Create Related PI Workflow</td>
<td>386</td>
</tr>
<tr>
<td>Changing Which Fields Are Copied to the New Product Issue</td>
<td>387</td>
</tr>
<tr>
<td>LS Medical Product Issue Review Complete Workflow</td>
<td>387</td>
</tr>
<tr>
<td>LS Medical User Verification Workflow</td>
<td>388</td>
</tr>
<tr>
<td>About the LS Medical Product Issue Service Business Service</td>
<td>389</td>
</tr>
</tbody>
</table>

### Chapter 25: Recording Product Analysis for AECM

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Recording Product Analysis for AECM</td>
<td>391</td>
</tr>
<tr>
<td>Scenario for Product Analysis Arising from a Complaint</td>
<td>392</td>
</tr>
<tr>
<td>Process of Product Analysis Following a Product Issue</td>
<td>393</td>
</tr>
<tr>
<td>Creating Product Analysis Activity Templates</td>
<td>393</td>
</tr>
<tr>
<td>Setting Up Codes for Product Analysis</td>
<td>394</td>
</tr>
<tr>
<td>Creating Product Analysis Records from a Product Issue (End User)</td>
<td>394</td>
</tr>
<tr>
<td>Filling in Product Analysis Records (End User)</td>
<td>395</td>
</tr>
<tr>
<td>Completing Product Analysis and Creating CAPAs (End User)</td>
<td>395</td>
</tr>
<tr>
<td>Submitting Product Analysis Records (End User)</td>
<td>396</td>
</tr>
<tr>
<td>Approving or Rejecting Product Analysis Records (End User)</td>
<td>397</td>
</tr>
<tr>
<td>About Configuring Product Analysis Approvals</td>
<td>398</td>
</tr>
<tr>
<td>LS Medical PA Submit Workflow</td>
<td>398</td>
</tr>
<tr>
<td>LS Medical PA Withdraw Workflow</td>
<td>399</td>
</tr>
</tbody>
</table>

### Chapter 26: Managing CAPAs

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About Managing CAPAs</td>
<td>401</td>
</tr>
<tr>
<td>Scenario for Managing CAPAs</td>
<td>402</td>
</tr>
<tr>
<td>Process of Managing CAPAs</td>
<td>403</td>
</tr>
</tbody>
</table>
Chapter 27: Regulatory Reporting

About Regulatory Reporting 409
About Regulatory Reports 410
Scenario for Regulatory Reporting 411
Process of Regulatory Reporting 412
Setting Up Report Numbers 412
Creating and Populating New Regulatory Reports (End User) 413
Entering and Reviewing Data for 3500A Reports (End User) 414
Entering and Reviewing Data for MDV Reports (End User) 421
Running 3500A and MDV Reports (End User) 422
Which Sections of the MedWatch 3500A Form Get Filled In? 423
Generating Regulatory Report Numbers and Submitting Reports (End User) 423
Reopening a Regulatory Report (End User) 424
Creating Supplemental or Follow-Up Regulatory Reports (End User) 425
Field Mapping for the MedWatch Report (Reference) 426
Field Mapping for the MDV Report (Reference) 432
About Configuring Buttons in Regulatory Reports 435
LS Medical Product Issue RR Submit Workflow 436
LS Medical Product Issue RR Reopen Workflow 438

Chapter 28: Closing Adverse Events and Complaints

About Closing Adverse Events and Complaints 439
Scenario for Closing Adverse Events and Complaints 440
Process of Closure for AECM 441
Closing Product Issues (End User) 441
Chapter 29: Communicating with Customers for AECM

About Communicating with Customers for AECM  447
Scenario for Customer Communication  447
Process of Customer Communication in AECM  448
Setting Up Proposals, Correspondence, and Presentations  449
Communicating about Product Issues Using Proposals (End User)  449
Communicating about Product Issues Using Correspondence (End User)  450
Communicating about Product Issues Using Presentations (End User)  450

Chapter 30: Using Personalized Content Delivery

About Personalized Content Delivery  453
Defining System Preferences for PCD  453
Managing Content for PCD  454
    PCD Support for Content File Formats  455
    Loading Content for PCD Usage  455
    Associating Attributes with PCD Content  457
    Adding Component Files to PCD Content  458
    Verifying PCD Content  459
    Providing Access to PCD Content  460
Working with Messaging Plans  460
    Creating and Editing Messaging Plans  461
    Updating Messaging Plans  462
    Releasing a Messaging Plan  464
    Providing Access to Messaging Plans  464
    Associating Help to Messaging Plans  465
    Revising Messaging Plans  465
    Associating a Messaging Plans with an Objective  466
    Associating a Messaging Plan with Contact Call Offers  467
Accessing and Delivering Messaging Plans 467
  Decompressing PCD Content 469
  Using Signature Control 469
Using the PCD Viewer 476

Appendix A: Configuring Siebel Life Sciences
Targeting Configuration 480
New Visit Type Configuration 481
Sequential Priority Configuration 482
Enabling Inventory Reconciliation Without Lot Numbers 482
Business Component User Properties 483
Configuring the Visit Generation Buttons 489
Editing the Labels of the LS Pharma HI Activity Calendar View Buttons 491
Special MedEd Classes—User Properties 491
Submitting Contact Details from Third-Party Applications 491
  Invoking the Submit Functionality from Third-Party Applications 492
Accounts Contacts Configuration 493
Configuring Personalized Content Delivery 493
  Setting System Preferences for PCD 494
  Availability of Messages in PCD Planner 495
  Availability of Messaging Plans in the PCD Viewer 496
  PCD Business Component Calculated Fields 497
Recommended Messaging Plans 500
Optimize Detailing Plan Method 501
Identifying Recommended Messaging Plans 503
Using Skins 504
  Modifying a Tooltip in the PCD Viewer 505
User Properties of the PCD Applets 506
User Properties of LS PCD Business Service 508
API for Using Multi-file Content 509
API for Recording Section Data 509

Appendix B: Configuring Data for Oracle Pharma Sales Analytics
Transactional Data Requirements 511
Configuring Product Hierarchies and Product Costs 512
Configuring Product Catalog and Category Hierarchies 513
Setting Up Sales Objectives 515
Entering Call Activity Data 516
Configuring Sales Territories for Pharma Sales Analytics 517
  Creating Primary Sales Force Hierarchies 518
  Creating Sales Territories 519
  Creating Alternate Sales Force Hierarchies 521
Creating Target Lists Using Oracle Business Intelligence 523
  About Target List Creator 523
  Creating a Siebel Target List Using Oracle Pharma Sales Disconnected Analytics Answers 525
  Configuring Oracle Pharma Sales Disconnected Analytics Integration with Siebel Pharma Mobile Web Client 526
  Using Target List Creator with Siebel Pharma Applications in Connected Mode 527

Index
What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. D

Table 1 lists changes in Version 8.0, Rev. D of the documentation to support release 8.0 of the software.

Table 1. What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. D

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Using Signature Control” on page 469</td>
<td>Added a new section about signature control. With signature control, users can capture signature samples to distribute to qualified contacts.</td>
</tr>
</tbody>
</table>


Table 2 lists changes in Version 8.0, Rev. C of the documentation to support release 8.0 of the software.

Table 2. What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. C

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About Features for Call Planning Specific to the Japanese Pharmaceutical Market” on page 122</td>
<td>Added a section that provides an overview about new features that address regulatory restrictions in the Japanese pharmaceutical market.</td>
</tr>
<tr>
<td>“Managing the PMS and Pre-Explain PMS Features” on page 123</td>
<td>Added a section about tasks specific to Post Market Surveillance (PMS) and Pre-Explain PMS features. With PMS users can create and track obligatory visits with hospital contacts before and after a new drug is launched.</td>
</tr>
<tr>
<td>“Managing the PID Feature” on page 126</td>
<td>Added a section about tasks specific to Product Insert Delivery (PID). With PID users can create and track obligatory visits with hospital contacts when a package insert for a drug is modified.</td>
</tr>
</tbody>
</table>
Table 2. What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. C

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Marking Package Insert Delivery and Post Market Surveillance Calls as Complete” on page 182</td>
<td>Added a section about marking PMS and PID calls as complete.</td>
</tr>
</tbody>
</table>
| Created several new topics in Chapter 12, “Managing Accounts Contacts in Life Sciences,” to address new features introduced for call planning specific to the Japanese pharmaceutical market. | Describes functionality that addresses the following tasks:  
  ■ Deleting Multiple Calls in the Accounts Contacts Call Planning Screen  
  ■ Switching to Reporting Mode in the Accounts Contacts Call Planning Screen  
  ■ Displaying Calls Created by Other Representatives |

Table 3 lists changes in Version 8.0, Rev. B of the documentation to support release 8.0 of the software.

Table 3. What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. B

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Using Personalized Content Delivery” on page 453</td>
<td>Added a chapter about how to use Personalized Content Delivery (PCD). PCD enables sales representatives to convey product messages to customers during face-to-face sales calls.</td>
</tr>
<tr>
<td>“Configuring Personalized Content Delivery” on page 493</td>
<td>Added a section about configuring PCD to Appendix A.</td>
</tr>
</tbody>
</table>

Table 4 lists changes in Version 8.0, Rev. A of the documentation to support release 8.0 of the software.

Table 4. What’s New in Siebel Life Sciences Guide, Version 8.0, Rev. A

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Regulatory Reporting” on page 409</td>
<td>Added new fields for reporting adverse events on Form 3500A so that it complies with the new FDA mandate.</td>
</tr>
</tbody>
</table>
### What’s New in This Release

#### Siebel Life Sciences Guide Version 8.0, Rev. D

Updated procedures about allocating event costs across team members and across product lines.

Updated references from Siebel Analytics products to reflect the current Oracle analytics product names in various places throughout the appendix.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Setting Up MedEd Events (End User)” on page 242</td>
<td>Updated procedures about allocating event costs across team members and across product lines.</td>
</tr>
<tr>
<td>Appendix B, &quot;Configuring Data for Oracle Pharma Sales Analytics&quot;</td>
<td>Updated references from Siebel Analytics products to reflect the current Oracle analytics product names in various places throughout the appendix.</td>
</tr>
</tbody>
</table>
### What’s New in Siebel Life Sciences Guide, Version 8.0

Table 5 lists changes in Version 8.0 of the documentation to support release 8.0 of the software.

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created new topic &quot;Viewing Departments and Contacts (End User)&quot; on page 75</td>
<td>Added topic about viewing departments and contacts.</td>
</tr>
<tr>
<td>Added support information to the topic &quot;About Electronic Signature Capture&quot; on page 165</td>
<td>Added information about support of Signature capture on tablet PCs using Windows XP on versions 7.7, 7.8, and 8.0.</td>
</tr>
</tbody>
</table>
| Created new Chapter 12, "Managing Accounts Contacts in Life Sciences" | Describes the functionality that addresses the following distinctive traits of the Japanese pharmaceutical market:  
  - Hospital-Physician relationships  
  - Hospital department support  
  - Hospital-Physician targeting information  
  - Weekly calendar with call-planning capabilities  
  - Contact call with account information |
| Added Accounts Contacts information to Chapter 17, "Importing Data into Life Sciences" | Added Accounts Contacts information to Data and Related Interface Tables.                                                                                                                                   |
| New functionality added to Chapter 18, "Setting Up and Carrying Out a Clinical Trial" | Added the following new topics:  
  - Setting Up a Protocol  
  - Tracking and Revising Team Assignment History  
  - Creating and Revising Protocol Versions  
  - Setting Up Regions  
  - Creating a Site (End User) |
| Added functionality to Chapter 19, "Managing Sites and Clinical Contacts" | Added the following new topics:  
  - Capturing Different Types of Addresses for Each Site (End User)  
  - Applying Protocol Site Activity Templates  
  - Creating CRF Tracking Activities  
  - Creating Site Correspondence Activities  
  - Adding Notes to a Site |
| Removed previous Chapter 22 Siebel Advanced Contracts | Moved this chapter to Siebel Field Service Guide.                                                                                                                                                    |
Table 5. What’s New in Siebel Life Sciences Guide, Version 8.0

<table>
<thead>
<tr>
<th>Topic</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added new topics to Appendix A, “Configuring Siebel Life Sciences”</td>
<td>Added the following new topics to Appendix A:</td>
</tr>
<tr>
<td></td>
<td>• Submitting Contact Details from Third-Party Applications</td>
</tr>
<tr>
<td></td>
<td>• Accounts Contacts Configuration</td>
</tr>
<tr>
<td>Created new Appendix B, “Configuring Data for Oracle Pharma Sales Analytics”</td>
<td>Describes how to enter application data in the transactional database, while meeting the requirements of the Siebel Pharma Relationship Management Warehouse (RMW).</td>
</tr>
</tbody>
</table>
The Siebel Life Sciences product from Oracle comprises Siebel Pharma, Siebel Medical, and Siebel Clinical. Siebel Life Sciences is the only integrated professional and investigator database that captures, tracks, and routes information to other parts of an organization, including the mobile sales force and customer service centers.

This chapter contains the following topics:

- “About Siebel Pharma” on page 25
- “About Siebel Medical” on page 26
- “About Siebel Clinical” on page 28
- “Product Modules and Options” on page 29
- “Business Functions of Screen Tabs in Siebel Life Sciences” on page 29

### About Siebel Pharma

Siebel Pharma is a suite of business applications specifically designed for the pharmaceutical industry. Siebel Life Sciences provides the industry’s only integrated solution that allows information captured through multiple channels to be shared between sales and marketing, clinical affairs, customer services and other parts of an organization.

Siebel Pharma provides:

- Flexible contact management, supporting a wide range of contact types, both prescribers and nonprescribers, including physicians, pharmacists, nurses, office staff, and business administrators
- Account management, supporting a wide range of account types, such as hospitals, pharmacies, health maintenance organizations (HMOs), clinics, wholesalers, and group purchasing organizations (GPOs)
- Advanced, specific querying and list generation, allowing product promotion to targeted accounts and health care professionals
- Activity management, tightly integrated with the Siebel Calendar, promoting streamlined call planning and call reporting
- Medical education event planning, aiding efficient planning and preparation for many types of medical education events by tracking speakers, invitees, meeting-related activities, and expenses
- Smart Calls, which are call report templates supporting true one-button call reporting
- Comprehensive analysis charts, presenting sales and prescription (Rx) trends by postal code, brick (retail sales analysis territory), territory, plan, and prescriber
Dedicated formulary-opportunity management, allowing focused product promotion and opportunity tracking

Sales effectiveness tools and methodologies, including Target Account Sales (TAS) and Enterprise Selling Process (ESP), to shorten the sales cycles and increase account revenue and production

Contract and pricing management, including contract creation, approval, execution, renewal, and contract-based pricing

Enterprise-wide product information for employees, allowing consistent, accurate, and up-to-date information sharing across sales teams and sales forces

Simplified sampling workflow for users and administrators, supporting shipments in or out, orders, inventory counts, adjustments, and reconciliation, as well as tracking by lot numbers

Support for a full customer service center that handles medical inquiries, adverse events, and other related issues

Handling of a large number of inbound telephone calls, faxes, email, and Internet correspondence for customer service, sales, and medical support

Support for outbound calling for telesales, telemarketing, and meeting planning

About Siebel Medical

Siebel Medical is a suite of business applications designed specifically for the medical products industry to increase revenue and profitability through strategic customer–partner relationship management, enhanced customer and partner productivity and reduced cost of process inefficiencies.

Siebel Medical provides:

Flexible contact management, supporting a wide range of contact types, including physicians, nurses, technicians, office staff, and business administrators

Account management, supporting a wide range of account types, such as hospitals, health maintenance organizations (HMOs), clinics, wholesalers, and group purchasing organizations (GPOs)

Support for creating and executing complex agreements, which helps make sure correct delivery of benefits and execution of penalties

Adverse Event and Complaints management to handle the complete life cycle of a complaint or adverse event, including generation of reports and follow-up reports for submission to regulatory agencies

Advanced, specific querying and list generation, allowing product promotion to targeted accounts and health care professionals

Activity management, integrated with the Siebel Calendar, promoting streamlined customer support and service

Medical education event planning, aiding planning and preparation for many types of medical education events by tracking speakers, invitees, meeting related activities, and expenses
Comprehensive analysis charts, presenting sales and product usage trend by account, postal code, territory, and plan

Opportunity management, allowing focused product promotion and opportunity tracking

Enterprise-wide product information for employees, allowing consistent, accurate, and up-to-date information sharing across sales teams, customer support, and field service

Simplified workflow to manage assets at customer site, supporting shipments in or out, orders, inventory counts, adjustments and reconciliation

Support for customer service centers that handle medical inquiries, service requests, and other related issues

Handling of a large number of inbound telephone calls, faxes, email, and Internet correspondence for customer service, sales, and medical support

Support for outbound calling for telesales, telemarketing, and meeting planning

Modeling of products and services that incorporates internal expertise, allowing sales representatives to configure and quote error-free customer solutions

Field-service functions that provide service center agents, warehouse staff, and field service engineers the tools to respond to service requests

Functionality to receive service calls, verify service agreements and entitlements, enter a service request, search for solutions, create activities for a service request, and assign and dispatch field service engineers

Detailed customer configuration, management of trunk inventory, tracking of parts consumption and logistics, management of inventory replenishment, and integration of return materials authorizations and service orders

Service details, including the required skills, tools, and parts for service activities

Management of preventive maintenance plans, and repair of defective parts

Tracking and analysis of service costs, preparation of invoices for service, and tracking of payments

Definition of asset characteristics and recording of readings from medical equipment (assets) in the field for preventive maintenance, billing, and service

Audit trail of activities

Single application to manage partner interactions through the entire partner life cycle, from recruitment, registration, profiling, certification, joint planning, and execution through measurement and analysis of partner performance

Sharing of opportunities, service requests, accounts, solutions, and other business information with partners in the same way as with employees

Processes and tools to work collaboratively with partners to develop plans to meet strategic goals; helps analyze partnership effectiveness, forecast revenue, manage market development funds, and analyze partner performance
About Siebel Clinical

Siebel Clinical allows pharmaceutical companies, biotechnology companies, and contract research organizations (CROs) to better manage the clinical trial process, maintain quality of clinical trials, and manage investigator relationships. It provides a comprehensive set of tools for clinical research associates (CRAs), clinical investigators, and site coordinators, including a personalized Internet portal to conduct study activities more efficiently.

Siebel Clinical includes:

- Personalized Internet portal to help site coordinators, clinical investigators, and CRAs better manage clinical trials over the Web
- Support for full clinical trial hierarchies of Subject-Site-Region-Protocol-Program
- Support for global trials running in multiple countries, multiple languages, and multiple currencies.
- Site management tools for CRAs, including a Site Calendar, trip reports, document tracking, and payment generation
- Investigator and site profiling
- Activity and calendar management for CRAs and study sites
- Clinical trial status and management reports for study manager and clinical research associates
- Integrated payment tracking for sites and investigators
- Support for multiple contracts associated with a site
- Visit templates for study staff to better plan subject visits and promote protocol adherence
- Trip report templates for CRAs to facilitate compliance with good clinical practice (GCP)
- Project and resource management
- A flexible audit trail engine

Siebel Clinical was designed to allow pharmaceutical and biotech companies, clinical research organizations, and other clinical trial sponsors to:

- Deploy a Web-based clinical trial management system to internal and external users
- Make better decisions throughout the clinical trials process, leading to more efficient use of resources and faster time to market
- Increase productivity of CRAs and their managers by automating repetitive tasks and allowing real-time information sharing
- Create sustainable competitive advantage by allowing customers to provide breakthrough service to sites and investigators
- Provide a solution integrated with Siebel Pharma Sales and Siebel Pharma Service to allow customers to deploy one customer management system across the entire enterprise
Product Modules and Options

You can purchase many Siebel Business Applications modules and use them with Siebel Life Sciences. In addition, you can purchase the optional modules that are specific to Siebel Life Sciences to provide enhanced functionality for various business processes. For information about the optional modules to use with Siebel Life Sciences, contact your Oracle sales representative.

This guide documents Siebel Life Sciences with the optional modules installed. In addition, the Sample database includes data for optional modules. If your installation does not include some of these modules, your software interface will differ from that described in some sections of this guide.

The exact configuration of Siebel Life Sciences screens and views depends on your company’s configuration of the application. For introductory information on using the Siebel Life Sciences interface, see *Siebel Fundamentals, Online Help*, and Chapter 3, “Getting Started with Life Sciences.”

Business Functions of Screen Tabs in Siebel Life Sciences

The Siebel Life Sciences interface provides various task-specific screens and views for administrative and end-user functions.

**NOTE:** Most administrative tasks are performed from administration screens that are accessed from the Site Map. You cannot access these from the screen tabs.

Table 6 lists the most frequently used Siebel Life Sciences screens and the functions of the views in those screens.

Table 6. Siebel Life Sciences Screens

<table>
<thead>
<tr>
<th>Screen Tab</th>
<th>Functions</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Manage information about accounts (such as hospitals, HMOs, clinics, wholesalers, GPOs, and pharmacies) and affiliate accounts, contacts, and other information about a particular account.</td>
<td>Chapter 5, “Administering and Managing Accounts in Life Sciences,” in this guide</td>
</tr>
<tr>
<td>Accounts Contacts</td>
<td>Manage information about account-contact affiliations within dedicated Accounts Contacts List views, and also within an Accounts Contacts Weekly Call Planning screen. The Account-Contact records displayed in these screens are managed within the Siebel Pharma application as a set of separate Targeting records for each Sales Representative Position.</td>
<td>Chapter 12, “Managing Accounts Contacts in Life Sciences,” in this guide</td>
</tr>
<tr>
<td>Activities</td>
<td>Manage activities with contacts and accounts, and create contact and account calls (with or without Smart Calls).</td>
<td>Chapter 7, “Planning Calls in Pharma,” in this guide and <em>Siebel Applications Administration Guide</em></td>
</tr>
</tbody>
</table>
### Table 6. Siebel Life Sciences Screens

<table>
<thead>
<tr>
<th>Screen Tab</th>
<th>Functions</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agreements</td>
<td>Manage information about agreements, administrative contracts, and entitlements.</td>
<td><em>Siebel Field Service Guide</em></td>
</tr>
<tr>
<td>Analysis</td>
<td>Display prescriber, account, plan, payer, and territory-level sales and Rx data.</td>
<td><em>Chapter 13, “Analyzing Syndicated Data,” in this guide</em></td>
</tr>
<tr>
<td>Assets</td>
<td>Manage information about products sold to accounts.</td>
<td><em>Siebel Field Service Guide</em></td>
</tr>
<tr>
<td>Business Plans</td>
<td>Create business plans for MCO (Managed Care Organizations) and PBMs (Pharmacy Benefit Managers).</td>
<td><em>Chapter 11, “Managing Managed Care Accounts,” in this guide</em></td>
</tr>
<tr>
<td>Calendar</td>
<td>Create and display activities (including to-do activities) and share calendar information with coworkers.</td>
<td>*Chapter 7, “Planning Calls in Pharma,” in this guide and <em>Siebel Fundamentals</em></td>
</tr>
<tr>
<td>Campaigns</td>
<td>Manage outbound communications with prospects targeted for a particular marketing effort.</td>
<td><em>Siebel Marketing Installation and Administration Guide and Siebel Marketing User Guide</em></td>
</tr>
<tr>
<td>Clinical Programs</td>
<td>Manage information about clinical trial programs.</td>
<td><em>Chapter 18, “Setting Up and Carrying Out a Clinical Trial,” in this guide</em></td>
</tr>
<tr>
<td>Contacts</td>
<td>Manage information about health care professionals (such as formulary directors, hospital administrators, pharmacists, and physicians) and their affiliations with other contacts and accounts.</td>
<td><em>Chapter 4, “Managing Contacts in Life Sciences,” in this guide</em></td>
</tr>
<tr>
<td>Corrective Actions</td>
<td>Manage corrective actions for adverse events and complaints.</td>
<td>*Chapter 26, “Managing CAPAs,” in this guide.</td>
</tr>
<tr>
<td>Document Tracking</td>
<td>Track documents at multiple levels (Site, Region, or Protocol) for multiple entities (Contact or Account)</td>
<td>In this guide:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*Chapter 18, “Setting Up and Carrying Out a Clinical Trial”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*Chapter 19, “Managing Sites and Clinical Contacts”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*Chapter 5, “Administering and Managing Accounts in Life Sciences”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*Chapter 4, “Managing Contacts in Life Sciences”</td>
</tr>
<tr>
<td>Expense Reports</td>
<td>Manage expense report information for your expenses, or your team’s expenses.</td>
<td><em>Siebel Project and Resource Management Administration Guide</em></td>
</tr>
</tbody>
</table>
### Table 6. Siebel Life Sciences Screens

<table>
<thead>
<tr>
<th>Screen Tab</th>
<th>Functions</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forecasts</td>
<td>Create business forecasts based on opportunities or products.</td>
<td>Siebel Forecasting Guide</td>
</tr>
<tr>
<td>Home</td>
<td>The first screen you see when you log in to the Siebel Life Sciences application. It is a centralized screen that summarizes contacts, accounts, and activities.</td>
<td>Siebel Fundamentals</td>
</tr>
<tr>
<td>List</td>
<td>Perform queries on profile information (such as best times to call and market ranking), as well as sales and Rx data, in order to generate target lists of contacts or accounts.</td>
<td>Chapter 7, “Planning Calls in Pharma,” in this guide</td>
</tr>
<tr>
<td>Management</td>
<td>Display company- and industry-related literature cataloged by the Oracle administrator.</td>
<td>Siebel Applications Administration Guide</td>
</tr>
<tr>
<td>Objectives</td>
<td>Define objectives for contacts and accounts and monitor progress made toward meeting goals.</td>
<td>Chapter 16, “Setting and Achieving Objectives,” in this guide</td>
</tr>
<tr>
<td>Opportunities</td>
<td>Manage formulary opportunities and affiliate contacts, accounts, and other information with a particular opportunity.</td>
<td>Siebel Applications Administration Guide</td>
</tr>
<tr>
<td>Orders</td>
<td>Manage information about samples ordered by physicians through your company’s Web site, as well as all goods and service orders recorded by the service organization.</td>
<td>Siebel Order Management Guide</td>
</tr>
<tr>
<td>Payments</td>
<td>Keep track of payments pertaining to clinical trial activities at sites.</td>
<td>Chapter 20, “Setting Up and Making Subject Activity Payments,” in this guide</td>
</tr>
<tr>
<td>Products</td>
<td>Display current product information, including key features and product trends.</td>
<td>Chapter 6, “Managing Products for Life Sciences,” in this guide</td>
</tr>
</tbody>
</table>
### Table 6. Siebel Life Sciences Screens

<table>
<thead>
<tr>
<th>Screen Tab</th>
<th>Functions</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocols</td>
<td>Maintain information about clinical trial protocols.</td>
<td>Chapter 18, “Setting Up and Carrying Out a Clinical Trial,” in this guide</td>
</tr>
<tr>
<td>Quotes</td>
<td>Automatically generate quotes tailored to meet customer requirements.</td>
<td>Siebel Order Management Guide</td>
</tr>
<tr>
<td>Receiving</td>
<td>Record and review information relating to a physical receipt of material.</td>
<td>Siebel Field Service Guide</td>
</tr>
<tr>
<td>Regions</td>
<td>Manage region or country level information about clinical trial protocols.</td>
<td>Chapter 18, “Setting Up and Carrying Out a Clinical Trial,” in this guide</td>
</tr>
<tr>
<td>Regulatory Reports</td>
<td>Create Managing complaints made against medical products.</td>
<td>Chapter 27, “Regulatory Reporting,” in this guide</td>
</tr>
<tr>
<td>Repairs</td>
<td>Track defective products returned to a service center for repair.</td>
<td>Chapter 13, “Analyzing Syndicated Data,” in this guide and Siebel Field Service Guide</td>
</tr>
<tr>
<td>Routes</td>
<td>Create routes to schedule regular visits to groups of accounts.</td>
<td>Chapter 7, “Planning Calls in Pharma,” in this guide</td>
</tr>
<tr>
<td>Samples</td>
<td>Organize phases of samples workflow: shipments, orders, adjustments, inventory counts, and reconciliation.</td>
<td>Chapter 8, “Managing Pharma Samples,” in this guide</td>
</tr>
<tr>
<td>Service Requests</td>
<td>Manage requests for medical or product information, adverse events, complaints, and related activities and attachments.</td>
<td>Chapter 23, “Capturing Adverse Events and Complaints,” in this guide and Siebel Field Service Guide</td>
</tr>
<tr>
<td>Shipping</td>
<td>Record and review information relating to a physical shipment of material.</td>
<td>Siebel Field Service Guide</td>
</tr>
<tr>
<td>Site Management</td>
<td>Manage information about a particular clinical trial site, including associated contacts, subjects, activities, payments, and site visits.</td>
<td>Chapter 19, “Managing Sites and Clinical Contacts,” in this guide</td>
</tr>
<tr>
<td>Site Visits</td>
<td>Manage site visits to a clinical site, and also monitor follow-up activities associated with these visits.</td>
<td>Chapter 18, “Setting Up and Carrying Out a Clinical Trial”</td>
</tr>
<tr>
<td>Smart Calls</td>
<td>Create and edit Smart Call templates that are applied in the Contact Call Detail and Account Call Detail views.</td>
<td>Chapter 10, “Creating Smart Calls,” in this guide</td>
</tr>
</tbody>
</table>
Table 6. Siebel Life Sciences Screens

<table>
<thead>
<tr>
<th>Screen Tab</th>
<th>Functions</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartScripts</td>
<td>Define the application workflow for an interactive situation in a script. These interactive situations could include inbound communications (such as customer service) and outbound contacts (such as telemarketing).</td>
<td>Siebel SmartScript Administration Guide</td>
</tr>
<tr>
<td>Solutions</td>
<td>Enter and display resolutions successfully used for reported problems.</td>
<td>Siebel Field Service Guide</td>
</tr>
<tr>
<td>Subjects</td>
<td>Manage information about clinical trial subjects.</td>
<td>Chapter 18, “Setting Up and Carrying Out a Clinical Trial,” in this guide</td>
</tr>
<tr>
<td>Time Off Territory</td>
<td>Manage information about time when sales representatives and field personnel are out of their territories, not working on activities directly associated with accounts, contacts, or opportunities.</td>
<td>Chapter 14, “Tracking Time Off Territory,” in this guide</td>
</tr>
<tr>
<td>Time Sheets</td>
<td>Track employee time, by project, for compensation and billing purposes.</td>
<td>Siebel Project and Resource Management Administration Guide</td>
</tr>
</tbody>
</table>
Getting Started with Life Sciences

This chapter covers the following topics:

- “About Getting Started with Life Sciences” on page 35
- “Administrative Setup Tasks for Life Sciences” on page 36
- “About the My Team’s Filter” on page 41
- “Using Assignment Manager in Siebel Life Sciences” on page 41
- “Setting Up Mobile Web Clients for Position Rollup” on page 44

About Getting Started with Life Sciences

This chapter lists the applications administration tasks that are specific to Siebel Life Sciences. Use this chapter in combination with *Siebel Applications Administration Guide*, the main guide for performing administrative tasks.

*Siebel Applications Administration Guide* covers the setup tasks that are common to all Siebel Business Applications, such as using license keys, defining employees, and defining your company’s structure. It also provides the information you will need to implement, configure, and monitor the Sales, Service, and Marketing products and to perform Data Administration and Document Administration tasks.

Some tasks listed in this chapter might replace those in the administration guide whereas others might be additional tasks. Make sure you review Table 7 on page 36 before following the procedures in *Siebel Applications Administration Guide*.

This guide assumes that you have already installed Siebel Life Sciences or completed an upgrade from another Siebel application. If you have not, refer to the Installation/Upgrade section of the *Siebel Bookshelf* and click the links to the guides that are relevant to your company’s implementation.

**NOTE:** The Siebel Bookshelf is available on Oracle Technology Network (OTN) and Oracle E-Delivery. It might also be installed locally on your intranet or on a network location.

The Siebel database server installation script creates a Siebel administrator account that can be used to perform the tasks described in this guide. For information about this process, see the *Siebel Installation Guide* for the operating system you are using for the operating system you are using, and *Siebel System Administration Guide*.

**CAUTION:** Do not perform system administration functions on your local database. Although there is nothing to prevent you from doing this, it can have serious results, such as data conflicts, an overly large local database, or a large number of additional transactions to route.
Administrative Setup Tasks for Life Sciences

Table 7 lists the administrative setup procedures that are specific to Siebel Life Sciences and procedures that might differ from those of the other Siebel Business Applications. The table also directs you to documentation containing information about each task.

When setting up your application, use Table 7 in combination with the main resource, Siebel Applications Administration Guide.

Table 7. Siebel Life Sciences Administration Tasks

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define sales territories</td>
<td>■ Define sales territories and set up the territory assignment process</td>
<td>Siebel Assignment Manager Administration Guide and Siebel Territory Management Guide</td>
</tr>
<tr>
<td>Define medical specialties</td>
<td>■ Defining medical specialties</td>
<td>Chapter 4, &quot;Managing Contacts in Life Sciences&quot;</td>
</tr>
<tr>
<td></td>
<td>■ Defining account specialties</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Specifying a contact’s primary specialty</td>
<td></td>
</tr>
<tr>
<td>Set up bricks</td>
<td>■ Defining bricks</td>
<td>Chapter 4, &quot;Managing Contacts in Life Sciences&quot;</td>
</tr>
<tr>
<td></td>
<td>■ Associating a brick with a contact address</td>
<td></td>
</tr>
<tr>
<td>Define decision issues</td>
<td>■ Defining decision issues</td>
<td>Chapter 4, &quot;Managing Contacts in Life Sciences&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chapter 6, &quot;Managing Products for Life Sciences&quot;</td>
</tr>
</tbody>
</table>
### Table 7. Siebel Life Sciences Administration Tasks

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
</table>
| Managing Samples          | ■ Establishing and reconciling initial master inventory  
■ Transferring inventory to end users  
■ Monitoring samples activities (disbursements, orders, transfers between employees, user inventory counts, and inventory adjustments)  
■ Setting up and maintaining a home-office master inventory (optional)  
■ Defining lot numbers (optional)  
■ Managing electronic signatures  
■ Identifying sample locations in the event of recalls  
■ Determine the number of open (unreconciled) inventory periods allowed  
■ Disabling samples tracking by lot number  
■ Allowing sample product reconciliation without lot numbers (optional) | Chapter 8, “Managing Pharma Samples”  
Appendix A, “Configuring Siebel Life Sciences” |
| Specifying a Competitor   | ■ Deleting an account  
■ Creating or identifying a competitor                                                                                                                                                                     | Chapter 5, “Administering and Managing Accounts in Life Sciences”  
Chapter 4, “Managing Contacts in Life Sciences”  
Chapter 9, “Recording Calls in Pharma” |
| Administer Smart Calls    | ■ Creating a smart call template and making it available to end users                                                                                                                                         | Chapter 10, “Creating Smart Calls”  
Chapter 8, “Managing Pharma Samples” |
### Table 7. Siebel Life Sciences Administration Tasks

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
</table>
| Managing Accounts Contacts in Life Sciences              | - Activating workflows for accounts contacts  
- Enabling server components for accounts contacts  
- Setting up targeting data for a new period  
- Activating new targeting data  
- Generating column maps for accounts contacts list  
- Creating product data to display in accounts contacts list | Chapter 12, “Managing Accounts Contacts in Life Sciences”                                                                 |
| Configuring Time Off Territory                            | - Configuring Time Off Territory approval process                                                      | Chapter 14, “Tracking Time Off Territory”                                                                 |
| Administering MedEd                                       | - Setting up funds for medical education plans and associating them  
- Creating MedEd master plans  
- Creating MedEd activity templates  
- Customizing the list of available drop-down values and adding literature items to the application  
- Designating contacts as medical education speakers | Chapter 15, “Managing MedEd Events”  
Siebel Enterprise Integration Manager Administration Guide |
| Creating a Clinical Program                               | - Creating a protocol  
- Revising protocols  
- Setting up regions (Optional)  
- Defining a subject visit template | Chapter 18, “Setting Up and Carrying Out a Clinical Trial”  
Chapter 6, “Managing Products for Life Sciences”  
Chapter 19, “Managing Sites and Clinical Contacts” |
| Managing Sites                                           | - Creating a protocol site template  
- Creating contact and account templates  
- Maintaining contact and account information  
- Setting up site contracts | Chapter 19, “Managing Sites and Clinical Contacts”                                      |
Table 7. Siebel Life Sciences Administration Tasks

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
</table>
| Setting Up Standard Payments | ■ Setting up standard payment amounts in subject visit templates  
                  | ■ Adjusting payment amounts and generating payments for sites                | Chapter 20, “Setting Up and Making Subject Activity Payments”                       |
| Creating Trip Report Templates | ■ Creating trip report templates  
                  | ■ Approving trip report templates                                             | Chapter 21, “Administering and Using Clinical Trip Reports”                          |
| Creating Project Templates | ■ Creating project templates                                                 | Chapter 22, “Managing Clinical Projects”                                           |
| Importing Data            | ■ Importing data with EIM  
                  | ■ Importing, extracting, and routing syndicated data                          | Chapter 17, “Importing Data into Life Sciences”                                     |
|                           | ■ Charting denormalized syndicated data                                      | Appendix A, “Configuring Siebel Life Sciences”                                     |
| Administering products    | ■ Creating an external product  
                  | ■ Creating an internal product or a market                                     | Chapter 6, “Managing Products for Life Sciences”                                    |
|                           | ■ Making a product inactive                                                 |                                                                                    |
|                           | ■ Specifying additional product features                                     |                                                                                    |
|                           | ■ Entering information on related products                                   |                                                                                    |
|                           | ■ Associating related literature                                             |                                                                                    |
|                           | ■ Entering product comparison information                                    |                                                                                    |
|                           | ■ Creating a price list                                                     |                                                                                    |
|                           | ■ Associating a price list with a product                                   |                                                                                    |
|                           | ■ Decision issues or product issues                                         |                                                                                    |
### Table 7. Siebel Life Sciences Administration Tasks

<table>
<thead>
<tr>
<th>Administrative Task</th>
<th>Description</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Siebel Life Sciences</td>
<td>• Targeting&lt;br&gt;• New visit type&lt;br&gt;• Charting denormalized syndicated data&lt;br&gt;• Modifying business component user properties&lt;br&gt;• Configuring the visit generation buttons&lt;br&gt;• Changing read-only status of fields&lt;br&gt;• MedEd special C++ classes&lt;br&gt;• Submitting contact details from third-party applications</td>
<td>Appendix A, “Configuring Siebel Life Sciences”</td>
</tr>
<tr>
<td>Configuring Data for Oracle Pharma Sales Analytics</td>
<td>• Transactional data requirements&lt;br&gt;• Configuring product hierarchies and product costs&lt;br&gt;• Configuring Product Catalog and Category Hierarchies&lt;br&gt;• Setting Up Sales Objectives&lt;br&gt;• Entering call activity data&lt;br&gt;• Configuring sales territories for Oracle Pharma Sales Analytics&lt;br&gt;• Creating target lists using Oracle Business Intelligence</td>
<td>Appendix B, “Configuring Data for Oracle Pharma Sales Analytics”</td>
</tr>
<tr>
<td>Editing the epharma.cfg</td>
<td>If you are using Oracle Pharma Sales Disconnected Analytics, edit the epharma.cfg file to allow:&lt;br&gt;• Integration of Pharma Sales Analytics Home Page with Pharma Sales Disconnected Analytics&lt;br&gt;• Importation of target list contacts into Oracle Pharma Sales Disconnected Analytics Client</td>
<td>The Siebel Analytics Installation and Configuration Guide (Integrating Oracle BI Delivers with Oracle Business Intelligence Applications)</td>
</tr>
</tbody>
</table>
About the My Team’s Filter

The Show drop-down list is found on many screens. It provides a list of filters such as My Contacts, My Team’s Contacts, and All Contacts. These filters determine what records appear in the view.

The behavior of the My Team’s filter varies from screen to screen. In some screens, this filter displays those records where the primary member of the team reports to the user. In other screens, the filter displays records where any of the team members reports to the user.

This behavior is determined in the business component by the Manager List Mode user property.

If the Manager List Mode user property is active and set to Team, the My Team’s filter displays all records where the user’s subordinate is on the team but is not necessarily the primary member.

Table 8 lists the default setting of the Manager List Mode user property for some Siebel Life Sciences screens and business components.

Table 8. The Default Setting for the Manager List Mode Use Property

<table>
<thead>
<tr>
<th>Screen</th>
<th>Business Component</th>
<th>Manager List Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Accounts</td>
<td>Inactive</td>
</tr>
<tr>
<td>Contacts</td>
<td>Contact</td>
<td>Inactive</td>
</tr>
<tr>
<td>MedEd</td>
<td>Pharma ME Event Professional Invitee</td>
<td>Active</td>
</tr>
<tr>
<td>Objectives</td>
<td>Objective</td>
<td>Active</td>
</tr>
<tr>
<td>Protocols</td>
<td>Clinical Protocol</td>
<td>Active</td>
</tr>
<tr>
<td>Site Management</td>
<td>Clinical Protocol Site</td>
<td>Active</td>
</tr>
</tbody>
</table>

Using Assignment Manager in Siebel Life Sciences

Siebel Assignment Manager allows the Siebel administrator to automatically assign tasks to specific people. To do this, however, the Siebel administrator must first define assignment rules for each task. For more information on using and implementing Siebel Assignment Manager, see Siebel Assignment Manager Administration Guide. For additional information on creating territories and running territory realignments, see Siebel Territory Management Guide.

This topic provides Siebel Assignment Manager information that is specific to Siebel Life Sciences.
Predefined Assignment Objects

Some of the predefined assignment objects and underlying criteria described in *Siebel Assignment Manager Administration Guide* have been modified in Siebel Life Sciences to support pharmaceutical business processes. **Table 9** describes the assignment objects that are changed in Siebel Life Sciences.

**NOTE:** Assignment Item Type Industry Name is not supported. This assignment rule is defined for Siebel Business Applications and currently conflicts with Siebel Life Sciences assignment rules. Siebel Life Sciences uses the assignment item type Industry SIC Code.

<table>
<thead>
<tr>
<th>Assignment Object</th>
<th>Modifications</th>
</tr>
</thead>
</table>
| Account           | The assignment criteria SIC Code has been renamed Account Class of Trade.  
|                   | Its assignment criteria are:  
|                   | ■ Account City State Country  
|                   | ■ Account Brick  
|                   | Account Brick source table has been changed to S_CON_ADDR and source column has been changed to BRICK_ID. |
| Contact           | This assignment object was created specifically for Siebel Life Sciences and is not described in *Siebel Assignment Manager Administration Guide*. Its assignment criteria are:  
|                   | ■ Contact  
|                   | ■ Contact Medical Specialty Code  
|                   | ■ Contact Wildcard  
|                   | ■ Contact City  
|                   | ■ Contact State  
|                   | ■ Contact Country  
|                   | ■ Contact Zip Code  
|                   | ■ Contact City State Country  
|                   | ■ Contact Brick  
|                   | ■ Medical Specialty  
|                   | ■ Organization  
|                   | ■ Position |
| Opportunity       | Siebel Pharma includes the Product Line or Product Line Wildcard assignment criteria. |
Contact Assignments in Siebel Life Sciences

In most Siebel Business Applications, assignment of contacts is based on primary address. This process is different for Siebel Life Sciences. A Siebel Life Sciences contact may have multiple addresses, and each representative on the contact’s sales team may indicate a different primary address for the same contact. For this reason, do not base the assignment of contacts on the primary address.

For example, Representative A might indicate a hospital address as the primary address, while Representative B might indicate a private-office address as primary. In the All Contacts and My Team’s Contacts views, the primary address that appears is the one assigned by the primary team member. For more information, see “Predefined Assignment Objects” on page 42.

Contact Denormalization Mode in Siebel Life Sciences

Contact Denormalization mode in Siebel Life Sciences differs from the description in Siebel Assignment Manager Administration Guide in the following ways:

- It denormalizes positions from the account team table to the contact team table for all contacts directly affiliated with an account. Users can specify a direct affiliation between a contact and an account by selecting:
  - The Direct field in the Contacts, Account Affiliations view tab
  - The Direct field in the Accounts, Contact Affiliations view tab

For more information, see "Indicating an Affiliation Between an Account and a Contact (End User)" on page 71.

- It does not denormalize positions from the opportunity team table to the contact team table.

- It must be run after running batch mode jobs for contacts and accounts separately. Run three separate batch mode jobs in this order:
  - Contacts
  - Accounts
  - Contact Denormalization

Contact Denormalization in Siebel Life Sciences has the following additional important rules, requirements, and exceptions:

- **Running Contact Denormalization mode in Dynamic mode.** To enable the Contact Denormalization Policy, set the expiration date to a future date or leave it blank. Then generate the database triggers by running Generate Triggers.

- **Running Contact Denormalization mode in Batch mode.** Remember to specify the parameters:
  
  Object Name = Contact Denormalization
  Assignment Mode = Denorm
Contact Denormalization mode does not evaluate rules. Therefore, it is not necessary to create a Contact Denormalization rule-based object to run Assignment Manager in this mode. Also, because it does not evaluate rules, Contact Denormalization mode does not set the primary team position.

Contact Denormalization assigns contacts to employees who are on the Account Team for which the contacts are directly affiliated. In order to reduce the number of contact-to-position relationship (S_POSTN_CON) rows routed to the manager's local database, the value of the ASGN_DNRM_FLG field is set to "N". With this default setting, the contacts that team members have been assigned by the Contact Denormalization process will not be visible to managers on their local databases. However, if the desired behavior is for managers to see all contacts who are assigned to their team members, regardless the assignment method, set the ASGN_DNRM_ "Y".

Setting Up Mobile Web Clients for Position Rollup

In Siebel Clinical, a clinical research associate (CRA) can create sites and assign employees to positions at the site level. When the CRA clicks the position rollup button, these positions become visible at the region and protocol levels. Typically, the CRA works in a disconnected mode, on a laptop computer.

The administrator must set up each mobile Web client to allow position rollups. The setup requires the following steps in Siebel Clinical:

- The administrator exports workflow processes and data maps from the server database to XML files.
- The administrator connects to a local client, imports the XML files to the client database and activates the workflow processes on the local client.

**NOTE:** Users of the local client must have Workflow Process Definition, EAI DATA Map View, and EAI Data Map Editor in their user responsibilities to accept imported workflow processes and data maps.

To export the workflow processes to the local client

1. Export the Clinical Assign Position From Region and Clinical Assign Position From Site workflows to XML files.
2. Import the two XML files to the local client and activate the workflows.

For information about exporting and importing workflow processes, see *Siebel Business Process Framework: Workflow Guide*.

To export DTE data maps from the server database to an XML file

1. In Siebel Clinical, connect to the server database.
2. Navigate to the Administration - Integration screen > Data Maps view.
3 In the Integration Object Map list, query for Clinical*.
   The query returns four records—Clinical Region Position to Protocol Position Map, Clinical Site
   Position to Account Position Map, Clinical Site Position to Protocol Position Map, and Clinical Site
   Position to Region Position Map.

4 In the drop-down menu, select Export Data Map.

5 In the dialog box, check Export All Rows in Current Query and click Export.

6 In the dialog box, select Save to Disk, select a location, and save the data maps as
   PositionRollupDataMap.xml.

**To import DTE data maps to a local client from an XML file**

1 In Siebel Clinical, connect to the local client.

2 Navigate to the Administration - Integration screen > Data Maps view.

3 In the Integration Object Map list, select Import Data Map from the drop-down menu.

4 In the dialog box, select Browse and find PositionRollupDataMap.xml created in the second
   procedure in this topic, "To export DTE data maps from the server database to an XML file" on
   page 44.

5 In the Integration Object Map list, query for Clinical*.
   The query returns four records—Clinical Region Position to Protocol Position Map, Clinical Site
   Position to Account Position Map, Clinical Site Position to Protocol Position Map, and Clinical Site
   Position to Region Position Map.
Managing Contacts in Life Sciences

This chapter covers the following topics:

- "About Managing Contacts in Life Sciences" on page 47
- "Scenario for Managing Contacts" on page 47
- "Process of Managing Contacts" on page 48
- "Setting Up Primary Specialties" on page 48
- "Removing Contact Records" on page 49
- "Administering Bricks" on page 50
- "Creating a Contact (End User)" on page 52
- "Specifying the Best Time to Call (End User)" on page 54
- "Indicating Affiliations Between Contacts (End User)" on page 55
- "Indicating Affiliations Between a Contact and an Account" on page 55
- "Viewing Pre-Call Information (End User)" on page 56
- "Tracking Documentation Associated with a Contact (End User)" on page 58
- "Other Tasks for Managing Contacts" on page 59

About Managing Contacts in Life Sciences

In Siebel Life Sciences, a contact is typically a physician, nurse, or pharmacist or other medical professional. In a more general sense, a contact can be any individual a pharmaceutical company deems significant to their business process including a formulary director, contracts administrator, or medical education event speaker.

This chapter describes how to manage Siebel Life Sciences contact information. Using the procedures given in this chapter, you will be able to perform the administrator tasks of defining and specifying medical specialities, deleting a contact, defining bricks, and associating contacts to a brick. End users such as sales representatives and managed care account managers can use the Contacts view to create and track a variety of contact information, including contact affiliations, contact and account relationships, contact assessments, and the best times to call on a contact.

Scenario for Managing Contacts

This topic outlines an example process performed by a Siebel administrator and end users. Your company may follow a different process according to its business requirements.
A pharmaceutical company is reviewing the contact information in their database to make sure it is as current and up-to-date as possible. During this update process, the administrator deletes obsolete contacts and associates new contacts with existing bricks (geographic areas).

Sales representatives use Siebel Contacts to manually enter and modify contact information. They add information that helps them track relationships between contacts.

Sales representative can add more depth to contact data by creating user-defined fields called categories. Using categories, representatives can track private or shared information about a contact.

**Process of Managing Contacts**

This topic details sample tasks often performed by administrators and end-users when managing contacts. Your company may follow a different process according to its business requirements.

**Administrator Procedures**

The following list shows tasks administrators typically perform to manage contacts:

- "Setting Up Primary Specialties” on page 48. Define medical specialties within the system and specify a contact’s primary speciality.
- "Deleting a Contact” on page 50.
- "Administering Bricks” on page 50.
- "Associating a Contact with a Brick” on page 51.

**End-User Procedures**

The following list shows tasks end users typically perform when managing contacts:

- “Creating a Contact (End User)” on page 52.
- "Specifying the Best Time to Call (End User)” on page 54.
- "Indicating Affiliations Between Contacts (End User)” on page 55.
- “Indicating Affiliations Between a Contact and an Account” on page 55.
- "Viewing Pre-Call Information (End User)” on page 56.
- “Tracking Documentation Associated with a Contact (End User)” on page 58.
- "Other Tasks for Managing Contacts” on page 59. Enter contact category information and create contact assessments.

**Setting Up Primary Specialties**

As a Siebel administrator, you are responsible for defining and entering the primary specialty information about contacts.
The Primary Specialty field is read-only and can be edited only through EIM. The list of specialties is defined in the Primary Specialty view of the Application Administration view.

**NOTE:** The Primary Specialty field is different from the Rep Specialty field on the Contacts screen. To create additional values for the Rep Specialty field on the Contacts screen, follow the procedures on modifying a list of values in the *Siebel Applications Administration Guide*.

**To define a specialty**

1. Navigate to the Administration - Application screen > Specialty view.
   The Primary Specialty view appears.
2. In the Primary Specialty list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>The Specialty Short Code for the health care provider’s designated area of expertise. This is normally provided by the syndicated data provider (for example, AMA, IMS, or NDC).</td>
</tr>
<tr>
<td>Name</td>
<td>A full description of the health care provider's designated area of expertise.</td>
</tr>
</tbody>
</table>

**NOTE:** On initial data load, you can use EIM to load Primary Specialty data into the base table S_MED_SPEC. For more information on using EIM, see *Siebel Enterprise Integration Manager Administration Guide*.

**To specify specialties for Contacts**

- Specialties cannot be specified for contacts through the UI. Specialties are loaded into the MED_SPEC_ID field in the S_CONTACT table of the database using EIM.
- Alternatively, configure the Primary Specialty field so that it can be edited.

### Removing Contact Records

Three methods for removing contact records are described.

**Merging Contact Records**

If you find that two or more contact records contain the same information, merge the records into one in order to keep the database accurate. For more information on merging records, see *Siebel Fundamentals*.
Removing Employees from a Contact’s Team
As an alternative to deleting a contact, consider making the Siebel administrator the primary team member so that he or she can remove all other employees from the account’s team.

Deleting a Contact
Deleting a contact completely removes the contact from the system. Be aware that deleting a contact could have undesired consequences.

NOTE: If a Contact record is deleted from the Data Administration, Contacts view, any records for that contact in the Signature Audit Administration view display with blank Last Name, First Name, and Reference # fields. To avoid this problem, you might need to enforce a business rule that prevents the delete record function from operating in the Data Administration, Contacts view.

If you are certain that the contact is no longer active, use the following procedure to delete it.

To delete a contact
1. Navigate to the Contacts screen > Contact Administration view. The Contact Administration view appears.
2. In the Contacts list, select and then delete the appropriate contact. The contact is deleted from the list.

Administering Bricks
A brick is a collection of accounts and contacts, normally in a common geographic area. Bricks are sometimes referred to as geo zones. The primary purpose of a brick is to allow a company to publish RSA (retail sales analysis) data while making sure that specific sales cannot be tracked to a particular contact or account.

IMS Health publishes retail sales data and determines the definition of bricks. Brick definitions are reviewed every six months and adjusted to make sure that the brick is as small as possible while providing the required level of anonymity.

Because brick data is a key measure of return on a pharmaceutical company's investment in sales promotion, outside the United States most pharmaceutical companies build sales territories based on brick data available for that country. This provides a meaningful way to measure performance over time.

About Bricks in Siebel Pharma
As Siebel administrator, you can associate a contact or an account address with a brick. A contact can be associated with multiple bricks and an account with multiple addresses can have one brick for each address.

Siebel Pharma also supports mini-bricks. Mini-brick data is a subset of brick data that narrows the number of contacts and accounts in a geographic area. Mini-bricks provide a more detailed view of an area, without identifying the individuals in the unit.
It is the Siebel administrator’s responsibility to set up and maintain brick definitions as well as associate bricks with contacts and account addresses. For information on associating a brick with an account address, see “Associating a Brick with an Account Address” on page 67.

**Defining a Brick**
This section includes information about defining bricks.

*To define a brick*

1. Navigate to the Administration - Data screen > Brick Details view.
2. In the Bricks list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Brick</td>
<td>The Pick Brick dialog box lists all the bricks in the database. If the new brick is a mini-brick, click the parent brick in the Pick Brick dialog box.</td>
</tr>
<tr>
<td>Active</td>
<td>If checked, the brick is active. Only active bricks are listed in the Pick Brick dialog box.</td>
</tr>
<tr>
<td>Position</td>
<td>Defines positions associated with the brick and controls visibility on the Analysis screen &gt; Brick views.</td>
</tr>
<tr>
<td></td>
<td>Note: For users to see the bricks for which they are responsible, the administrator must associate their position with those bricks.</td>
</tr>
</tbody>
</table>

**NOTE:** On initial data load, you can use EIM to load brick data into the base table S_REGION. For more information on using EIM, see *Siebel Enterprise Integration Manager Administration Guide*.

**Associating a Contact with a Brick**
You can associate a brick directly with one or more contacts.

*To associate a contact with a brick*

1. Navigate to the Administration - Data screen > Brick Details view.
2. In the Bricks list, select a Brick.
3. In the Contact list, create a new record for the contact you want to associate with the brick.
Creating a Contact (End User)

A contact can be any individual an end user deems significant in achieving their business goals. Multiple employees can be assigned, as a team, to a contact. Any employee assigned to the team can update the contact’s information. The user who creates the contact is automatically designated as the primary contact team member. However, he or she can also be assigned to other contact teams by another user (such as a manager).

**NOTE:** The My Team’s Contacts view is limited to showing only those contacts with a subordinate person as the primary on the team. It does not show contacts where the subordinate is on the team, but is not primary.

If you prefer the behavior of displaying all contacts who are on the team of the subordinate person, create a service request (SR) on My Oracle Support. Alternatively, you can phone Global Customer Support directly to create a service request or get a status update on your current SR.

Because the contacts shell is assigned to individual people (that is, employees) and not positions, this view does *not* show contacts who are assigned to a position that has no employee assigned. To prevent this behavior, assign a placeholder employee to every position.

Contacts can also be viewed on an account hierarchy tree that shows accounts, their child accounts and all activities, contacts, and opportunities associated with the accounts. For more information, see Chapter 5, “Administering and Managing Accounts in Life Sciences.”

**To create a contact record**

1. Navigate to the Contacts screen > Contacts List > More Info view.
2 In the Contacts form, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>A contact can have multiple addresses. Use the Addresses dialog box to select an existing address or create a new one. <em>NOTE:</em> Be careful when editing an existing address. Editing an existing address changes it for all contacts currently associated with the address. If you are unsure whether the change applies to all contacts, create a new address. Each user must specify one address as primary by selecting the Primary field. Each sales representative assigned to a contact can specify a different primary address. For example, one representative might specify a private office as the primary address, while another representative might specify a hospital department as the primary address. In the All Contacts view and the My Team’s Contacts view, the primary address displayed is the one assigned by the primary team member.</td>
</tr>
<tr>
<td>Brick</td>
<td>Indicates an impartial geographic code that groups contacts in a way that mirrors the definition provided by syndicated data providers. These codes are loaded by the administrator and are read-only for all users. For more information, see “About Bricks in Siebel Pharma” on page 50, and “Associating a Contact with a Brick” on page 51.</td>
</tr>
<tr>
<td>Clinical</td>
<td>Indicates if this contact has been involved in a clinical trial.</td>
</tr>
<tr>
<td>Company Identifier</td>
<td>A unique identifier for the contact that can be used to cross reference with other systems.</td>
</tr>
<tr>
<td>Consumer</td>
<td>Indicates if this contact is a customer.</td>
</tr>
<tr>
<td>Last Call Date</td>
<td>The date of the most recent call that has been submitted for each member of the team. In the My Contacts view, this field shows the last date that you, as the logged-in user, has made a call. In the other Contacts views, this field shows the last date the team’s primary has made to the account.</td>
</tr>
<tr>
<td>License #</td>
<td>Used to record all contact’s professional licenses.</td>
</tr>
<tr>
<td>Primary Specialty</td>
<td>Only Siebel administrators can define this value. For more information, see “Setting Up Primary Specialties” on page 48 and “Setting Up Primary Specialties” on page 48.</td>
</tr>
<tr>
<td>Primary TOP</td>
<td>The physician’s primary type of practice.</td>
</tr>
<tr>
<td>Provider</td>
<td>Indicates if this contact is a health care provider.</td>
</tr>
<tr>
<td>Rep Specialty</td>
<td>The specialty or area of expertise the end user sees this contact has having within their organization.</td>
</tr>
</tbody>
</table>
Managing Contacts in Life Sciences  
■ Specifying the Best Time to Call (End User)

**NOTE:** Contacts can only be deleted by a Siebel administrator in the Data Administration, Contacts view. For information on administering contacts, see “Deleting a Contact” on page 50.

### Specifying the Best Time to Call (End User)

A contact can have more than one address. Using the Addresses view, end users can enter the best times to call on a contact based on a selected address. Entering information in this view automatically populates other views such as the PreCall view.

For more information about:

- Creating addresses, see the addresses field description in “Creating a Contact (End User)” on page 52
- Using the PreCall view, see “Viewing Pre-Call Information (End User)” on page 56

### To specify the best time to call on a contact

1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select a contact and drill down on the Last Name.
3. Click the Addresses view tab.
4. In the Addresses list, select an address.
5. In the Best Times list, create a new record, and complete the necessary fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rep TOP</td>
<td>The physician's primary type of practice according to the assigned sales representative.</td>
</tr>
<tr>
<td>Route</td>
<td>Allows users to select a when to visit an account from a predefined schedule. For more information, see &quot;About Defining a Route Plan (End User)&quot; on page 108.</td>
</tr>
<tr>
<td>Speaker</td>
<td>A check mark indicates this contact is a speaker for MedEd events. This field is used to track various speakers at any level. For more information, see “Designating MedEd Event Speakers” on page 240.</td>
</tr>
<tr>
<td>Team</td>
<td>Multiple people can be assigned to the contact’s team. The team member who created the record is indicated as primary.</td>
</tr>
<tr>
<td>Territory</td>
<td>Territories are assigned to contacts using Siebel Assignment Manager.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of contact.</td>
</tr>
</tbody>
</table>
Indicating Affiliations Between Contacts (End User)

The Contacts Affiliations view allows end users to track referral relationships between contacts. Using this view, users can track:

- **Referral or Referring Relationship.** Users can specify whether a contact receives or gives referrals to other contacts.
- **Influence of Contacts on One Another.** Users can specify whether or not one contact influences another contact.

**To indicate an affiliation between contacts**

1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select a contact and drill down on the Last Name.
3. Click the Affiliations view tab.
4. To specify a referring relationship, in the Affiliations list, create a new record, and complete the necessary fields.
5. To specify an influencing relationship, in the Influenced list, create a new record, and complete the necessary fields.

Indicating Affiliations Between a Contact and an Account

Using the Account Affiliations view tab, end users can associate a contact with an account. One reason to indicate these affiliations is for greater efficiency in call reporting, as described in Chapter 9, "Recording Calls in Pharma."

Once you record an affiliation between an account and a contact, you can also:

- **Specify a role for the affiliated contact.** This gives the end user some comprehension of the contact’s occupation.
- **Specify the best times to call the contact at the affiliated account.** This makes sure that the contact is not called at inconvenient or inappropriate times.
- **Specify the role of the contact at the affiliated account.** This helps end users to track a contact’s importance within an organization. They can then refer to this information prior to calls and adjust their discussions with each contact accordingly.
Review products in the formularies of the affiliated account. If the contact is affiliated with any MCOs, make sure to add the names of these to the Account Affiliations list.

The Formulary Status list (LS Formulary Status List Applet) shows the drugs that are in the MCO account’s formulary. This is read-only information. Formulary status can be updated from the Plan Formulary view of the Accounts screen.

NOTE: If a PBM (pharmacy benefit management company) owns the formulary, you need to affiliate the PBM account instead of the MCO account, in order to see the formulary.

To indicate an affiliation between a contact and an account
1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select a contact and drill down on the Last Name.
3. Click the Account Affiliations view tab.
4. In the Account Affiliations list, create a new record, and complete the necessary fields.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to be affiliated with the selected contact.</td>
</tr>
<tr>
<td>Start date</td>
<td>The beginning date on which the contact became affiliated with this account.</td>
</tr>
<tr>
<td>End date</td>
<td>The date on which the contact ended affiliation with this account.</td>
</tr>
<tr>
<td>Direct</td>
<td>Select this field to route profile data for the contact to the members of the team assigned to the affiliated account. The Siebel administrator must enable this behavior. Do not select this field to route the profile data for the contact to the members of the team assigned to the contact. (Users who are connected to the server see the profile data whether or not a check mark appears in the field.)</td>
</tr>
</tbody>
</table>

5. To specify the role of the contact at the affiliated account, in the Roles list, create a new record, and complete the necessary fields.

6. To specify the best time to call on the contact at the affiliated account, in the Best Times list, create a new record, and complete the necessary fields.

Viewing Pre-Call Information (End User)
The Pre-Call view tab is a single view that provides end users with a thumbnail view of important information about a contact. Users can access this view prior to making a call to get a summary of key information about the customer they are about to visit.
To view pre-call information

1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select a contact and drill down on the Last Name.
3. Click the PreCall view tab.

The following table describes the list applets in the PreCall view.

<table>
<thead>
<tr>
<th>List</th>
<th>Comments</th>
<th>Link Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rx Trends</td>
<td>Syndicated data about prescription trends.</td>
<td>Rx Trend</td>
</tr>
<tr>
<td></td>
<td>Data can be viewed as a chart or as a list.</td>
<td></td>
</tr>
<tr>
<td>Rx Trends By Plan</td>
<td>Syndicated data about prescription trends. Rx Trend by Plan shows</td>
<td>Rx Trend By Plan</td>
</tr>
<tr>
<td></td>
<td>prescriptions by managed care plans.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data can be viewed as a chart or as a list.</td>
<td></td>
</tr>
<tr>
<td>Rx Trends By Formulary</td>
<td>Syndicated data about prescription trends. Rx Trend by Formulary shows</td>
<td>Rx Trend and Formulary</td>
</tr>
<tr>
<td></td>
<td>prescription trends and formulary status information at affiliated accounts.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Data can be viewed as a chart or as a list.</td>
<td></td>
</tr>
<tr>
<td>Account Affiliations</td>
<td>Lists all accounts affiliated with this contact.</td>
<td>Rx Trend</td>
</tr>
<tr>
<td></td>
<td>This list can also be populated from the Account Affiliation view tab.</td>
<td>Rx Trend By Plan</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Indicating Affiliations Between a Contact and</td>
<td>Rx Trend and Formulary</td>
</tr>
<tr>
<td></td>
<td>an Account” on page 55.</td>
<td></td>
</tr>
<tr>
<td>Best Times</td>
<td>Lists the best times to visit the contact.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This list can also be populated in the Addresses view tab. For more</td>
<td></td>
</tr>
<tr>
<td></td>
<td>information, see “Specifying the Best Time to Call (End User)” on page 54.</td>
<td></td>
</tr>
<tr>
<td>Calls</td>
<td>Features an historical list of all calls made on the contact.</td>
<td></td>
</tr>
<tr>
<td>Formulary status</td>
<td>Provides formulary status information for products in affiliated accounts.</td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>Contains end-user notes regarding the selected contact.</td>
<td></td>
</tr>
<tr>
<td>Campaigns</td>
<td>Lists all the current campaigns targeted for the contact.</td>
<td>Marketing Communications¹</td>
</tr>
<tr>
<td></td>
<td>Marketing Communications are not editable in this view. This list is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>populated from the Campaigns screen. For more information, see the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>chapter about creating campaigns in the Siebel Marketing User Guide.</td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td>Lists all the offers associated with the campaign selected in Campaigns.</td>
<td></td>
</tr>
</tbody>
</table>

1. Requires the Siebel Pharma Campaigns option.
4. To add information:
a  Select the Calls, Best Times, Notes, or Account Affiliations lists.

b  Create a new record and complete the necessary fields.

**NOTE:** The Rx Trend data is not editable in this view.

### Tracking Documentation Associated with a Contact (End User)

Clinical research associates can attach electronic files, such as CVs, contracts, and reports, that may be associated with a contact and record significant dates, such as the date the document is sent, received, expected, or expires.

#### To add an attachment to a contact

1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select a contact and drill down on the Last Name.
3. Click the Document Tracking view tab.
4. In the Document Tracking list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Must be Document.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>The person to whom responsibility for the document has been assigned.</td>
</tr>
<tr>
<td>Expected Date</td>
<td>The date that the signed document is expected to be received from the contact.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>The date the document expires.</td>
</tr>
<tr>
<td>Name</td>
<td>The document name. This is a hyperlink to the Attachments view tab.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Assigned To field is locked. If the activity is locked, Assignment Manager will not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
</tbody>
</table>

5. Select the record you just created and click the Attachments view tab.
6. Create a new record and add the document as an attachment.

#### To track documentation associated with a contact

1. Navigate to the Contacts screen > Contacts List.
2. In the Contacts list, select for whom you want to track documentation and drill down on the Last Name.
3 Click the Document Tracking view tab.

4 In the Document Tracking list, query for the document of interest and complete the necessary fields.

For more information on associating electronic documents with contacts, see “Creating Documentation Tracking Activities” on page 324.

Other Tasks for Managing Contacts

Other tasks associated with contacts are:

- **Creating contact assessments.** End users can use assessment templates to rate and rank contacts on key indicators. For example, sales representatives can use assessments to conduct primary market research during their sales calls. For information about creating assessment templates, see *Siebel Applications Administration Guide*. For information about performing assessments (contact assessments are performed the same way as account assessments), see *Siebel Applications Administration Guide*.

- **Creating category information.** End users can create public or private categories to track additional contact information, such as a particular sports a contact enjoys or food a contact prefers. For information about categories, see *Siebel Applications Administration Guide*.
5 Administering and Managing Accounts in Life Sciences

This chapter covers the following topics:

- "About Administering and Managing Accounts in Life Sciences“ on page 61
- "About Account Hierarchies“ on page 62
- "About Bricks“ on page 62
- “Scenario for Accounts“ on page 63
- “Process of Managing Accounts“ on page 63
- “Specifying a Competitor“ on page 64
- “Deleting an Account“ on page 64
- “Generating Account Hierarchies“ on page 65
- “Associating a Brick with an Account Address“ on page 67
- “Entering an Account (End User)“ on page 67
- “Specifying an Account Profile (End User)“ on page 68
- “Viewing Account Hierarchies in Roll-up Views (End User)“ on page 69
- “Creating Category Information for an Account (End User)“ on page 71
- “Indicating an Affiliation Between an Account and a Contact (End User)“ on page 71
- “Indicating Affiliations Between Accounts (End User)“ on page 72
- “Creating Subaccounts (End User)“ on page 73
- “Viewing Pre-Call Information (End User)“ on page 75
- “Viewing Departments and Contacts (End User)“ on page 75
- “Tracking Documentation Associated with Accounts (End User)“ on page 76
- “About Configuring the Generate Hierarchy Button“ on page 77

About Administering and Managing Accounts in Life Sciences

An account is any healthcare business that generates sales for your company or potentially could generate business. Typical examples of accounts include hospitals, clinics, MCOs (managed care organizations), wholesalers, group purchasing organizations (GPOs), and pharmacies. An account can also be any organization with which multiple contacts are associated, such as a group practice or an assisted-living facility.
This chapter describes how to administer and manage Siebel Life Sciences account information. Using the procedures given in this chapter, you will be able to perform the administrator tasks of generating account hierarchies, deleting an account, specifying which accounts are competitors, and associating bricks with account addresses. End users use the Accounts views to track a variety of account information, including account affiliations, account and contact relationships, activities and opportunities associated with accounts, and formulary information.

For more information on specific administrator and end-user tasks, see “Scenario for Accounts” on page 63.

About Account Hierarchies

An account hierarchy is a group of accounts that are organized by parent-child relationships. All of the Siebel Life Sciences applications support displaying these account relationships and the contacts, activities, and opportunities associated with each account on a hierarchical tree.

The hierarchical tree is a visual representation of account hierarchy data that allows end users to view the relationships between accounts. By viewing an account rollup, users can see aggregated account information, including contacts, coverage teams, activities and opportunities.

When end users have access to an account, they can review the hierarchical structure for that account, its child accounts and the contacts who work there. Account hierarchies are stored in five subviews of the Account screen—Relationship Hierarchy view, Activity Roll-up, Contact Roll-up, Opportunity Roll-up, and Coverage Team Roll-up.

Depending on your configuration, an account that does not have a parent-child relationship with another account may not appear in the rollup views.

About Bricks

A brick is a collection of accounts and contacts, normally in a common geographic area. The primary purpose of a brick is to allow a company to publish RSA (retail sales analysis) data while making sure that specific sales cannot be tracked to a particular contact or account. For more information on creating bricks, see “Administering Bricks” on page 50.

IMS Health publishes retail sales data and determines the definition of bricks. Brick definitions are reviewed every six months and adjusted to make sure that the brick is as small as possible while providing the required level of anonymity.

In countries where physician-level prescription data is not available, brick data is a key measure of return on a pharmaceutical company's investment in sales promotion. In these markets, most pharmaceutical sales territories are built based on brick data available for that country. This provides a meaningful way to measure performance over time.

How Bricks Work in Siebel Pharma

In Siebel Life Sciences, you can associate a contact or an account address with a brick. A contact can be associated with multiple bricks and an account with multiple addresses can have one brick for each address.
This implementation of Siebel Pharma also supports “mini-bricks.” Mini-brick data is a subset of brick data that narrows the number of contacts and accounts in a geographic area. Mini-bricks provide a more detailed view of an area, without identifying the individuals in the unit.

It is the Siebel administrator’s responsibility to set up and maintain brick definitions as well as associate bricks with account addresses and contacts. For more information on associating a brick with an account address, see "Associating a Brick with an Account Address” on page 67.

Scenario for Accounts

This topic outlines an example process performed by a Siebel administrator and end users. Your company may follow a different process according to its business requirements.

A pharmaceutical company is updating account information in their database. During this update process, the administrator is responsible for setting up and updating Siebel Accounts so that sales representatives can plan, track, and access account information. The administrator first deletes any obsolete accounts, then enters new information about competitors, and generates an account hierarchy. Finally, the administrator associates new accounts with existing bricks (geographic areas), if applicable.

Sales representatives use Siebel Accounts to manually enter and modify account information. For accounts with multiple departments and divisions, representatives can enter additional information for subaccounts. They can also add more depth to account data by creating user-defined fields called categories. Using categories, representatives can track private or shared information about accounts (for example, which accounts have memberships to specific professional associations).

For greater efficiency in call reporting, representatives can associate a contact with a specific account. Once these relationships are tracked within the system, they can record attendee calls. Attendee calls (very similar to contact calls) allow users to record the account call and samples disbursements for contacts seen at the account. Prior to visiting an account, representatives can view a snapshot of important information related to an account using the Pre-Call view.

Finally, both representatives and managers can evaluate the business potential of accounts by using the Account Rankings and Ratings view and the various charts provided in the Charts views.

Process of Managing Accounts

This topic details sample tasks often performed by administrators and sales representatives to record account calls. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks administrators typically perform to manage accounts:

- "Specifying a Competitor” on page 64.
- "Deleting an Account” on page 64.
- "Generating Account Hierarchies” on page 65. The account hierarchy lists accounts, child accounts and the activities, contacts and opportunities associated with all the accounts.
End-User Procedures
The following list shows tasks end users typically perform when managing account information in the field:

- "Entering an Account (End User)" on page 67.
- "Specifying an Account Profile (End User)" on page 68.
- "Viewing Account Hierarchies in Roll-up Views (End User)" on page 69.
- "Creating Category Information in Roll-up Views (End User)" on page 69.
- "Indicating an Affiliation Between an Account and a Contact (End User)" on page 71.
- "Indicating Affiliations Between Accounts (End User)" on page 72.
- "Creating Subaccounts (End User)" on page 73.
- "Viewing Pre-Call Information (End User)" on page 75.
- "Viewing Departments and Contacts (End User)" on page 75.
- "Tracking Documentation Associated with Accounts (End User)" on page 76. Representatives can review documentation associated with an account, the contacts responsible for each document and when reviews are due.

Specifying a Competitor
You enter competitors as accounts in Siebel Life Sciences, and with the Competitor field selected.

**To specify an account as a competitor**

1. Navigate to the Accounts screen > Accounts Administration view.
2. In the Accounts form, create a new record and click the show more button.
3. Complete the necessary fields.
4. Select the Competitor field.

For more information on creating accounts from the Accounts screen, see "Entering an Account (End User)" on page 67. For more information on adding competitive product information, see "Managing Competitor Information" on page 93.

Deleting an Account
Deleting an account completely removes the account from the system. Be aware that deleting an account could have undesired consequences.

As an alternative to deleting an account, consider making the Siebel administrator the primary team member so that he or she can remove all other employees from the account’s team.
If you are certain that the account is no longer active, use the following procedure to delete it.

**To delete an account**

1. Navigate to the Accounts screen > Accounts Administration view.
2. In the Accounts list, select and delete the account.

---

**Generating Account Hierarchies**

Data aggregation is available using the Roll-up views provided the administrator defines one or more hierarchies. The application administrator typically defines a “default” hierarchy by associating accounts with one another using the parent field on a company form, or the subaccount view for child accounts. Administrators can define account hierarchies display aggregated data—the activities, opportunities, contacts, and coverage teams—across account organizational structures. For example, the top node of the hierarchy contains activities for the organization, the subsidiaries below the organization, the departments at the subsidiaries, and contacts working at any level of the tree. As the end users move up and down the tree, they see more or less data rolled up to the selected level.

The application administrator can define two types of hierarchies for data aggregation—a default hierarchy for all end users and specific hierarchies that are used only by certain end users.

**Default Account Hierarchies**

The application administrator sets up a default account hierarchy once, during the initial application setup. The default hierarchy is available to all end users who are not tied to a specific hierarchy and who have been granted view access to the accounts represented in the hierarchy. It is the administrator’s responsibility to give end user access to Account views. For more information, see about Global Accounts in the Siebel Applications Administration Guide.

When new accounts are created, they are automatically added to the default hierarchy tree and the contacts, coverage teams, activities, and opportunities that are associated with the accounts are automatically displayed in the rollup views. For information about configuring the Generate Hierarchy button, see "About Configuring the Generate Hierarchy Button” on page 77.

**To generate a default account hierarchy**

1. Navigate to the Account screen > Global Accounts Administration view.
In the Account Hierarchy list, click Generate Hierarchy.

The parent-child account relationships that have been defined in your application are registered for participation in the roll-up views. This process may take some time, depending on the quantity of account records that are in your existing environment.

When the account hierarchy has been generated, a new record appears in the Account Hierarchies list. If it is the only account hierarchy record, the Default field is automatically checked. The accounts that have been added for participation in the roll-up views appear in the Account Relationships list.

NOTE: If no accounts are visible in the Account Relationships list, click the query button, step off the query, and click Go to refresh the view.

3 (Optional) Rename the account hierarchy and, if necessary, check the Default field.

NOTE: If end users are using the application when you generate the account hierarchy, they must log off and log on again to see the default account hierarchy in the rollup views.

Custom Account Hierarchies

In some cases, users work with particular accounts or subaccounts of a large corporation, but not with others. In these instances, some end users do not need to or should not see aggregated data across the entire corporation. An administrator can define a custom hierarchical structure across which data can be aggregated. This customer hierarchy can be as simple or complex as needed and offers users the ability to aggregate data across the accounts they are interested in seeing.

To create a custom account hierarchy of selected accounts

1. Navigate to the Account screen > Global Accounts Administration view.

2. In the Account Hierarchy list, create a new record, and complete the necessary fields. Do not select the Default checkbox.

3. In the Account Relationships list:
   a. Create new records for each of the top level parent accounts. Leave the Parent Account field blank for each of these.
   b. Create new records for the child accounts, entering the Parent Account for each.

4. Associate the hierarchy with an organization. For information about assigning a custom hierarchy to an organization, see Siebel Applications Administration Guide.

End users can only see the account hierarchy with which their current position’s primary organization is tied.
Associating a Brick with an Account Address

In Siebel Life Sciences, you can associate a brick with an account address. Because bricks are associated with an account’s address (and not the account itself), you can associate accounts that have multiple addresses with multiple bricks.

To associate a brick with an existing account address

1. Verify that brick records have been set up.
   For information, see "Administering Bricks" on page 50.
2. Navigate to the Accounts screen > Account Administration view.
3. In the Accounts list, select an account.
4. In the Account form, click the select button in Addresses to open the Account Addresses shuttle applet.
5. For a selected address, edit the Brick field.

If this procedure does not work, review the Siebel Release Notes on My Oracle Support (see the issue about pop-ups invoked from shuttle applets).

Entering an Account (End User)

Accounts are businesses and organizations that either currently generate sales for your company or have the potential to do so. Because formulary opportunities are created and managed based on accounts and contacts can be affiliated with one or more accounts, entering and maintaining accurate account information is a critical task.

Accounts are also used to track competitor information. An account record with the Competitor field selected represents a competing company. Only the administrator can edit the Competitor field to create a competitor record. For more information, see "Specifying a Competitor" on page 64.

Multiple employees can be assigned, as a team, to an account. Any employee assigned to the team can update the account’s information. The user who creates the account is automatically designated as the primary account team member. However, he or she can also be added to an account team created by another user (such as a manager).

Accounts in Siebel Life Sciences can have multiple addresses. Users can edit existing addresses directly in the Address field. However, users must be careful when editing an existing address. Editing an existing address, changes it for all accounts currently associated with the address.

To create an account

1. Navigate to the Accounts screen > Accounts List view.
2 In the form, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team</td>
<td>Multiple people can be assigned to the account team. The team member who created the record is indicated as primary.</td>
</tr>
<tr>
<td>Address</td>
<td>The account can have more than one address. One address must be specified as primary.</td>
</tr>
<tr>
<td>Brick</td>
<td>The brick (geographic area) code associated with the account's primary address.</td>
</tr>
<tr>
<td>Parent</td>
<td>If this account is a subaccount of another account, select the parent account.</td>
</tr>
<tr>
<td>Site</td>
<td>A unique location identifier that distinguishes this account from any other accounts with the same name. For example, enter a city or county name in this field to uniquely identify a hospital.</td>
</tr>
</tbody>
</table>

3 Drill down on the account record and click the More Info view tab.

4 In the More Info form, complete the necessary fields.

The More Info form is a dynamic applet. There are five dynamic form applets in addition to the default account profile form:

- Hospital
- Clinic
- Pharmacy
- Long Term Care
- Managed Care

The fields that appear are dependent on the account's Type field value.

**NOTE:** Only a Siebel administrator can delete an account. For more information, see "Deleting an Account" on page 64.

**Specifying an Account Profile (End User)**

Using the Account Profile view, end users can track profile information about an account, including the call frequency, details about the account size, the best times to call on the account, and historical list of all activities at the account. The Account type field in the Account form (at the top of the screen) determines what fields appear in the Account Profile form.

**To create an account profile information for an account**

1 Navigate to the Accounts screen > Accounts List view.
2 In the Accounts list, drill down on an account.
3 Click the Account Profile view tab.
   **NOTE:** The fields that appear in the Account Profile form depend upon which Account Type field 
in the Account form at the top of the screen. All fields in the Account Profile form are editable.
4 In the Account Profile form, complete the fields.
   You can track the best times to call on the account in the Best Times list.
5 In the Best Times list, review, create, or modify best time to call records.
6 In the Activities list, review or modify records or create general activities for the account.

**Viewing Account Hierarchies in Roll-up Views (End User)**

End users can review the account and its parent organization, subsidiaries, contacts, opportunities, 
and relationships to other entities in the graphical relationship hierarchy tree control available in the 
roll-up views. By drilling down on hypertext links on the hierarchy tree, end users navigate to related 
views.

**NOTE:** If the account has not been added to a hierarchy tied to the user's position's organization 
(either default hierarchy or custom hierarchy), the hierarchy tree is not visible to the end user. 
Instead they see “The selected record is not included as part of your defined hierarchy. If you feel 
this is in error, please contact your system administrator.” The administrator is responsible for 
associating positions with organizations and an organization with a hierarchy.

The Activities-Roll-up view shows all of the activities associated with the selected account and its 
children. End users can apply filters to the list to find specific activity records and save the filtered 
list.

**To view aggregated activities for an account**

1 Navigate to the Accounts screen > Accounts List view.
2 Drill down on an account.
3 Click the Activities - Roll-up view tab.
   The associated account hierarchy appears on the right side of the screen. All activities associated 
with the account and all of its child accounts appear in the Activities-Roll-up list.

In the Activities-Roll-up List, you can:

- Drill down on an activity type to navigate to the Activities > Attachments view.
- Drill down on an account name to navigate to the Account > Contacts view.

**NOTE:** If you create an activity in the Activities screen and do not set the Account field, the 
activity will not appear in the Activities-Roll-up list.
To view the aggregated coverage team for an account hierarchy

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account.
3. Click the Coverage Team-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All coverage team members associated with the account and all of its subsidiaries appear in the Coverage Team-Roll-up list.

In the Coverage Team-Roll-up list, you can:
- Drill down on a last name to navigate to the Employees screen.
- Drill down on an email address to open a blank email message addressed to the team member who has that address.

To view the aggregated opportunities for an account hierarchy

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account.
3. Click the Opportunities-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All opportunities associated with the account and all of its child accounts appear in the Opportunities-Roll-up list.

In the Opportunities-Roll-up list, you can:
- Drill down on an opportunity name to navigate to the Opportunities screen.
- Drill down on an account name to navigate to the Account > Contacts view.

To view an aggregated list of contacts an account

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account.
3. Click the Contact-Roll-up view tab.

The associated account hierarchy appears on the right side of the screen. All contacts associated with the account and all of its child accounts appear in the Contacts-Roll-up list.

In the Contacts-Roll-up list, you can:
- Drill down on a last name to navigate to the Contacts screen.
- Drill down on an account name to navigate to the Account > Contacts view.
- Drill down on an email address to open a blank email message addressed to the contact who has that address.
Creating Category Information for an Account (End User)

End users can create categories to track additional account information. In creating a category, a user can:

- Define possible category values.
- Specify the relative importance of the category and each of its values.

By default, categories are visible system-wide. However, users can mark categories as private. Private categories are only visible to the user who created them.

**To create category information for an account**

- Follow the procedure for adding a category in the *Siebel Applications Administration Guide*.

Indicating an Affiliation Between an Account and a Contact (End User)

For accounts having multiple contacts, you associate contacts with an account using the Contact Affiliations view. One reason to indicate these affiliations is for greater efficiency in call reporting, as described in “Recording Calls in Pharma” on page 161.

**NOTE:** The records for contacts you want to affiliate must already exist in the system; you cannot create new contact in this view. For more information on creating contacts, see “Creating a Contact (End User)” on page 52.

**To indicate an affiliation between an account and a contact**

1. Navigate to the Accounts screen > Accounts List view.
2. Drill down on an account.
3. Click the Contact Affiliations view tab.
4. In the Contact Affiliations list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td>If a check mark appears in this field, profile data for the contact is routed to members of the team assigned to the affiliated account.</td>
</tr>
<tr>
<td></td>
<td>If no check mark appears in this field, the profile data is routed only to the members of the team assigned to the contact. (Users who are connected to the server see the profile data regardless of whether a check mark appears in the field or not.)</td>
</tr>
<tr>
<td>Last Name</td>
<td>The contact affiliated with this account.</td>
</tr>
</tbody>
</table>
End users can track a contact’s importance and influence level within an account by defining their role in the Roles list. Users can then refer to this information prior to calls and adjust their discussions accordingly.

To create a new role for an affiliated contact

1. Affiliate an account with a contact as described in the previous procedure, "To indicate an affiliation between an account and a contact” on page 71.
2. Scroll down to the Roles list, create a new record, and complete the necessary fields.

Indicating Affiliations Between Accounts (End User)

In addition to specifying affiliations with contacts, accounts can also have affiliations with one another. For example, a hospital can have affiliations with certain pharmacies and referring clinics. Users can use the Account Affiliations view to indicate affiliations between accounts and to indicate whether the relationship is an upward or downward affiliation.

NOTE: Do not use the Account Affiliations view to indicate a child account of an account, such as a department within a hospital or a subsidiary of an account. To specify this kind of association, see “Creating Subaccounts (End User)” on page 73.

The Account Affiliations view includes two lists users can use to distinguish between upward (or peer affiliations) and downward affiliations:

- **Upward or Peer Affiliations list.** Indicates an affiliation in which the selected account is the agent of the affiliation, such as an organization responsible for referring patients to another hospital.

- **Downward Affiliations list.** Indicates an affiliation in which the selected account is the object of the affiliation, such as an organization receiving referrals from another hospital.

To indicate an affiliation between accounts

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Account Affiliations view tab.
4. In Account Affiliations view, scroll down and select one of the following lists:
   - **Upward or Peer Affiliations.** Indicates an affiliation in which the selected account is the agent of the affiliation, such as an organization responsible for referring patients to another hospital.
   - **Downward Affiliations.** Indicates an affiliation in which the selected account is the object of the affiliation, such as an organization receiving referrals from another hospital.
In the Upward or Peer Affiliations list or the Downward Affiliations list, create a new record, and complete the necessary fields.

**NOTE:** If the relationship between the accounts is generic or unknown, add the record to the Upward or Peer Affiliations list.

You can add more than one account at a time by selecting multiple accounts in the Add Accounts dialog box.

### To view an account’s upward and downward account affiliations

1. Navigate to the Accounts screen > Explorer view.
2. Expand the account for which you wish to view upward and downward affiliations.

## Creating Subaccounts (End User)

Some accounts may have child accounts or subaccounts; for example, a hospital can have several departments or clinics. End users can create subaccounts for existing accounts using the Sub Accounts view. End users can also use this view to indicate affiliations between contacts and subaccounts.

Once a user has created a subaccount, it can be viewed and modified in any of the views in the Accounts screen. All accounts—parent accounts and child subaccounts—exist as separate accounts in the system. In the Account Explorer view, however, a subaccount appears under its parent, reflecting the hierarchical relationship between the two.

Table 10 describes how parent and subaccount team membership affect account data access. Users assigned to a parent account team but not to a subaccount team, only have partial access to subaccount data. In contrast, users assigned to a subaccount team but not to the parent account team, have no access to the parent account except to the account name.

### Table 10. Access to Account and Subaccount Data

<table>
<thead>
<tr>
<th>Access</th>
<th>Assigned Only to Parent Account’s Team</th>
<th>Assigned Only to Subaccount’s Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to Parent Account Data</td>
<td>Full access</td>
<td>Partial access, account name only</td>
</tr>
<tr>
<td>Access to Subaccount Data</td>
<td>Partial access</td>
<td>Full access</td>
</tr>
</tbody>
</table>

**NOTE:** Do not use the Account Sub Accounts view to indicate affiliations between independent accounts, such as a hospital and a referring clinic. For more information on establishing this type of association, see “Indicating Affiliations Between Accounts (End User)” on page 72.

### To create a subaccount

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Sub Accounts view tab.
4. In the Sub Accounts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Team</td>
<td>Multiple people can be assigned to the account’s team. The team member who created the record is indicated as primary.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the subaccount.</td>
</tr>
<tr>
<td>Site</td>
<td>A unique location identifier that distinguishes this account from any other accounts with the same name. For example, enter a city or county name in this field to uniquely identify a hospital.</td>
</tr>
</tbody>
</table>

Adding a subaccount automatically adds a child record to the account hierarchy. For information about account hierarchies, see “Generating Account Hierarchies” on page 65.

**NOTE:** To enter detailed data for a subaccount (such as activities and best times to call), drill down on the Name field and complete the fields in the various account views.

To indicate an affiliation between a contact and a subaccount

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Sub Accounts view tab.
4. In the Sub Accounts list, select a subaccount.
5. Scroll down to the Contact Affiliations list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
</table>
| Direct        | If a check mark appears in this field, profile data for the contact is routed to members of the teams assigned to the related account.  
                | If no check mark appears in this field, the profile data is routed only to the members of the team assigned to the contact. (Users who are connected to the server see the profile data regardless of whether a check mark appears in the field or not.) |
| Last Name     | The contact affiliated with this subaccount.                                                    |

6. Scroll down to the Roles list, create a new record, and complete the necessary fields.
Viewing Pre-Call Information (End User)

The Pre-Call view tab is a single view that provides end users with a thumbnail view of important information related to an account. Users can access this view prior to making a call to get a summary of key information about the account they are about to visit.

To view pre-call information

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Pre-Call view tab.

   The Pre-Call view appears, displaying the lists described in the following table.

<table>
<thead>
<tr>
<th>List</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Sales</td>
<td>Product sales information associated with the account.</td>
</tr>
<tr>
<td>Contact Affiliations</td>
<td>Lists all contacts affiliated with the account.</td>
</tr>
<tr>
<td></td>
<td>This list can also be populated in the Contact Affiliations view tab. For more information, see “Indicating an Affiliation Between an Account and a Contact (End User)” on page 71.</td>
</tr>
<tr>
<td>Activities</td>
<td>Features a historical list of all activities associated with the account. For more information on working with activities, see “About Creating Activities” on page 112.</td>
</tr>
</tbody>
</table>

4. (Optional) Select the Contact Affiliations or Activities lists, create a new record, and complete the necessary fields.

Viewing Departments and Contacts (End User)

Large hospitals can have a large number of doctors working in different medical departments within a hospital. Medical departments are generally organized around medical specialities. The Departments and Contacts view tab is a single view that allows end users to track the work department within the hospital where the contact performs his or her duties. Users can access this view prior to making a call to get familiar with the department of the contact they are about to visit.

An account can have multiple departments, but a department can belong to only one account. Departments are organized hierarchically within a hospital. A department can have one and only one parent department.

A contact can belong to multiple departments within a hospital. Membership to a child department does not define membership to any of the parent departments. However, membership to a child department does establish membership of the parent hospital Account.
To set up departments and contacts information

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, create a new record for the Hospital Department, and select Department as the value for the Type field.
3. Click the Parent Account field and from the Pick Applet, select the Parent Account for the Department.
4. Click the Contact Affiliation detail view tab.
5. In the List applet, click the New button, and open the Pick Applet on the Last Name field to associate a Contact to the Department.
6. Repeat Step 5 for other Contacts associated with the Department.

To view departments and contacts information

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, query for the Parent Account and drill down on the Account record.
3. Click the Departments and Contacts detail view tab.
   The Departments and their affiliated Contacts are displayed in the list.

Tracking Documentation Associated with Accounts (End User)

Clinical research associates can use the Document Tracking view to review and track documents associated with accounts.

To track documentation associated with an account

1. Navigate to the Account screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Document Tracking view tab.
4. In the list, view, edit, create, and delete document records as required.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>By default, the activity is Document.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>The person to whom responsibility for the document has been assigned.</td>
</tr>
<tr>
<td>Expected Date</td>
<td>The date that the signed document is expected to come back from the account.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>The date the document expires.</td>
</tr>
</tbody>
</table>
Clinical research associates can also create a documentation tracking activity and attach a document. For more information, see “Tracking Documentation Associated with a Contact (End User)” on page 58.

### About Configuring the Generate Hierarchy Button

In the preconfigured application, using the Generate Hierarchy button adds only parent account and child accounts to the hierarchy. Any account that does not have a child or parent is not displayed in the rollup views. In Siebel Tools, you can change the DynHierarchy LoadAllAccounts user property to alter this behavior.

The DynHierarchy LoadAllAccounts user property on the Dynamic Hierarchy Direct Relationship business component can be set to N or Y. When it is set to N (default), only parent and children appear in the generated hierarchy. When DynHierarchy LoadAllAccounts user property is set to Y, all accounts are added to the account hierarchy. For information on setting user properties, see Siebel Developer’s Reference.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Lock Assignment field should be selected. If the activity is locked, Assignment Manager will not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the document. This field is a hypertext link to the Attachments tab.</td>
</tr>
<tr>
<td>Received Date</td>
<td>The date that the signed document returns from the account.</td>
</tr>
<tr>
<td>Sent Date</td>
<td>The date that the document is sent to the account.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- “About Managing Products for Life Sciences” on page 79
- “How Siebel Life Sciences Stores Product Information” on page 80
- “Scenario for Managing Products” on page 80
- “Process of Managing Products” on page 81
- “Defining External Products” on page 81
- “Defining Internal Products” on page 82
- “Specifying Additional Product Information” on page 90
- “Defining Price Lists” on page 91
- “Managing Competitor Information” on page 93
- “Defining Decision Issues” on page 94
- “Adding Products to Catalogs” on page 95
- “Capturing Product Hierarchies for Medical Handheld” on page 98
- “Viewing Product Information (End User)” on page 99
- “Creating a Product Change Request (End User)” on page 99
- “Configuring Lot Numbers for Other Products” on page 100

About Managing Products for Life Sciences

Consistent product and price list information allows your company to sell its products. This chapter describes how to manage product information and pricing structures by setting up and defining products, product lines, product features, and price lists.

Using the procedures given in this chapter, you will be able to perform the administrator tasks of defining products (both internal and external) and entering information about promotional items, competitive products, markets (therapeutic classes), medical equipment and devices, and compounds under clinical trial. End users use the Products views to view product information and enter product change requests.

For more information on the differences between administrator and end-user tasks, see “Scenario for Managing Products” on page 80.
How Siebel Life Sciences Stores Product Information

Siebel Life Sciences provides two different tables for storing product information:
- An internal product table (S_PROD_INT)
- An external product table (S_PROD_EXT)

These tables supply data used in various chart views, such as those in the Analysis screen.

About the Internal Product Table
The internal product table (S_PROD_INT) is used primarily for proprietary product data, including products that are detailed or distributed as (pharmaceutical) samples or promotional items by sales representatives. The administrator can categorize products according to product level, therapeutic class, and product type as well as define market categories, such as an antibiotics market. For more information on entering products in the internal product table, see “Defining Internal Products” on page 82.

**NOTE:** After you enter a product into the internal product table, you cannot delete it. However, you can prevent it from appearing in drop-down lists and dialog boxes by making it inactive. For more information, see the procedure “To make a product inactive” on page 89.

About the External Product Table
The external product table (S_PROD_EXT) is used for syndicated data from content providers, and for any additional data the administrator chooses to enter about competitive or complementary products. Check with your content provider for information on the product identifiers they use. For more information on loading syndicated data, see Chapter 17, “Importing Data into Life Sciences.”

Products entered in the external product table can also be entered in the internal product table. However, for any product that is entered in both tables, make sure that the product name and other product identifiers match exactly in both tables.

For more information on entering products in the external product table, see “Defining External Products” on page 81.

Scenario for Managing Products
This topic outlines an example process performed by a Siebel Products administrator and end users. Your company may follow a different process according to its business requirements.

A medical devices company has a new product to bring to market. To make the new product available to sales representatives in the field, the administrator defines the new product within the system, creates a price list, and then associates the new product with the price list. Next he enters new background information (called decision issues) that the home office wants to communicate to the field. Finally, he uses the capture hierarchy command to update the product hierarchy so the new product can be inventoried by the sales representatives who are using the Medical Handheld application.
Sales representatives use Siebel Products to view product information and enter change requests.

**Process of Managing Products**

This topic details sample tasks often performed by administrators and end-users when managing products. In this scenario, the administrator is responsible for setting up Siebel Products so that end users can view product information. Your company may follow a different process according to its business requirements.

**Administrator Procedures**

The following list shows tasks administrators typically perform to set up product information:

- "Defining Internal Products" on page 82. Create a new product (called an internal product).
- "Specifying Additional Product Information" on page 90. Define product features and set up any product literature, entering additional product details including key features, information on related products, product comparison data, and associate literature.
- "Defining External Products" on page 81. Create any competitive and complementary products (called external products).
- "Adding Products to Catalogs" on page 95.
- "Defining Price Lists" on page 91. Define a price list and then associate it with the new product.
- "Defining Decision Issues" on page 94.
- "Capturing Product Hierarchies for Medical Handheld" on page 98. If you are using the Medical Handheld application, you must capture product hierarchies.

**End-User Procedures**

The following list shows tasks end users typically perform when viewing product information:

- "Viewing Product Information (End User)" on page 99.
- "Creating a Product Change Request (End User)" on page 99.

**Defining External Products**

Use the External Products view to manage information about competitive and complementary products and to associate those products with the companies that produce them.

Siebel Life Sciences stores the information you enter in the External Products view in the external product table (S_PROD_EXT). In addition, it also displays this information in the Competitor Comparison Administration view. For more information on the internal and external product tables, see “How Siebel Life Sciences Stores Product Information” on page 80.

**NOTE:** Make sure that the product information you specify in the External Products view matches exactly the information specified for the same product in the Products view. For more information, see “Defining Internal Products” on page 82.
To create an external product

1. Navigate to the Administration - Product screen > External Products view.
2. In the External Products list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competitor</td>
<td>Indicates whether or not the company specified in the Vendor field is a competitor. For more information on how to create account records, see “Specifying a Competitor” on page 64.</td>
</tr>
<tr>
<td>Product</td>
<td>If the product is also entered in the internal product table, the name entered here must match the name entered in the Product Administration view. For more information, see “Defining Internal Products” on page 82.</td>
</tr>
<tr>
<td>Product Type</td>
<td>Specifies whether the product is competitive or complementary.</td>
</tr>
<tr>
<td>Vendor</td>
<td>The manufacturer of this product.</td>
</tr>
</tbody>
</table>

Defining Internal Products

Use the Product Administration view to enter and update information about your company’s internal products, promotional items, competitive products, markets (therapeutic classes), and compounds under clinical trial. Siebel Life Sciences stores the information entered in this view in the internal product table (S_PROD_INT). For more information, see “How Siebel Life Sciences Stores Product Information” on page 80.

To create a new internal product, you create a new record in the Product Administration view. In creating a new internal product you specify:

- **Product categorization settings.** Use the values described in Table 11 on page 83 to categorize new products, or create market (therapeutic class) records.

- **Samples and promotional items settings.** Use the values described in Table 12 on page 84 to define samples and promotional items.

**NOTE:** If you plan on tracking products using lot numbers, create lot numbers for samples. For more information, see “Defining Lot Numbers for Samples” on page 138 or “Setting Up Lot Numbers for Medical Products” on page 369.
### Product Categorization Settings

You categorize products or create market (therapeutic class) records using the Product Administration field values described in Table 11.

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Product Level Field</th>
<th>Type Field</th>
<th>Inventory Field</th>
<th>Orderable Field</th>
<th>Sales Product Field</th>
<th>Sales Service Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Market (therapeutic class)</td>
<td>1</td>
<td>Market</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
</tr>
<tr>
<td>Detailed product.</td>
<td>2</td>
<td>Detail</td>
<td>Null</td>
<td>Null</td>
<td>Selected</td>
<td>Null</td>
</tr>
<tr>
<td>Product associated with call details, meetings, formularies, objectives, or opportunities</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Competitive product.</td>
<td>2</td>
<td>Competitor</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
</tr>
<tr>
<td>For more information, see &quot;About the External Product Table&quot; on page 80.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sample products disbursed on contact calls or account calls</td>
<td>3</td>
<td>Sample</td>
<td>Null if tracking by lot number</td>
<td>Selected</td>
<td>Selected</td>
<td>Null</td>
</tr>
<tr>
<td>Selected if tracking by product name</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Promotional item disbursed on contact calls or account calls</td>
<td>5</td>
<td>Promotional Item</td>
<td>Selected (if desired)</td>
<td>Selected</td>
<td>Null</td>
<td>Null</td>
</tr>
<tr>
<td>Equipment, medical, or surgical devices</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
<td>Selected</td>
<td>Selected</td>
<td>Null</td>
</tr>
<tr>
<td>Services</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
<td>Selected</td>
<td>Selected</td>
<td>Selected</td>
</tr>
<tr>
<td>Product configuration models</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
<td>Selected</td>
<td>Selected</td>
<td>Null</td>
</tr>
<tr>
<td>Product available for clinical trial</td>
<td>Null</td>
<td>Compound</td>
<td>Selected (if desired)</td>
<td>Null</td>
<td>Null</td>
<td>Null</td>
</tr>
</tbody>
</table>

1. If the product will be tracked by lot number, you must specify additional settings, as described in "About Samples and Promotional Items Settings" on page 84.
About Samples and Promotional Items Settings

The Food and Drug Administration (FDA) in the USA and similar agencies in other countries have regulations that stipulate that pharmaceutical samples disbursements must be tracked by lot number. However, it is not required that the actual samples inventory be tracked by lot number. Using Table 12:

- Locate a product type and description that matches the product you are creating.
- Configure the Inventory, Lot # Tracking, and Inventory by Lot fields using the values described in the last three columns.

For more information on defining lot numbers, see “Defining Lot Numbers for Samples” on page 138.

Table 12. (Pharmaceutical) Sample and Promotional Items Settings

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Description</th>
<th>Inventory Field (Product Administration View)</th>
<th>Lot # Tracking Field (Product Administration View)</th>
<th>Inventory by Lot Field (Lot Setup View)</th>
</tr>
</thead>
</table>
| Samples      | Full tracking by lot number:  
  - Samples disbursements tracked by lot number  
  - Samples inventory tracked by lot number  
  No tracking by product name. | Null | Selected | Selected |
| Samples      | Partial tracking by lot number:  
  - Samples disbursements tracked by lot number  
  - Samples inventory not tracked by lot number  
  No tracking by product name. | Null | Selected | Null |
| Samples      | Full tracking by product name:  
  - Samples disbursements tracked by product name  
  - Samples inventory tracked by product name  
  No lot number tracking. | Selected | Null | Null |
To create an internal product or a market

1. Navigate to the Administration - Product screen > Products view.

2. In the Products list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog #</td>
<td>Catalog number for a medical product.</td>
</tr>
<tr>
<td>Model #</td>
<td>Model number for a medical product.</td>
</tr>
</tbody>
</table>
**Managing Products for Life Sciences ▪ Defining Internal Products**

3. Click the Release button.
4. Drill down on the product.
5. Click the More Info view tab.
6. In the form, click the show more button and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the product, promotional item, or market (therapeutic class). If this product also exists in the external product table, this name must match the product name in the External Product Administration view. For more information, see &quot;Defining External Products&quot; on page 81. If this product will be tracked in inventory, either by product name or by lot number, include both the product name and the dosage (for example, Axis 2mg).</td>
</tr>
<tr>
<td>Part #</td>
<td>The part number of this product. If a product image will be displayed on a Web site created with Siebel Life Sciences portals, do not include spaces or special characters in the part number.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of product. For the recommended settings, see Table 11 on page 83. If this product also exists in the external product table, select Competitor so that the products will match up correctly.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;1 Barcode</td>
<td>This field is for Siebel Medical Handheld. Indicates that the product is labeled with more than one barcode.</td>
</tr>
<tr>
<td>Approval #</td>
<td>The approval number for a medical product given by the approval organization.</td>
</tr>
<tr>
<td>Approval Org</td>
<td>The authority who has approved a medical product, for example TÜV.</td>
</tr>
<tr>
<td>Barcode</td>
<td>This field is for Siebel Medical Handheld. Indicates the standard for the product barcode.</td>
</tr>
<tr>
<td>Doses/Unit</td>
<td>This field is for Adverse Events and Complaints Management.</td>
</tr>
<tr>
<td>Expression</td>
<td>This field is for Siebel Medical Handheld. This expression is used to generate unique asset numbers from the product’s barcode. It is a concatenation of the data descriptions for barcode items. For the example shown, if the expression is Lot Number, Serial Number, then the serial number and lot number portions of the barcode are the product’s unique asset numbers. These barcodes are provided in the Administration - Mobile screen &gt; Barcode Administration view.</td>
</tr>
</tbody>
</table>
### Managing Products for Life Sciences

#### Defining Internal Products

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>This field is for Adverse Events and Complaints Management. Indicates how many times each day the product is used.</td>
</tr>
<tr>
<td>Leaf Level</td>
<td>This field is for Siebel Medical Handheld. It is computed when the Capture Hierarchy button is clicked, and indicates that the product has no children in the product hierarchy. Only leaf-level products are physical products—products that can be purchased and inventoried. Products that are not leaf-level represent groups of products. For example, the Helix 15 mm Stent is a leaf-level product in the Stent group of products.</td>
</tr>
<tr>
<td>Lot # Tracking</td>
<td>Select this field if the product will be tracked by lot number, either for purposes of disbursement tracking or for inventory tracking. If you select this field:</td>
</tr>
<tr>
<td></td>
<td>■ You must define lot numbers for the product as described in Table 12 on page 84. For more information on defining lot numbers, see “Defining Lot Numbers for Samples” on page 138.</td>
</tr>
<tr>
<td></td>
<td>■ You should <em>not</em> check the Inventory field. This field is read-only if the Samples Lots Enabled system preference is set to FALSE. Only products of type Sample, Device, and Equipment can be tracked by lot number. To use lot number tracking for products of other types, see “Configuring Lot Numbers for Other Products” on page 100.</td>
</tr>
<tr>
<td>Inventory</td>
<td>Applies to products that will be tracked in inventory by product name rather than by lot number. If you check this field, you should <em>not</em> check the Lot # Tracking field. For more information, see Table 11 on page 83 and then Table 12 on page 84.</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>This field is for Adverse Events and Complaints Management.</td>
</tr>
<tr>
<td>Orderable</td>
<td>Select this field for any product or service that may be included in a samples order or in a sales order. For more information, see Table 11 on page 83.</td>
</tr>
<tr>
<td>OTC Product</td>
<td>This field is for Adverse Events and Complaints Management.</td>
</tr>
<tr>
<td>Parent Product</td>
<td>The parent products of this product within the product hierarchy. Products that are disbursed as samples should have a parent product. Parent products can be markets (therapeutic classes). Parent Product is a multivalue group that enables you to associate multiple parent product records. Ensure that you check the Primary flag when selecting the parent product. <strong>NOTE:</strong> For Siebel Medical Handheld, only the primary parent is considered. Other parent products are ignored.</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pre-1938</td>
<td>This field is for Adverse Events and Complaints Management.</td>
</tr>
<tr>
<td>Level</td>
<td>Enter the appropriate value according to your product hierarchy. For the recommended setting, see Table 11 on page 83. If this product also exists in the external product table, enter 2 so that the products will be matched up correctly. In Siebel Medical Handheld, this field is set when the hierarchy is captured. For more information, see “Capturing Product Hierarchies for Medical Handheld” on page 98.</td>
</tr>
<tr>
<td>Requires Approval</td>
<td>This field is for Siebel Medical Handheld. If this box is selected and if the Requires Approval field in the Inventory screen &gt; Inventory Locations view is set to Product, then customer approval (Handheld signature capture) is required when this product is taken from the corresponding inventory.</td>
</tr>
<tr>
<td>Rollup Level</td>
<td>This field is for Siebel Medical Handheld. It applies only to root-level products. (A root-level product is one that has no parent.) This field determines what levels of products are included in data rollup and also which levels of product appear in the inventories in the Medical Handheld application. For example, if Rollup Level is 3 for a product hierarchy that has six levels, the products at level 6, 5, 4, and 3 appear in Medical Handheld inventories. The root product (level 1) and its immediate children (level 2) do not appear.</td>
</tr>
<tr>
<td>Root</td>
<td>This field is for Siebel Medical Handheld. It is computed when the Capture Hierarchy button is clicked. This field indicates root product (the oldest ancestor) of the product’s hierarchy. For example, for a level-2 product, the Root field displays the product’s parent.</td>
</tr>
<tr>
<td>Route Used</td>
<td>This field is for Adverse Events and Complaints Management.</td>
</tr>
<tr>
<td>Sales Product</td>
<td>Check this field (and the Orderable field) for any product or service that your company actually sells (and will therefore be included in a sales order). For more information, see Table 11 on page 83.</td>
</tr>
<tr>
<td>Short Days</td>
<td>This field is for Siebel Medical Handheld. An asset or lot for this product is short dated this many days before expiration.</td>
</tr>
</tbody>
</table>
To make a product inactive

1. Navigate to the Administration - Product screen > Products view.
2. Drill down on the product that you want to make inactive.
3. Click the More Info view tab.
4. In the form, click the show more button and clear the following fields:
   - Product Level
   - Type
   - Lot # Tracking
   - Inventory
   - Orderable
   - Sales Product
   - Leaf Level

After end users synchronize with the server, they will not see the product in any drop-down list or dialog box. However, they will see the product listed in views that display products.
Specifying Additional Product Information

You can specify additional product information in the Product Administration view by drilling down on the product in the Products list, and then adding either Product Recommendations or Product Collateral.

Specifying Product Recommendations

Using the Recommendations view you can add related products, and recommended cross-sell and up-sell products to the product record.

To add related products to a product record
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on the required product.
3. Click the Recommendations View tab.
4. Click the Related Products link on the Recommendations tab.
5. In the Related Products list, create a new record.
6. In the Add Internal Products dialog box, select a related product, and click OK.
   The related product is added to the list.
7. Complete the remaining fields, including indicating the Integration Status, Effective End Date, and whether or not the product can be ordered.

Specifying Product Collateral

Using the Collateral view you can specify additional product features and product comparisons, associate product literature and images with the product, or add product news to the product record.

To specify additional product features
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on the required product.
3. Click the Collateral View tab.
4. Click the Key Features link on the Collateral View tab.
5. In the Feature list, create a new record, and complete the necessary fields.

To add product comparison information
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on the required product.
To associate related literature
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on the required product.
3. Click the Collateral View tab.
4. Click the Literature link on the Collateral View tab.
5. In the Product Literature list, create a new record.
6. In the Add Literature dialog box, select one or more records and click OK.
   The selected records are added to the Literature list.

NOTE: For more information on adding other selections to the Add Literature dialog box, see the chapter on literature administration in Siebel Applications Administration Guide.

To add images for a product
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on the required product.
3. Click the Collateral View tab.
4. Click the Images link on the Collateral View tab.
5. In the Images form, click the Select button in the Image File name field.
6. In the Images dialog box, query for and select the required image.
   The image is added to the product record.

NOTE: For more information on adding other selections to the Pick Product News dialog box, see the chapter on literature administration in Siebel Applications Administration Guide.

Defining Price Lists
You can use the Price List views to create and maintain an unlimited number of price lists for your products. Using these views, you can:

- Create and update price lists
- Define and update price list names and descriptions
- Create new records based on existing price lists
Managing Products for Life Sciences ■ Defining Price Lists

- Associate products with price lists
- Enter pricing information (such as effective date, terms, and shipping information)

To create a price list
1. Navigate to the Administration - Pricing screen > Price List view.
2. In the Price Lists, More Info form, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency</td>
<td>The currency for this price list. The values that appear in the Pick Currency Code dialog box are defined in the Application Administration, Currency view.</td>
</tr>
<tr>
<td>Name</td>
<td>The name for the price list.</td>
</tr>
<tr>
<td>Payment Terms</td>
<td>The payment terms of the price list. The values that appear in the Pick Payment Terms dialog box are defined in the Application Administration, Payment Term view.</td>
</tr>
<tr>
<td>Shipping Method</td>
<td>The shipping method for products associated with this price list.</td>
</tr>
<tr>
<td>Shipping Terms</td>
<td>The shipping terms for products associated with this price list.</td>
</tr>
</tbody>
</table>

3. Click the Price List Line Items view tab.
4. In the Price List Line Items list, create a new record, and complete the necessary fields. The products that appear in the Name field and the Add Internal Products dialog box are defined in the Product Administration view. For more information, see “Defining Internal Products” on page 82.

To associate a price list with a product
1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, drill down on a product.
3. On the lower link bar, click Price Lists.
4. In the Product List list, create a new record and select the price list.

For more information on adding other selections to the Add Price Lists dialog box, see “Defining Price Lists” on page 91.

**NOTE:** You can also associate images with products so that the images appear in the Products. For more information, see the chapter on basic product administration in Siebel Product Administration Guide.
Managing Competitor Information

Effective sales and marketing requires that your company have up-to-date and consistent information about the competitive landscape. This topic describes how to administer information about competitors and competitive products.

Tracking competitor information in Siebel Life Sciences involves the following steps:

- Creating account records for competitors and selecting the Competitor field. For more information, see “Specifying a Competitor” on page 64.
- Creating records for competitors’ products. For more information, see “Defining External Products” on page 81.
- Adding comparative and competitive literature files to the application. For more information, see the chapter on literature administration in Siebel Applications Administration Guide.

To administer competitor information you must:

- Define company features and product features that can be used to compare your company and its products with those of your competitors. For more information, see the procedures “To define company features” on page 93 and “To define product features” on page 93.
- Enter information about competitive products, product and company comparisons, and competitive and comparative literature. For more information, see the procedure “To enter competitor comparison information” on page 94.

To define company features

1. Navigate to the Competitors screen > Company Features Administration view.
2. In the Company Features list, create a new record, and complete the necessary fields.

To define product features

1. Navigate to the Administration - Product screen > Product Features view.
2. In the Product Features list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The category in which this product feature is classified.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Select the product line of which this product is a part.</td>
</tr>
<tr>
<td>Name</td>
<td>The product feature criterion; for example, Once a Day Formulation.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the feature, if necessary.</td>
</tr>
</tbody>
</table>
To enter competitor comparison information

1. Navigate to the Competitors screen > Competitor Administration view.

   The Competitors list appears.

   This list displays every account flagged as a competitor. Note that the Competitor Flag field is checked for every record. For more information on creating competitors, see "Specifying a Competitor" on page 64.

2. In the Competitors list:
   - Select a competitor.
   - Optionally, enter the competitor’s World Wide Web address (URL) in the Home Page field.

3. In the Company Comparison list, create a new record, and complete the necessary fields.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>The features listed in the Add Competitive Company Features dialog box are defined in the Company Feature Administration view. For more information on adding company features, see &quot;To define company features&quot; on page 93.</td>
</tr>
<tr>
<td>Rank</td>
<td>Enter the numeric rank of the feature as defined by your business process.</td>
</tr>
</tbody>
</table>

Defining Decision Issues

Contacts often raise important issues during a call. Decision issues are the objections a contact may raise when evaluating a product prior to making a prescribing decision. Often these objections are related to the efficacy of the product, its pharmacological properties, the recommended dosage, its safety profile, drug interactions, competitor’s claims, product availability, price and generic substitution.

Using the Decision Issues Administration view, you can:

- Create and edit decision issues within the application
- Enter explanations about specific decision issues and provide instructions to representatives in the field on how to discuss them
- Associate literature and related issues with decision issues

Sales representatives can then use this information to prepare for calls on contacts and accounts. They can also associate decision issues with particular calls, indicating which issues are of concern to particular contacts.

**NOTE:** Before you can use the procedures described in this topic, you must first add set up categories. (For general information about setting up categories, see the *Siebel Order Management Guide*.)
To create a decision issue

1. Navigate to the Administration - Data screen > Decision Issues view.
2. In the form, create a new record, and complete the necessary fields.
3. Click the Decision Issues Categories view tab.
4. Add records to the list.
   The categories determine which users can see and select the decision issue. Users must have access to at least one of the categories in order to see the decision issue.
5. (Optional) Add literature to the decision issue:
   a. Click the Literature view tab.
   b. Add literature records to the list.
6. (Optional) Add related issues to the decision issue:
   a. Click the Related Issues view tab.
   b. Add decision issue records to the list.
   Only decisions issues that belong to categories to which you have visibility can be added.

Adding Products to Catalogs

When simple and complex products have been created, administrators must add catalog visibility to these products. Starting with Siebel Life Sciences version 7.0.3, products—including samples and promotional items—and lot numbers need to be associated with catalogs to determine drop-down list visibility. Product catalogs may be assigned to groups of people to control which users may access the products. By adding catalog visibility to products, you allow them to be accessed by different groups of people in your company.

You can further subdivide catalogs into product categories. For example, when you create a catalog, you might want to create a Catalog for cancer drugs and further subdivide this into categories with the same active ingredients.

When creating catalogs, you can also provide effective start and end dates for the categories associated with the catalog. This may be useful if you are providing particular products only at particular times in a clinical trial, for example.

To give a product catalog visibility, you must do the following:

- Creating the Product Catalog on page 96
- Creating a Product Category on page 96
- Adding Products to Catalogs and Categories on page 97
- Adding Access Groups to Catalogs and Categories on page 97

For more information about product catalogs and categories, see Siebel Order Management Guide.

For more information about access groups, see Siebel Security Guide.
Creating the Product Catalog

The following procedure details how to create a product catalog.

To create a product catalog

1. Navigate to the Administration - Product screen > Product Catalog list.
2. In the Product Catalog list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the new catalog.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the catalog.</td>
</tr>
<tr>
<td>Effective Start Date,</td>
<td>The date range between which the catalog is effective.</td>
</tr>
<tr>
<td>Effective End Date</td>
<td></td>
</tr>
</tbody>
</table>
| Private                      | Select this check box if you want the catalog to be visible only to users
                              | belonging to the access groups associated with it. If the catalog is     |
                              | private, all of its categories will also be private.                     |
| Active                       | Select this check box if the category is active.                          |
| Sequence                     | The sequence of this catalog in the list.                                |

Creating a Product Category

You can further group products into product categories under catalogs.

To create a product category

1. Navigate to the Administration - Product screen > Product Catalog list.
2. In the Product Catalog list, query for and select the required catalog.
3. Drill down on the link in the Name field.
   The Categories view appears.
4. In the Categories list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the new category.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The display name for the category in drop-down lists.</td>
</tr>
</tbody>
</table>
Create new product categories and subcategories as required, and indent the new categories under the original catalog to create a category hierarchy if required.

Adding Products to Catalogs and Categories

After you have created product catalogs and categories, you can add products to them.

To add products to catalogs and categories
1. Navigate to the Administration - Product screen > Product Catalog list.
2. In the Product Catalog list, query for and select the required catalog.
3. Drill down on the link in the Name field, and select the required category in the Categories list.
4. Scroll down, click the Categories view tab, and then click the Products link.
5. In the Products list, create a new record.
6. The Add Internal Products selection dialog box is displayed.
7. Query for and select the required product, and click OK.
   Most of the fields are populated when the product has been selected.
8. If necessary, enter the sequence in which the products added are to be displayed.

Adding Access Groups to Catalogs and Categories

When you have added products to catalogs and categories, you may add access groups to make the products visible to the required groups of people.
To add access groups to a catalog
1. Navigate to the Administration - Product screen > Product Catalog list.
2. In the Product Catalog list, query for and select the required catalog.
3. Drill down on the link in the Name field, and then click the Access Groups view tab.
4. In the Access Groups list, create a new record.
   The Add Access Groups selection dialog box is displayed.
5. Query for and select the required access group, and click OK.
   The remaining fields are populated when the required access group is chosen.

To add access groups to a category
1. Navigate to the Administration - Product screen > Product Catalog list.
2. In the Product Catalog list, query for and select the required catalog.
3. Drill down on the link in the Name field, and expand the catalog name to select the required category in the Categories list.
4. Click the Categories view tab, and then click the Access Groups link.
5. In the Access Groups list, create a new record.
   The Add Access Groups selection dialog box is displayed.
6. Query for and select the required access group, and click OK.
   The remaining fields are populated when the required access group is chosen.

Capturing Product Hierarchies for Medical Handheld
To appear in a Medical Handheld inventory detail view, a product must belong to a product hierarchy that has been captured. The following procedure describes how to capture a product hierarchy.

NOTE: Remember to recapture the hierarchy after editing the relationships between products.

To capture a product's hierarchy
1. Navigate to the Administration - Product screen > Products view.
2. Select the root products whose hierarchies you want to capture.
   If you select a product that is not a root, that product is ignored. A dialog box lists these ignore records.
3 Click Capture Hierarchy.

This prepares the product data so that it can be used by Medical Handheld application to track inventory. It sets Root, Level, and Leaf Level fields based on the product relationships defined by the primary parent product.

### Viewing Product Information (End User)

The views in the Products screen allow end users to view lists of products and obtain information such as prices, key features, and product defects. The Siebel administrator is responsible for entering information on products, product issues, price lists, and other information displayed in the Products views.

**To view product information**

1. Navigate to the Products screen > Internal Product List view.
2. In the Products list, drill down on a product.
3. Click a view tab.
   - **NOTE:** To view hidden view tabs, scroll to the right.

### Creating a Product Change Request (End User)

End users who receive information about a product change request that has not already been entered in the system, can create a product change request.

**To create a product change request record**

1. Navigate to the Products screen > Internal Product List view.
2. In the Products list, drill down on a product.
3. Click Change Requests.
4. In the Change Requests list, create a new record.
5. In the Add Change Request dialog box, click New.
   - The application adds a new record to the Change Requests list.
6. In the Change Requests list:
   - Enter a description in the Summary field.
   - Select the type of request in the Type field.
   - Drill down on the Change Request hyperlink.
   - The Change Request form appears.
7 In the Change Request form, complete the necessary fields.

**Configuring Lot Numbers for Other Products**

In the preconfigured application, only products of type Sample, Device, and Equipment can be tracked by lot numbers.

**To enable lot number tracking for other types of product**

- Use Siebel Tools to edit the Lot Tracking Product Types user property of the Internal Product business component.

  For information about the Lot Tracking Product Types user property, see Table 13.

  For more information on editing user properties, see *Configuring Siebel Business Applications* and *Using Siebel Tools*.

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot Tracking Product Types</td>
<td>,ProductType1,ProductType2,ProductType3,..., ProductType</td>
<td>Enables lot tracking for specified product types.</td>
</tr>
<tr>
<td></td>
<td>,ProductType is the Language Independent Code (LIC) for the product type you want to track with lot numbers.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Value must start and end with a comma and have no spaces between LICs.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Example: ,Sample,Equipment,Device,</td>
<td></td>
</tr>
</tbody>
</table>
7 Planning Calls in Pharma

This chapter covers the following topics:

- "About Planning Calls in Pharma" on page 101
- “Tools for Planning Calls” on page 102
- “Scenario 1: Users Set Up Personal Lists” on page 103
- “Scenario 2: Users Create Target Lists” on page 103
- “Scenario 3: Users Define Route Plans” on page 104
- “Scenario 4: Users Create Activities” on page 105
- “Process of Planning Calls” on page 106
- “Creating a Personal List (End User)” on page 106
- “Creating and Applying Target Lists (End User)” on page 107
- “About Defining a Route Plan (End User)” on page 108
- “Creating a Route (End User)” on page 109
- “Adding Accounts to a Route (End User)” on page 110
- “Using a Route to Schedule Calls (End User)” on page 112
- “About Creating Activities” on page 112
- “Creating a General Activity (End User)” on page 113
- “Creating a General Activity in the Calendar (End User)” on page 114
- “Setting Up a Meeting (End User)” on page 115
- “Creating a Contact Call (End User)” on page 117
- “Creating an Account Call (End User)” on page 119
- “About Features for Call Planning Specific to the Japanese Pharmaceutical Market” on page 122
- “Managing the PMS and Pre-Explain PMS Features” on page 123
- “Managing the PID Feature” on page 126

About Planning Calls in Pharma

This chapter describes the tools available in Siebel Life Sciences to plan account and contact calls. For more information on recording account and contact calls, see Chapter 9, “Recording Calls in Pharma.”
Using the procedures given in this chapter end users can add products to personal lists, create and apply target lists, define route plans, create activities, set up meetings, and schedule calls.

Tools for Planning Calls

Siebel Life Sciences offers end users the following tools for planning their account calls:

- **Personal Lists.** For more information, see “Personal Lists” on page 102.
- **Targeting.** For more information, see “Targeting” on page 102.
- **Routes.** For more information, see “Routes” on page 102.
- **Activities.** For more information, see “Activities” on page 103.

Personal Lists

Personal lists allow for faster call reporting by limiting the number of products that appear in drop-down lists. Before end users can record call details, they must configure personal lists of the products they detail, the products they distribute as samples, and the products they provide as promotional items. For more information on personal lists, see the scenario “Scenario 1: Users Set Up Personal Lists” on page 103 and “Creating a Personal List (End User)” on page 106.

Targeting

Targeting using Global Target List Management is an extension of querying. In targeting, end users save the results of queries in a target list and then apply those saved lists to other views within the system. In Siebel Life Sciences, a target list can be a set of contacts or accounts and can be applied to any view that contains contacts or accounts.

Using the account and professional targeting list views in the List Management screen, users can create advanced queries on contacts and accounts. Users can apply target lists to views individually or in combination with other target lists. If combining multiple target lists, users have the option of applying an intersection or a union of the lists. For more information on targeting, see the scenario “Scenario 2: Users Create Target Lists” on page 103 and “Creating and Applying Target Lists (End User)” on page 107.

Routes

End users can create routes to schedule regular calls to groups of accounts. By defining a route, a user can plan the order in which to visit accounts and then determine a starting time for each account call. By arranging a group of accounts into an efficient route, users can minimize the amount of time spent traveling between accounts. After a route has been created, it can be used repeatedly to schedule future account calls. For more information on routes, see the scenario “Scenario 3: Users Define Route Plans” on page 104 and “About Defining a Route Plan (End User)” on page 108.
Activities
An activity is a scheduled task or event. Activities represent the ways in which users spend their time. Although activities are typically performed or planned for opportunities, contacts, or accounts, they can also be personal tasks that users want to track. For more information on activities, see the scenario “Scenario 4: Users Create Activities” on page 105 and “About Creating Activities” on page 112.

All activities with valid dates and times appear in the Calendar views as well as in the Activities views. The views in the Calendar screen provide a visual representation of each user’s scheduled activities and appointments. For more information using the calendar, see “Creating a General Activity in the Calendar (End User)” on page 114.

Contact and Account Calls
Contact and account calls are a type of activity record. Although users create contact calls in the Contact screen, they actually record calls details in the Activities screen. For more information on scheduling calls, see “Creating a Contact Call (End User)” on page 117 and “Creating an Account Call (End User)” on page 119. For information on recording calls, see Chapter 9, “Recording Calls in Pharma.”

Scenario 1: Users Set Up Personal Lists
This scenario describes how end users set up and configure their personal lists. Your company may follow a different process according to its business requirements.

Personal lists determine which products appear in various Name drop-down lists in Siebel Life Sciences. For more information, see “Personal Lists” on page 102.

A sales representative has recently joined a pharmaceutical company that uses Siebel Life Sciences in the field. During her sales training, the representative’s sales manager tells her that before she can record calls within the system, she must first set up her personal lists. The sales manager explains that personal lists allow for faster call reporting by limiting the number of products that appear in the application’s Name drop-down lists. The sales manager then demonstrates how to add products to the sales representative’s Call Products Detailed, Samples Dropped, and Promotional Items Dropped views. Following her manager’s instruction, the sales representative updates all her personal lists and is ready to record call details.

The process for this scenario comprises two end-user procedures:

- **Configure personal lists.** For more information, see “Creating a Personal List (End User)” on page 106.
- **Record contact and account calls.** For more information, see Chapter 9, “Recording Calls in Pharma.”

Scenario 2: Users Create Target Lists
This scenario describes how end users use targeting to create lists of contacts and accounts. Your company may follow a different process according to its business requirements.
A sales representative for a pharmaceutical company has just been assigned a new territory. As a first step in becoming more familiar with her territory, she queries her contacts and accounts and creates target lists of the following information:

- Contacts located within specific postal codes, bricks, or cities with NRx (new Rx) in Product A greater than 100 over the last two months
- The highest-potential contacts in a given postal code or city with a Best Time To Call setting that includes noon to 1:00 p.m. on Tuesdays (useful if a lunch appointment cancels)
- Accounts with sales in Product B greater than $60,000 over the last half-year that are available for calls on Monday afternoons, located within a specific range of postal codes, and last seen over five weeks ago
- Accounts or contacts with high ratings in a product’s therapeutic class but low ratings in a specific product

Once she has saved these target lists, she can apply them to other views within the application.

The process for this scenario comprises two steps:

1. **Create and save a target list.** For more information, see “To create a target list from the List Management screen” on page 108.

2. **Apply target lists to other views.** For more information, see the Siebel Applications Administration Guide.

---

**Scenario 3: Users Define Route Plans**

This topic illustrates how end users can use the Routes views to group accounts by location and then use that information to schedule calls. It also describes how sales managers can create routes and schedule calls for the sales representatives they manage.

Your company may follow a different process according to its business requirements.

**Sales Representative Creates Routes to Schedule Account Calls**

A sales representative for a pharmaceutical company needs to plan his account call schedule. Because he always visits the same accounts in the same order, he decides to organize his accounts into routes so that he can efficiently schedule all account calls.

He begins by dividing up his accounts into specific geographic areas. Then, he creates a four-day route that includes all accounts in the outlying portions of his sales territory. In addition to specifying which accounts fall into what routes, he defines additional details such as the starting time and the duration of each call. Once all routes have been defined, he schedules calls to all accounts in his territory for the upcoming month.

**Sales Manager Creates Routes for New Direct Report**

A sales manager for a pharmaceutical company manages 10 sales representatives. One of her representatives, a new employee, is not familiar with his territory. To help her new representative get up-to-speed, she organizes the new representative’s accounts into a series of routes.
Planning Calls in Pharma ■ Scenario 4: Users Create Activities

Each route is divided into sections and will be visited every two weeks. The sales manager creates 10 routes: one for each workday in a two-week period. Each route includes multiple accounts in the same neighborhood. Once the sales manager has finished creating the routes, she uses them to schedule a month’s worth of account calls for her new sales representative.

Once her new direct report becomes familiar with his territory, she gives him the responsibility of maintaining and updating his routes. The new sales representative can then add new accounts to a route, change the order in which routes are visited, or adjust the start time and duration of each visit.

The process for this scenario comprises four procedures:

1. **Create a route.** For more information, see “To create a route” on page 109.
2. **Add accounts to a route.** For more information, see “To add accounts to a route using the Accounts view tab” on page 110.
3. **Schedule account visits using routes.** For more information, see “Using a Route to Schedule Calls (End User)” on page 112.

**Scenario 4: Users Create Activities**

This scenario describes how end users use activities to manage their own time, keep their manager informed of their workload, and track their expenses. Your company may follow a different process according to its business requirements.

Typically activities are performed or planned for opportunities, contacts, or accounts, but they can also be used to track personal tasks. Consider the following example.

A sales manager for a pharmaceutical company wants to review her schedule. She uses the Activities screen to create, categorize, and track all the activities on which she plans to spend her time during the next month.

From the My To Do List view, she prints a report detailing her current activities, their due dates, and all pertinent account information. Remembering she wants to meet with each of her direct reports in the next two weeks, she prints a report summarizing all the calls her team has made over a 20-week period. Then, she schedules meeting with each of her direct reports to discuss their sales goals for the next quarter. Finally, she schedules a contact call with a prominent customer whose regular sales representative is on a long leave. Then, she reviews the Calendar screen to review her schedule for the upcoming weeks.

**NOTE:** End users also use the Activities screen to record and submit details of Contact and Account Calls. For more information, see Chapter 9, “Recording Calls in Pharma.”

The process for this scenario comprises four procedures:

1. **Create general activities.** For more information, see “About Creating Activities” on page 112.
2. **Create contact or account call.** For more information, see “Creating a Contact Call (End User)” on page 117 and “Creating an Account Call (End User)” on page 119.
3. **Set up a meeting.** For more information, see “Setting Up a Meeting (End User)” on page 115.
4. **View activities and create new activities on the Calendar screen.** For more information, see “Creating a General Activity in the Calendar (End User)” on page 114.
Process of Planning Calls

This topic details sample tasks often performed by end-users when planning calls. Your company may follow a different process according to its business requirements.

The following list shows tasks end users typically perform when planning contact and account calls:

- (Optional) "Scenario 2: Users Create Target Lists" on page 103. Using target lists users can query for accounts or contacts and then apply those lists to other views within the application.
- (Optional) "Scenario 3: Users Define Route Plans" on page 104. Route plans are groups of accounts sorted by location. Once created, users can use route information to schedule calls.
- (Optional) "Scenario 4: Users Create Activities" on page 105. Activities allow users to manage their own time, keep their manager informed of their workload, and track expenses.
- "Creating a Contact Call (End User)" on page 117.
- "Creating an Account Call (End User)" on page 119.

**NOTE:** After end users set up their personal list, they can record calls. For more information, see "Recording and Submitting Contact Calls" on page 168 and "Recording and Submitting Account Calls" on page 172.

Creating a Personal List (End User)

Personal lists determine which products appear in the drop-down lists of the Call Products Detailed, Samples Dropped, and Promotional Items Dropped views. End users must specify at least one product in a personal list or the corresponding drop-down list will be empty when they try to enter call details. For more information on recording calls, see Chapter 9, "Recording Calls in Pharma."

Setting up personal lists is a one-time setup procedure. Once end users have completed it, they do not need to repeat it. However, they can revise their personal lists at any time, deleting or adding products as necessary. For more information on personal lists, see "Personal Lists" on page 102 and the scenario "Scenario 1: Users Set Up Personal Lists" on page 103.

**To add a product to a personal list**

1. Navigate to the Activities screen > Personal List view.
2. From the Show drop-down list, select one of the following:
   - **Personal Details List.** Adds products to the Personal Details List.
   - **Personal Samples List.** Adds products to the Personal Samples List.
   - **Personal Promotional Items List.** Adds products to the Promotional Items List.
3 In the appropriate list, create a new record, and complete the necessary fields.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The products being detailed during contact and account calls. This field appears in the Product Details List.</td>
</tr>
<tr>
<td>Sample</td>
<td>The products to be dropped as samples during contact and account calls. This field appears in the Personal Samples List.</td>
</tr>
<tr>
<td>Promotional Item</td>
<td>The promotional items being dropped during contact and account calls. This field appears in the Personal Promotional Items List.</td>
</tr>
</tbody>
</table>
| Order          | Enter a number that indicates where this product should appear in the drop-down list. This field appears in the Product Details List, Personal Samples List, and Personal Promotional Items List.  
    For example, if you want a product in the Product Details List to appear first, enter 1. If this field is null for all products in the list, the products will appear in alphabetical order. If this field is null for some products but not for others, records with a null Order field appear at the beginning of the list, in alphabetical order. |

4 Complete this procedure for each of the views:
- Personal Details List view
- Personal Samples List view
- Personal Promotional Items List view

Creating and Applying Target Lists (End User)

Targeting is an extension of querying. In targeting, end users save the results of queries in a target list and then apply those saved lists to other views within the application. A target list typically consists of contacts or accounts and can be applied to various views and dialog boxes that contain lists of contacts or accounts.

For general information about creating and applying target lists, see the Siebel Applications Administration Guide.

This topic describes how to create target lists using the account and professional targeting list views, which are unique to the Siebel Life Sciences application. These views present data such as best times to call, and prescriber habits that sales representatives typically want to query when creating their contact and account target lists.
To create a target list from the List Management screen

1. Navigate to one of the following views:

<table>
<thead>
<tr>
<th>View</th>
<th>Navigate to the List Management screen then</th>
<th>To create lists of</th>
<th>Based on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Profile</td>
<td>In the link bar, click Professional Targeting List.</td>
<td>Contacts</td>
<td>Rx consumption</td>
</tr>
<tr>
<td>Contact Attributes</td>
<td>In the link bar, click Professional Targeting List.</td>
<td>Contacts</td>
<td>Best times to call, ranking and rating</td>
</tr>
<tr>
<td></td>
<td>In the visibility filter, select Account Attributes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account Profile</td>
<td>In the link bar, click Account Targeting List.</td>
<td>Accounts</td>
<td>Profile data such as number of physicians, call frequency, and market share</td>
</tr>
<tr>
<td>Account Attributes</td>
<td>In the link bar, click Account Targeting List.</td>
<td>Accounts</td>
<td>Best times to call and sales data</td>
</tr>
<tr>
<td></td>
<td>In the visibility filter, select Account Attributes.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Run a query in the view.
3. Review the query results in the list.
4. When the list of contacts or accounts contains the records you want to save as a target list, click the Save Target List button.

**NOTE:** The saved target list includes only those records that matched the query criteria *when the query was generated*. You should re-create your target lists periodically because data may have been modified or new contacts or accounts may have been added since you created the target list. For example, you must re-create your target lists after a territory realignment.

About Defining a Route Plan (End User)

End users can create routes to schedule regular calls to groups of accounts. By defining a route, a user can plan the order in which to visit accounts and determine a starting time for each account call. For more information, see “Routes” on page 102 and the scenario “Scenario 3: Users Define Route Plans” on page 104.

When creating a route, users must complete the following tasks in the order listed:

- **Create a route.** Users must specify the person for whom they are creating the route. Although each user can be assigned multiple routes, each route can only be assigned to one user. For more information, see “To create a route” on page 109.
- **Add accounts to a route.** Once users have established a route, they can add accounts to it.
(Optional) Assign a target list to a route. If users are using the Account Targeting features to create target lists, they can assign them to a route using the Target Accounts view.

Schedule calls. When a route has been created, users can use it to schedule calls to every account in the route. For more information, see “To schedule calls from the My Routes view” on page 112

Creating a Route (End User)

When creating a route, users must specify the person for whom they are creating the route (generally a field sales manager or sales representative). When creating a route remember that:

- Each user can be assigned many routes
- A route can have any number of accounts
- A route can only be assigned to one user
- A route name can only be used once for each user
- The same route name can be used for routes assigned to different users

To create a route

1. Navigate to the Routes screen.
2. In the Routes form, create a new record, and complete the necessary fields.

   **NOTE:** In the My Routes view, the Sales Person field is automatically filled with the current user name. If you are assigning a route to someone other than yourself, enter that person’s name in the Sales Person field.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Select this field if the route is active and available for use in scheduling calls.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The application automatically populates this field with the time and date the route was last changed.</td>
</tr>
<tr>
<td>Route Name</td>
<td>A user-defined name for the route, such as Northeast Richmond. A route name must be unique to the end user to which it is assigned.</td>
</tr>
<tr>
<td>Sales Person</td>
<td>The sales person to whom the route is assigned. A route can be assigned only to one person.</td>
</tr>
<tr>
<td>Start Day</td>
<td>The day of the week on which the route is designated to begin. This is used as reference information only and does not prevent you from using the route to schedule calls starting on some other day of the week.</td>
</tr>
<tr>
<td>Updated By</td>
<td>The application automatically populates this field with the name of the user who last changed the route.</td>
</tr>
</tbody>
</table>
Adding Accounts to a Route (End User)

Once users have established a route, they can add accounts to it. There is no limit to the number of accounts that can be assigned to one route. Three views are available for adding accounts to routes:

- **Accounts view tab.** Shows accounts associated with the selected routes. For more information, see “To add accounts to a route using the Accounts view tab” on page 110.
- **Explorer view tab.** Shows routes and accounts in a hierarchical format. For more information, see “To add accounts to a route using the Explorer view tab” on page 110.
- **Target Accounts view tab.** Shows all accounts and allows you to choose which you want to add to the selected route. For more information, see “To add accounts to a route using the Target Accounts view tab” on page 111.

**To add accounts to a route using the Accounts view tab**

1. Navigate to the Routes screen.
2. In the Routes list, drill down on a route.
3. Click the Accounts view tab.
4. In the Accounts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Only accounts where the user is on the coverage team can be added.</td>
</tr>
<tr>
<td>Call Duration</td>
<td>The scheduled duration of the account call.</td>
</tr>
<tr>
<td>Call Time</td>
<td>The application automatically enters the current time in this field. Edit the value to reflect the time at which the account is to be visited.</td>
</tr>
<tr>
<td>Last Call</td>
<td>Identifies the date and time of the most recent call to this account.</td>
</tr>
<tr>
<td>Offset Day</td>
<td>Allows you to create routes that span more than one day. Indicates the number of days after the beginning of the route that an account should be visited. For example, if an account is to be visited on the first day of a route, this field should be set to 0. If the account is to be visited on the second day of a route, this field should be set to 1.</td>
</tr>
</tbody>
</table>

5. Repeat Step 4 on page 110 until all accounts have been added to the Accounts list.

**To add accounts to a route using the Explorer view tab**

1. Navigate to the Routes screen.
2. In the Routes list, drill down on a route.
3. Click the Explorer view tab.
4. In the Routes explorer tree, click the plus sign next to the route to which you want to add an account.

5. Click the plus sign next to the Accounts folder displayed under the route. A list of all the accounts assigned to the route appears.

6. In the Accounts list, create a new record for the account you want to add to the route and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Duration</td>
<td>The scheduled duration of the account call.</td>
</tr>
<tr>
<td>Call Time</td>
<td>The application automatically enters the current time in this field. Edit the value to reflect the time at which the account is to be visited.</td>
</tr>
<tr>
<td>Last Call</td>
<td>Identifies the date and time of the most recent call to this account.</td>
</tr>
<tr>
<td>Offset Day</td>
<td>Allows you to create routes that span more than one day. Indicates the number of days after the beginning of the route that an account should be visited. For example, if an account is to be visited on the first day of a route, this field should be set to 0. If the account is to be visited on the second day of a route, this field should be set to 1.</td>
</tr>
</tbody>
</table>

7. Repeat Step 6 on page 111 for each account you want to add.

**To add accounts to a route using the Target Accounts view tab**

**NOTE:** When associating a target account with a route, only select accounts where the owner of the route is represented on the sales team. It is possible to pick any existing account in the database when associating a target account with a route. However, there is no check to determine whether you or the owner of the route has access to the account.

1. Navigate to the Routes screen.
2. In the Routes list, drill down on a route.
3. Click the Target Accounts view tab.
4. Select the accounts to add to the route.
   One way to select the accounts is to apply a target list and select the accounts in the list.
5. Click Commit.
Using a Route to Schedule Calls (End User)

After a route has been created, end users can use it to schedule calls to all the listed accounts. Users can schedule route calls from a number of views. The following procedures demonstrate how to schedule routes from the My Routes view, the Target Accounts view, and the Daily Calendar view.

**To schedule calls from the My Routes view**

1. Navigate to the Routes screen.
2. In the form, click Schedule.
3. In the dialog box, enter a start date and click OK.

   Appointments for each account in the route are created in the calendar of the end user to whom the route is assigned.

   **CAUTION:** It is possible to schedule multiple appointments for the same time period when using the Routes views to schedule calls. Such scheduling conflicts do not trigger any sort of automatic notification. Sales representatives should check the Daily Calendar view for possible conflicts after routes have been added to their schedules. If scheduling conflicts exist, they should adjust the starting times of appointments or delete them as necessary to resolve the conflicts.

**About Creating Activities**

End users use general activities to manage their own time and keep their manager informed of their workload. Managers can also create general activities and assign them to members of their teams. The kinds of activities that end users can create in Siebel Life Sciences include:

- **General.** Used to track non-call and non-meeting tasks such as to-do items, personal events, and correspondence. Users can create an alert for a general activity to remind them of significant tasks or events.

- **Contact call.** Used to track a planned or past call activity with a contact. Users can record details about contact calls such as the products detailed, the samples and promotional items dropped, and decision issues discussed. Before users can record details about a contact call, they must set up their personal lists. For more information, see “Creating a Personal List (End User)” on page 106.

- **Account call.** Used to track a planned or past call activity at an account. Users can record products detailed, attendees, promotional items dropped, and decision issues discussed. For more information, see Chapter 9, “Recording Calls in Pharma.”

- **Meeting.** Used to track meetings, such as a "lunch-and-learn" or a symposium, designed to increase sales through product awareness. A meeting typically involves one or more speakers who give presentations in support of one or more products. For more information, see "Setting Up a Meeting (End User)” on page 115.
Planning Calls in Pharma ■ Creating a General Activity (End User)

Time off territory. Used to track blocks of time that users spend on activities not directly associated with an account or contact. Examples of time off territory can include field training sessions, national sales meetings, vacations, or personal activities such as doctor's appointments. For more information on working with time off territory activities, see Chapter 14, “Tracking Time Off Territory.”

MedEd activity. Used to track and plan medical education events such as a “lunch-and-learn” meetings or seminars. A MedEd event is similar to a meeting activity, but offers planning, budgeting, and cost aggregation functionality. MedEd activities are only associated with the separate Siebel MedEd module. For more information, see “Process of Managing MedEd Events” on page 233.

Subject activities. Used to track subject activities for a protocol. Subject activities are generated by applying the visit template based on the screening or enrollment date. Visit activities can also be created for a non-scheduled visit. For more information, see “Creating a Subject and Setting Up Visits and Visit Activities (End User)” on page 303.

Clinical protocol site activities. Used to track the activities associated with initiating the protocol sites, for example, collecting the essential documents. For more information, see “Creating Site Activity Plans (End User)” on page 321.

Checklist activities. Used to provide a checklist for clinical research associates (CRAs) to check activities associated with visiting a protocol site. Once a trip report record has been created, checklist activities are generated by selecting a trip report template. Checklist activities specific to a trip report can also be created for a trip report from the Trip Report Details view. For more information, see “Selecting a Trip Report Template Before a Site Visit (End User)” on page 341.

Follow-up activities. Used to record follow-up issues for a trip report. Users can create a follow-up activity to a trip report from the Trip Report Details view. Only the follow-up activities with open status are listed in a Follow-up Activities report generated from the Reports menu. For more information, see “Selecting a Trip Report Template Before a Site Visit (End User)” on page 341.

Project Activities. Used to track activities associated with clinical projects. These activities appear in the Projects screen and the Activities screen and can be created by project activity templates. For more information, see “Creating Activities and Tasks for a Project (End User)” on page 353.

For more general information on activities, see “Activities” on page 103 and “Scenario 4: Users Create Activities” on page 105.

NOTE: End users also use the Activities screen to record and submit details of contact and account calls. For more information, see Chapter 9, “Recording Calls in Pharma.”

Creating a General Activity (End User)

End users use general activities to manage their own time and to keep their manager informed of their workload. Managers can also create general activities and assign them to members of their teams.

To create a general activity

1. Navigate to the Activities screen > Activity List view.
2 Create a new record and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>The length of time, in minutes, that you expect the activity to take.</td>
</tr>
<tr>
<td>Employees</td>
<td>Delegate the activity to someone else. Select the appropriate employee and click OK. If you delegate an activity this way, the activity appears in the My Delegated Activities view.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of activity. If you select Alert, the activity appears in the My Alerts view. The values displayed in this drop-down list depend on the value of the Activity field. For example, the activity types that you can select for a contact call are different from those that you can select for a general activity.</td>
</tr>
</tbody>
</table>

Creating a General Activity in the Calendar (End User)

The views in the Calendar screen provide visual representations of a user’s scheduled activities, or appointments; that is, activities with a start time. For instance, in the Daily view, users can see a particular day’s agenda, their unscheduled activities, or a to-do list. To appear in the Calendar views, all activities must have a start time.

Users who work as part of a team may find it useful to share access to their calendar.

To create a general activity in the Calendar view and to grant others access to your calendar

Follow the procedures for adding an activity to the calendar and granting access to your calendar in Siebel Fundamentals.

To create specialized activities in the Calendar view

1. Navigate to the Activities screen > Activity List view.

2. Do one of the following:
   - Click New Contact Call to schedule a call to a contact.
   - Click New Acct Call to schedule a call to an account.
   - Click New Meeting to schedule a meeting and to list activities, meeting speakers and invitees.
Setting Up a Meeting (End User)

Use the Meetings subviews of the Activities screen to manage information about activities, speakers, and invitees associated with meetings. Meetings themselves are activities that appear in the My Activities view.

**NOTE:** A MedEd event is similar to a meeting activity, but offers planning, budgeting, and cost aggregation functionality. MedEd activities are only associated with the separate Siebel MedEd module. For more information, see Chapter 15, “Managing MedEd Events.”

Setting up a meeting involves the following steps:

- **Create a new meeting record.** For more information, see “To create a meeting” on page 115. 
  **NOTE:** Users can also create a meeting by clicking the New Meeting button in the Activities list of the My Activities view.

- **Create activities for the meeting.** For more information, see “To create a meeting activity” on page 116.

- **Add speakers for the meeting.** For more information, see “To add a meeting speaker” on page 116.

- **Add invitees for the meeting.** For more information, see “To add a meeting invitee” on page 116.

**To create a meeting**

1. Navigate to the Activities screen > Activity List view.
2. In the Activities list, click New Meeting.
3. In the Meetings form, complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account associated with this meeting. Select an account from the Pick Account dialog box. The Location and Site fields are automatically filled based on the account you specify.</td>
</tr>
<tr>
<td>Cost</td>
<td>The application calculates this field based on costs entered for meeting activities. For more information, see “To create a meeting activity” on page 116. The application calculates this field when you click the Distribute Costs button in the Meeting Invitees view and updates it each time you click the Distribute Costs button again. For more information, see “To add a meeting invitee” on page 116.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The application automatically populates this field with the date and time that the record was created. If needed, make additional changes.</td>
</tr>
<tr>
<td>Status</td>
<td>This field is hard-coded so that its value cannot be set to Submitted to avoid interference with other activity types, such as contact calls and account calls that are based on the same class of Siebel business components.</td>
</tr>
</tbody>
</table>
Add information about activities, speakers, and invitees, as described in the following procedures.

**To create a meeting activity**
1. Navigate to the Activities screen > Meeting List view.
2. In the Activities list, do one of the following:
   - Create a new meeting. For more information, see "To create a meeting" on page 115.
   - Select an existing meeting and then drill-down on the Name field.
3. Click the Meeting Activities view tab.
4. In the Meeting Activities list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

Add information about speakers and invitees, as described in the following procedures.

**NOTE:** Meetings are activities that appear in the My Activities view. However, activities that you create for a meeting are child records of the meeting. These records appear in the Meeting Activities tab view and as activities in the Calendar views.

**To add a meeting speaker**
1. Navigate to the Activities screen > Meeting List view.
2. In the Activities list, do one of the following:
   - Create a new meeting. For more information, see "To create a meeting" on page 115.
   - Select an existing meeting and then drill-down on the Name field.
3. Click the Meeting Speakers view tab.
4. In the Meeting Speakers list, create a new record, and complete the necessary fields.

Affiliated contacts are those associated with the account (if any) specified in Step 3 in the "To create a meeting" procedure on page 115. For more information, see “Indicating an Affiliation Between an Account and a Contact (End User)” on page 71.

**To add a meeting invitee**
1. Navigate to the Activities screen > Meeting List view.
2. In the Activities list, do one of the following:
   - Create a new meeting. For more information, see "To create a meeting" on page 115.
   - Select an existing meeting and then drill-down on the Name field.
3. Click the Meeting Invitees view tab.
4. In the Meeting Invitees list, create a new record, and complete the necessary fields.
The application calculates the value of the Cost field in the Meeting Invitees list based on values entered in Cost field of the Meeting Activities list. It then distributes the costs across all invitees whose Invitee Status field is set to Attended.

**To update the Cost field in the Meeting Invitees list**

1. Click the Meeting Activities view tab.
2. In the Meeting Activities list, record the costs associated with each meeting activity in the Cost field.
3. To distribute the meeting costs across those individuals who attended the meeting, click the Meeting Invitees view tab.
4. In the Meeting Invitees list, update the Invitee Status for each invitee. Selecting the status Attended includes the selected invitee in the count of contacts for distribution of meeting costs.
5. Click Distribute Costs.

As you add costs and attendees to the meeting, repeat the previous steps as many times as needed.

**Creating a Contact Call (End User)**

End users track details about calls made on a contact with contact call records. Although users can create and display contact calls on the Contacts screen, they enter details about the actual call on the Activities screen. Also, as activities, contact call records can also be viewed in the Calendar screen as planned events.

For more information on entering call details, see “Recording and Submitting Contact Calls” on page 168.

**NOTE:** Before user can enter information about products detailed, samples, and promotional items dropped during a contact call, they must set up their personal lists. For more information, see “Creating a Personal List (End User)” on page 106.

This topic presents four different methods of creating contact calls:

- To create a contact call from the Activities screen on page 117
- To automatically schedule contact calls using the Schedule button on page 118
- To manually schedule a contact call in the Calls view tab on page 119
- To schedule a contact call in the Calendar on page 119

**Creating a Contact call from the Activities Screen**

**To create a contact call from the Activities screen**

1. Navigate to the Activities screen > Activities List view.
2 In the Activities list, click New Contact Call.

3 In the Contact Call form, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>The contact to be visited during this call.</td>
</tr>
<tr>
<td>Ref #</td>
<td>A reference number for this call. This reference number becomes the</td>
</tr>
<tr>
<td></td>
<td>transaction number (Transaction # field) for a samples transaction</td>
</tr>
<tr>
<td></td>
<td>corresponding to this call. For information on samples transactions, see</td>
</tr>
<tr>
<td></td>
<td>Chapter 8, “Managing Pharma Samples.”</td>
</tr>
<tr>
<td>Smart Call</td>
<td>The Smart Call template to be associated with this call. Make a selection</td>
</tr>
<tr>
<td></td>
<td>from the Pick Smart Call dialog box.</td>
</tr>
<tr>
<td></td>
<td>A Smart Call is a template that you apply to contact calls that defines</td>
</tr>
<tr>
<td></td>
<td>information about the products detailed, samples and promotional items</td>
</tr>
<tr>
<td></td>
<td>distributed, and issues discussed on a call. Once you apply a Smart</td>
</tr>
<tr>
<td></td>
<td>Call template to a call, you can make additional edits any fields in the</td>
</tr>
<tr>
<td></td>
<td>Contact Call Detail view. For more information on Smart Calls, see</td>
</tr>
<tr>
<td></td>
<td>Chapter 10, “Creating Smart Calls.”</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this call. The default value is Planned. This value changes</td>
</tr>
<tr>
<td></td>
<td>to Synchronized after synchronization. Have you applied a Smart Call?</td>
</tr>
<tr>
<td></td>
<td>To change the status of the call to Submitted, you must submit the call.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Recording and Submitting Contact Calls” on</td>
</tr>
<tr>
<td></td>
<td>page 168.</td>
</tr>
</tbody>
</table>

For more information on how to enter information in Call Products Detailed, Sample Products Dropped, Promotional Items Dropped, and Issues lists, see “Recording and Submitting Contact Calls” on page 168.

**NOTE:** If you applied a Smart Call to the call (as described in Step 3), you may only need to verify that all the information in the four lists is accurate.

**Creating Calls Using the Schedule Button From the Contacts Screen**

When you use the schedule button to create calls, the auto-scheduling function:

- Tries to schedule a call at a best time for each contact at their primary address
- Schedules a call even if it does not find a best time
- Distributes the calls over the time period (For example, if you select 10 contacts to be scheduled over a 5-day week, two calls each day are scheduled.)

**To automatically schedule contact calls using the Schedule button**

1 Navigate to the Contacts screen > Contacts List view.
2 In the Contacts list, select one or more contacts.
3 Click Schedule.
4 In the Auto Schedule dialog box, review the displayed values, make any needed changes, and click OK.

NOTE: The auto-scheduling function does not check for scheduling conflicts. Therefore, users need to verify that automatically scheduled calls do not conflict with other activities in their calendar.

Manually Scheduling a Contact Call from the Contacts Screen

To manually schedule a contact call in the Calls view tab
1 Navigate to the Contacts screen > Contacts List view.
2 Drill down on a contact.
3 Click the Calls view tab.
4 In the Call list, create a new record, and complete the necessary fields.

NOTE: You cannot change the call’s Status field to Submitted from this view. To change the status of the call to Submitted, you must submit the call. For more information, see “Recording and Submitting Contact Calls” on page 168.

5 To go to the Contact Call Detail view, drill down on the date hyperlink in the Start Date field. The Contact Call Detail view appears.

For more information on recording calls, see “Recording and Submitting Contact Calls” on page 168.

Scheduling a Contact Call from the Calendar Screen

To schedule a contact call in the Calendar
1 Navigate to the Calendar screen > Calendar view.
2 Select either the Daily or Weekly view tab.
3 Navigate to the day on which you want to schedule the call and click New Contact Call.

The Contact Call Detail view appears.

For more information on recording calls, see “Recording and Submitting Contact Calls” on page 168.

Creating an Account Call (End User)

End users track details about calls made on specific accounts with account call records. An account call is a type of activity record. Although users can create and display account calls on the Accounts screen, they enter details about the actual call on the Activities screen. Also, as activities, account call records can also be viewed in the Calendar screen.
For more information, entering call details see “Recording and Submitting Contact Calls” on page 168.

**NOTE:** Before users can enter information about products detailed, attendees, and activities associated with an account call, they must set up their personal lists. For more information, see “Creating a Personal List (End User)” on page 106.

This topic presents five different methods of creating account calls:

- To create an account call from the Activities screen on page 120
- To automatically schedule an account call using the Schedule button on page 120
- To manually schedule an account call in the Account view tab on page 121
- To create an account call using the New Call button on page 121
- To schedule an account call in the Calendar on page 121

**To create an account call from the Activities screen**

1. Navigate to the Activities screen > Activity List view.
2. In the Activities list, click New Acct Call.
3. In the Account Call form, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The account to be visited during this call.</td>
</tr>
<tr>
<td>Smart Call</td>
<td>The Smart Call template to be associated with this call. A Smart Call is a template that you apply to contact calls that defines information about the products detailed, samples and promotional items distributed, and issues discussed on a call. Once you apply a Smart Call template to a call, you can make additional edits any fields in the Account Call Detail view. For more information on Smart Calls, see Chapter 10, “Creating Smart Calls.”</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this call. The default value is Planned. You cannot select the value Submitted. To change the status of the call to Submitted, you must submit the call. For more information, see “Remaking Electronic Signatures” on page 174.</td>
</tr>
</tbody>
</table>

For information on how to enter information in the Call Products Detailed, Attendees, and Activities lists, see “Recording and Submitting Contact Calls” on page 168.

**NOTE:** If you applied a Smart Call to the call (as described in Step 3), you may only need to verify that all the information in the four lists is accurate.

**To automatically schedule an account call using the Schedule button**

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, select an account and click Schedule.
3  In the Auto Schedule dialog box, review the displayed values, make any needed changes, and click OK.

**NOTE:** The auto-scheduling function does not check for scheduling conflicts. Therefore, users need to verify that automatically scheduled calls do not conflict with other activities in their calendar.

**To manually schedule an account call in the Account view tab**
1  Navigate to the Accounts screen > Accounts List view.
2  In the Accounts list, drill down on an account.
3  Click the Calls view tab.
4  In the Calls list, create a new record, and complete the necessary fields.

**NOTE:** You cannot change the Status field to Submitted from this view. To change the status of the call to Submitted, you must submit the call. For more information, see “Remaking Electronic Signatures” on page 174.

To enter details about the call, drill-down on the Date hyperlink in the Date field to display the Account Call Detail view.

For more information on recording calls, see “Recording and Submitting Account Calls” on page 172.

**To create an account call using the New Call button**
1  Navigate to the Accounts screen > Accounts List view.
2  In the Accounts list, drill down on an account.
3  In the More Info view tab, click New Call.
   
   The Account Call Detail view of the Activities screen appears. The selected account automatically appears in the Account Call form.

For more information on recording calls, see “Recording and Submitting Account Calls” on page 172.

**To schedule an account call in the Calendar**
1  Navigate to the Calendar screen > Calendar view.
2  Select either the Daily or Weekly view tab.
3  Navigate to the day on which you want to schedule the call and click New Acct Call.
   
   The Account Call Detail view appears.

For more information on recording calls, see “Recording and Submitting Account Calls” on page 172.
About Features for Call Planning Specific to the Japanese Pharmaceutical Market

The Japanese pharmaceutical market has some unique characteristics concerning patient safety as stipulated by government regulations. These market characteristics dictate how sales representatives engage with physicians and hospitals in their territories and how they plan future calls. For example, pharmaceutical companies must provide safety information about a product to a physician. Additionally, after a new product is released, sales representatives are required to meet with physicians at pre-determined intervals to gather information about any anomalous effects the product may be having on the patients.

NOTE: Features specific to the Accounts Contacts in the Japanese pharmaceutical market are not covered in this section. For information about Accounts Contacts features specific to the Japanese market, see “About Japanese Pharmaceutical Market Features for Accounts Contacts” on page 205.

The following Siebel Life Sciences features address the distinctive traits of the Japanese pharmaceutical market:

- **Post Market Surveillance (PMS).** The purpose of the PMS process is to encourage feedback relating to adverse effects that may have been noted in patients taking new drugs to be reported back to the drug company. When a drug is approved, sales representatives must visit each institution that purchases the drug. As stipulated by government regulation, these visits must occur every 2 weeks for the first 2 months after a hospital purchases the drug, and monthly thereafter for a period of 6 months after the launch date of the drug. For a specific example of how calls are scheduled for PMS after a product is released, see “Visit Timeline During the PMS Period” on page 123.

  The purpose of these visits is to remind the health care professionals of their obligations to report any adverse effects that they have observed, or that have been reported to them. This process is initiated only when a hospital (account) purchases a drug (product) for the first time. This an activity associated at the account level. For information about managing PMS, see “Managing the PMS and Pre-Explain PMS Features” on page 123.

- **Pre-Explain PMS.** A process that is a precursor to the PMS process. This process is triggered when a new hospital (account) is targeted for a drug (product). Using the Pre-Explain PMS feature will automatically set up a call for each hospital. The goal of the ensuing call is for the sales representative to explain to the hospital (account) contact how the PMS process will work. The Pre-Explain PMS typically occurs before any hospital (account) purchases a new drug (product). For information about managing Pre-Explain PMS, see “Managing the PMS and Pre-Explain PMS Features” on page 123.

- **Package Insert Delivery (PID).** Pharmaceutical companies are required to offer safety information about a drug (product). This safety information is called a package insert. Its purpose is to improve the doctor’s recognition of the product, and protect patient safety in accordance with Japanese government regulations. Pharmaceutical companies are required to monitor whether their representatives are carrying out these calls whenever a package insert is updated for a product. After a modified package insert is delivered and the call has been made to the hospital contact, the sales representative is responsible for recording the call as having been completed. For information about managing PID, see “Managing the PID Feature” on page 126.
VisitTimeline During the PMS Period

As stipulated by Japanese government regulation, sales representatives from pharmaceutical companies must visit hospitals at preset intervals for six months after a drug is launched. These visits must occur every two weeks for the first two months after a hospital purchases the drug, and monthly thereafter for a total period of six months after the launch date of the drug.

For example, Drug XYZ is launched on February 1, 2009. The PMS period will also begin on February 1, 2009. The PMS period will end for Drug XYZ six months after its release: on August 1, 2009.

Hospital 1 buys Drug XYZ on February 1, 2009. This means that they will have the maximum amount of PMS visits from the pharmaceutical company. There will be a total of eight visits that will occur approximately on the following dates:

- Biweekly dates: February 15th, March 1st, March 15th, April 1st
- Monthly dates: May 1st, June 1st, July 1st, August 1st

Hospital 2 buys Drug XYZ on April 1, 2009. As a result, there will be a total of six PMS visits that will occur approximately on the following dates:

- Biweekly dates: April 15th, May 1st, May 15th, June 1st
- Monthly dates: July 1st, August 1st

Hospital 4 buys Drug XYZ on July 15, 2009. As a result, there will be a total of one PMS visit that will occur approximately on the following date:

- Biweekly date: August 1st

NOTE: Once six months have elapsed after the launch date, there are no more PMS calls.

Managing the PMS and Pre-Explain PMS Features

After a drug is released in the Japanese market, a series of follow-up calls must be scheduled with hospitals purchasing the drug in order to track any possible side effects. Although users can create and display account calls on the Accounts screen, calls can be created for this purpose using the PMS and Pre-Explain PMS features. For more information about PMS and Pre-Explain PMS, see "About Features for Call Planning Specific to the Japanese Pharmaceutical Market" on page 122.

This topic presents different tasks involved for creating account calls relating to PMS and Pre-Explain PMS:

- "Enabling a Product for PMS” on page 124
- "Scheduling Calls for Pre-Explain PMS“ on page 124
- "Scheduling Calls for PMS” on page 124
- "Viewing or Editing PMS Account Products” on page 125
- "Viewing Upcoming Pre-Explain PMS and PMS Calls for All Accounts” on page 125
- "Viewing All Missed Calls for Account Contacts” on page 125
Enabling a Product for PMS
The following procedure describes how to enable a product for PMS.

To enable a product for PMS
1. Navigate to the Administration - Products screen > Products view.
2. Select a product.
3. Define a date in the Period Start Date column.
   NOTE: The date should be the product’s launch date.
4. Define a date in the Period End Date column.
   NOTE: The date should be six months after product’s launch date.

Scheduling Calls for Pre-Explain PMS
The following procedure describes how to schedule calls for Pre-Explain PMS.

To schedule calls for Pre-Explain PMS
1. Navigate to the Administration - Products screen > Schedule PMS Activities view.
2. Select a product.
3. Select an account list.
4. Enter a value for Due Date.
5. Click Pre PMS Call.
   A Pre-Explain PMS call will be scheduled for each hospital in list of Accounts.

Scheduling Calls for PMS
The following procedure describes how to schedule calls for PMS.

To schedule calls for PMS
1. Navigate to the Administration - Products screen > Schedule PMS Activities view.
2. Select a product.
3. Select an account list.
4 Enter a value for Due Date.
5 Click PMS Call.

A series of follow-up calls will be scheduled for each hospital in list of Accounts.

**NOTE:** Depending on the defined PMS period, each hospital may have up to eight follow-up calls scheduled. These are out-of-the-box default values.

### Viewing or Editing PMS Account Products

The following procedure describes how to view or edit PMS Account Products.

**To view or edit PMS Account Products**

1. Navigate to the Administration - Product screen > PMS Account Product view.
   
   All products set up for Pre-Explain PMS and PMS will appear in this view.

2. Select a product.

3. Modify any of the fields.

### Viewing Upcoming Pre-Explain PMS and PMS Calls for All Accounts

The following procedure describes how to view all upcoming Pre-Explain PMS and PMS calls for all accounts.

**To view all upcoming Pre-Explain PMS and PMS calls for all accounts**

1. Navigate to the Calendar screen > Account Call Planning view.

2. Select an account.

3. Scroll left to move to past calls and right to move to future calls.

4. Calls will be denoted by different blocks of color, according to the legend below the Account Call Planning view.

**NOTE:** PMS calls for all accounts also appear on the Home screen.

### Viewing All Missed Calls for Account Contacts

The following procedure describes how to view all missed calls for account contacts:
To view all missed calls for account contacts
1. Navigate to the Home screen.
2. Scroll to the Missed Calls section.

Viewing All Account and Contact Level Attachments for a PMS Call
The following procedure describes how to view all account and contact level attachments for a PMS call.

To view all account and contact level attachments for a PMS call
1. Navigate to the Post Market Surveillance screen > Activity Details view.
2. Select a PMS account product.
3. Scroll to the bottom of the view.
   The Account Attachment section will list any account-level attachments, and the Contact Attachment section will list any contact-level attachments.

Managing the PID Feature
After pharmaceutical companies modify safety information in a package insert for a drug in the Japanese market, a call must be scheduled with all the hospitals distributing the drug. Although users can create and display account calls on the Accounts screen, calls can be created for this purpose using the PID feature. For more information about PID, see "About Features for Call Planning Specific to the Japanese Pharmaceutical Market" on page 122.

This topic presents different tasks involved for creating account calls relating to PID:
- "Creating a Package Insert" on page 126
- "Scheduling a Call for PID" on page 127
- "Viewing All Upcoming PID Calls for All Accounts" on page 127

Creating a Package Insert
The following procedure describes how to create a package insert:

To create a package insert
1. Create a product for the package insert. While creating the package insert, ensure that the following fields are set:
Effective Start Date

**NOTE:** The value given to Effective Start Date should represent the issue date for the product.

Item Size

**NOTE:** The value given to the Item Size field should reflect the number of pages in the package insert.

Type

**NOTE:** The Type field must be set to Insert.

For more information about creating products, see “Process of Managing Products” on page 81.

1. Click the Release button.
2. Add visibility through the category. For more information about product categorization, see “Product Categorization Settings” on page 83.
3. Add the package insert to a personal list. For more information about personal lists, see “Personal Lists” on page 102.

**Scheduling a Call for PID**

The following procedure describes how to schedule a call for PID.

**To schedule a call for PID**

1. Navigate to the Administration - Products screen > Schedule PID Activities view.
2. Select the product insert from the list of products.
3. Select an account list.
4. Enter a value for Due Date.
5. Click PID Calls.

A series of calls will be scheduled for each hospital in the list of accounts.

**Viewing All Upcoming PID Calls for All Accounts**

The following procedure describes how to view all upcoming PID calls for all accounts.

**To view all upcoming PID calls for all accounts**

1. Navigate to the Calendar screen > Account Call Planning view.
2. Select an account.
3 Scroll left to move to past calls and right to move to future calls.

Different types of calls will be denoted by different blocks of color, according to the legend below the Account Call Planning view.

**NOTE:** PID calls for all accounts also appear on the Home screen.
Managing Pharma Samples

This chapter covers the following topics:

- "About Managing Pharma Samples" on page 129
- "About Samples and Lot Numbers" on page 132
- "About Scenarios for Managing Samples" on page 133
- "Scenario 1: Administrator Establishes a Master Inventory” on page 134
- "Scenario 2: Administrator and End Users Establish a Master Inventory” on page 135
- "Scenario 3: Users Transfer Samples to One Another” on page 137
- "Prerequisites for Managing Samples” on page 137
- "About Samples Transactions” on page 137
- "Defining Lot Numbers for Samples” on page 138
- "Establishing an Initial Inventory” on page 141
- "Managing Inventory Tracking and Reconciliation Without Lot Numbers” on page 143
- "Creating a Samples Transfer” on page 145
- "Monitoring Samples Activities” on page 147
- "Adjusting a Past Samples Transaction” on page 149
- "Checking Electronic Signatures” on page 151
- "About Establishing an Initial Inventory Count (End User)” on page 152
- "Creating a Samples Order (End User)” on page 153
- "Acknowledging Receipt of a Samples Transfer (End User)” on page 154
- "Adjusting an Inventory Count (End User)” on page 155
- "Recording Thefts and Losses (End User)” on page 155
- "Reconciling an Inventory Period (End User)” on page 155

About Managing Pharma Samples

Most pharmaceutical manufacturers provide free samples to health care professionals in an effort to influence the prescribing habits of physicians across the United States and the world. In the United States, samples distribution is regulated by the FDA and must be reconciled at least once a year.
This chapter describes how to manage and maintain an electronic inventory of samples and promotional items using Siebel Pharma Samples Management. Using the procedures given in this chapter, you will be able to perform the administrator tasks of setting up and maintaining a home-office master inventory (optional) and monitoring samples disbursements, orders, transfers, receipts, discrepancies, adjustments, and inventory counts. End users use the Samples Management screens to track an electronic inventory of samples stock, create samples request order and transfers, acknowledges receipt of samples transfers, and adjust inventory balances for reconciliation purposes.

Siebel Samples Management allows sales representatives and administrators to measure and monitor sample disbursements at every level throughout the organization. For more information on the differences between administrator and end-user tasks see “About Scenarios for Managing Samples” on page 133.

About Samples Transactions

Siebel Samples Management maintains a samples transaction record for every sample transfer, receipt, disbursement, order, and inventory adjustment. The application assigns each samples transaction record a unique identifier for tracking purposes. Depending on the type of transaction, you can display this identifier as a transaction number, an order number, an invoice number, or a transfer number.

Each samples transaction record represents a single transaction consisting of one or more line items. As shown in Figure 1, the application tracks a transfer of multiple samples as a single transaction record with multiple corresponding line item records—one line item for each type of product transferred. These line item records are child records of the parent transaction record.

Inventory Reconciliation

In the United States, pharmaceutical companies may request that sales representatives perform an inventory reconciliation from one to twelve times a year to remain compliant with the Prescription Drug Marketing Act (PDMA). (Sampling regulations vary significantly in North America, Europe, Asia, and Latin America.) If sales representatives’ physical sample inventories do not match their disbursement and transaction histories, they may perform inventory adjustments to justify the discrepancies. For more information, see “Reconciling an Inventory Period (End User)” on page 155.
It is also possible to create sample products by lot numbers and to disburse samples to contacts by lot numbers and yet not reconcile by lot numbers. For more information, see “Reconciling an Inventory Period (End User)” on page 155.

**PDMA Compliance and Lot Numbers**

Companies in the United States may need to perform additional tasks to meet PDMA requirements. According to the Food and Drug Administration’s Final Ruling of December 3, 1999 (21 CFR Part 203 and 205), samples must also be tracked by lot number to the level of disbursement. Siebel Samples Management provides additional functionality that allows you to meet this lot number tracking requirement. For more information on using lot numbers, see “About Samples Transactions” on page 137.

**Inventory Periods**

Because samples inventory reconciliation can happen as often as once a month, Siebel Samples Management allows you to reconcile as often as you like and provides three types of inventory periods for maximum flexibility. These period types are described in Table 14.

<table>
<thead>
<tr>
<th>Period Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>The current period; it shows no end date and it is not reconciled. You can enter any type of samples transaction, including adding new products; inventory counts will be adjusted accordingly.</td>
</tr>
<tr>
<td>Inactive</td>
<td>A past, unreconciled period; it shows an end date but has not been reconciled yet. Except for adding new products into inventory, you can enter any type of samples transaction; inventory counts will be affected accordingly. The default application configuration provides one inactive period, but can be configured for multiple instances.</td>
</tr>
<tr>
<td>Reconciled</td>
<td>A past, inactive period; it shows an end date and has been reconciled. Although you can enter samples disbursements for a reconciled period, the inventory counts for the active period will not be affected.</td>
</tr>
</tbody>
</table>

The default Siebel Samples Management configuration provides two unreconciled periods: one active period and one inactive period. The Siebel administrator can control the number of unreconciled periods allowed. For more information, see “Reconciling an Inventory Period (End User)” on page 155.

**How Siebel Samples Management Works with Calls**

This topic describes how Siebel Samples Management works with the Contact Call Detail and Account Call Detail views. For more information on recording calls, see Chapter 9, “Recording Calls in Pharma.”

When you click the Submit button in either the Contact Call Detail and Account Call Detail views, the application verifies that:
Managing Pharma Samples ■ About Samples and Lot Numbers

- At least one product has been recorded and detailed.
  This requirement can be changed by the administrator. For more information, see Appendix A, “Configuring Siebel Life Sciences.”
- The call’s date and time is the same as or earlier than the current date and time. A call cannot be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

- A valid paper or electronic signature has been obtained.
- The Ref# field is not empty.
- The samples exist in the inventory for the period indicated by the call’s date and time.
- The period into which the samples will be recorded is an unreconciled period. If it is a reconciled period, a warning message appears.
- A valid lot number has been specified for dropped samples tracked by lot number.

**NOTE:** When the Lots for Disperse Only system preference is set to TRUE, the lot number is not required. For more information, see “Managing Inventory Tracking and Reconciliation Without Lot Numbers” on page 143.

If the call passes these checks, the application:

- Creates a samples disbursement transaction, with a line item for each dropped sample recorded for the call.
- Creates a samples disbursement transaction, with a line item for each dropped sample recorded for the call when Signature is saved for Electronic Signature Calls.
- Submits a disbursement transaction to update the samples inventory. If the submission of the disbursement transaction is successful, the application changes the call’s Status field to Submitted.
- Sets the Last Call Date field for the contact or account to the date of the submitted call, and many fields in the call record become read-only.

As an administrator, you can change the fields that become read-only after a call is submitted (or synchronized with Siebel Pharma Handheld on a PDA). For information, see Appendix A, “Configuring Siebel Life Sciences.”

**NOTE:** If attendees are recorded in an account call, an attendee call is created for each attendee, and the process described above is performed for each attendee call. Attendee calls are the same as contact calls except that they do not appear in the Activities view and they are submitted automatically when the account call is submitted.

About Samples and Lot Numbers

The use of product samples for product promotion by pharmaceutical companies around the world is governed by local country legislations. Siebel Samples Management maintains a samples transaction record for every sample transfer, receipt, disbursement, order, and inventory adjustment.
The following three options are available to customers who are implementing Siebel Samples Management:

- Use Lot numbers for samples creation, transfer, adjustment, order, disbursement, inventory, and reconciliation.
  
  This option is the default setting. It is made possible with the system preferences settings shown on the following table.

<table>
<thead>
<tr>
<th>System Preference</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lots for Disperse Only</td>
<td>FALSE</td>
</tr>
<tr>
<td>Sample Lots Enabled</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

**NOTE:** An administrator sets the system preferences by navigating to the Administration - Application screen > System Preferences view.

- Use Lot numbers for samples creation, transfer, adjustment, order, disbursement, but do not use lot numbers for inventory and reconciliation.
  
  This option is made possible with the system preferences settings shown on the following table.

<table>
<thead>
<tr>
<th>System Preference</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lots for Disperse Only</td>
<td>TRUE</td>
</tr>
<tr>
<td>Sample Lots Enabled</td>
<td>TRUE</td>
</tr>
</tbody>
</table>

In addition to these system preference changes, a Siebel administrator must use Siebel Tools to control product visibility associated with this behavior. For more information, see Appendix A, “Configuring Siebel Life Sciences.”

**NOTE:** The Lot# Tracking flag on the Administration - Product screen must be checked.

- Do not use lot numbers for samples management at all.
  
  This option is made possible with the system preferences settings shown on the following table.

<table>
<thead>
<tr>
<th>System Preference</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lots for Disperse Only</td>
<td>FALSE</td>
</tr>
<tr>
<td>Sample Lots Enabled</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

The Lot# Tracking flag on the Administration - Product screen does not have to be checked.

**About Scenarios for Managing Samples**

This chapter outlines three scenarios that are examples of workflows performed by a samples administrator and the sales representatives who distribute samples to health care professionals. Your company may follow a different process according to its business requirements.
Managing Pharma Samples  ■ Scenario 1: Administrator Establishes a Master Inventory

A pharmaceutical company has new products to bring to market. To set up a samples inventory, the samples administrator adds the products to the database, associates any lot numbers, and transfers samples to the managers and sales representatives in the field. Once sales representatives and managers receive the samples, they add them to their personal lists so they are available options in their call reporting. The sales representatives then visit the doctors in their territories and drop the new samples. After a month goes by, each sales representative is required to reconcile his or her inventory. One sales representative realizes there are some discrepancies in her inventory. After she makes the needed adjustments, she reconciles her inventory and starts a fresh inventory period.

Scenarios discussed in this chapter include:

- **Scenario 1: Administrator Establishes a Master Inventory.** The Siebel samples administrator establishes and transfers inventory to end users.
- **Scenario 2: Administrator and End Users Establish a Master Inventory.** The Siebel samples administrator and the end user establish an initial inventory and then reconcile it before they disburse any samples.
- **Scenario 3: Users Transfer Samples to One Another.** Describes the basic process of how users can exchange samples inventory within the system.

Using the procedures described in this chapter, sales representatives can track their samples inventories, record inventory transfers, and track lost or damaged inventory. However, to record samples disbursements, sales representative should use the procedures described in Chapter 9, “Recording Calls in Pharma.”

**Scenario 1: Administrator Establishes a Master Inventory**

In this scenario, samples administrators are responsible for their company’s samples inventory and making sure it complies with regulatory rules and regulations. In this role, they take the responsibility for establishing a master samples inventory and then transferring samples to each end user.

Having the samples administrator establish a master inventory and then transfer samples to each end user is a simpler process from the end user’s perspective. Once the samples administrator establishes the master samples inventory, the next step is to transfer inventory to each end user. When each recipient electronically receives the shipment, they submit a receipt and application automatically enters the received samples into their inventory counts.

In this process, the representative, the representative’s manager, and the samples administrator can monitor discrepancies between shipped quantities and received quantities.

**Administrator Procedures**

The samples administrator requires administrative responsibilities in Siebel Samples Management to:

- **Define samples as products.** For more information, see Chapter 6, “Managing Products for Life Sciences.”
Define lot numbers (optional). For more information, see “Defining Lot Numbers for Samples” on page 138.

Set up and reconcile initial master inventory. For more information, see “Establishing an Initial Inventory” on page 141.

Transfer inventory to end users. For more information, see “Creating a Samples Transfer” on page 145.

Monitor samples activities. Activities for samples include disbursements, orders, transfers between employees, user inventory counts, and inventory adjustments. For more information, see “Monitoring Samples Activities” on page 147.

Manage electronic signatures. For more information, see “Checking Electronic Signatures” on page 151.

Identify sample locations in the event of recalls. Follow your company’s guidelines for managing sample recalls.

End-User Procedures
The end users are the sales representatives who distribute samples to health care professionals. They enter information to:

Acknowledge receipt of the inventory transfers. For more information, see “Acknowledging Receipt of a Samples Transfer (End User)” on page 154.

Add inventory to personal lists. For more information, see “Creating a Personal List (End User)” on page 106.

Use the new samples in regular call reporting. For more information, see Chapter 9, “Recording Calls in Pharma.”

Transfer samples to other end users. Sales representatives exchange samples among themselves. For more information, see “Creating a Samples Transfer” on page 145.

Request more samples. For more information, see “Creating a Samples Order (End User)” on page 153.

Perform inventory adjustments. For more information, see “Adjusting a Past Samples Transaction” on page 149.

Reconcile inventory periods as needed. For more information, see “Reconciling an Inventory Period (End User)” on page 155.

Scenario 2: Administrator and End Users Establish a Master Inventory
In this scenario, both the samples administrator and the end user establish a master samples inventory or inventory count. Samples administrators are again responsible for their company’s samples inventory and making sure it complies with regulatory rules and regulations.

From a process perspective, this process requires more steps for the end user because they must first establish an initial inventory and then reconcile it before they can disburse any samples.
Managing Pharma Samples  ■ Scenario 2: Administrator and End Users Establish a Master Inventory

**Administrator Procedures**
Samples administrators require administrative responsibilities in Siebel Samples Management to:

- **Define samples as products.** Product inventory is maintained in the database. For more information, see Chapter 22, "Managing Clinical Projects."

- **(Optional) Define lot numbers.** Samples may be tracked by lot numbers. For more information, see "Defining Lot Numbers for Samples" on page 138.

- **Set up and reconcile initial master inventory.** This step is required only if you are not using a third-party system to populate the samples inventory. For more information, see "Establishing an Initial Inventory" on page 141.

- **Monitor samples activities.** Samples activities that are monitored include disbursements, orders, transfers between employees, user inventory counts, and inventory adjustments. For more information, see "Monitoring Samples Activities" on page 147.

- **Check electronic signatures.** Regularly check Signature Audit Administration to verify that signatures collected from contacts are consistent. For more information, see "Checking Electronic Signatures" on page 151.

- **Identify sample locations in the event of recalls.** Follow your company’s guidelines for managing sample recalls.

**End-User Procedures**
The end users are the sales representatives who distribute samples to health care professionals. They enter information to:

- **Set up and reconcile initial master inventory.** For more information, see "About Establishing an Initial Inventory Count (End User)" on page 152.

- **Add inventory to personal lists.** For more information, see "Creating a Personal List (End User)" on page 106.

- **Use the new samples in regular call reporting.** For more information, see Chapter 9, "Recording Calls in Pharma."

- **Transfer samples to other end users.** Sales representatives exchange samples among themselves. For more information, see "Creating a Samples Transfer" on page 145.

- **Acknowledge receipt of the inventory transfers.** End users must acknowledge receipt of a samples transfer transaction before the transfer can be completed. For more information, see "Acknowledging Receipt of a Samples Transfer (End User)" on page 154.

- **Perform counts and adjustments.** For more information, see "Adjusting a Past Samples Transaction" on page 149.

- **Reconcile inventory periods as needed.** For more information, see "Reconciling an Inventory Period (End User)" on page 155.
Scenario 3: Users Transfer Samples to One Another

This scenario describes the basic process for exchanging inventory with other users within the system. This process can be used by both the administrator and end users to exchange samples. When a user creates a samples transfer to move inventory to another user, the recipient electronically receives a shipment of samples. Once the recipient submits a receipt for that shipment, the application automatically enters the received samples into their inventory counts.

Prerequisites for Managing Samples

**Administrators.** Before you can set up Siebel Samples Management, you must first define your products. For more information, see Chapter 6, "Managing Products for Life Sciences."

**End-users.** Before they can drop samples, they must configure personal lists of the products they detail, the products they distribute as samples, and the products they provide as promotional items before they can record information about contact calls or account calls. For more information on creating personal lists, see "Creating a Personal List (End User)” on page 106.

About Samples Transactions

In the default configuration, Siebel Samples Management supports two open inventory periods. The samples administrator can override this default behavior by adding additional open periods using Siebel Tools. When users click the Submit button for a samples transaction, the system checks the transaction date and time to determine the inventory period into which the transaction should be entered.

For all transactions except receipts, the application enters the transaction into the inventory period that includes the transaction’s date and time. If no such period exists, the transaction submission fails.
If the situation involves samples receipts (that is, received samples transactions displayed in the Received Samples view) and no inventory period exists that includes the transaction’s date and time, Siebel Samples Management creates a new inventory period.

For example, this situation might occur during initial deployment, before any inventory periods have been opened. The new period’s start date and time are set to the invoice receipt’s date and time. However, the application first checks whether any pending transaction has an earlier transaction date than the one being submitted. This is done to prevent any impasse that might occur if a second invoice receipt is later submitted with an earlier transaction date.

**NOTE:** Once the first inventory period has been created, another period with an earlier start date and time cannot be created.

Submitted samples transactions impact inventory counts in the following ways:

- Samples orders are independent of inventory periods because they have no effect on inventory counts.
- Received Samples (transactions whose Type field is Transfer In) are added to the submitter’s inventory counts.
- Sent Samples (transactions whose Transfer Type or Transaction Type field is Transfer Out or Return) are subtracted from the submitter’s current inventory counts. In addition, a corresponding invoice receipt is created for the receiving party.

**NOTE:** Typically, samples returns (samples transfers whose Transfer Type field is Return) are expired products that are sent back to the home office to be destroyed. Samples returns are not added back into the home office’s master inventory counts. The samples administrator can track samples returns by using the Sent Samples administration view or the Samples History administration views and querying for those samples transactions with a type equal to Return.

- Samples adjustments (transactions whose Transaction Type field is Inventory Adjustment) are either added to or subtracted from the submitter’s inventory counts. Samples adjustments are the only type of samples transaction in which negative quantities are allowed.

In the Samples History view, the Add, Adjust, and Submit buttons are enabled or disabled as follows:

- If the transaction’s Status field is set to Submitted, the Adjust button is enabled and the Add and Submit buttons are disabled.
- If the transaction’s Status field is set to Adjusted, all the buttons are disabled.
- If the transaction’s Status field is set to In Progress, the Submit button is enabled and the Add and Adjust buttons are disabled.

## Defining Lot Numbers for Samples

Siebel Samples Management allows you to define your samples and promotional items according to a number of different implementation scenarios. By specifying certain product settings, you can make Siebel Samples Management suit your company’s strategy for inventory tracking and distribution of samples. You can implement samples using lot numbers in the following ways:

- Tracking samples for inventory purposes at a lot level or a sample product level.
- Disbursing some products with lots and others without lots.
Managing existing samples that have already been distributed and tracked without lot numbers in Siebel Samples Management.

Using lot numbers for samples creation, transfers, adjustments, orders, and call reporting, but not using lot numbers for inventory and reconciliation. For more information, see “Managing Inventory Tracking and Reconciliation Without Lot Numbers” on page 143.

Before you can track samples by lot number, you must:

- Verify that the Samples Lots Enabled system preference is set to TRUE (the default setting). For more information, see “Disabling Lot Number Tracking” on page 140.
- Define the products that will be disbursed as samples. For more information, see “Defining Internal Products” on page 82.
- Define the lot numbers for each product. For more information, see the procedure “To define lot numbers” on page 139.

If you track disbursements at the lot number level, you may track inventory with or without using lot numbers. For more information on disabling lot number tracking see “Disabling Lot Number Tracking” on page 140. For more information on reconciliation without lot numbers, see “Managing Inventory Tracking and Reconciliation Without Lot Numbers” on page 143 and “Enabling Inventory Reconciliation Without Lot Numbers” on page 482.

If you are implementing either full or partial lot number tracking for samples use the following procedure to define the lot numbers associated with those samples. This procedure creates lot number records that are children of the parent sample product record. For more information setting up lot tracking, see “Defining Internal Products” on page 82.

Existing products (that is, products that were previously defined without lot number tracking specified) cannot be tracked by lot number if they exist in any user inventory. To begin tracking lot numbers for an existing product, you must create a new product record with a product name indicating that this product will be tracked by lot number. For example, if the existing product is named Aracid 200, you could name the new product Aracid 200 (Lot).

**To define lot numbers**

1. Verify that you have specified the correct settings for the products to be disbursed as samples.
   
   For more information setting up lot tracking, see “Defining Internal Products” on page 82 paying specific attention to Table 11 on page 83 and Table 12 on page 84.

2. Navigate to the Administration - Samples screen > Lot Setup view.

3. In the Lot Setup list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Date</td>
<td>This information can be used for recalls of expired products.</td>
</tr>
<tr>
<td>Effective Start Date</td>
<td>The date of manufacture, the date on which the product was received, or another date defined by your company.</td>
</tr>
</tbody>
</table>
Managing Pharma Samples ■ Defining Lot Numbers for Samples

4 Repeat Step 3 to define other lot numbers.

**NOTE:** Multiple lot numbers can be defined for a sample product, as long as each lot number is unique.

You can also include the lot number in the product name when defining the product. For more information, see “Defining Internal Products” on page 82. However, using this method can make the drop-down lists that users select from very long. Only use this method if the number of products that will be disbursed is small.

### Disabling Lot Number Tracking
Lot number tracking for sample products is enabled by default. With lot number tracking enabled, the constraints and data checks described in “How Siebel Samples Management Works with Calls” on page 131 and “Defining Internal Products” on page 82 become active.

Regardless of whether you have set the Samples Lots Enabled system preference to TRUE or FALSE, samples dispersed with lot numbers should appear in both the Samples History and the Inventory Count views. Thus, even if you decide not to use lot numbers, your samples history is fully recorded.

**To disable lot number tracking for samples**
- Set the Samples Lots Enabled system preference to FALSE.

For general information about setting system preferences, see the *Siebel Applications Administration Guide.*

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot #</td>
<td>Enter an unique value that corresponds to the lot number printed on the label of the product.</td>
</tr>
<tr>
<td>Inventory By Lot</td>
<td>Check this field if inventory tracking by lot number is required. For more information, see “Defining Internal Products” on page 82 paying specific attention to Table 11 on page 83 and Table 12 on page 84.</td>
</tr>
<tr>
<td>Sample</td>
<td>The name of the product for which this lot number will be affiliated. This field should indicate both product name and dosage. Only products that are set up for lot number tracking appear in the dialog box. For more information, see “Defining Internal Products” on page 82 paying specific attention to Table 11 on page 83 and Table 12 on page 84.</td>
</tr>
</tbody>
</table>
Setting the Lots for Disperse Only system preference to TRUE allows you to ship samples to users by lot numbers and allows sales representatives to disburse the samples by lot numbers while maintaining and reconciling inventory without lot numbers. To retain sample product visibility, the samples administrator must reconfigure the Siebel repository. For more information, see “Managing Inventory Tracking and Reconciliation Without Lot Numbers” on page 143.

**NOTE:** By default, Sample Lots Enabled is set to TRUE and Lots for Disperse Only is set to FALSE. If you do not want to use lot numbers, you can change both of these system preferences, setting Sample Lots Enabled to FALSE and Lots for Disperse Only to FALSE. Lots for Disperse Only works only when Sample Lots Enabled is set to TRUE. If Sample Lots Enabled is set to FALSE, the system ignores Lots for Disperse Only.

### Establishing an Initial Inventory

Establishing an initial master inventory is only necessary if you are manually entering and tracking samples. If you are populating your samples inventory from a third-party system, it is not recommended that you establish an initial master inventory.

As outlined in "About Scenarios for Managing Samples" on page 133, either an administrator or an end user may establish an inventory. However, because Siebel Samples Management routes and maintains transactions by Employee ID, only the user who creates an inventory (the initial inventory count) can create or manipulate that inventory.

Before adding products to the master inventory, you must verify that the products are correctly defined for inventory tracking. For more information, see "Defining Internal Products” on page 82 paying specific attention to Table 11 on page 83 and Table 12 on page 84.

In particular, in the Products form, you must select one of the following fields:

- Orderable
- Either Inventory or the Lot# Tracking

When neither Inventory nor Lot # Tracking are checked, the sample is not tracked in inventory.

For more information, see “Defining Internal Products” on page 82 and “About Samples Transactions” on page 137.

**NOTE:** End users do not need to perform the procedures described in this topic if their initial counts consist only of samples transfers routed to them by their samples administrator. Instead, they should simply acknowledge the receipt of those shipments. For more information, see "Acknowledging Receipt of a Samples Transfer (End User)” on page 154. However, end users do need to perform the procedures described in this topic if their initial counts contain any records that they entered manually. End users who enter records manually must submit those counts and reconcile the initial inventory period.

To establish an initial master inventory:

- **Count products on-hand.** Establish an inventory count by physically counting the products currently on-hand. This process creates a list of the products in your inventory and an inventory period solely for your initial count.
Managing Pharma Samples ■ Establishing an Initial Inventory

- **Add products and submit count.** Add products to the inventory and submit an initial count. (See “To add products to inventory and submit an initial count” on page 142.)

- **Submit adjustments.** Create and submit adjustments for the initial count. (See "To create and submit initial count adjustments" on page 143.)

- **Reconcile.** Reconcile the initial inventory period. (See “To reconcile the initial inventory period” on page 145.)

**To add products to inventory and submit an initial count**

1. Navigate to the Samples screen.
2. On the link bar, click Inventory Count.
3. In the Inventory Count list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>The amount of your initial inventory.</td>
</tr>
<tr>
<td>Difference</td>
<td>Shows a negative number after you enter a value in the Count field.</td>
</tr>
<tr>
<td>Lot</td>
<td>The lot number for this sample.</td>
</tr>
<tr>
<td>Sample</td>
<td>The name of the sample to be added.</td>
</tr>
</tbody>
</table>

Repeat Step 3 to create a new record and count for each product in your inventory.

**NOTE:** Records created in this view can be deleted only if the value of the On Hand Quantity field is zero.

4. Click Submit.

   The Difference field is cleared for all records. The application transfers the number you entered in the Count field to the On Hand Quantity field and clears the Count field.

   Once you submit an initial count, the Siebel Samples Management deactivates the inventory period into which you entered your initial counts and creates a new active inventory period.

5. On the link bar, click Samples History.

   The Samples History view appears.

   The inventory period into which you entered your initial counts becomes inactive—a date and time appear in the End Date field, and there is no check mark in the Active field. In addition, a new active period has been opened.
Create adjustment transactions for the period, as described in the next procedure.

**NOTE:** You cannot submit an adjustment transaction if the product is not currently active. Siebel Samples Management considers a product inactive if the administrator has made it inactive, or the product does not exist in the inventory count list (it could have been deleted if the on-hand quantity was zero). Inactive products do not display in drop-down lists or dialog boxes, although they may be visible in views displaying products.

---

**Managing Inventory Tracking and Reconciliation Without Lot Numbers**

Siebel Samples Management supports using lot numbers for samples creation, shipment, receipt, transfers, adjustment, ordering, and disbursement while not using lot numbers for inventory and reconciliation.

To enable this behavior, you must make three changes:

- Set the value of two system preferences—Samples Lots Enabled and Lots for Disperse Only—to “True.”
- Check the Lot# Tracking flag in the Administration - Product screen.
- Implement product visibility. For more information, see "Retaining Sample Product Visibility" on page 482.

When this behavior has been enabled, the Lot No. field is available but not required for samples creation, shipment, receipt, transfers, adjustment, ordering and call reporting. In addition, the Lot No. field is disabled in the Inventory Count and Reconciliation views.

---

**To track and reconcile inventory without lot numbers**

1. Set the Samples Lots Enabled system preference to TRUE.
2. Set the Lots for Disperse Only system preference to TRUE.

For general information about setting system preferences, see the *Siebel Applications Administration Guide*.

---

**To create and submit initial count adjustments**

1. Navigate to the Samples screen.
2. On the link bar, click Sample Adjustments.
3 In the My Samples Adjustments list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment Reason</td>
<td>Select Initial Count from the drop-down list.</td>
</tr>
<tr>
<td>Inventory Period</td>
<td>Selecting an Inventory Period automatically enters a validated date in the Transaction Date (Txn Date) field, making sure that the adjustment is entered into the appropriate inventory period.</td>
</tr>
<tr>
<td>Transaction #</td>
<td>The application automatically generates an unique identifier. You can change this value.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>It is recommended that you complete the Inventory Period field to auto-fill this field so that the adjustment is entered into the correct period.</td>
</tr>
<tr>
<td>Transaction Status</td>
<td>The application automatically changes this field value to Submitted when you submit the adjustment.</td>
</tr>
</tbody>
</table>

4 In the Line Items list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #</td>
<td>The application automatically generates this value. If you want to have the items appear in a particular order, edit this value in the Administration - Product screen.</td>
</tr>
<tr>
<td>Item Status</td>
<td>The application automatically changes this field value to Submitted when you submit the transaction.</td>
</tr>
<tr>
<td>Lot Name</td>
<td>The lot number for this sample.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The amount of your initial inventory. This quantity should be the same as the value you entered in the Count field in the Inventory Count view. For more information, see “To add products to inventory and submit an initial count” on page 142.</td>
</tr>
<tr>
<td>Sample</td>
<td>The sample to be adjusted.</td>
</tr>
</tbody>
</table>

Repeat Step 3 and Step 4 to enter a line item for each sample needing adjustment.

5 Click Submit.

The values in the Transaction Status field (in the Samples Adjustment form) and the Item Status fields (in the Line Items list) are changed to Submitted.

Reconcile the initial inventory period, as described in the next procedure.
**To reconcile the initial inventory period**

1. Navigate to the Samples screen.
2. On the link bar, click Reconciliation.

The Reconciliation view contains the following lists:

<table>
<thead>
<tr>
<th>List</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unreconciled Inventory Periods</td>
<td>Shows all inactive (past, unreconciled) inventory periods. An active period becomes inactive once you submit an inventory count for the period (as described in “To add products to inventory and submit an initial count” on page 142).</td>
</tr>
<tr>
<td>Unreconciled Inventory</td>
<td>Shows the products in your inventory, their physical and electronic counts, and the difference between the two counts (if any). The Difference field must be zero for all products before you can reconcile the period.</td>
</tr>
<tr>
<td>Samples History</td>
<td>Shows samples transactions entered for the currently selected product in the Unreconciled Inventory list. If no transactions were entered for the selected product during the inactive inventory period, this list is empty.</td>
</tr>
</tbody>
</table>

3. In the Unreconciled Inventory list, verify that the Difference field shows zero for the products listed.

   If a product shows a value other than zero, you must make an adjustment to correct the difference. For more information, see “Adjusting a Past Samples Transaction” on page 149.

4. In the Unreconciled Inventory Periods list, click Reconcile.

   The lists in the view are cleared.

5. From the Show drop-down list, select My Samples History.

   The Samples History view appears. In the Inventory Periods list, a check mark appears in the Reconciled field of the inactive period that you just reconciled.

---

**Creating a Samples Transfer**

You create a samples transfer whenever product samples are exchanged within your company. This procedure can be used by:

- A samples administrator to send shipments to end users in the field
- End users to exchange samples between themselves
- End users to return samples to the home office
Once the samples transfer has been submitted into the system, the recipient receives a samples transfer. After the recipient acknowledges the receipt of the transaction, the application enters the new inventory into his or her inventory count. For more information, see “Acknowledging Receipt of a Samples Transfer (End User)” on page 154.

**NOTE:** Samples returns are defined as transfer transactions for which corresponding received shipment transactions have not been created. Returned samples are subtracted from the sender’s inventory counts but are not added to the master inventory, because they are typically expired or damaged products.

**To create a samples transfer**

1. Navigate to the Samples screen.
2. On the link bar, click Sent Samples.
3. In the My Sent Samples list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transfer #</td>
<td>The application automatically generates an unique identifier. You can change this value.</td>
</tr>
<tr>
<td>Transfer Date</td>
<td>The application automatically generates a date and time value that falls in the active period.</td>
</tr>
<tr>
<td>Transfer Status</td>
<td>The application automatically changes this field value to Submitted when you submit the transaction.</td>
</tr>
<tr>
<td>Transfer to Last Name</td>
<td>The employee to whom you are transferring the samples. If the value of the Transfer Type field is Transfer Out, you must complete this field. Leave this field empty if the value of the Transfer Type field is Return.</td>
</tr>
<tr>
<td>Transfer Type</td>
<td>Select the appropriate value:</td>
</tr>
<tr>
<td></td>
<td>■ Transfer Out - Indicates you are transferring samples to another employee.</td>
</tr>
<tr>
<td></td>
<td>■ Return - Indicates you are returning samples to the home office. Samples are typically returned because they are expired or damaged products that should be destroyed. Transfers with the Transfer Type field set to Return do not generate shipment transactions, and they are not added to the master inventory counts. However, the samples administrator can see returned samples transactions in the Administration - Samples views. For more information, see “Monitoring Samples Activities” on page 147.</td>
</tr>
<tr>
<td>Inventory Period with Comments</td>
<td>Inventory period restricts the available products and Lot #’s for selection when adding line items. Also ensures that only valid product and Lot # for the selected inventory period are available for selection and that the Transfer Txn is entered for the appropriate inventory period.</td>
</tr>
</tbody>
</table>
4 In the Line Items list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #</td>
<td>The application automatically generates an unique identifier. Edit this value to have the items appear in a particular order.</td>
</tr>
<tr>
<td>Item Status</td>
<td>The application automatically changes this field value to Submitted when you submit the transaction.</td>
</tr>
<tr>
<td>Lot #</td>
<td>The lot number for this samples transfer.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity that you are transferring.</td>
</tr>
<tr>
<td>Sample</td>
<td>The samples being transferred.</td>
</tr>
</tbody>
</table>

Repeat Step 4 to enter a line item for each product or promotional item you are transferring.

5 Click Submit.

**NOTE:** A transfer transaction cannot be modified or deleted after it has been submitted.

The value of the Transfer Status field (in the Sent Samples list) and the Item Status field (in the Line Items list) changes to Submitted.

6 On the link bar, click Samples History.

When you select a product that has been transferred in Inventory List, the line items of the transfer transaction appear in the Samples History list.

### Monitoring Samples Activities

As the samples administrator you are responsible for your company’s samples inventory and making sure it complies with regulatory rules and regulations. Use the views described in Table 15 on page 148 to monitor samples activity across the enterprise.

**To access monitor samples activities**

1 Navigate to the Administration - Samples screen.
2 On the link bar, click one of the view names listed in the left column of Table 15.

**NOTE:** The views discussed in Table 15 are read-only and appear only when you are connected to the server.

Table 15. Administrator Views for Monitoring Samples Activity

<table>
<thead>
<tr>
<th>View</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Count</td>
<td>Shows samples inventory counts that have been submitted within the enterprise.</td>
</tr>
<tr>
<td>Inventory Adjustments</td>
<td>Shows inventory adjustments for the organization. Adjustment transactions can be submitted by end users or by the samples administrator to resolve discrepancies between physical and electronic inventory counts. Adjustment transactions provide a clear audit trail of samples inventory adjustments.</td>
</tr>
<tr>
<td>Received Samples</td>
<td>Shows samples receipt transactions submitted by end user. The Line Items list shows the line items of the samples receipt currently selected in the Samples Receipts list. This view allows the administrator to review sent shipments between end users.</td>
</tr>
<tr>
<td>Sample Discrepancies</td>
<td>Shows samples receipts submitted by users in which the received quantity did not match the shipped quantity. The Line Items list shows the line items for the receipt currently selected in the Sample Discrepancies list. This view allows the administrator to make sure that samples are not being diverted.</td>
</tr>
<tr>
<td>Samples History</td>
<td>Shows a list of samples transactions. Be aware that:</td>
</tr>
<tr>
<td></td>
<td>■ If a Contact record is removed, the application removes that name from all lists that reference that contact's name in the S_CONTACT table. This can cause the name fields in Samples History records to appear empty. Use caution when deleting Contacts records.</td>
</tr>
<tr>
<td></td>
<td>■ Drilling down on the Transaction # takes users to the view where the transaction was created. In order to assure that users can take advantage of these hyperlinks, they must have the destination view for product hyperlinks in their responsibilities.</td>
</tr>
</tbody>
</table>
Adjusting a Past Samples Transaction

The samples administrator and end users can adjust inventory counts of samples stock by making adjustments to past samples transactions. Common reasons for adjusting past transactions include product loss or expiration, counting mistakes, or data entry errors. You can add products or adjust quantities for any type of samples transaction (disbursement, transfer, order, and so on).

**NOTE:** You cannot add a product to your inventory that did not exist when the original transaction was created.

You adjust a past samples transaction in the Samples History view.

When you select a product in the Inventory List, the Samples History list shows samples transactions entered for that product. For example, if a sales representative dropped multiple samples on a call, the Samples History list would display one line-item record for each sample. Also, if an adjustment has been made to an item in the transaction, an additional row (corresponding to the adjustment) will appear in this view.

**To add a product to a samples transaction**

1. Navigate to the Samples screen.
2. On the link bar, click Samples History.
3. In the Inventory List, select a product.

   When you select a product in the Inventory List, the Samples History list shows all samples transactions entered for that product. You can identify the transaction record in the Samples History list by the Transaction Date, Last Name, or Transaction # field values.

4. In the Samples History form, create a new record.

   When you create a new record, the application adds a new line-item record for the transaction in the Samples History list and sets the line-item record’s Item field Status to In Progress. With the exception of the Item Status value, the new record is a copy of the record selected in Step 3.
In the Samples History form, modify the new record to reflect the correct product information. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By Full Name</td>
<td>The full name of the creator of the transaction.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the product or comment describing the transaction.</td>
</tr>
</tbody>
</table>
| Item Status                  | The application automatically changes this field value to Submitted when you submit the adjustment. For any row that shows an item status of Submitted, you can also see one or more rows with the identical sample name and transaction number but with an item status of In Progress or Adjusted. Valid values include:
  • In Progress — Indicates that the adjustment record has not yet been submitted, so it can still be modified. However, the record’s data is not reflected in the inventory count.
  • Submitted — Indicates that the record has been submitted and therefore cannot be modified. Because it has been submitted, the record’s data is reflected in the inventory count.
  • Adjusted — Indicates that a previously submitted record has been superseded by a subsequent adjustment record. The record cannot be modified. |
| Lot #                        | The correct lot number for this sample.                                  |
| Quantity                     | The quantity of samples shipped or disbursed in the transaction.         |
| Sample                       | Verify that the correct product name is selected.                        |
| Transaction #                | The transaction number or, in the case of samples disbursements, the reference number. The Transaction # value corresponds to the Ref # value displayed in the Contact Call Detail view. |
| Transaction Date             | The date the transaction was created.                                    |
| Transaction Status           | An indicator of the status of the original sample transaction.            |
| Transaction Type             | Shows the type of transfer. Valid values include Transfer Out and Transfer In. |
| Transfer To/From Full Name   | The name of the employee receiving or generating the transaction. Used only if the transaction type is Transfer Out or Transfer In. |

To adjust a quantity in a samples transaction

1. Navigate to the Samples screen.
2 On the link bar, click Samples History.

3 In the Inventory Periods list, select the period containing the transaction for which you want to adjust a quantity.
   The products for the selected period are displayed in the Inventory List.

4 In the Inventory List, select the product whose quantity you want to adjust.
   When you select a product in the Inventory List, the Samples History list lists all samples transactions entered for that product. You can identify the transaction record in the Samples History list by the Transaction Date, Last Name, or Transaction # field values.

5 In the Samples History form, click Adjust Qty and then OK.
   The application first verifies that you have sufficient rights to make the adjustment and then adds a new line-item record for the transaction in the Samples History list and sets the line-item record’s Item Status field to In Progress. With the exception of the Item Status value, this record is a copy of the record you selected in Step 4.

6 In the Samples History form, enter the correct quantity in the Quantity field.

7 Click Submit, and then OK.
   The application creates a new item with an Item Status of Submitted and changes the original item record (whose quantity you adjusted) to an Item Status of Adjusted. The new quantity is reflected in the on-hand quantities in the Inventory Count view.

Checking Electronic Signatures

End users can use Siebel Pharma or Siebel Pharma Handheld to electronically capture signatures. The Signature Audit Administration view lists the four most recent electronically captured signatures of a contact to whom samples were dropped.

As the samples administrator, be sure to check Signature Audit Administration regularly and perform signature capture verification to make sure that signatures collected from each contact are consistent.

The signature capture verification determines if the call information has been modified by comparing the information captured from the signature (the signature event string) with the current call information (the current call string). Reasons for call information modification include:

- Recreation of a sample receipt
- Sample adjustments
- Fraud

Signature capture verification is launched from the Verify button on the Signature Audit Administration view. For an example of signature audit administration, see Siebel Pharma Handheld Guide.

As the samples administrator you are responsible for your company’s samples inventory and making sure it complies with regulatory rules and regulations. Use the views described in Table 15 on page 148 to monitor samples activity across the enterprise.
To display Signature Audit Administration

■ Navigate to the Administration - Samples screen > Signature Audit Administration view.

NOTE: If a Contacts record is deleted, the application removes the contact name from lists that reference that contact’s name in the S_CONTACT table. Therefore, if the Contact Id is deleted from the S_ACT_SIGN table, the last name and first name fields appear empty in the Signatures form within the Signature Audit Administration view. However, deleting a Contacts record does not affect the Contact Full name because it is stored in a text field in the same table. In the Pharma Signature Receipt Form, the control above the Signature shows the full name of the contact at the time of the call (that is, no reference to the S_CONTACT table). Because the contact’s name is not removed from this list, a permanent and complete electronic record of calls captured with signatures recorded electronically is maintained.

Generating a Receipt for Calls with Electronic Signatures
The Sample Event Administration view shows an entire sample transaction as it was recorded at the time the signature was captured. Sales representatives can submit electronically captured signatures using Siebel Pharma or Siebel Pharma Handheld.

To display Sample Event Administration
■ Navigate to the Administration - Samples screen > Sample Event Administration view.

Creating New Disclaimer Text for Signature Capture Display
The Disclaimer Administration view shows the disclaimer information that appears in the LS Pharma Call Signature Form Applet (in Siebel Pharma) or the Siebel Signature Capture display (in Siebel Pharma Handheld).

To display the Disclaimer Administration view
1 Navigate to the Administration - Samples screen > Disclaimer Administration view.

2 To replace existing disclaimer text, create a new record in the Disclaimers list and complete the necessary fields.

   The new disclaimer becomes active immediately. Only one disclaimer can be active at a time.

About Establishing an Initial Inventory Count (End User)
End users only need to establish an initial inventory count when their initial counts contain records that they manually entered into Siebel Samples Management. If that is the case, they must set up an initial master inventory, make adjustments, and then reconcile it as described in "Establishing an Initial Inventory" on page 141.
If their initial counts only contain samples routed to them by their samples administrator, they simply need to acknowledge the receipt of those shipments. For more information, see "Acknowledging Receipt of a Samples Transfer (End User)" on page 154.

Creating a Samples Order (End User)

End users can request additional samples by creating a samples order. Once submitted, the application routes the samples order to the samples administrator. The samples administrator then creates a samples transfer that is routed back to the requestor. Once the requestor acknowledges receipt of the transfer, Siebel Samples Management automatically enters the new inventory into their inventory counts.

**NOTE:** Creating samples orders is optional. Siebel Samples Management allows users to acknowledge receipt of samples shipments, even if they have not created orders for those samples. The Siebel administrator determines whether or not users are required to create samples orders for record-keeping purposes.

To create a samples order

1. Navigate to the Samples screen.
2. On the link bar, click Samples Orders.
3. In the Samples Orders list, create a new record.
   - The application creates a new record and automatically sets the Order Date field to a date and time in the active period.
   - **NOTE:** It is not necessary to change the Order Type field. You can include both samples and promotional items in a single order.
4. In the Line Items list, create a new record, and complete the necessary fields.
   - Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Status</td>
<td>Initially set to In Process. The application automatically changes this field value to Submitted when you submit the transaction.</td>
</tr>
<tr>
<td>Sample</td>
<td>The product to be ordered.</td>
</tr>
</tbody>
</table>

   Repeat **Step 4** to enter a line item for each product or promotional item you want to order.
5. Click Submit.
   - **NOTE:** An order cannot be modified or deleted after it has been submitted.

The values of the Order Status field (in the Samples Order list) and the Item Status field (in the Line Items list) change to Submitted.
Managing Pharma Samples

Acknowledging Receipt of a Samples Transfer (End User)

Siebel Samples Management supports two ways of electronically moving samples inventory:

- By creating a samples transfer, see “Creating a Samples Transfer” on page 145
- By creating a samples order, see “Creating a Samples Order (End User)” on page 153

In either case, the application creates a samples transfer transaction and routes it to the recipient for acknowledgement. Once the recipient submits a receipt, the application transfers the new inventory into their active inventory period. End users can then view the new inventory in the Samples History screen. For more information on displaying the Samples History view, see “Adjusting a Past Samples Transaction” on page 149.

To acknowledge receipt of a samples transfer

1. Navigate to the Samples screen > Received Samples view.

2. In the Received Samples list, select the transfer that you want to acknowledge.

   Samples transfers that have not been acknowledged as received show an Invoice Status value of In Progress. Those that have been acknowledged as received show an Invoice Status value of Submitted.

3. In Line Items list, modify the Received Quantity field if the value does not accurately reflect the quantity received.

4. Click Submit.

   **NOTE:** The samples transfer quantities do not appear in end users inventory counts until they submit a samples receipt. However, once the samples receipt has been submitted, it cannot be modified or deleted.

   The values in the Invoice Status field (Received Samples list) and the Item Status field (Line Items list) change to Submitted.

   End users can track discrepancies between shipped quantities and received quantities by using the My Received Samples Transfer Discrepancies filter. A manager’s version of this view is also provided, and the samples administrator can track samples discrepancies system-wide by using an Administration - Samples view. For more information on available administration views, see “Monitoring Samples Activities” on page 147.

5. Navigate to the Samples screen > Samples History view.

   The Samples History view appears. Selecting a period in the Inventory Periods list shows the line items of the received transfer in the Samples History list.
Adjusting an Inventory Count (End User)

The administrator and end users can adjust inventory counts of samples stock by making adjustments to past samples transactions. Common reasons for adjusting past transactions include product loss or expiration, counting mistakes, or data entry errors. When adjusting an inventory account, users may add products or adjust quantities for any type of samples transaction (disbursement, transfer, order, and so on). For more information on adjusting inventory counts, see “Adjusting a Past Samples Transaction” on page 149.

Recording Thefts and Losses (End User)

End users record sample thefts or losses in the Samples Adjustments view.

To record a sample theft or loss
1. Navigate to the Samples screen.
2. On the link bar, click Sample Adjustments.
3. In the Samples Adjustments list, create a new record.
4. In the Adjustment Reason field, select Lost.
5. In the Line Items list, create a new record, and complete the necessary fields.
6. Click Submit.

Reconciling an Inventory Period (End User)

At least once a year, end users are required to perform an inventory reconciliation to remain in PDMA compliance. Users might also need to perform an inventory reconciliation if they are receiving a promotion or leaving the company. For more information on reconciliation, see “Inventory Reconciliation” on page 130.

Prior to starting inventory reconciliation, users must perform the steps outlined in Figure 3.

Figure 3. Inventory Reconciliation Prerequisites

These inventory reconciliation prerequisites must be performed in the following order:
Managing Pharma Samples  ■  Reconciling an Inventory Period (End User)

- **Verify previous inventory periods are reconciled.** End users must reconcile previous inventory periods in chronological order. This is only a concern if a company’s configuration allows more than one inactive, unreconciled period. For more information, see "About Establishing an Initial Inventory Count (End User)" on page 152.

- **Acknowledge receipt of inventory transfers.** End users must send acknowledgements for all received sample inventory shipments. For more information, see "Acknowledging Receipt of a Samples Transfer (End User)" on page 154.

- **Create transfer transactions for transferred samples.** End users must create transfer transactions for any samples transferred to another representative or returned to the home office. For more information, see "Creating a Samples Transfer" on page 145.

- **Mobile users synchronize with server database.** Mobile end users must synchronize their local database with the server database before submitting an inventory count. This is especially important if they are recording samples received in a prior period or to be received in a future period. For more information on synchronizing a local database, check with your Siebel administrator.

**NOTE:** Counts for transferred and received samples are not reflected in the inventory count until their records have been submitted.

An inventory period cannot be reconciled if any discrepancy exists between the physical and electronic counts. If a discrepancy exists, it must be corrected before a user can reconcile the period. For more information, see the procedure "To identify discrepancies in inventory counts" on page 157.

The reconciliation process consists of the steps outlined in Figure 4.

Figure 4. Inventory Reconciliation Process

These reconciliation steps must be performed in the following order:

- **Create and submit an inventory count.** End users must create and submit an inventory count (either by product or lot number) of the products currently on-hand. For more information, see the procedure "To create and submit an inventory count" on page 157.

  End users cannot submit a count differently from the way they submitted the previous period’s count unless the previous period has been reconciled. For example, if they submitted the previous period’s count by product name, they must reconcile that period before they can submit a subsequent count by lot number.

- **Correct physical and electronic count discrepancies.** End users must correct any discrepancies between the physical counts and the electronic counts by:
Creating and submitting a sample adjustment transaction with one or more line items. For more information, see the procedure "To adjust multiple quantities with a new adjustment transaction" on page 158.

This method allows end users to adjust the inventory counts of multiple products with a single adjustment transaction (containing multiple line items). However, they may want to use this method if they need to adjust more than two or three counts.

Adjusting previous transactions. Adjusting line-item records of previously entered transactions. For more information, see the procedure "To adjust a quantity in a samples transaction" on page 150.

This method allows end users to adjust the quantity of a selected line item in a previously entered transaction. However, they may want to use this method if they only need to adjust one or two counts.

Reconcile the inventory period. For more information, see the procedure "To reconcile an inventory period" on page 159.

**To create and submit an inventory count**

1. Physically count all samples currently on-hand.
2. Navigate to the Samples screen.
3. On the link bar, click Inventory Count.
   
   The Inventory Count list lists records for every product in your inventory.

   **NOTE:** Records in the Inventory Count view can be deleted only if the value of the On Hand Quantity field is zero. Do not delete records from this view unless you are certain that you will not need to enter adjustments to any transactions containing the product in the future or in a past unreconciled period.

4. In the Inventory Count list, enter a value in the Count field for all records.
   
   The Difference field in some records may show a value other than zero.

   Proceed in one of the following ways:

   - If the Difference field in any record shows a value other than zero, click Submit and follow the procedure "To identify discrepancies in inventory counts" on page 157.
   - If the Difference field in all records is equal to zero, click Submit and follow the procedure "To reconcile an inventory period" on page 159.

**To identify discrepancies in inventory counts**

1. Navigate to the Samples screen.
2. On the link bar, click Reconciliation.
3. In the Unreconciled Inventory Periods list, select the period that you want to reconcile.
4. In the Unreconciled Inventory List, scroll to determine how many product records show a value other than zero in the Difference field.
For every record in the Unreconciled Inventory List whose Difference field does not equal zero, write down the sample name, the lot number, and the value displayed in the Difference field.

A positive value in the Difference field means that your electronic count (the Stock Quantity field) is greater than your physical count (the Counted Quantity field). A negative value in the Difference field means that your electronic count (the Stock Quantity field) is less than your physical count (the Counted Quantity field).

Proceed in one of the following ways:

- If only a small number of records require adjustments, enter individual line-item adjustments for those transactions. In this case, write down the transaction numbers of the transactions you plan to adjust.

  The Samples History list displays all transactions corresponding to the product selected in the Unreconciled Inventory List. You can find the transaction number in the Transaction # field of the Samples History list. Then use the following procedure: “To adjust a quantity in a samples transaction” on page 150.

- If multiple records require adjustments, enter a single adjustment transaction, with multiple line items, that adjusts all the quantities. To do this use the following procedure: “To adjust multiple quantities with a new adjustment transaction” on page 158.

**To adjust multiple quantities with a new adjustment transaction**

1. Navigate to the Samples screen.
2. On the link bar, click Samples Adjustments.
3. From the Show drop-down list, select My Samples Adjustments.
4. In the Samples Adjustments list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjustment Reason</td>
<td>Follow your company’s guidelines for what to select for this field.</td>
</tr>
<tr>
<td>Transaction #</td>
<td>The application automatically generates an unique identifier. You can change this value.</td>
</tr>
<tr>
<td>Transaction Date</td>
<td>The application automatically generates an unique identifier for this field.</td>
</tr>
<tr>
<td>Transaction Status</td>
<td>The value will be changed to Submitted when you submit the transaction.</td>
</tr>
</tbody>
</table>
5 In the Line Items list, create a new record, and complete the necessary fields.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Date</td>
<td>This field is automatically filled when you complete the Lot # field.</td>
</tr>
<tr>
<td>Item Status</td>
<td>The application changes value in this field changes to Submitted when you submit the transaction.</td>
</tr>
<tr>
<td>Item #</td>
<td>The number of this item in the transaction. Line numbers are automatically generated but can be edited. You might want to edit this value to have the items appear in a particular order (other than the order in which you entered them).</td>
</tr>
<tr>
<td>Lot Name</td>
<td>The lot number for this sample.</td>
</tr>
</tbody>
</table>
| Quantity    | The amount of the sample adjustment. The quantity you enter can be positive or negative, depending on the value you recorded in Step 5 on page 158:  
  ■ If the value that you recorded was positive, enter a negative quantity.  
  ■ If the value that you recorded was negative, enter a positive quantity. |
| Sample      | The product for which you want to enter a quantity adjustment.            |

Repeat Step 5 until you have entered a line item for each needed adjustment.

6 In the Samples Adjustments list, click Submit.
The values of the Transaction Status field (in the Samples Adjustments list) and the Item Status field (in the Line Items list) change to Submitted.

7 Reconcile the inventory period, as described in the following procedure.

To reconcile an inventory period
1 Navigate to the Samples screen > Reconciliation view.
2 In the Unreconciled Inventory Periods list, select the inventory period that you want to reconcile.
3 Scroll through the records.
4 In the Unreconciled Inventory List, scroll through the records and verify that the value of the Difference field for each record is zero.
5 Click Reconcile.
The Samples Reconciliation view is cleared.
9 Recording Calls in Pharma

This chapter covers the following topics:

- "About Recording Calls in Pharma” on page 161
- "About the Submit Button” on page 161
- "About Electronic Signature Capture” on page 165
- “Scenario for Recording Calls” on page 166
- “Process of Recording Calls” on page 167
- "(Optional) Recording Marketing Responses in Contact Calls” on page 167
- “Recording and Submitting Contact Calls” on page 168
- “Recording a Contact Call for a Different Contact at the Time of Signature Capture” on page 170
- “Recording and Submitting Account Calls” on page 172
- “Remaking Electronic Signatures” on page 174
- “Configuring the Submit Button” on page 175
- “Configuring the Sign Button” on page 176
- “Marking Package Insert Delivery and Post Market Surveillance Calls as Complete” on page 182

About Recording Calls in Pharma

This chapter describes how to record account and contact calls in Siebel Life Sciences. For more information on planning account and contact calls, see Chapter 7, “Planning Calls in Pharma.”

Using the procedures in this chapter, you can perform the end-user tasks of recording contact and account calls such as adding information about products detailed, capturing signatures electronically, and submitting calls.

If you are using Siebel Pharma Campaigns, you can record contacts responses to campaign offers to achieve closed-loop marketing.

Contact and account calls are both types of activity records. Although you can create contact and account calls in the Contacts and Accounts screens, you can only record the details of calls in the Activities screen.

About the Submit Button

Clicking the Submit button in Siebel Life Sciences causes a number of important events to occur within the application. Table 16 describes the specific actions that occur when clicking the Submit button in the view listed in the left column.
Table 16. Effects of the Submit Button on Siebel Life Sciences Views

<table>
<thead>
<tr>
<th>View</th>
<th>Access Path</th>
<th>Transaction Type</th>
<th>Clicking the Submit button...</th>
</tr>
</thead>
</table>
| Contact Call Detail | Activities > Contact Call Detail | Disbursement | Changes the contact call detail Status field to Submitted.  
Except for the Comment field, sets the record to read-only.  
Sets all child records to read-only.  
**NOTE:** The Disburse on Signature Capture system parameter is set to TRUE by default. This means that when the user clicks the Save button on Signature Capture view, the application decrements the inventory count for Samples Dropped only. For Promotional Items Dropped, transaction records are generated upon submitting the call.  
If samples were dropped, and the Disburse on Signature Capture system parameter is set to FALSE, then clicking the Submit button creates a Samples Transaction History record. |
| Account Call Detail | Activities > Account Call Detail | Disbursement | Changes the account call detail Status field to Submitted.  
Except for the Comment field, sets the record to read-only.  
Sets all child records to read-only.  
If the Disburse on Signature Capture system parameter is set to TRUE, the application decrements the inventory count for Samples Dropped only when the user clicks the Save button on Signature Capture view.  
If samples were dropped, clicking the Submit button creates a Samples Transaction History record only if the Disburse on Signature Capture system parameter is set to FALSE. |
Table 16. Effects of the Submit Button on Siebel Life Sciences Views

<table>
<thead>
<tr>
<th>View</th>
<th>Access Path</th>
<th>Transaction Type</th>
<th>Clicking the Submit button...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inventory Count</td>
<td>Samples &gt; Inventory Count</td>
<td></td>
<td>Verifies each a value has been entered in the Count field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Changes the status of each record to inactive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Creates an active transaction by moving the count in the latest inventory period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>NOTE:</strong> Products with Expired Lot# and with zero physical count will not be moved in to the new inventory period.</td>
</tr>
<tr>
<td>Received Samples</td>
<td>Samples &gt; My Received Samples</td>
<td>Transfer In</td>
<td>Updates the user inventory to reflect the quantity entered in Received Quantity field of the Line Items list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Updates Sample Invoices by setting the Active flag to N (No).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the Invoice Status is submitted, the application updates the Line Items list by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Setting the Stock Update flag to Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Updates the Stock Position ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Changes the Item Status to Submitted</td>
</tr>
<tr>
<td>Sample Order</td>
<td>Samples &gt; My Samples Order</td>
<td>Sample Order</td>
<td>Updates the Samples Orders list by setting the Active flag to N (No).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the Order Status is submitted, the application updates the Line Items list by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Setting the Stock Update flag to Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Updates the Stock Position ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Changes the Item Status to Submitted</td>
</tr>
</tbody>
</table>
When a user clicks the Submit button in either the Contact Call Detail or Account Call Detail views, the application verifies that:

- At least one product has been recorded and detailed.
  
  This requirement can be changed by the administrator. For more information, see Appendix A, “Configuring Siebel Life Sciences.”

- The call’s date and time is the same as or earlier than the current date and time. A call cannot be submitted with a future date.

If dropped samples are recorded for the call, the application checks that:

- The samples exist in the inventory for the period indicated by the call’s date and time.

---

Table 16. Effects of the Submit Button on Siebel Life Sciences Views

<table>
<thead>
<tr>
<th>View</th>
<th>Access Path</th>
<th>Transaction Type</th>
<th>Clicking the Submit button…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples Adjustments</td>
<td>Samples &gt; My Samples Adjustments</td>
<td>Inventory Adjustment</td>
<td>Updates the user inventory to reflect the quantity entered in Quantity field of the Line Items list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Updates Sample Adjustments by changing the Active flag to N (No).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the Transfer Status is Submitted, the application updates Line Items list by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Setting the Stock Update flag to Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Updating the Stock Position ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Changing the Item Status to Submitted</td>
</tr>
<tr>
<td>Sent Samples</td>
<td>Samples &gt; My Sent Samples</td>
<td>Transfer Out</td>
<td>Updates the user inventory to reflect the quantity entered in Line Items list Quantity field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Updates My Sent Samples by setting the Active Flag to N (No), Changes the Status to Submitted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If the Transfer Status is Submitted, the application updates the Line Items list by:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Setting the Update Flag to Y (Yes)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Updating the Stock Position ID</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Changing the Item Status to Submitted</td>
</tr>
</tbody>
</table>
The period into which the samples will be recorded is an unreconciled period. If it is a reconciled period, a warning message appears.

A valid lot number has been specified for dropped samples tracked by lot number.

The Ref # field is not empty (paper signature only).

If the call passes these checks, the application:

- Creates a samples disbursement transaction, with a line item for each dropped sample recorded for the call.
  
  **NOTE:** If the Disburse on Signature Capture system parameter is set to TRUE, the application decrements the inventory count for Samples Dropped only when the user clicks the Save button on Signature Capture view.

- Submits a disbursement transaction to update the samples inventory. If the submission of the disbursement transaction is successful, the application changes the call’s Status field to Submitted.

- Sets the Last Call Date field for the contact or account to the date of the submitted call, and many fields in the call record become read-only.

The Siebel administrator can change the fields that become read-only after a call is submitted (or synchronized with Siebel Pharma Handheld on a PDA). For information, see “Configuring the Submit Button” on page 175 (Changing Read-Only Fields).

  **NOTE:** If attendees are recorded in an account call, an attendee call is created for each attendee, and the process described above is performed for each attendee call. Attendee calls are the same as contact calls except that they do not appear in the Activities view, and they are submitted automatically when the account call is submitted.

---

**About Electronic Signature Capture**

Users can capture signatures for samples disbursement within Siebel Pharma running on a mobile client. End users can capture signatures directly on the screen for samples dropped to qualified contacts.

**NOTE:** Electronic signature capture is enabled for Siebel Mobile Web Clients only; it is not enabled on Siebel Web Clients connected to the Siebel Server.

For information about configuring logic behind the Sign button and the appearance of the LS Pharma Call Signature Form Applet, see “Configuring the Sign Button” on page 176.

Signature capture is supported on tablet PCs using Windows XP on versions 7.7, 7.8, and 8.0. See Siebel System Requirements and Supported Platforms on Oracle Technology Network for information about which operating systems and devices are supported with the current release of Siebel Pharma. (For example, some releases are not certified on the Tablet PC platform.)

Electronic signature capture is also available on handheld devices. For more information, see Siebel Pharma Handheld Guide.
Scenario for Recording Calls

This topic outlines an example process performed by end users when recording contact and account calls. Your company may follow a different process according to its business requirements. A sales representative for a pharmaceutical company has a busy day of calls to both individual physicians and to accounts.

Recording Call Information

As he makes calls, the sales representative records the information about the call. He records information relating to samples delivered to the physicians during the call, including details such as the lot number and the quantity.

The sales representative records information about the products discussed and the indications for which the products were promoted. The representative also delivers promotional items, a coffee mug and some memo pads, which he also records as part of the call information. He logs the issues that the contact raised during the call so he can follow up on them prior to his next visit.

Obtaining Signatures for Dropped Samples

This sales representative is using the electronic signature capture: the physician acknowledges receipt of dropped samples by using a stylus to sign directly on screen, and the signature is recorded in the Pharma application. (Alternatively, sales representatives can collect paper signatures and record a reference number for the paper signature in the Pharma application.)

Delivering Marketing Messages and Recording the Contact’s Response

Some of the physicians he visits have been targeted in specific marketing campaigns. Information about these campaigns appears automatically in the appropriate contact call records—this reminds the sales representative to deliver the marketing messages. The sales representative enters the physicians’ responses to the messages.

(The response information is later reviewed by the marketing manager; she uses the information for refining segmentation and targeting.)

Submitting the Call

After making sure that all data about the call is correctly entered, the sales representative submits the calls. This changes most fields to read-only so that the call records cannot be accidentally changed or tampered with.

In the Event of a Mistake, Remaking Electronic Signatures

Unfortunately, after submitting the final account call, the sales representative realizes that the two doctors attending the call mistakenly signed for each other’s samples. The next day, the sales representative returns to the account and the doctors sign again for their samples.
Process of Recording Calls

This example process represents the tasks that are carried out in the "Scenario for Recording Calls" on page 166. Your company may follow a different process according to its business requirements.

**NOTE:** Prior to recording calls, end users need to set up and update their personal lists, create target lists and route plans, and create activities. For more information, see Chapter 7, "Planning Calls in Pharma."

1. "(Optional) Recording Marketing Responses in Contact Calls" on page 167. (Requires Siebel Pharma Campaigns.)
2. "Recording and Submitting Contact Calls" on page 168.
3. "Recording a Contact Call for a Different Contact at the Time of Signature Capture" on page 170.
4. "Remaking Electronic Signatures" on page 174. If you are using electronic signature capture and you discover after submitting a call that a professional signed the wrong receipt, you can re-create the receipt.

For more information on planning calls and setting up meetings, see Chapter 7, "Planning Calls in Pharma" and "Setting Up a Meeting (End User)" on page 115.

**(Optional) Recording Marketing Responses in Contact Calls**

If your license includes Siebel Pharma Campaigns, information about the contact’s response to campaign offers can be recorded for the contact call, through the Contact Call Detail - Marketing view.

These campaign offers may be actual offers, such as an invitation to an event. Or, the offers may be messages about products that the sales representative conveys during the contact call. These messages augment the call products detailed by delivering more granular information and by recording the responses received during detailing. These messages are part of marketing campaigns, and responses must be recorded in order to capture the bidirectional flow of information.

The contact’s response also appears in the Track Results view for the campaign; this closes the loop on the marketing strategy and allows the marketing manager to assess the effectiveness of the campaign and to further refine segmentation and targeting.

*To record offer responses in contact calls*

1. Display the call in the Contact Call Detail - Marketing view, for example, in one of the following ways:
   - Navigate to the Activities screen > Activities List view, and drill down on a planned contact call activity.
Recording Calls in Pharma

Recording and Submitting Contact Calls

- Navigate to the Contacts screen > Contacts List view, drill down on a contact, click the Calls view tab, and drill down on the call.

**NOTE:** For more information on scheduling and creating contact calls, see “Creating a Contact Call (End User)” on page 117.

2 In the Marketing Communications list, select an offer.

This list displays campaign offers where:

- The offer is of channel type Contact Call
- The contact is a prospect associated with the offer’s campaign

3 In the Response list, create a new record, and complete the necessary fields.

The choices for the Response field are restricted to the response templates set up for the offer. For more information, see about contact call offers in the Siebel Marketing User Guide.

After the call is submitted, the responded to offer record will not be available for future calls to that contact. If no response was recorded for the offer, the offer record is not included in the submitted call and will be available for future calls to the contact.

---

Recording and Submitting Contact Calls

Some end users carry their laptops with them throughout the day and enter call information as they make the calls. (This is necessary if signatures are captured electronically when samples are dropped.) Others choose to enter all call details at the end of the day.

End users track details about calls made on a contact with contact call records. Although users can create and display contact calls on the Contacts screen, they enter details about the actual call in the Activities screen. To record a contact call, users must complete the following procedures:

- Display the Contact Call Detail view
- Enter information on products detailed
- Enter information about any samples dropped and obtain signatures for these dropped samples
- Enter information about any promotional items dropped
- Record any decision issues discussed during the call
- Submit the call

**NOTE:** End users can view all activities, contacts, and opportunities associated with an account and its child accounts on the account hierarchy tree. For more information, see Chapter 5, “Administering and Managing Accounts in Life Sciences.”

This task is a step in “Process of Recording Calls” on page 167.

**To record contact calls**

1 Display the call in the Contact Call Detail view, for example, in one of the following ways:
Navigate to the Activities screen > Activities List view, and drill down on a planned contact call activity.

Navigate to the Contacts screen > Contacts List view, drill down on a contact, click the Calls view tab, and drill down on the call.

**NOTE:** For more information on scheduling and creating contact calls, see “Creating a Contact Call (End User)” on page 117.

2 In the Call Product Detailed list, create a new record for each product discussed during the call and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indication</td>
<td>The purpose or therapeutic area for which a drug is designed.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of this product relative to others discussed during the call.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>This field can be configured to automatically assign 1 to the first record and then sequentially number each additional record. For more information, see Appendix A, “Configuring Siebel Life Sciences.”</td>
</tr>
<tr>
<td>Product</td>
<td>The product detailed during the call. The products appearing in this drop-down list are based on the products added to your Personal list. For more information on adding products to your personal lists, see “Creating a Personal List (End User)” on page 106.</td>
</tr>
</tbody>
</table>

3 In the Samples Dropped list, create a new record for each product dropped during the call and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot #</td>
<td>The lot number (if applicable) of the products dropped during the call. If tracking samples by lot number, select a lot number in the Pick Lot dialog box. For more information, see “Defining Lot Numbers for Samples” on page 138.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the products dropped during the call. The products appearing in this drop-down list are based on the products available in your samples inventory. For more information on samples, see Chapter 8, “Managing Pharma Samples.”</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity of sample dropped during the call.</td>
</tr>
</tbody>
</table>

**NOTE:** If the sample you dropped does not appear in the Name field drop-down list, either you need to add it to the Personal Samples list or the sample has not been defined as a product. For information about adding products to the Personal Samples list, see To add a product to a personal list on page 106. It is the responsibility of your administrator to define products.

4 If you are collecting an electronic signature for the dropped samples:
   
a Click Sign.
Recording Calls in Pharma ▪ Recording a Contact Call for a Different Contact at the Time of Signature Capture

1. Obtain the professional’s signature and click Save.
2. Enter sample reference number (if required) in the Ref # field.

5. If you are collecting a paper signature for the dropped samples:
   a. Select the Paper Sign check box.
   b. Obtain the professional’s signature on the paper record.
   c. Enter sample reference number (if required) in the Ref # field.

   **NOTE:** If you want to create a new activity for a different contact at the time of capturing a signature, click New Sample Drop button. The Pick Contact Applet is displayed.

6. In the Promotional Items Dropped list, create a new record for each item dropped during the call and complete the necessary fields.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The promotional item dropped during the call. The items appearing in this drop-down list are based on items added to your Personal Promotional Items list. For more information, see “Creating a Personal List (End User)” on page 106.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity of the promotional item dropped during the call.</td>
</tr>
</tbody>
</table>

7. In the Issues list, create a new record for each issue discussed during the call and complete the necessary fields.

   **NOTE:** Decision issues are the objectives a contact may raise when evaluating a product before making a prescribing decision. For more information, see “Defining Decision Issues” on page 94.

8. Verify that all information entered is correct and click Submit.

   **NOTE:** Once you submit a call, you cannot delete the call nor modify any fields except the Comment field.

   **CAUTION:** If you are a mobile user, submit your calls before connecting to the server, and then synchronize. Mobile users should not submit calls while connected to the server or they run the risk of introducing errors into their inventory counts.

Recording a Contact Call for a Different Contact at the Time of Signature Capture

A sales representative creates a call for a contact, but prior to saving the signature, sales representative might need to choose a different contact or change the address of the call. The representative might need to create a new sample drop call for another contact whom he or she might have met while waiting for the first contact to arrive.

A representative can change an existing call, and click Pick And Sign to quickly navigate back to the Signature Capture view.
A representative can also create a new Call record based on an existing call directly from within the Contact Call view. The New Sample Drop button on the Contacts Call applet enables users to create a Contact Call record with contact Id, address and samples dropped based on data setup from an existing call. The created Call records are displayed in the Contacts Call Detail view under Activities. The user is prompted to select the contact name, and click Pick And Sign to capture the signature.

To create a new Sample Drop based on an existing contact call for a new contact
1. Navigate to the Contacts List screen.
2. Select a Contact record from the list.
3. Click New Call.
   A new Contact record is created and the Contact Call Detail view is displayed.
4. Add Sample Drop records based on the personal list or choose a Smart Call Template to prepare the sample drops.
5. Click Sign.
   If all the business rules are valid, the signature capture window is launched.
6. Verify the contact’s name, address, DEA number and license number displayed in the call header.

To change the contact or address of an existing call
1. Click Cancel on Signature Capture view.
2. Click the small icon on the Last Name field.
   The Pick Contact Applet is displayed. You can query All Contacts, Affiliated Contacts, and By Location to find the relevant contacts.
3. Select a contact from the list, and click Pick And Sign to navigate back to the Signature Capture view.
4. Click the small icon on the Address field.
   The Pick Address Applet is displayed.
5. Select the correct address from the list, and click Pick And Sign to navigate back to the Signature Capture view.

To create a new Sample Drop contact call based on an existing call
1. Click Cancel on Signature Capture view.
2. Click New Sample Drop in the Contact Call Detail view.
   The Pick Contact Applet is displayed. You can query All Contacts, Affiliated Contacts, and By Location to find the relevant contacts.
3. Select a contact from the list, and click Pick And Sign to navigate back to the Signature Capture view.

**NOTE:** The sample drop records are copied when the user clicks New Sample Drop. The details, promotional items, and decision issues are not copied over.

4. Save the signature of the contact.

This action decrements the inventory and creates sample transaction history records.

---

### Recording and Submitting Account Calls

End users track details about calls made on an account with account call records. Although users can create and display account calls on the Accounts screen, they enter details about the actual call on the Activities screen. To record an account call, users must complete the following procedures:

- Display the Account Call Detail view
- Enter information on products detailed
- Enter attendee information (the names of contacts met and any samples dropped)
- Obtain signatures for dropped samples
- Enter information about any activities related to the call (optional)
- Submit the call

This task is a step in “Process of Recording Calls” on page 167.

#### To record account call

1. Display the account call in the Account Call Detail view, for example, in one of the following ways:

   - Navigate to the Activities screen > Activities List view, and drill down on a planned account call activity.
   - Navigate to the Accounts screen > Accounts List view, drill down on an account, click the Calls view tab, and drill down on the call.

**NOTE:** For more information on scheduling and creating account calls, see “Creating an Account Call (End User)” on page 119.
2 In the Call Products Detailed list, create a new record for each product detailed during the call and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indication</td>
<td>The purpose or therapeutic area for which a drug is designed.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of this product relative to others discussed during the call.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>This field can be configured to automatically assign 1 to the first record and then sequentially number each additional record. For more information, see Appendix A, “Configuring Siebel Life Sciences.”</td>
</tr>
<tr>
<td>Product</td>
<td>The product detailed during the call. The products appearing in this drop-down list are based on the products added to your Personal list. For more information on adding products to your personal lists, see “Creating a Personal List (End User)” on page 106.</td>
</tr>
</tbody>
</table>

3 For each contact and employee who attended the account call: in the Attendees list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The Add Attendees dialog box displays both contacts and employees. Affiliated contacts are those associated with the account. For more information, see “Indicating an Affiliation Between an Account and a Contact (End User)” on page 71.</td>
</tr>
<tr>
<td>Samples Dropped</td>
<td>Remember to specify quantity and lot number (if required).</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>The items appearing in the Sample Dropped dialog box are based on items added to your Personal Promotional Items list. For more information, see “Creating a Personal List (End User)” on page 106.</td>
</tr>
<tr>
<td>Sample Reference Number</td>
<td>Reference number for any samples dropped. This reference number becomes the transaction number (Transaction # field) for a samples transaction corresponding to this call. For information on samples transactions, see “Managing Pharma Samples” on page 129.</td>
</tr>
</tbody>
</table>

The application creates an attendee call record (similar to a contact call) for each contact you include as an attendee of the account call. These attendee call records are child records of the account call and appear in the Activities screen under each contact’s name.

4 Drill down on the Name field for each attendee added to the account call.

5 In the Contact Call Detail view:

a Enter any further information such as promotional items dropped and issues discussed.
Obtain a paper or an electronic signature for the dropped samples.

For more information, see Step 4 on page 169 or Step 5 on page 170 of the procedure “To record contact calls” on page 168.

6 Return to the parent account call, in the Account Call Detail view by clicking the back button.

7 In the Activities applet at the bottom of the Account Call Detail view, add any general activities records for the call, such as a reminder to send information about an upcoming medical education event.

8 Verify that all information entered is correct and click Submit.

   NOTE: Once you submit a call, you cannot delete the call nor modify any fields except the Comment field.

   CAUTION: If you are a mobile user, submit your calls before connecting to the server, and then synchronize. Mobile users should not submit calls while connected to the server or they run the risk of introducing errors into their inventory counts.

**Remaking Electronic Signatures**

The sales representative can create an updated sample receipt and signature in the event that the original call information was incorrect.

For example, if Dr. Smith mistakenly signs for the receipt of samples on a request form having a different physician’s name (such as Dr. Jones), then the sample form is inaccurate. In this example, the sales representative must change the name on the original call to the correct physician (Dr. Smith) and have Dr. Smith sign again.

Using the Recreate Receipt button, the sales representative can capture a second signature on the corrected sample form. The Pharma application automatically tracks the appropriate audit trail information required by the FDA and similar agencies in other countries in the recreate receipt functionality.

This task is a step in “Process of Recording Calls” on page 167.

**To remake a receipt**

1 Display the submitted call in the Contact Call Detail view, for example, in one of the following ways:

   - Navigate to the Activities screen > Activities List view, and drill down on the contact call activity.
   - Navigate to the Contacts screen > Contacts List view, drill down on a contact, click the Calls view tab, and drill down on the call.
   - Navigate to the Activities screen > Activities List view, drill down on a planned account call activity, and drill down on the Attendee’s name.
   - Navigate to the Accounts screen > Accounts List view, drill down on an account, click the Calls view tab, and drill down on the Attendee’s name.
2 Click Recreate Receipt.
3 Edit the name and address fields for the professional.
4 Click Sign.
5 Obtain the professional’s signature and click Save.

**NOTE:** Signature records are not sent to the local database in order to avoid sizing issues, and in case your local database is re-extracted.

The Recreate Receipt process first attempts to deactivate current signatures before capturing a new one. If you re-extracted your local database after having captured a signature, the original signature record will not be available to you, hence the process is aborted and you will not be able to capture a recreated receipt signature. Nothing happens when you click the Recreate Receipt button for calls created and signed prior to the re-extraction of your local database.

If you require that local signatures are downloaded from the server to your local database, contact your Oracle sales representative for Oracle Advanced Customer Services to request assistance from Oracle’s Application Expert Services.

**Configuring the Submit Button**

This topic provides information about how to configure the Submit button.

**Changing the Requirement That One Product Must Be Detailed**

When you click the Submit button in either the Contact Call Detail and Account Call Detail views, the application verifies that at least one product has been recorded and detailed. Table 16 on page 162 describes the specific actions that occur when clicking the Submit button in the views in which it appears.

This one-product-dropped requirement can be changed by the administrator using Siebel Tools. The business component user property is Must Detail Products. Table 48 on page 487 shows the user property values that are to be changed.

**NOTE:** A call cannot be deleted after it has been submitted. This behavior is controlled by a specialized class and, for regulatory and data integrity reasons, cannot be configured to allow for deletion.
LOVs That Should Not be Changed

Table 17 lists LOVs that are required in the submit process. Do not delete or inactivate these LOVs.

<table>
<thead>
<tr>
<th>Type</th>
<th>Language-Independent Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAMPLE_INVOICE_TYPE</td>
<td>Return</td>
</tr>
<tr>
<td></td>
<td>Transfer In</td>
</tr>
<tr>
<td></td>
<td>Transfer Out</td>
</tr>
<tr>
<td></td>
<td>Inventory Adjustment</td>
</tr>
<tr>
<td></td>
<td>Invoice Receipt</td>
</tr>
<tr>
<td></td>
<td>Disbursement</td>
</tr>
<tr>
<td></td>
<td>Sample Order</td>
</tr>
<tr>
<td>SAMPLE_TXN_STATUS</td>
<td>Submitted</td>
</tr>
<tr>
<td></td>
<td>In Progress</td>
</tr>
</tbody>
</table>

Changing Read-Only Fields

As mentioned in this chapter and in Chapter 8, “Managing Pharma Samples,” the Siebel administrator can change the fields that become read-only after a call is submitted or synchronized with Siebel Pharma Handheld on a PDA. By default, only Comment is editable after clicking the Submit button. Edit the Update After Submit user property to change which fields are editable after a call is submitted. See Table 48 on page 487 for details.

Configuring the Sign Button

About the Sign Button

A special validation process is carried out before the physician can sign for dropped samples. The default validation when the user clicks the Sign button (on the Activities screen > Contact Call Detail view) is as follows:

- Check that the dropped samples have lot numbers
- Check that the physician is OK to sample
- Check that the physician has a valid and active license number
- If any of the dropped samples are controlled substances, check that the address at which the call is being made has a valid DEA number. A DEA number checksum algorithm is run to check that DEA# is populated, valid for the address, and not expired.
- Check that Last Name, First Name, Title, and Address fields are populated for the physician
If any of checks are not met, the Signature Capture view does not display and an error message specifies the specific point of failure.

Because not all pharmaceutical companies require validation, Siebel Pharma can be configured to turn the validations on or off using user properties.
Figure 5 on page 179 illustrates the default validation for the Sign button. (This is very similar to the validation logic used in Siebel Pharma Handheld.) User properties can be used to alter the Sign button’s validation logic. These are described in Table 18 on page 180.
Figure 5. Default Validation Logic Flowchart for Sign Button
Table 18. Sign Button User Properties in the Pharma Professional Call Business Component

<table>
<thead>
<tr>
<th>Flowchart Reference</th>
<th>User Property</th>
<th>Action if Y...</th>
<th>Action if N...</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>“Validate Sign Lot Number”</td>
<td>Enforce the Signature button Lot Number validation.</td>
<td>Skip the Signature button Lot Number validation.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Use to validate if the lot number is populated on</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>launching the Signature Capture display.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>“Validate OK to Sample”</td>
<td>Enforce the OK to Sample validation.</td>
<td>Skip the OK to Sample validation.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Use to enforce confirmation that the OK to Sample</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>flag is selected before launching the Signature</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Capture display.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>“SRE Professional Types”</td>
<td>The professional type (for example, “Physician”)</td>
<td></td>
<td>null</td>
</tr>
<tr>
<td></td>
<td>Use to require that the professional type be valid</td>
<td>must match the value of this</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>for signature recorded electronically (SRE) calls.</td>
<td>user property.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Use to require that the professional type be valid</td>
<td>If the value is null, all professional types</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>for signature recorded electronically (SRE) calls.</td>
<td>are valid.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>“Validate License Number”</td>
<td>Enforce the License Number validation.</td>
<td>Skip the License Number validation.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Use to enforce validation that the License # is</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>populated before launching the Signature Capture</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>display.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>“Validate License Number Status”</td>
<td>Enforce the License Number Status validation.</td>
<td>Skip the License Number Status validation.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Use to enforce validation that the License # status=</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Active before launching the Signature Capture</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>display.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>“Validate License Number Expiration”</td>
<td>Enforce the License Number Expiration validation.</td>
<td>Skip the License Number Expiration validation.</td>
<td>Y</td>
</tr>
<tr>
<td></td>
<td>Use to enforce validation that the Expiration date</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>on the License # is later than Today before</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>launching the Signature Capture display.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Recording Calls in Pharma  ■ Configuring the Sign Button

Siebel Life Sciences Guide Version 8.0, Rev. D 181

Table 18. Sign Button User Properties in the Pharma Professional Call Business Component

<table>
<thead>
<tr>
<th>Flowchart Reference</th>
<th>User Property</th>
<th>Action if Y...</th>
<th>Action if N...</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>“Validate DEA Number” Use to enforce that the DEA number is populated and that the value is valid (DEA # checksum algorithm) before launching the Signature Capture display.</td>
<td>Enforce the DEA Number validation in the Sign button (field is populated and number is valid).</td>
<td>Skip the DEA Number validation in the Sign button (DEA number is valid per the checksum routing and the field is populated).</td>
<td>Y</td>
</tr>
<tr>
<td>8</td>
<td>“Validate DEA Number Expiration” Use to enforce validation that the Expiration date on the DEA is later than Today before launching the Signature Capture display.</td>
<td>Enforce the DEA Number Expiration validation in the Signature button (expiration date is later than today).</td>
<td>Skip the DEA Number Expiration validation in the Signature button (expiration date is later than today).</td>
<td>N</td>
</tr>
<tr>
<td>9</td>
<td>“Validate Professional Profile” Use to validate if the professional’s Last Name, First Name, Title, and Address fields are populated before launching the Signature Capture display.</td>
<td>Enforce the Professional Profile validation.</td>
<td>Skip the Professional Profile validation.</td>
<td>Y</td>
</tr>
</tbody>
</table>

Configuring the LS Pharma Call Signature Form Applet
Various display features of the LS Pharma Call Signature Form Applet can be edited. See Table 19 on page 181.

Table 19. User Properties for the Signature Capture Control in the LS Pharma Call Signature Form Applet

<table>
<thead>
<tr>
<th>User Property</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>AxProperty: ActiveBorderColor</td>
<td>Border color when the control has the focus</td>
<td>10485760</td>
</tr>
<tr>
<td>AxProperty: BackgroundColor</td>
<td>Background color of the control window</td>
<td>null (=white)</td>
</tr>
<tr>
<td>AxProperty: BorderColor</td>
<td>Border color when the control is enabled but does not have focus</td>
<td>10485760</td>
</tr>
<tr>
<td>AxProperty: BorderStyle</td>
<td>Single, double, 3D, or no border on the window</td>
<td>1</td>
</tr>
</tbody>
</table>
Recording Calls in Pharma  ■ Marking Package Insert Delivery and Post Market Surveillance Calls as Complete

After Package Insert Delivery (PID) and Post Market Surveillance (PMS) calls have been completed, sales representatives will need to mark them as complete in Siebel Pharma.

This section contains instructions about marking PID and PMS calls as complete.

For information about PID and PMS calls see “About Features for Call Planning Specific to the Japanese Pharmaceutical Market” on page 122.

Marking a PID Call as Complete

The following instructions explain how to mark a PID call as complete.

Table 19.  User Properties for the Signature Capture Control in the LS Pharma Call Signature Form Applet

<table>
<thead>
<tr>
<th>User Property</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>AxProperty: DisabledBorderColor</td>
<td>Border color when the control is disabled</td>
<td>null (=white)</td>
</tr>
<tr>
<td>AxProperty: DisabledColor</td>
<td>Ink color when the window is disabled</td>
<td>null (=white)</td>
</tr>
<tr>
<td>AxProperty: InkColor</td>
<td>Current color of pen input</td>
<td>10485760</td>
</tr>
<tr>
<td>AxProperty: InkWidth</td>
<td>Current width of pen input</td>
<td>3</td>
</tr>
<tr>
<td>AxProperty: CompressionEnabled</td>
<td>Enables/Disables compression of the ink data</td>
<td>0</td>
</tr>
<tr>
<td>AxProperty: CompressionLevel</td>
<td>The compression level for compression of the ink data (0 - 5, with best fidelity at level 0 and highest compression at level 5)</td>
<td>0</td>
</tr>
</tbody>
</table>
| AxProperty: DisplayMode           | 0 - Normal - Ink is displayed as collected without any scaling or offsetting. This is the default.  
1 - Force To Fit  
2 - Shift To Control  
3 - Proportional Fit  
4 - Custom               | 0       |
To mark a PID call as complete
1. Navigate to the Package Insert Delivery screen > Mark Completion view.
2. Select an insert from the Products list.
3. Select the account from the Mark Completion list.
4. Select the check-box in the Executed column.

The status of the activity will change to In Progress if there are multiple inserts associated with the activity or Complete if this is the only insert associated with the activity.

Marking a PMS Call as Complete

The following instructions explain how to mark a PMS call as complete.

To mark a PMS call as complete
1. Navigate to the Post Market Surveillance screen > Activity Details view.
2. Select an Account Product combination.
3. Select an Activity.
4. Click Submit.
Recording Calls in Pharma ■ Marking Package Insert Delivery and Post Market Surveillance Calls as Complete
10 Creating Smart Calls

This chapter covers the following topics:

- “About Creating Smart Calls” on page 185
- “Scenario for Smart Calls” on page 185
- “Administering Smart Calls” on page 187
- “Creating a Smart Call (End User)” on page 189
- “About Applying a Smart Call Template to a Call” on page 190

About Creating Smart Calls

A Smart Call is a template that users can apply to contact calls and account calls to simplify and speed up the call-reporting process. A Smart Call defines a set of information about the products detailed, samples and promotional items distributed, and issues discussed on a call.

Smart Calls can be also be used for calls related to a particular campaign or promotional effort, or for everyday call reporting. They are intended for situations where sales representatives report details about a number of calls that are identical in content (the same products are detailed in the same order, the same samples are dropped, and so on).

This chapter describes how to create and modify Smart Calls. Using the procedures given in this chapter, you will be able to perform the administrator tasks of creating a new Smart Call template and then making it available to end users. Using the Smart Calls screens, end users can also create new Smart Call templates, enter Smart Call information, and modify Smart Call information after it has been applied to a call.

For more information on the differences between administrator and end-user tasks see “Scenario for Smart Calls” on page 185.

Scenario for Smart Calls

This topic outlines an example process performed by the Siebel administrator and end users. Your company may follow a different process according to its business requirements.

A pharmaceutical company is bringing a new product to market. The Siebel administrator adds this new product into the database and then creates a Smart Call template to distribute to the sales representatives in the field. The administrator then makes the Smart Call available to representatives in the field.
Once the Smart Call has been defined and made public, field sales representatives then apply it to their contact calls and account calls. By applying a Smart Call template, the representatives can automatically fill in various pieces of information in the Contact Call and Account Call Detail views, such as the products they detail, the samples they drop, and information they should provide. Representatives can also create Smart Call templates that suit their individual purposes. These end-user Smart Calls are only visible to each Smart Call creator.

The Siebel administrator requires administrative responsibilities in Siebel Smart Calls to:

- Create a new Smart Call and enter Smart Call information
- Make a Smart Call template available to end users

The end users are sales representatives in the field. They enter information to:

- Create Smart Call templates and enter Smart Call information
- Apply a Smart Call template to an account or contact call
- Modify Smart Call information after it has been applied to a call
Figure 6 and Figure 7 illustrate the workflows for these scenarios.

**Figure 6.** Administrator Creates Smart Call Templates

- Add a Smart Call as an administrator
- Enter Smart Call information
- Make a Smart Call available to end users

**End-User Procedures**
- Receive the Smart Call
- Apply Smart Call template

**Figure 7.** End User Creates Smart Call Templates

- Add a Smart Call template as an end user
- Enter Smart Call information
- Apply Smart Call templates

### Administering Smart Calls

The following administrator procedures are described in this topic:

- To create a Smart Call as an administrator
- To enter Smart Call information as an administrator on page 188
- To make a Smart Call template available to end users on page 189
By default, a Smart Call is accessible only to the user who created it. However, the Siebel administrator can make a Smart Call available to users system-wide by using the Smart Call Administration view. The administrator can also create and modify Smart Calls using the Application Administration, Smart Call Detail view.

**NOTE:** Both end users and the Siebel administrator can create and modify Smart Calls using the views in the Smart Calls screen. For more information, see “Creating a Smart Call (End User)” on page 189.

**To create a Smart Call as an administrator**

1. Navigate to the Administration - Application screen > Smart Calls view.
2. In the Smart Call form, create a new record, and complete the necessary fields.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By Name</td>
<td>The user who created the Smart Call.</td>
</tr>
<tr>
<td>Expense</td>
<td>This amount will appear in the Cost field of the contact call or account call. For more information, see “Creating a Contact Call (End User)” on page 117 and “Creating an Account Call (End User)” on page 119.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the Smart Call.</td>
</tr>
</tbody>
</table>

Enter information in the Smart Call Detail screen, as described in the next procedure.

**NOTE:** Deleting a Smart Call permanently removes the Smart Call from the system. Before you delete a Smart Call, make sure that it is no longer needed. Calls that were completed using a deleted Smart Call are not affected.

**To enter Smart Call information as an administrator**

1. Navigate to the Administration - Application screen > Smart Calls view.
2. In the Smart Calls list, drill down on a Smart Call name.
3. In the Smart Call Detail view, select any of the four lists:
   - Call Products Detailed
   - Samples Dropped
   - Promotional Items Dropped
   - Issues

   **NOTE:** You may not need to enter information in every one of these lists.
For the appropriate lists, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the samples or promotional items dropped during the call. This field appears in the Call Products Detailed and Promotional Items Dropped lists.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity of samples or promotional items dropped during the call. This field appears in the Call Products Detailed and Promotional Items Dropped lists.</td>
</tr>
</tbody>
</table>

To make the Smart Call available to users, see the next procedure.

**To make a Smart Call template available to end users**

1. Navigate to the Administration - Application screen > Smart Calls view.
2. In the Smart Calls list, select the Smart Call that you want to make available to end users.
3. Click the Private field to clear the check mark.

**NOTE:** Mobile end users must synchronize before they can access or modify a Smart Call.

**Creating a Smart Call (End User)**

By default, a newly created Smart Call is private; that is, it is available only to the user who created it. The Siebel administrator can make a Smart Call available to users. For more information, see the procedure “To make a Smart Call template available to end users” on page 189.

**NOTE:** For account calls where attendees are specified, users can also apply a Smart Call to each of the attendees. For more information, see the Smart Call field descriptions in “Creating a Contact Call (End User)” on page 117 and “Creating an Account Call (End User)” on page 119.

**To create a Smart Call as an end user**

1. Navigate to the Smart Calls screen.
2. In the Smart Calls list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created By Name</td>
<td>The user who created the Smart Call.</td>
</tr>
<tr>
<td>Expense</td>
<td>This amount will appear in the Cost field of the contact call or account call. For more information, see “Creating a Contact Call (End User)” on page 117 and “Creating an Account Call (End User)” on page 119.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the Smart Call.</td>
</tr>
</tbody>
</table>
Enter information in the Smart Call Detail view as described in the next procedure.

**NOTE:** Deleting a Smart Call permanently removes the Smart Call from the system. Before you delete a Smart Call, make sure that it is no longer needed. Calls that were completed using a deleted Smart Call are not affected.

### To enter Smart Call information as an end user

1. Navigate to the Smart Calls screen.
2. In the Smart Calls list, drill down on a Smart Call.
3. Click the Smart Call Detail view tab.
4. Make sure that the correct Smart Call appears in the Smart Call form.
5. Select any of the four lists in the Smart Call Detail view:
   - Call Products Detailed
   - Samples Dropped
   - Promotional Items Dropped
   - Issues
   **NOTE:** You may not need to enter information in every one of these lists.
6. Create a new record and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the samples or promotional items dropped during the call. This field appears in the Call Products Detailed and Promotional Items Dropped lists.</td>
</tr>
<tr>
<td>Quantity</td>
<td>The quantity of samples or promotional items dropped during the call. This field appears in the Call Products Detailed and Promotional Items Dropped lists.</td>
</tr>
</tbody>
</table>

**NOTE:** To protect system integrity and to make sure users enter the correct information, users cannot enter dates and reference numbers for samples with Smart Calls. For more information on entering information on dropped samples, see "Recording and Submitting Contact Calls" on page 168 and "Recording a Contact Call for a Different Contact at the Time of Signature Capture" on page 170.

### About Applying a Smart Call Template to a Call

End users apply a Smart Call template by making a selection from the Smart Call field in the Contact Call Detail and Account Call Detail views. For more information, see the field descriptions in "Creating a Contact Call (End User)" on page 117 and "Creating an Account Call (End User)" on page 119.
Once a user applies a Smart Call template to a call, the user can make additional edits to any fields in the current view.

If end users apply a Smart Call that contains samples, promotional items, or details that have not been set up in their personal lists, the smart call can still be applied, but only the samples, items, and details from the end users’ personal lists can appear in the Call Detail view.
Creating Smart Calls ■ About Applying a Smart Call Template to a Call
11 Managing Managed Care Accounts

This chapter covers the following topics:

- “About Managed Care in Siebel Life Sciences” on page 193
- “Scenario for Managed Care” on page 196
- “Process of Using Siebel Managed Care” on page 196
- “Entering Health Plan and Formulary Information” on page 197
- “Associating Contact Information with Health Plans” on page 199
- “Creating a Business Plan for a Managed Care Organization” on page 200
- “Entering Formulary Information for Managed Care Business Plans” on page 201
- “Performing Business and SWOT Analysis for a Managed-Care Business Plan” on page 202
- “Associating Contacts and Accounts with Managed-Care Business Plans” on page 203
- “Setting Objectives for the Managed-Care Business Plan” on page 204

About Managed Care in Siebel Life Sciences

Siebel Life Sciences has a number of features that help pharmaceutical and medical product companies maintain important data about MCOs (managed care organizations) and PBMs (pharmacy benefit management companies). Some of these features are listed here:

- **Account Data.** MCOs and PBMs are entered as accounts of type Managed Care. The fields in the managed care account form are designed to hold data relevant to these businesses, such as enrollment, prescription spending, and number of participating providers.

- **Health Plans.** Health plans are associated with managed care accounts. Health plan records contain information about the individual plans offered by MCOs, such as the plan name, size, utilization, co-payment.

- **Formulary.** Formularies are associated with health plans. Typically a unique formulary is set up for each therapeutic market, so that a plan has a list of formularies associated with it. Each formulary lists the individual drugs and products available for prescription on the health plan.

- **Contacts.** Two types of contact that are typically associated with health plans are the providers of health-care services (for example, physicians) and members of the P & T committee.
**Managed-Care Business Plans.** Managed-care account managers create business plans outlining how they can work with MCOs to promote the use of their company's products by members of the health plan. One way this is done is by influencing the P & T committee to add the products to formularies. Business plan records are associated with managed care accounts. Comprehensive data is contained in these business plans, including SWOT and business analysis views, key contact and account lists, formulary lists, and the objectives of the plan.

**Table 20 on page 194** defines some terms that are used in this chapter and also in the application’s user interface.

### Table 20. Terms Used in Managed Care

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>health plan</td>
<td>This is a health insurance option (or product) offered by an MCO. Variables in plans are premiums, choice of providers, out of pocket expenses, treatments covered, and so on. Large MCO’s typically offer a selection of health plans.</td>
</tr>
<tr>
<td>MCO (Managed Care Organization)</td>
<td>Health care insurer where the insuring company is involved in the delivery of care. This is contrasted with the traditional indemnity plan where the insurer is not involved in care delivery. MCOs offer HMO, PPO, POS health plans.</td>
</tr>
<tr>
<td>Formulary</td>
<td>The list of products, usually drugs that are available to patients subscribing to the MCO. Formulary may be managed:</td>
</tr>
<tr>
<td></td>
<td>- In-house by the MCO, or</td>
</tr>
<tr>
<td></td>
<td>- Outsourced to a PBM</td>
</tr>
<tr>
<td>PBM (Pharmacy Benefit Manager)</td>
<td>These are organizations that contract with MCOs to administer pharmacy benefits to members. In many cases, the MCO delegates the pharmacy benefit management to the PBM. Large PBMs may have their own P &amp; T committee who develop a universal formulary. Individual MCOs then appoint their own P &amp; T committees who select products from the universal formulary to develop formularies for the MCO’s health plans.</td>
</tr>
<tr>
<td>Managed Care Account Managers</td>
<td>These are the sales representatives who work for pharmaceutical and medical companies and who specialize in working with MCOs and in order to influence which products appear in the MCO’s formularies.</td>
</tr>
<tr>
<td>HMO (Health Maintenance Organization)</td>
<td>In this type of health plan, members pay a fixed monthly premium and receive health care without charge or for a small fixed co-payment. There are several different types of HMOs and also hybrids of the different types available in the U.S.A. Some of these types are described in this table.</td>
</tr>
</tbody>
</table>
Managing Managed Care Accounts

About Managed Care in Siebel Life Sciences

Managing Managed Care Accounts

Siebel Life Sciences Guide Version 8.0, Rev. D 195

Table 20. Terms Used in Managed Care

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Staff Model HMO</td>
<td>In this type of health plan, the MCO employs salaried physicians and owns the medical facilities. Typically, the co-payment charge is minimal. Patients may only consult with the doctors in the HMO; though, in very rare cases these doctors refer patients to sub-specialists outside the network.</td>
</tr>
<tr>
<td>Group Model HMO</td>
<td>In this type of health plan, the MCO contracts with one or more large multi-specialty physician group practices to provide care. Doctors are not employed directly, instead the group practice employs the physicians.</td>
</tr>
<tr>
<td>IPA (Independent Practitioner Association Model)</td>
<td>In this type of health plan, a MCO contracts with many individual and group physician practices to form one or more associations of independent practitioners (IPAs). The IPA pays the physicians, but these physicians remain as contractors, not salaried employees, and maintain their offices independently.</td>
</tr>
<tr>
<td>POS (Point of Service)</td>
<td>This type of health plan is a mix of HMO and a traditional indemnity plan. When a patient stays in the HMO network of physicians and follows the referral path, care is fully covered (with the usual co-payment). When the patient seeks care outside the network specialist care without a primary care physician (PCP) referral within the network, the patient is covered at a lower level.</td>
</tr>
<tr>
<td>PPO (Preferred Provider Organization)</td>
<td>This type of health plan is similar to POS, except that a patient does not need a PCP referral to see a specialist within the network.</td>
</tr>
<tr>
<td>P &amp; T (Pharmacy &amp; Therapeutics) Committee</td>
<td>This committee is a group of health-care specialists, including physicians and pharmacists. The committee determine which products are in the MCO’s or PBM’s formulary.</td>
</tr>
<tr>
<td>SWOT analysis</td>
<td>This is a planning tool to help you evaluate the strengths, weaknesses, opportunities, and threats of your business and product in the marketplace. SWOT analysis is a component of a business plan.</td>
</tr>
<tr>
<td>Tiered Benefit</td>
<td>A tiered pharmacy benefit is one where the member’s co-payments vary. For example, in a typical three-tiered system, generic drugs require the lowest co-payment, brand name drugs on the formulary require a higher co-payment, and brand name drugs off formulary require the highest co-payment.</td>
</tr>
<tr>
<td>Open Formulary</td>
<td>An open formulary is one where the MCO allows any drug to be prescribed.</td>
</tr>
<tr>
<td>Closed Formulary</td>
<td>A closed formulary is one where only the drugs on formulary may be prescribed. A closed formulary may be limited or unlimited.</td>
</tr>
<tr>
<td>Limited Formulary</td>
<td>A limited formulary is one where only a given number of drugs is allowed in each therapeutic class. In order for a new drug to be added, an existing drug must be removed from the formulary.</td>
</tr>
<tr>
<td>Unlimited Formulary</td>
<td>An unlimited formulary is one where there is no set limit on the number of drugs allowed in a therapeutic class.</td>
</tr>
</tbody>
</table>
Scenario for Managed Care

This scenario is an example process performed by a managed-care account manager and by a sales representative. Your company may follow a different process according to its business requirements.

The managed-care account manager and the sales representative are employees of a large pharmaceutical company.

Managed Care Account Manager Maintains HMO Account Data

The managed-care account manager is responsible for a nationwide HMO account. His job is to influence the HMO so that it buys more of his company’s drugs.

His first task when he is assigned this account is to enter data about the account, such as enrollment and spending data, information about the individual health plans offered by the account, and formulary lists for each plan.

Of particular interest to him are the members of the P & T committee; these are contacts who he wants to influence.

Sales Representative Reviews and Enters HMO Account Data

The sales representative is responsible for detailing the company’s drugs to physicians in her territory. She makes professional calls and influences the prescription habits of the physicians she calls on.

Before she meets with a physician, she wants to know about the health plans that the physician is affiliated with. Of particular interest to her is whether the drugs she details are on the plans’ formularies. Furthermore, if the physician happens to be on the P & T committee, it is most important that she know this so that she can discuss her approach in advance with the account manager.

Managed Care Account Manager Prepares a Business Plan for the HMO Account

The account manager’s relationship with the HMO can have significant impact on his company’s sales revenues. The account manager plans his approach carefully. He creates a business plan for the account. It contains information about the account, including formulary, key contact, and associated account information, SWOT analysis, and finally his objectives with relation to the account for the coming year.

Process of Using Siebel Managed Care

This example process represents the tasks that are carried out in the "Scenario for Managed Care” on page 196.

- “Entering Health Plan and Formulary Information” on page 197
- “Associating Contact Information with Health Plans” on page 199
- “Creating a Business Plan for a Managed Care Organization” on page 200
- “Entering Formulary Information for Managed Care Business Plans” on page 201
- “Performing Business and SWOT Analysis for a Managed-Care Business Plan” on page 202
Entering Health Plan and Formulary Information

Managed-care account managers can use the Account Plan Formulary view to enter and maintain information about health plan designs and formularies owned or administered by the account and about the products on those formularies. Account managers associate P & T committee members and track formulary review dates to be well prepared for calling on their contacts in the account.

Sales representatives, making professional calls may hear about contacts’ roles in P & T committees. They also can review the Plan Formulary information and add their contacts to the P & T member list as appropriate.

This task is a step in “Scenario for Managed Care” on page 196.

Who Owns the Formulary?

There are two approaches to setting up formularies in Siebel Life Sciences. The formulary can belong to one of the following:

- The MCO account
- The PBM account

Before deciding which type of account should own the formulary, review “Indicating Affiliations Between a Contact and an Account” on page 55 and “Entering Formulary Information for Managed Care Business Plans” on page 201, and consider your own business process.

Procedure

To create health plan information for an account

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, drill down on an account.
3. Click the Plan Formulary view tab.
Managing Managed Care Accounts  ■  Entering Health Plan and Formulary Information

4. In the Plan Design list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plan Type</td>
<td>See Table 20 on page 194 for definitions of the default values in this LOV.</td>
</tr>
<tr>
<td>No. of Lives</td>
<td>Number of lives in the health plan. This number cannot exceed the total lives entered for the account.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The Total Lives field must be completed in the Account form before you enter a value in this field. (Click on the show more button to see this field.)</td>
</tr>
<tr>
<td>% of Total Lives</td>
<td>Equal to ([(\text{Number of Lives at Plan Level}) \div (\text{Number of Lives at Account Level})]) multiplied by 100.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Number of health plan members who are using health plan benefits. This number cannot exceed the number of lives in the health plan.</td>
</tr>
<tr>
<td>Utilization %</td>
<td>Equal to ([(\text{Utilization}) \div (\text{Number of lives at Plan Level})]) multiplied by 100.</td>
</tr>
<tr>
<td>Co-Payment</td>
<td>Typically, the co-payment amount for a member visit to a primary care physician. The pharmacy co-payment is entered separately for each product.</td>
</tr>
<tr>
<td>P &amp; T Members Name</td>
<td>Names of contacts who are on the Pharmacy &amp; Therapeutics committee.</td>
</tr>
<tr>
<td>Pharmacy Distribution</td>
<td>Type of distribution, such as in-house, contracted, or mail-order.</td>
</tr>
</tbody>
</table>

To create formulary information for an account

1. Navigate to the Plan Formulary view tab. For information on how to navigate to the Plan Formulary view, see “To create health plan information for an account” on page 197.

2. In the Plan Design list, select a health plan.

3. In the Formularies list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>See Table 20 on page 194 for definitions of the default values in this LOV.</td>
</tr>
<tr>
<td>Market</td>
<td>The option selected in this field determines which products are available in the formulary’s Products list.</td>
</tr>
</tbody>
</table>
4 In the Products list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>■ Off Formulary — Banned from the formulary.</td>
</tr>
<tr>
<td></td>
<td>■ On Formulary — Approved by the formulary.</td>
</tr>
<tr>
<td></td>
<td>■ On/Prior Auth — Physicians require MCO or PBM approval before prescribing.</td>
</tr>
<tr>
<td></td>
<td>■ On/Restricted — One of the few drugs allowed its therapeutic class.</td>
</tr>
<tr>
<td></td>
<td>■ On/Exclusive — The only drug allowed in its therapeutic class.</td>
</tr>
<tr>
<td>Tier</td>
<td>If the product is in a tiered formulary, indicate the tier.</td>
</tr>
<tr>
<td>Reimbursable</td>
<td>For example, if a product is off formulary, but can be reimbursed with prior authorization, select this check box.</td>
</tr>
<tr>
<td>Qty Limit</td>
<td>The quantity allowed per patient per year.</td>
</tr>
<tr>
<td>Competitor</td>
<td>This field is filled in automatically when the product’s type is Competitive Product.</td>
</tr>
</tbody>
</table>

By adding a product to the Products list you indicate it is on formulary and can track its status. **NOTE:** You cannot edit the Competitor field. A check mark appears in this field if the product you selected for the Name field is a competitor’s product. For more information, see “Specifying a Competitor” on page 64.

5 Repeat Step 3 and Step 4 until you have created a record for every product on the formulary.

**Associating Contact Information with Health Plans**

Managed-care account managers can use the Contacts By Plan view (Accounts screen) to associate contacts (usually physicians) to health plans. This contact information may be typed in the UI as described here, but is more typically imported from external sources. **NOTE:** Sales representatives use the Contact Affiliations view (Accounts screen) to track similar information about contacts. However, the Contact Affiliations view differs because it associates the contacts to the MCO account and not to the individual health plans.

This task is a step in “Scenario for Managed Care” on page 196.

**To associate contacts with account plans**

1 Navigate to the Accounts screen > Accounts List view.
2 In the Accounts list, drill down on an account.
3 Click the Contacts By Plan view tab.
4 In the Plan Design list, select the plan to which you want to associate a contact.
5 In the Plan Contacts list, create a new record, and complete the necessary fields.

Creating a Business Plan for a Managed Care Organization

The account manager creates a business plan for his MCO account. If the MCO contracts out its pharmacy formulary, the account manager may also choose to create a business plan for the PBM.

Typically business plans are created on a yearly basis, but the frequency varies according to business process. An account would have a number of business plans associated with it; each plan for a different period.

The first step in creating the business plan is creating the business plan record and entering overview information about the account.

This task is a step in “Scenario for Managed Care” on page 196.

To create an business plan for an account
1 Navigate to the Accounts screen > Accounts List view.
2 In the Accounts list, drill down on an account.
3 Click the Business Plans view tab.
4 Create a new record and complete the necessary fields.
5 Drill down on the business plan record.
6 Click the Account Overview view tab.
   In the Account Overview form, enter information about the account that pertains to the business plan.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Description</td>
<td>Use this text field to note general information about the MCO.</td>
</tr>
<tr>
<td>Regional Plans</td>
<td>Use this text field make note of other business plans related to this account. For example, if this is a national business plan, this field might contain the names of regional and local business plans that are related to this national plan.</td>
</tr>
</tbody>
</table>
### Entering Formulary Information for Managed Care Business Plans

The Pharmacy Benefit view allows the managed-care account manager to see, in a view list, all the products in all the formularies associated with a given business plan.

**To add PBM and formulary information to a business plan for a managed-care account**

2. Drill down on a business plan record.
3. Click the Pharmacy Benefit view tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contracts Process</td>
<td>Use this text field to note information about the contracts process. For example, notes about any contracts for rebates or discounts that the pharmaceutical company has with the account or with the account’s PBM.</td>
</tr>
<tr>
<td>HMO Lives</td>
<td>This is the number of individuals enrolled in the HMO health plans offered by the account.</td>
</tr>
<tr>
<td>Total Lives</td>
<td>This is the number of individuals enrolled in all the health plans offered by the account. This field should equal the sum the other three lives fields (HMO Lives, PPO Lives, and POS Lives). This field is the same as the Total Lives field in the Accounts screen. (Click on the show more button to see this field in the Accounts form.)</td>
</tr>
<tr>
<td>Network Phy</td>
<td>This is the number of physicians participating in the insurance network. This field should contain approximately the same number as the Physicians field in the Accounts screen &gt; More Info view.</td>
</tr>
<tr>
<td>Network Hosp</td>
<td>This is the number of hospitals belonging to the insurance network.</td>
</tr>
<tr>
<td>PPO Lives</td>
<td>This is the number of individuals enrolled in the PPO health plans offered by the account.</td>
</tr>
<tr>
<td>POS Lives</td>
<td>This is the number of individuals enrolled in the POS health plans offered by the account.</td>
</tr>
<tr>
<td>Medicare</td>
<td>This is the number of individuals who are enrolled both in Medicare and in the health plans offered by the account.</td>
</tr>
<tr>
<td>Medicaid</td>
<td>This is the number of individuals who are enrolled both in Medicaid and in the health plans offered by the account.</td>
</tr>
</tbody>
</table>
4 In the Pharmacy Benefit list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefit Provider</td>
<td>Specify the account that owns the formularies that are relevant to the business plan. All products in all plans belonging to this account will be listed in the Formulary Status list in this Pharmacy Benefit view. Typically enter the name of the MCO account itself or of the PBM account. See note in “Entering Health Plan and Formulary Information” on page 197.</td>
</tr>
<tr>
<td>Tiered Benefit %</td>
<td>Indicate the approximate percentage of lives belonging to health plans with a tiered pharmacy benefit.</td>
</tr>
<tr>
<td>Open Benefit %</td>
<td>Indicate the approximate percentages of lives belonging to plans with open and closed formularies benefit.</td>
</tr>
<tr>
<td>Closed Benefit %</td>
<td></td>
</tr>
<tr>
<td>Reimbursement Policy</td>
<td>Enter information about the benefit provider’s reimbursement policy that is relevant to the business plan, for example, the co-payment rates, premium increases, or recent policy changes.</td>
</tr>
<tr>
<td>Formulary Approval Process</td>
<td>Enter information about the benefit provider’s formulary approval that is relevant to the business plan, for example, how long it typically takes to have a new drug entered in the formulary.</td>
</tr>
</tbody>
</table>

5 Scroll down to the Formulary Status list and review the products in the formularies owned by the selected PBM.

**Performing Business and SWOT Analysis for a Managed-Care Business Plan**

When creating a business plan for managed care, the managed-care account manager needs to analyze both the market and the account. Two views in the business plan view that are useful during the analysis phase of preparing the business plan are:

- Business Analysis view for reviewing syndicated prescription data:
  - Rx Trend by Plan - Volume
  - Rx Trend by Plan - Market Share
- SWOT view for entering information about:
  - The account’s (MCO’s or PBM’s) strengths and weaknesses
  - The opportunities and threats that the managed-care account manager needs to address in the business plan
To enter SWOT information for a business plan

2. Drill down on a business plan record.
3. Click the Business Analysis view tab.
4. Use the Business Analysis view to review prescription trends for the market of interest.
   For general information about analysis of syndicated data, see Chapter 13, “Analyzing Syndicated Data."
5. Click the SWOT view tab.
6. In the SWOT form, complete the fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strengths</td>
<td>For example, a recent study shows your drug is better tolerated by patients.</td>
</tr>
<tr>
<td>Weaknesses</td>
<td>For example, the MCO has very restrictive reimbursement policies for drugs in your market.</td>
</tr>
<tr>
<td>Opportunities</td>
<td>For example, a change of policy in the account makes it easier to get a drug added to the formularies.</td>
</tr>
<tr>
<td>Threats</td>
<td>For example, a study indicates that a competitor’s product is as effective and less expensive than the product you are promoting.</td>
</tr>
</tbody>
</table>

Associating Contacts and Accounts with Managed-Care Business Plans

When creating a business plan for managed care, the account manager gathers information about accounts and contacts who are associated with the business plan.

Views in the business plan view that are useful for recording related accounts and contacts are as follows:

- Account Coverage view: Use this view to list accounts associated with the business plan. For example, if the business plan is for a national account, add the names of the regional accounts associated with the national account.

- Organizational Analysis view: Use this view to list key contacts for the business plan and to indicate the relationships between the key contacts.

- Key Contacts view: Use this view instead of the Organizational Analysis view if you do not want to indicate the relationships between the contacts.
Managing Managed Care Accounts ▪ Setting Objectives for the Managed-Care Business Plan

To associate accounts and contacts with business plan for a managed-care accounts

2. Drill down on a business plan record.
3. Click the Account Coverage view tab and in the list, create new records and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team</td>
<td>This field indicates which employees in your company are responsible for the account.</td>
</tr>
<tr>
<td>Coverage Level</td>
<td>For example, if the business plan is for a national account, the regional and local accounts associated with the national are listed. Use this field to indicate which account is regional or local.</td>
</tr>
</tbody>
</table>

4. Click the Organizational Analysis view tab.
5. Use the Organizational Analysis view to enter your list of contacts and to indicate relationships between them.

For general information about the organization analysis, see the Siebel Applications Administration Guide.

Setting Objectives for the Managed-Care Business Plan

The last but very important stage of creating a business plan is for the managed-care account managers to list what they are going to do to carry out the plan. These are their objectives.

These objectives are created in the Business Plans screen > Objectives view, but can also be viewed, created, and edited in the Objectives screen > Objective List > My Objectives view.

To create objectives for a business plan

2. Drill down on a business plan record.
3. Click the Objectives view tab.
4. In the list, create new records and complete the necessary fields.
5. Drill down on the objective record to add activities to the objective.

For general information about objectives in Siebel Life Sciences, see Chapter 16, “Setting and Achieving Objectives.”
About Japanese Pharmaceutical Market Features for Accounts Contacts

The Japanese pharmaceutical market has some unique characteristics concerning the relationships of Hospitals and Physicians that influence how pharmaceutical companies conduct their Sales and Marketing activities in Japan. These market characteristics dictate how Sales Representatives engage with physicians and hospitals in their territories and how they plan future calls. For example, Physicians always see patients at either large hospitals or small, private clinics. Therefore a contact call always takes place within the context of the Hospital (account) that the Physician (contact) is associated with.

Japanese Pharmaceutical companies also typically create and distribute large Targeting lists for each Sales Representative in their Sales Force which are based on the Hospital-Physician relationships and a series of Targeted Products. These Targeting lists are generally updated and distributed at the start of a new Targeting period, which is typically every quarter or half-year. The Hospital-Physician targeting lists include a number of targeting attributes (such as Call frequency) for one or more Products that are specific to each sales representative assigned to the specified Hospital-Physician. For example, one sales representative might be asked to make six visits to one account-contact during the quarter for Product A, but another sales representative might be asked to make only three visits to the same account-contact for the same Product A.

**NOTE:** Features specific to the call-planning features in the Japanese Pharmaceutical market are not covered in this section. For information about the call-planning features specific to the Japanese market, see "About Features for Call Planning Specific to the Japanese Pharmaceutical Market" on page 122.
The following Siebel Life Sciences features address the distinctive traits of the Japanese pharmaceutical market:

- **Hospital-Physician relationships.** Sales representatives can visualize Hospital-Physician (that is account-contact) affiliations as a single record within a list. This feature provides an intuitive interface for users to retrieve customer information, create Siebel Target lists, and plan future calls.

- **Hospital department support.** Affiliated Accounts can be displayed as Hospital Departments along with the corresponding Physicians who are affiliated to these departments.

- **Hospital-Physician targeting information.** For a given targeting period (such as half year), Hospital-Physician targeting lists can be created by administrators and distributed to sales representatives for use within their targeting and call planning processes. Targeting information, such as call frequencies, detail frequencies and targeting flags, can be displayed for each hospital-physician record. Administrators can modify these attributes as business needs change and Sales representatives can plan their calls using these targeting attributes as guiding parameters.

- **Weekly calendar with call-planning capabilities.** The application provides an intuitive and user-friendly Weekly call planning user interface which enables sales representatives to plan and visualize all the activities for their hospital-physician targets within a specific time period. New calls can be created by double clicking within the Call Planning screen. Sales representatives can also enter and report basic call data, (such as products detailed and samples dropped within the same screen), and submit the call if no additional information is required.

- **Contact call with account information.** The standard contact call view has been enhanced to include account information. This feature allows sales representatives to capture detailed call data for a hospital-doctor record, such as promotional items dropped or decision issues.

### About Accounts Contacts

The Siebel Pharma Accounts Contacts functionality supports the display of account-contact affiliations as a single record within dedicated Accounts Contacts List views, and also within an Accounts Contacts Weekly Call Planning screen. The Account-Contact records displayed in these screens are managed within the Siebel Pharma application as a set of separate Targeting records for each Sales Representative Position. These Targeting records store the relationship between the Account-Contact affiliation and Sales Representative Position. The records also have a series of Product Targeting attributes fields for each Account-Contact-Position relationship which store Product targeting information such as Detail Frequency targets.

The Targeting Period and related Accounts Contacts Targeting records needs to be created by an administrator, and then Targeting Period activated in order to make the Accounts Contacts Targeting records visible to end users. Administrators can create multiple Targeting Periods (and their related Accounts Contacts Targeting data) within the Siebel Pharma application, but only one Targeting Period can be active at any one time. The Targeting data can be manually created and setup through administration screens. However, a series of dedicated Siebel EIM tables are also provided to support the batch loading of the Targeting data. This method is the typical process for creating the data within the Siebel Pharma application.
Configuring Workflows for Accounts Contacts

The Siebel Pharma Accounts Contacts functionality utilizes Siebel Workflows in order to create and activate the Targeting lists. The application needs to be correctly configured to enable these workflows. The following topics describe how to configure and validate the Siebel Pharma application to enable Siebel Pharma Accounts Contacts functionality:

"Activating Workflows for Accounts Contacts" on page 207

"Enabling Server Components for Accounts Contacts" on page 207

Activating Workflows for Accounts Contacts

LS Pharma JPN Targeting Period Activation workflow must be activated to create and activate the Targeting periods and the Accounts Contacts lists. The administrator needs to set and activate this workflow process in order to enable the functionality.

To activate workflows for accounts contacts

2. Click Query and enter LS Pharma JPN* in the Name field.
   The query returns LS Pharma JPN Targeting Period Activation.
3. Select the workflow and click Activate.
   The selected workflow is added to the Active Workflow Processes view at the bottom of the screen.

   **NOTE:** You only need to perform this procedure the first time you want to access the Accounts Contacts feature. The workflow remains activated the next time you use this feature.

Enabling Server Components for Accounts Contacts

The Accounts Contacts functionality also requires that a number of Siebel Pharma Application Server components be enabled to support the Workflows. These components are as follows:

- Workflow Action Agent
- Workflow Monitor Agent
- Workflow Process Batch Manager
- Workflow Process Manager
- Workflow Recovery Manager
To activate workflows for accounts contacts

1. Navigate to the Administration - Server Configuration screen > Servers view.
2. Click the Components tab and Query Workflow* in the Components field.
   The query returns the agent and manager records associated with the accounts contacts. All should have a status of Enabled.
3. Click Manual Start if any one of the components is Inactive.
   NOTE: If you cannot view the Status field, select Columns Displayed from the Menu drop-down list and add the appropriate fields that you want displayed in the view.

Managing Accounts Contacts

The following topics describe the key tasks required to manage accounts contacts:

“Loading and Distributing Accounts Contacts Targeting Data” on page 208
“Creating a New Targeting Period” on page 209
“Creating Accounts Contacts Targeting Product Data” on page 210
“Generating Column Maps for Display of Product Attribute Fields” on page 211
“Activating the New Accounts Contacts Targeting Data” on page 212
“Creating Account-Contact Target List Records Manually” on page 213

Loading and Distributing Accounts Contacts Targeting Data

When a new Targeting period begins, the administrator must load and distribute the Accounts Contacts Targeting data. The database administrator (DBA) then loads the new Target data into the Siebel Pharma application through Accounts Contacts Targeting EIM tables.

To load and distribute Accounts Contacts targeting data

1. Create a new Targeting Period record in the Accounts Contacts > Administration screen, and retrieve the Row Id for the new Targeting Period record.
2 Use the Row Id to create a set of Accounts Contacts Targeting Product records in a flat file that includes the following information:

- Targeting Period Id
- Account Id
- Contact Id
- Position Id (for Sales Representative)
- Product Id
- Product Targeting attributes.

3 Send the flat file to the database administrator (DBA) who loads the new Target data into the Siebel Pharma application through Accounts Contacts Targeting EIM tables.

4 Validate that the data is correct after the Targeting data is loaded into the application.

5 Use the Accounts Contacts Administration screens to set the Display Names for each of the Targeting Product Attributes.

6 Generate the corresponding column mappings for the Siebel Pharma Application to display the Product Attributes within the Accounts Contacts list screens.

7 Activate the current Targeting Period to create and distribute the Accounts Contacts Targeting lists to the end users.

**Creating a New Targeting Period**

In order to load and activate a new set of Accounts Contacts target lists and targeting information a new Accounts Contacts Period record must first be created by the administrator.

**To set up the period for account-contact affiliation**

1 Navigate to the Accounts Contacts screen > Administration view.

2 In the Administration list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period</td>
<td>Select a target period from the Pick Period dialog and click OK.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name for the contact.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the accounts contact.</td>
</tr>
<tr>
<td>Status</td>
<td>(Read only) Indicate the status of this period. (In Progress, Lock, Active, Obsolete, Error).</td>
</tr>
</tbody>
</table>
Managing Accounts Contacts in Life Sciences  ■  Managing Accounts Contacts

3  Select Help > About Record and note the Record # (Row Id) of the new period.

This Row Id is used by the Administrator to create a flat file which maps the new Period to the new Accounts Contacts Target List and Targeting information so that the data can be loaded using the Accounts Contacts EIM tables. For more information about importing data with Siebel EIM, see "Importing Data with Siebel EIM" on page 262.

Creating Accounts Contacts Targeting Product Data

For each Targeting Period, a series of Targeting Product data records for each Account, Contact, and Sales Representative Positions needs to be created in order to generate the Targeting lists used by the end users. A Targeting Product is any Product being targeted to an Account Contact by a Sales Representative which needs to be tracked in terms of Targeting attributes (for example, Call Frequency targets) as part of the Sales Force’s Targeting process. There are four Targeting Product attribute fields defined in the application which can be used to store and manage the Targeting Attribute values associated to a Target Product for a specific Account-Contact-Position (Sales Representative) relationship. By default, only the two numeric Targeting Attribute fields are enabled and are displayed in the Accounts Contacts list screens.

The steps below explain how to manually enter the Targeting Product records in the Accounts Contacts Administration screens. The values for each of the Account-Contact-Position Targeting Attributes fields can be loaded through the Accounts Contacts EIM tables.

To create targeting product data for account-contact-position relationship

1  Navigate to the Accounts Contacts screen > Administration view.
2  Select a period record from the list and drill down on the Period column.
3  In the Product Data applet, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>Select a name from the Pick Contact dialog box, and click OK.</td>
</tr>
<tr>
<td>Sales Representative</td>
<td>Select a position from the Pick Position dialog box, and click OK.</td>
</tr>
<tr>
<td>Product</td>
<td>Select a product from the Pick Product dialog box, and click OK.</td>
</tr>
</tbody>
</table>
Generating Column Maps for Display of Product Attribute Fields

For each Product Attribute field, a common Display name value can be mapped to all the available Target Products. This Display name mapping is then used to automatically generate the Product Attribute Column labels displayed to the end users in the Accounts Contacts lists. The Display name for each of these Target Products' attribute fields is generated by combining the Product Name for each Targeting Product with the common Display name value defined by the administrator for the Product Attribute field. Once the Product Attribute labels are generated, an administrator can still edit the final display labels if minor updates are required before activating the Targeting Period.

The Targeting Product attributes used by the Sales Force may change from one Targeting Period to another. The application supports the ability to use the same attribute fields across all Targeting Periods, but define different labels for these fields for different Targeting periods. For example, a pharmaceutical company can decide to display the following information to the end users in the Accounts Contacts list screens:

- In the first quarter, they might display the number of visits by product
- In the second quarter, they might display the number of samples by product
- In the third quarter, they might display the number of primary details by product

**NOTE:** While the labels can change, the underlying Targeting Product Attribute columns are the same. For this reason, it is important for the administrator to track how the attributes columns and labels are mapped for Targeting period.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric Attribute 1</td>
<td>Use the calculator to enter the first numeric attribute. For example, enter the numeric value for number of Sales Calls.</td>
</tr>
<tr>
<td>Numeric Attribute 2</td>
<td>Use the calculator to enter the second numeric attribute. For example, enter the numeric value for number of Product Details.</td>
</tr>
<tr>
<td>Text Attribute 1</td>
<td>Enter a text value to use as a product attribute.</td>
</tr>
<tr>
<td>Data Time Attributes 1</td>
<td>Enter a date value to use as a product attribute.</td>
</tr>
</tbody>
</table>

*Create column map for Accounts Contacts List*

1. Navigate to the Product Attributes screen.
2. Check the Mapped Field column to select the field to be used to generate the column map.
3. Enter the Display Name as the postfix to the column display name.
4 Click the Generate button to generate column mapping in the Column Map view. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mapped Field</td>
<td>Check to select Product Data field used to display on Accounts Contacts List after activation.</td>
</tr>
<tr>
<td>Field</td>
<td>(Read only) Product data field column.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Postfix of the Column Display Name in the Accounts Contacts List. This field will append to the product name in the generated column map.</td>
</tr>
</tbody>
</table>

5 Edit the Display Name in the Column Map view. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>(Read Only) Product Name</td>
</tr>
<tr>
<td>Source Field</td>
<td>(Read Only) Product data field</td>
</tr>
<tr>
<td>Target Field</td>
<td>(Read Only) Mapped field in Accounts Contacts List view</td>
</tr>
<tr>
<td>Display Name</td>
<td>Column Display Name of this product attribute in Accounts Contacts List view</td>
</tr>
</tbody>
</table>

Activating the New Accounts Contacts Targeting Data

To allow end users to view and use the new Accounts Contacts Targeting data, the administrator must activate the Targeting Period. When a new Targeting Period is activated, the existing period becomes obsolete. Only the Targeting data for the active Targeting Period is visible to end users in the Accounts Contacts list screens. The activation process assigns an account-contact record to a Sales Representative's Position only if the Position is already part of both the Account and Contact teams. If this relationship already exists, then a targeting record is created for the Sales Representative's Position and all remaining targeting attributes are added to this record.

**To activate a Targeting Period**

1. Navigate to the Accounts Contacts screen > Administration view.
2. Select a period record from the list.
3. Select the Mapping and Activation view from the view toggle list.
4. Click the Activate button on the list.
   
   The Server Request should be displayed in the Request Id field and the Status field should change to In Progress.
5 After a few minutes, refresh the screen to verify that Workflow processes have completed and the Period status has changed to Active.

6 Navigate to the Accounts Contacts List and toggle to the All Accounts Contacts Across Organization view.

7 Verify that the current Targeting Period’s Accounts Contacts Targeting data has been created correctly.

Creating Account-Contact Target List Records Manually

Once a Target Period has been successfully activated, each Sales Representative will be able to view their list of Account-Contact-Targeting Product records for the current Targeting period in the Accounts Contacts list view. A user can also manually create new target list records for Account-Contact affiliations in the Accounts Contacts list.

To create a target list for account-contact affiliations

1 Navigate to the Accounts Contacts > Accounts Contacts List view.

2 In the Accounts Contacts list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Indicates when a new Account Contact record is created for the current position.</td>
</tr>
<tr>
<td>Sales Rep</td>
<td>The sales representative to whom this account contact is associated.</td>
</tr>
<tr>
<td>Account Name</td>
<td>From the Pick Account Contact dialog, select the appropriate Account-Contact Affiliation.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Only affiliations where the Sales Representative’s Position on both the Account and Contact teams will be displayed in this dialog.</td>
</tr>
<tr>
<td>Account Location</td>
<td>The location of the account contact.</td>
</tr>
<tr>
<td>Contact Primary Speciality</td>
<td>Primary speciality of the contact.</td>
</tr>
</tbody>
</table>

Creating Accounts Contacts Call Detail Records

The Accounts Contacts list displays the Account-Contact records with their targeting Product attributes for the current Targeting Period. The records in the list are limited to Account-Contact targeting records created for the current user’s Position.
Managing Accounts Contacts in Life Sciences ■ Planning Calls in the Weekly Call Planning Screen (End User)

Users can create a Call record directly from the Accounts Contacts List applet. The New Call button on the Accounts Contacts List applet creates an Account Contact Call record with both the Account and Contact Ids populated. The created Call records are displayed in the Accounts Contacts Call Detail view under Activities. Users can create records for the Products Detailed and Samples Dropped based on the data setup in the user's Personal Lists.

To create Contact Call Details for a new Contact

1. Navigate to the Accounts Contacts List screen.
2. Select an Account - Contact record from the list.
3. Click New Call.
   A new Contact Call Detail record is created and the Contact Call Detail view is displayed.
   You can create records in the Products Details and Samples Dropped views with records based on data setup in your Personal List.
4. Click Sign.
   If all business rules are valid, signature capture window is launched. Verify the contact's name, address, DEA number and license number displayed in the call header.
5. Click Submit to submit the call. If Samples were dropped a Signature will need to be entered before the call can be submitted. For more information, see "Recording a Contact Call for a Different Contact at the Time of Signature Capture" on page 170.

Planning Calls in the Weekly Call Planning Screen (End User)

Japanese sales representatives generally plan their Account Contact calls a week or more at a time. For ease of viewing and editing, they prefer to use a calendar that displays Accounts Contacts on the vertical axis and days of the week along the horizontal axis. The Weekly Account Contact Call Planning screen enables sales representatives to easily view and plan their Account Contact calls. Users can double-click any of the cells within the weekly calendar grid to easily and quickly create a call record for an Account Contact on a given day of the week.

From this Weekly Call Planning screen, sales representatives can also see whether other sales representatives have also scheduled calls for a particular Account-Contact which allows Sales teams to plan their joint sales efforts more effectively. Managers can also view the planned and completed Sales calls for all of their direct reports, allowing them to better monitor Sales Representatives' activities and suggest any changes as needed.

When a sales representative creates a new activity, all other information, such as Products Detailed and Samples Dropped, is automatically populated with the information previously entered on their personal lists. For more information on personal lists, see the scenario "Scenario 1: Users Set Up Personal Lists" on page 103 and "Creating a Personal List (End User)" on page 106.

The calls displayed on the Accounts Contacts Call Planning screen are color-coded, so that sales representatives can monitor the status of a particular activity. When a call is submitted, the activity color is automatically refreshed, and the record is locked.
To plan a call in the Weekly Call Planning screen

1. Navigate to the Calendar screen > Accounts Contacts Call Planning view.

2. In the Weekly Calendar grid, double-click the intersection cell corresponding to the Account Contact record on the Day for which you wish to create the Call record.

3. The application creates an Account Contact Call detail record and displays it in the view below the Weekly Call Planning Gantt chart.

A call created in this manner has the following characteristics:

- **Account and contact name.** The account name and contact last name corresponding to the account-contact record selected.
- **Start date and time.** The day corresponding to the day selected on the calendar. The time for all calls scheduled on this view is set to the start of the work day, as entered on the User Profile Calendar View.

Some of the fields displayed in the List portion on the left-hand side of the Gantt chart are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name</td>
<td>Displays the Last Name of the Contact as displayed in the Accounts Contacts list. (If you click the Last Name link, the Contact Details screen is displayed showing details of the call contact.)</td>
</tr>
<tr>
<td>First Name</td>
<td>Enter first name for the contact.</td>
</tr>
<tr>
<td>Account</td>
<td>The name of the Account as displayed in the Accounts Contacts list.</td>
</tr>
<tr>
<td>Sales Rep</td>
<td>The Sales Representative position associated to the Account Contact record as displayed in the Accounts Contacts List.</td>
</tr>
<tr>
<td>Primary Speciality</td>
<td>Primary speciality of the contact.</td>
</tr>
<tr>
<td>Calls</td>
<td>A calculated field which displays the number of calls for the Account Contact record within a given period. The displayed value for this column is calculated when the user clicks the Calculate button on the Gantt chart and enters the Start and End Period for the calculation.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Button</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Template</td>
<td>Saves all the calls to a template for all current Account Contact records between a Start and Finish date set by the user.</td>
</tr>
<tr>
<td>Apply Template</td>
<td>Applies a selected template from a start date set by the user.</td>
</tr>
<tr>
<td>5 Day Week</td>
<td>Displays all the days between Monday and Friday.</td>
</tr>
</tbody>
</table>
Reporting a Call in the Weekly Call Planning Screen

Sales representatives can use the Weekly Call Planning screen to also report completed calls. Information for Products Detailed and Samples Dropped is displayed below the Weekly Call Planning Calendar for the currently selected Call record. A sales representative can quickly and easily update this information before submitting the completed call all within the same Calendar Call Planning screen.

To update call records in the Call Planning screen
1. Navigate to the Calendar > Accounts Contacts Call Planning screen.
2. In the Accounts Contacts Call Planning screen, single click on a previously created Call record in the Weekly Calendar grid.
3. The application displays the selected Call record in the form below the Weekly Calendar grid.
4. Update the fields in the form for the completed Call as necessary.
5. In the Products Detailed list below the form, enter a value in the Priority column for each Product detailed during the Call. All other Product Detailed records will be deleted when the Call is submitted.
6. If Samples were dropped during the call, then in the Samples Dropped list below the form, specify a lot number and quantity for the dropped samples.
7. If Samples were dropped, enter a Signature before you submit the call.
8. Click Submit to submit the call.

Deleting Multiple Calls in the Accounts Contacts Call Planning Screen

Sales representatives can use the Accounts Contacts Call Planning screen to delete multiple calls. A sales representative can quickly and easily update this information in a weekly view for multiple accounts.

To delete multiple calls
1. Navigate to the Calendar > Accounts Contacts Call Planning screen.
2  Press and hold the Ctrl key, and select the calls that you want to delete.
3  Click Delete.

Switching to Reporting Mode in the Accounts Contacts Call Planning Screen

Sales representatives can use the Accounts Contacts Call Planning screen to switch to reporting mode. A sales representative can quickly and easily switch modes by clicking one button.

To switch to reporting mode and submit calls
1  Navigate to the Calendar > Accounts Contacts Call Planning view.
2  Click Go to reporting mode.
3  Report the call information:
   a  Select the call from the list.
   b  Enter product details.
   c  The Start Date field will be pre-populated with the current date. Change it to a different date, where appropriate.
   d  Enter the number of minutes in the Duration field.
   e  Enter any decision issues in the Decisions Issues field.
   f  Select a status from the Status list.
   g  Enter any additional comments in the Comments field.
4  Click Submit to submit the call.

Displaying Calls Created by Other Representatives

Sales representatives can use the Accounts Contacts Call Planning screen to display calls created by other representatives.

To display calls created by other representatives
1  Navigate to the Calendar > Accounts Contacts Call Planning screen.
2  Scroll through the calendar view.
   All entries in grey represent calls created by other representatives.
Managing Accounts Contacts in Life Sciences  ■  Displaying Calls Created by Other Representatives
This chapter covers the following topics:

- "About Analyzing Syndicated Data" on page 219
- "Scenario for Analysis" on page 219
- "Process of Analysis" on page 220
- "Defining Payer and Plan Information" on page 220
- "Importing Syndicated Data Files (End User)" on page 221
- "Analyzing Brick-Level Syndicated Data (End User)" on page 222
- "Working with Sales, Rx, and Call Data (End User)" on page 223
- "Views in the Analysis Screen" on page 224

### About Analyzing Syndicated Data

The views in the Analysis screen present sales, prescription, and call detailing data in an accessible format. These views allow you to evaluate your performance and determine where to focus your sales activities.

Much of the data displayed in these views derives from syndicated data.

**NOTE:** All the views in the Analysis screen are read-only.

The terms *direct sales* and *indirect sales* are used in some views of the Analysis screen as follows:

- **Direct sales.** Refers to product sales directly from your company to accounts.
- **Indirect sales.** Refers to product sales from wholesalers to accounts.

### Scenario for Analysis

This topic outlines an example process performed by the Siebel administrator and end users. Your company may follow a different process according to its business requirements.

A pharmaceutical company has bought syndicated data concerning its retail product sales. This syndicated data is displayed in most of the Siebel Life Sciences Analysis views.

Periodically, the Siebel administrator extracts portions of the syndicated data and distributes it according to territory assignments. As part of this process, the Siebel administrator updates responsibilities, which affect the data that can be viewed by an individual, and updates payer and plan information.
In order to use the new information, the application user must download the syndicated data updates.

**Process of Analysis**

This topic details sample tasks often performed by administrators and end-users working with the Analysis screen. Your company may follow a different process according to its business requirements.

**Administrator Procedure**

The following administrative procedure is described in this topic:

- "Defining Payer and Plan Information" on page 220.

Other administrator procedures, applicable to the data used in the Analysis screen, are described elsewhere:

- "Loading Data into the Siebel Life Sciences Database" on page 270.
- "To create a data extraction rule" on page 273. Extract portions of data according to territory assignments.
- "To specify the data that is routed to mobile users" on page 274. Send the compressed data extracts to mobile users.
- (Optional) Updating responsibilities. For general information about responsibilities, see *Siebel Security Guide*.
- Associating positions to bricks. See "Administering Bricks" on page 50.

**End-User Procedures**

The following list shows tasks end users typically perform using the Analysis screens:

- "Importing Syndicated Data Files (End User)" on page 221.
- "Analyzing Brick-Level Syndicated Data (End User)" on page 222.
- "Working with Sales, Rx, and Call Data (End User)" on page 223.

**Defining Payer and Plan Information**

You can use the Payer Administration view to define payer and plan information. This information appears in the plan and payment type–based views in the Analysis screen.

**To create a payer**

1. Navigate to the Administration - Application screen > Payer view.
2 Click the New button and complete the fields in the new record.

Some of the fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Three types are supported: Total, Plan, and Payer.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name of the payer, plan, or payment type. If you selected Plan in the Type field, enter the plan name.</td>
</tr>
<tr>
<td>Account Name</td>
<td>If relevant, select the payer account, or create a new account for the payer in the Pick Account dialog box.</td>
</tr>
<tr>
<td>Account Site</td>
<td>The location of the plan.</td>
</tr>
<tr>
<td>IMS Id</td>
<td>The identifier assigned to the plan by the syndicated data provider.</td>
</tr>
</tbody>
</table>

**Importing Syndicated Data Files (End User)**

If data extracts have been routed to the end users by the Siebel administrator, the end users receive notification when they synchronize your local database. During synchronization, the data extracts are downloaded to their hard drives (as attachments), where they are stored until you import them. After they import the data into their local databases, the files are deleted from their hard drives.

**NOTE:** If you want to postpone receiving data extracts until a later time, turn off the Retrieve Published Files option in your synchronization setup. To find this option, choose File > Synchronize, and then click Setup in the Siebel Remote dialog box.

**To import syndicated data extracts**

1 Navigate to the Syndicated Data Files screen.

   **NOTE:** Even if you postponed receiving data extract files by turning off the Retrieve Published Files option in your synchronization setup, this view displays records for all the files routed to you. Although the files are listed here, you cannot import them until you have received them during a subsequent synchronization.

2 Select one or more files and click Import.

   The Syndicated Data Files view is cleared, and the data extract files that you received during synchronization are deleted from your hard drive.
Analyzing Brick-Level Syndicated Data (End User)

End users can analyze syndicated data that is associated with a brick. They can also analyze activities, such as calls, associated with an account or contact within a brick. Using the brick-level analysis views, end users can correlate those activities with prescription or sales trends.

The data that appears in the Analysis screen > Bricks is determined by the user’s position and the bricks that the administrator has associated with that position. For more information, see “Administering Bricks” on page 50.

To display all contacts associated with a brick
1. Navigate to the Analysis screen > Bricks Analysis List view.
2. From the Show drop-down menu, select Bricks Rx Analysis.
3. Select a brick in the Bricks list.
4. Click on the Contacts view tab.
   The Contacts list displays all contacts associated with the selected brick.

To correlate actual calls made with indirect sales by brick
1. Navigate to the Analysis screen > Bricks Analysis List view.
2. Select a brick in the Bricks list.
3. Click on the Indirect Sales by Brick view tab.
4. Select a record and click the actual calls button.
   The list shows the number of account calls submitted for the selected product and period. Remember to select a record that contains your company’s product in order to see the activity data.

To correlate actual calls made with prescription trends by brick
1. Navigate to the Analysis screen > Bricks Analysis List view.
2. Select a brick in the Bricks list.
3. Click on the Rx Trend by Brick view tab.
4. Select a record and click the actual calls button.
   The list shows the number of account calls submitted for the selected product and period. Remember to select a record that contains your company’s product in order to see the activity data.
Working with Sales, Rx, and Call Data (End User)

The views in the Analysis screen display prescriber, account, plan, payer, and territory level sales and Rx data, as well as call data. These views provide the capability to view data in both list and chart formats.

To access any of the views listed in Table 21 on page 224, navigate to the Analysis screen default Analysis view, select the appropriate market in the All Markets list, and then select the desired view from the view tabs.

A list format appears by default when you select a view from the Analysis view tabs. You can view your sales and Rx data numbers in a chart format by clicking the toggle button.

The data in the Analysis screen must be updated periodically. Mobile users must download files that have been extracted and sent by the Siebel administrator and then import the new data into their local databases. For more information, see “To import syndicated data extracts” on page 221.

To display data with the views in the Analysis screen

1. Navigate to the Analysis screen.
2. Select the appropriate market (therapeutic class) in the All Markets list.
   
   **NOTE:** You can select a different market at any time in all views in the Analysis screen, except in the Activities subviews (the Account Detailing Analysis and Contact Detailing Analysis views).
3. Click a category from the view tabs.
4. Display only the sales, Rx, or call data you want to view using query by example or targeting. See Chapter 7, “Planning Calls in Pharma,” for information on targeting.
   
   **NOTE:** By default, Siebel Pharma displays (and charts) all available data appropriate to the selected Analysis view. It is recommended that you always filter your data lists to make the displayed data more meaningful. The charts in the Account Detailing Analysis and Contact Detailing Analysis views display all calls, regardless of status, unless you filter the data in the upper list.
5. Select a chart type from the drop-down list to specify which type of chart you want to use for viewing the selected data.
   
   Examples of available chart types include 3D stacked bar, 3D bar, and 2D bar.
6. Zoom in on data or limit the chart to particular data points by hovering the mouse cursor over the chart element (a bar or pie segment) to see the data only for that chart element. To return to the complete set of data for the original chart, execute a new query.
Views in the Analysis Screen

In Siebel Life Sciences, the availability of certain views can be limited according to each user’s responsibilities. Therefore, the views you see may differ from those shown and described in Table 21.

**NOTE:** Analysis data is read-only. Data refresh cycles are determined by your company’s business process and data availability.

Table 21 describes the functions of the views in the Analysis screen. Your responsibilities determine which views are available to you.

<table>
<thead>
<tr>
<th>View</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Markets &gt; Direct Sales Trend by Territory - Volume</td>
<td>For managers, displays internal product sales data at the territory level over a selected period of time. Displays direct sales data for areas covered by their sales representatives.</td>
</tr>
<tr>
<td>All Markets &gt; Direct Sales Trend by Account - Volume</td>
<td>For representatives, displays internal product sales data at the account level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Territory - Volume</td>
<td>For managers, displays product sales data at the territory level over a selected period of time. Allows managers to see indirect sales data for the areas covered by their sales representatives.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Territory - Share</td>
<td>For managers, displays product sales data at the territory level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Brick - Volume</td>
<td>For representatives, displays product sales data at the brick level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Brick - Share</td>
<td>For representatives, displays market share data at the brick level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Postal Code - Volume</td>
<td>For representatives, displays product sales data at the ZIP Code level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Postal Code - Share</td>
<td>For representatives, displays market share data at the ZIP Code level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Account - Volume</td>
<td>For representatives, displays product sales data at the account level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Indirect Sales Trend by Account - Share</td>
<td>For representatives, displays market share data at the account level over a selected period of time.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Territory - Volume</td>
<td>For managers, displays product Rx trends in a territory. Allows managers to see Rx trends for the areas covered by their sales representatives.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Territory - Share</td>
<td>For managers, displays product Rx trends in a territory.</td>
</tr>
</tbody>
</table>
Table 21. Views Available from the Analysis Screen

<table>
<thead>
<tr>
<th>View</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Markets &gt; Rx Trend by Prescriber - Volume</td>
<td>For representatives, displays product Rx trends by prescriber.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Prescriber - Share</td>
<td>For representatives, displays product Rx trends by prescriber.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Plan and Territory - Volume</td>
<td>For managers, displays product Rx trends by plan and territory.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Plan and Territory - Share</td>
<td>For managers, displays product Rx trends by plan and territory.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Plan and Prescriber - Volume</td>
<td>For representatives, displays product Rx trends by plan and prescriber.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Plan and Prescriber - Share</td>
<td>For representatives, displays product Rx trends by plan and prescriber.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Payment Type and Prescriber</td>
<td>For representatives, displays product Rx trends by the payment types associated with prescriptions and prescribers.</td>
</tr>
<tr>
<td>All Markets &gt; Rx Trend by Payment Type and Territory</td>
<td>For both representatives and managers, displays product Rx trends by the payment types associated with prescriptions.</td>
</tr>
<tr>
<td>Activities &gt; Account Detailing</td>
<td>For both representatives and managers, shows the number of times a product was detailed during account calls, as well as the priority, or order, of the product details. Use this view to assess your product emphasis and plan your account calls.</td>
</tr>
<tr>
<td>Activities &gt; Contact Detailing</td>
<td>For both representatives and managers, shows the number of times a product was detailed during contact calls, as well as the priority, or order, of the product details. Use this view to assess your product emphasis and plan your contact calls.</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Rx Analysis &gt; Rx trend by brick</td>
<td>For representatives, displays product prescription trends by brick. This data is for the entire brick that is selected in the Bricks list and is not related to any contact.</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Rx Analysis &gt; Rx trend by brick-Product NRx</td>
<td>For representatives, displays new prescriptions for a given product by brick. This data is for the entire brick that is selected in the Bricks list and is not related to any contact.</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Rx Analysis &gt; Rx trend by brick-Product TRx</td>
<td>For representatives, displays total prescriptions for a given product in a given period by brick. This data is for the entire brick that is selected in the Bricks list and is not related to any contact.</td>
</tr>
<tr>
<td>View</td>
<td>Functions</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Sales Analysis &gt; Indirect sales by brick</td>
<td>For representatives, displays indirect sales data at the brick level for the brick selected on the Bricks list.</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Sales Analysis &gt; Indirect sales trend by product value</td>
<td>For representatives, displays indirect sales data at the brick level for the selected product and for the brick selected on the Bricks list.</td>
</tr>
<tr>
<td>Bricks &gt; Bricks Sales Analysis &gt; Indirect sales trend by product units</td>
<td>For representatives, displays indirect sales data at the brick level for the selected product unit and for the brick selected on the Bricks list.</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- “About Tracking Time Off Territory” on page 227
- “Scenario for Time Off Territory” on page 227
- “Process of Tracking Time Off Territory” on page 228
- “Creating a Time Off Territory Record (End User)” on page 228
- “Submitting a Time Off Territory Record (End User)” on page 229
- “Viewing Time Off Territory Charts (End User)” on page 229
- “Configuring Time Off Territory” on page 230

**About Tracking Time Off Territory**

In order to better manage their sales and field personnel, pharmaceutical companies need a way to measure and track the amount of time individuals take off.

A time off territory is any block of time during normal business hours in which sales representatives are out of their territories. Examples of time off territory include field trainings, national sales meetings, sick leave, vacation, or personal activities such as doctor’s appointments.

Companies can use time off territory information to track the time that remote sales and field personnel spend on activities that do not directly relate to accounts, contacts, or opportunities. Companies can use this information to:

- Maintain a record of field employee time such as vacation and sick days
- Evaluate market penetration based on territory coverage and to assess the effectiveness of field personnel

Using the views in the Time Off Territory screen, users can record blocks of time that should not be included in call-frequency reporting. In addition, they can enter and record past and future time off information, including the duration, reason, date, and description of the time off territory event.

Because time off territory is actually a type of activity in Siebel Pharma, time off territory records appear in the Activities screen and in views that display activities. For more information about activities, see “About Creating Activities” on page 112.

**Scenario for Time Off Territory**

This scenario is an example process performed by two types of end users, a field sales representative and his or her regional sales manager. Your company may follow a different process according to its business requirements.
A sales representative for a pharmaceutical company has been invited to a two-day, out of town seminar. She speaks to her manager and they decide she should attend it. The sales representative then uses Time Off Territory to record why her territory will not be worked on the days on which the seminar will take place. Once she submits the information, her manager has a record of where she is and why she is gone.

### Process of Tracking Time Off Territory

This topic details sample tasks often performed by end-users when tracking time off territory. Your company may follow a different process according to its business requirements.

When tracking time off territory, end users typically perform the following tasks:

- **“Creating a Time Off Territory Record (End User)” on page 228.** Typically, the sales representative creates a record for all of the days she will be attending the seminar.

- **“Submitting a Time Off Territory Record (End User)” on page 229.**

The regional sales manager uses Siebel Time Off Territory to:

- **“Viewing Time Off Territory Charts (End User)” on page 229.** The regional sales manager can review the time off territory records that have been submitted to the system.

Once the sales representatives submit time off territory records to the system, Siebel Pharma:

- Creates a new time off territory record in the Activities list.
- For each time off territory record, creates an all-day appointment in the calendar.

**NOTE:** Siebel Time Off Territory includes two filters for displaying time off territory records: My Time Off Territory and My Team’s Time Off Territory. Each user’s responsibilities determines which of these views are available.

### Creating a Time Off Territory Record (End User)

End users must create at least one time off territory record for business days that they spend on activities not directly related to an account, contact, or opportunity. A single time off territory record can represent one or many days. Multiple time off territory records can represent different activities performed on a single day. For example, a user could create one record for a conference attended in the morning and another for vacation time taken in the afternoon.

**To create a time off territory record**

1. Navigate to the Time Off Territory screen.
2 Create a new record and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The reason for the time off.</td>
</tr>
<tr>
<td>Hours</td>
<td>Represents duration of the time off request. The application automatically calculates this value when you enter or update the Start Time and End Time fields.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of a time off request. End users cannot select Submitted. For more information on changing the status of a record to Submitted, see &quot;Submitting a Time Off Territory Record (End User)&quot; on page 229.</td>
</tr>
</tbody>
</table>

The new time off territory record appears in the Activities lists and in the calendar.

**Submitting a Time Off Territory Record (End User)**

End users must submit a time off territory record for the information to be included in ROI (return on investment) analyses and expense reports. Once a time off territory record has been submitted, it can no longer be modified or deleted.

**To submit a completed time off territory record**

1 Navigate to the Time Off Territory screen.
2 Select the record you want to submit.
3 Click Submit and then OK.

The status of the time off territory record changes to Submitted and the record becomes read-only.

**Viewing Time Off Territory Charts (End User)**

Managers and end users can view graphical charts of time off territory information by clicking the Charts view tab. Using these charts is an effective way see trends and patterns.
For Siebel Mobile Web Client: If your routing rules are not configured to route employee time off territory records to managers, employees can give calendar access to their managers so that managers working remotely can view their teams’ time off territory records.

**NOTE:** Routing rules can no longer be edited in the Administration - Siebel Remote screen. For help with editing routing rules, contact your Oracle sales representative for Oracle Advanced Customer Services to request assistance from Oracle’s Application Expert Services.

**To view time off territory charts**
1. Navigate to the Time Off Territory screen.
2. From the visibility filter, select My Team’s Time Off Territory.
3. On the link bar, click Charts.
4. From the drop-down list, select how you want the information to be displayed:
   - **TOT by Reason.** Displays the number of hours spent off territory each month, by reason.
   - **TOT by Creator.** For managers. Displays the aggregate and incremental number of hours spent off territory.
5. From the By drop-down list, select how you want the information to be displayed.

**Configuring Time Off Territory**

Most of the procedures in Siebel Time Off Territory are end-user related. However, the Siebel administrator may want to:

- Create an approval process and develop alerts so that managers will be notified when sales representatives submit Time Off Territory records. For more information, see the message broadcasting chapter in *Siebel Applications Administration Guide*.
- Enter additional selections to the Reason drop-down list. For more information about Lists of Values, see *Siebel Applications Administration Guide*. 
This chapter describes how a pharmaceutical company can use Siebel Pharma Medical Education (Siebel MedEd) to plan all aspects of a medical education event. A medical education event can be as simple as a “lunch-and-learn” in a physician’s office or as complex as a seminar series or national sales meeting.

Using the procedures given in this chapter you will be able to perform the administrator tasks of setting up funding for MedEd plans, creating templates for activities, making literature selections available to end users, and designating contacts as MedEd speakers. After these administrative tasks have been completed, end users can then use Siebel MedEd to define MedEd plans, set up MedEd events and sessions, and invite and register event attendees.
Siebel MedEd provides a single repository of medical event information to allow administrators and end users to:

- Plan and execute events
- Track allocated event budgets
- Compare allocated budgets to actual event costs

For more information on the differences between administrator and end-user tasks see “Scenario for MedEd Events” on page 233.

**MedEd Terminology**

Before reading further, you should understand the terminology specific to the Siebel MedEd application. This chapter includes the following MedEd-specific terminology:

- **Event or MedEd event.** Refers to a promotional or educational event attended by physicians or medical professionals. An event may consist of single or multiple-sessions and functions as a forum for exchanging information on a particular disease, illness, therapeutic class, or product.

- **Session.** Refers to a single class or meeting attended by one or more participants as part of a particular MedEd event.

- **MedEd Team.** Refers to a group of people from various departments or sales teams who are primarily responsible for the planning, execution, and funding of a MedEd event.

- **Plan.** Refers to a hierarchical collection of MedEd events focused on delivering a specific set of objectives and sharing common funding. For example, the objective might be promotion of a new indication, to gain awareness and increase market share for a particular product. A plan may display aggregated actual cost and attendee information related to every event associated with that plan.

**About MedEd Event Types**

A MedEd event can be any type or promotional or education event attended by physicians or medical professionals. From a corporate perspective, MedEd event types include:

- **Sales Representative Level.** Executed by a manager or one or many sales representatives in the field.

- **Corporate or National Level.** A national training or meeting targeted at a specific group of medical professionals.

Depending upon the needs of their environment, users can plan events at the national level for either a specific product or time period and then allocate resources by region, district, or sales representative.
Scenario for MedEd Events

This topic outlines an example process performed by a Siebel MedEd administrator and end users. Your company may follow a different process according to its business requirements.

A product manager at a pharmaceutical company is responsible for increasing the market share of a new product. To accomplish this objective, he uses Siebel MedEd to plan various dinners, symposiums, and lunch-and-learn meetings to communicate the budgets and objectives. In Siebel MedEd, he creates a MedEd plan and then defines how much money each sales representative will be given to drive events within the district. In the process of creating sub plans, the product manager allocates a budget and assigns the teams who will be responsible for event planning and execution.

Sales representatives in the field use Siebel MedEd to see the events and plans to which they have been assigned, itemize the tasks they need to accomplish, invite various contacts, record expenses, develop the meetings agendas, associate speakers, add materials, and manage the overall calendar of events in his or her territory. Over time, the product manager can closely monitor whether his team is executing on-time and within budget by comparing each event’s allocated budget with the actual costs.

In this scenario, the product manager is responsible for administrating Siebel MedEd so that end users can plan, track, and execute medical events. As the MedEd administrator, he requires administrative responsibilities in Siebel MedEd to:

- Establish funds for a MedEd plan
- Create MedEd activity templates
- Add MedEd literature items to the application
- Designate a contact as a MedEd speaker

The end users are the sales representatives and managers who execute MedEd events in the field. They enter information to:

- Set up a MedEd plan
- Set up MedEd events
- Track the MedEd event costs
- Set up sessions within an a MedEd event to track speakers and associate literature and materials with the event
- Designate a contact as a MedEd speaker
- Invite and register MedEd event attendees

Process of Managing MedEd Events

This topic details sample tasks often performed by administrators and end users when managing MedEd events. Your company may follow a different process according to its business requirements.
Managing MedEd Events ■ Establishing Funds for MedEd Plans

Administrator Procedures
The following list shows tasks administrators typically perform to manage MedEd events. The administrator may be the product manager who is responsible for using Siebel MedEd to plan a variety of events that feature the new product. These tasks are typically performed in the following order:

1. “Establishing Funds for MedEd Plans” on page 234
2. “Creating Master MedEd Plans” on page 236
3. “Creating a MedEd Activity Template” on page 237
4. “Administering MedEd Literature” on page 239
5. “Designating MedEd Event Speakers” on page 240

End-User Procedures
The following list shows tasks end users typically perform when managing MedEd events. These tasks are typically performed in the following order:

1. “Setting Up a MedEd Plan (End User)” on page 240
2. “Setting Up MedEd Events (End User)” on page 242
3. “Tracking Costs of MedEd Activities (End User)” on page 244
4. “Setting Up Sessions Within a MedEd Event (End User)” on page 246
5. “Inviting and Registering Prospective MedEd Attendees (End User)” on page 249
6. “Generating Correspondence for MedEd Event Invitees (End User)” on page 250
7. “Scheduling Calls to an Invitee (End User)” on page 250

Establishing Funds for MedEd Plans
A MedEd plan is a database record in which you specify common funding for a group of MedEd events that share a common objective. Each MedEd event can be funded by up to one MedEd plan for each event team member who is responsible for each event. Using the MedEd Activities view, you can track costs associated with each event. Because these events are automatically aggregated by plan, you can compare actual expenditures with MedEd plans across sales divisions.
Figure 8 shows the possible relationships between MedEd funds, master plans, subplans, events, sessions, activities, and invitees.

To establish a fund and associate it with a MedEd plan, you must:

- **Define an active period for the fund.** Define an active period that can be assigned to a fund. For more information on defining periods, see *Siebel Applications Administration Guide.*
Establish the fund. Establish the fund by loading fund information into the database using Siebel Enterprise Integration Manager (EIM). To perform this task, you must consult Siebel Enterprise Integration Manager Administration Guide to determine which columns are included in the database table EIM_MDF and how those columns map to the columns in the base table S_MDF. Then, use a standard SQL utility to place information about the fund you are establishing in the EIM_MDF table.

**NOTE:** If you want the fund to be active immediately, make sure that the current date falls between the start date and end date that you specify for the fund.

For more information on using EIM, see Siebel Enterprise Integration Manager Administration Guide.

Verify fund availability. Verify that the fund has been successfully established and is available for association with a MedEd plan. For more information, see the procedure “To verify that a fund is available for association with a MedEd plan” on page 236.

**To verify that a fund is available for association with a MedEd plan**

1. Navigate to the Administration - Data screen > MedEd Planning view.
2. In the Plans list, select a plan.
3. In the Plan Administration form, click the select button in the Funds field. All active funds listed in the S_MDF table appear.
4. Verify the fund you want is available and then close the dialog box.

Creating Master MedEd Plans

Administrators and managers create master MedEd plans to allocate funding resources and spending privileges to end users who perform tasks associated with a MedEd event. Each person who receives a funding allocation from a specific MedEd plan can create one or more subplans to further specify how the funds will be allocated. For more information on creating MedEd plans and subplans, see “Setting Up a MedEd Plan (End User)” on page 240.

**To create a MedEd master plan**

1. Navigate to the Administration - Data screen > MedEd Planning view.
2. In the Plan Administration form, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>Person responsible for carrying out the plan. Defaults to the current user name.</td>
</tr>
<tr>
<td>Budget</td>
<td>Amount of money authorized for spending under the plan.</td>
</tr>
<tr>
<td>Funds</td>
<td>One or more funds (cost centers) associated with the plan.</td>
</tr>
</tbody>
</table>
Creating a MedEd Activity Template

Activity templates let you provide your MedEd event team with a list of standard activities required to successfully complete a particular type of event. Each activity plan for an individual event depends upon an activity template. Activity plans assist you in scheduling and assigning activities.

**To create an activity template for a MedEd event**

- Create an activity template of type Pharma ME Event.

  For information about how to create activity templates, see *Siebel Applications Administration Guide*.

  **NOTE:** Lead times for MedEd activities are defined as the amount of time between the start date for an activity plan and the date that the selected activity should start.
MedEd Lists of Values

As you work with various MedEd records, you will find a number of fields that require you choose values from drop-down lists. Table 22 lists the locations, field names, and values types of some MedEd drop-down lists.

<table>
<thead>
<tr>
<th>Views</th>
<th>Field Name</th>
<th>List of Values Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MedEd Events &gt; More Info view tab</td>
<td>Accreditation</td>
<td>LS_ME_EVT_ACCREDT_CD</td>
<td>Organizations that give Continued Medical Education (CME) credits for attending MedEd events.</td>
</tr>
<tr>
<td></td>
<td>Dress Code</td>
<td>LS_ME_EVT_DRESS_CD</td>
<td>Appropriate types of dress for MedEd events.</td>
</tr>
<tr>
<td></td>
<td>Status</td>
<td>LS_ME_EVT_STAT_CD</td>
<td>Status of MedEd events. Note: When the status is Completed, the event and its children records—such as Invitees, Sessions, Material, Activities, and Activity Plan—are locked. The status can only be unlocked by the administrator using the Administration - Data screen &gt; MedEd Event Details.</td>
</tr>
<tr>
<td>MedEd Events &gt; Invitees view tab</td>
<td>Type</td>
<td>LS_ME_EVT_TYPE_CD</td>
<td>Types of MedEd events.</td>
</tr>
<tr>
<td>MedEd Events &gt; Event Details view tab</td>
<td>Role</td>
<td>LS_ME_INV_ROLE_CD</td>
<td>Roles that invited contacts or employees may fill for MedEd events.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When the status is Completed, the event and its children records—such as Invitees, Sessions, Material, Activities, and Activity Plan—are locked.</td>
</tr>
</tbody>
</table>
If you need to create a new value in the list of values, follow the procedures on modifying a list of values in *Siebel Applications Administration Guide*.

### Administering MedEd Literature

You can associate a literature item with one or more MedEd sessions when it meets two conditions:

- The literature item is stored in the Siebel Life Sciences repository
- The Literature Type of the item is set to Sales Tool

For information about how to associate the literature item with a MedEd session, see "To specify literature for a MedEd session" on page 248.

### To add a literature item to the application

- Follow the procedure for adding literature records in the *Siebel Applications Administration Guide*.
Designating MedEd Event Speakers

Both administrators and end users may designate a contact as a speaker. In order to associate a speaker with a MedEd session, you must include the speaker as a Contact in the S_CONTACT table and select the Speaker flag.

For more information on working with contacts, see Chapter 4, "Managing Contacts in Life Sciences."

To designate a contact as a MedEd speaker

1. Navigate to the Contacts screen > Contacts List view.
2. From the Show drop-down list, select All Contacts.

   **NOTE:** Depending on your responsibilities, you may also be able to use the My Contacts, My Team’s Contacts, or the All Contacts Across Organizations filters.

3. In the Contacts list, select the Speaker field for the contact you want to designate as a speaker.

   The application lists the contact as a possible speaker for MedEd sessions.

Setting Up a MedEd Plan (End User)

A MedEd plan is a database record that lets end users specify common funding for a group of medical education events that have a common objective. A subplan allocates a specific amount of the parent plan’s funding to a given user in order to help accomplish the parent plan’s objectives.

End users can compare aggregated actual costs of event activities with the MedEd plan budget at any time. For information on tracking costs, see “Tracking Costs of MedEd Activities (End User)” on page 244.

To create a MedEd plan

2. In the Plans list, create a new record, and complete the necessary fields.

   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>Person responsible for carrying out the plan.</td>
</tr>
<tr>
<td>Budget</td>
<td>Amount of money that the plan authorizes the responsible person to spend.</td>
</tr>
<tr>
<td>Parent Plan Name</td>
<td>Blank for master plans. For subplans, the application automatically provides the name of the associated parent plan.</td>
</tr>
<tr>
<td>Periods</td>
<td>Time period during which the plan is to be used.</td>
</tr>
<tr>
<td>Plan Name</td>
<td>The name of the MedEd plan for which team members can associate event costs with a given fund.</td>
</tr>
</tbody>
</table>
In the form, enter any additional details. The application automatically creates an unique alphanumeric value for the Plan ID.

Specify the details of the new MedEd Plan by creating subplans as described in the next procedure.

**To create a subplan**

2. In the Plans list, drill down on the Name of the plan for which you want to specify a subplan.
3. In the Sub-Plans list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>Person responsible for carrying out the subplan.</td>
</tr>
<tr>
<td>Budget</td>
<td>Amount of money that the subplan authorizes the responsible person to spend. If you wish to keep some funding in reserve, do not allocate the entire amount of the parent plan to the subplans.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the subplan.</td>
</tr>
<tr>
<td>Objective</td>
<td>One or more purposes to be accomplished by holding the MedEd events associated with the subplan.</td>
</tr>
<tr>
<td>Period</td>
<td>Time period during which the subplan is to be used. For more information on defining periods, see <em>Siebel Applications Administration Guide</em>.</td>
</tr>
<tr>
<td>Products</td>
<td>Products to be promoted with the funds supplied under this subplan.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the subplan. Defaults to Active.</td>
</tr>
</tbody>
</table>

The application automatically populates the subplan Plan Status and Assigned To fields.

4. Scroll down to the Events list. In this view, the Events list is read-only.

When you create an event, you associate the event with a funding plan by assigning fractions of the event cost to specific end users. Once an event has been associated with an end user, that user designates which MedEd plan will be charged for his or her share of the total event costs. For more information, see the next topic, “Setting Up MedEd Events (End User)” on page 242.
Managing MedEd Events ▪ Setting Up MedEd Events (End User)

Setting Up MedEd Events (End User)

A MedEd event is a database record that describes an educational event attended by physicians or medical professionals. An event may consist of single or multiple-sessions and functions as a forum for exchanging information on a particular disease, illness, therapeutic class, or product.

The cost of a MedEd event can be allocated across multiple products and across team members. Users who have purchased and installed the optional Pharma Sales Analytics product can use cost allocations as input when creating return on investment (ROI) analysis reports.

**NOTE:** Users who have purchased and installed the optional MedEd for Customers module can also display MedEd event information to selected professionals on their Physician Portal Web site. For more information, see *Siebel Life Sciences Portals Guide*.

To create a MedEd event

2. Create a new record and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accreditation</td>
<td>The organization that will be giving Continued Medical Education (CME) credits for attending the event.</td>
</tr>
<tr>
<td>Budget</td>
<td>The amount of money budgeted for the event.</td>
</tr>
<tr>
<td>CME Credit</td>
<td>Number of CME (Continued Medical Education) credits that can be earned at the event. For MedEd for Customers, this field appears on the Physician Portal Web site.</td>
</tr>
<tr>
<td>Confirm Date</td>
<td>Date on which MedEd team members should send any confirmation reminder messages to registered invitees.</td>
</tr>
<tr>
<td>Confirmation</td>
<td>Indicates whether MedEd team members should send messages to registered invitees prior to the event reminding them to attend and asking them to reconfirm their attendance.</td>
</tr>
<tr>
<td>Created By</td>
<td>User name for the person who created the MedEd event.</td>
</tr>
<tr>
<td>End</td>
<td>Date and time that the event ends. Set the time fields before clicking a calendar day. For MedEd for Customers, this field appears on the Physician Portal Web site.</td>
</tr>
<tr>
<td>Fee Required</td>
<td>Indicates whether the event requires an attendance fee.</td>
</tr>
<tr>
<td>Location</td>
<td>City and address or venue where the event is to take place. For MedEd for Customers, this field appears on the Physician Portal Web site.</td>
</tr>
<tr>
<td>MedEd ID</td>
<td>The application automatically creates this alphanumeric value when you create the event.</td>
</tr>
</tbody>
</table>
In the MedEd Team field, click the Select button.

All available team members appear in the Event Team dialog box.

**To allocate event costs across team members**

2. In the MedEd Events list, drill down on an event.
3. Click the Cost Allocation view tab.
For each team member, enter the percentage of the event costs that will be charged to that team member.

For example, if an event team consists of three employees, one employee might be allocated 40% of the cost and the remaining two employees might be allocated 30% of the cost.

NOTE: The total of the values you enter for Cost Allocation across team members should equal 100%.

Select your own record, specify a plan, and click OK.

Each MedEd Team member must log in to Siebel Life Sciences, and specify which MedEd plan will be charged for his or her portion of the event’s costs.

To allocate event costs across product lines

2. In the MedEd Events list, drill down on an event.
3. In the Product field, click the Select button, and the Products dialog box appears.
4. Add one or more products that will be discussed at the event.
5. In the Cost Allocation field for each product, enter the percentage of the event costs that will be charged to each product.

NOTE: The total of the values you enter for Cost Allocation across products should equal 100%.

Tracking Costs of MedEd Activities (End User)

In order to compare MedEd costs with the amount of funds budgeted in MedEd plans, event team members must:

- List task activities associated with MedEd events
- Enter the costs incurred for each activity

Siebel MedEd aggregates the line item activity costs against the MedEd plans specified by team members. For increased efficiency in planning event activities, users can create a MedEd activity template for each type of MedEd event that they commonly host.

An activity template allows common recurring tasks to be associated with a given event without having to enter each task manually. Such tasks might include renting a venue, hiring a caterer, obtaining equipment, printing literature, and arranging for other materials to be available for the event. For more information on creating activity templates, see “Creating a MedEd Activity Template” on page 237.

The following procedure describes how to create an activity plan for an individual MedEd event, where the plan contains a combination of tasks derived from an activity template and tasks that are specific to the given event.
To create an activity plan for a MedEd event

2. In the MedEd Events list, drill down on an event.
3. Click the Activity Plans view tab.
4. In the Activity Plans list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Assigned To field should be locked. If the activity is locked, Assignment Manager does not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
<tr>
<td>Planned Start</td>
<td>Refers to the date that planning and preparation for an event starts, rather than the date that the MedEd event starts. Changing the value of Planned Start in an activity plan automatically changes the value of all Due dates for activities that are a part of that plan. In contrast, changing the value of an individual activity’s Due date does not affect the values of Due dates for other activities or the Planned Start date for the activity plan.</td>
</tr>
<tr>
<td>Template</td>
<td>Select an activity template from the drop-down list. Individual activities from the selected template appear in the Activities list. For more information on creating activity templates, see Siebel Applications Administration Guide.</td>
</tr>
</tbody>
</table>

5. If this event involves activities that are not included in the selected activity plan template, click the Activities subview tab.

6. In the Activities list, create a new record, and complete the necessary fields.
   Many activity fields are not applicable to MedEd events and can be left blank.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employees</td>
<td>User name of the person who is to perform the activity. Leave this field blank for the activity to be assigned to the active user.</td>
</tr>
</tbody>
</table>

7. Repeat Step 6 until all activities have been specified.

To record the cost of an activity

2. In the MedEd Events list, drill down on the Name hyperlink for the event for which you want to record the cost.
About Designating MedEd Event Speakers (End User)

Both administrators and end users may designate a contact as a speaker. In order to associate a speaker with a MedEd session, users must include the speaker as a Contact in the S_CONTACT table and select the Speaker flag. For more information, see “Designating MedEd Event Speakers” on page 240.

You can review a list of all designated speakers.

To review all available speakers
1. Navigate to the MedEd screen.
2. On the link bar click All Speakers.
   - The Speakers list shows all contacts who have been designated as speakers. This is a read-only list.
3. In the form, click the show more button to see more details about the speakers.

Setting Up Sessions Within a MedEd Event (End User)

A MedEd event can be a single presentation, such as a lunch-and-learn where participants listen to a single speaker, or it can be composed of multiple individual sessions covering different subject areas. A session consists of a single class or meeting attended by one or more participants of a MedEd event. Because certain types of information are only associated with sessions, users must create at least one session for an event if they want to:

- Track speaker participation
- Associate one or more literature items with the event
Managing MedEd Events ■ Setting Up Sessions Within a MedEd Event (End User)

- Associate materials or equipment items with the event
- Register participants for the event using their Physician Portal Web site and MedEd for Customers software

MedEd is designed to allow participants to register for individual sessions, whether at one-session or at multiple session events.

**NOTE:** MedEd event participants can use the optional MedEd for Customers module to register for MedEd sessions at your Physician Portal Web site. However, participants can only register at the session level. For reasons of configuration flexibility, event-level registration must be entered manually in the Invitee Status field of the Invitee view tab.

The following procedure describes how to create a session for a MedEd event. Repeat this procedure for each required session.

**To create a session for a MedEd event**

2. In the MedEd Events list, drill down on an event.
3. Click the Sessions view tab.
4. In the Sessions list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>CME Credit</td>
<td>Number of Continued Medical Education Credits (CME) that can be earned by attending the session. This field is not typically displayed on the Physician Portal Web site, but can be configured to do so as an implementation detail.</td>
</tr>
<tr>
<td>End Date</td>
<td>Defaults to end date and time for the event that includes the session. However, for multiple session events, each session’s end date and time can differ from the end date and time of the event. Typically, the time is the most important part of this setting. For MedEd for Customers, this field appears on the Physician Portal Web site.</td>
</tr>
<tr>
<td>Location</td>
<td>Describes where the session will be held. Typically used to indicate a room name or number within a hotel, conference center, or other venue.</td>
</tr>
<tr>
<td>Max Attendees</td>
<td>Indicates the maximum number of attendees for the session.</td>
</tr>
<tr>
<td>Products</td>
<td>One or more products targeted for discussion during the session.</td>
</tr>
<tr>
<td>Session Name</td>
<td>Name of the session within a multiple-session event. For single-session events, simply repeat the event name. For MedEd for Customers, this field appears on the Physician Portal Web site.</td>
</tr>
<tr>
<td>Session Objective</td>
<td>Overall goal for the participants attending the session. For MedEd for Customers, this field appears on the Physician Portal Web site, but the field name is changed from Objective to Description.</td>
</tr>
</tbody>
</table>
Managing MedEd Events ■ Setting Up Sessions Within a MedEd Event (End User)

To provide literature to event attendees, end users can associate literature with each session of an event. The MedEd administrator can also create an item in an activity template directing an event team member to make sure that there is adequate stock of the required literature items available. For more information about adding a literature item to the database, see "Administering MedEd Literature" on page 239.

To specify literature for a MedEd session
2. In the MedEd Events list, drill down on an event.
3. Click the Sessions view tab.
4. Drill down on the Session Name hyperlink for the session for which you want to specify literature.
5. Scroll down to the Literature list, and create a new record.

In addition to literature, each session can require certain equipment and other materials, such as flip charts, markers, projectors, and screens. You may wish to create an item in an activity template directing an event team member to make sure that the required materials will be available.

To specify materials for a MedEd session
Managing MedEd Events ■ Inviting and Registering Prospective MedEd Attendees (End User)

In the MedEd Events list, drill down on an event.
3 Click the Sessions view tab.
4 Drill down on the Session Name hyperlink for the session for which you want to specify materials.
5 Scroll down to the Materials list, create a new record, and complete the necessary fields.

The new items appear in the Materials list.

For more information about adding a materials item to the drop-down list of available items, see “MedEd Lists of Values” on page 238. Drop-down values are normally added and maintained by an administrator.

Inviting and Registering Prospective MedEd Attendees (End User)

After an end user has scheduled a MedEd event and decided what sessions will be offered, the next step is to invite participants.

End users who have purchased and set up the optional MedEd for Customers module can also use this procedure to let each invited contact view information about an event on their Physician Portal Web site. For those users who are not using MedEd for Customers, the Invitee information indicates that the call center agents or sales representatives need to convey the invitation to the invitee.

To invite a contact or an employee to a MedEd event
1 Navigate to the MedEd screen > MedEd Events view.
2 In the MedEd Events list, drill down on an event.
3 Click the Invitees view tab.
4 In the Invitees list, create a new record.
5 In the Role field of the Invitees list, select the value that best describes each individual’s role at the session.
6 In the Comments field, enter any additional information.

As soon as you leave the current record, information about the selected session becomes available to the designated invitee at the Physician Portal Web site.

NOTE: When the event status is Completed, the event and its children records—such as Invitees, Sessions, Material, Activities, and Activity Plan—are locked and become read-only lists.

The following procedure describes how to register a contact or employee for a MedEd session by using the dedicated client software. This procedure can be used whether or not you are using the optional MedEd for Customers module for the Physician Portal Web site.
To register an invitee for a MedEd session

1. Invite the contact or employee to the MedEd event as described in “To invite a contact or an employee to a MedEd event” on page 249.
2. In the Invitees list, select the invitee to be registered.
3. Scroll down to the Sessions list and create a new record.
4. In the Registration Status field, change the status to Confirmed.
Repeat Step 3 through Step 4 for each additional session the invitee will attend.

Generating Correspondence for MedEd Event Invitees (End User)

End users can send electronic correspondence, such as an agenda, brochures, or a list of hotels, to all event invitees.

To generate correspondence to multiple invitees

2. In the MedEd Events list, drill down on an event.
3. Click the Invitees view tab.
4. Perform one of the following:
   - Query for the invitees to whom you wish to send correspondence.
   - From the application-level menu, select Edit > Select All to select all the people invited to the MedEd event.
5. From the application-level menu, select File > Send Letter.
   The Correspondence Recipients list shows all the invitees you selected in Step 4.
6. In the Correspondence List, select a correspondence template and complete the necessary fields.

Scheduling Calls to an Invitee (End User)

End users can schedule calls to invitees. These calls appear in the Contacts screen.

To automatically schedule a call to an invitee

2. In the MedEd Events list, drill down on an event.
3. Click the Invitees view tab.
4 Query for the invitees with whom you wish to schedule a call.

5 Click the Schedule button.

6 In the Auto Schedule dialog box, review the displayed values, make any needed changes, and click OK.

The auto-scheduling function does not check for scheduling conflicts. Therefore, users need to verify that automatically scheduled calls do not conflict with other activities in their calendar.
This chapter covers the following topics:

- "About Setting and Achieving Objectives” on page 253
- “Scenario for Objectives” on page 254
- "Process of Objectives” on page 254
- "Creating an Objective” on page 255
- "Creating Recommended Activities for an Objective” on page 256
- "Targeting Accounts to an Objective” on page 258
- “Loading Actual Amount Fields Using EIM” on page 258
- "Reviewing Objectives (End User)” on page 258
- "Charting Objectives” on page 259

**About Setting and Achieving Objectives**

An *objective* is usually a sales or marketing goal, assigned to a particular individual or team, and targeted at a particular set of accounts or contacts. It includes one or more recommended activities to be performed by sales representatives as they visit the target contacts and accounts to which the objective is applied.

Ideally, objectives should be implemented at the beginning of a planning cycle.

Objectives can have child objectives associated with them. For example, an overall objective of increasing prescriptions of a particular product might have associated sub-objectives of increased calls to certain contacts or accounts and improved education on product issues.

**Structuring Objectives**

Managers typically define objectives for their teams, but individual users can also define personal objectives for themselves or create child objectives of larger objectives that have been defined for them. If there is general information about the objective that all team members need to know, include it in the Summary text. If there are electronic versions of documents or graphics that are related to the objective, add them as attachments.

The process of associating accounts and contacts with objectives is an excellent candidate for using target lists. After creating target lists of contacts and accounts at whom you will direct your sales efforts, you can apply those lists in the Objective Targets view.
Scenario for Objectives

This scenario is an example process performed by a pharmaceutical district manager and sales representatives to create and fulfill sales objectives. Your company may follow a different process according to its business needs.

Your company, a large pharmaceutical manufacturer, has received approval for a new indication for one of your products. The district manager is responsible for making sure that the sales representatives reporting to her take the actions necessary to have a successful launch of this product for the new indication.

The district manager begins by creating an objective. Next, she creates three recommended activities that she wants each member of her sales force to carry out in order to meet this objective: to attend a training program, to attend a team meeting to outline tactical aspects of promoting the new indication, and to conduct contact calls. In order to communicate the importance of these activities to her sales force, she assigns the priority “1-ASAP” to all three recommended activities. She also adds a product insert to the objective as a literature item. Her sales representatives can use this product insert to gain valuable information about the new indication prior to visiting contacts. Finally, she adds every targeted contact in each territory to the objective, adds each sales representative as an objective team member.

As the sales representatives check their calendars, they will see that the district manager has scheduled a series of calls for them to complete. As they prepare for each of these calls, they can review the objective and the recommended activities she has created and the product insert she added. Later, as the new indication launch is in progress and the sales representatives are performing sample drops, the district manager and sales representatives can review the objective.

Process of Objectives

This topic details sample tasks often performed by administrators and end users when working with objectives. Your company may follow a different process according to its business requirements.

Administrator Procedures

The following list shows tasks typically performed by district managers or marketing administrators. Although some companies choose to allow sales representative to create their own objectives.

1  “Creating an Objective” on page 255
2  “Creating Recommended Activities for an Objective” on page 256
3  “Targeting Accounts to an Objective” on page 258
4  “Loading Actual Amount Fields Using EIM” on page 258

End-User Procedures

The following list shows tasks end users typically perform when managing their objectives:

1  “Reviewing Objectives (End User)” on page 258
2  “Creating an Objective” on page 255
Creating an Objective

You must complete this task before performing the remaining tasks in this chapter. If you need an objective to recur, see "Creating Recurring Objectives" on page 256.

To create an objective

1. Navigate to the Objectives screen.
2. Create a new record and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Objective</td>
<td>If this objective is a subgoal of another objective, select the parent objective. The parent objective defines some of the criteria for all of its child objectives. For example, child objectives are constrained to the products associated with the parent objective, if any. You can create parent objectives without completing the Parent Objective field. You must complete the Parent Objective field when creating child objectives. Parent-child relationships between objectives can be viewed in the Objectives Explorer view. Note that child objectives are not constrained by the organization or team definitions of the parent objectives.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of objective being created; for example, a promotion or a marketing type of objective. Selecting the type of objective does not drive any other functionality within the product.</td>
</tr>
<tr>
<td>Description</td>
<td>A few words which describe the purpose of the objective.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start date of an objective. It must fall within the objective's time period. This field is automatically updated if the Period field is changed.</td>
</tr>
<tr>
<td>End Date</td>
<td>The ending date of an objective. It must fall within the objective's time period. This field is automatically updated if the Period field is changed.</td>
</tr>
<tr>
<td>Period</td>
<td>The period of time during which an objective must be completed.</td>
</tr>
<tr>
<td>Actual</td>
<td>This data must be imported by the Siebel administrator using EIM. You cannot manually edit this field.</td>
</tr>
</tbody>
</table>
Creating Recurring Objectives
At some time you may wish to create recurring objectives. You can:

- Change the period of an existing objective
- Copy an existing objective and apply a new period to it
- Use a workflow to schedule monthly calls. For general information about workflows, see Siebel Business Process Framework: Workflow Guide.

NOTE: Deleting an objective completely removes the objective from the system. If you are unsure about whether the objective is still active (and therefore should not be deleted), you can remove yourself from the objective’s team instead of deleting the record.

Creating Recommended Activities for an Objective
You can create one or more recommended activities for an objective. These recommended activities are a guide for sale representatives. Sales representatives can review this list and create similar activities for their accounts and contacts targeted for the objective.

To create recommended activities for an objective
1. Navigate to the Objectives screen.
2. In the Objectives list, drill down on the objective for which you want to create an activity.
3 Click the Activities view tab, in the Activities list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of activity to be performed; for example, an assessment or presentation.</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>If the recommended activity requires an assessment to be carried out, the relevant assessment template should be added here.</td>
</tr>
<tr>
<td>Products</td>
<td>Each activity can have one or more products associated with it. The choice of products is restricted to products that are already associated with the objective. To add products to an objective, see “Creating an Objective” on page 255.</td>
</tr>
</tbody>
</table>
Targeting Accounts to an Objective

You can apply objectives to one or more target accounts. The target accounts that will be available are those that belong to the organization of which the user is an account team member.

In the Objective Targets view, add and view accounts and contacts targeted for an objective. You can display charts of progress toward a quantified goal for target accounts or target contacts. A variety of chart formats can be selected from the drop-down menu in the chart view.

**NOTE:** For general information on creating and applying target lists, see *Siebel Applications Administration Guide*.

**To specify target accounts or contacts for an objective**

1. Navigate to the Objectives screen.
2. Drill down on an objective, and click the Targets view tab.
3. Create new records in the Target Accounts and the Target Contacts lists.
   - You can select multiple records in the Add Accounts and Add Contacts dialog boxes.
   - **NOTE:** You can also add accounts through the Target Accounts view (click Commit) and the Account Status view. You can also add contacts through the Contacts Status view.
4. In the form, click Schedule to automatically create and schedule calls to the targeted accounts and contacts.
   - The account calls and contact calls are scheduled for the current date and time.
5. Navigate to the Calendar screen > Daily view and edit the start and end times for the account and contact call records.
   - **NOTE:** Data for the Actual Amount fields in the Target Accounts and Target Contacts lists must be imported by the Siebel administrator. You cannot manually edit these fields. For more information, see Chapter 17, "Importing Data into Life Sciences.”

Loading Actual Amount Fields Using EIM

You must load data into the Actual Amounts fields of Target Accounts and Target Contacts using Siebel Enterprise Integration Manager (EIM). Once loaded, this data becomes read-only. Refer to *Siebel Enterprise Integration Manager Administration Guide*.

Reviewing Objectives (End User)

When end users navigate to the Objectives screen, the default filter used on the Objectives list is My Objectives. The availability of the other view, My Team’s Objectives, can be limited by the user’s responsibilities.

The remaining view tabs and fields visible to the end users in the Objectives screen are identical to those available to the administrator.
To review objectives

1. Navigate to the Objectives screen.
2. From the Show drop-down list, select the appropriate filter:
   - My Objectives: Objectives for which the user is assigned to the team
   - My Team’s Objectives: All objectives within a manager’s team, including their own
   - All Objectives: If available, the list of objectives for the default organization, such as department, business unit, or sales force
   - All Objectives Across Organization: If available, the most comprehensive list of objectives
3. Drill down on an objective.
4. Use the view tabs to review recommended activities, target accounts, and other information about the objectives.

Charting Objectives

During the campaign, managers and sales representatives can graph objective data.

To chart objectives

1. Navigate to the Objectives screen.
2. Select the objective whose status you want to review.
3. On the link bar, click Charts.
   - Choose from the charts available using the Charts view Show drop-down list.
17 Importing Data into Life Sciences

This chapter covers the following topics:

- "Scenario for Importing Data" on page 262
- "Process of Importing Data" on page 262
- "Importing Data with Siebel EIM" on page 262
- "Importing, Extracting, and Routing Syndicated Data" on page 269
- "About Summary Records" on page 272
- "Extracting Data for Mobile Users" on page 272
- "Troubleshooting Syndicated Data Loading" on page 279
- "Views Requiring Syndicated Data Import" on page 279
- "Data Loading Matrix for Syndicated Data" on page 281
- "Importing Syndicated Data Files (End User)" on page 284

In this chapter, you will learn how to import data into your Siebel Life Sciences database.

There are two general categories of data: proprietary data and syndicated data. These two types of data possess different characteristics and should generally be loaded into Siebel base tables using different processes.

**NOTE:** Loading data directly into Siebel base tables is not supported. Because of the complexity of table relationships and Mobile Web Client requirements, and the risk of loss of data integrity, Siebel Enterprise Integration Manager (EIM) must be used to import data into Siebel base tables. Do not attempt to modify data directly in the physical tables.

- **Proprietary data.** This is data that resides in an existing database and must be imported into the Siebel Life Sciences database during initial implementation or on an ongoing basis.

  For proprietary data, Siebel Enterprise Application Integration (EAI) is used. Siebel Enterprise Integration Manager, one method of EAI, is a subsystem in the Siebel Life Sciences software that manages the exchange of data between Siebel Life Sciences database tables and other corporate databases. It includes a number of data integrity features, such as generation of foreign-key references and case adjustment.

- **Syndicated data.** This is read-only data about sales, Rx, and profitability that is provided periodically by third-party vendors. Once delivered, this data must be loaded into the Siebel Life Sciences database and made available to users in a timely fashion. Although you can use Siebel EIM (with transaction logging turned off) to import syndicated data, direct loading with a database utility (such as SQL* Loader) is faster for importing the large volumes of syndicated data typically loaded by pharmaceutical companies.

The Siebel Life Sciences views and business components that require data import, and the data values for those views, are shown in Table 26 on page 279.
Scenario for Importing Data

This scenario is an example of the tasks performed by the database administrator, the application administrator, and the sales representatives. Your company may follow a different sequence according to its business requirements.

The database administrator (DBA) transfers company data into the Siebel Life Sciences interface data tables. The Siebel EIM transfers the data to the Siebel Life Sciences base tables.

Later, the DBA receives syndicated data from a data provider (for example, IMS Health) and transfers this data to a staging table.

The application administrator uses administrative views to map EIM_SYND_DATA fields to S_SYND_DATA, to load the data from the staging table into the application base tables.

After loading a syndicated data update, the application administrator extracts portions of the data according to territory assignment and sends a compressed version of the data extracts to mobile users in the field.

The sales representatives download the data extracts and import them into their local databases. Using the imported data in the Analysis views, they can evaluate their performance and determine where to focus their sales activities.

Process of Importing Data

This topic details sample tasks performed by database and application administrators and end users when importing data.

Administrator Procedures

The following list shows tasks administrators typically perform to import data:

1. "Importing Data with Siebel EIM" on page 262
2. “Importing, Extracting, and Routing Syndicated Data” on page 269
3. "Extracting Data for Mobile Users” on page 272

End-User Procedure

- "Importing Syndicated Data Files (End User)” on page 284

Importing Data with Siebel EIM

Siebel EIM manages the exchange of data between Siebel database tables and other corporate databases. This topic provides information specific to Siebel Life Sciences and supersedes information in Siebel Enterprise Integration Manager Administration Guide. For general information on Siebel EIM, read Siebel Enterprise Integration Manager Administration Guide.
Stages of the Data Import Process

The data import process with Siebel EIM uses two stages, as shown in Figure 9.

1. The data is first copied from external data tapes (or other provided media) into the interface tables for the Siebel Industry Application (SIA), using a native database data-loading utility (such as SQL* Loader).

   For information about the interface tables and their relationships to base tables in the Siebel application database, read "Data and Related Interface Tables" on page 264. For further details on Siebel Industry Application interface tables, such as the contents of each table, read Siebel Enterprise Integration Manager Administration Guide.

2. Using EIM, you transfer the data from the interface tables to predefined destination columns in the base tables of the Siebel Life Sciences database. The EIM process uses a configuration file (default.ifb).

   For general information about default.ifb and instructions on using Siebel EIM, read Siebel Enterprise Integration Manager Administration Guide.

![Figure 9. Process Flow From an External Database to the SIA Database](image)

Recommended Import Order

To correctly establish the relationships between dependent data elements, the data should be imported in the order recommended below. In general, reference data such as therapeutic classes, competitive metrics, and competitive issues should be imported first, followed by employee and product data (internal products, external products, and medical specialties), followed by contacts data. Syndicated data should be loaded last.

The following list shows the recommended import order for all data types specific to Siebel Life Sciences:

1. Reference data (therapeutic classes, competitive metrics, and so on)
2. Employees
3. Broadcast messages
4. Products (both internal and external)
5. Leads
6. Medical specialties
7. Insurance plans
8. Accounts
9. Opportunities
Importing Data into Life Sciences  ■ Importing Data with Siebel EIM

10 Formularies
11 Contacts
12 Contact ratings and rankings
13 Quotes
14 Documents
15 Proposal templates
16 Forecasts
17 Fulfillment data
18 Call lists
19 Objectives
20 Marketing campaigns
21 Product consumption
22 Service requests
23 Product defects
24 Activities and appointments
25 Notes
26 File attachments
27 Syndicated data

Data and Related Interface Tables
The process for importing syndicated data takes advantage of the fact that syndicated data is read-only. Because the row ID on the S_SYND_DATA table is never referred to anywhere else in the Siebel data model, it can be populated with dummy values that differ from usual row IDs. The application administrator uses SQL*Loader to populate the ID field with a unique sequential value, a process which provides either full or partial table-level extraction. Using views in the Administration - Syndicated Data screen, you can define complex routing rules for syndicated data.
Table 23 shows the relationships between the data, interface tables, and base tables.

### Table 23. Data and Related Interface Tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts Contacts</td>
<td>EIM_TGT</td>
<td>S_TGT</td>
<td>Accounts Contacts Targeting List</td>
</tr>
<tr>
<td></td>
<td>EIM_TGT_ADMIN</td>
<td>S_TGT_ADMIN</td>
<td>Targeting Period</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_TGT_ITM_ADMIN</td>
<td>Accounts Contacts - Targeting Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_GT_COL_MAP</td>
<td>Targeting Product Column Mappings</td>
</tr>
<tr>
<td>Account Details</td>
<td>EIM_ACCNT_DTL</td>
<td>S_ORG_EXT</td>
<td>Organization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ORG_EXT_LSX</td>
<td>1:1 Extension table for Account Types</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ORG_EXT_X</td>
<td>1:1 Account Best Times to Visit</td>
</tr>
<tr>
<td>Activities</td>
<td>EIM_ACTIVITY</td>
<td>S_EVT_Act</td>
<td>Activities</td>
</tr>
<tr>
<td></td>
<td>EIM_ACTIVITY1</td>
<td>S_EVT_Act</td>
<td>Activities Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACT_SIGN</td>
<td>Signatures</td>
</tr>
<tr>
<td></td>
<td>EIM_ACTIVITY2</td>
<td>S_EVT_Act</td>
<td>Activities Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACT_PRDINT</td>
<td>Activity Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACT_ISS</td>
<td>Activity Issues</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACT_PROD_ISS</td>
<td>Issues for Activity Products</td>
</tr>
<tr>
<td>Addresses</td>
<td>EIM_ADDR_ORG</td>
<td>S_ADDR_ORG</td>
<td>Account Addresses including Bricks</td>
</tr>
<tr>
<td>Agreements and Contracts</td>
<td>EIM_AGREEMENT</td>
<td>S_DOC_AGREE</td>
<td>Agreements and Contracts</td>
</tr>
<tr>
<td></td>
<td>EIM_AGREE_LS</td>
<td>S_DOC_AGREE</td>
<td>Contracts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_AGREE_PAY</td>
<td>Contract Payments</td>
</tr>
<tr>
<td></td>
<td>EIM__ENTLMNT</td>
<td>S_ENTLMNT</td>
<td>Entitlements and Contract Price Group</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ENTLMNT_ITEM</td>
<td>Price Group Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ENTLMNT_FEE</td>
<td>Nonproduct Fees</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ENTLMNT_ITEM_FEE</td>
<td>Product Fee Price Group</td>
</tr>
<tr>
<td>Brick</td>
<td>EIM_AREA_LS</td>
<td>S_AREA_LS</td>
<td>Bricks</td>
</tr>
</tbody>
</table>
Table 23. Data and Related Interface Tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chat and Discussions</td>
<td>EIM_DISCN_LS</td>
<td>S_TOPIC_LS</td>
<td>Chat/Discussion Topics</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_TOPIC_CON_LS</td>
<td>Chat User Registration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_MESG_BRD_LS</td>
<td>Message Board</td>
</tr>
<tr>
<td>Clinical</td>
<td>EIM_CL_ACT_LS</td>
<td>S_EVT_ACT</td>
<td>Clinical Activity Columns</td>
</tr>
<tr>
<td></td>
<td>EIM_CL_DSGN_LS</td>
<td>S_CL_DSGN_LS</td>
<td>Clinical Designs</td>
</tr>
<tr>
<td></td>
<td>EIM_CL_PGM_LS</td>
<td>S_CL_PGM_LS</td>
<td>Clinical Programs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PGM_ATT_LS</td>
<td>Clinical Program Attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PGM_APP_LS</td>
<td>Clinical Program Applications</td>
</tr>
<tr>
<td></td>
<td>EIM_CL_PTCL_LS</td>
<td>S_CL_PTCL_LS</td>
<td>Clinical Protocols</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PTCL_LXM</td>
<td>1:M Protocol Extension Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PTL_ATT_LS</td>
<td>Clinical Protocol Attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PTL_POS_LS</td>
<td>Clinical Protocol Positions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CPTCL_DSGN_LS</td>
<td>Clinical Protocol Designs</td>
</tr>
<tr>
<td></td>
<td>EIM_CL_SUBJ_LS</td>
<td>S_CL_SUBJ_LS</td>
<td>Clinical Subjects</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_SUBJ_ST_LS</td>
<td>Clinical Subject Status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_SJ_CSNT_LS</td>
<td>Clinical Subject Consent</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_SBJ_ATT_LS</td>
<td>Clinical Subject Attachments</td>
</tr>
<tr>
<td></td>
<td>EIM_PTL_SITE_LS</td>
<td>S_PTCL_SITE_LS</td>
<td>Clinical Protocol Sites</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PTCL_ST_POS_LS</td>
<td>Clinical Protocol Site Positions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PTCL_ST_ATT_LS</td>
<td>Clinical Protocol Site Attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PTCL_ST_CON_LS</td>
<td>Clinical Protocol Site Contacts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PS_STMPVER_LS</td>
<td>Clinical Protocol Site Template Versions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_ACT_EXC_LS</td>
<td>Clinical Protocol Site Activity Exceptions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CL_PYMNT_LS</td>
<td>Clinical Payments</td>
</tr>
<tr>
<td></td>
<td>EIM_SBJ_TMPL_LS</td>
<td>S_SUBJ_TMPL_LS</td>
<td>Subject Templates</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_SUBJ_TMP_VER_LS</td>
<td>Subject Template Versions</td>
</tr>
<tr>
<td></td>
<td>EIM_TMPL_PLNITM</td>
<td>S_TMPL_PLAN_ITEM</td>
<td>Subject Template Visits</td>
</tr>
</tbody>
</table>
### Table 23. Data and Related Interface Tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Companies</td>
<td>EIM_ACCOUNT</td>
<td>S_ORG_EXT</td>
<td>Organization</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACCNT_POSTN</td>
<td>Position for Account</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ADDR_ORG</td>
<td>Account Addresses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ORG_REL</td>
<td>Account Affiliations</td>
</tr>
<tr>
<td></td>
<td>EIM_ACCOUNT1</td>
<td>S_ORG_EXT</td>
<td>Organization Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACCNT_CLS_RNK</td>
<td>Account Ratings and Rankings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACCNT_MED_PROC</td>
<td>Account Medical Procedures</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACCNT_MED_SPEC</td>
<td>Account Medical Specialties</td>
</tr>
<tr>
<td>Contacts</td>
<td>EIM_CONTACT</td>
<td>S_CONTACT</td>
<td>Contacts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ADDR_PER</td>
<td>Contact Addresses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CONTACT_REL</td>
<td>Contact Affiliations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PER_ORG_UNIT</td>
<td>Contact to Account Affiliations and Roles</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_STATE_LIC_LS</td>
<td>Contact State Licenses</td>
</tr>
<tr>
<td></td>
<td>EIM_CONTACT1</td>
<td>S_CONTACT</td>
<td>Contacts Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_POSTN_CON</td>
<td>Contact Positions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CON_ADDR</td>
<td>Contact Address Usage</td>
</tr>
<tr>
<td></td>
<td>EIM_CON_DTL</td>
<td>S_CONTACT</td>
<td>Contacts Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CONTACT_LS</td>
<td>1:1 Contacts Extension Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CONTACT_LSXM</td>
<td>1:M Contacts Extension Table</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ACCNT_CON_ATT</td>
<td>Accounts Contacts File Attachments</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_NOTE_ACCT_CON</td>
<td>Accounts Contacts Notes</td>
</tr>
<tr>
<td>Formularies</td>
<td>EIM_FRMULRY_LS</td>
<td>S_FORMULARY</td>
<td>Formulary Opportunities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_FRMULRY_PROD</td>
<td>Formulary Products</td>
</tr>
<tr>
<td>Industry</td>
<td>EIM_INDUSTRY</td>
<td>S_INDUST</td>
<td>Account and Contact Types</td>
</tr>
<tr>
<td>Insurance Plans</td>
<td>EIM_INS_PLAN_LS</td>
<td>S_INS_PLAN</td>
<td>Insurance Plans</td>
</tr>
</tbody>
</table>
### Importing Data with Siebel EIM

#### Medical Education

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Education</td>
<td>EIM_ME_EVT_LS</td>
<td>S_ME_EVT_LS</td>
<td>MedEd Events</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_EVT_POS_LS</td>
<td>MedEd Event Positions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_EVT_PRD_LS</td>
<td>MedEd Event Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_EVT_INV_LS</td>
<td>MedEd Event Invitees</td>
</tr>
<tr>
<td></td>
<td>EIM_ME_PLN_LS</td>
<td>S_ME_PLN_LS</td>
<td>MedEd Plans</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_PLN_MDF_LS</td>
<td>MedEd Plan Funds</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_PLN_PRD_LS</td>
<td>MedEd Plan Products</td>
</tr>
<tr>
<td></td>
<td>EIM_ME_SES_LS</td>
<td>S_ME_SES_LS</td>
<td>MedEd Sessions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_SES_PRD_LS</td>
<td>MedEd Session Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_SES_INV_LS</td>
<td>MedEd Session Invitees</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_SES_LIT_LS</td>
<td>MedEd Session Literature</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_ME_SES_MAT_LS</td>
<td>MedEd Session Materials</td>
</tr>
</tbody>
</table>

#### Medical Procedures

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Procedures</td>
<td>EIM_PROC_LS</td>
<td>S_MED_PROC</td>
<td>Medical Procedures</td>
</tr>
</tbody>
</table>

#### Medical Specialties

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Specialties</td>
<td>EIM_SPEC_LS</td>
<td>S_MED_SPEC</td>
<td>Medical Specialties</td>
</tr>
</tbody>
</table>

#### Objectives

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objectives</td>
<td>EIM_ACCT_SRC</td>
<td>S_ACCNT_SRC</td>
<td>Target Accounts for Objectives</td>
</tr>
<tr>
<td></td>
<td>EIM_CONTACT2</td>
<td>S_CONTACT</td>
<td>Contacts Only User Key</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_CAMP_CON</td>
<td>Target Contacts for Objective</td>
</tr>
<tr>
<td></td>
<td>EIM_SRC</td>
<td>S_SRC</td>
<td>Objectives</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_SRC_POSTN</td>
<td>Objective Positions</td>
</tr>
</tbody>
</table>

#### Products

<table>
<thead>
<tr>
<th>Data</th>
<th>Interface Table</th>
<th>Base Table</th>
<th>Table Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>EIM_PROD_INT</td>
<td>S_PROD_INT</td>
<td>Products-Details, Samples, Markets, Lots, and Promotional Items</td>
</tr>
<tr>
<td></td>
<td>EIM_PROD_INT1</td>
<td>S_PROD_INT</td>
<td>Products</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PROD_POSTN</td>
<td>Personal Product List</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S_PROD_REL</td>
<td>Product Relations</td>
</tr>
</tbody>
</table>
For further information, see *Siebel Enterprise Integration Manager Administration Guide*, which lists the contents of each table referred to in Table 23 on page 265:

- Specific data and file attachments that Siebel EIM can process.
- Names of the interface tables.
- Target base tables mapped to the interface tables.
- Any secondary tables associated with the target tables (where data from the interface tables might ultimately reside).

### Importing, Extracting, and Routing Syndicated Data

The process described here for importing syndicated data takes advantage of the fact that syndicated data is read-only. Because the row ID on the S_SYND_DATA table is never referred to anywhere else in the Siebel data model, it can be populated with dummy values that differ from usual row IDs. The application administrator uses SQL*Loader to populate the ID field with a unique sequential value, a process that allows either full or partial table-level extraction. Using views in the Administration - Syndicated Data screen, you can define complex routing rules for syndicated data.

**NOTE:** Routing rules are used by Siebel Remote and Replication Manager to determine what data and transactions are routed to mobile client databases and regional databases. For more information on routing rules, see *Siebel Remote and Replication Manager Administration Guide*.

The views that require syndicated data import are shown in Table 26 on page 279.

The general steps for loading syndicated data and distributing it to mobile users are:

1. Load the data into the base tables of the Siebel Life Sciences database.
   - If you choose to use EIM to load the data, turn off transaction logging.
2. Extract the data required by mobile users.
3. Transfer the extracted data files to mobile users.
Loading Data into the Siebel Life Sciences Database

Before you can view syndicated data in Siebel Applications, you must first populate the foreign keys fields in the S_SYND_DATA table. These keys are populated from the sales representative (POSITION_ID), territory (TERR_ID), product group (MARKET_ID), product (PROD_ID), contact (CON_ID), area (AREA_ID), and period (PERIOD_ID) fields. Each of these is a key to a record in another Siebel application table. Therefore, these fields need to be populated with valid row IDs for the corresponding position, territory, product group, product, and period business components.

To load syndicated data, the application must have the row IDs for the foreign key data that is stored in the S_SYND_DATA table. The data files used to load syndicated data are supplied in a format in which any key information is supplied as a textual description. This means that unless EIM is used to load the data, the textual descriptions need to be converted into their Siebel application table row ID equivalents.

Different data types need to be supplied to make a record visible in S_SYND_DATA. The only compulsory foreign key field is the PERIOD_ID. However, there is a unique index on the table that comprises all of the foreign key fields: S_SYND_DATA_U1. Table 24 lists all of the foreign key fields, their foreign key table, and a description of what the field contains for Siebel Life Sciences.

Table 24. Foreign Key Fields in Syndicated Data Loading

<table>
<thead>
<tr>
<th>Field</th>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AREA_ID</td>
<td>S_AREA_LS</td>
<td>Brick/Mini Brick Id</td>
</tr>
<tr>
<td>CON_ID</td>
<td>S_CONTACT</td>
<td>Contact for this sales data</td>
</tr>
<tr>
<td>MARKET_ID</td>
<td>S_PROD_INT</td>
<td>Product Group</td>
</tr>
<tr>
<td>OU_EXT_ID</td>
<td>S_ORG_EXT</td>
<td>Account</td>
</tr>
<tr>
<td>PERIOD_ID</td>
<td>S_PERIOD</td>
<td>Period</td>
</tr>
<tr>
<td>PLAN_ID</td>
<td>S_INS_PLAN</td>
<td>Plan</td>
</tr>
<tr>
<td>POSITION_ID</td>
<td>S_POSTN</td>
<td>Person who owns the data (for example, a sales representative)</td>
</tr>
<tr>
<td>PRDINT_ID</td>
<td>S_PROD_INT</td>
<td>Product</td>
</tr>
<tr>
<td>TERR_ID</td>
<td>S_ASSN_GRP</td>
<td>Territory</td>
</tr>
</tbody>
</table>

Use a native data loader (recommended method) such as SQL*Loader in Oracle or BCP in SQL Server. For the purposes of example, Oracle is used as the target database, although the technique applies equally to SQL Server. Alternatively, you can use Visual Basic and Com.

Using SQL*Loader to Load the Data

Data records in Siebel applications do not refer to the row ID field in the S_SYND_DATA table. You can insert any value in this field if it is unique in the record. Therefore, you can use a native database utility to populate this table. This method discusses the use of the Oracle SQL*Loader utility. As with the Visual Basic and COM method, using SQL*Loader requires that you resolve the foreign key references either before or after the data has been loaded into the table.
To use SQL*Loader to load the data

1. Resolve the foreign keys before loading.
   Process the input file one line at a time and convert each foreign key value into a row ID. To save time, first load the data directly into the table as it is stored in the flat file, then update the foreign key fields using SQL statements.

2. Load the data file using a .ctl format file.
   The following is an example of loading a data file:
   ```sql
   options (rows=100)
   load data
   infile 'c:\myfile.txt'
   badfile 'c:\myfile.bad'
   append
   into table S_SYND_DATA
   fields terminated by "",
   trailing null cols
   (ROW_ID SEQUENCE (MAX,1),
   CREATED SYSDATE, CREATED BY CONSTANT "1-0",
   LAST_UPD SYSDATE, LAST_UPD_BY CONSTANT "1-0",
   MODIFICATION_NUM CONSTANT 0,
   CONFLICT_ID CONSTANT "0",
   POSITION_ID, TERR_ID,
   PERIOD_ID, DATA_SRC_CD CONSTANT "RXTer",
   MARKET_ID, PRDINT_ID, ATTRIB_01)
   ``

3. Run the SQL*Loader utility from the command line using the following syntax:
   ```sql
   SQLLDR73.EXE database/userid@pw control=c:\my.ctl log=c:\my.log
   ```
   **NOTE:** The exact file name and syntax of the Loader utility is determined by the version of Oracle being used.

4. When the data has been loaded, resolve the foreign key references for each field. This step makes the data visible to the users, as in the following example.
   ```sql
   UPDATE s_synd_data
   FROM s_period p
   SET s_synd_data.period_id=p.id
   WHERE p.name=s_synd_data.period_id ;
   ```
   This code updates the Period field in the Syndicated Data Table to the ID of the Period rather than to the textual description of the period. You must modify and run this code for each foreign key field referred to in Table 24 on page 270. The code only needs to be run for each field that you load, not for all of the fields.

**Alternative Method: Using Visual Basic and COM to Load the Data**
Use Visual Basic and the Siebel COM interface to retrieve the Siebel table row ID information by searching for the field that contains the text and return the ID field.
About Summary Records

Sales forces are frequently hierarchically organized, with a sales representative being the lowest level of the hierarchy, rising through various managerial levels. It is possible that someone at the top of the hierarchy needs to see all of the syndicated data in the system. This may be practical if the particular user is connected to the database. However, if the managerial levels are remote users, they will have visibility on a very large number of records; their synchronization times will be extremely long.

A solution to this problem is to store summary records in the S_SYND_DATA table. Summary records are totals of the sales data for territory, region, division, and other groupings, stored with a type flag in an extension column that indicates the level of summarization is being stored. The summary records can be created by SQL scripts or with a database package such as Microsoft Access. They can be loaded using the two methods described in the previous topics.

In addition to loading summary records, you also must configure the table using Siebel Tools, to make sure that a manager-level user sees only summary records, rather than detail records, on the sales data views. Using this technique, you can also implement drill-down functionality for connected managers so that they can start at top level data and work down.

Extracting Data for Mobile Users

Once the data is in the database, it needs to be made visible to the users. The data is visible by position and can be viewed on many chart and analysis views in Siebel Life Sciences. This is fine for connected users, but the typical user of such data will be the sales rep or sales manager of a particular territory, who are likely to be remote users, synchronizing with the database using Siebel Remote. Therefore, the data needs to be extracted from the database.

The application administrator extracts syndicated data according to data-routing (visibility) rules that the administrator defines. When you do this, a full export-process audit trail is generated through log files.

**NOTE:** Insurance plan data (S_INS_PLAN table) might not be extracted for a specific mobile if syndicated data (S_SYND_DATA table) is loaded to the server at the same time a database extract component is running for the mobile client. In addition, if there is no account associated to the insurance plan data, then insurance data for a specific mobile can not be extracted. The data extraction rule, (dock object MedicalInsPlan, rule ≠ 3) controls how insurance plan data is routed. If an account is associated to an insurance plan record and mobile has visibility over that account, the insurance plan data is successfully extracted.

You can run multiple instances of the extraction process on each Siebel Server to maximize hardware capacity. The resulting output files are written in a compressed form and then zipped again to minimize file transfer time.

The general steps for data extraction are:

1. Create a data extraction rule.
2. Associate the necessary nodes of mobile users with the rule.
3. Define the portion of the data you want to extract and specify whether any deletions should be performed on the extracted data.
4 Set the environment by running the siebenv.bat file at the command prompt under the Siebel Server bin directory.

5 Run the Syndexp.exe executable file to perform the extraction. These general steps are detailed in the following procedures.

**To create a data extraction rule**

1 Navigate to the Administration-Syndicated Data screen > Export Rules view.

2 Click to select the Rules list and create a new record.

3 Complete the fields described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name for the rule.</td>
</tr>
<tr>
<td>Outfile Id</td>
<td>Enter a unique, three-character ID. This ID will be used as the name of a temporary data file created by the extraction process.</td>
</tr>
<tr>
<td>Active</td>
<td>If the rule is not active, it will not be processed by the extraction process.</td>
</tr>
</tbody>
</table>

You can create multiple rules for different types of extractions. For example, you could create one rule for Rx data and another rule for Outlet Level data. You can also extract data by multiple criteria (for example, sales force or position).

The WHERE part of a SQL SELECT statement specifies the rows of the S_SYND_DATA table that should be exported. In most cases, this WHERE clause is

```
WHERE T.POSITION_ID = [Position Id]
```

When you specify the users to extract, it will match their position ID to the position ID on the syndicated data table and extract only the data that is visible to them.

**To associate nodes with an extract rule**

1 In the Syndicated Data Export Rules view, select the correct extract rule.

   If a different view is currently displayed, navigate to Data Administration > Export Rules and select the appropriate rule.
In the Nodes list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>You can select multiple nodes in the Add Nodes dialog box.</td>
</tr>
<tr>
<td>Group Code</td>
<td>A code used for the grouping of nodes within the same extraction rule. You can specify the Group Cd value as an argument for the extraction process that is run with the Syndexp.exe executable file. With this group code, multiple Syndexp.exe processes can be run for the same extraction rule on the same Siebel Server.</td>
</tr>
<tr>
<td>Node Type Code</td>
<td>An attribute column for the nodes, used to identify the remote nodes. (The Syndexp.exe process services only remote nodes.)</td>
</tr>
<tr>
<td>Active</td>
<td>Only nodes specified as active will be processed.</td>
</tr>
</tbody>
</table>

**To specify the data that is routed to mobile users**

1. In the Syndicated Data Export Rules view, select the correct extract rule.
   
   If a different view is currently displayed, navigate to Data Administration > Export Rules and select the appropriate rule.

2. Click in the Tables list and create a new record.
3 Complete the fields. The fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Generally, this value should be S_SYND_DATA. The exception to this general rule is if you have created an extension table or if you are using another table to store syndicated data.</td>
</tr>
</tbody>
</table>
| Where String   | Enter a string that defines the data to be extracted. Generally, these strings use standard SQL WHERE statements to build the extraction scripts. In addition to using static column values and column names to specify the data to be extracted, you can use two case-sensitive variables, [Position Id] and [Employee Id]. An example WHERE string definition that uses the Position Id variable is provided below. This example extracts data where the position ID in the syndicated data is equal to the position ID of the user. Example: 

```
WHERE T.POSITION_ID = [Position Id]
```

A second example, provided below, extracts data for all positions assigned to an employee. Note that <TableOwner> in the example should be replaced with the appropriate Siebel database TableOwner value. Example: 

```
WHERE EXISTS (SELECT 1 FROM <TableOwner>.S_PARTY_PER R WHERE R.PARTY_ID = T.POSITION_ID AND R.PERSON_ID = [Employee Id])
```
| Sequence       | Enter a numeric value that defines the order in which tables will be extracted.                                                          |
| Active         | Only tables specified as active will be processed.                                                                                     |

4 In the Administration - Syndicated Data screen, from the Show drop-down list, select SQL Statements.

5 Click in the Pre SQL Statements list and create a new record.
6 Complete the fields described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>SQL Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Text</td>
<td>This SQL statement cleans up the data in the remote database in preparation for importing newer data, by deleting the existing data that will be replaced by newer data. If the entire syndicated data table is to be extracted, use the DELETE FROM table function. If only a subset of the data is to be extracted (for example, the latest month’s data), use a where clause to specify the data subset. <strong>NOTE:</strong> Each SQL statement must be prefixed with the table owner SIEBEL. If you do not include the table owner, the syndicated data import process fails.</td>
<td></td>
</tr>
<tr>
<td>Comments</td>
<td>Optional description of statement’s purpose; for example, describe the portion of the data you want to extract.</td>
<td></td>
</tr>
<tr>
<td>Sequence</td>
<td>Enter a numeric value that defines the order in which SQL statements will be executed.</td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td>Only statements specified as active will be processed.</td>
<td></td>
</tr>
</tbody>
</table>

You can refresh the entire syndicated data table, or you can refresh only certain specified data periods.

**NOTE:** Do not use the TRUNCATE function. Use the DELETE FROM function instead.

**To set the environment**

1 In a DOS window, navigate to the `siebel_server\BIN` directory.
2 Run the siebenv.bat file.

**CAUTION:** If you do not run siebenv.bat, you may encounter the following error message: “Unable to start common api. Error in DATAExpStartApis function.”
3 Set the environment variables.

**NOTE:** Syndexp.exe will not detect nodes in a clustered environment successfully unless you manually set CLUSTER_NETWORK_NAME in either siebenv.bat or syndexp.bat.

Refer to the command line arguments listed in Table 25 for multiple variables that are specific to the user environment. For more information on administering data extracts, see *Siebel Remote and Replication Manager Administration Guide*.

**NOTE:** Arguments that contain path names or spaces should be enclosed in double quotes (" ").

### Table 25. Command Line Arguments for Environment Variables

<table>
<thead>
<tr>
<th>Argument and Meaning</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>/A</td>
<td>Create Attachment</td>
</tr>
<tr>
<td>/C</td>
<td>ODBC Data Source</td>
</tr>
<tr>
<td>/D</td>
<td>Siebel Table Owner</td>
</tr>
<tr>
<td>/E</td>
<td>Extract Rule Name</td>
</tr>
<tr>
<td>/F</td>
<td>File Server Directory</td>
</tr>
<tr>
<td>/G</td>
<td>Group Code</td>
</tr>
<tr>
<td>/L</td>
<td>Log File</td>
</tr>
<tr>
<td>/N</td>
<td>Repository Name</td>
</tr>
<tr>
<td>/P</td>
<td>Password</td>
</tr>
<tr>
<td>/Q</td>
<td>Log Frequency</td>
</tr>
<tr>
<td>/R</td>
<td>Read Consistency</td>
</tr>
<tr>
<td>/S</td>
<td>Use Sequence Number</td>
</tr>
<tr>
<td>/T</td>
<td>Data File Type</td>
</tr>
<tr>
<td>/U</td>
<td>Username</td>
</tr>
<tr>
<td>/V</td>
<td>AppServer name</td>
</tr>
<tr>
<td>/X</td>
<td>Appserver Home Directory</td>
</tr>
</tbody>
</table>
To perform the data extraction

1. In the `siebel_server\BIN` directory, run the Syndexp.exe executable file.

   Use the command line arguments listed in Table 25 on page 277 to define multiple variables that are specific to the user environment. For example:

   ```
   syndexp /U sadmin /P sadmin /D phdemo /E "Rule One" /C siebsrvr_siebel
   ```

   **NOTE:** Interruption of the extraction process at any point causes the system to fail and necessitates restarting the data extraction from the beginning.

2. If an interruption occurs, you must go into the Pharma Node Attachment Administration view (navigate to the Syndicated Data Files view) and delete the previously generated data files. You also must go into each node and delete the latest file that was created in the previous run.

   After the program executes the Syndicated Data Loading (SDL) process, it displays the name of the user whose data is being extracted. This process continues until it has completed the extraction process for each user defined in the Syndicated Data Export Rules.

3. After you successfully complete the extraction process, you may want to create a batch file for use with subsequent extractions.

   The extracted files are output in a compressed form to minimize file transfer time. Files are transferred using Siebel Remote, which is described in *Siebel Remote and Replication Manager Administration Guide*. After mobile users receive their extracted files, they must import the data into their local databases.

Full and Partial Data Extracts

Because syndicated data loading does not use EIM to maintain synchronization between the server and the remote databases, you must force a resynchronization step at the end of each direct load. Force resynchronization either by re-extracting an entirely new remote database for each mobile user or by performing a partial extract that includes only the refreshed syndicated data. A new, full database extract creates a database snapshot file for a given mobile user. A partial extract contains only S_SYND_DATA table data.

Some users receive syndicated data updates once a week, while some may receive syndicated data updates monthly or quarterly. Therefore, partial extract is preferred.

Possible Data Loss

Sometimes remote users connect to Siebel Server using unstable dial-up connections that prevent the data file from being transferred correctly, so that the data file does not reach the remote server. Siebel Server does not verify that the data file reached its destination successfully. At the end of the transfer step, Siebel Server removes the data file from the server.

In the case in which a data file is lost and removed from the server, you must extract a new data file for users.

**CAUTION:** The loss of data or files may occur without warning. You might not be able to automatically determine the success or failure of a particular transfer. As a result, sales representatives may be using incorrect data for up to several months without realizing it.
Troubleshooting Syndicated Data Loading

If the Siebel application client session freezes or terminates during a syndicated data file import, do the following procedure.

To fix a session freeze or termination
1. In a DOS window, navigate to the \siebel_server\FS folder.
2. Copy S_NODE_ATTxxx.SAF (containing S_NODE_ATTxxxx.dat) to \CLIENT\LOCAL\FILES.
3. Navigate to the \CLIENT\LOCAL\FILES folder.
4. Delete S_NODE_ATTxxxx.dat.
5. Restart the Life Sciences client.
6. Click Import.

Views Requiring Syndicated Data Import

This topic lists the Siebel Life Sciences views and business components that require data import and indicates which data values must be loaded into the syndicated data table.

Table 26 lists the views that require data import.

Table 26. Views and Business Components Requiring Data Import

<table>
<thead>
<tr>
<th>Screen</th>
<th>View</th>
<th>Business Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>Charts &gt; Sales</td>
<td>Pharma Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Charts &gt; Profitability</td>
<td>Pharma Consumption</td>
</tr>
</tbody>
</table>
Table 26. Views and Business Components Requiring Data Import

<table>
<thead>
<tr>
<th>Screen</th>
<th>View</th>
<th>Business Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis</td>
<td>Direct Sales Trend by Territory - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Direct Sales Trend by Account - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Territory - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Territory - Share</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Zip - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Zip - Share</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Brick - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Brick - Share</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Account - Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales Trend by Account - Share</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Territory - Volume</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Territory - Share</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Prescriber - Volume</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Prescriber - Share</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Plan and Territory - Volume</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Plan and Territory - Share</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Plan and Prescriber - Volume</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Plan and Prescriber - Share</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Payment Type and Prescriber</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Payment Type and Territory</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Rx Trend by Brick</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales by Brick-Share</td>
<td>Pharma GA Markets</td>
</tr>
<tr>
<td></td>
<td>Indirect Sales by Brick-Volume</td>
<td>Pharma GA Sales Consumption</td>
</tr>
<tr>
<td>Contacts</td>
<td>Rx Trend &gt; Rx Trend by Product</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>PreCall &gt; Rx Trend</td>
<td>Contact BC</td>
</tr>
<tr>
<td></td>
<td>PreCall &gt; Rx Trend and Formulary</td>
<td>Pharma GA Rx Consumption</td>
</tr>
<tr>
<td></td>
<td>PreCall &gt; Rx Trend by Plan</td>
<td>Pharma GA Rx Consumption</td>
</tr>
</tbody>
</table>
Data Loading Matrix for Syndicated Data

The Data Loading Matrix, shown in Table 27, and the Attribute by Data Source Matrix, shown in Table 28 on page 283, are provided to facilitate loading sales, Rx, profitability, and influence data. Table 27 indicates, by view, the combination of data source, mandatory ID, and plan type values a record must have to be displayed in the view. The following list explains the table headings:

- **View.** Name of the Analysis, Contacts, Accounts, or Products view.
- **Data Source.** Value that determines which view will display the data stored in the record. The valid values are SlsDirAct, SlsDirBrk, SlsDirTer, SlsDirZip, SlsIndAct, SlsIndBrk, SlsIndTer, SlsIndZip, RSPT, RXBrk, RXEVM, RXSMI, RSXMM, RXPrf, RXTer, RXXPT, RXZip, Anlsys ROI, and Anlsys EvsR.
- **Mandatory Id.** Value that indicates the ID field that must be non-NULL for a database record to be displayed in the corresponding view. There are four key ID fields: Account Id, Contact Id, Territory Id, and Zip Id. For each view listed in the table, one of these ID fields is required and the other three must be NULL.
- **Plan Type.** Value that indicates the type of plan ID a database record must have to be displayed in the view.

### Table 27. Data Loading Matrix

<table>
<thead>
<tr>
<th>View</th>
<th>Data Source</th>
<th>Mandatory ID</th>
<th>Plan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts &gt; Charts &gt; Sales</td>
<td>SlsIndAct</td>
<td>Account Id</td>
<td>Total</td>
</tr>
<tr>
<td>Accounts &gt; Charts &gt; Profitability</td>
<td>Anlsys ROI</td>
<td>Account Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Direct Sales Trend &gt; by Territory - Volume</td>
<td>SlsDirTer</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Direct Sales Trend &gt; by Account - Volume</td>
<td>SlsDirAct</td>
<td>Account Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Territory - Volume</td>
<td>SlsIndTer</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
</tbody>
</table>
Table 27. Data Loading Matrix

<table>
<thead>
<tr>
<th>View</th>
<th>Data Source</th>
<th>Mandatory ID</th>
<th>Plan Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Territory - Share</td>
<td>SlsIndTer</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Zip - Volume</td>
<td>SlsIndZip</td>
<td>Zip Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Zip - Share</td>
<td>SlsIndZip</td>
<td>Zip Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Brick - Volume</td>
<td>S1sIndBrk</td>
<td>Area Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Brick - Share</td>
<td>S1sIndBrk</td>
<td>Area Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Account - Volume</td>
<td>SlsIndAct</td>
<td>Account Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Indirect Sales Trend &gt; by Account - Share</td>
<td>SlsIndAct</td>
<td>Account Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Territory - Volume</td>
<td>RXTer</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Territory - Share</td>
<td>RXTer</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Prescriber - Volume</td>
<td>RXPrf</td>
<td>Contact Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Prescriber - Share</td>
<td>RXPrf</td>
<td>Contact Id</td>
<td>Total</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Plan and Territory - Volume</td>
<td>RXTer</td>
<td>Territory Id</td>
<td>Plan</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Plan and Territory - Share</td>
<td>RXTer</td>
<td>Territory Id</td>
<td>Plan</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Plan and Prescriber - Volume</td>
<td>RXPrf</td>
<td>Contact Id</td>
<td>Plan</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Payment Type and Prescriber</td>
<td>RXPrf</td>
<td>Contact Id</td>
<td>Payer</td>
</tr>
<tr>
<td>Analysis &gt; Rx Trend &gt; by Payment Type and Territory</td>
<td>RXTer</td>
<td>Territory Id</td>
<td>Payer</td>
</tr>
<tr>
<td>Contacts &gt; Rx Trend &gt; Rx Trend by Product*</td>
<td>RXPrf</td>
<td>Contact Id</td>
<td>Total</td>
</tr>
<tr>
<td>Contacts &gt; Profitability</td>
<td>Anlsys ROI</td>
<td>Contact Id</td>
<td>Total</td>
</tr>
<tr>
<td>Contacts &gt; Sample Influence</td>
<td>Anlsys EvsR</td>
<td>Contact Id</td>
<td>Total</td>
</tr>
<tr>
<td>Products &gt; Product Profitability &gt; Sample ROI*</td>
<td>Anlsys ROI</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
<tr>
<td>Products &gt; Sample Influence</td>
<td>Anlsys EvsR</td>
<td>Territory Id</td>
<td>Total</td>
</tr>
</tbody>
</table>

* Fourth level menu
Table 28 indicates, by data source, the data values that should be loaded into the syndicated data table (S_SYND_DATA) attribute fields.

Table 28.  S_SYND_DATA Attribute by Data Source

<table>
<thead>
<tr>
<th>Data Source</th>
<th>Attribute 1</th>
<th>Attribute 2</th>
<th>Attribute 3</th>
<th>Attribute 4</th>
<th>Attribute 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anlsys EvsR</td>
<td>TRx</td>
<td>Number of Calls</td>
<td>Number of Samples</td>
<td>Number of Details</td>
<td></td>
</tr>
<tr>
<td>Anlsys ROI</td>
<td>Revenue</td>
<td>Samples Cost</td>
<td>Promotion Cost</td>
<td>Call Expenses</td>
<td>Other Expenses</td>
</tr>
<tr>
<td>RSPT</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXBrk</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXEVM</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXPrf</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXSMI</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXSMM</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXTer</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXXPT</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>RXZip</td>
<td>Product NRx</td>
<td>Product TRx</td>
<td>Market NRx</td>
<td>Market TRx</td>
<td>None</td>
</tr>
<tr>
<td>SlsDirAct</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>SlsDirBrk</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>SlsDirTer</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>SlsDirZip</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>SlsIndAct</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>Market Sales $</td>
<td>Market Sales Units</td>
<td>None</td>
</tr>
<tr>
<td>SlsIndBrk</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>Market Sales</td>
<td>Market Sales Units</td>
<td>None</td>
</tr>
<tr>
<td>SlsIndTer</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>Market Sales $</td>
<td>Market Sales Units</td>
<td>None</td>
</tr>
<tr>
<td>SlsIndZip</td>
<td>Product Sales $</td>
<td>Product Sales Units</td>
<td>Market Sales $</td>
<td>Market Sales Units</td>
<td>None</td>
</tr>
</tbody>
</table>
Importing Syndicated Data Files (End User)

Extracted files are transferred using Siebel Remote (as described in Siebel Remote and Replication Manager Administration Guide). After mobile users receive their extracted files, they must import the data into their local databases.

The process is described in the following procedure.

To import syndicated data files

1. Using Siebel Remote, synchronize your local database with extracted data files that have been routed to you. Extracted data files are received as attachment files.

2. Click the Import button and the extracted data files are downloaded to the \LOCAL\FILES folder of your hard drive.

3. After importing the extracted data files into your local database, delete the downloaded files from the \LOCAL\FILES folder.

**NOTE:** Users may postpone downloading of extracted data files by turning off the Retrieved Published Files option in their synchronization setup. Whether or not the extracted data files are downloaded, header information is transferred to the mobile client during the synchronization session. This information appears in the Syndicated Data Files view.

For further information, see Siebel Remote and Replication Manager Administration Guide.
This chapter covers the following topics:

- "About Setting Up and Carrying Out a Clinical Trial” on page 285
- “Scenario for Clinical Trials” on page 286
- "Process of Managing Clinical Trials” on page 287
- “Creating a Clinical Program” on page 288
- “Setting Up a Protocol” on page 289
- "Tracking and Revising Team Assignment History” on page 291
- “Creating and Revising Protocol Versions” on page 292
- “Setting Up Regions” on page 293
- "Defining a Subject Visit Template” on page 295
- “Creating an Account and Contacts (End User)” on page 298
- “Creating a Site (End User)” on page 300
- “Creating a Subject and Setting Up Visits and Visit Activities (End User)” on page 303
- “Applying Protocol Amendments (End User)” on page 307
- "About Subject Enrollment Information Roll-Up” on page 310
- “Monitoring Subject Status and Enrollment Rates (End User)” on page 311

**About Setting Up and Carrying Out a Clinical Trial**

This chapter describes the main steps involved in carrying out a clinical trial using Siebel Clinical. Following the procedures given in this chapter you will be able to:

- Create a clinical program and clinical protocols
- Set up document tracking at the protocol, region, and site levels, and for accounts and contacts
- Set up and revise subject visit templates for a protocol
- Enter data on accounts, sites, and contacts
- Screen and enroll subjects
- View charts showing subject status and enrollment rates
- Review payments made to the protocol
Figure 10 illustrates the important hierarchical relationship of programs, protocols, regions, and sites. In this example, the Bristol General Hospital in the USA region is participating in the AMXN 98447 protocol, which is being carried out as part of the Anemia program.

Scenario for Clinical Trials

This scenario is an example process performed by the director of clinical trials, clinical study manager, and the clinical research associates (CRAs). Your company may follow a different process according to its business requirements.

In this scenario, the clinical director and the study manager, working for a clinical research organization, or pharmaceutical, biotech, or medical device company, have administrator responsibilities in Siebel Clinical to:

- Set up a new treatment study program.
- Create one or more protocols designed to assess the safety and efficacy of certain compounds in the treatment of the disease.
- Set up the geographic regions where the protocols are to be carried out.
- Compile a list of documents that are critical to the study and implement tracking at the protocol, region, and site levels, and for accounts and contacts.
- Create a subject visit template to facilitate consistent application of the protocol across sites and subjects. This template is used to set up subject visit schedules and activities according to the guidelines laid out in the protocol.

When the program, protocol, and subject visit templates have been set up, the CRAs who are the end users of the Siebel Clinical product do the following:

- Enter data about the:
  - Sites where the protocols are carried out.
  - Members to be assigned to the teams at the site, region, and protocol levels.
Setting Up and Carrying Out a Clinical Trial

Process of Managing Clinical Trials

This topic details sample tasks often performed by administrators and end-users when managing clinical trials. Your company may follow a different process according to its business requirements.

In the following examples, tasks are carried out in the order presented. For example, a protocol must exist before its subject visit template can be created.

Administrator Procedures

The following list shows tasks administrators typically perform to manage a clinical trial. These tasks are typically performed in the following order:

3. “Tracking and Revising Team Assignment History” on page 291
5. (Optional) “Setting Up Regions” on page 293.

End-User Procedures

The following list shows tasks end users typically perform when managing a clinical trial. The procedures are performed by the CRA at the site level and are typically performed in the following order:

1. (Optional) “Creating an Account and Contacts (End User)” on page 298.
Creating a Clinical Program

The clinical program is the highest-level initiative in Siebel Clinical. Protocols, regions, sites, and subjects must be associated with a program.

Multiple regulatory applications can be associated with a program.

**To create a new clinical program**

1. Navigate to the Clinical Programs screen > Program List view.
2. In the Clinical Programs list, create a new record, and complete the necessary fields.

   **NOTE:** Before you can create an application, the associated product must be correctly defined. For more information about defining products, see Chapter 6, “Managing Products for Life Sciences.”

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>A multi-value field containing details of the application.</td>
</tr>
<tr>
<td></td>
<td><strong>Filed.</strong> Whether the application has been filed with the specified regulatory agency.</td>
</tr>
<tr>
<td></td>
<td><strong>Indication.</strong> The clinical indication for the application.</td>
</tr>
<tr>
<td></td>
<td><strong>Number.</strong> The number assigned to the application when submitted to the regulatory agency, for example the (A)NDA or IND number.</td>
</tr>
<tr>
<td></td>
<td><strong>Product.</strong> This field must be completed before a protocol can be created for the program.</td>
</tr>
<tr>
<td></td>
<td><strong>Sub-Type.</strong> Who filed the application. For example, a company or an investigator.</td>
</tr>
<tr>
<td></td>
<td><strong>Type.</strong> The type of application, such as CTN, IND, or CTX.</td>
</tr>
<tr>
<td>Mechanism</td>
<td>Partners associated with the clinical program.</td>
</tr>
<tr>
<td>Program</td>
<td>The name of the clinical program.</td>
</tr>
</tbody>
</table>

3. (Optional) Drill down on the new record and associate files with the clinical program.
Setting Up a Protocol

Multiple protocols can be associated with a program. When you have created a protocol record, you may also add extra information about the protocol, such as financial information, central lab information, and so on.

To create a protocol record

1. Navigate to the Administration - Clinical screen > Protocol List view.
2. In the Protocols list, create a new record, and complete the necessary fields. (To access more fields, drill down on the name field of the protocol and select the More Info tab view.)

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td># Planned Sites</td>
<td>Number of sites planned for the protocol.</td>
</tr>
<tr>
<td># Planned Subjects</td>
<td>Number of subjects planned for the protocol.</td>
</tr>
<tr>
<td>Central Lab</td>
<td>The name of the laboratory associated with the study. This is entered through the Accounts screen.</td>
</tr>
<tr>
<td>CRO</td>
<td>Name of the Clinical Research Organization that is sponsoring the trial.</td>
</tr>
<tr>
<td>Design</td>
<td>Information about the type of study.</td>
</tr>
<tr>
<td>Phase</td>
<td>Phase of clinical trial such as Phase II, or III.</td>
</tr>
<tr>
<td>Product</td>
<td>Only products that have been associated with the clinical program, through the Application field in the Clinical Programs view, can be selected from the Clinical Product and Indication dialog box. For more information about creating a clinical program, see &quot;To create a new clinical program&quot; on page 288.</td>
</tr>
<tr>
<td>Program</td>
<td>Name of the clinical trial program.</td>
</tr>
<tr>
<td>Protocol #</td>
<td>Identifying number assigned to the protocol.</td>
</tr>
<tr>
<td>Regions Required</td>
<td>Flag to indicate the sites for this protocol must belong to a region. For information on regions, see &quot;Setting Up Regions&quot; on page 293. When this flag is selected, you cannot create sites directly under protocols. You must create regions first and then create sites that are associated with regions.</td>
</tr>
<tr>
<td>Status</td>
<td>Protocol status such as planned, in progress, completed.</td>
</tr>
<tr>
<td>Team</td>
<td>Enter the names of those who need access to the protocol, the study manager and others who monitor the clinical trial.</td>
</tr>
<tr>
<td>Title</td>
<td>Descriptive title for the protocol.</td>
</tr>
<tr>
<td>Type</td>
<td>Purpose of the protocol.</td>
</tr>
</tbody>
</table>
### Field | Comments
--- | ---
Withholding Amount | The amount to be withheld from each of the payments to the investigators until the trial is complete. This may be overwritten at the Region and Site levels.
Withholding Percentage | The percentage to be withheld from each of the payments to the investigators until the trial is complete. This may be overwritten at the Region and Site levels.
Currency Code | The currency that is used to display the payments, costs, and budgets for the protocol. The default value is USD (United States dollars).
**NOTE:** It is important to specify the Currency Code for the protocol.
Exchange Date | The date that determines the exchange rate of the currency used. By default, the exchange date for the protocol is the date the protocol is created.

3 To add team members to the protocol, click the Select button in the Team field to open the Team dialog.
4 Select a name in the Team picklist, and click Add to move the member to the Selected pane.
5 Click Position Rolldown.
   Multiselected team members are added to the protocol as well as to all regions and sites belonging to the protocol.
6 Click OK.
   Each time a member is added to the team of a protocol, a tracking record is created in the Team History view with a proper start date for this Tracking record. For more information, see "Automatically Assign Team Members to a Protocol Using the Position Rolldown Button” on page 291. If a member is removed from the team of a protocol, the end date of this record will be automatically filled in. For more information, see “Remove Team Members from the Team of a Protocol” on page 292.
7 Click the Team History tab to view the details of the team member that was automatically added to the protocol in the previous step.
   From the Team History tab you can administer and track team members who have worked on the protocol. It also provides details about what the role was as well as the start and end dates. To administer and track the history of team members who have worked on a protocol and to determine what their role was, see "Tracking and Revising Team Assignment History” on page 291.
Tracking and Revising Team Assignment History

A typical clinical trial can span many months to years and often requires changes of study members. Clinical organizations are required by rules and regulation to keep records of study team assignments, and to promote tight access controls so that only those who are assigned roles and responsibilities for a trial have the proper access to trial data.

When a person is no longer part of the clinical trial team, all access rights to the trial data cease as well. When necessary, the study manager can also manually create a tracking record independent of the team assignment. Similar functionality applies to Region and Site team assignment. The Team History view allows you to administer and track who has worked on the protocol, region, or site. It also provides details about what the role was as well as the start and end dates.

**To manually create protocol assignment team history**

1. Navigate to the Administration - Clinical screen > Protocol List view.
2. In the Protocols list, drill down on the Protocol # of the protocol for which you want to create a new team assignment history.
3. In the Team History tab view, create a new record, and complete the necessary fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>Select the value that best describes each individual’s role.</td>
</tr>
<tr>
<td>Start Date</td>
<td>If a team member is added from the Team of a Protocol (either manually or by using the Position Rollup mechanism), the start date defaults to the system date, and the end date is blank.</td>
</tr>
<tr>
<td>End Date</td>
<td>If a team member is removed from the Team of a Protocol (either manually or through reverse of Position Rollup mechanism), the end date of the team member’s record is auto-populated with the system date. The system date overrides whatever date exists in the End Date field if the record is not set to read-only.</td>
</tr>
<tr>
<td>Lock Record</td>
<td>When checked, the record becomes read-only, and the End Date field becomes a required field.</td>
</tr>
</tbody>
</table>

Automatically Assign Team Members to a Protocol Using the Position Rolldown Button

When a team member is added to a protocol, click the Position Rolldown button to enable the member to be added to all regions and all sites under the Protocol. You can add a member to the team only once.
When you use the Position Rolldown button to add a member to the team of a Protocol, a record is created, where applicable, in each of the Team History views for all regions and all sites belonging to the Protocol. The Position Rolldown mechanism automates the addition of team members to the Site Team History and Region Team History views as if they had been assigned manually.

### Remove Team Members from the Team of a Protocol

When you remove a team member from the protocol, the team member is removed from either the Protocol, or from all protocols, regions and sites belonging to the protocol.

When a member is removed from the team of a Protocol (either manually or through Position Rollup or Position Rolldown), the End Date of the team member’s record, if present, is overridden with the system date. However, if the record is already read-only, the initial End Date is not updated. The Position Rolldown mechanism automates the update of the End Date of the assignment records as if they are manually removed from the Team of the sites and regions.

**NOTE:** The system prompts whether to remove the member from only the Protocol or from All (Protocol, Region, and Sites belonging to the Protocol).

### Creating and Revising Protocol Versions

Protocol versions can be tracked and managed using Siebel Clinical. The study manager can create a tracking record for the original protocol as well as for each subsequent version.

**To create a new protocol version**

1. Navigate to the Administration - Clinical screen > Protocol List view.
2. In the Protocols list, drill down on the Protocol # of the protocol for which you want to create a new protocol version.
3. In the Protocol Versions tab view, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original Version</td>
<td>If this is the first version of the protocol, check this field. If this field is checked, the Amendment Version field becomes read-only.</td>
</tr>
<tr>
<td>Amendment Version</td>
<td>The version number of the protocol version. For example, Version 1, Version 2, and so on.</td>
</tr>
<tr>
<td>Date</td>
<td>The date on which the new version was approved.</td>
</tr>
</tbody>
</table>
Setting Up Regions

Clinical trials are often global, taking place in multiple countries. It is useful to track and view study data by country and region. The region level in Siebel Clinical allows you to do this.

Regions are optional for protocols. However, if you choose to use regions, by flagging the Regions Required field in the protocol record, then each site associated with the protocol must belong to a region.

One of the advantages of using regions is that it provides another way of grouping sites and subjects. For example, you can chart subject enrollment by region in addition to by protocol and by site.

**NOTE:** You cannot create regions for a protocol unless the Regions Required flag has been selected for the protocol. See “Regions Required” on page 289.

**To create region records for a protocol**

1. Navigate to the Administration - Clinical screen > Region List view.
2. In the Regions list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Currency Code</td>
<td>The currency that is used to display the payments, costs, and budgets in the Regions screen. The default value is USD (United States dollars).</td>
</tr>
<tr>
<td>Exchange Date</td>
<td>The date that determines the exchange rate of the currency used. By default, the exchange date for the region is the date the region is created. This date may be changed in response to changes in currency rates. However, changes made to the exchange date at the region level take effect only when the exchange date also changes at the system level. For more information, see <strong>Siebel Applications Administration Guide</strong>.</td>
</tr>
<tr>
<td>No Site Info</td>
<td>Check this flag when there is no site information available under a region. Only summary information on enrollment is available for such a region. For more information, see “About Subject Enrollment Information Roll-Up” on page 310.</td>
</tr>
<tr>
<td>Protocol #</td>
<td>Only protocols where regions are required are listed in the Pick Protocol dialog box.</td>
</tr>
<tr>
<td># Planned Sites</td>
<td>Number of sites planned for the region.</td>
</tr>
<tr>
<td># Planned Subjects</td>
<td>Number of subjects planned for the region.</td>
</tr>
<tr>
<td>Protocol Region</td>
<td>A name for the region. This is automatically filled in with the protocol number and the region name.</td>
</tr>
<tr>
<td>Region</td>
<td>Geographic region to which the site belongs.</td>
</tr>
</tbody>
</table>
3 To add team members to the region, click the Select button in the Team field to open the Team dialog.

4 Select a name in the Team picklist, and click Add to move the member to the Selected pane.

5 Click Position Rolldown.

   Multiselected team members are automatically added to all the site teams of this region.

   **NOTE:** The Position Rolldown button for region applies only to the sites below a region.

6 Click Position Rollup.

   Multiselected team members are automatically added to the protocol to which the region belongs.

   To administer and track the history of team members who have worked on a protocol in a region and what their role was, see “Tracking and Revising Team Assignment History” on page 291.

7 Create a region record for each country or geographical area where there are or will be sites participating in the protocol.

8 (Optional) Drill down on the region field and add extra information using the More Info tab view.

   **NOTE:** It is important to specify the Currency Code for each region if multiple currencies will be used for the trial.

### Automatically Assign Team Members Using the Position Rolldown and Rolldown Buttons

When you use the Position Rolldown and Position Rollup button, a record is created, where applicable, in each of the Team History views for the Protocol and all Sites belonging to the Region. The Position Rolldown mechanism automates the addition of team members to the Site Team History and Protocol Team History views as if they had been assigned manually.

To remove a team member from the Protocol, see “Remove Team Members from the Team of a Protocol” on page 292.
Creating Region Assignment Team History

The Team History view allows you to administer and track who has worked in the region. It also provides details about what the role was as well as the start and end dates.

*To manually create region assignment team history*

1. Navigate to the Administration - Clinical screen > Region List view.
2. In the Region list, drill down on the Region for which you want to create a new team assignment history.
3. In the Team History tab view, create a new record, and complete the necessary fields.

Defining a Subject Visit Template

Subject visit templates allow you to set up a template schedule based on the protocol. The template is then used to generate screening, rescreening, and enrollment schedules for each subject, according to the subject’s screening, rescreening, and enrollment dates.

About Subject Visit Templates

Figure 11 and Figure 12 illustrate the relationship between the subject visit template and the visit schedule created for a given subject.
For example, if the subject visit template in Figure 11 is applied to a subject with a screen date of 11/20/2006, a rescreen date of 11/22/2006, and an enrollment date of 11/27/2006, the resulting visit schedule is displayed in Figure 12.

Figure 11. Visits List

Figure 12. Subject Form and Visits List in the Visit Plans View

The first screening visit takes place on the screen date because the lead time for this visit is 0. But this visit can be rescheduled to 11/21/2002 because the allowed variation for this visit is two days after the lead date (Max = 2 days). If you enter a date before the 11/20/2002 or after the 11/21/2002, an alert message appears, warning you that the entered date is outside the allowed range.

Similarly, the first enrollment visit takes place on 12/03/2001 because the lead time for this visit is 1 week after the enrollment date of 11/26/2001.

If the protocol is amended, you will need to create new versions of the subject visit template to reflect the modifications made to the protocol. See “Tracking and Revising Team Assignment History” on page 291.

Creating a Subject Visit Template
The following procedure describes how to create a subject visit template.
To create a subject visit template

1. Navigate to the Administration - Clinical screen > Visit Templates view.

2. In the Subject Visit Templates list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the new subject visit template.</td>
</tr>
<tr>
<td>Protocol #</td>
<td>Protocol to which this subject visit template is to be associated. Select from list of existing protocols in the Pick Protocol dialog box.</td>
</tr>
<tr>
<td>Title</td>
<td>Tied to the Protocol # field.</td>
</tr>
</tbody>
</table>

3. For the new subject visit template, in the Template Versions list, create a new template version record or select a version that you have created using the Versions view. For more information, see “Tracking and Revising Team Assignment History” on page 291.

4. For the new template version record, in the Visits list, create a visit record for each visit (screening, rescreening, and enrollment) that a subject is to make to the site. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>For Screening visits, this is the time from the screen date. For example, in Figure 11 on page 296 the Lead value for the screening visit is 0. For Rescreening visits, this is the time from the rescreen date. For Enrollment visits, this is the time from the enrollment date. The Lead value for an enrollment visit taking place 1 week after enrollment would be 1, assuming the Lead Unit is weeks.</td>
</tr>
<tr>
<td>Lead Units</td>
<td>Units for lead time.</td>
</tr>
<tr>
<td>Max</td>
<td>The time after the lead time that the visit may take place. For example, if Max=2 and Min/Max Units = days, the visit may take place up to two days after the scheduled visit. Do not leave this field blank.</td>
</tr>
<tr>
<td>Min</td>
<td>The time before the lead time that the visit may take place. For example, if Min=1 and Min/Max Units = days, the visit may take place one day before the scheduled date. Do not leave this field empty.</td>
</tr>
<tr>
<td>Min/Max Units</td>
<td>Units for the Min and Max values. Do not leave this field empty.</td>
</tr>
</tbody>
</table>
Setting Up and Carrying Out a Clinical Trial ■ Creating an Account and Contacts (End User)

For each visit record, in the Activities record, create a set of activity records to describe the procedures and tasks required for the visit. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the visit; for example, screening or baseline.</td>
</tr>
<tr>
<td>Sequence</td>
<td>Sequence number of the visits. Typically, the first visit that will be made has order number 1.</td>
</tr>
<tr>
<td>Visit Type</td>
<td>Screening, Rescreening, or Enrollment. If Screening is selected, the visit due date will be based on the screen date. If Rescreen is selected, the visit due date will be based on the rescreen date. If Enrollment is selected, the visit date will be based on the enrollment date.</td>
</tr>
<tr>
<td># CRF Pages</td>
<td>Number of CRF pages.</td>
</tr>
</tbody>
</table>

5 For each visit record, in the Activities record, create a set of activity records to describe the procedures and tasks required for the visit. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>Length of time the activity is estimated to take.</td>
</tr>
<tr>
<td>Payment Amount</td>
<td>The standard amount that the investigator is to be paid for this activity. This amount may be adjusted on a per site or per individual basis.</td>
</tr>
<tr>
<td>Payment Flag</td>
<td>This flag is selected by default. It indicates that the investigator is to be paid for this activity.</td>
</tr>
</tbody>
</table>

For more information about payments, see Chapter 20, “Setting Up and Making Subject Activity Payments.”

Creating an Account and Contacts (End User)

An account is the institution from which clinical trials are managed. Typically, it is the facility where the investigators conduct the trials. More than one site can be associated with an account and one account can carry out multiple protocols. IRBs (institutional review boards), central labs, CROs (clinical research organizations), and other subcontractors may also be tracked as accounts.

Contacts is the term used for personnel working at clinical sites. This includes the investigators, typically medical professionals who are also researchers and site coordinators, who may be the practicing nurses administering the treatment plan according to the clinical protocol.

Bulk loading of data on accounts and contacts is generally performed by the Siebel administrator, but end users may create and modify these records as needed. (See Chapter 17, “Importing Data into Life Sciences.”)
To create an account

1. Navigate to the Accounts screen > Accounts List view.
2. In the Accounts list, create a new record, and complete the necessary fields. (To access more fields, click the more info button in the account form.)

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Type</td>
<td>Hospital, Clinic, IRB, and so on.</td>
</tr>
<tr>
<td>Address Line 1</td>
<td>Allows you to add addresses for the account by picking from existing addresses or by entering new addresses. Avoid duplicating addresses by checking if the address exists before entering a new one.</td>
</tr>
<tr>
<td>Site</td>
<td>Description of the location or function of the account, such as “headquarters” or “corporate” or “San Francisco.”</td>
</tr>
<tr>
<td>Synonyms</td>
<td>Allows you to refer to accounts in the way that you prefer. For example, an account named A/B Products, Inc., might have the following synonyms: AB, A/B, and AB Products. When you search for an account or enter an account in another part of your Siebel application, you can use a synonym instead of the actual name.</td>
</tr>
<tr>
<td>Team</td>
<td>Multiple users can be assigned to the account team. The team member who creates the account record is indicated as primary team member.</td>
</tr>
</tbody>
</table>

3. Use the views tabs to access other views such as Account Team, Activities, Addresses, and so on to add more information to the account record.

For more information about creating and maintaining account affiliations, see Chapter 5, “Administering and Managing Accounts in Life Sciences.”

To create a contact record

1. Navigate to the Contacts screen > Contacts List view.
2. In the Contacts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Address</td>
<td>The contact can have more than one address. One address must be specified as primary. Each CRA assigned to the contact can specify a different address as primary. For example, one CRA might specify a private office as the primary address, while another CRA might specify a hospital department as the primary address.</td>
</tr>
<tr>
<td>Team</td>
<td>Multiple CRAs can be assigned to the contact. The team member who created the record is indicated as primary.</td>
</tr>
</tbody>
</table>
3 Add or associate additional information with the contact’s record, using the other views on the screen.

   For example, use the Relationships view to associate site coordinators and other site personnel with the contact.

   For more information about creating and maintaining contact records, see Chapter 4, “Managing Contacts in Life Sciences.”

### Creating a Site (End User)

The site is the group at an account, headed by a principal investigator, who carries out a particular protocol. In Siebel Clinical, a separate site record must exist for each unique combination protocol, account, and principal investigator.

**To create a site**

1 Navigate to the Site Management screen > Protocol Site List view.
2 In the Sites list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The institution where the protocol is to be carried out.</td>
</tr>
<tr>
<td>Currency Code</td>
<td>The currency that is used to display the payments, costs, and budgets for the site.</td>
</tr>
<tr>
<td>Exchange Date</td>
<td>The date that determines the exchange rate of the currency used. By default, the exchange date for the site is the date the site is created. This date may be changed in response to changes in currency rates. However, changes made to the exchange date at the site level take effect only when the exchange date also changes at the system level. For more information, see <em>Siebel Applications Administration Guide</em>.</td>
</tr>
<tr>
<td>No Subject Info</td>
<td>Check this flag when there is no subject information available for a site. Only summary information on subject enrollment is available for such a site.</td>
</tr>
<tr>
<td>PI Last Name</td>
<td>Last name of the principal investigator. If an account has already been specified for the site, use Affiliated Contacts in the Pick Contacts dialog box to view only those who are affiliated with the account.</td>
</tr>
<tr>
<td>Protocol #</td>
<td>Select from list of existing protocols in the Pick Protocol dialog box.</td>
</tr>
<tr>
<td>Region</td>
<td>If regions are required for this protocol, enter a region name.</td>
</tr>
</tbody>
</table>
3 To enter team members, click the Select button in the Team field, select a team member in the Team picklist and click OK.

If you multi-select Team members and click Position Rollup, then if the region required flag is checked, the team members are added to the region that the site belongs to and are added to the protocol to which the site belongs.

4 Click the Select button in the MVG Version field and do the following:

   a Enter the version for the subject visit template to be used at the site.

      The template versions are filtered to display only those related to your protocol.

   b Enter the IRB Approval Date for the selected version.

      The template version cannot be activated without the IRB approval date.

   c Click the Active field to make the selected version the active version at the site.

      Only one version can be active at a time. The active template is used when activities are generated for a subject.

      **NOTE:** The IRB Approval Date must be entered before the template can be activated.

      For more information about protocol versions, see “Tracking and Revising Team Assignment History” on page 291.

5 Create records for the principal investigator and other key site personnel.

For information, see “To associate contacts with a site” on page 319.
6 (Optional) Drill down on the Site # field, and add extra information using the More Info tab view.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Select one of the principal investigator’s addresses as the site address.</td>
</tr>
<tr>
<td>Contract Amount</td>
<td>Lists the sum of all contract amounts for the site. This field is read-only. For more information, see “Associating Contracts with a Site” on page 317.</td>
</tr>
<tr>
<td># Early Terminated</td>
<td>The number of subjects who have terminated the study before it has been completed.</td>
</tr>
<tr>
<td>Earned To Date</td>
<td>The amount of money earned to date by the investigators.</td>
</tr>
<tr>
<td>First Subject Enrolled</td>
<td>The date that the first subject was enrolled to the study. (This field is automatically rolled-up from the subject data.)</td>
</tr>
<tr>
<td>Last Subject Off Study</td>
<td>The date that the last of the subjects has completed the study. (This field is automatically rolled-up from the subject data.)</td>
</tr>
<tr>
<td>Paid To Date</td>
<td>The amount of money paid to date to the investigators.</td>
</tr>
<tr>
<td>#Screen Failure</td>
<td>Number of subjects that have failed the screening.</td>
</tr>
</tbody>
</table>

Automatically Assign Team Members to a Site Using the Position Rollup Button

When a member is added to the team for a Site (either manually or through the Position Rollup mechanism), a record is created in the Team History view, with the Start Date set to the system date by default, and with the End Date displayed as blank.

To remove a team member from the Protocol, see "Remove Team Members from the Team of a Protocol” on page 292.

Creating Site Assignment Team History

The Team History view allows you to administer and track who has worked on the site. It also provides details about what the role was as well as the start and end dates.

To manually create site assignment team history

1. Navigate to the Administration - Clinical screen > Site List view.
2. In the Site list, drill down on the Site for which you want to create a new team assignment history.
3. In the Team History tab view, create a new record, and complete the necessary fields.
Removing Team Members from the Team of a Site

When a member is removed from the team of a Site (either manually or through Position Rollup), the End Date of the team member’s record, if present, is updated with the system date. However, if the record is already read-only, the initial End Date is not updated. The Position Rollup mechanism automates the update of the End Date of the assignment record as if it was manually removed from the Team.

**NOTE:** The system prompts whether the member should be removed from only the Site or from ALL (Sites, Region and Protocol) Sites including both these particular sites as well as all other sites within this protocol that this user is a team member.

Creating a Subject and Setting Up Visits and Visit Activities (End User)

CRAs may enter information about clinical trial subjects. When the subject record has been created, the subject visit template active for the site can be applied to set up a schedule of visits and activities for the subject.

**Screening a Subject**

It is possible to enter and screen subjects for clinical trials using the Subjects view tab.

**To enter and screen a subject**

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the site for which you want to add subjects.
3. Click the Subjects view tab.
4. In the Subjects list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Id</td>
<td>This is the principal ID number for the subject. The value is entered when you click the Enroll button (Step 8 on page 308).</td>
</tr>
<tr>
<td>Informed Consent</td>
<td>An informed consent date must be entered before a subject can be enrolled in the protocol. See Step 4 on page 305.</td>
</tr>
<tr>
<td>Randomization Id</td>
<td>An ID number for the subject, which can be used in studies where both an enrollment ID and a randomization ID are required.</td>
</tr>
</tbody>
</table>
5 Click the hyperlink in the Screening # field of the subject.

The Visits view of the Subjects screen appears.

6 To generate screening visits and activities:
   a Click Screen in the Subject form.
   b Enter the screen date in the Screening dialog box.

   Screening visits and activities to take place in those visits appear in the Visits and Activities lists.

   **NOTE:** A subject can be screened only once for each visit template. After screening visits have been generated, clicking the Screen button again and changing the screen date reschedules the screening visits according to the new screen date. (If the subject visit template has been updated since the last time the screen button was clicked, new screening visits are generated.) See “Applying Protocol Amendments (End User)” on page 307.

7 (Optional) Edit subject visits dates.

   For example, you might want to edit some subject visit dates so that visits are not scheduled on weekends.

   If the rescheduled date falls outside the range specified by the subject visit template, the application displays a warning message, but **still reschedules the visit** according to the new date.

8 (Optional) Create or modify subject visits or activities.

### Rescreening a Subject

A subject who initially fails screening can be rescreened. The rescreen date must be greater than or equal to the screen date and rescreening cannot happen if the subject has not already been screened (that is, if the screen date is null).
To rescreen a subject

1. Navigate to the Subjects screen.
2. Select the subject who is eligible for the study. (The subject must have already been screened.)
3. Click Rescreen in the Subject form and enter a rescreen date.
   The rescreen visits and activities are automatically created in the subject’s schedule.
4. (Optional) Edit subject visits dates.
5. (Optional) Create or modify subject visits or activities.
6. (Optional) Rescreen multiple times.

   A subject can be rescreened more than once. Each time the Rescreen button is clicked and the rescreen date entered, a new set of the rescreening visits and activities is generated and appended to the existing ones. This applies even though the subject visit template has not been changed.

Enrolling a Subject

A subject who has successfully passed screening or rescreening is then enrolled in the study.

To enroll a subject

1. Navigate to the Subjects screen.
2. Drill down on the Screening # for the subject.
3. Click the Visits view tab.
4. Enter the informed consent date:
   a. Click the Select button in the Informed Consent Dates field to open the Informed Consent dialog box.
   b. Click New.
      The versions of the subject visit template appear in the drop-down list of the Add Informed Consent dialog box. Make sure to select the version before entering the informed consent date.
   c. Click Add.
   d. In the Informed Consent Dates dialog box, enter an informed consent date for the subject and close the Informed Consent Dates dialog box.
      
      NOTE: Enrollment activities cannot be generated without an informed consent date for the active version of the protocol.

5. Click the Enroll button in the Subject form.
6. Enter the enrollment date and the enrollment ID in the Enrollment dialog box.
   The enrollment date must be greater than or equal to the screen date.
7  (Optional) Edit subject visit dates.
   See Step 7 on page 304 for more information about editing visit dates.
8  (Optional) Create or modify subject visits or activities.

Creating an Unscheduled Subject Visit
On occasion, it may be necessary to create an unscheduled subject visit. This can be done in the Subjects screen, or in the Site Calendar.

To create a subject visit from the Subjects screen
1  Navigate to the Subjects screen > Subject List view.
2  In the Subjects list, drill down on the screening number of the subject for whom you want to add an unscheduled visit.
3  Click the Visits View tab.
4  In the Visits list, create a new record, and complete the necessary fields. The type of the visit is automatically populated as an Unscheduled Visit.

To create a subject visit from the Site Calendar
1  Navigate to the Site Management screen > Protocol Site List view.
2  In the Sites list, drill down on the site for which you want to add subject visits.
3  Click the Calendar view tab.
4  Click New Subject Visit to create a new record, and complete the necessary fields.
   The Calendar details view is displayed.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigned To</td>
<td>Person to whom the subject visit is assigned.</td>
</tr>
<tr>
<td>Completed</td>
<td>Indicates whether or not the visit has taken place.</td>
</tr>
<tr>
<td>Completed Date</td>
<td>Indicates the date on which the visit took place.</td>
</tr>
<tr>
<td>Due</td>
<td>Date on which the subject visit is due.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Lock Assignment field should be selected. If the activity is locked, Assignment Manager will not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
</tbody>
</table>
Terminating a Subject’s Trial Early
On occasion, it may be necessary to terminate a subject’s participation in a trial before completion of the trial. This may be because the subject no longer wished to take part in the trial or because the subject failed a screening.

To terminate a subject’s trial early
1. Navigate to the Subjects screen > Subject List view.
2. In the Subjects list, Drill down on the Screening # of the subject whose trial you wish to terminate.
3. Click the Select button in the MVG Status field.
4. In the Subject Status dialog box, click the Status field and do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicate that the trial was terminated early</td>
<td>Early Terminated</td>
</tr>
<tr>
<td>Indicate that the subject failed the screening</td>
<td>Screen Failure</td>
</tr>
</tbody>
</table>

When either of these two events occur, all remaining visits for the subject are deleted.

Applying Protocol Amendments (End User)
When a protocol is revised mid-study, you need to apply the protocol amendments and update:
- The subject visit template version associated with the site.
- The visit schedules of any subjects who are still in the study.

To apply a new version of a subject visit template to a site
1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, select the site for which you want to apply a new version of the visit template.
3. Enter the new version of the subject visit template in the Version field.
   Make sure that the new version is active by entering the IRB Approval Date for the version and checking the Active flag.
   For instructions on editing the MVG Version field, see Step 4 on page 301.

To apply a new version of the subject visit template for an enrolled subject
1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # for which you want to update subject visits.
3 Click the Subjects view tab.

4 Click Apply Active Version.

   This creates new records for the new version of the template in the Informed Consent Dates field for all subjects in this site except for those whose status is “Early Terminated” or “Completed.”

5 Navigate to the Subjects screen and drill down on Screening # of the enrolled subject whose schedule you want to update for the revised subject visit template.

6 Click the Visits view tab.

7 Enter the informed consent date for the newer version as described in Step 4 on page 305.

8 In the Subjects form, click Enroll and click OK in the Enrollment dialog box.

   A dialog box is displayed asking you if you would like to delete non-applicable visits. Non-applicable visits are those visits generated from the old template version that are scheduled to take place after the new Informed Consent Date and those visits generated by the new template version that have due dates prior to the new Informed Consent Date.

9 Do one of the following:
   ■ Click OK. If you click OK, the non-applicable visits are deleted.
   ■ Click Cancel. If you click cancel, the new visits for the new protocol version are appended to the existing Visits list. No visits are deleted. Typically, if you select this option, you may return at a later stage to the Visits list and delete:
     ■ Future-scheduled visits from the original subject visit template version.
     ■ Past-scheduled visits from the new subject visit template version.

   See “Rules for Applying Protocol Amendments” on page 308 for more information.

**NOTE:** Screening and rescreening schedules are revised in the same way, except that informed consent dates are not necessary for these types of visit.

### Rules for Applying Protocol Amendments

If you choose Cancel in response to the delete uncompleted visits from the old version and completed visits from the new version dialog, the application creates a new set of visits, and adds them on top of the visits already created from prior versions.

If you choose OK, the application creates a new set of visits, compares the two sets of visits, and deletes the non-applicable visits when the following conditions are satisfied:

1 The application uses the Subject's Informed Consent date for the new version as a cut-off date for transitioning from the old version to the newer version.

2 Equivalent Visits are those that have the same Visit Name.

3 For an old visit (created from the old template version) that has the Completed date filled in:
a If the Completed date is < Informed Consent date, then the old completed visit is left intact, and the corresponding visit from the more recent amended version is deleted. In other words, visits under the old version that are completed before an amendment takes effect are preserved, and the equivalent visits from the new version are deleted.

b If the Completed date is > or = Informed Consent date, then the following rules apply:

- If the Due date of the corresponding new visit is < Informed Consent date, the old completed visit is left intact. In other words, visits that are scheduled under the old version to complete before an amendment takes place but are actually completed later are also preserved. The equivalent visits from the new version are deleted.

- If the Due date of the corresponding new visit is > or = Informed Consent date, the visits from the old version are deleted, but the completed dates are copied to the equivalent visits from the new version. In addition, all children activities of the completed visits are set to Completed and have the same completed date of the parent visit. This rule applies in situations where the Subject has already switched to the new version before the application is setup in time to cater for such a scenario. In such a case, the visit records generated under the old version are marked Complete instead of the visits from the new version.

4 For an old visit that does not have the Completed date filled in:

- If the Due date is > or = Informed Consent date, the visit generated form the old version is deleted. In other words, future visits generated from the old version that have not yet been completed are deleted, and their equivalent visits from the new version are preserved.

- If the Due date is < Informed Consent date, the visit from the old version is left intact. In other words, visits under the old version that have not been completed (those are presumably the visits that a Subject has missed in the past) are preserved, and the equivalent visit from the new version is deleted.

5 For a new visit generated under the new template version:

- If the Due date is < Informed Consent date, the new visit is deleted.

- If the Due date is > or = Informed Consent date, the new visit is left intact, although it could still be deleted based on other rules specified above.

Rules for Deleting Visits Deemed Non-applicable by Early Termination

In addition to automatically deleting non-applicable visits per protocol amendments, the application applies the following automation rules to delete visits deemed non-applicable by early termination.

1 Delete non-applicable visits after a subject terminates the study.

When the Status of a Subject is changed to Early Terminated and the Early Terminated date is filled in, all the remaining visits are deleted. The remaining visits are identified as visits with Due date > Early Terminated date.
About Subject Enrollment Information Roll-Up

One of the key capabilities of Siebel Clinical is supporting clinical organizations to better manage their trials in real-time enrollment status tracking. This is implemented through rolling-up subject information from Site to Region and then to protocol or directly from Site to Protocol. However, it is often the case that this data is not available to the clinical organization, which presents significant business challenges. For example, if trials are outsourced to CROs it is not always possible for the clinical organization to receive subject level information. The enhanced subject roll-up functionality allows accurate subject enrollment data to be available at Region and Protocol level, even when subject level information is not available for each site, or when site level information is not available for each region.

Trials, for which subject-level information is available for each site, display the following roll-up characteristics:

- Subject enrollment information is automatically rolled-up from Subject to Site, from Subject to Region, and from Subject to Protocol.
- When a subject is the first subject to enroll to a Site, Region, or Protocol, the First Subject Enrolled Date for that Site, Region, or Protocol, is automatically populated.
- When a subject is the last subject to complete or drop off the trial for the Site, Region, or Protocol, the Last Off Study Date for that Site, Region or Protocol is automatically populated.

Trials, for which subject-level information is not available for a site, display the following characteristics:

- Sites that do not have subject-level information available may be check-marked as having No Subject Info.
- The following information may be entered by CRAs for sites that do not have subject or site level information:
  - # Subjects Screened
  - # Subjects Re-screened
  - # Subjects Screen Failure
  - # Subjects Enrolled
  - # Subjects Completed
  - # Subjects Early Terminated
  - First Subject Enrolled Date
  - Last Subject Off Study Date

2. Delete non-applicable visits after a Subject fails screening.
   When the Status of a Subject is changed to Screen Failure and the Screen Failure date is filled in), all future visits are deleted. Future visits are defined as visits with Due date > Screen Failure date.
Monitoring Subject Status and Enrollment Rates (End User)

You can view charts of:

- Subjects by status
- Enrollment rates

These charts can be displayed by protocol, region, or site. Charts can be displayed in a variety of formats.
To create graphical charts
1  Navigate to the Protocols, Regions, or Site Management screen.
2  In the list, select the record for which you want to create the charts.
3  On the link bar, click the Charts view tab.
4  To display a subjects-by-status chart:
   a  From the Show drop-down menu, select Subject Accruals.
   b  From the second drop-down menu, select Subject Status Analysis.
5  To display an enrollment rate chart:
   a  From the Show drop-down menu, select Subject Enrollment.
   b  From the second drop-down menu, select Subject Enrollment Analysis.
This chapter covers the following topics:

- "About Managing Sites and Clinical Contacts" on page 313
- "Scenario for Managing Sites and Clinical Contacts" on page 314
- "Process of Managing Site and Contact Information" on page 315
- "Creating a Clinical Protocol Site Template" on page 316
- "Creating Contact and Account Assessment Templates" on page 316
- "Maintaining Contact and Account Information" on page 317
- "Associating Contracts with a Site" on page 317
- "Creating and Managing Site Visits" on page 318
- "Creating and Updating Site, Contact, and Account Records (End User)" on page 319
- "Capturing Different Types of Addresses for Each Site (End User)" on page 320
- "Assigning Employees to the Site Team (End User)" on page 320
- "Creating Site Activity Plans (End User)" on page 321
- "Applying Protocol Site Activity Templates" on page 322
- "Tracking and Adding Documents at Sites (End User)" on page 323
- "Creating Documentation Tracking Activities" on page 324
- "Creating CRF Tracking Activities" on page 325
- "Creating Site Correspondence Activities" on page 327
- "Adding Notes to a Site" on page 329
- "Assessing Investigators and Hospitals or Other Contacts and Accounts (End User)" on page 329

About Managing Sites and Clinical Contacts

This chapter describes the tasks that the administrator and end users perform to update and maintain information about:

- Clinical trial sites
- Contacts (investigators and other site personnel)
- Accounts (hospitals and clinics where the trials are carried out)
- Employees on the site team
Siebel Adverse Events and Complaints Management’ feature set allows you to record the relationships among these six entities.

This chapter also describes setting up and using:

- Site activity plans
- Account and contact assessments

Scenario for Managing Sites and Clinical Contacts

This scenario provides an example of a process performed by the administrator and the clinical research associates (CRAs). Your company may follow a different process according to its business requirements.

In preparation for the clinical trial, the administrator sets up templates to generate site activity plans for site initiation and to track documents. The administrator also creates templates that the CRA uses towards the end of the trial to assess contacts and accounts associated with the trial. Contact and account information may need to be updated by the administrator before the CRA can begin work on the site. Another important task that the administrator may have to carry out is to associate contracts with a site. Often, multiple contracts may need to be associated with individual sites.

When the CRAs begin work on a new clinical trial, they must set up a number of site visits that will dictate whether the site can be used to carry out the trial. After this, they add new information and update existing information about accounts, contacts, and sites, and about the affiliations and associations among them. Maintaining accurate data is critical to successful clinical trials.

When a new contact is entered, the CRAs request that the administrator enter the contact’s primary specialty. Data cannot be entered into this field from the CRAs’ views. After this, the CRAs must appoint a team of employees that is to be assigned to that site. This allows the study manager to keep track of the members of each site team.

CRAs need to plan how the protocol will be carried out at the site. This is done by creating a site activity plan, which determines how the trial is conducted. The CRAs use the clinical protocol site template that has been created by the administrator. CRAs may also track any number of extra documents that are associated with a site. This may include regulatory or clinical trial documentation.

From time to time, CRAs enter account or contact records incorrectly or they discover that some account or contact records have become obsolete. The CRA then puts in a request to the administrator to have those accounts and contacts deleted. CRAs do not have the permissions needed to delete these records.
Before the clinical trial ends, the administrator or the study manager creates a contact assessment template that each CRA can use to evaluate the performance of the investigators at the conclusion of the trial.

**CAUTION:** In some countries, it is not permitted to evaluate the performance of site personnel. Please obtain legal advice before using the contact assessment feature in Siebel Clinical.

### Process of Managing Site and Contact Information

This topic details sample tasks often performed by administrators and end-users when managing site and contact information. Your company may follow a different process according to its business requirements.

**NOTE:** The administrative tasks described in this topic must be performed before the related end-user task can be performed. For example, a clinical protocol site template must exist before the corresponding site activity plan can be created.

#### Administrator Procedures

The following list shows tasks administrators typically perform to manage site and contact information:

- "Creating a Clinical Protocol Site Template” on page 316. An administrator creates templates that detail the activities that must be performed at all sites that are carrying out the same protocol.
- "Creating Contact and Account Assessment Templates” on page 316. The administrator or the study manager creates assessment templates that define weighted attributes for assessing a contact or account.
- "Maintaining Contact and Account Information” on page 317. An administrator maintains records of contact license numbers and deletes erroneous or obsolete account and contact data.
- "Associating Contracts with a Site” on page 317. The administrator or a study manager enters details about the contracts for a site and the payment details for each contract.

#### End-User Procedures

The following list shows tasks end users typically perform when managing site and contact information:

- "Creating and Managing Site Visits” on page 318. CRAs create site visits to evaluation, initiate, monitor, and close-out sites.
- "Creating and Updating Site, Contact, and Account Records (End User)” on page 319. CRAs record details about contacts, accounts, and sites.
- "Assigning Employees to the Site Team (End User)” on page 320. Managers or CRAs add employees to the team associated with the site.
- "Creating Site Activity Plans (End User)” on page 321. CRAs use the clinical protocol site template that has been created by an administrator to plan a list of activities for each site.
“Tracking and Adding Documents at Sites (End User)” on page 323. CRAs and regional study managers post clinical trial and regulatory documentation for review at site, region, and protocol levels.

“Creating Documentation Tracking Activities” on page 324. Documents can be attached and tracked at the protocol, region, and site levels, or for accounts or contacts.

“Assessing Investigators and Hospitals or Other Contacts and Accounts (End User)” on page 329. CRAs score contacts and accounts, based on the attributes defined in an assessment template.

Creating a Clinical Protocol Site Template

Activities can be associated directly with sites. For example, all sites carrying out the same protocol need to perform similar site initiation activities and submit similar documents to the regulatory agencies. When many activities are common to multiple sites, the clinical protocol site template helps CRAs create site activities.

The clinical site protocol template is one of a number of activity templates used in Siebel Clinical. Others are subject visit templates (“Defining a Subject Visit Template” on page 295), trip report templates (“Creating a Trip Report Template” on page 341), contact and account assessment templates (“Creating Contact and Account Assessment Templates” on page 316).

When an activity template is of type, Clinical Protocol Site, and is not associated with a Protocol Title, the template can be applied to all sites in the Clinical Protocol Site Activity Plan View (Site Management > Activity Plans).

If an activity plan of type, Clinical Protocol Site, is associated with a Protocol Title, the activity plan can be applied only to sites under this Protocol.

NOTE: Unlike trip report templates, clinical protocol site templates are protocol-specific. To use a clinical site template in association with more than one protocol, either duplicate the record, and then edit the Protocol Title field, or remove the Protocol Title to make the Template available to all Sites.

To create a clinical protocol site template
- Create an activity template of type Clinical Protocol Site.
  - Make sure that Protocol Title field is completed and correct.
  - For information about how to create activity templates, see Siebel Applications Administration Guide.

Creating Contact and Account Assessment Templates

The purpose of the assessment is to determine a single total score or a percentage that can be used to rank a contact or account.
To create an assessment template

- Follow the procedure for creating an assessment template in the *Siebel Applications Administration Guide*. For contact assessment templates, make sure to set the template type to Contact. For account assessment templates, make sure to set the template type to Account.

Maintaining Contact and Account Information

The end users are responsible for much of the day-to-day maintenance of their account and contact data. However, there are a few tasks for which the administrator is responsible. These are:

- Entering data into the primary specialty field for contacts. See "Setting Up Primary Specialties" on page 48.

  **NOTE:** If the specialty type you need is not available, enter it by following the procedure, "To define a specialty" on page 49.

- Deleting contact and account records that were created in error or are obsolete. See "To delete a contact" on page 50 and "To delete an account" on page 65.

Associating Contracts with a Site

Contracts that define the total payments that are to be made to a site can be associated with each site. Some sites may only need one contract that will govern the entire payment for the site. However, depending on the site in question, it may be necessary to associate multiple contracts with the site. There may also be multiple payees associated with each contract. It is possible to associate multiple contracts and multiple payees with a site through the Contracts view tab in the Site Management screen.

**To associate a clinical contract with a site**

1. Navigate to the Site Management screen > Protocol Site List view.
2. Drill down on the Site # of the site with which you wish to associate a contract.
3. In the Contracts view tab, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Number</td>
<td>The number assigned to this contract. This field is automatically populated.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of contract that is to be associated with the site.</td>
</tr>
</tbody>
</table>
Managing Sites and Clinical Contacts ▶ Creating and Managing Site Visits

CRAs typically need to carry out five types of visits to a site as follows:

- **Site evaluation.** A site visit to evaluate a site’s qualification for a study
- **Site initiation.** A site visit to initiate a site
- **Site monitoring.** A site visit to monitor study progress and to monitor and retrieve case report forms (CRFs)
- **Site close-out.** A site visit to close-out or terminate a site at the conclusion of a study
- **Unscheduled.** (Optional) An unexpected site visit that a CRA may wish to carry out

CRAs need to create these visits for each site for which they are responsible. When a CRA creates a site visit, it appears in the CRA’s calendar, the site investigator’s calendar, and the study manager’s calendar. This means that the study manager can keep track of all site visits for all CRAs. It also acts as a useful reminder for investigators of when site visits are to be made.

Site visits are created using the Site Management > Protocol Site List view. From this view, it is possible for CRAs to view all their site visits and all follow-up activities that arise from the visits. It is also possible to view all site visits in the system and follow-up activities associated with these visits. Study managers can also filter site visits to see what visits are assigned to their teams and view follow-up activities in order to assess what the most pressing issues are.

Depending on the type of site visit you choose, the drill down views vary. If the site visit type is Site Initiation or Site Evaluation, then the drill down view does not contain the CRF Tracking tab. If the site visit type is Site Monitoring or Site close-out, the drill down view contains the CRF Tracking tab.

For more information, see “Defining a Subject Visit Template” on page 295.

**To create a site visit**

1. Navigate to the Site Management screen > Protocol Site List view.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contract Amount</td>
<td>The amount of money that this contract is worth. If multiple contracts are entered, then the total value of all Contract Amounts is equal to the total contract amount for the site. This total can be seen in the Contract Amount field on the site form.</td>
</tr>
<tr>
<td>Payee Last Name</td>
<td>The name of the person to whom the payments for this contract are to be made. This is a multi-value field and multiple payees for the contract may be entered using the multi-value picklist.</td>
</tr>
<tr>
<td>Address</td>
<td>The address associated with the payee.</td>
</tr>
</tbody>
</table>
In the Sites list, drill down on the Site # for the site with which you want to create a visit and click the Site Visits tab.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trip Report Completed</td>
<td>The date on which the trip report for this visit has been completed.</td>
</tr>
<tr>
<td>Trip Report Status</td>
<td>The status of the trip report. For more information on Trip Reports, see</td>
</tr>
<tr>
<td></td>
<td>Chapter 21, &quot;Administering and Using Clinical Trip Reports&quot;.</td>
</tr>
<tr>
<td>Visit Name</td>
<td>A descriptive name for the visit.</td>
</tr>
<tr>
<td>Visit Start</td>
<td>The date on which the visit is due to take place. When you drill down on</td>
</tr>
<tr>
<td></td>
<td>this field, you are brought to the trip report for the visit.</td>
</tr>
<tr>
<td>Visit Status</td>
<td>Not Stated, In Progress, Completed, Submitted, Approved, and Rejected.</td>
</tr>
<tr>
<td></td>
<td>A state model is preconfigured to allow for structured state transition.</td>
</tr>
</tbody>
</table>

**Monitoring Site Visits Using the Calendar**

All CRA visits to a site can also be monitored from the Calendar tab. The calendar can be used to view visits on a daily, weekly, or monthly basis.

**Creating and Updating Site, Contact, and Account Records (End User)**

It is important to maintain accurate information in the Siebel Clinical database. End users need to keep data about their sites, accounts, and investigators up to date. To do this, they create new records, modify existing records, and request that their administrator delete obsolete records. In addition, they create and maintain the relationships (affiliations) among their contacts, accounts, and sites.

For more information, see the following topics:
- "To create an account" on page 299
- "To create a contact record" on page 299
- "To create a site" on page 300
- "To indicate an affiliation between contacts" on page 55
- "To indicate an affiliation between an account and a contact" on page 71
- "To indicate an affiliation between accounts" on page 72

**To associate contacts with a site**

1. Navigate to the Site Management screen > Protocol Site List view.
In the Sites list, drill down on the Site # for the site with which you want to associate contacts.

Click the Contacts view tab.

In the Contacts list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

### Capturing Different Types of Addresses for Each Site (End User)

Users can add a specific type of addresses for each site.

**To add an address type for a site**

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Protocol Site list, drill down on the Site # of the protocol site for which you want to add an address type.
3. In the Addresses tab view, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the address.</td>
</tr>
<tr>
<td>Address Type</td>
<td>Select an address type from the list of values to associate with the site.</td>
</tr>
<tr>
<td>Address Line 1</td>
<td>Select the appropriate site location from the MVG.</td>
</tr>
</tbody>
</table>

### Assigning Employees to the Site Team (End User)

CRAs assign employees to the site team. The team members can be rolled up and made visible at the region and protocol levels.

**NOTE:** If the CRA is working from a mobile Web client, the administrator must set up position rollup on the Web client. For more information, see “Setting Up Mobile Web Clients for Position Rollup” on page 44.

Before an employee can be added to the site team, an administrator must set up the employee record. For more information, see *Siebel Security Guide*. 
Managing Sites and Clinical Contacts

Creating Site Activity Plans (End User)

A site activity plan is a list of activities and documents associated with the site. Although activities can be created without a template, using a clinical protocol site template as described here makes creating site activity plans more efficient.

For information on creating templates, see “To create a clinical protocol site template” on page 316.

To assign activities to a site using a template

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site to which you want to assign activities.
3. Click the Activity Plans view tab.
4. In the Activity Plans list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Start</td>
<td>Make sure that this date is correct before you choose a template. The due dates for the template-generated activities are based on this start date and on the lead time set in the template.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Lock Assignment field should be selected. If the activity is locked, Assignment Manager will not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
<tr>
<td>Template</td>
<td>Only templates whose type is Clinical Protocol Site and whose protocol matches the protocol at the site are displayed. Only activities with type Document or Site Initiation are shown in the document tracking views.</td>
</tr>
</tbody>
</table>
5  Edit the activities in the Activities list or create more activities.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Date</td>
<td>This field is tied to the Status field. When a date is entered in this field, the status field is automatically set to Done.</td>
</tr>
<tr>
<td>Expected Date</td>
<td>For document tracking: The date that the signed document is expected to come back from the site.</td>
</tr>
<tr>
<td>Received Date</td>
<td>For document tracking: The date that the signed document returns from the site.</td>
</tr>
<tr>
<td>Sent Date</td>
<td>For document tracking: The date that the document is sent to the site.</td>
</tr>
<tr>
<td>Status</td>
<td>This field is tied to the Completed Date field. When this field is set to Done, the Completed Date field is automatically set to the current date.</td>
</tr>
<tr>
<td>Displayed In</td>
<td>A check mark in this field indicates that the activity does not appear on the user’s calendar.</td>
</tr>
</tbody>
</table>

**NOTE:** To view additional fields in this list, click the menu button and select Columns Displayed.

### Applying Protocol Site Activity Templates

You can simultaneously apply one or multiple site-activity templates across one or multiple sites for a study. Activity records of type, document and site initiation, are displayed in the Site Management > Document Tracking view. Correspondence activity types are displayed in the Site Management > Activities view.

The templates applied through this action are also displayed in the Site Management > Activity Plans view for each of the sites selected.

**To simultaneously apply one or multiple activity templates to multiple sites in a region**

1. Navigate to the Regions screen > Region List view.
2. In the Regions list, drill down on the Region for which you want to apply an activity template.
3. In the Sites tab view, select the sites for which you want to apply an activity template.
4. Click Apply Template and from the Templates dialog, select one or multiple activity templates that you want to apply to the selected site.
5. Click OK.
To simultaneously apply one or multiple activity templates to multiple sites in a protocol

2. In the Protocols list, drill down on the Protocol for which you want to apply an activity template.
3. In the Sites tab view, select the sites for which you want to apply an activity template.
4. Click Apply Template and from the Templates dialog, select one or multiple activity templates that you want to apply to the selected site.
5. Click OK.

Tracking and Adding Documents at Sites (End User)

During the life of a clinical trial, CRAs need to collect and track numerous documents, including critical regulatory documents. CRAs can take advantage of the activity plans to generate a list of documents for tracking. In the document tracking views, they can also create their own lists of activities to track important dates.

**NOTE:** Regional study managers can use similar procedures to add and track documents at the Region level in the Regions screen.

To track documentation milestones

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site for which you want to track documentation.
3. Click the Document Tracking view tab.
   A list of documents associated with the clinical trial appear.
4. Query for the document of interest and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>By default, the activity is Document.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>The person to whom responsibility for the document has been assigned.</td>
</tr>
<tr>
<td>Expected Date</td>
<td>The date that the signed document is expected to come back from the site.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>The date the document expires.</td>
</tr>
<tr>
<td>Lock Assignment</td>
<td>Determine whether the Lock Assignment field should be selected. If the activity is locked, Assignment Manager will not access it. If it is unlocked, Assignment Manager can reassign it.</td>
</tr>
</tbody>
</table>
To add a document to a site
1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site for which you want to track documentation.
3. Click the Document Tracking view tab.
   A list of documents associated with the clinical trial appears.
4. Create a new record and complete the necessary fields.
5. Step off the record you have just added and drill down on the Name hyperlink.
   The Attachment view appears.
6. Create a new record and in the Name field specify the file name or URL.
7. Check the Auto Update flag if you want to have the file automatically updated during synchronization.
   This applies only to local files. If a file is not local, it cannot be updated during synchronization.

Creating Documentation Tracking Activities

Numerous documents are collected during clinical trials, either as electronic files or as paper. These documents must be tracked and periodically updated. Documents can be associated with sites, regions, protocols, contacts, or accounts.

To create documentation tracking activities
2 In the Document Tracking list, create a new record, and complete the necessary fields.

**NOTE:** A document tracking activity can be associated with only one of the available tracking levels or entities.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The document name. This is a hyperlink to the associated Attachment view.</td>
</tr>
<tr>
<td>Site, Region, Protocol, Contact, or Account</td>
<td>Delegate the document to one of these fields. The field you select determines how the hyperlink in the Name field operates. This field is a hyperlink to the associated Activities view.</td>
</tr>
</tbody>
</table>

To review, update, and add existing documentation for tracking

2. In the Document Tracking list, query for the document you want to update.
3. Click the document name hyperlink.
   - The associated Attachment view appears.
4. In the Attachment list, query for the document and click the document name.
5. Open, update, and save the document.
6. Use the thread bar to return to the document record on the Document Tracking list.
7. Copy the original document record and revise the associated site, region, protocol, contact, or account field.

Alternatively, documentation tracking activities can be created and reviewed in the Document Tracking view tab for a site. Similarly, document tracking activities at the protocol and region levels can be created and reviewed in the Document Tracking view tab for the protocol and region.

Creating CRF Tracking Activities

Numerous case report forms (CRFs) are collected during clinical trials, either as electronic files or as paper. These forms must be tracked and periodically updated. CRFs can be associated with sites, regions, protocols, contacts, or accounts.

CRF Tracking records are created when you apply a subject visit template in addition to subject visit records. You can also create a CRF Tracking Activity from the Protocol Site CRF Tracking View.

To view CRF tracking activities

Tracking Case Report Forms (CRFs)

Users can create and track CRFs as part of a protocol, site and region. Relevant information, such as whether the CRFs are source verified, retrieved from a site, in-house, or by a data management process, is captured for each CRF record within a protocol, site and region.

When you apply a subject visit template, in addition to creating subject visit records and the children activities records as existed in the current product, a duplicate set of visit records with Type = Case Report Form are created (with # Pages as specified in the template).

These visit records with # CRF pages are listed in the Site Management > Protocol Site List > CRF Tracking view. You can also create records for CRF tracking in this view.

To monitor and retrieve case report forms
1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Protocol Site list, drill down on the Site # of the protocol site for which you want to track CRFs.

To review, update, and add existing CRFs for tracking
2. In the CRF Tracking list, query for the document you want to update.
3. Open, update, and save the CRF.
4. Use the thread bar to return to the CRF record on the CRF Tracking list.
5. Copy the original CRF record, and revise the associated site, region, protocol, contact, or account field.

Alternatively, you can create and review CRF tracking activities from the CRF Tracking view tab for a site. Similarly, at the protocol and region levels, you can also create and review CRF tracking activities from the CRF Tracking view tab.

Managing Sites and Clinical Contacts ■ Tracking Case Report Forms (CRFs)

2. Click CRF Tracking and in the CRF Tracking list you can view all tracking records in the system.

**NOTE:** A CRF tracking activity can be associated with only one of the available tracking levels or entities.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The CRF name. This is a hyperlink to the associated Attachment view.</td>
</tr>
<tr>
<td>Site, Region, Protocol, Contact, or Account</td>
<td>Delegate the CRF to one of these fields. The field you select determines how the hyperlink in the Name field operates. This field is a hyperlink to the associated Activities view.</td>
</tr>
</tbody>
</table>
3 In the CRF Tracking tab view, click New to create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Lists the activities associated with the site.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Defaults to CRF activity type. Only activity records with CRF activity type are displayed in this view.</td>
</tr>
<tr>
<td># CRF Pages</td>
<td>Number of pages contained in the CRF.</td>
</tr>
<tr>
<td>Retrieved</td>
<td>Checked if the CRA was retrieved by Data Management.</td>
</tr>
<tr>
<td>Retrieved Date</td>
<td>Date when the CRF was retrieved.</td>
</tr>
<tr>
<td>Received in House</td>
<td>Date when the CRA retrieved the CRF in house.</td>
</tr>
<tr>
<td>Received by Data Management</td>
<td>Date when the CRA retrieved the CRF by data management.</td>
</tr>
<tr>
<td>Source Verified</td>
<td>Indicates whether the CRF is a verified source document.</td>
</tr>
<tr>
<td>Source Verified Date</td>
<td>The date when the CRF was source verified.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter a relevant comment about the CRF.</td>
</tr>
</tbody>
</table>

**Creating Site Correspondence Activities**

You can track all correspondence (phone, fax, email, and letters delivered by the postal service) between a site and a study team member as site correspondence activities. You can create such activities for multiple sites. This feature provides an easy way of capturing all forms of communication between a site and an employee, or between business partners, such as a clinical research organization, or central lab.

For each correspondence activity created, an activity record is created in Contact > Activities view for each of the contacts.

**To create a correspondence activity for a site**

1. Navigate to the Site Management screen > Protocol Site List view.

2. In the Protocol Site list, drill down on the Site # of the protocol site for which you want to create a correspondence activity.
3  In the Activities tab view, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Defaults to Correspondence activity for the site.</td>
</tr>
<tr>
<td>Activity Type</td>
<td>Select from one of the following activity types:</td>
</tr>
<tr>
<td></td>
<td>▪ Case Report Form</td>
</tr>
<tr>
<td></td>
<td>▪ Email</td>
</tr>
<tr>
<td></td>
<td>▪ Fax</td>
</tr>
<tr>
<td></td>
<td>▪ Mail</td>
</tr>
<tr>
<td></td>
<td>▪ Phone</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a brief description for the correspondence activity.</td>
</tr>
<tr>
<td>Screen #</td>
<td>The number of screens for the correspondence.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter a relevant comment about the correspondence activity.</td>
</tr>
<tr>
<td>Last Name</td>
<td>Enter the Last name of the creator of the Correspondence activity. This is a required filed.</td>
</tr>
</tbody>
</table>

**To create a new role correspondence for a site**

1  Navigate to the Protocol screen > Protocol List view.
2  In the Protocols list, drill down on the Protocol # of the protocol for which you want to create a new role.
3  In the Sites tab view, select one or multiple sites for which you want to apply a new role for the correspondence.
4  Click New Correspondence and from the Roles of Contacts dialog box, select the role or multiselect the roles that best describe the individual’s role, and click OK.

**Tracking Business Partner Correspondence**

You can track all correspondence (phone, fax, email, and letters delivered by the postal service) between business partners, such as a CRO, or Central Lab.

**To create a correspondence activity between business partners**

1  Navigate to the Site Management screen > Protocol Site List view.
2  In the Protocol Site list, drill down on the Protocol # of the protocol site for which you want to create a business partner correspondence activity.
3  In the Activities tab view, create a new record, and complete the necessary fields.
Adding Notes to a Site

When you are working with site records, you often find that you need to make notes. In the Notes view, you can enter public notes or private notes. Use the link bar in the Notes view to switch between public and private notes. A public note can be seen by anyone who has access to the record. A private note can be seen only by the person who enters the note.

To add private and public notes to a site

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Protocol Site list, drill down on the Site # of the protocol site for which you want to add notes.
3. Click the Notes view, and select Private Notes or Public Notes.
4. Click New, and complete the fields for the new record.
   - The Created By Name and the Created Date fields are automatically completed with the creator's User ID and system date.
5. In the Type field, select the note type.
   - Examples of note types are Exclusion, Pre-existing Condition, Permanent, System, Temporary, Business Description, Regional Plans, and Contracts Process.
6. In the Description field, enter the note text.
7. Use the Check Spelling button to make sure your note has no spelling errors.

Assessing Investigators and Hospitals or Other Contacts and Accounts (End User)

Assessments allow end users to calculate a single numerical value that expresses the fitness of a contact or account, according to a set of attributes defined in the assessment template. For example, an investigator may be assessed to determine competence to carry out a large scale phase III clinical trial or a hospital may be assessed to determine suitability to carry out a similar trial. The results of this assessment help CRAs find suitable investigators and hospitals for subsequent trials.

NOTE: The application automatically updates the score values in the Assessment Attributes list and the (total) score value in the Assessments list.

For information on creating templates, see “To create an assessment template” on page 317.

To assess a contact or account

1. Do one of the following, depending on whether you want to assess a contact or account:
   - Navigate to the Contacts screen > Contacts List view. In the Contacts list, drill down on the contact whom you want to assess.
Navigate to the Accounts screen > Accounts List view. In the Accounts list, drill down on the account that you want to assess.

2. Click the Assessments view tab.

3. In the Assessments list, create a new record.

4. In the Template Name field, select the assessment template that has been prepared for you. (For more information, see "Creating Contact and Account Assessment Templates" on page 316.)

   The application fills in other fields in the record when the record is saved.

5. In the Assessment Attributes list, for each attribute:
   a. Enter a Value by selecting from the Pick Attribute Value dialog box.
   b. Add or edit comments in the Comment field of the attribute.
About Setting Up and Making Subject Activity Payments

Payments to investigators and sites are set and adjusted at three levels:

- Standard payment amounts are set by the financial administrator through the subject visit template.
- Exceptions to standard payment amounts are set according to agreements negotiated by individual sites.
- Payments can be further adjusted on a one-off only basis before the payment is generated.

Not all subject activities have payment amounts associated with them. For example, obtaining informed consent may be a subject activity for which the site is not paid, but a site would be paid for performing a blood test. Subject activities for which the site can be paid are referred to as payment subject activities. (In the Siebel Clinical interface, these activities are indicated by the Payment Flag.)

In addition to subject activities, sites can be paid on other activities created at the site level, such as IRB fees and equipment costs. Those activities can be flagged as payable to the site with the Payment Flag.

**NOTE:** For information about managing budgets at the protocol level, see Chapter 22, “Managing Clinical Projects.”

You can use multiple currencies for a protocol. Currencies and exchange rate dates are set at three levels:
Setting Up and Making Subject Activity Payments

Scenario for Payments

This scenario is an example process performed by the financial administrator for your company. Your company may follow a different process according to its business requirements.

Based on the input from the clinical contract or grant negotiations group, the financial administrator sets up the standard payment amounts for procedures and tasks that the site performs. A major pain-point for clinical organizations is managing investigator payments. Often investigators are paid for activities that they have not carried out, or for activities that they have carried out but that are not to the satisfaction of the sponsor. By specifying a withholding amount and a withholding percentage, it is possible to withhold payments from an investigator to make sure that all activities are carried out. This will guarantee that investigators are motivated to carry out all activities so that they get paid in full.

The CRAs set up the payment exceptions for sites where different payments have been negotiated for subject activities. (In some organizations, this task is done by study manager instead of the CRA.)

As the sites carry out the procedures, the financial administrator verifies successful completion of the procedures and tasks and generates payments for these activities. A payment (minus the withholding amount or percentage) is generated when an activity is completed. If all activities for a site are completed, then the investigator will be paid the full amount for all activities including the amount or percentage withheld.

Occasionally, the sponsor or CRO (clinical research organization) needs to make an additional payment to a site, a payment which is not directly associated with subject activities. These are ad hoc payments, for example, reimbursement for an unscheduled visit.

**NOTE:** As the clinical trial progresses, the sites carry out the subject activities for which they are paid. Typically, site personnel at the sites enter completed dates for subject activities using the Site Portal application. For more information about Siebel Site Portal, see Siebel Life Sciences Portals Guide.
Process of Setting Up and Making Payments

This topic details sample tasks often performed by administrators and end-users when setting up and managing subject activity payments, performed by study managers and CRAs. Your company may follow a different process according to its business requirements. The tasks are generally carried out in the order presented, although ad hoc payments can be made any time.

Administrator Procedures

2. "Adjusting Payment Amounts and Generating Payments for Sites" on page 336. This task is generally performed after the End-User Procedures have been carried out.

End-User Procedures

The following list shows tasks end users typically perform when managing subject activity payments. These tasks are typically performed in the following order:

1. "Setting Payment Exceptions for a Site (End User)" on page 334. Adjust payment amounts for individual sites.
2. "Marking Subject Activities Completed (End User)" on page 335.
3. (Optional) "Generating Ad Hoc Payments for Sites (End User)" on page 335.
4. "Generating Final Payments for Sites (End User)" on page 337.

Setting Up Standard Payment Amounts in the Subject Visit Template

Payment amounts can be set up when the subject visit template is created (as described in "Defining a Subject Visit Template" on page 295) or may be added later following the procedure described here.

Payments at the site level may be entered in any currency. All payment amounts made at the site level are converted to the currency designated for the site and rolled up into the currency that is designated for the region. If a region is not required, payment amounts at the site level are rolled up into the currency that is designated for the protocol.

To set up standard payment amounts for subject activities

1. Navigate to the Administration - Clinical screen > Visit Templates view.
2. Select the Subject Visit Template and Template Version for which you want to add payment amounts.
3. For each visit and each activity that the sites will be paid for:
Setting Payment Exceptions for a Site (End User)

The amount paid to individual sites for a particular procedure may differ from the standard amount set in the subject visit template ("Setting Up Standard Payment Amounts in the Subject Visit Template" on page 333), or the currency used at the site might differ from the currency used for the standard amount.

The procedure below explains how to use payment exceptions to change the standard amount paid for a payment subject activity for an individual site.

Once the payment exception has been set for an activity associated with the given site, visit, and template version, each time the activity is generated for a subject the activity will show the site-specific amount.

NOTE: When a new subject visit template becomes active, payment exceptions need to be set for the new template.

To set site-specific payment amounts for subject visit activities

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site for which you want to set up payment exceptions.
3. Click the Payment Exceptions view tab.
4. In the Payment Exceptions list, create a new record.

    The Payment Exceptions dialog box filters payment subject activities to show only those for the current protocol version. However, you can query from the set of all subject payment activities with Payment Flag selected across all versions and protocols. This way, you can set payment exceptions for activities in protocol version 2 and in protocol version 1, for example, if the site is expected to transition to the newer version in the near future.

5. In the Payment Exceptions dialog box, select all activities for which you want to set payment exceptions and click OK.
6. In the Exception Amount fields, enter the new amounts that are to be paid to this site for each activity.

NOTE: The Exception Amount to be paid at the site level may be in a different currency than the currency designated in the subject visit template or for the site. When subject activities are created at a site, the currency is converted to the currency designated for the site.

a. Set the Payment Flag.

   If the Payment Flag is not selected, the activity will not appear in the Payment Activities view and a payment cannot be generated.

b. In the Payment Amount field, use the currency calculator to enter the amount and currency code.
Marking Subject Activities Completed (End User)

Usually the site personnel will use the Site Portal Web site to enter when subjects complete activities. However, this task can also be performed by the CRA using Siebel Clinical, as shown in “To mark subject activities as completed” on page 335.

**To mark subject activities as completed**

1. Navigate to the Subjects screen > Subjects list.
2. Drill down on Screening # of the subject whose activities have been completed.
3. Click the Visits view tab.
4. In the Visits list, select the visit that has just been completed and click Check All.
   - This marks the selected visit and all of its activities as completed:
     - The Completed flag is selected.
     - The Completed Dates of all activities of the selected visit are also filled in with the same Completed Date as that of the parent visit.
     - The Status is set to Done.
5. If necessary, edit the fields for the visit in the Activities list.

Generating Ad Hoc Payments for Sites (End User)

Ad hoc payments not associated with subject activities can be created for sites.

**To generate an ad hoc payment**

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site for which you want to generate a payment.
3. Click the Payment Activities view tab.
4. In the Payment Activities list, create a new record, and complete the necessary fields.
   - Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment</td>
<td>This field must be selected.</td>
</tr>
<tr>
<td>Completed</td>
<td>This field must be selected.</td>
</tr>
<tr>
<td>Standard Amount</td>
<td>The payment amount.</td>
</tr>
</tbody>
</table>
5  Click Generate Payment.
   The application removes the completed payments from the Payment Activities list.

6  To complete the payment, follow Step 6 on page 336 to Step 8 on page 337 in the procedure “To make final adjustments to the payment amounts and generate payments.”

Adjusting Payment Amounts and Generating Payments for Sites

Although payments are generally set on per-site basis (“Setting Payment Exceptions for a Site (End User)” on page 334), occasionally the financial administrator may want to make additional adjustments to the amount paid for a given payment activity.

When the financial administrator has finalized the amounts, payments are generated for all completed payment subject activities in the currency specified for the site. Each payment record is given a unique identity number. Other information, such as check number, check date, and check amount, can be entered later, either manually or by importing the data from a back-office finance system.

To make final adjustments to the payment amounts and generate payments

1  Navigate to the Site Management screen > Protocol Site List view.

2  In the Sites list, drill down on the Site # of the site for which you want to generate payments.

3  Click the Payment Activities view tab.
   This view lists all scheduled payment subject activities for subjects associated with the site.

4  (Optional) Adjust the Actual Amount to be paid to the site by entering a value in the Deviation Amount field.
   Standard Amount + Deviation Amount = Actual Amount

5  Check Completed and click Generate Payment.
   The application removes the completed payments from the Payment Activities list.

6  Click the Payments view tab.
   The payment generated in Step 5 appears in the Payments list.
Complete the fields in the Payments record.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Amount</td>
<td>The amount of money for which the check is to be made out. This is usually, but does not have to be, the same as the Earned Amount. The sum of all values in the Check Amount fields for a site is equal to the Paid to Date value of the site.</td>
</tr>
<tr>
<td>Check Date</td>
<td>The date on which the check was issued.</td>
</tr>
<tr>
<td>Check Number</td>
<td>The number assigned to the check.</td>
</tr>
<tr>
<td>Contract #</td>
<td>The contract with which the payment is associated.</td>
</tr>
<tr>
<td>Earned Amount</td>
<td>The sum of the Actual Payment amounts for the completed payment activities. The sum of all values in the Earned Amount column equals the Earned to Date value of the site.</td>
</tr>
<tr>
<td>Payment #</td>
<td>The application automatically generates this unique number.</td>
</tr>
<tr>
<td>Requested Amount</td>
<td>The requested amount of payment for the payment activities carried out at this site. This field is calculated as follows: [ \text{Requested Amount} = \text{Earned Amount} \times \left(100 - \frac{\text{Withholding Percentage}}{100}\right) - \text{Withholding Amount} ]</td>
</tr>
<tr>
<td>Type</td>
<td>For payment subject activities that are generated from the Generate Payment button, this field defaults to Interim Payments. For payment subject activities that are generated from a back office system, this field defaults to Initial Payments.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the payment record, for example, To be Processed, In Progress, Processed, and so on. A preconfigured state model is supplied to allow for a structured state transition.</td>
</tr>
</tbody>
</table>

Information may also be automatically loaded from a back-office finance system.

(Optional) Click the hyperlink in the Payment # field to view the payment activities associated with this payment.

Generating Final Payments for Sites (End User)

Final payments can be made to sites when all payment activities have been completed.

**NOTE:** All prior final payments to sites must be completed and information for these payments updated in the system before new final payments can be generated.
To generate final payments for a site

1. Navigate to the Site Management screen > Protocol Site List view.
2. In the Sites list, drill down on the Site # of the site for which you want to generate a payment.
3. Click the Payments view tab.
4. Make sure that all Check Amounts for past payments are up to date.
5. In the Payment list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Amount</td>
<td>The amount of money for which the check is to be made out. This is usually, but does not have to be, the same as the Earned Amount.</td>
</tr>
<tr>
<td>Check Date</td>
<td>The date on which the check was issued.</td>
</tr>
<tr>
<td>Check Number</td>
<td>The number assigned to the check.</td>
</tr>
<tr>
<td>Status</td>
<td>This field defaults to To Be Processed.</td>
</tr>
<tr>
<td>Type</td>
<td>You must set this field to Final Payment. When this field is set, the Requested Amount for the final payment is automatically calculated as equal to the Earned to Date Amount minus the Paid to Date Amount for the site.</td>
</tr>
</tbody>
</table>

When you step-off and save the record, the requested amount field is automatically updated, by subtracting the site’s total Paid Amount to date (that is, Check Amount) from its total Earned Amount to date. For more information on these values, see Step 7 on page 337.
This chapter covers the following topics:

- "About Administering and Using Clinical Trip Reports" on page 339
- “Scenario for Managing Clinical Trip Reports” on page 339
- “Process of Administering Clinical Trip Reports” on page 340
- “Creating a Trip Report Template” on page 341
- “Selecting a Trip Report Template Before a Site Visit (End User)” on page 341
- “Completing a Trip Report After a Site Visit (End User)” on page 343
- “Approving Trip Reports” on page 345

**About Administering and Using Clinical Trip Reports**

This chapter describes how to set up and use trip reporting in Siebel Clinical.

The study managers or clinical administrators can set up templates for trip reporting. These templates are then used by the clinical research associates (CRAs) when they create trip reports to record their visits to sites.

Advantages of using the trip reports in Siebel Clinical are:

- Trip reports are made consistent across the organization and are based on GCP (good clinical practice) and SOPs (standard operating procedures)
- CRAs save time planning trips and writing trip reports
- Managers save time reviewing trip reports
- A formatted, tamper-proof report for print or PDF can be generated from the trip report record
- A central repository for all trip reports

**Scenario for Managing Clinical Trip Reports**

This scenario is an example process performed by the clinical administrator and the clinical research associates (CRAs). Your company may follow a different process according to its business requirements.
The Clinical Administrator
In this scenario, a clinical administrator prepares a set of trip report templates for the CRAs to use when preparing for and writing up their visits to clinical sites.

The clinical administrator prepares four templates, one for each type of site visit the CRAs are typically required to perform:

- Site evaluation
- Site initiation
- Site monitoring
- Site close-out

For more information about site visits, see "Creating a Subject and Setting Up Visits and Visit Activities (End User)" on page 303.

The CRAs
The CRA is the end user of the Siebel Clinical product. Before visiting a site, the CRA uses the trip report feature to prepare for the visit. The follow-up items list reminds the CRA of the open activities arising from previous visits that need to be closed.

After preparing a draft trip report, the CRA makes a hard copy of the report and takes this copy on the site visit. The report can be used as a reference to help keep track of the activities that are carried out while at the site.

Upon return from a site visit, the CRA completes the trip report and generates a final report. This report is then submitted to the study manager for approval. The manager reviews the report and approves it if it is satisfactory. If the manager approves the trip report, it is then locked to prevent the CRA from making any further changes. If the trip report is not satisfactory, the manager may reject the report and return it to the CRA for further attention.

Process of Administering Clinical Trip Reports
This topic details sample tasks often performed by administrators and end-users when administering clinical trip reports. Your company may follow a different process according to its business requirements.

Administrator Procedures
1. "Creating a Trip Report Template" on page 341. Create a template for each type of site visit.
2. "Approving Trip Reports" on page 345. Approve or reject trip reports submitted by CRAs.
End-User Procedures
The following list shows tasks end users typically perform when administering clinical trip reports. These tasks are typically performed in the following order:

1. “Selecting a Trip Report Template Before a Site Visit (End User)” on page 341. Before a visit, use a trip report template to prepare an activities checklist and follow-up items.

2. “Completing a Trip Report After a Site Visit (End User)” on page 343. After visiting a site, use the Trip Report view to record activities accomplished, site personnel met, and follow-up items. Distribute and archive the completed trip report.

Creating a Trip Report Template
Typically, the clinical administrator prepares a number of generic trip report templates, perhaps one designed for each of the different stages in the study. (See “The Clinical Administrator” on page 340.)

The trip report template is an activity template of type Clinical Trip Report. This is one of a number of activity templates used in Siebel Clinical.

Other activity templates used in Siebel Clinical are subject visit templates (“Defining a Subject Visit Template” on page 295), clinical site templates (“Creating a Clinical Protocol Site Template” on page 316), and contact assessment templates (“Creating Contact and Account Assessment Templates” on page 316).

To create a trip report template

Create an activity template of type Clinical Trip Report.

For information about how to create activity templates, see Siebel Applications Administration Guide.

In the Activity Template Details list, create new records that describe activities for trip or follow-up items to be carried out after trips.

Selecting a Trip Report Template Before a Site Visit (End User)

Although a trip report is designed to be written after a site visit, it can be used during a site visit to guide the CRA through a list of required activities. The report contains different lists depending on the Visit Type.

The Trip Reports view contains two lists for Pre-Study and Site Initiation visit types:

- **Checklist Activities.** Activities in this list can be generated by applying a trip report template. Ad-hoc activities can also be created individually.

- **Follow-up Items.** These are the activities that need to be followed up later. The Current Trip and Follow Up-Items view allows the CRA to record, and later to review, the follow-up items associated with the current site visit. The All Follow-Up Items view (accessed using the filter) lists follow-up items from both previous visits and also from the current visit.
For Site Monitoring and Site Close-Out visit types, a Trip Report contains both of the lists detailed above and also contains an extra list:

- **Case Report Forms Tracking.** The items in this list track the Case Report Forms corresponding to subject visits.

**To select a trip report template**

1. Navigate to the Site Visits screen.
2. In the Site Visits list, click the hyperlink in the Visit Start field of the visit for which you want to create the trip report.
   
   The Trip Report view is displayed. Some of the fields will already be populated from when the site visit was created. For more information about creating site visits, see "Creating a Subject and Setting Up Visits and Visit Activities (End User)” on page 303.
3. Complete or edit other fields in the Trip Report form. See also Step 2 on page 344.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owned By</td>
<td>This field defaults to the creator of the trip report. Other names can be added to indicate a shared trip report.</td>
</tr>
<tr>
<td>Site Visit Status</td>
<td>The status of the site, for example, Planned, Completed, and so on.</td>
</tr>
<tr>
<td>Visit Start</td>
<td>The date and time on which the site visit is started or planned.</td>
</tr>
<tr>
<td>Visit Type</td>
<td>The nature of the visit, for example, prestudy, site initiation, or site monitoring.</td>
</tr>
<tr>
<td>Visit Name</td>
<td>A descriptive name for the trip report.</td>
</tr>
</tbody>
</table>

4. In the Template field, select the name of the trip report template that you want to apply.
   
   When you click off the Template field, the activities defined in the template appear in the Checklist Activities list.

5. (Optional) Edit the activities in the Checklist Activities list or create more activities.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display In</td>
<td>Indicates where the activity should be displayed.</td>
</tr>
</tbody>
</table>

6. If there are follow-up items from previous trips, review them:
   a. In the Current Trip Follow-Up Items list, from the drop-down menu, select All Follow-Up Items.
      
      This displays all follow-up issues for that site (open and closed; past, present, and future).
Click Filter.

This displays all the open-to-date follow-up items and any follow-up items that were closed between completed dates of the last trip and the current trip.

To print or email a trip report

1. Navigate to the Site Visits screen.
2. In the Site Visits list, click the hyperlink in the Visit Start field of the visit for which you want to print the trip report.
   The Trip Report view is displayed.
3. Click the Reports button and select and run the Trip Report report.
   This opens the Siebel Report Viewer.
4. Print, email, or save the report.
   For more information about the Siebel Report Viewer, see Siebel Fundamentals.

Completing a Trip Report After a Site Visit (End User)

After the site visit, the end users record details of their trips, such as:

- Which of the planned activities were completed
- What additional activities were carried out
- Which site personnel they met
- Any follow-up items arising from the trip
- Comments to any of the above

The records in the Trip Report Detail view can be updated and edited at any time. For this reason, it is likely that the end user will want to create a static report at the completion of the trip, using the Siebel Report Viewer. This read-only document is ideal for archiving: as a printed document, as a file, or as an attachment to the site record in the Siebel Life Sciences database.

To complete a trip report

1. Navigate to the Trip Report view and select the trip report that you want to complete.
   For details on how to do this, see Step 1 on page 342.
2 Complete or edit fields in the Trip Report form. See also Step 3 on page 342.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendees</td>
<td>The contacts (site personnel) whom you met during the visit.</td>
</tr>
<tr>
<td>Completed date</td>
<td>The date and time on which the trip report is completed. It is important that this date be filled in because the filter in the All Follow-Up Items list uses this date to determine which closed follow-up items to display (Step 6 on page 342). This field becomes required when the Visit Status is changed to Done.</td>
</tr>
<tr>
<td>Trip Report Status</td>
<td>The status of the trip report.</td>
</tr>
</tbody>
</table>

3 In the CheckList list, complete the Status and Comments fields for planned activities and add any unplanned activities that you may have carried out.

4 In the Current Trip Follow-Up Items list, add any follow-up activities resulting from the site visit.

5 In the Current Trip Follow-Up Items list, from the drop-down menu, select All Follow-Up Items and click Filter to display all open follow-up items and those closed between the current and previous trip.

6 Update the records for those follow-up items that were addressed during the site visit.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed Date</td>
<td>The resolution date of the follow-up issue. It is important that this date be filled in. The filter in the All Follow-Up Items list uses this date to determine which closed follow-up items to display (Step 6 on page 342).</td>
</tr>
<tr>
<td>Status</td>
<td>This field automatically changes to Done when a completed date is entered for the item.</td>
</tr>
</tbody>
</table>

7 When all the above tasks have been completed and the trip report is ready to be submitted for review, you should change the value of the Trip Report Status to Submitted. This submits the report to the study manager for approval.

*To create a case report form tracking activity*

**NOTE:** The Case Report Forms Tracking view is only available for site visits of type Monitoring, Unscheduled, or Close-out.

1 Navigate to the Trip Report view.

2 In the Case Report Forms Tracking view, create a new record.
Click the select button in the Visit field, select a subject and visit in the Pick Subject and Visits dialog box, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retrieved</td>
<td>This field is checked when the CRA retrieves the case report forms from the site.</td>
</tr>
<tr>
<td>Source Document Verified</td>
<td>This field is checked when the case report form has been verified from the source document.</td>
</tr>
</tbody>
</table>

### Approving Trip Reports

At various times during a trial, study managers need to review and approve trip reports completed by CRAs. To do this, the study managers use the Site Visits view and query for trip reports with a status of Submitted.

#### To approve trip reports

1. Navigate to the Site Visits screen.
2. In the sites list, click the drop-down list and select My Team’s Site Visits.
3. Query the list for site visits whose status is set to Submitted.
4. For each report, drill down on the hyperlink in the Visit Start field.
   - The Trip Report view is displayed.
5. Review the report and change the Trip Report Status to Approved. The Site Visit record and the Trip Report become read only.
   - If you set the Trip Report Status to Rejected, the CRA will have the opportunity to revise the report and then resubmit it for approval.

#### To distribute and archive a trip report

1. Follow Step 1 on page 343 to Step 3 on page 343 to create a report in the Siebel Report Viewer.
2. From within the Siebel Report Viewer, email the report, for example, to colleagues and to a manager for approval.
3. From within the Siebel Report Viewer, save the report as an ROI file and then close the Siebel Report Viewer.
   - For more information about the Siebel Report Viewer, see Siebel Fundamentals.
5. Drill down on the Site #.
6 Click the Attachments view tab.
   Add the ROI file as an attachment to the site record.
This chapter covers the following topics:

- "About Managing Clinical Projects" on page 347
- "Scenario for Managing Clinical Projects" on page 347
- "Process of Managing Clinical Projects" on page 348
- "Creating a Project Activity Template" on page 349
- "About Setting Up Employee Profiles" on page 349
- "Setting Up Position Types and Rate Lists for Billing" on page 350
- "Creating a Project (End User)" on page 351
- "Associating People and Accounts with Projects (End User)" on page 351
- "Creating Activities and Tasks for a Project (End User)" on page 353
- "Monitoring Project Costs (End User)" on page 354
- "Managing Risk (End User)" on page 354
- "About Views in the Projects Screen" on page 355

**About Managing Clinical Projects**

This chapter is meant to be used as a supplement to the documentation in *Siebel Project and Resource Management Administration Guide* (in the chapter about projects management) and *Siebel Applications Administration Guide* (in the chapter about professional services).

Siebel Clinical Projects is designed to help project managers manage clinical trial projects. The projects are associated with individual protocols. Timelines, milestones, costs, and resources can be entered, viewed, and updated from the Projects screen.

**Scenario for Managing Clinical Projects**

This scenario is an example process performed by the administrator and the project manager (PM) for the clinical trial. Your company may follow a different process according to its business requirements.

The PM works for a large clinical research organization (CRO) that has been awarded a contract to carry out a clinical trial for a pharmaceutical company and is responsible for setting up and running the clinical trial project.
Setup and Staffing
First, the PM enters some basic information about the project into Siebel Clinical and determines which employees should have visibility to the project data by entering them in the project access list.

To optimize the resource assignment, the PM first enters the resource requirements in the team workbook and then uses Siebel Assignment Manager to help with the staffing. The PM specifies the roles, skills, competencies, and availability required for the team and lets Resource Manager find the best candidate for the roles.

For this large project the CRO may need some subcontractors to complete certain aspects of the project. Because the subcontractors are paid on an hourly rate, the PM associates the appropriate billing rate list to the project. The PM also needs to add employees of the subcontracting company to the subcontractor resource list.

Other external contacts and accounts can also be added to the project. For example, information about the central laboratory and the primary contact at this laboratory are added.

Tasks, Activities, and Risks
Milestones can be set as tasks or activities. The PM can create them within Siebel Clinical Projects. Each Siebel activity has a budget and the actual costs of these activities are updated as the project progresses. Periodically, the PM reviews these project costs, making sure that the project is staying within budget. Payments made to sites for subject activities are rolled up to the project costs.

Project risks are documented as they arise, as well as the resolution activities to address the risks.

Process of Managing Clinical Projects
This topic details sample tasks often performed by administrators and end users when managing clinical projects. Your company may follow a different process according to its business requirements.

Administrator Tasks
The following list shows tasks administrators typically perform to manage clinical projects. The procedures that an administrator needs to carry out in support of projects depends upon which features of the Projects will be used by the organization. You may not need to perform all the procedures listed here. These tasks must occur before the project manager creates the project:

- “Creating a Project Activity Template” on page 349. These templates are used by many project managers carrying out similar clinical trials.
- “About Setting Up Employee Profiles” on page 349. Maintain the employee profiles of skills and competencies that are used by Siebel Assignment Manager.
- “Setting Up Position Types and Rate Lists for Billing” on page 350. The position types and rate lists are required to allow subcontractors (and employees) to bill the project for their time.
- “Creating a Project (End User)” on page 351.
End-User Procedures
These tasks can be performed only after the administrator has completed the required preparatory work described in the preceding topics. These tasks may be carried out according to your company’s business needs:

- “Creating a Project (End User)” on page 351.
- “Associating People and Accounts with Projects (End User)” on page 351. Give employees access to the project; add contacts and accounts to the project’s team workbook.
- “Creating Activities and Tasks for a Project (End User)” on page 353.
- “Monitoring Project Costs (End User)” on page 354.
- “Managing Risk (End User)” on page 354. Document project risks and resolution activities.

Creating a Project Activity Template
Activities can be created within (Siebel) Projects screen. If the study managers are primarily entering activities through the Projects screen, then creating project activity templates will be advantageous.

Typically, the administrator prepares a number of project templates, perhaps each designed for a different stage in the life of a study.

The project is an activity template of type “Project.” Other activity templates used in Siebel Clinical are subject visit templates (“Defining a Subject Visit Template” on page 295), clinical site templates (“Creating a Clinical Protocol Site Template” on page 316), trip report templates (“Creating a Trip Report Template” on page 341), and contact assessment templates (“Creating Contact and Account Assessment Templates” on page 316).

To create a project activity template
Create an activity template of type Project.

The Protocol Type field is optional: a project activity template can be applied to any project, regardless of the protocol associated with the project.

In the Activity Template Details list, create records to describe activities and milestones for the project.

For information about how to create activity templates, see Siebel Applications Administration Guide.

About Setting Up Employee Profiles
The end user may use Siebel Assignment Manager to automatically search the employee database for the available employees whose skills best fit the needs of the project. Siebel Assignment Manager requires that profiles of skills and competencies be set up for employees.

For information on using Siebel Assignment Manager, see Siebel Assignment Manager Administration Guide.
Use of Siebel Assignment Manager is not required. The end user can assign team members directly into the Team Workbook view, without using Siebel Assignment Manager.

**Setting Up Position Types and Rate Lists for Billing**

If project team members are to bill their time to the project through the Team Workbook view, position types and rate lists should be set.

Position types, such as consultant, are set up as products and flagged as resources. Lists of hourly rates for the position types are then set up. When the rate list is applied to the project, the hourly rates for the team members are automatically supplied in the team workbook.

For more information about position types and rate lists for Professional Services, see *Siebel Applications Administration Guide*.

**To create position types as products**

1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, create a new record, and complete the necessary fields.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>A product (resource) name, for example, Consultant.</td>
</tr>
<tr>
<td>Project Resource</td>
<td>Check this field.</td>
</tr>
</tbody>
</table>

**To create a rate list**

1. Navigate to the Administration - Pricing screen > Rate List view.
2. In the Rate Lists list, create a new record, and complete the necessary fields.
3. In the Rate Lists list, drill down on the Rate List hyperlink.
4. In the Rate List Line Items list, create a new record.
5. In the Add Position Types dialog box, select the Position Type and click OK.
   
   This list of resources has been created as a product.
6. In the Rate List Line Items list, complete the remaining fields.
Creating a Project (End User)

The first step is to create the project record and to associate a protocol with the project.

**NOTE:** It is recommended that only one project be associated with a protocol. However, the application does not prevent the association of a protocol to multiple projects. In this case, costs associated with payments to sites are rolled up to each project.

**To create a project**

1. Navigate to the Projects screen > List view.
2. In the Projects list, create a new record.
   a. Enter the Start date and End date for the project.
   b. Associate a protocol with the project.
   c. Complete the remaining fields as necessary.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>For example, enter the name of the pharmaceutical company for whom this project is being carried out.</td>
</tr>
<tr>
<td>Actual Cost</td>
<td>This field is calculated by summing the actual costs of all the tasks, activities, and site payments associated with the project.</td>
</tr>
<tr>
<td>Budgeted Cost</td>
<td>This field is calculated by summing the budgeted costs of all the tasks, activities, and site payments associated with the project.</td>
</tr>
<tr>
<td>Revenue</td>
<td>The total Revenue for the project. Click the select button for this field to enter the amount of revenue, the currency, and the exchange date for the currency.</td>
</tr>
<tr>
<td>Project ID</td>
<td>A unique identification number for the project.</td>
</tr>
<tr>
<td>Protocol #</td>
<td>All protocols in the database can be selected from this drop-down menu. The creator of the project is not required to be a member of the protocol team.</td>
</tr>
<tr>
<td>Rate List</td>
<td>If a rate list has been set up for the project team members, enter it in this field. Use the more button if this field is not visible. (See “Setting Up Position Types and Rate Lists for Billing” on page 350.)</td>
</tr>
</tbody>
</table>

Associating People and Accounts with Projects (End User)

**Employees.** Employees in Siebel Clinical can be given access to the project and added to the team workbook.
**Contacts.** Contacts can be associated with projects through the Contacts view and the Organizational Analysis view. The same contacts appear in the Contacts view and the Organizational Analysis view.

**Accounts.** Accounts can be associated with projects through the Partners view and the Subcontractors view. Adding accounts to the Subcontractors view allows you to add employees from the subcontracting accounts to the project’s team workbook. (For more information about adding subcontractors, see *Siebel Project and Resource Management Administration Guide*.)

**To add employees to a project**

1. Give employees visibility to a project by adding them to the Access view.
   
   For more information about providing access to a project, see *Siebel Project and Resource Management Administration Guide*.

2. Allow employees and subcontractors to be assigned to activities and to bill time to the project by adding them to the Team Workbook view.

   If a rate list has been set up, make sure that the Resource field on the Resource Detail form of the Team Workbook view is set for the team members.

   For more information about the team workbook for projects management, see *Siebel Project and Resource Management Administration Guide*.

**To add a contact to a project using the Organization Analysis view**

1. Navigate to the Projects screen > List view.

2. Drill down on the Name of a project.

3. Click the Organization Analysis view tab.

4. From the Organization Analysis drop-down list, select Contacts.

5. In the Contacts list, create a new record, and complete the necessary fields.

6. From the Contacts drop-down list, select Organization Analysis.

   An organization chart of the contacts appears. Any employee-manager relationships set in Step 5 are indicated.

**To add a partner account to a project**

1. Navigate to the Projects screen > List view.

2. Drill down on the Name of a project.

3. Click the Partners view tab.
4. In the Partners list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site</td>
<td>This is the account site, a unique identifier for the account. It is not related to the sites where clinical trials are carried out.</td>
</tr>
</tbody>
</table>

Creating Activities and Tasks for a Project (End User)

Activities can be created for the project in a variety of ways:

- Enter activities in the Activities view.
- Generate activities in the Activity Plan view by applying a project activity template. (See "To create an activity for a project using a project activity template" on page 353.)
- Enter activities manually in the Activity Plan view. These activities must be associated with an activity plan based on a template.
- Create a task in the Task view and associate activities with the task. (See "To create a task and associate activities to it" on page 353.)

A task is a container for activities. Activities associated with tasks are different from regular standalone activities. Activities that belong to tasks cannot be generated by project activity templates. They can only be created manually from within the Project Task Activity view. A standalone activity cannot be added to a task, nor can a task activity be disassociated from the task.

For more information, see about creating activities and tasks for projects management in Siebel Project and Resource Management Administration Guide.

To create an activity for a project using a project activity template

1. Navigate to the Projects screen > List view.
2. Drill down on the Name of the project.
3. Click the Activity Plans view tab.
4. In the Activity Plans list, create a new record.
5. In the Template field, select a template from the drop-down list.

The activities associated with the activity plan appear in the Activities list subview.

NOTE: Activities can also be created manually in the Activities view.

To create a task and associate activities to it

1. Navigate to the Projects screen > List view.
2. Drill down on the Name of the project.
3 Click the Tasks view tab.
4 In the Tasks list, create a new record, and complete the necessary fields.
5 In the Tasks list, drill down on the Name hyperlink.
6 In the Activities list, create a new record, and complete the necessary fields.

Monitoring Project Costs (End User)

The Cost view provides the end user with a valuable summary of all costs associated with a particular project and protocol.

The cost items are displayed in three lists:

- **Project Activities.** Displays those activities from the Activities view where the Cost field is selected.
- **Project Tasks.** Displays those tasks from the Tasks view where the Cost field for the task is selected. The actual cost and budgeted cost for a task are determined by summing the costs of the activities contained in the task.
- **Clinical Payments.** Displays payments made to the sites associated with the protocol. These payment amounts are rolled up into the actual cost field in the Project form.

End users cannot create, modify, or delete records in this view.

**NOTE:** All costs in this view are in the default currency set for the project.

To view costs associated with a project
1 Navigate to the Projects screen > List view.
2 Drill down on the Name of the project.
3 Click the Costs view tab.
4 Click a hyperlink in the Clinical Payments or Project Tasks list to see the activities associated with a cost item.

Managing Risk (End User)

An important aspect of project management is risk management. The features of the Risks view allow the end user to enter information about project risks and create and assign resolution activities to address the risks.

For more information, about assessing risks for projects management, see *Siebel Project and Resource Management Administration Guide*.

To create risk and resolution activities for a project
1 Navigate to the Projects screen > List view.
2 Drill down on the Name of the project.
3 Click the Risks view tab.
4 In the Risks list, create a new record, and complete the necessary fields.
5 In the Risks list, drill down on the Name hyperlink.
6 In the Resolution Activities list, create a new record, and complete the necessary fields.

**About Views in the Projects Screen**

There are many views in the Projects screen for the standard Siebel Clinical application. Many implementations may choose to use only a subset of these views. Refer to Table 29 for a brief description of each of the views that are available in the Projects screen.

<table>
<thead>
<tr>
<th>View</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access</td>
<td>Use this view to provide project visibility. Add the names of the project team members and also managers or executives who want visibility to monitor the progress of the project. The Access view has a similar function to the Team field in other screens.</td>
</tr>
<tr>
<td>Activities</td>
<td>This view lists activities associated with the project. Activities in this view may have been created manually or by project activity templates. Activities belonging to tasks do not appear in this view.</td>
</tr>
<tr>
<td>Activity Plans</td>
<td>Use this view to generate activities from project activity templates. Additional activities can be added manually to the activities already associated with an activity plan.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attach project documents in this view. For general information about attachments, see Siebel Fundamentals.</td>
</tr>
<tr>
<td>Calendar</td>
<td>This view shows a monthly calendar of the activities associated with the project. Activities belonging to tasks and standalone activities appear in this view. For general information about the calendar views, see Siebel Fundamentals.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Use this view to maintain a list of contacts associated with the project. Enter names of employees in subcontracting or partner organizations.</td>
</tr>
<tr>
<td>Financial Profile</td>
<td>Use this view to gain an overall perspective of a project’s financial information, status, and progress. Use this view to change the Delivery status for the project (green, yellow, or red). For more information, see Siebel Project and Resource Management Administration Guide.</td>
</tr>
<tr>
<td>Invoices</td>
<td>Use this view to create invoices for time and expenses logged against a project. For more information, see Siebel Project and Resource Management Administration Guide.</td>
</tr>
</tbody>
</table>
### Table 29. Views in the Projects Screen

<table>
<thead>
<tr>
<th>View</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>Use this view to keep private and public notes about the project. For general information about the Notes view, see <em>Siebel Fundamentals</em>.</td>
</tr>
<tr>
<td>Orders</td>
<td>Use this view to create a product or material order and associate it with the project. For more information, see <em>Siebel Project and Resource Management Administration Guide</em>.</td>
</tr>
<tr>
<td>Organizational Analysis</td>
<td>This view displays an organizational chart of contacts, showing the relationships between them.</td>
</tr>
<tr>
<td>Partners</td>
<td>Use this view to maintain a list of partner accounts associated with the project. Use this view to keep a list of accounts associated with the project, such as vendors who handle printing of the clinical trial materials or the shipping of sample drugs. Because the Partners, Subcontractors, and Clinical Contacts views contain account information, depending on your business process, you may use one or more of these views to keep track of accounts associated with project.</td>
</tr>
<tr>
<td>Risks</td>
<td>Use this view to maintain a list of the risks associated with the project and resolution activities required to address those risks.</td>
</tr>
<tr>
<td>Status Report</td>
<td>Use this view to create a status report summarizing the project’s progress, forecast, and issues. For more information, see <em>Siebel Project and Resource Management Administration Guide</em>.</td>
</tr>
<tr>
<td>Subcontractors</td>
<td>Use this view to keep a list of subcontractors associated with the project. (See also “Partners” on page 356 in this table.)</td>
</tr>
<tr>
<td>Tasks</td>
<td>Use this view to create and modify tasks for the project.</td>
</tr>
<tr>
<td>Team Workbook</td>
<td>Use this view to assign team members to roles in the project. This can be done manually or it can be done automatically using Siebel Assignment Manager. Team members must be listed in the workbook before they can be assigned to activities.</td>
</tr>
<tr>
<td>Time &amp; Expense</td>
<td>Use this view to adjust and summarize time sheets and expense reports associated with the project. For more information, see about time sheets and expense reporting in  <em>Siebel Project and Resource Management Administration Guide</em>.</td>
</tr>
</tbody>
</table>
23 Capturing Adverse Events and Complaints

This chapter covers the following topics:

- "About Adverse Events and Complaints Management” on page 357
- "About Capturing Adverse Events and Complaints” on page 360
- "Scenario for Capturing and Escalating Adverse Events and Complaints” on page 362
- "Process of Capturing and Escalating Adverse Events and Complaints” on page 363
- "Confirming Standard Setup for Service Requests” on page 364
- "Setting Up Codes” on page 365
- “Setting Up Lot Numbers for Medical Products” on page 369
- “Capturing Adverse Events and Complaints as Service Requests (End User)” on page 369
- “Escalating Adverse Events and Complaints as Product Issues (End User)” on page 371
- “Adding Complaint-Specific Information to Product Issues (End User)” on page 372
- “About Configuring Adverse Events and Complaints Capture” on page 373

About Adverse Events and Complaints Management

Adverse events and complaints management (AECM) is an important process in the regulated medical device and pharmaceutical industries. The FDA in the USA and similar agencies in other countries have specific requirements for capturing, investigating, reporting, and resolving adverse events and complaints on medical devices and drugs.

Poor handling of adverse events and complaints can lead to non-compliance penalties such as warning letters, restrictions, fines, and recalls.
Siebel Adverse Events and Complaints Management

Siebel Adverse Events and Complaints Management (Siebel AECM) is designed to manage the life cycle of an adverse event or a medical product complaint. Users collaborate and capture all of the necessary data to track the complaint through investigation to corrective action and generate the required regulatory reports. Table 30 illustrates such a life cycle. Each step in the process represents a chapter in this book.

Table 30. Complaints Process Flow

<table>
<thead>
<tr>
<th>Process</th>
<th>Roles</th>
<th>Typical Activities</th>
</tr>
</thead>
</table>
| **1** Capture adverse event or complaint | Call Center Agent | - Capture and verify customer contact information  
- Identify whether service request is potential adverse event or complaint  
- Capture adverse event and patient consequences; identify devices  
- Diagnose and solve problem  
- Assess the problem  
- Dispatch Field Engineer  
- Create RMA and replacement orders |
| **2** Investigate adverse event or complaint | Quality or Regulatory Agency | - Review information for correctness  
- Identify FDA codes, other similar agencies codes, and internal codes to label the problem  
- Assess whether reportable  
- Perform trend analysis  
- Contacts customer for information  
- Coordinate investigation |
| **3** Manage product analysis and CAPA | Product Analysis and CAPA Team | - Make sure receipt of product  
- Decontaminate devices  
- Ship devices to manufacturing or third party for analysis  
- Review complaints  
- Analyze the devices and records results  
- Approve analysis  
- Submit requests for CAPA |
Capturing Adverse Events and Complaints

■ About Adverse Events and Complaints Management

Where to Find More Information

The following chapters describe other aspects of the complaints and adverse events management process:

■ Chapter 24, “Investigating Adverse Events and Complaints”
■ Chapter 25, “Recording Product Analysis for AECM”
■ Chapter 26, “Managing CAPAs”
■ Chapter 27, “Regulatory Reporting”
■ Chapter 29, “Communicating with Customers for AECM”
■ Chapter 28, “Closing Adverse Events and Complaints”

Integration with Other Siebel Applications

Siebel AECM is integrated with Siebel Call Center, Siebel Sales, Siebel Field Service, and Siebel Clinical. This allows the flexibility to share varying levels of visibility to adverse event or complaint details, investigation status, and corrective action across different users and functions within the organization. The Siebel Audit Trail functionality keeps a record of changes made to records throughout the course of the investigation.

---

Table 30. Complaints Process Flow

<table>
<thead>
<tr>
<th>Process</th>
<th>Roles</th>
<th>Typical Activities</th>
</tr>
</thead>
</table>
| 4       | Quality or Regulatory Agency | ■ Verify and approve analysis  
■ Assess whether problem is reportable  
■ Complete information for regulatory reports  
■ Generate and submit reports  
■ Submit supplemental and annual reports |
| 5       | Call Center Agent or Quality or Regulatory Agency | ■ Notify customer about investigation  
■ Identify all customers with potentially defective devices  
■ Execute product recalls  
■ Create communication materials for sales and regional offices |
| 6       | Quality or Regulatory Agency | ■ Verify that all necessary activities are completed  
■ Initiate complaint closure approval  
■ Close complaint |

Table 30: Complaints Process Flow

Quality or Regulatory Agency

■ Verify and approve analysis
■ Assess whether problem is reportable
■ Complete information for regulatory reports
■ Generate and submit reports
■ Submit supplemental and annual reports

Call Center Agent or Quality or Regulatory Agency

■ Notify customer about investigation
■ Identify all customers with potentially defective devices
■ Execute product recalls
■ Create communication materials for sales and regional offices

Quality or Regulatory Agency

■ Verify that all necessary activities are completed
■ Initiate complaint closure approval
■ Close complaint

---
About Capturing Adverse Events and Complaints

This chapter describes capturing information about a medical product complaint or adverse event as a service request and then escalating that complaint as a product issue for further investigation.

One of the goals in capturing such information is to identify complaints accurately, making sure that all valid complaints are identified while at the same time minimizing the number of false-positive complaints that are escalated for investigation.

Siebel AECM Terms

Table 31 lists some important terms and abbreviations used in Siebel AECM.

Table 31. Siebel AECM Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adverse Event</td>
<td>An adverse event is a customer event associated with a product malfunction or adverse reaction to a pharmaceutical. It can be initially captured as a service request and then escalated to a product issue (which becomes the complaint file associated with the event). In some places in this text, <em>complaints</em> includes both adverse events and complaints.</td>
</tr>
<tr>
<td>AECM</td>
<td>Adverse Events and Complaints Management</td>
</tr>
<tr>
<td>Call Center Agent</td>
<td>Another name for this job title is customer service agent. This agent is trained to identify a product complaint and distinguish it from a normal service or information request.</td>
</tr>
<tr>
<td>CAPA</td>
<td>Corrective and preventive action. This specifies the changes in product or process needed to resolve the root cause of the adverse event or complaint. For example, a CAPA could be a request from the analysis team for the correction of the manufacturing, design, or process flaw that caused the initial adverse event or complaint.</td>
</tr>
<tr>
<td>Complaint</td>
<td>A complaint is a customer event associated with a product malfunction. It can be initially captured as a service request and then escalated to a product issue (which becomes the complaint file associated with the event). In some places in this text, <em>complaints</em> includes both adverse events and complaints.</td>
</tr>
<tr>
<td>Initial regulatory report</td>
<td>The first report to a regulatory agency regarding a product complaint or an adverse event.</td>
</tr>
<tr>
<td>MDR</td>
<td>Medical device reports are required to be submitted to a regulatory agency when an adverse event or complaint is determined to be reportable.</td>
</tr>
<tr>
<td>MDV</td>
<td>Medical Device Vigilance</td>
</tr>
</tbody>
</table>
### About Capturing Adverse Events and Complaints

- **Medical Product**: Examples of medical products are capital equipment, disposables, reagents, implanted devices, and pharmaceuticals.

- **MedWatch 3500A**: U.S. Food and Drug Administration (FDA) report for mandatory reporting of adverse reactions and medical product problems by drug and biologic manufacturers and packers and by medical device manufacturers, distributors, importers, and user-facilities.

- **MedWatch 3500A Supplemental**: A 3500A report sent as a follow-up to an initial 3500A report.

- **NCA**: National Competent Authorities. Regulatory reports are often sent to these agencies. These country-specific agencies also report adverse events to each other.

- **Product Issue**: A product issue is the adverse event or complaint file. The product issue is often first captured as a service request record. Then the information is transferred to a product issue record, which becomes the adverse event or complaint file.

- **Product Issue Assessments**: A product issue assessment evaluates a product issue on defined criteria. For example, a product issue assessment can be used to determine whether the product issue should be reported to a regulatory agency.

- **Quality Manager**: Other names for this job title are complaint investigator, regulatory affairs representative, safety and regulator manager, regulatory liaison, and quality group liaison.

- **Regulatory report**: There are four types of regulatory reports supported by Siebel AECM (preconfigured):
  - MedWatch 3500A
  - MedWatch 3500A Supplemental
  - MDV Initial
  - MDV Follow-up

  **Regulatory report record**: The record in the Regulatory reports screen.

  **Regulatory report**: The report created using data contained in the regulatory report record.

  Other regulatory reports like CIOMS can be configured using other reporting tools.

- **Siebel AECM**: The Siebel Adverse Events and Complaints Management module.

- **Signature capture**: See User authentication.

---

### Siebel AECM Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Product</td>
<td>Examples of medical products are capital equipment, disposables, reagents, implanted devices, and pharmaceuticals.</td>
</tr>
<tr>
<td>MedWatch 3500A</td>
<td>U.S. Food and Drug Administration (FDA) report for mandatory reporting of adverse reactions and medical product problems by drug and biologic manufacturers and packers and by medical device manufacturers, distributors, importers, and user-facilities.</td>
</tr>
<tr>
<td>MedWatch 3500A Supplemental</td>
<td>A 3500A report sent as a follow-up to an initial 3500A report.</td>
</tr>
<tr>
<td>NCA</td>
<td>National Competent Authorities. Regulatory reports are often sent to these agencies. These country-specific agencies also report adverse events to each other.</td>
</tr>
<tr>
<td>Product Issue</td>
<td>A product issue is the adverse event or complaint file. The product issue is often first captured as a service request record. Then the information is transferred to a product issue record, which becomes the adverse event or complaint file.</td>
</tr>
<tr>
<td>Product Issue Assessments</td>
<td>A product issue assessment evaluates a product issue on defined criteria. For example, a product issue assessment can be used to determine whether the product issue should be reported to a regulatory agency.</td>
</tr>
<tr>
<td>Quality Manager</td>
<td>Other names for this job title are complaint investigator, regulatory affairs representative, safety and regulator manager, regulatory liaison, and quality group liaison.</td>
</tr>
</tbody>
</table>
| Regulatory report         | There are four types of regulatory reports supported by Siebel AECM (preconfigured):
  - MedWatch 3500A
  - MedWatch 3500A Supplemental
  - MDV Initial
  - MDV Follow-up

  **Regulatory report record**: The record in the Regulatory reports screen.

  **Regulatory report**: The report created using data contained in the regulatory report record.

  Other regulatory reports like CIOMS can be configured using other reporting tools. |
Table 31. Siebel AECM Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartScripts</td>
<td>A SmartScript is a collection of predefined questions, answers, and branches that can be used to guide the quality manager through potentially complex decision making processes to arrive at a solution to a problem or query. For more information about SmartScripts, see Siebel SmartScript Administration Guide.</td>
</tr>
<tr>
<td>Inbox</td>
<td>The Inbox allows managers and other employees to view and approve items (of multiple types) from one screen. In Siebel AECM, the Inbox is used to approve product analyses. For more information, see Siebel Applications Administration Guide.</td>
</tr>
<tr>
<td>User authentication</td>
<td>The user authorization check captures and verifies the user’s name and password. This user authentication is controlled by the LS Medical User Verification workflow. [NOTE: User authentication is sometimes called signature capture, but should not be confused with electronic signature capture on mobile devices or tablet PCs used elsewhere in the Siebel Life Sciences application.]</td>
</tr>
</tbody>
</table>

Scenario for Capturing and Escalating Adverse Events and Complaints

This scenario is an example workflow performed by the Siebel administrator and a call center agent. Your company may follow a different workflow according to its business requirements.

This workflow is designed to illustrate the functionality of Siebel AECM.

Introduction

A medical manufacturing company makes capital equipment for use in hospitals. The company has recently released a new blood analyzer system. The company manufactures both the instrument and the consumables.

The Siebel Administrator

In preparation for the new blood analyzer being released on the market, the Siebel administrator performs a number of preparatory administration tasks so that the product and all necessary codes and lot numbers are set up in the Siebel application. In case the company has to file a 3500A report, the administrator refers to the MedWatch coding manual and sets up appropriate codes for event problems and evaluation.

The Siebel administrator also sets up the activity templates used by the call center agents to create activity plans for handling customer complaints. The Siebel administrator needs to have all these ready before the call center agents begin to receive calls about the product.
When troubleshooting and problem resolution information becomes available for the new blood analyzer, the Siebel administrator creates solution records that contain this troubleshooting information.

**The Call Center Agent**

A call center agent takes a customer call about a failing blood analyzer system.

In addressing the customer’s complaint, the call center agent does the following:

- Enters a service request, recording details about the product and the failure.
- Works with the customer to troubleshoot the problem, searching the solution database for possible solutions. In this case, he finds a solution document about running a diagnostic test. The test does not resolve the problem, but it does indicate the repair that is needed.
- Creates an activity plan—a list of predefined activities—to dispatch a service engineer to the customer site.
- Dispatches a service engineer to make a repair to the analyzer.
- Sets up an RMA (return materials authorization) to return the cartridge and reagents that were in use when the analyzer failed.
- Reviews the report of the work done by the field engineer.

The call center agent has been trained to identify calls as potential complaints. He recognizes that this customer’s problem needs to be escalated as a product issue. Before escalating, he reviews the information entered in the service request, making sure that the service request is classified correctly, for example, with accurate types and codes. When the call center agent creates the product issue from the service request record, the appropriate data is transferred from the service request to the product issue record.

**Process of Capturing and Escalating Adverse Events and Complaints**

This example process represents the tasks that are carried out in the Scenario for Capturing and Escalating Adverse Events and Complaints on page 362.

**Administrator Procedures**

The Siebel administrator sets up the service request functionality so that call center agents can capture adverse events and complaints. To do this, the Siebel administrator performs the following tasks:

- Confirming Standard Setup for Service Requests on page 364
- Setting Up Codes on page 365
- Setting Up Lot Numbers for Medical Products on page 369
End-User Procedures
To capture and escalate adverse events and complaints, end users perform the following tasks:

1. Capturing Adverse Events and Complaints as Service Requests (End User) on page 369
2. Escalating Adverse Events and Complaints as Product Issues (End User) on page 371
3. Adding Complaint-Specific Information to Product Issues (End User) on page 372

Confirming Standard Setup for Service Requests
Before service requests can be logged against products, the Siebel administrator sets up the following:

- **Products.** Records need to be set up for products against which there may be adverse events and complaints.
- **Product Lines and Categories.** Product lines and categories can both be associated with codes. If you configure your application to filter codes according to product line or category, make sure to set these up. For more about codes, see "Setting Up Codes" on page 365.
- **Assets.** Asset records should be set up for devices with serial numbers. Assets do not need to be set up for items such as consumables.
- **Activity Templates of type Service Request.** Call center agents use activity templates to create service request activity plans—sets of predefined and scheduled activities associated with service requests.
- **Solutions.** Many service requests are similar to previously addressed issues. Solution documents contain information about previously resolved requests.
- **LOVs for Type, Area, and Sub Area.** These fields are particularly important for classifying service requests. You can customize these LOVs.

You might have already completed these setup tasks for other reasons in Siebel Life Sciences. These setup tasks are standard in many Siebel applications and are not unique to Siebel Life Sciences.

**TIP:** To aid call center agents with information gathering and problem diagnosis associated with adverse events and complaints, you may wish to set up SmartScripts. For more information about SmartScripts, see Siebel SmartScript Administration Guide.

This task is a step in "Process of Capturing and Escalating Adverse Events and Complaints" on page 363.
Setting up Products, Product Lines, Categories, Assets, Activity Templates, Solutions, and LOVs

For information, consult Table 32.

Table 32. Setting up Products, Product Lines, Categories, Assets, Activity Templates, Solutions, and LOVs

<table>
<thead>
<tr>
<th>To Set Up...</th>
<th>Use This Screen...</th>
<th>And for More Information, See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Products</td>
<td>Product Administration</td>
<td>“Defining External Products” on page 81 and Siebel Product Administration Guide</td>
</tr>
<tr>
<td>Product Lines</td>
<td>Product Administration &gt; Product Lines</td>
<td>Siebel Product Administration Guide</td>
</tr>
<tr>
<td>Categories</td>
<td>Catalog Administration</td>
<td>“Adding Products to Catalogs” on page 95</td>
</tr>
<tr>
<td>Assets</td>
<td>Assets</td>
<td>Siebel Field Service Guide, Siebel Communications Guide</td>
</tr>
<tr>
<td>Activity Plans of type Service Request</td>
<td>Data Administration &gt; Activity Templates</td>
<td>Siebel Field Service Guide</td>
</tr>
<tr>
<td>Solutions</td>
<td>Solution Administration</td>
<td>Siebel Field Service Guide</td>
</tr>
<tr>
<td>LOVs</td>
<td>Data Administration &gt; List of Values</td>
<td>Siebel Applications Administration Guide</td>
</tr>
</tbody>
</table>

Setting Up Codes

Codes allow you to codify many aspects of the AECEM process. For example, codes are used to categorize the service request that triggers the adverse event or complaint, and codes are used to categorize the corrective actions initiated at the end of a complaint’s life cycle.

Multiple codes and sometimes codes of multiple types can be specified in one code field.

Think carefully when designing and setting up your code system. Codes are used as search criteria for service requests and product issues.

According to your business needs, you may decide to use:

- Industry codes such as FDA patient, device, method, results, and conclusion codes required for the MedWatch 3500A form
- Company-specific codes
- A combination of industry and company-specific codes
Table 33 lists where code fields appear in the Siebel AECM module.

<table>
<thead>
<tr>
<th>Screen</th>
<th>View</th>
<th>Field Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service Requests</td>
<td>More Info</td>
<td>Codes</td>
<td>None</td>
</tr>
<tr>
<td>Product Issues</td>
<td>More Info</td>
<td>Codes</td>
<td>Copied from the service request when a product issue is created. Codes from the service request record are copied to this field when a product issue is created from a service request.</td>
</tr>
<tr>
<td>Corrective Actions</td>
<td>Codes</td>
<td></td>
<td>Typically, codes of type Corrective Action are entered in this field, although any type of code can be entered.</td>
</tr>
<tr>
<td>Investigation</td>
<td>Method Codes</td>
<td></td>
<td>Only codes of type Method can be entered.</td>
</tr>
<tr>
<td></td>
<td>Result Codes</td>
<td></td>
<td>Only codes of type Result can be entered.</td>
</tr>
<tr>
<td></td>
<td>Conclusion Codes</td>
<td></td>
<td>Only codes of type Conclusion can be entered.</td>
</tr>
<tr>
<td></td>
<td>Non-Evaluation Codes</td>
<td></td>
<td>Only codes of type Non-Evaluation can be entered.</td>
</tr>
<tr>
<td>Importer MDV</td>
<td>Patient Codes</td>
<td></td>
<td>Only codes of type Patient can be entered.</td>
</tr>
<tr>
<td></td>
<td>Device Codes</td>
<td></td>
<td>Only codes of type Device can be entered.</td>
</tr>
<tr>
<td>Repairs</td>
<td>More Info</td>
<td>Codes</td>
<td>Typically, codes of type Product Analysis are entered in this field, although any type of code can be entered.</td>
</tr>
<tr>
<td>Corrective Actions</td>
<td>More Info</td>
<td>Codes</td>
<td>Typically, codes of type Corrective Action are entered in this field, although any type of code can be entered.</td>
</tr>
</tbody>
</table>
An Example
When you set up codes, you can enter values for Product, Product Line, Category, Type, Area, and Sub Area that are associated with the code. Call center agents can use these values to search for and identify the correct code for a service request.

Table 34 is an example of the field values used to describe one code.

Table 34. Example Fields for a Code Classifying a Pump Error on a Blood Analyzer

<table>
<thead>
<tr>
<th>Field</th>
<th>Example Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Error 333</td>
</tr>
<tr>
<td>Description</td>
<td>Blood analyzer pump overflow.</td>
</tr>
<tr>
<td>Code Type</td>
<td>Device</td>
</tr>
<tr>
<td>Product</td>
<td>Blood Analyzer Model 350, Blood Analyzer Model 373</td>
</tr>
</tbody>
</table>
Capturing Adverse Events and Complaints ■ Setting Up Codes

How to Set Up Codes
Create the codes needed to classify your company’s adverse events and complaints.

Codes are needed for the procedures in this chapter and for procedures in the following AECM chapters.

This task is a step in “Process of Capturing and Escalating Adverse Events and Complaints” on page 363.

To set up codes

1. Navigate to Administration - Service screen > Code Administration view.
2. In the Code Admin list, create a new record, and complete the necessary fields.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Example Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Line</td>
<td>Blood analyzer, Dialysis system 1</td>
</tr>
<tr>
<td>Category</td>
<td>Nephrology</td>
</tr>
<tr>
<td>Type</td>
<td>Potential Complaint</td>
</tr>
<tr>
<td>Area</td>
<td>Software</td>
</tr>
<tr>
<td>Sub Area</td>
<td>Pump timing</td>
</tr>
</tbody>
</table>

Field can have multiple values.

### Table 34. Example Fields for a Code Classifying a Pump Error on a Blood Analyzer

<table>
<thead>
<tr>
<th>Field</th>
<th>Example Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name for the code. Typically this is a number or a letter number combination.</td>
</tr>
<tr>
<td>Code Type</td>
<td>Examples are: Method, Result, Conclusion, Device, Patient.</td>
</tr>
<tr>
<td>Product</td>
<td>Multiple products can be associated with a code.</td>
</tr>
<tr>
<td>Product Line</td>
<td>Multiple product lines can be associated with a code.</td>
</tr>
<tr>
<td>Category</td>
<td>A grouping of products. Only one category can be associated to a code. To set up categories, see Siebel Order Management Guide.</td>
</tr>
<tr>
<td>Type</td>
<td>Use to categorize the type of service request, for example, as a potential complaint. This is the same LOV used in service request and product issue records.</td>
</tr>
<tr>
<td>Area</td>
<td>The Type field constrains this drop-down list.</td>
</tr>
<tr>
<td>Sub Area</td>
<td>The Area field constrains this drop-down list.</td>
</tr>
</tbody>
</table>
Setting Up Lot Numbers for Medical Products

Create lot numbers for all batches of products that are tracked by lot number.

Lot numbers for Siebel Medical and Siebel Pharma are the same except that:

<table>
<thead>
<tr>
<th>For...</th>
<th>Lot numbers are set up in...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Siebel Medical</td>
<td>Administration - Service screen &gt; Lot Administration view</td>
</tr>
<tr>
<td>Siebel Pharma</td>
<td>Administration - Samples screen &gt; Lot Setup view</td>
</tr>
</tbody>
</table>

This task is a step in “Process of Capturing and Escalating Adverse Events and Complaints” on page 363.

To set up lot numbers

1. Navigate to Administration - Service screen > Lot Administration view.
2. In the Lot Admin list, create a new record, and complete the necessary fields.
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expiration Date</td>
<td>This information can be used for recalls of expired products.</td>
</tr>
<tr>
<td>Effective Start Date</td>
<td>The date of manufacture, the date on which the product was received, or another date defined by your company.</td>
</tr>
<tr>
<td>Lot #</td>
<td>Enter an unique value that corresponds to the lot number printed on the label of the product.</td>
</tr>
<tr>
<td>Product</td>
<td>The name of the product with which this lot number is affiliated. For more information, see “Defining Internal Products” on page 82 paying specific attention to Table 11 on page 83 and Table 12 on page 84.</td>
</tr>
<tr>
<td>Product Level</td>
<td>Applies only to drug samples.</td>
</tr>
</tbody>
</table>

Capturing Adverse Events and Complaints as Service Requests (End User)

The creation of the service request by the call center agent is often the first step in AECM.

The following procedure assumes that you are familiar with the service request screen and associated functionality. (For information about the service request screen, see Siebel Field Service Guide.)

This task is a step in “Process of Capturing and Escalating Adverse Events and Complaints” on page 363.
To create a service request

1. Navigate to the Service Requests screen > Service Request List view.
2. In the Service Request list, create a new record, and complete the necessary fields, such as account, contact, product, summary, and description.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codes</td>
<td>Codes to describe or categorize the service request.</td>
</tr>
<tr>
<td>Lot #</td>
<td>Select an existing lot number or enter a new lot number.</td>
</tr>
<tr>
<td></td>
<td>You can enter a new lot number in one of two ways:</td>
</tr>
<tr>
<td></td>
<td>▪ Formally enter a new lot number using the New button on the Lot Setup</td>
</tr>
<tr>
<td></td>
<td>dialog box.</td>
</tr>
<tr>
<td></td>
<td>▪ Use the Lot # field as a simple text field. If you enter a Lot # this</td>
</tr>
<tr>
<td></td>
<td>way, the value is only stored in this product issue record and is not</td>
</tr>
<tr>
<td></td>
<td>checked against a table of valid lot numbers. This does not create a</td>
</tr>
<tr>
<td></td>
<td>new lot # record in the Lot Administration view.</td>
</tr>
<tr>
<td>Product Issue</td>
<td>This is automatically flagged if the service request is escalated to a</td>
</tr>
<tr>
<td></td>
<td>product issue.</td>
</tr>
<tr>
<td>Type</td>
<td>Use this field to categorize the type of service request, for example, as</td>
</tr>
<tr>
<td></td>
<td>a potential complaint.</td>
</tr>
<tr>
<td>Area</td>
<td>The Type field constrains this drop-down list.</td>
</tr>
<tr>
<td>Sub Area</td>
<td>The Area field constrains this drop-down list.</td>
</tr>
</tbody>
</table>

3. Search for a solution to the service request:
   a. Drill down on a record.
   b. Click the Solutions view tab.
   c. Create a new record to the Solutions list.
   d. In the Add Solutions dialog box, query for a solution and add it.
   e. In the Solutions list, drill down on the Name field to see details about the solution.

   For more information about solutions, see Siebel Field Service Guide.

4. Set up activities for the service request using an activity plan. For example, the appointments the field service engineer can be set up from the Activities view.

   For more information about field service activities, see Siebel Field Service Guide.

5. Dispatch a field engineer.

   For more information about dispatch and scheduling, see Siebel Field Service Guide.
6 If products or materials need to be returned for analysis, set up an RMA order.

For more information about shipping and receiving, see *Siebel Field Service Guide*.

**Escalating Adverse Events and Complaints as Product Issues (End User)**

A valid adverse event or complaint that is first recorded as a service request should be transferred to a product issue record. As a product issue, it can be investigated by the quality manager. This allows the Call Center to retain ownership of the service request and the Quality team to manage the investigation and processing of the complaint.

**NOTE:** Only one product issue can be created from a given service request using the Create Product Issue button. Additional product issues for a service request can be created using the Create Related PI button in the Product Issues screen.

This procedure describes creating a product issue from the Service Requests screen. Product issue records can also be created in the Product Issues screen and the Site Management screen.

**TIP:** To aid call center agents with information gathering and problem diagnosis associated with adverse events and complaints, you may wish to set up SmartScripts. For more information about SmartScripts, see *Siebel SmartScript Administration Guide*.

This task is a step in "Process of Capturing and Escalating Adverse Events and Complaints” on page 363.

**To create a product issue from a service request**

1. Navigate to the Service Requests screen > Service Request List view.
2. Select the service request for which you want to create a product issue.
3. Click Create Product Issue.

This starts the Create a Product Issue from a Service Request workflow that:

- Makes these fields in the Service Request read-only:
  - Account
  - Last Name
  - First Name
  - Product

- Creates a product issue record from a Service Request.
- Copies these fields from the service request to the new product issue:
  - Account
  - Summary
  - Last Name
  - First Name
  - Description
  - Type
  - Area
  - Sub Area
  - Priority
  - Severity
  - Product
  - Codes
  - Asset #
  - Lot #
Adding Complaint-Specific Information to Product Issues (End User)

The call center agent enters complaint-specific information to the product issue record, for example, patient details. Information about only one patient can be associated with a product issue.

This task is a step in “Process of Capturing and Escalating Adverse Events and Complaints” on page 363.

To add information about the patient to the Product Issue record

2. Drill down on a product issue.
   
   **NOTE:** If you created the product issue using the Create Product Issue button in the Service Requests screen, the workflow takes you to this view.
3. Click the Patient view tab.
4. Complete the fields in the Patient form.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Identifier</td>
<td>None</td>
<td>A1</td>
</tr>
<tr>
<td>Gender</td>
<td>None</td>
<td>A3</td>
</tr>
<tr>
<td>Age</td>
<td>None</td>
<td>A2</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>None</td>
<td>A2</td>
</tr>
<tr>
<td>Weight</td>
<td>None</td>
<td>A4</td>
</tr>
<tr>
<td>U/M</td>
<td>Unit of measurement for weight</td>
<td>A4</td>
</tr>
</tbody>
</table>
About Configuring Adverse Events and Complaints Capture

There are two aspects of the Create Product Issue button that you can configure:

- The Create a Product Issue from a Service Request Workflow
- The fields that are copied from the Service Request to the Product Issue record

Create a Product Issue from a Service Request Workflow

This workflow (LS Medical Create PI from SR) is initiated from the Create Product Issue button on the Service Requests screen.

The workflow appears in Figure 13.

![Figure 13. LS Medical Create PI from SR Workflow](image)

The workflow does the following steps:

1. Checks if a product issue has already been created from this service request. If it has, the workflow ends. (Only one product issue can be created from a service request using the Create Product Issue button.)
2. Creates a new product issue.
3. Copies data from the service request to the product issue.

You can modify workflows to suit your own business model using Siebel Business Process Designer. For more information, see Siebel Business Process Framework: Workflow Guide.

Changing Which Fields Are Copied to the Product Issue

When the Create Product Issue button is used to create a product issue record from a service request record, data from various fields are copied from the service request record to the new product issue record.

To change which fields are copied when a product issue is created

- Use the Data Transfer Utilities to edit the LS Medical Create PI from SR data map object.
For information about the Data Transfer Utilities, see *Siebel Finance Guide*. 
This chapter covers the following topics:

- "About Investigating Adverse Events and Complaints” on page 375
- "Scenario for Complaint Investigation” on page 376
- "Process of Adverse Events and Complaints Investigation” on page 377
- “Creating Product Issue Assessment Templates” on page 377
- “Creating Product Issue Activity Templates” on page 377
- “Reviewing and Editing the Product Issues (End User)” on page 378
- “Creating Multiple Product Issues Related to One Service Request (End User)” on page 383
- “Creating Product Issue Activity Plans (End User)” on page 384
- “Assessing if a Product Issue Is Reportable (End User)” on page 385
- “Completing Adverse Events and Complaints Reviews (End User)” on page 385
- “About Configuring Create Related PI and Review Complete Buttons” on page 386
- “About the LS Medical Product Issue Service Business Service” on page 389

**About Investigating Adverse Events and Complaints**

This chapter describes review and investigation of a product complaint or adverse event using the Siebel Adverse Events and Complaints Management (Siebel AECM) module. This typically involves entering more information about the product issue, determining if the issue should be reported, and creating an activity plan for researching and addressing the issue.

**Where to Find More Information**

The following chapters describe other aspects of the complaints and adverse events management process:

- Chapter 23, “Capturing Adverse Events and Complaints”
- Chapter 25, “Recording Product Analysis for AECM”
- Chapter 26, “Managing CAPAs”
- Chapter 27, “Regulatory Reporting”
- Chapter 29, “Communicating with Customers for AECM”
- Chapter 28, “Closing Adverse Events and Complaints”
Scenario for Complaint Investigation

This scenario is an example process performed by the Siebel administrator and the quality manager. Your company may follow a different process according to its business requirements.

This process is designed to illustrate the functionality of the Siebel AECM.

The Siebel Administrator
The administrator sets up the assessment and activity templates that the quality manager uses in the course of investigating product issues.

Before creating templates, the administrator consults with the quality manager who thoroughly understands the company’s business processes. The quality manager suggests the text for the templates that administrator sets up and reviews the templates before roll out.

The Quality Manager
The quality manager reviews the complaints assigned to her. Her job is to determine if an investigation of the complaint is required and if the complaint needs to be reported to a regulatory agency.

The quality manager notices that a new product issue has been added to her queue. This complaint was initially reported as a service request and was escalated by a call center agent. It concerns a failure in a blood analyzer.

Upon taking ownership, the quality manager reviews the service request associated with the product issue, including the work done by the service engineer.

Next, the quality manager contacts the customer and obtains more details about the issue. She discovers that there are two product issues associated with this incident: the cartridge may have been faulty as reported in the service request, but also the third-party reagents used may have exacerbated the problem. The quality manager creates a second product issue to investigate the reagents.

To help guide the investigation and keep it on schedule, the quality manager applies an activity template that generates an activity plan — a list of activities that need to be carried out, some by her and some by other employees.

Her next step is to determine if the product issues are reportable. She answers the series of questions in the Assessments view and looks at the score. Scores of above 75% indicate that the product issues should be reported.

After completing the review, the quality manager changes the status of the product issue records to Review Complete. This locks down some data in the complaint file and makes other data read-only.
Process of Adverse Events and Complaints Investigation

This example process represents the tasks that are carried out in the Scenario for Complaint Investigation on page 376.

Administrator Procedures
- Creating Product Issue Assessment Templates on page 377
- Creating Product Issue Activity Templates on page 377

End-User Procedures
- Reviewing and Editing the Product Issues (End User) on page 378
- Creating Multiple Product Issues Related to One Service Request (End User) on page 383
- Creating Product Issue Activity Plans (End User) on page 384
- Assessing if a Product Issue Is Reportable (End User) on page 385
- Completing Adverse Events and Complaints Reviews (End User) on page 385

Creating Product Issue Assessment Templates

The purpose of the assessment is to quantify an evaluation of the product issue. The assessment template is made up of a series of questions about the product issue with an associated list of possible answers. Each question and each answer is assigned a weighting from which a single score is calculated.

This value can be used to indicate the risk associated with the issue or whether the issue should be reported to the regulatory agency.

This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.

To create an assessment template
- Refer to Siebel Applications Administration Guide for information about how to create assessment templates. Make sure to set the template type to Product Issue.

Creating Product Issue Activity Templates

Product issue activity templates are used to create a standard set of activities that the quality manager and other employees do to investigate product issues.
This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.

**To create a product issue activity template**
1. Navigate to the Administration - Data screen > Activity Templates view.
2. In the Activity Templates list, create a new record, and complete the necessary fields.
   a. Set the Type field to Product Issue.
   b. Leave these fields blank: Sales Stage, Sales Method, Protocol Title; they do not apply to product issue activities.
3. Associate individual activities with the template, as described in *Siebel Applications Administration Guide*.

**NOTE:** Lead times for product issue activities are defined as the amount of time between the start date for an activity plan and the date that the selected activity should start.

**Reviewing and Editing the Product Issues (End User)**

Early in the investigation, the quality manager reviews, updates, and adds information to the product issue record. This record becomes the adverse event or complaint file for the investigation.

There are many fields in the product issue record. Some are filled in by the call center agent, some automatically, and others by the quality manager. Of particular importance are those fields that are used to populate the regulatory reports. For more information, see Chapter 27, “Regulatory Reporting.”

This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.

**To review and edit a product issue**
2. Select a product issue.
3. Edit fields in the Product Issues list and form as required.
   Some fields are described in the following table.
   (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>The name of the account associated with the product issue.</td>
<td>E1</td>
</tr>
<tr>
<td>Address</td>
<td>Account address - street address.</td>
<td>E1</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
<td>Mapping to 3500A Form</td>
</tr>
<tr>
<td>----------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Alert Age</td>
<td>The number of days since the product issue was identified as reportable.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>If an initial report has been filed, the alert age is the number of days</td>
<td></td>
</tr>
<tr>
<td></td>
<td>that the product issue was marked reportable before the report was filed.</td>
<td></td>
</tr>
<tr>
<td>Alert Date</td>
<td>The date when a representative of a company becomes aware that the event</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>needs to be reported.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, when:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A call center agent captures the adverse event or complaint.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- An assessment indicates that the event is reportable.</td>
<td></td>
</tr>
<tr>
<td>Area</td>
<td>The general categorization area for the product issue.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>This field is constrained by Type.</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>Account address - city.</td>
<td>E1</td>
</tr>
<tr>
<td>Contacts</td>
<td>The last name of the customer contact associated with the product issue.</td>
<td>E1</td>
</tr>
<tr>
<td>(Contact Last Name in list)</td>
<td>These contacts can also be entered using the Contacts view of the Product</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Issues screen &gt; Contacts view.</td>
<td></td>
</tr>
<tr>
<td>CSN</td>
<td>Customer service number. A unique number to identify the account.</td>
<td>E1</td>
</tr>
<tr>
<td>Evaluation</td>
<td>This field appears in the list applet. It also appears in the form in the</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Investigation view.</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the investigator carrying out a particular clinical trial</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>at a site.</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the customer contact associated with the product issue.</td>
<td>E1</td>
</tr>
<tr>
<td>(Contact First Name in list)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Investigator</td>
<td>The last name of the investigator carrying out a particular clinical trial</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>at a site.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the product issue is associated with a clinical trial, this field is</td>
<td></td>
</tr>
<tr>
<td></td>
<td>auto-populated with the last name of the investigator at the protocol site,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>specified in the Protocol number field.</td>
<td></td>
</tr>
<tr>
<td>Mfg Report #</td>
<td>This field appears in the list applet. It also appears in the form in the</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Importer view.</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
<td>Mapping to 3500A Form</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Occupation</td>
<td>Occupation of the contact.</td>
<td>E3</td>
</tr>
<tr>
<td></td>
<td>This is copied from the value of the Type field in the Contacts screen.</td>
<td></td>
</tr>
<tr>
<td>Open Age</td>
<td>The number of days since the product issue was opened, or, if the product issue is closed, this is the number of days that the product issue was open.</td>
<td>None</td>
</tr>
<tr>
<td>Phone #</td>
<td>Contact’s work phone number.</td>
<td>E1</td>
</tr>
<tr>
<td>PI #</td>
<td>Unique number to identify the product issue. It is auto-generated when the product issue is created.</td>
<td>None</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Account address - postal code.</td>
<td>E1</td>
</tr>
<tr>
<td>Protocol #</td>
<td>Protocol number identifies the clinical trial at a site. If regulatory report is an IND safety report, enter the protocol number.</td>
<td>G6</td>
</tr>
<tr>
<td>Provider</td>
<td>Indicates if the contact is a health professional.</td>
<td>E2</td>
</tr>
<tr>
<td>Received (Received Date in the list)</td>
<td>The date when a company representative became aware of the event.</td>
<td>None</td>
</tr>
<tr>
<td>Reported FDA</td>
<td>Indicates if initial reporter sent a report to the FDA.</td>
<td>E4</td>
</tr>
<tr>
<td>SR #</td>
<td>The service request from which the product issue was created.</td>
<td>None</td>
</tr>
<tr>
<td>State</td>
<td>Account address - state.</td>
<td>E1</td>
</tr>
<tr>
<td>Status</td>
<td>The current status of the product issue.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>The status of the product issue can be changed by the owner of the product issue, using the Review Complete, Close, and Reopen buttons.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Changes to this field are tracked in the Approvals view.</td>
<td></td>
</tr>
<tr>
<td>Sub Area</td>
<td>This further refines the area categorization. (The Area field constrains this drop-down list.)</td>
<td>None</td>
</tr>
<tr>
<td>Sub Status</td>
<td>The Status field constrains this drop-down list.</td>
<td>None</td>
</tr>
</tbody>
</table>
In the Event Detail form edit fields as required.

Some fields are described in the following table. (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Type</td>
<td>Describes the type of event.</td>
<td>B1</td>
</tr>
<tr>
<td>Event Date</td>
<td>The approximate date of the adverse event.</td>
<td>B3</td>
</tr>
<tr>
<td>Description (Event Description in the list)</td>
<td>Detailed description of the event</td>
<td>B5</td>
</tr>
<tr>
<td># Occurrences</td>
<td>Number of times the event occurred before it was reported</td>
<td>None</td>
</tr>
<tr>
<td>External Products</td>
<td>List of other medical products (for example, drugs, medical devices) used by patient at the time of the event and dates of use</td>
<td>C10 or D11</td>
</tr>
<tr>
<td>Tests/Data</td>
<td>All appropriate relevant test and laboratory findings and dates</td>
<td>B6</td>
</tr>
<tr>
<td>Life Threatening</td>
<td>Life Threatening</td>
<td>B2</td>
</tr>
<tr>
<td>Disability</td>
<td>Disability</td>
<td>B2</td>
</tr>
<tr>
<td>Hospitalization</td>
<td>Hospitalization</td>
<td>B2</td>
</tr>
<tr>
<td>Congenital Anomaly</td>
<td>Congenital Anomaly</td>
<td>B2</td>
</tr>
<tr>
<td>Relevant History</td>
<td>Relevant history, including preexisting medical conditions</td>
<td>B7</td>
</tr>
<tr>
<td>Death</td>
<td>Death</td>
<td>B2</td>
</tr>
<tr>
<td>Required Intervention</td>
<td>Required Intervention</td>
<td>B2</td>
</tr>
<tr>
<td>Date of Death</td>
<td>Date of Death</td>
<td>B2</td>
</tr>
<tr>
<td>Other</td>
<td>Describe the reported outcome if it was not covered in the above selections</td>
<td>B2</td>
</tr>
</tbody>
</table>
In the Products list, create records and edit fields as required.

Some fields are described in the following table. (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>The name of the product associated with the event</td>
<td>C1</td>
</tr>
<tr>
<td>Lot #</td>
<td>Lot number of the product</td>
<td>C6, D4</td>
</tr>
<tr>
<td>Asset #</td>
<td>Asset number for the product</td>
<td>D4</td>
</tr>
<tr>
<td>Serial #</td>
<td>Serial number for the asset</td>
<td>D4</td>
</tr>
<tr>
<td>Mfg Name</td>
<td>Full name of the manufacturer of the product</td>
<td>D3</td>
</tr>
<tr>
<td>Mfg Date</td>
<td>The date the product was manufactured</td>
<td>H4</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Expiration date of the lot or product</td>
<td>C7, D4</td>
</tr>
<tr>
<td>Labeled Single Use</td>
<td>Indicates if the device is labeled for single use</td>
<td>H5</td>
</tr>
<tr>
<td>Device Operator</td>
<td>Type of person operating or using the suspect medical product on the patient at the time of the event</td>
<td>D5</td>
</tr>
<tr>
<td>Device Available</td>
<td>Indicates if the device is available for evaluation by the manufacturer</td>
<td>D10</td>
</tr>
<tr>
<td>Return Date</td>
<td>Date that the device was shipped to the manufacturer</td>
<td>D10</td>
</tr>
<tr>
<td>Device Type</td>
<td>Generic or common name of the suspect medical device</td>
<td>D2</td>
</tr>
<tr>
<td>Reprocessed</td>
<td>Indicate if this is a single-use device that was reprocessed and reused on a patient</td>
<td>D8</td>
</tr>
<tr>
<td>Reprocessor</td>
<td>Name and address of the reprocessor of the reused single-use device</td>
<td>D9</td>
</tr>
<tr>
<td>NDC#</td>
<td>National drug code #</td>
<td>C9</td>
</tr>
<tr>
<td>Part #</td>
<td>Part number</td>
<td>D4</td>
</tr>
<tr>
<td>Implant Date</td>
<td>The implant date or best estimate for medical devices that are implanted in the patient</td>
<td>D6</td>
</tr>
<tr>
<td>Explant Date</td>
<td>The date or best estimate for medical devices removed from a patient</td>
<td>D7</td>
</tr>
<tr>
<td>Street Address</td>
<td>Manufacturer’s street address</td>
<td>D3</td>
</tr>
<tr>
<td>City</td>
<td>Manufacturer’s address: City</td>
<td>D3</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Manufacturer’s address: Postal Code</td>
<td>D3</td>
</tr>
</tbody>
</table>
Review any service requests associated with the product issue:

- a Drill down on the product issue record.
- b Click the Service Request view tab.
- c Drill down on the SR #.

Creating Multiple Product Issues Related to One Service Request (End User)

Only one product issue can be created directly from a service request (using the Create Product Issue button on the Service Requests screen). However, in the Product Issues screen, the quality manager can create additional product issues related to the service request and the original product issue.

Here are some examples where multiple product issue records are needed:

- A medical kit contains a drug and a device. The drug and the device may have caused the event. Separate adverse event and product complaint investigations have to be completed.
- There are several products involved with the adverse event or complaint and the quality manager wants a unique product issue for each product.
To create a new product issue

2. Drill down on a product issue.
3. Click Create Related PI.
   
   This starts a workflow (LS Medical Product Issue Create Related PI), which creates a new product issue record, copying fields from the current product issue.
   
   For more information about the workflow, see “About Configuring Create Related PI and Review Complete Buttons” on page 386.
4. Edit fields in the Event Detail form as required.
5. Enter information about the products associated with the issue in the Products list.

Creating Product Issue Activity Plans (End User)

A product issue activity plan is a list of activities associated with the product issue. The quality manager applies an activity template, suited to the type of product issue being investigated. The activity template sets up predefined activities that the quality manager and others follow to complete the product issue investigation.

This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.

To create activities for product issue investigation using a template

2. Drill down on a product issue.
3. Click the Activity Plans view tab.
4. In the Activity Plans list, create a new record, and complete the necessary fields.
   
   Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Start</td>
<td>Make sure that this date is correct before you choose a template. The due dates for the template-generated activities are based on this start date and on the lead time set in the template.</td>
</tr>
<tr>
<td>Template</td>
<td>Only templates whose type is Product Issue can be selected in this field.</td>
</tr>
</tbody>
</table>

5. Edit the activities in the Activities list or create more activities.
Assessing if a Product Issue Is Reportable (End User)

Assessments allow end users to calculate a single numerical value based on their answers to questions about the product issue. An quality manager can then use the assessment score to decide how to proceed with the investigation.

These are some example assessment questions used to determine if a product needs to be reported:

- Was there any patient injury? {No, Mild, Moderate, Severe}
- Was there a labeling problem? {No, Yes}
- Did the product function according to specification? {No, Yes}

**TIP:** An alternate way to assess product issues is by using a SmartScript which guides the quality manager through a series of questions using a decision tree. For more information about SmartScripts, see *Siebel SmartScript Administration Guide*.

This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.

**To assess a product issue**

2. Drill down on a product issue.
3. Click the Assessments view tab.
4. In the Assessments list, create a new record.
5. In the Template Name field, select the assessment template that has been prepared for you. The application fills in other fields in the record when the record is saved.
6. In the Assessment Attributes list, enter a value for each attribute.
   
   The assessment score and percentage are calculated and shown in the Assessments list.

Completing Adverse Events and Complaints Reviews (End User)

The exact meaning of the adverse event or complaint review status depends upon your business process. For example, it could indicate that there is sufficient data to begin a second phase of the investigation (trend analysis and recreation of the problem in the lab).

As part of the review process, the quality manager changes the status the record to Review Complete. An important effect of changing the status of a product issue to Review Complete is that a number of key fields are locked down and others are made read-only.

This task is a step in “Process of Adverse Events and Complaints Investigation” on page 377.
To complete a review of a product issue

2. Select a product issue.
3. Click Review Complete.

   This starts a workflow (LS Medical Product Issue Review Complete) that:
   ■ Changes the status of the product issue to Review Complete
   ■ Authenticates the user
   ■ Locks down these fields:
     - Primary Contact first and last names
     - Contact work phone #
     - Reported By
     - Account Name
     - Account Address
     - Product
     - Device Type
     - Part #
   ■ Makes these fields read-only:
     - Account
     - Account Address
     - Date of Event
     - Summary
     - All patient information (on Patient view)
     - Description

For more information about the workflow, see "About Configuring Create Related PI and Review Complete Buttons" on page 386. For more information about field lockdown, see Chapter 28, "Closing Adverse Events and Complaints."

About Configuring Create Related PI and Review Complete Buttons

There are two buttons associated with adverse events and complaints investigation. You can configure the workflows and fields copied for these buttons.

■ LS Medical Product Issue Create Related PI Workflow
■ Changing Which Fields Are Copied to the New Product Issue
■ LS Medical Product Issue Review Complete Workflow
■ LS Medical User Verification Workflow

You can modify workflows to suit your own business model using Siebel Business Process Designer. For more information, see Siebel Business Process Framework: Workflow Guide.

LS Medical Product Issue Create Related PI Workflow

This workflow is initiated from the Create Related PI button on the Product Issues screen.
The workflow appears in Figure 14.

![Figure 14. LS Medical Product Issue Create Related PI Workflow](image)

The workflow does the following steps:
2. Copies data from the original product issue to the new product issue.
3. Makes the new product issue the active record.

**Changing Which Fields Are Copied to the New Product Issue**

When the Create Related PI button is used to create a product issue, data from various fields are copied from the original product issue record to the new product issue record.

*To change which fields are copied when a product issue is created*

- Use the Data Transfer Utilities to edit the LS Medical PI Create Related PI data map object.

For information about the Data Transfer Utilities, see the *Siebel Finance Guide*.

**LS Medical Product Issue Review Complete Workflow**

This workflow is initiated from the Review Complete button on the Product Issues screen.

The workflow appears in Figure 15.

![Figure 15. LS Medical Product Issue Review Complete Workflow](image)

The workflow does the following steps:
1. Checks if the user is the primary owner of the product issue. If not, the workflow ends.
Checks if the product issue has already been processed. If it has, the workflow ends.

Calls the LS Medical User Verification workflow.

If the user authentication is successful, copies the lockdown fields, makes some fields read-only, and changes the status to Review Complete.

**LS Medical User Verification Workflow**

This workflow authenticates the user's name and password. This workflow is called from other workflows.

**TIP:** You can configure the User Verification workflow to capture the user name and password of two users.

The workflow appears in Figure 16.

The workflow does the following steps:

1. Calls the Authentication business service to verify the user name and password. The Authentication business service calls two methods to perform this action as follows:

   - **ValidateSessionUser.** This method validates that the logged-in user is the current session user.
   - **Authenticate.** This method checks that the supplied username and password are valid in the system.

2. If the authentication passes, returns to the original view and sets the result code to 100—passed.
3. If the user name and password are expired, shows an error dialog box and sets the result code to 200—expired.

4. If the authentication fails, increases the result code by 1 and on the third failure logs the user out of the application.

About the LS Medical Product Issue Service Business Service

The LS Medical Product Issue Service is based on the class CSSServiceLSProductIssue. It is a placeholder for the business services used by Siebel AECM.

Customizing the LS Medical Product Issue Service

The LS Medical Product Issue Service business service is written in C++ and cannot be modified. However, the methods in this business service are modular and can be used in workflows that you create.

The LS Medical Product Issue Service Business Service Methods

The LS Medical Product Issue Service has three methods. These are described in Table 35.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Used in Workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>GenerateReportNum</td>
<td>Generates report numbers for MedWatch and MDV reports as follows.</td>
<td>LS Medical Product Issue RR Submit</td>
</tr>
<tr>
<td></td>
<td><em>If the Report Is...</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Then the Method...</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td>An initial report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Generates a new report number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A supplemental report</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Takes the report number from the initial report.</td>
<td></td>
</tr>
<tr>
<td>Logoff</td>
<td>Logs out the user.</td>
<td>LS Medical User Verification</td>
</tr>
<tr>
<td>Query</td>
<td>Queries with the input search spec and sort spec.</td>
<td>LS Medical Create Related Product Issue</td>
</tr>
</tbody>
</table>
This chapter covers the following topics:

- "About Recording Product Analysis for AECM" on page 391
- "Scenario for Product Analysis Arising from a Complaint" on page 392
- "Process of Product Analysis Following a Product Issue" on page 393
- "Creating Product Analysis Activity Templates" on page 393
- "Setting Up Codes for Product Analysis" on page 394
- "Creating Product Analysis Records from a Product Issue (End User)" on page 394
- "Filling in Product Analysis Records (End User)" on page 395
- "Completing Product Analysis and Creating CAPAs (End User)" on page 395
- "Submitting Product Analysis Records (End User)" on page 396
- "Approving or Rejecting Product Analysis Records (End User)" on page 397
- "About Configuring Product Analysis Approvals" on page 398

About Recording Product Analysis for AECM

This chapter describes how to use the Siebel application during the product analysis phase of an adverse events and complaints investigation.

When a faulty product is returned to the manufacturer for study, a product analysis record is opened. This record documents details of the analysis. When the analysis is complete, root cause and corrective action information are added and the record is submitted for approval.

Where to Find More Information

The following chapters describe other aspects of the complaints and adverse events management process:

- Chapter 23, “Capturing Adverse Events and Complaints”
- Chapter 24, “Investigating Adverse Events and Complaints”
- Chapter 26, “Managing CAPAs”
- Chapter 27, “Regulatory Reporting”
- Chapter 29, “Communicating with Customers for AECM”
- Chapter 28, “Closing Adverse Events and Complaints”
Scenario for Product Analysis Arising from a Complaint

This scenario is an example process performed by the Siebel administrator, the manager of the product analysis team, a team member, and the quality manager. Your company may follow a different process according to its business requirements.

This process is designed to illustrate the functionality of the Siebel AECM.

Introduction
A customer had a problem with a new blood analyzer system. The analyzer’s cartridge was determined to be faulty, and the customer returned it to the manufacturer for analysis. The quality manager has already opened a product complaint file (product issue record) for this problem.

The Siebel Administrator
The administrator sets up the activity templates that the product analysis team uses in the course of analyzing product issues. Before creating these templates, the administrator consults with the quality manager and reviews the company’s S.O.P (standard operating procedure) for product analysis.

The administrator checks that all the necessary codes for product analysis have been set up as appropriate for the company’s business process and products.

Quality Manager
The initial review of the product complaint has been completed and the faulty cartridge has been sent by the customer. The quality manager creates a product analysis record in the complaint file. She assigns a member of the product analysis team to be the primary owner of the product analysis record.

Member of the Product Analysis Team
The decontamination unit initially receives and processes the faulty cartridge. After decontamination, the cartridge is sent to a member of the product analysis team. He records receipt of the faulty cartridge, reviews the product analysis record associated with this complaint, and begins analysis of cartridge.

During the course of the analysis, the team member creates activities to keep track of the analysis steps. He records the results of the analysis. At the conclusion of the analysis, he records the root cause of the problem and proposes corrective action.

When analysis of the cartridge is complete, the team member submits the product analysis information for approval.
**Quality Manager and Product Analysis Manager**

Both the manager of the product analysis team and the owner of the product complaint file are required to approve the product analysis. When they review their Inboxes, they learn that the product analysis is complete and ready for approval. Individually, they review and approve the product analysis.

**Process of Product Analysis Following a Product Issue**

This example process represents the tasks that are carried out in the Scenario for Product Analysis Arising from a Complaint on page 392.

**Administrator Procedures**

- Creating Product Analysis Activity Templates on page 393
- Setting Up Codes for Product Analysis on page 394

**End-User Procedures**

- Creating Product Analysis Records from a Product Issue (End User) on page 394
- Filling in Product Analysis Records (End User)
- Completing Product Analysis and Creating CAPAs (End User) on page 395
- Approving or Rejecting Product Analysis Records (End User) on page 397

**Creating Product Analysis Activity Templates**

Product analysis activity templates are used to create standard sets of activities that the product analysis team use to guide them as they carry out decontamination procedures, validation tests, and so on.

This task is a step in “Process of Product Analysis Following a Product Issue” on page 393.

**To create a product analysis activity template**

1. Navigate to the Administration - Data screen > Activity Templates view.
2. In the Activity Templates list, create a new record, and complete the necessary fields.
   a. Set the Type field to Repair.
   b. Leave these fields blank: Sales Stage, Sales Method, and Protocol Title; they do not apply to product analysis activities.
3. Associate individual activities with the template, as described in Siebel Applications Administration Guide.

Setting Up Codes for Product Analysis

The administrator defines the codes that are used to categorize product analysis.

This task is a step in “Process of Product Analysis Following a Product Issue” on page 393.

To set up codes for Product Analysis

■ See “Setting Up Codes” on page 365.

NOTE: Typically, you create codes of type Product Analysis for use with Product Analysis records. However, all types of codes can be associated with Product Analysis records.

Creating Product Analysis Records from a Product Issue (End User)

The first task in analyzing a defective product is to create a product analysis record. The product analysis record captures information from the associated product issue and serves as a repository for all information associated with the product analysis.

Typically, the product analysis record is created by the quality manager who has access to the Product Issues screen. The quality manager can then assign the product analysis to a member of the analysis team who has access to the Repairs screen but not necessarily to the Product Issues screen.

The product analysis record is a repair record of type Product Issue Analysis. For information about the Repairs screen, see Siebel Field Service Guide.

This task is a step in “Process of Product Analysis Following a Product Issue” on page 393.

To create and assign the product analysis record

2. Drill down on a product issue.
3. Click the Product Analysis view tab.
4. Create a new product analysis record.
   Account, product, asset number, lot number, and service request number are copied from the product issue to the new product analysis record.
5. Click the Repair # to drill down to the product analysis record in the Repairs screen.
6. Complete the Owners field.
   If Assignment Manager is set up, you can assign an owner by clicking the menu button and selecting Assign.
### Filling in Product Analysis Records (End User)

The product analysis team member records information such as the results of decontamination and validation tests.

This task is a step in "Process of Product Analysis Following a Product Issue" on page 393.

#### To complete a product analysis
1. Navigate to Repairs screen > Repair List view.
2. Select a product analysis.
3. Complete the fields.
   - Some fields are described in the following table. Other fields are described in *Siebel Field Service Guide*.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codes</td>
<td>Codes to describe or categorize the product analysis. Typically, select codes of type Product Analysis.</td>
</tr>
<tr>
<td>Product</td>
<td>The primary product associated with the product issue.</td>
</tr>
<tr>
<td>Received</td>
<td>Defaults to the date and time that the record was created.</td>
</tr>
<tr>
<td>Repair #</td>
<td>A unique identifying number for the repair. Automatically populated.</td>
</tr>
<tr>
<td>Type</td>
<td>Defaults to Product Issue Analysis.</td>
</tr>
</tbody>
</table>

4. Create activities in the Activity Plans view.
5. Attach documents in the Attachments view.
6. Add notes in the Notes view.

### Completing Product Analysis and Creating CAPAs (End User)

At the conclusion of the product analysis, the product team member adds information about the root cause of the problem and initiates corrective and preventive actions (CAPA).

This task is a step in "Process of Product Analysis Following a Product Issue" on page 393.

#### To add root cause and corrective actions to a product analysis record
1. Navigate to Repairs screen > Repair List view.
2. Drill down on a product analysis record.
3 Complete the Root Cause field.
4 Add corrective actions to the record:
   a Click the Corrective Actions view tab.
   b Click Add or New.

<table>
<thead>
<tr>
<th>If the corrective action...</th>
<th>Click...</th>
<th>And...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Already exists</td>
<td>Add</td>
<td>Select a corrective action from the Add Corrective Actions window</td>
</tr>
<tr>
<td>Is new</td>
<td>New</td>
<td>Complete the fields in the new CAPA record</td>
</tr>
</tbody>
</table>

For more information about CAPAs, see Chapter 26, “Managing CAPAs.”

### Submitting Product Analysis Records (End User)

Once the root cause has been recorded and corrective actions initiated, the product analysis is ready to be submitted for approval.

Here are some restrictions on submitting a product analysis record:

- Only the primary owner of the product analysis record can submit it.
- The owner of the product analysis must have a manager.
- The product analysis must have a product issue associated with it.
- The associated product analysis must have an owner.

**NOTE:** These restrictions can be modified to meet your business needs. For information about configuring the submit workflow see “About Configuring Product Analysis Approvals” on page 398.

This task is a step in “Process of Product Analysis Following a Product Issue” on page 393.

### To submit a product analysis

1. Navigate to Repairs screen > Repair List view.
2. Select a product analysis.
3. Click Submit.
   
   This starts a workflow (LS Medical PA Submit) that sends requests for approval to the Inboxes of the designated approvers. For more information about the workflow, see “About Configuring Product Analysis Approvals” on page 398.

   **NOTE:** If you submit a product analysis record in error, click the Withdraw button to unsubmit it. This starts the LS Medical PA Withdraw workflow. For more information about the workflow, see “About Configuring Product Analysis Approvals” on page 398.
4 Verify that the product analysis was submitted to the correct approvers:
   a Drill down on the product analysis.
   b Click the Approval History view tab.
      The list should contain three records for:
         ❑ The primary owner (This should already be approved)
         ❑ The primary owner’s manager
         ❑ The product issue’s primary owner

***Approving or Rejecting Product Analysis Records (End User)***

Depending on your business process, an approved product analysis may be required before corrective actions can be taken.

In the preconfigured application, the required approvers for product analysis records are:

■ The manager of the product analysis primary owner
■ The primary owner of the product issue record that generated product analysis

This task is a step in “Process of Product Analysis Following a Product Issue” on page 393.

**To approve a product analysis record**

1 Navigate to Inbox screen > Inbox Items List view.
2 Review and approve the item.
   The status of the product analysis becomes Closed and the sub status becomes Approved.

**To reject a product analysis record**

1 Navigate to Inbox screen > Inbox Items List view.
2 Review and reject the item.
   The status of the product analysis becomes Rejected. (The product analysis team member can submit the record again.)
   If Manager 1 rejects the item before Manager 2 takes action on it, Manager 2 never sees the item (it is deleted from Manager 2’s Inbox when it is rejected by Manager 1).

For more information about the Inbox, see *Siebel Applications Administration Guide*. 
About Configuring Product Analysis Approvals

There are two buttons associated with adverse events and complaints investigation. You can configure the workflows for these buttons.

- Submit button (LS Medical PA Submit Workflow)
- Withdraw button (LS Medical PA Withdraw Workflow)

You can modify workflows to suit your own business model using Siebel Business Process Designer. For more information, see *Siebel Business Process Framework: Workflow Guide*.

LS Medical PA Submit Workflow

This workflow is initiated from the Submit button on the Repairs screen.

The workflow appears in Figure 17.

Figure 17. LS Medical PA Submit Workflow

This workflow does the following steps:

1. Checks if the current record has already been submitted. If it has, the workflow ends.
Checks if the current record has an owner, if the owner has a manager, and if the product issue record that generated this record has a primary owner. If these criteria are not met, the workflow ends.

3. Calls the LS Medical User Verification workflow. If the authentication does not pass, the workflow ends.

4. Sets the status to Submitted and the sub-status to Waiting.

5. Deactivates any approval record associated with the current product analysis record.

6. Creates an inactive approval record for the current owner (for record purposes).

7. Creates approval items for the owner’s manager and for the owner of the product issue.

### LS Medical PA Withdraw Workflow

This workflow is initiated from the Withdraw button on the Repairs screen.

The workflow appears in **Figure 18**.

---

**Figure 18. LS Medical PA Withdraw Workflow**

This workflow does the following steps:

1. Checks if the current record has already been submitted. If it has not, the workflow ends.
2. Checks if the user is the primary owner. If not, the workflow ends.
3. Calls the LS Medical User Verification workflow. If the authentication does not pass, the workflow ends.
4. Sets the status to Reopen.
5. Deactivates any approval record associated with the current product analysis record.
Managing CAPAs

This chapter covers the following topics:

- "About Managing CAPAs" on page 401
- "Scenario for Managing CAPAs" on page 402
- "Process of Managing CAPAs" on page 403
- "Creating Corrective Action Activity Templates" on page 403
- "Setting Up Codes for CAPAs" on page 404
- "Creating a CAPA Record (End User)" on page 404
- "Managing CAPAs (End User)" on page 406
- “Tracking Approvals and Other Changes to CAPAs (End User)” on page 406
- "About Configuring CAPA Approvals" on page 407

About Managing CAPAs

This chapter describes recording and managing corrective actions and preventive actions for Siebel Adverse Events and Complaints Management (Siebel AECM). Table 36 defines and distinguishes these two terms. But generally, corrective and preventive actions are called CAPAs; this is how they will be referred to generically in this chapter.

Table 36. Terms Defined with Examples

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition from ISO 8402</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Corrective Action</td>
<td>Action taken to eliminate the causes of an existing non-conformity, defect, or other undesirable situation in order to prevent recurrence.</td>
<td>When devices were returned because of damage caused by electrostatic discharge (ESD) during assembly, the corrective actions were (i) implementation of ESD controls and (ii) ESD control training for operators.</td>
</tr>
<tr>
<td>Preventative Action</td>
<td>Action taken to eliminate the cause of a potential non-conformity, defect, or other undesirable situation in order to prevent occurrence.</td>
<td>When control charts indicated the diameter of a molded part was drifting towards the upper limit, the preventive action was to replace the mold and validate that the new parts met the specifications.</td>
</tr>
</tbody>
</table>
Managing CAPAs ■ Scenario for Managing CAPAs

The CAPA record in Siebel AECM is designed to contain all information about a corrective or preventive action: from its creation through planning and implementation through authentication, closure and beyond.

Where to Find More Information
The following chapters describe other aspects of the complaints and adverse events management process:

■ Chapter 23, “Capturing Adverse Events and Complaints”
■ Chapter 24, “Investigating Adverse Events and Complaints”
■ Chapter 25, “Recording Product Analysis for AECM”
■ Chapter 27, “Regulatory Reporting”
■ Chapter 29, “Communicating with Customers for AECM”
■ Chapter 28, “Closing Adverse Events and Complaints”

Scenario for Managing CAPAs
This scenario is an example process performed by the Siebel administrator, and the CAPA team. Your company may follow a different process according to its business requirements.

This process is designed to illustrate the functionality of Siebel AECM.

The Siebel Administrator
The administrator sets up the activity templates that the CAPA team members use in the course of planning, implementing, and verifying CAPAs.

Before creating these templates, the administrator consults with the CAPA team. It is very important that the activities defined by the template accurately and completely reflect the company’s policies and procedures for the handling of CAPAs.

The administrator also checks the necessary codes for CAPA have been set up as appropriate for the company’s business needs.

The CAPA Team Members
The product analysis team has alerted the CAPA team that some of the cartridges used in the new blood analyzer are out of tolerance and that this is causing them to jam in the analyzer. The CAPA team is responsible for correcting this problem.

The CAPA manager creates a corrective action record. He fills in all the information known about the problem and its root cause, including the associated product analysis and product issue records. The CAPA team use this record as the project file, referring and adding to it throughout the life cycle of the CAPA.
All information associated with the CAPA is stored and accessible from this record. The information takes a variety of forms, from short comments where employees share information about recent actions and findings, to longer notes (both public and private), and large documents such as reports and specs that are saved as file attachments.

The CAPA manager uses the activity template to generate a standard set of activities that outline the team’s standard operating procedure for implementing CAPAs. He assigns the activities to members of his team. The manager uses the list of activities to monitor the progress of the CAPA; noting the start and end dates and which activities have been completed and which are still to be done.

CAPA team members are assigned activities, with start and due dates. They carry out their assigned activities, recording the tools and parts used, how long each activity takes to complete, and the results and measurements obtained.

Major milestone dates, both target and actual, are recorded on the main form of the CAPA record. Also the approval history of the CAPA record is tracked as changes in the CAPA’s status are made, from Open, through Approved, to Verification.

**Process of Managing CAPAs**

This example process represents the tasks that are carried out in the Scenario for Managing CAPAs on page 402.

**Administrator Procedures**

- Creating Corrective Action Activity Templates on page 403
- Setting Up Codes for CAPAs on page 404

**End-User Procedures**

- Creating a CAPA Record (End User) on page 404
- Managing CAPAs (End User) on page 406
- Tracking Approvals and Other Changes to CAPAs (End User) on page 406

**Creating Corrective Action Activity Templates**

Corrective action activity templates are used to create a standard sets of activities that the CAPA team follow as they plan, implement, and verify a CAPA.

This task is a step in “Process of Managing CAPAs” on page 403.

**To create a corrective action activity template**

1. Navigate to the Administration - Data screen > Activity Templates view.
2 In the Activity Templates list, create a new record, and complete the necessary fields.
   a Set the Type field to Corrective Action.
   b Set start and end dates for the activities by specifying Lead Times and Durations.
   c Leave these fields blank: Sales Stage and Sales Method; they do not apply to product issue activities.
3 Associate individual activities with the template, as described in Siebel Applications Administration Guide.

Setting Up Codes for CAPAs
The administrator defines the codes that are used to categorize CAPAs and their root causes.
This task is a step in “Process of Managing CAPAs” on page 403.

To set up codes for CAPAs
See "Setting Up Codes" on page 365.

   NOTE: Typically, you create codes of type Corrective Action for use with CAPA records. However, all types of codes can be associated with CAPA records.

Creating a CAPA Record (End User)
Corrective actions can be created and viewed in these screens:

   ■ Corrective Actions. When a CAPA record is created in this screen, no default type is associated with the CAPA.
   ■ Product Issues. When a CAPA record is created in this screen, the default type is Product Issue.
   ■ Repairs. When a CAPA record is created in this screen, the default type is Product Analysis.

When a CAPA is created from the Product Issues or the Repairs screen, a CAPA number is assigned automatically. You can configure the application to copy information from the Product Issue or the Product Analysis record to the CAPA record. Review the configuration of the Create Product Issue button (see “About Configuring Adverse Events and Complaints Capture” on page 373) for an example of a similar configuration.
This task is a step in “Process of Managing CAPAs” on page 403.

To create a CAPA record in the Corrective Actions screen
1 Navigate to the Corrective Actions screen > Corrective Action List view.
2 Create a new record and complete the necessary fields.

Only some fields described in the following table are filled in when the CAPA is first created; other fields are filled in later in the CAPA investigation.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounts</td>
<td>The accounts requiring the fix.</td>
</tr>
<tr>
<td>Actual Fixed</td>
<td>The date when the fix was actually implemented.</td>
</tr>
<tr>
<td>Area</td>
<td>Classification for the corrective action. The Type field constrains this drop-down list.</td>
</tr>
<tr>
<td>Asset #</td>
<td>For example, the asset number of the first machine to which the fix is applied.</td>
</tr>
<tr>
<td>CA #</td>
<td>Unique number to identify the CAPA. It is auto-generated when the CAPA record is created.</td>
</tr>
<tr>
<td>Codes</td>
<td>Typically, select codes of type Corrective Action. Example uses:</td>
</tr>
<tr>
<td></td>
<td>■ Use codes to indicate the root cause of the CAPA.</td>
</tr>
<tr>
<td></td>
<td>■ Use codes to classify the CAPA.</td>
</tr>
<tr>
<td>Comments</td>
<td>Use this field to record and share short notes during the life cycle of the CAPA.</td>
</tr>
<tr>
<td>Corrective Action</td>
<td>Detailed description of the corrective action and its root cause.</td>
</tr>
<tr>
<td>Fix Age</td>
<td>Number of days since the Actual Fixed date.</td>
</tr>
<tr>
<td>Lot #</td>
<td>For example, the first lot number to which the fix is applied.</td>
</tr>
<tr>
<td>Mfg Name</td>
<td>Typically this is the (internal) manufacturing site.</td>
</tr>
<tr>
<td>Serial #</td>
<td>Serial number of the asset. This field is automatically populated if there is a serial number associated with the asset.</td>
</tr>
<tr>
<td>Status</td>
<td>Changes to this field are tracked in the Approvals view.</td>
</tr>
<tr>
<td>Sub Area</td>
<td>The Area field constrains this drop-down list.</td>
</tr>
<tr>
<td>Sub Status</td>
<td>The Status field constrains this drop-down list.</td>
</tr>
<tr>
<td>Target</td>
<td>The version of the product targeted to have the fix.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of corrective action: Product Analysis, Product Issue, Manufacturing, Preventive Action, Other.</td>
</tr>
</tbody>
</table>

3 Drill down on the record and click the Related Products view tab and enter records for the products related to the CAPA.

4 Click the Product Issues view tab and enter records for any product issues related to the CAPA.

5 Click the Product Analysis view tab and enter records for any product analyses related to the CAPA.
Managing CAPAs (End User)

Use the views on the Corrective Actions screen to store, maintain, and share many types of information about a CAPA.

Typically several employees are assigned ownership of a CAPA record and are assigned activities related to the CAPA. All owners update the CAPA record during the course of the CAPA’s life cycle.

To add information to CAPA records

1. Navigate to the Corrective Actions screen > Corrective Action List view.
2. Drill down on a CAPA record.
3. Update the record by editing status, comment, and date fields.
4. Create activity plans for the CAPA:
   a. Click the Activity Plan view tab.
   b. In the Activity Plans list, create a new record, and complete the necessary fields.
      Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planned Start</td>
<td>Make sure that this date is correct before you choose a template. The due dates for the template-generated activities are based on this start date and on the lead time set in the template.</td>
</tr>
<tr>
<td>Template</td>
<td>Only templates whose type is Corrective Action can be selected in this field.</td>
</tr>
</tbody>
</table>

   c. Edit the activities in the Activities list or create more activities.
5. Create private and public notes for the CAPA record using the Notes view.
6. Associate files to the CAPA record using the Attachments view.

For general information about activities, notes, and attachments, see Siebel Fundamentals.

Tracking Approvals and Other Changes to CAPAs (End User)

Changes in the status of the CAPA record are tracked in the Approvals view. Changes to other fields in the CAPA record can be seen in the Audit Trail view. For information about enabling Audit Trail, see Siebel Applications Administration Guide.

NOTE: For information about configuring the Corrective Action screen to use buttons and workflows for changing the status of a CAPA record, see “About Configuring CAPA Approvals” on page 407.
To track approval history and other changes to CAPA records

1. Navigate to the Corrective Actions screen > Corrective Action List view.
2. Drill down on a CAPA record.
3. Click the Approvals view tab.
   Changes in the Status of the CAPA record is tracked in this view.
4. Click the Audit Trail view tab.
   Changes made to fields in the CAPA record are tracked in this view.

About Configuring CAPA Approvals

There are no buttons or workflows associated with the Corrective Actions screen.

However, you can configure your application with Submit and Withdraw buttons and workflows similar to those used for approving product analysis records on the Repairs screen.

See:

- “About Configuring Product Analysis Approvals” on page 398 for specific information on the product analysis approval workflows
- Configuring Siebel Business Applications for information about how to configure buttons
- Siebel Business Process Framework: Workflow Guide for information about how to create workflows
This chapter covers the following topics:

- "About Regulatory Reporting" on page 409
- "Scenario for Regulatory Reporting" on page 411
- "Process of Regulatory Reporting" on page 412
- "Setting Up Report Numbers" on page 412
- "Creating and Populating New Regulatory Reports (End User)" on page 413
- "Entering and Reviewing Data for 3500A Reports (End User)" on page 414
- "Entering and Reviewing Data for MDV Reports (End User)" on page 421
- "Running 3500A and MDV Reports (End User)" on page 422
- "Which Sections of the MedWatch 3500A Form Get Filled In?" on page 423
- "Generating Regulatory Report Numbers and Submitting Reports (End User)" on page 423
- "Reopening a Regulatory Report (End User)" on page 424
- "Creating Supplemental or Follow-Up Regulatory Reports (End User)" on page 425
- "Field Mapping for the MedWatch Report (Reference)" on page 426
- "Field Mapping for the MDV Report (Reference)" on page 432
- "About Configuring Buttons in Regulatory Reports" on page 435

**About Regulatory Reporting**

This chapter describes how to use the Siebel application to create and manage regulatory reports for product complaints and adverse events. The reports are generated with unique and sequential numbers and formatted ready for submission to the FDA or other regulatory agencies.

**Where to Find More Information**

The following chapters describe other aspects of the complaints and adverse events management process:

- Chapter 23, “Capturing Adverse Events and Complaints”
- Chapter 24, “Investigating Adverse Events and Complaints”
- Chapter 25, “Recording Product Analysis for AECM”
- Chapter 26, “Managing CAPAs”
- Chapter 29, “Communicating with Customers for AECM”
About Regulatory Reports

From the time an adverse event or complaint is confirmed as reportable, companies generally have less than 30 days to report to a regulatory agency. An adverse event or complaint can be verified as reportable at various stages of the AECM process, from the initial customer call through to the review of the findings by the analysis team. Companies usually follow certain assessments that determine if an adverse event or complaint is reportable or not.

Separate reports have to be filed for each product that malfunctioned or caused the adverse event. Reports filed are based on the product issue, which typically contains much of the needed information. After the initial report, companies generally file additional supplemental, summary, and annual reports to update information on the investigation and resolution process.

The preconfigured Siebel AECM module supports MedWatch and MDV reports:

- **MedWatch Reports.** Using Siebel AECM, you can automatically generate MedWatch 3500A reports. Sections A to H of the report are populated from the relevant fields in the regulatory report record. The completed report can be printed and mailed to the FDA or saved as a PDF file and submitted electronically to the FDA.

- **MDV Reports.** Medical device companies operating in multiple countries report adverse events or complaints to the various NCAs using the MDV form. Unlike MedWatch reports, there is no standard template for the MDV form. However, the Global Harmonization Task Force (GHTF) has guidelines.

    The report created by Siebel AECM follows these guidelines. For more information, see: http://www.ghtf.org.

About Report Types

Table 37 details the four regulatory reports that can be created in Siebel AECM.

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Use</th>
<th>Data for the Report Is Taken from These Views in the Regulatory Reports Screen</th>
</tr>
</thead>
</table>
| 3500A                | For initial mandatory reports to MedWatch (FDA). | • More Info
                       |                                               | • Patient
                       |                                               | • Importer (if the Facility Type field in the Importer view is not blank)
                       |                                               | • Manufacturer and Investigation (if the Facility Type field in the Importer view is blank)
| 3500A Supplemental   | For additional information to MedWatch after initial reports have been submitted. |                                   |
Scenario for Regulatory Reporting

This scenario is an example process performed by the Siebel administrator and the quality manager. Your company may follow a different process according to its business requirements.

This scenario is designed to illustrate the functionality of Siebel AECM.

Introduction

A complaint about a cartridge for a blood analyzer machine has been made to the manufacturer. The complaint has been assessed; it needs to be reported to the FDA. A product issue record has already been set up and contains a lot of information about the complaint.

The Siebel Administrator

The administrator is responsible for setting up the report number schema for the organization. The company started using Siebel AECM in the middle of the year. Because the company had already submitted eight MedWatch 3500A reports to the FDA, the administrator sets the report number sequence to start at 9.

Quality Manager

It is the quality manager’s responsibility to prepare the initial MedWatch 3500A form and send it to the FDA. First, she creates a new regulatory report record and populates the record with data from the product issue. Then she reviews the data.

Because her company manufactures the cartridge, she enters data into the Manufacturer and Investigation views. This data will appear in sections G and H of the MedWatch 3500A form.

Satisfied that the necessary data has been entered, she generates the MedWatch 3500A report. This report is a facsimile of the MedWatch 3500A form. But, it is also a standard Siebel report, so the quality manager prints it as she would any other Siebel report.

After reviewing the printed version of the report, she submits it. When she submits the report record, two things happen:

Table 37. Report Types in Siebel AECM

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Use</th>
<th>Data for the Report Is Taken from These Views in the Regulatory Reports Screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDV Initial</td>
<td>For initial reports to NCAs who accept MDV forms</td>
<td>■ More Info&lt;br&gt;■ Patient&lt;br&gt;■ MDV</td>
</tr>
<tr>
<td>MDV Follow-up</td>
<td>For additional information to NCAs after initial reports have been submitted.</td>
<td></td>
</tr>
</tbody>
</table>
A report number is generated.

Most fields in the report record become read-only.

It is the submitted version of the MedWatch 3500A form that the quality manager sends to the FDA.

The quality manager complied with regulations by sending her initial report within 30 days of the company becoming aware of the issue. However, the product analysis had not been completed at that time. Later, the product analysis team discovers the root cause of the cartridge failure, and the quality manager submits a supplemental report to the FDA.

**Process of Regulatory Reporting**

This example process represents the tasks that are carried out in the *Scenario for Regulatory Reporting* on page 411.

**Administrator Procedures**

- Setting Up Report Numbers on page 412

**End-User Procedures**

1. Creating and Populating New Regulatory Reports (End User) on page 413
2. Entering and Reviewing Data for 3500A Reports (End User) on page 414, or
3. Entering and Reviewing Data for MDV Reports (End User) on page 421
4. Running 3500A and MDV Reports (End User) on page 422
5. Generating Regulatory Report Numbers and Submitting Reports (End User) on page 423
6. Creating Supplemental or Follow-Up Regulatory Reports (End User) on page 425

**Additional End-User Procedure**

This end-user procedure is not part of the scenario described:

- Reopening a Regulatory Report (End User) on page 424

**Setting Up Report Numbers**

The administrator determines the numbering scheme for regulatory reports.

The number is generated automatically when the regulatory report record is submitted.
The report number composed of concatenated fields. The report number field is incremented by 1 each time a report is generated for a new product issue.

<table>
<thead>
<tr>
<th>Reports numbers of this type...</th>
<th>Are the concatenation of these fields...</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>MedWatch 3500A</td>
<td>■ Manufacturer Id ■ Report Year ■ Report Number</td>
<td>XERCO-2003-0004</td>
</tr>
<tr>
<td>MDV Initial</td>
<td>■ MDV Id ■ MDV Report Number</td>
<td>MEDDEV-000008</td>
</tr>
</tbody>
</table>

This task is a step in “Process of Regulatory Reporting” on page 412.

**To set up report numbering scheme**

1. Navigate to Administration - Group screen > Organizations view.
2. In the Organizations list, select your organization.
3. To set up numbering for MedWatch 3500A reports complete the following fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manufacturer Id</td>
<td></td>
</tr>
<tr>
<td>Report Year</td>
<td></td>
</tr>
<tr>
<td>Report Number</td>
<td>Set to zero to have the first report numbered 0001.</td>
</tr>
</tbody>
</table>

4. To set up numbering for MDV Initial reports complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDV Id</td>
<td></td>
</tr>
<tr>
<td>MDV Report Number</td>
<td>Set to zero to have the first report numbered 000001.</td>
</tr>
</tbody>
</table>

The best way to create a regulatory report record is from the product issue record. When a report is created from the regulatory report, fields (for example, products) can be populated from the product issue record to the regulatory report record.

There are two kinds of initial regulatory report that you can create:

- MedWatch 3500A
MDV Initial

NOTE: If you want to create supplemental or follow-up reports, see "Creating Supplemental or Follow-Up Regulatory Reports (End User)" on page 425.

This task is a step in “Process of Regulatory Reporting” on page 412.

CAUTION: Regulatory report records cannot be deleted.

To create a regulatory report record
2. Drill down on a product issue.
3. Click the Regulatory Reports view tab.
4. In the Regulatory Reports list, create a record.
   - When the regulatory report is created:
     - These fields are copied from the product issue: PI# and SR #
     - These fields are set with a default value: Status = In Progress, Owner = Creator of the record
5. Set the Report Type field to MedWatch 3500A or MDV Initial.
6. Click Populate Report.
   - This starts the LS Medical Product Issue Populate Report workflow, which copies data from the product issue according to the report type. For more information about the workflow, see “LS Medical Product Issue Populate Report Workflow” on page 436.

Entering and Reviewing Data for 3500A Reports (End User)

When you populate a regulatory report, many fields are copied from the product issue record. When you edit these fields in the regulatory report record, the edits are not copied back to the product issue record.

NOTE: The process described here is to enter data in the Manufacturer, Investigation, and Importer views of the Regulatory Reports screen. However, an alternate way is to enter the data in these views in the Product Issues screen before the regulatory report is populated. If you use the Product Issues screen, you have copies of the data in both the product issue record and in the regulatory report record.

This task is a step in “Process of Regulatory Reporting” on page 412.

To review and enter data for the 3500A report
2. Drill down on a 3500A regulatory report record.
Review and edit if necessary the information in the More Info and Patient views.

If you are a manufacturer:

- Make sure that the Facility Type field in the Importer view is blank. (By default, this field is set to blank.)
- Complete the fields in the Manufacturer view.

These fields populate section G of the 3500A form. Some fields are described in the following table. (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>(A)NDA #</td>
<td>The abbreviated new drug application or the new drug application number. This field is automatically populated if there is an (A)NDA number associated with the protocol site.</td>
<td>G5</td>
</tr>
<tr>
<td>STN #</td>
<td>Product Submission Tracking Number (STN). If this number does not exist, then use the U.S. License Number.</td>
<td></td>
</tr>
<tr>
<td>PMA/510(K) #</td>
<td>Pre-market application (PMA) or pre-market notification (510(k)) submission number for the approved or cleared medical device or combination product. If a product has several applicable submission numbers and you cannot determine the specific number to use, then use the first approved PMA or 510(k) number.</td>
<td></td>
</tr>
<tr>
<td>Combo Product</td>
<td>Define whether a suspect product comprises a drug-device, device-biological, drug-biological, or a drug-device-biological product.</td>
<td></td>
</tr>
<tr>
<td>10-day</td>
<td>Select the check box to indicate the report is a 10-day report.</td>
<td>G7</td>
</tr>
<tr>
<td>15-day</td>
<td>For reports of serious and unexpected adverse events.</td>
<td>G7</td>
</tr>
<tr>
<td>5-day</td>
<td>For events requiring remedial action to prevent unreasonable risk to public health, or where written notice is required.</td>
<td>G7</td>
</tr>
<tr>
<td>7-day</td>
<td>Select the check box to indicate the report is a 7-day report.</td>
<td></td>
</tr>
<tr>
<td>30-day</td>
<td>Select the check box to indicate the report is a 30-day report.</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>Manufacturer contact office address - Street.</td>
<td>G1</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
<td>Mapping to 3500A Form</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>AE Terms</td>
<td>List of adverse event terms that most accurately characterize the adverse event described in Event Detail section.</td>
<td>G8</td>
</tr>
<tr>
<td>City</td>
<td>Manufacturer contact office address - City.</td>
<td>G1</td>
</tr>
<tr>
<td>Consumer</td>
<td>Report Source is the consumer or treating health care provider.</td>
<td>G3</td>
</tr>
<tr>
<td>Contact Name</td>
<td>Manufacturer contact’s last name.</td>
<td>G1</td>
</tr>
<tr>
<td>Contact Office</td>
<td>Manufacturer’s contact office.</td>
<td>G1</td>
</tr>
<tr>
<td>Country</td>
<td>Manufacturer contact office address - Country.</td>
<td>G1</td>
</tr>
<tr>
<td>Distributor</td>
<td>Check this if report was received from the distributor (importer) of the suspect product.</td>
<td>G3</td>
</tr>
<tr>
<td>First Name</td>
<td>Manufacturer contact’s first name.</td>
<td>G1</td>
</tr>
<tr>
<td>Follow-up</td>
<td>Check if the report is a follow-up to a previously submitted report.</td>
<td>G7</td>
</tr>
<tr>
<td>Follow-Up #</td>
<td>Follow-up sequence number.</td>
<td>G7</td>
</tr>
<tr>
<td>Foreign</td>
<td>Report Source is a foreign source (for example, foreign medical facility, affiliate, or government).</td>
<td>G3</td>
</tr>
<tr>
<td>IND #</td>
<td>The investigational new drug (IND) application number.</td>
<td>G5</td>
</tr>
<tr>
<td></td>
<td>This field is automatically populated if there is an IND number associated with the protocol site.</td>
<td></td>
</tr>
<tr>
<td>Initial</td>
<td>Check if the report is the first submission of a manufacturer report (30 day report for device).</td>
<td>G7</td>
</tr>
<tr>
<td>Literature</td>
<td>Report Source is the scientific literature or an unpublished manuscript.</td>
<td>G3</td>
</tr>
<tr>
<td>Mfg Report #</td>
<td>Regulatory report number.</td>
<td>G9</td>
</tr>
<tr>
<td>OTC Product</td>
<td>Check if the suspect medication can be purchased over-the-counter (without a prescription).</td>
<td>G5</td>
</tr>
<tr>
<td>Other</td>
<td>Report Source is any source not covered by the previous categories.</td>
<td>G3</td>
</tr>
<tr>
<td>Periodic</td>
<td>For reports of serious labeled and non-serious (labeled and unlabeled) adverse events.</td>
<td>G7</td>
</tr>
<tr>
<td>Phone #</td>
<td>Manufacturer contact’s work phone number.</td>
<td>G2</td>
</tr>
<tr>
<td>PI Received</td>
<td>The date when a company representative became aware of the event.</td>
<td>G4</td>
</tr>
</tbody>
</table>
If you are a device manufacturer, complete the fields in the Investigation view.

These fields populate section H of the 3500A form. Some fields are described in the following table. (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation</td>
<td>If an evaluation was conducted, note summary here and choose Evaluation Summary Attached in Evaluated by Mfg Field.</td>
<td>H3</td>
</tr>
<tr>
<td>Death</td>
<td>Check only if the death was an outcome of the adverse event.</td>
<td>H1</td>
</tr>
<tr>
<td>Correction</td>
<td>Do not check when creating an initial report. Follow-up with changes to previously submitted information.</td>
<td>H2</td>
</tr>
<tr>
<td>Field</td>
<td>Comments</td>
<td>Mapping to 3500A Form</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Serious Injury</td>
<td>Event is life-threatening, results in permanent impairment, requires intervention to prevent permanent impairment.</td>
<td>H1</td>
</tr>
<tr>
<td>Additional Information</td>
<td>Do not check when creating an initial report. Information concerning the event that was not provided in the initial report.</td>
<td>H2</td>
</tr>
<tr>
<td>Malfunction</td>
<td>Device malfunctions.</td>
<td>H1</td>
</tr>
<tr>
<td>Response to FDA Request</td>
<td>Do not check when creating an initial report. Additional information requested by FDA concerning the device/event.</td>
<td>H2</td>
</tr>
<tr>
<td>Other</td>
<td>Event not covered by death, serious injury, or malfunction. This type of category should be rarely used.</td>
<td>H1</td>
</tr>
<tr>
<td>Device Evaluation</td>
<td>Do not check when creating an initial report. Evaluation/analysis of device.</td>
<td>H2</td>
</tr>
<tr>
<td>Mfg Narrative</td>
<td>Any additional information, evaluation, or clarification of data presented in previous sections.</td>
<td>H10</td>
</tr>
<tr>
<td>Recall</td>
<td>Remedial Action - Recall.</td>
<td>H7</td>
</tr>
<tr>
<td>Method Codes</td>
<td>Method codes capture two items — the source of the device that was evaluated and the type of evaluation performed. Do not enter more than four codes.</td>
<td>H6</td>
</tr>
<tr>
<td>Repair</td>
<td>Remedial Action - Repair.</td>
<td>H7</td>
</tr>
<tr>
<td>Result Codes</td>
<td>Describes the results of evaluation and analyses of the reported device problem(s). Do not enter more than four codes.</td>
<td>H6</td>
</tr>
<tr>
<td>Replace</td>
<td>Remedial Action - Replace.</td>
<td>H7</td>
</tr>
<tr>
<td>Conclusion Codes</td>
<td>Describes the evaluation conclusions. Do not enter more than four codes.</td>
<td>H6</td>
</tr>
<tr>
<td>Relabeling</td>
<td>Remedial Action - Relabeling.</td>
<td>H7</td>
</tr>
<tr>
<td>Evaluated by Mfg</td>
<td>If you do not check this box, then you should complete the Non-Evaluation Codes field. Identify if the device was evaluated.</td>
<td>H3</td>
</tr>
<tr>
<td>Notification</td>
<td>Remedial Action - Notification.</td>
<td>H7</td>
</tr>
</tbody>
</table>
If you are a user facility or importer, complete the fields in the Importer view. These fields populate section F of the form. Some fields are described in the following table. (The letter and number combination in the last column indicates how this field maps to the 3500A form.)

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facility Type</td>
<td>Indicate whether the report is from a user facility, importer, or others.</td>
<td>F1</td>
</tr>
<tr>
<td>Importer</td>
<td>Name of the distributor or importer.</td>
<td>F3</td>
</tr>
<tr>
<td>Contact Name</td>
<td>Last name of the distributor’s or importer’s representative to contact regarding the event.</td>
<td>F4</td>
</tr>
<tr>
<td>Device Age</td>
<td>The approximate age of the device.</td>
<td>F9</td>
</tr>
</tbody>
</table>

If an evaluation of a returned medical device was NOT conducted, provide the appropriate code.

Additional, corrected, or missing information, identifying each data item by the applicable section and block number.

Remedial Action - Inspection.

Remedial Action - Patient monitoring.

Month and year of manufacture of the suspect medical device.

This field may be based on asset number (asset manufacture date) or lot number (effective start date).

Remedial Action - Modification.

Indicates whether the device was labeled for single use.

Remedial Action - Other - Specify the type of action in this field.

If action reported to FDA under 21 USC 360i(f), list correction or removal reporting number.
<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
<th>Mapping to 3500A Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report #</td>
<td>Regulatory report # for this report, which is being submitted by an importer. This number is auto-populated when the report is generated.</td>
<td>F2</td>
</tr>
<tr>
<td>Address</td>
<td>Distributor's or Importer's address - Street Address line #1. This field is auto-populated based on the distributor's or importer's name.</td>
<td>F3</td>
</tr>
<tr>
<td>First Name</td>
<td>First name of the distributor's or importer's representative to contact regarding the event.</td>
<td>F4</td>
</tr>
<tr>
<td>Age UoM</td>
<td>Unit of measurement for device age.</td>
<td>F9</td>
</tr>
<tr>
<td>Report Type</td>
<td>Indicates if the report to the regulatory agency will be an initial or follow-up report.</td>
<td>F7</td>
</tr>
<tr>
<td>City</td>
<td>Distributor's or importer's address - City.</td>
<td>F3</td>
</tr>
<tr>
<td>Phone #</td>
<td>Contact’s work phone number.</td>
<td>F5</td>
</tr>
<tr>
<td>Patient Codes</td>
<td>Patient codes describe what happened to the patient as a result of the event. Do not enter more than three codes.</td>
<td>F10</td>
</tr>
<tr>
<td>Follow-up #</td>
<td>Sequence number of the follow-up report.</td>
<td>F7</td>
</tr>
<tr>
<td>Postal Code</td>
<td>Distributor’s or importer’s address - Postal Code.</td>
<td>F3</td>
</tr>
<tr>
<td>Reported FDA</td>
<td>Indicates if the distributor or importer has already sent a report to the regulatory agency.</td>
<td>F11</td>
</tr>
<tr>
<td>Device Codes</td>
<td>Device codes describe device failures or problems encountered during the event. Do not enter more than four codes.</td>
<td>F10</td>
</tr>
<tr>
<td>Reported Mfg</td>
<td>Indicates if the distributor or importer has sent a report to the manufacturer.</td>
<td>F13</td>
</tr>
<tr>
<td>State</td>
<td>Distributor’s or importer’s address - State.</td>
<td>F3</td>
</tr>
<tr>
<td>FDA Report Date</td>
<td>Date the report was sent to the regulator agency.</td>
<td>F11</td>
</tr>
<tr>
<td>Event Location</td>
<td>Location of the actual occurrence of the event.</td>
<td>F12</td>
</tr>
<tr>
<td>Mfg Report Date</td>
<td>Date the report was sent to the manufacturer.</td>
<td>F13</td>
</tr>
<tr>
<td>Country</td>
<td>Distributor’s or importer’s address - Country.</td>
<td>F3</td>
</tr>
<tr>
<td>PI Received</td>
<td>The date when a company representative became aware of the event.</td>
<td>F6</td>
</tr>
</tbody>
</table>
Entering and Reviewing Data for MDV Reports (End User)

When you populate the regulatory report, many fields are copied from the product issue record. When you edit these fields in the regulatory report record, the edits are not copied back to the product issue record.

**NOTE:** The process described here is to enter data in the MDV view in the Regulatory Reports screen. However, an alternate way is to enter the data in the MDV view in the Product Issues screen before the regulatory report is populated. If you use this alternative, you have copies of the data in both the product issue record and in the regulatory report record.

This task is a step in “Process of Regulatory Reporting” on page 412.

**To review and enter data for an MDV Initial report**
2. Drill down on an MDV regulatory report record.
3. Review and edit if necessary the information in the More Info and Patient views.
4. Click the MDV view tab.
5. Complete the fields in the MDV view.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MDV Report #</td>
<td>MDV Report number. This number is auto-populated when the report is generated.</td>
</tr>
<tr>
<td>Authorities</td>
<td>The name of the regulatory agencies to send the report to.</td>
</tr>
<tr>
<td>Affiliate Acct</td>
<td>The affiliate account representing the company.</td>
</tr>
<tr>
<td>PI Received</td>
<td>The date when the company became aware of the event.</td>
</tr>
<tr>
<td>Determination</td>
<td>The type of the reportable event for MDV reporting.</td>
</tr>
<tr>
<td>Patient Codes</td>
<td>Patient codes describe what happened to the patient as a result of the event.</td>
</tr>
<tr>
<td>Device Codes</td>
<td>Device codes describe device failures or problems encountered during the event.</td>
</tr>
<tr>
<td>Usage of Device</td>
<td>Indicates whether the use of the suspect medical device was the initial use, reuse, or unknown.</td>
</tr>
<tr>
<td>Follow-up Date</td>
<td>Date field to indicate the approximate follow-up or final report date.</td>
</tr>
<tr>
<td>Approval Org</td>
<td>The approval body for the device.</td>
</tr>
<tr>
<td>Approval #</td>
<td>The approval number for the device.</td>
</tr>
</tbody>
</table>
Running 3500A and MDV Reports (End User)

Siebel AECM uses the Siebel Reports Server to create formatted reports suitable for submitting to the FDA or other regulatory agency.

Typically, the user views the report:

- Before generating it, to make sure that the data is correct
- After generating it, to print a final report for sending to the FDA or other regulatory agencies

**NOTE:** The fields used to fill in the report are those in the regulatory report record (not the product issue record).

This task is a step in “Process of Regulatory Reporting” on page 412.

To run a report

2. Drill down on a report.

<table>
<thead>
<tr>
<th>For this type of report...</th>
<th>Navigate to one of these views...</th>
<th>Select this report from the Reports button menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>MedWatch 3500A</td>
<td>More Info</td>
<td>3500A</td>
</tr>
<tr>
<td></td>
<td>Patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Importer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manufacturer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Investigation</td>
<td></td>
</tr>
<tr>
<td>MVD</td>
<td>More Info</td>
<td>MDV</td>
</tr>
<tr>
<td></td>
<td>Patient</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MDV</td>
<td></td>
</tr>
</tbody>
</table>

3. Run, print, and save the report as necessary. For information about reports, see *Siebel Fundamentals*. 

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation</td>
<td>If the evaluation was conducted, note summary here and choose Evaluation Summary Attached in Evaluated by Mfg field.</td>
</tr>
<tr>
<td>Mfg Narrative</td>
<td>Any additional information, evaluation, or clarification of data presented in previous sections.</td>
</tr>
</tbody>
</table>
Which Sections of the MedWatch 3500A Form Get Filled In?

Not all sections of the MedWatch 3500A get filled in for every report. Which sections are filled in depends upon the Event Type and Facility Type fields.

These sections always get filled in:
- A. Patient Information
- B. Adverse Event or Product Problem
- E. Initial Reporter

Table 38 lists the conditions for which the other sections get filled in.

### Table 38. Sections of the Report Filled In According to Event Type and Facility Type Field Values

<table>
<thead>
<tr>
<th>If...</th>
<th>And...</th>
<th>These sections are filled in...</th>
<th>And these sections are left blank...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Type 1 = Adverse Event Drug, Product Problem Drug, or AE and PP Drug</td>
<td>—</td>
<td>C, G</td>
<td>D, F, H</td>
</tr>
<tr>
<td>Event Type 1 = Adverse Event Device, Product Problem Device, or AE and PP Device</td>
<td>Facility Type 2 = NULL (blank)</td>
<td>D, G, H</td>
<td>C, F</td>
</tr>
<tr>
<td></td>
<td>Facility Type 2 = User Facility, Distributor, or Importer (That is, not blank)</td>
<td>D, F, G</td>
<td>C, H</td>
</tr>
</tbody>
</table>

1. Regulatory Reports screen > More Info view
2. Regulatory Reports screen > Importer view

Generating Regulatory Report Numbers and Submitting Reports (End User)

When you generate a 3500A or MDV initial report:
- The report number is generated and filled in
- The Status field changes to Submitted
- The fields in the regulatory report record become read-only (except for the Sub Status field)
Only the primary owner of the regulatory report can generate the report number and submit the report.

This task is a step in “Process of Regulatory Reporting” on page 412.

**To generate and submit a regulatory report**

1. Make sure the application is running on a server database.
   
   You cannot generate a report number on the Siebel Mobile Web Client.


3. Drill down on a regulatory report with status of In Progress.

4. Click Generate.

   This starts the LS Medical Product Issue RR Submit workflow, which authenticates the user, adds a number for the regulatory report, changes the status to Submitted, and makes all fields except Sub Status read-only.

   For more information about the workflow, see “LS Medical Product Issue RR Submit Workflow” on page 436.

**Reopening a Regulatory Report (End User)**

If you want to make a change in a generated (submitted) regulatory report record, you need to reopen it. Only the primary owner of the regulatory report can reopen it.

When you reopen a report:

- The Status field changes to Reopen
- The fields in the regulatory report record can be edited

This task is a step in “Process of Regulatory Reporting” on page 412.

**To reopen a regulatory report**


2. Drill down on a regulatory report with status of Submitted.

3. Click Reopen.

   This starts the LS Medical Product Issue RR Reopen workflow, which authenticates the user and changes the status of the report to Reopen.

   For more information about the workflow, see “LS Medical Product Issue RR Reopen Workflow” on page 438.
Creating Supplemental or Follow-Up Regulatory Reports (End User)

Often, it is necessary to follow-up an initial report with a follow-up report that provides supplementary information to the regulatory agency.

When you run a supplemental or follow-up report, the report should contain the initial report number and any corrected or new data.

**CAUTION:** Regulatory report records cannot be deleted.

This task is a step in “Process of Regulatory Reporting” on page 412.

**To create a follow-up or supplemental regulatory report**

2. Drill down on a product issue.
3. Click the Regulatory Reports view tab.
4. In the Regulatory Reports list, create a record.
   
   When the regulatory report is created:
   
   - These fields are copied from the product issue: PI # and SR #
   - These fields are set with a default value: Status = In Progress, Owner = Creator of the record
5. Set the Report Type field to 3500A Supplemental or MDV Follow-up.
6. Click Populate Report.
   
   The Populate Report button only copies the initial report number to the supplemental report. (No other fields are copied.) You can configure the application to copy additional fields such as Mfg Narrative and Corrected Data to the supplemental report. Review the LS Medical Product Issue Populate Report Workflow for an example of a similar configuration.
7. If you are a device manufacturer preparing a 3500A Supplemental report, make sure to check a Follow-Up Type in the Investigation view.
8. After creating a follow-up or supplemental regulatory report, you can view it, submit it, reopen it in the same way as a initial report:
   
   - “Running 3500A and MDV Reports (End User)” on page 422
   - “Generating Regulatory Report Numbers and Submitting Reports (End User)” on page 423
   - “Reopening a Regulatory Report (End User)” on page 424
### Field Mapping for the MedWatch Report (Reference)

Table 39 shows how the fields in the Regulatory Reports screen map to the fields in the MedWatch 3500A report.

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A. Patient Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>A1</td>
<td>Patient Identifier</td>
<td>Patient</td>
</tr>
<tr>
<td>A2</td>
<td>Age</td>
<td>Patient</td>
</tr>
<tr>
<td>A2</td>
<td>Date of Birth</td>
<td>Patient</td>
</tr>
<tr>
<td>A3</td>
<td>Gender</td>
<td>Patient</td>
</tr>
<tr>
<td>A4</td>
<td>U/M</td>
<td>Patient</td>
</tr>
<tr>
<td>A4</td>
<td>Weight</td>
<td>Patient</td>
</tr>
<tr>
<td><strong>B. Adverse Event or Product Problem</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B1</td>
<td>Event Type</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Congenital Anomaly</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Date of Death</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Death</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Disability</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Hospitalization</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Life Threatening</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Other</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B2</td>
<td>Required Intervention</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B3</td>
<td>Event Date</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B4</td>
<td>Report Date</td>
<td>More Info, Regulatory Reports screen only</td>
</tr>
<tr>
<td>B5</td>
<td>Description ¹</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B6</td>
<td>Tests/Data ¹</td>
<td>More Info (Event Detail)</td>
</tr>
<tr>
<td>B7</td>
<td>Relevant History ¹</td>
<td>More Info (Event Detail)</td>
</tr>
</tbody>
</table>

**C. Suspect Medication(s)**
Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>Product</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C2</td>
<td>Dose Per Unit</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C2</td>
<td>Frequency</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C2</td>
<td>Route Used</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C3</td>
<td>Therapy From Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C3</td>
<td>Therapy To Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C4</td>
<td>Indication</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C5</td>
<td>Event Abated</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C6</td>
<td>Lot #</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C7</td>
<td>Expiration Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C8</td>
<td>Reintroduce Reoccur</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C9</td>
<td>NDC#</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>C10</td>
<td>External Products</td>
<td>More Info (Event Detail)</td>
</tr>
</tbody>
</table>

**D. Suspect Medical Device**

| D1                              | Product              | More Info (Products)                                                 |
| D2                              | Common Device Name   | More Info (Products)                                                 |
| D3                              | City                 | More Info (Products)                                                 |
| D3                              | Mfg Name             | More Info (Products)                                                 |
| D3                              | Postal Code          | More Info (Products)                                                 |
| D3                              | State                | More Info (Products)                                                 |
| D3                              | Street Address       | More Info (Products)                                                 |
| D4                              | Asset #              | More Info (Products)                                                 |
| D4                              | Catalog #            | More Info (Products)                                                 |
| D4                              | Expiration Date      | More Info (Products)                                                 |
| D4                              | Lot #                | More Info (Products)                                                 |
| D4                              | Model #              | More Info (Products)                                                 |
| D4                              | Part #               | More Info (Products)                                                 |
| D4                              | Serial #             | More Info (Products)                                                 |
| D5                              | Device Operator      | More Info (Products)                                                 |
### Field Mapping for the MedWatch Report (Reference)

Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>D6</td>
<td>Implant Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D7</td>
<td>Explant Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D8</td>
<td>Reprocessed</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D9</td>
<td>Reprocessor</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D10</td>
<td>Device Available</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D10</td>
<td>Return Date</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>D11</td>
<td>External Products</td>
<td>More Info (Event Detail)</td>
</tr>
</tbody>
</table>

#### E. Initial Reporter

<table>
<thead>
<tr>
<th></th>
<th>Field Name</th>
<th>View (Applet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1</td>
<td>Account</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>Address</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>City</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>Contacts (Contact Last Name in list)</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>CSN #</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>First Name (Contact First Name in list)</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>Phone #</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>Postal Code</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>Site</td>
<td>More Info</td>
</tr>
<tr>
<td>E1</td>
<td>State</td>
<td>More Info</td>
</tr>
<tr>
<td>E2</td>
<td>Provider</td>
<td>More Info</td>
</tr>
<tr>
<td>E3</td>
<td>Occupation</td>
<td>More Info</td>
</tr>
<tr>
<td>E4</td>
<td>Reported FDA</td>
<td>More Info</td>
</tr>
</tbody>
</table>

#### F. For Use by User Facility/Importer (Devices Only)

<table>
<thead>
<tr>
<th></th>
<th>Field Name</th>
<th>View (Applet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Facility Type</td>
<td>Importer</td>
</tr>
<tr>
<td>F2</td>
<td>Report #</td>
<td>Importer</td>
</tr>
<tr>
<td>F3</td>
<td>Address</td>
<td>Importer</td>
</tr>
<tr>
<td>F3</td>
<td>City</td>
<td>Importer</td>
</tr>
<tr>
<td>F3</td>
<td>Country</td>
<td>Importer</td>
</tr>
</tbody>
</table>
### Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3</td>
<td>Importer</td>
<td>Importer</td>
</tr>
<tr>
<td>F3</td>
<td>Postal Code</td>
<td>Importer</td>
</tr>
<tr>
<td>F3</td>
<td>State</td>
<td>Importer</td>
</tr>
<tr>
<td>F4</td>
<td>Contact Name</td>
<td>Importer</td>
</tr>
<tr>
<td>F4</td>
<td>First Name</td>
<td>Importer</td>
</tr>
<tr>
<td>F5</td>
<td>Phone #</td>
<td>Importer</td>
</tr>
<tr>
<td>F6</td>
<td>PI Received</td>
<td>Importer</td>
</tr>
<tr>
<td>F7</td>
<td>Follow-up #</td>
<td>Importer</td>
</tr>
<tr>
<td>F7</td>
<td>Report Type</td>
<td>Importer</td>
</tr>
<tr>
<td>F8</td>
<td>Report Date</td>
<td>More Info</td>
</tr>
<tr>
<td>F9</td>
<td>Age UoM</td>
<td>Importer</td>
</tr>
<tr>
<td>F9</td>
<td>Device Age</td>
<td>Importer</td>
</tr>
<tr>
<td>F10</td>
<td>Device Codes</td>
<td>Importer</td>
</tr>
<tr>
<td>F10</td>
<td>Patient Codes</td>
<td>Importer</td>
</tr>
<tr>
<td>F11</td>
<td>FDA Report Date</td>
<td>Importer</td>
</tr>
<tr>
<td>F11</td>
<td>Reported FDA</td>
<td>Importer</td>
</tr>
<tr>
<td>F12</td>
<td>Event Location</td>
<td>Importer</td>
</tr>
<tr>
<td>F13</td>
<td>Mfg Report Date</td>
<td>Importer</td>
</tr>
<tr>
<td>F13</td>
<td>Reported Mfg</td>
<td>Importer</td>
</tr>
</tbody>
</table>

### G. All Manufacturers

<table>
<thead>
<tr>
<th>G1</th>
<th>Address</th>
<th>Manufacturer</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1</td>
<td>City</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>Contact Name</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>Contact Office</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>Country</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>First Name</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>Postal Code</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G1</td>
<td>State</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G2</td>
<td>Phone #</td>
<td>Manufacturer</td>
</tr>
</tbody>
</table>
Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>G3</td>
<td>Consumer</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Foreign</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Distributor</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Literature</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Other</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Professional</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Representative</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>Study</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G3</td>
<td>User Facility</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G4</td>
<td>PI Received</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>(A)NDA #</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>STN #</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>PMA/S10(K) #</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>Combo Product</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>IND #</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>OTC Product</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G5</td>
<td>Pre-1938</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G6</td>
<td>Protocol #</td>
<td>More Info (Product Issues) and Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>10-day</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>15-day</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>5-day</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>7-day</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>30-day</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>Follow-up</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>Follow-Up #</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>Initial</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G7</td>
<td>Periodic</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G8</td>
<td>AE Terms</td>
<td>Manufacturer</td>
</tr>
<tr>
<td>G9</td>
<td>Mfg Report #</td>
<td>Manufacturer</td>
</tr>
</tbody>
</table>
### Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>H. Device Manufacturers Only</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>H1</td>
<td>Death</td>
<td>Investigation</td>
</tr>
<tr>
<td>H1</td>
<td>Malfunction</td>
<td>Investigation</td>
</tr>
<tr>
<td>H1</td>
<td>Other</td>
<td>Investigation</td>
</tr>
<tr>
<td>H1</td>
<td>Serious Injury</td>
<td>Investigation</td>
</tr>
<tr>
<td>H2</td>
<td>Additional Information</td>
<td>Investigation</td>
</tr>
<tr>
<td>H2</td>
<td>Correction</td>
<td>Investigation</td>
</tr>
<tr>
<td>H2</td>
<td>Device Evaluation</td>
<td>Investigation</td>
</tr>
<tr>
<td>H2</td>
<td>Response to FDA Request</td>
<td>Investigation</td>
</tr>
<tr>
<td>H3</td>
<td>Evaluated by Mfg</td>
<td>Investigation</td>
</tr>
<tr>
<td>H3</td>
<td>Evaluation</td>
<td>Investigation</td>
</tr>
<tr>
<td>H3</td>
<td>Non-Evaluation Codes</td>
<td>Investigation</td>
</tr>
<tr>
<td>H4</td>
<td>Mfg Date</td>
<td>Investigation</td>
</tr>
<tr>
<td>H4</td>
<td></td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>H5</td>
<td>Labeled Single Use</td>
<td>More Info (Products)</td>
</tr>
<tr>
<td>H5</td>
<td></td>
<td>Investigation</td>
</tr>
<tr>
<td>H6</td>
<td>Conclusion Codes</td>
<td>Investigation</td>
</tr>
<tr>
<td>H6</td>
<td>Method Codes</td>
<td>Investigation</td>
</tr>
<tr>
<td>H6</td>
<td>Result Codes</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Inspection</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Modification</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Notification</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Other</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Patient Monitoring</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Recall</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Relabeling</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Repair</td>
<td>Investigation</td>
</tr>
<tr>
<td>H7</td>
<td>Replace</td>
<td>Investigation</td>
</tr>
</tbody>
</table>
Field Mapping for the MDV Report (Reference)

Table 40 shows how the fields in the Regulatory Reports screen map to the fields in the MDV report.

Table 40. Mapping of Fields from Siebel AECM UI to the MDV Report

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
</tr>
</thead>
<tbody>
<tr>
<td>H8</td>
<td>Usage of Device</td>
<td>Investigation</td>
</tr>
<tr>
<td>H9</td>
<td>Correction #</td>
<td>Investigation</td>
</tr>
<tr>
<td>H10</td>
<td>Mfg Narrative ^1</td>
<td>Investigation, MDV</td>
</tr>
<tr>
<td>H11</td>
<td>Corrected Data ^1</td>
<td>Investigation</td>
</tr>
</tbody>
</table>

1. If the text is long, it is appears on continuation pages, starting from the third page.

Field Mapping for the MDV Report (Reference)

Table 39 shows how the fields in the Regulatory Reports screen map to the fields in the MedWatch 3500A Form.

Table 39. Mapping of Fields from the Siebel AECM UI to the MedWatch 3500A Form

<table>
<thead>
<tr>
<th>Location on MedWatch Form 3500A</th>
<th>Field Name</th>
<th>View (Applet) on the MedWatch Form 3500A</th>
</tr>
</thead>
<tbody>
<tr>
<td>H8</td>
<td>Usage of Device</td>
<td>Investigation</td>
</tr>
<tr>
<td>H9</td>
<td>Correction #</td>
<td>Investigation</td>
</tr>
<tr>
<td>H10</td>
<td>Mfg Narrative ^1</td>
<td>Investigation, MDV</td>
</tr>
<tr>
<td>H11</td>
<td>Corrected Data ^1</td>
<td>Investigation</td>
</tr>
</tbody>
</table>
### Table 40. Mapping of Fields from Siebel AECM UI to the MDV Report

<table>
<thead>
<tr>
<th>UI Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
<th>Text on MDV Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td><a href="#">More Info</a> Regulatory Reports and the Product Issues screen MDV</td>
<td>Address</td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Date</td>
<td><a href="#">More Info</a> Regulatory Reports and the Product Issues screen MDV</td>
<td>Report Date</td>
</tr>
<tr>
<td>Received</td>
<td><a href="#">More Info</a></td>
<td>Manufacturer Awareness Date</td>
</tr>
<tr>
<td>Affiliate Acct</td>
<td><a href="#">MDV</a></td>
<td>Reporting Firm Name</td>
</tr>
<tr>
<td>Auth Rep</td>
<td><a href="#">MDV</a></td>
<td>Authorized Representative</td>
</tr>
<tr>
<td>First Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td><a href="#">MDV</a></td>
<td>Address</td>
</tr>
<tr>
<td>City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>State</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Country</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone #</td>
<td><a href="#">MDV</a></td>
<td>Telephone</td>
</tr>
<tr>
<td>Fax #</td>
<td><a href="#">MDV</a></td>
<td>Facsimile</td>
</tr>
<tr>
<td><strong>Event Information</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Identifier</td>
<td>Patient</td>
<td>Patient Identifier</td>
</tr>
<tr>
<td>Gender</td>
<td>Patient</td>
<td>Gender</td>
</tr>
<tr>
<td>Age</td>
<td>Patient</td>
<td>Age</td>
</tr>
<tr>
<td>Weight</td>
<td>Patient</td>
<td>Weight</td>
</tr>
<tr>
<td>Date of Birth</td>
<td>Patient</td>
<td>Date of Birth</td>
</tr>
<tr>
<td>Account</td>
<td><a href="#">More Info</a></td>
<td>Health Care Facility Name</td>
</tr>
<tr>
<td>Site</td>
<td><a href="#">More Info</a></td>
<td>Site</td>
</tr>
<tr>
<td>Contacts, First Name</td>
<td><a href="#">More Info</a></td>
<td>Contact Name</td>
</tr>
</tbody>
</table>
### Table 40. Mapping of Fields from Siebel AECM UI to the MDV Report

<table>
<thead>
<tr>
<th>UI Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
<th>Text on MDV Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>More Info</td>
<td>Address</td>
</tr>
<tr>
<td>Phone #</td>
<td>More Info</td>
<td>Contact Phone Number</td>
</tr>
<tr>
<td>Event Date</td>
<td>More Info (Event Detail)</td>
<td>Event Date</td>
</tr>
<tr>
<td>Description</td>
<td>More Info (Event Detail)</td>
<td>Event Description</td>
</tr>
<tr>
<td># Occurrences</td>
<td>More Info (Event Detail)</td>
<td>Number of Occurrences</td>
</tr>
<tr>
<td>Labeled Single Use</td>
<td>More Info (Products) Investigation</td>
<td>Device Labeled for Single Use</td>
</tr>
<tr>
<td>Patient Codes</td>
<td>MDV Importer</td>
<td>Patient Outcomes</td>
</tr>
<tr>
<td>Device Codes</td>
<td>MDV Importer</td>
<td>Device Outcomes</td>
</tr>
<tr>
<td>Usage of Device</td>
<td>MDV Investigation</td>
<td>Usage of Device</td>
</tr>
<tr>
<td>Authorities</td>
<td>MDV</td>
<td>Competent Authorities Already Notified</td>
</tr>
</tbody>
</table>

#### Device Information

<table>
<thead>
<tr>
<th>UI Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
<th>Text on MDV Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mfg Name</td>
<td>MDV</td>
<td>Manufacturer Name</td>
</tr>
<tr>
<td>Contact</td>
<td>MDV</td>
<td>Manufacturer Contact Name</td>
</tr>
<tr>
<td>First Name</td>
<td>MDV</td>
<td>Manufacturer Contact Name</td>
</tr>
<tr>
<td>Address</td>
<td>MDV</td>
<td>Address</td>
</tr>
<tr>
<td>City</td>
<td>MDV</td>
<td>Telephone</td>
</tr>
<tr>
<td>State</td>
<td>MDV</td>
<td>Facsimile</td>
</tr>
<tr>
<td>Postal Code</td>
<td>More Info (Products)</td>
<td>Device Name</td>
</tr>
<tr>
<td>Country</td>
<td>More Info (Products)</td>
<td>Type of Device</td>
</tr>
<tr>
<td>Phone #</td>
<td>More Info (Products)</td>
<td>Device Lot #</td>
</tr>
<tr>
<td>Fax #</td>
<td>More Info (Products)</td>
<td></td>
</tr>
</tbody>
</table>
Table 40. Mapping of Fields from Siebel AECM UI to the MDV Report

<table>
<thead>
<tr>
<th>UI Field Name</th>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
<th>Text on MDV Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part #</td>
<td>More Info (Products)</td>
<td>Device Part #</td>
</tr>
<tr>
<td>Asset #</td>
<td>More Info (Products)</td>
<td>Device Asset #</td>
</tr>
<tr>
<td>Serial #</td>
<td>More Info (Products)</td>
<td>Device Serial #</td>
</tr>
<tr>
<td>Model #</td>
<td>More Info (Products)</td>
<td>Model #</td>
</tr>
<tr>
<td>Catalog #</td>
<td>More Info (Products)</td>
<td>Catalog #</td>
</tr>
<tr>
<td>Approval Org</td>
<td>MDV</td>
<td>Device Approval Body</td>
</tr>
<tr>
<td>Approval #</td>
<td>MDV</td>
<td>Approval #</td>
</tr>
<tr>
<td>Qty Involved</td>
<td>More Info (Products)</td>
<td>Quantity of Devices Involved</td>
</tr>
<tr>
<td>Device Available</td>
<td>More Info (Products)</td>
<td>Device Disposition</td>
</tr>
<tr>
<td>External Products</td>
<td>More Info (Event Detail)</td>
<td>Associated Products</td>
</tr>
</tbody>
</table>

Results of Investigation

<table>
<thead>
<tr>
<th>View (Applet) on the Regulatory Reports and the Product Issues screen</th>
<th>Text on MDV Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluation</td>
<td>Device Evaluation Result</td>
</tr>
<tr>
<td>Remedials</td>
<td>Remedial Action</td>
</tr>
<tr>
<td>MFG Narrative</td>
<td>Manufacturer’s Narrative</td>
</tr>
</tbody>
</table>

2. On the MDV view.
3. The primary product only.

About Configuring Buttons in Regulatory Reports

There are three buttons associated with regulatory reports. You can configure the workflows for these buttons.

- Generate ("LS Medical Product Issue RR Submit Workflow" on page 436)
- Reopen ("LS Medical Product Issue RR Reopen Workflow" on page 438)

You can modify workflows to suit your own business model using Siebel Business Process Designer. For more information, see Siebel Business Process Framework: Workflow Guide.
LS Medical Product Issue Populate Report Workflow

This workflow is initiated from the Populate button on the Regulatory Reports view of the Product Issues screen.

The workflow appears in Figure 19.

The workflow does the following steps:

1. Checks if current record has already been populated. If it has, the workflow ends.
2. Sets the data map object according to the report type.
   The data map objects are:
   - LS Medical PI Populate Report - 3500A
   - LS Medical PI Populate Report - 3500 Supplemental
   - LS Medical PI Populate Report - MDV Initial
   - LS Medical PI Populate Report - MDV Follow-up
3. Populates the report from the product issue according to the data map object.

LS Medical Product Issue RR Submit Workflow

This workflow is initiated from the Generate button on the Regulatory Reports screen.
The workflow appears in Figure 20.

Figure 20. LS Medical Product Issue RR Submit

The workflow does the following steps:

1. Checks if the application is running on a server database. If not, the workflow ends.
2. Checks if the user is the primary owner. If not, the workflow ends.
3. Checks if the record has already been processed. If it has, the workflow ends.
4. Calls the LS Medical User Verification workflow. If the authentication does not pass, the workflow ends.
5 Checks if the parent product issue already has a report number.

<table>
<thead>
<tr>
<th>If the product issue...</th>
<th>and the Report Type Is...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Has a report record with a report number</td>
<td>None</td>
<td>Use the same number for the report being submitted.</td>
</tr>
<tr>
<td>Does not have a report record with a report number</td>
<td>3500A or MDV</td>
<td>Generate a new report number.</td>
</tr>
<tr>
<td></td>
<td>3500A Supplemental or MDV Follow-up</td>
<td>The workflow ends.</td>
</tr>
</tbody>
</table>

6 Sets the status of the report to Submitted.

**LS Medical Product Issue RR Reopen Workflow**

This workflow is initiated from the Reopen button on the Regulatory Reports screen. The workflow appears in Figure 21.

The workflow does the following steps:

1 Checks if the user is the primary owner. If not, the workflow ends.
2 Checks if the record has already been processed. If it has, the workflow ends.
3 Calls the LS Medical User Verification workflow. If the authentication does not pass, the workflow ends.
4 Sets the status of the report to Reopen.
This chapter covers the following topics:

- "About Closing Adverse Events and Complaints” on page 439
- “Scenario for Closing Adverse Events and Complaints” on page 440
- "Process of Closure for AECM” on page 441
- “Closing Product Issues (End User)” on page 441
- “Reopening Product Issues (End User)” on page 442
- "Reviewing Approvals for Product Issues (End User)” on page 442
- "Reviewing Lockdown Fields (End User)” on page 443
- "Reviewing Changes Made to Fields (End User)” on page 444
- "About Configuring Close and Reopen Buttons for Product Issues” on page 444

About Closing Adverse Events and Complaints

This chapter describes the closing of a product issue.

A product issue has come to a conclusion and no new activity or information is anticipated: quality manager closes the product issue record.

When the status of a product issue is changed to Closed, many of the fields in the product issue record become read-only or are locked down to maintain data integrity.

Where to Find More Information

The following chapters describe other aspects of the complaints and adverse events management process:

- Chapter 23, “Capturing Adverse Events and Complaints”
- Chapter 24, “Investigating Adverse Events and Complaints”
- Chapter 25, “Recording Product Analysis for AECM”
- Chapter 26, “Managing CAPAs”
- Chapter 27, “Regulatory Reporting”
- Chapter 29, “Communicating with Customers for AECM”
Scenario for Closing Adverse Events and Complaints

This scenario is an example process performed by the quality manager. Your company may follow a different process according to its business requirements.

This scenario is designed to illustrate the functionality of Siebel AECM.

The Quality Manager

In the course of this scenario, the quality manager closes the product issue, reopens it, reviews its history and finally closes it for good.

Closing

A product issue is ready for closure when:

- The activities associated with the product issue have been completed and closed.
- Product analysis has been carried out.
- The product issue was assessed as reportable and the report sent to the regulatory agency.
- The customer has been informed about the status of the product issue.
- A CAPA record has been created.

The quality manager, who is the owner of the product issue, changes the status of the product issue to closed.

Reopening

Some months later, new information resulting from the CAPA work is reported. A new quality manager needs to reopen and revise the product issue based on this new information.

Reviewing History

The new quality manager acquaints himself with the product issue.

He reviews the approval history for the issue, noting who approved the initial product issue review, and who approved the closure.

He also reviews the lockdown fields. This tells him that the name of the account has changed since the product issue was closed.

After updating the fields, the quality manager uses audit trail to review all changes that were made to product issue since reopening. Then he closes the product issue.
Process of Closure for AECM

This example process represents the tasks that are carried out in the “Scenario for Closing Adverse Events and Complaints” on page 440. Your company may follow a different process according to its business requirements.

End-User Procedures
- Closing Product Issues (End User) on page 441
- Reopening Product Issues (End User) on page 442
- Reviewing Approvals for Product Issues (End User) on page 442
- Reviewing Lockdown Fields (End User) on page 443
- Reviewing Changes Made to Fields (End User) on page 444

Closing Product Issues (End User)

When the status of the product issue is changed to closed, the LS Medical Product Issue Close workflow:
- Does a user authentication
- Locks down these fields:
  - Asset #
  - Serial #
  - Lot #
  - Manufacture Date
  - Manufacture Name
  - Street Address
  - City
  - State
  - Postal Code
  - Country
- Makes all fields read-only

For more information about the workflow, see “About Configuring Close and Reopen Buttons for Product Issues” on page 444.

This task is a step in “Process of Closure for AECM” on page 441.

To close a product issue
2. Select a product issue.
3. Click Close.
4. Complete user authentication.
Reopening Product Issues (End User)

Reopening a product issue reverses the effects of the Review Complaint and Close buttons. When the status of the product issue is changed to Reopen, the LS Medical Product Issue Reopen workflow:

- Authenticates the user’s login and password
- Makes read-only fields editable

For more information about the workflow, see “About Configuring Close and Reopen Buttons for Product Issues” on page 444.

TIP: When a product issue is reopened and then closed again, all locked down fields are overwritten with new information: To keep the track of the changes, turn on Audit Trail for the lockdown fields.

This task is a step in “Process of Closure for AECM” on page 441.

To reopen a product issue

2. Select a product issue.
3. Click Reopen.

Reviewing Approvals for Product Issues (End User)

Any change to the Status field for the product issue record is recorded in the Approvals view. Use the Approvals view to see who has changed that status of the product issue and when the change was made.

To use approval tracking, you must have Audit Trail turned on. For information about Audit Trail, see Siebel Applications Administration Guide.

To view approvals for a product issue

2. Drill down on a product issue.
3. Click the Approvals view tab.
   
   In the read-only list, you can view all approvals to the product issue.
Reviewing Lockdown Fields (End User)

About Lockdown Fields
For most purposes, you want your product issue data to contain the up-to-date information. For example, if an account has changed its name, you want have its current name appear in all product issues records so that a query for the current name returns the complete set of product issues associated with the account, both before and after the name change.

However, for record keeping, you may also want to maintain some relational data exactly as it was when the product issue was closed. For example, after the product issue was closed, Dana Frederick changes her name to Dana Feldman. Her new name was updated through the Contacts screen, and this change is reflected in the current product issue record. However, the Lockdown view for the product issue shows Dana’s name when product issue was closed. (See Figure 22.)

The application should be configured so that the fields appropriate for your business processes are locked down. In the preconfigured application, some fields are locked down at review complete and others are locked down when the product issue is closed.

How to Review Locked Down Fields for a Product Issue
This task is a step in “Process of Closure for AECM” on page 441.

To view lockdown fields for a product issue
2. Drill down on a product issue.
3. Click the Lockdown view tab.
   Lockdown fields show the field values as they were when the product issue was closed.

   **NOTE:** For multivalue fields, only the primary value is locked down.
Reviewing Changes Made to Fields (End User)

Using the Audit Trail view, quality managers and other users can see changes made to various fields in the product issue record.

Many fields are set to be audited in the preconfigured application. You can configure the application to audit more or fewer fields. For more information about enabling the audit trail function, see *Siebel Applications Administration Guide*.

**To view changes made to product issue fields**

2. Drill down on a product issue.
3. Click the Audit Trail view tab.
4. Review records in the Audit Trail list.

About Configuring Close and Reopen Buttons for Product Issues

There are two buttons associated with closing a product issue. You can configure the workflows for these buttons.

- Close button (*Close Complaint Workflow*)
- Reopen button (*Reopen Complaint Workflow*)

You can modify workflows to suit your own business model using Siebel Business Process Designer. For more information, see *Siebel Business Process Framework: Workflow Guide*.

Close Complaint Workflow

This workflow (LS Medical Product Issue Close) is initiated from the Close button on the Product Issues screen.

The workflow appears in Figure 23.

![Figure 23. LS Medical Product Issue Close Workflow](image-url)
The workflow does the following steps:
1. Checks if the user is the primary owner of the product issue.
2. If the user is not the primary owner, shows an error dialog box and ends.
3. Checks if the product issue has already been processed.
4. If the product issue has already been processed, shows an error dialog box appears and ends.
5. Calls the User Verification workflow.
6. If the user authentication is successful, copies the lockdown fields and changes the status to Closed.

Reopen Complaint Workflow

This workflow (LS Medical Product Issue Reopen) is initiated from the Reopen button on the Product Issues screen.

The workflow appears in Figure 24.

Figure 24. LS Medical Product Issue Reopen Workflow

The workflow does the following steps:
1. Checks if the user is the primary owner of the product issue.
2. If the user is not the primary owner, shows an error dialog box and ends.
3. Checks if the product issue has already been processed.
4. If the product issue has already been processed, shows an error dialog box appears and ends.
5. Calls the User Verification workflow.
6. If the user authentication is successful, changes the status to Reopen and makes the read-only field editable.
Closing Adverse Events and Complaints ■ About Configuring Close and Reopen Buttons for Product Issues
29 Communicating with Customers for AE CM

This chapter covers the following topics:

- "About Communicating with Customers for AE CM" on page 447
- "Scenario for Customer Communication" on page 447
- "Process of Customer Communication in AE CM" on page 448
- "Setting Up Proposals, Correspondence, and Presentations" on page 449
- "Communicating about Product Issues Using Proposals (End User)" on page 449
- "Communicating about Product Issues Using Presentations (End User)" on page 450
- "Communicating about Product Issues Using Correspondence (End User)" on page 450

About Communicating with Customers for AE CM

This chapter describes ways to communicate with the customers and coworkers about an adverse event or complaint. If you have installed the Siebel Document Server, you can create documents such as letters, reports, and presentations from within the Siebel Medical application.

Where to Find More Information

The following chapters describe other aspects of the complaints and adverse events management process:

- Chapter 23, "Capturing Adverse Events and Complaints"
- Chapter 24, "Investigating Adverse Events and Complaints"
- Chapter 25, "Recording Product Analysis for AE CM"
- Chapter 26, "Managing CAPAs"
- Chapter 27, "Regulatory Reporting"
- Chapter 28, "Closing Adverse Events and Complaints"

Scenario for Customer Communication

This scenario is an example process performed by the Siebel administrator and the quality manager. Your company may follow a different process according to its business requirements.

This scenario is designed to illustrate the functionality of the Siebel AE CM.
Communicating with Customers for AECM  ■ Process of Customer Communication in AECM

The Siebel Administrator
The administrator sets up the Document Server and the Proposals, Presentations, and Correspondence templates that the quality manager uses to create customized reports, letters, and presentations. The administrator works closely with the quality manager who provides the text for the templates.

The Quality Manager
The quality manager is the owner of the complaint investigation about a faulty cartridge in a blood analyzer system. The investigation is coming to a close: the product analysis has been completed and a corrective action has been logged.

The quality manager has been assigned two activities:
- To communicate the status of the product issue with the customer who made the initial complaint
- To give a short presentation about the product issue at the CAPA team’s weekly meeting

To Brief the Customer
The quality manager prepares two sets of documents. First, she generates a report. The report takes a standard template for product issue reports and automatically incorporates data from the product issue into the report. She reviews the report in MS Word, making edits and changes as necessary.

There are five contacts associated with the account that made the initial complaint. As a courtesy, the quality manager wants to send each of them a copy of the report. She uses the Correspondence feature to generate five personalized cover letters to be mailed with the report.

To Present Data to Colleagues
The quality manager is routinely asked to present information about various product issues at the weekly CAPA meeting. The administrator has prepared a Power Point template which she uses to generate a standard product issue presentation, incorporating specific data from the selected product issue.

Conclusion
After mailing the report packages to the customer contacts and delivering her presentation at the CAPA meeting, the quality manager changes the status of her two activities to Closed.

Process of Customer Communication in AECM
This example process represents the tasks that are carried out in the “Scenario for Customer Communication” on page 447. Your company may follow a different process according to its business requirements.
Communicating with Customers for AECM

Setting Up Proposals, Correspondence, and Presentations

Administrator Procedures
- Setting Up Proposals, Correspondence, and Presentations on page 449

End-User Procedures
- Communicating about Product Issues Using Proposals (End User) on page 449
- Communicating about Product Issues Using Correspondence (End User) on page 450
- Communicating about Product Issues Using Presentations (End User) on page 450

Setting Up Proposals, Correspondence, and Presentations

Siebel Proposals, Correspondence, and Presentations allow your employees to create documents based on templates that you create in Microsoft Office.

This task is a step in “Process of Customer Communication in AECM” on page 448.

To set up proposals, correspondence, and presentations
- See Siebel Correspondence, Proposals, and Presentations Guide for how to:
  b. Install the correct version of Microsoft Office.
  c. Create field mappings.
  d. For proposals and correspondence, create template files in Microsoft Word.
  e. For presentations, create template files in Microsoft PowerPoint.
  f. Add the templates to the Siebel application.

<table>
<thead>
<tr>
<th>For This Template</th>
<th>Set the Category Field to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposal</td>
<td>Product Issue Proposal</td>
</tr>
<tr>
<td>Presentation</td>
<td>Product Issue Presentation</td>
</tr>
</tbody>
</table>

Communicating about Product Issues Using Proposals (End User)

During the course of an investigation, the quality manager may need to create reports containing information about the product issue.

Such reports, as Microsoft Word files, can be generated automatically, incorporating fields from the selected product issue. Predefined product issue proposal templates are set up by the administrator. End users can edit the generated report file in MS Word.
Communicating about Product Issues Using Correspondence (End User)

During the course of an investigation, the quality manager may want to send letters to the contacts associated with the product issue.

The Correspondence feature is used to generate MS Word files (typically letters) where the file is personalized for each contact. That is, information about the contact (name, address, and so on) is incorporated into the letter.

Information about the product issue cannot be incorporated using Correspondence. Use the Proposals feature to incorporate information about the product issue. Predefined correspondence templates are set up by the administrator. End users can edit the generated files in MS Word.

This task is a step in “Process of Customer Communication in AECM” on page 448.

To create a Microsoft Word correspondence

2. Drill down on a product issue.
3. Click the Contacts view tab.
   
   For information about creating correspondence, see Siebel Correspondence, Proposals, and Presentations Guide.

Communicating about Product Issues Using Presentations (End User)

During the course of an investigation, the quality manager might need to present information about the product issue.

To create a Microsoft Word report for a product issue

2. Drill down on a product issue.
3. Click the Proposals view tab.
   
   For information about creating proposals, see Siebel Correspondence, Proposals, and Presentations Guide.
Microsoft PowerPoint presentations can be generated automatically, incorporating fields from the selected product issue. Predefined product issue presentation templates are set up by the administrator. End users can edit the generated presentation file in MS PowerPoint.

This task is a step in “Process of Customer Communication in AECM” on page 448.

**To create a Microsoft PowerPoint presentation for a product issue**

2. Drill down on a product issue.
3. Click the Presentations view tab.

   For information about creating proposals, see *Siebel Correspondence, Proposals, and Presentations Guide*. 
This chapter describes how to use Personalized Content Delivery (PCD). It includes the following topics:

- “About Personalized Content Delivery” on page 453
- “Defining System Preferences for PCD” on page 453
- “Managing Content for PCD” on page 454
- “Working with Messaging Plans” on page 460
- “Accessing and Delivering Messaging Plans” on page 467
- “Using the PCD Viewer” on page 476

About Personalized Content Delivery

*Personalized Content Delivery* enables companies to deliver presentations that are tailored to meet customer needs using multimedia content. It allows sales teams to deliver the right message to the right customer at the right time. PCD enables sales representatives to optimize each selling opportunity, resulting in improved customer acquisition, satisfaction, and retention.

Sales representatives can use PCD to convey product messages to their customers during a face-to-face sales call. PCD is integrated into the call-reporting process for Siebel Pharma allowing sales representatives to:

- Present key messages and related information
- Capture responses
- Conduct assessments of the messages delivered
- Capture signature for samples

PCD automatically tracks all the interactions and the content presented. The PCD Viewer and PCD Planner leverage Adobe Flash Player technology to render the user interface (UI). The client machine must have Adobe Flash installed to allow users to use PCD functionality in a Siebel Business Application.

Defining System Preferences for PCD

Your system administrator must define the following system preferences before you can begin to use PCD.

- Server Uncompression Location
  
  Specifies the Siebel Server file path location from where uncompressed message files are cached.
Decompressed Files Path
Specifies the relative path to cache uncompressed message files when using Siebel Mobile Web Client.

CheckForNeedToSync
For remote users, only messages with the user property, NeedToSync, set to Y are decompressed. Otherwise, all messages are decompressed.

Skin
Specifies the theme as custom graphical appearances for PCD.

For more information about setting system preferences, see “Setting System Preferences for PCD” on page 494. Table 52 lists the system preference values that you need to set before you start using PCD.

Managing Content for PCD
Siebel Literature allows you to give your users access to sales and marketing literature, such as product brochures, white papers, data sheets, multimedia presentations, interactive presentations, and other types of literature items. For information about literature, see Siebel Applications Administration Guide.

PCD uses the content loaded in to the Siebel database. This content is defined as a literature item and the literature type is set to Message. The process for managing PCD content is as follows:

Create new content using content creation tools
Obtain Legal and Marketing approval for the content
Load the content into the Siebel Business Application
Verify the content
Provide access to content users who create messaging plans

This topic contains the following information:

“PCD Support for Content File Formats” on page 455
“Loading Content for PCD Usage” on page 455
“Associating Attributes with PCD Content” on page 457
“Adding Component Files to PCD Content” on page 458
“Verifying PCD Content” on page 459
“Providing Access to PCD Content” on page 460
“Providing Access to PCD Content” on page 460
PCD Support for Content File Formats

Users can create content using a number of third-party content creation tools. The following file types are among the most common:

- Adobe Flash (SWF)
- Portable Network Graphics (PNG)
- Graphics Interchange Format (GIF)
- Photographic Experts Group (JPEG and JPG)

**NOTE:** You can enable support for additional file formats such as Bitmap (BMP), Adobe Acrobat (PDF), Word (DOC), PowerPoint (PPT and/or PPS), and Excel (XLS) by editing the IsSupportedFormat calculated field. However, these file formats are not recommended for creating content.

In order to view a document in PCD, your computer must have the document's native application installed. For example, if you are trying to view a Microsoft Word 2000 document (.doc), Microsoft Word 2000 must reside on your computer.

For more information about the calculated fields for the PCD business components, see “PCD Business Component Calculated Fields” on page 497.

Loading Content for PCD Usage

You must create content before you can load it in your Siebel database. You can create the content using a content creation tool. After you have created a content file, create a literature record in the Siebel database to make the file available to users of Siebel Business Applications. In the Literature record, set the Literature Type field to Message to differentiate the content available to users in PCD from other document files loaded and managed in the Literature view.

**To create a literature record**

1. Navigate to the Administration - Document > Literature view.
2. In the Literature list, create a new record, and attach the literature file.
   - The new literature file is added to the available literature items. Some information is displayed in the Literature list view and the More Info view.
3. Enter the required information in the Literature list and the More Info views for the new record. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the literature record. It is recommended to remove any dot extension added in the Name field by default when you load the file.</td>
</tr>
<tr>
<td>File Name</td>
<td>Click Browse and in the Choose File dialog box, select the document file. You can also enter the file name manually.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Literature Type</td>
<td>Select the type of the literature as Message. You must set this field to Message type, because the Literature Type field is used to filter the literature items that are available in PCD.</td>
</tr>
<tr>
<td>Release Date</td>
<td>Select a date after which this content can be used in PCD. This is required for records of Literature Type equal to Message.</td>
</tr>
<tr>
<td>Expiration Date</td>
<td>Select a date after which this content should not be used in PCD. This is required for records of Literature Type equal to Message.</td>
</tr>
<tr>
<td>Distribution Method</td>
<td>Select Publish to automatically distribute the content to remote users based on permissions.</td>
</tr>
<tr>
<td>Questionnaire</td>
<td>(Optional). Click Browse and in the Questionnaire dialog box, select the Template Name that you want, and click OK. Sales assessment templates for Messages are created in Data Administration screen &gt; Sales Assessment Templates view, where assessment template type must be set to Message.</td>
</tr>
<tr>
<td>Thumbnail Image</td>
<td>(Optional). Click Browse and in the Images dialog box, select the image that you want and click OK. The associated thumbnail image file is used in PCD Planner.</td>
</tr>
<tr>
<td>Verification Status</td>
<td>Set to default value of Not Verified. After the Administrator verifies that the content can be loaded and displayed in PCD Viewer, the verification status is set to Success or Failed. For more information about verification, see “Verifying PCD Content” on page 459.</td>
</tr>
</tbody>
</table>
Click Show More to capture additional information about the new content.
Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synopsis</td>
<td>(Optional). Enter a brief synopsis of the content.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional). Enter a description of the content.</td>
</tr>
<tr>
<td>Subtype</td>
<td>(Optional). Use the drop-down list to select a subtype of the literature file.</td>
</tr>
<tr>
<td>Rating</td>
<td>(Optional). Select the rating for the content, if any.</td>
</tr>
<tr>
<td>Speaker Notes</td>
<td>(Optional). Enter any Speaker notes for the content.</td>
</tr>
<tr>
<td>Audience</td>
<td>(Optional). Enter the intended audience for the content.</td>
</tr>
<tr>
<td>External Author</td>
<td>(Optional). Enter the name of the author of the content.</td>
</tr>
<tr>
<td>Detail Product</td>
<td>(Optional). Click Browse and in the Pick Product dialog box, select the product name for which this message is created and click OK.</td>
</tr>
<tr>
<td>Legal Approval</td>
<td>(Optional). Select if content was approved by Legal.</td>
</tr>
<tr>
<td>Legal Approver</td>
<td>(Optional). Select the Legal approver of the content.</td>
</tr>
<tr>
<td>Legal Approval Date</td>
<td>(Optional). Select the date the content was approved by Legal.</td>
</tr>
<tr>
<td>Marketing Approval</td>
<td>(Optional). Select if content was approved by Marketing.</td>
</tr>
<tr>
<td>Marketing Approver</td>
<td>(Optional). Select the Marketing approver of the content.</td>
</tr>
<tr>
<td>Marketing Approval Date</td>
<td>(Optional). Select the date the content was approved by Marketing.</td>
</tr>
</tbody>
</table>

**NOTE**: Do not associate any Accounts, Competitors, Industries and Products to the content as this action might result in unnecessary distribution of content based on associated visibility.

In addition, do not change Local (Checked), Request (Unchecked), Update File (Checked) and Internal (Checked) fields. If you uncheck Internal, Literature is available as an enclosure in the Correspondence screen, and it is displayed in the Competitive Literature list of the Competitors screen.

**Associating Attributes with PCD Content**

You can associate attributes such as name, product, segment, and so on, with the PCD content to enable users to filter content based on the specified values.
To associate attributes with the PCD content

1. Navigate to the Administration - Document > Literature view.
2. In the Literature list, select a record.
3. Click the Applies To tab, and indicate which product, indications, decision issues, and therapeutic class that the message applies to.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product</td>
<td>Select the product that you want to apply to the message.</td>
</tr>
<tr>
<td>Indication</td>
<td>Use the drop-down list to select the indication for which the message was designed.</td>
</tr>
<tr>
<td>Issues</td>
<td>Use the drop-down list to select the issue that the message was designed to address.</td>
</tr>
<tr>
<td>Therapeutic Class</td>
<td>Use the drop-down list to select the therapeutic class for which the message was designed.</td>
</tr>
</tbody>
</table>

Adding Component Files to PCD Content

You might want to add additional component files to the PCD content. For example, the message might be composed of one or more files, such as logos, help text, and translation files. Other component files might contain dynamic content to promote content reuse.

Adding component files to PCD content

1. Navigate to the Administration - Document > Literature view.
2. In the Literature list, select a record.
3 Click the Component Files tab to indicate the component files that you want to add to the selected message, and click New. The Component Files dialog box is displayed.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description of the component file.</td>
</tr>
<tr>
<td>Literature Type</td>
<td>Use the drop-down list to select a literature type for this component file.</td>
</tr>
<tr>
<td>Subtype</td>
<td>Use the drop-down list to select a subtype. For example, Message, Video,</td>
</tr>
<tr>
<td></td>
<td>Document, Clinical Reprint, Case Study and so on.</td>
</tr>
<tr>
<td>Relationship Type</td>
<td>Use the drop-down list to select the relationship type of the file in relation to the message, for example, Help, Component File, Translation File, Logos, and so on.</td>
</tr>
</tbody>
</table>

**NOTE:** You can add only one help file to each PCD content record. In PCD Viewer, click the Help button to display the help component file associated with the message being presented.

### Verifying PCD Content

You must verify that the PCD content loads in to the Siebel database correctly, and that the content works as intended before making the content available to users of Siebel Business Applications. Ensure that any help files or assessments associated with the message displays properly.

You can click Verify to load and verify the PCD content. When you close the Verify window, you are prompted to select a verification status of Success or Failed.

**To verify PCD content**

1 Navigate to the Administration - Document > Literature view.
2 In Literature view, click Verify.
   
   The PCD content and component files are loaded, and a Verify window (PCD Planner) is launched in preview mode.
3 Check the content and ensure that all links are working.
4 Click Save and the Message Verification dialog displays.
5 Select the verification status, either Success or Failed.
   
   You can select Success, if the content is successfully loaded to PCD. If you select Failed, the content is not loaded, and the content might have to be revised. For example, you might have to recreate content using a compatible format.

   The result is written to the verification status field of the message record.
Providing Access to PCD Content

PCD content can be made accessible to brand managers and sales operation managers by adding appropriate categories to the Literature record. You can create private categories for users you want to have access to the content by associating the categories to the PCD content.

For more information about access groups, see Siebel Security Guide.

To add category information for PCD content

1. Navigate to Administration - Document > Literature > Category view.
2. Click Add and from the Sub Categories dialog, select the record that you want, and click OK.
3. Drill down on the Catalog Name and select Private in order to restrict visibility and to route the PCD content to the selected users.

Working with Messaging Plans

Messaging plans combine a number of messages in a specific sequence. For example, a presentation that comprises of a number of slides are displayed in a specific sequence. Messaging plans are created by brand managers, product managers, and sales operation managers. You can associate messaging plans with objectives for a sales representative. You can also associate messaging plans with marketing communications (Contact Call Offers) directed at a contact.

A high level process of messaging plans is as follows:

- Create, update and revise messaging plans
- Preview messaging plan
- Release messaging plan
- Provide sales representatives access to messaging plans
- Associate messaging plans to Objectives and Marketing Communications Offers

This topic contains the following information:

- “Creating and Editing Messaging Plans” on page 461
- “Updating Messaging Plans” on page 462
- “Releasing a Messaging Plan” on page 464
- “Providing Access to Messaging Plans” on page 464
- “Associating Help to Messaging Plans” on page 465
- “Revising Messaging Plans” on page 465
- “Associating a Messaging Plans with an Objective” on page 466
- “Associating a Messaging Plan with Contact Call Offers” on page 467
- “Decompressing PCD Content” on page 469
Creating and Editing Messaging Plans

After you have verified the approved PCD content and made it accessible to select users by adding appropriate private categories to the Literature record, you must create a messaging plan that can be distributed to the various sales representatives. The sales representative can use these messaging plans during their face to face calls with targeted customers.

To create a messaging plan

2. Click New to launch the Create Messaging Plan window.
   **NOTE:** This window is often referred to as PCD Planner when messages are loaded into the Siebel Business Application.
3. From the Create Messaging Plan window:
   a. Click the Items tab to view the content items that are available to you.
   b. Drag and drop individual items into the Presentation Items area to start creating your own customized messaging plan.

   You can associate additional items to be made accessible to the user as Related Messages and Detailed Messages when viewing a presentation item in PCD Viewer as follows:
   - Drag an item to the Presentation Items area.
   - Select the item, then drag and drop the item to the Related Messages or Detailed Messages area to automatically create an association with the selected additional items.
   c. Click the Plans tab to view previously created messaging plans that you might want to reuse.
   d. Drag and drop previously created plans to the Presentation Items, Related Messages and Detailed Messages area, as required.
4. Click More Information to view additional messaging plan information as required.

   For example, you can view a short description or some speaker notes to aid with the presentation of the message. You might also see some information about the audience for whom the message is targeted.
5. Click Filter if you want to search the messaging plan for a specific value.

   If the Items tab is selected, then the Filter tab shows the filter attributes for the messages, (that is, content items). If the Plans tab is selected, the Filter tab shows the filter attributes for the messaging plans.
   a. Enter the field attributes that you want to filter and click OK to start the filtering process.
   b. Click Reset to clear the messaging plan filter attributes previously set.
6. Click Save As to display the Save Messaging Plan dialog box.
7. Enter your messaging plan name.
8. Select the Product for which the messaging plan is being created.
9. Determine if the messaging plan can be customized by selecting Allow Personalization.
10 Select the Disclosure Mandatory option and define the disclosure message if disclosure is mandatory.

11 Click Save.

The Create Messaging Plan window closes and the Messaging Plan List view is displayed. The messaging plan is written to the Siebel database and is visible from the Messaging Plans screen.

After you have created a messaging plan, you can edit the plan by clicking the Edit button in the Messaging Plan Detail view.

To edit a messaging plan
1 From the Messaging Plan Detail view, select a record, drill down on the Name field, and click Edit.

You can modify any of the presentation items or related or detailed messages in your messaging plan.

2 Click Save.

3 (Optional) Click Preview if you want to review the messaging plan.

Updating Messaging Plans

When you have created your messaging plan, you can configure it to suit your specific requirements. When you navigate to Messaging Plans screen > Messaging Plans view and drill down on a messaging plan, you are presented with the Messaging Plans Detail view. Under the Presentation Items detail view tab are three applets namely Presentation Items, Related Messages and Detail Messages. All three applets are edit only. You cannot create new records or delete records here. These applets are populated when the Messaging Plan is created in PCD Planner (Create Messaging Plan window).

You can sequence the information to suit a particular presentation. You can also associate any related messages and detailed messages with the messaging plan.

Select the Assess Group tab to control access of the messaging plans, the related data, and component files. You can also add help text to your messaging plan to aid in the presentation of your message.

You can update the presentation details for a messaging plan.

To update the presentation details for a messaging plan
1 Navigate to Messaging Plans > Messaging Plans view.

2 In the Messaging Plan list, select a record, and drill down on the Name field.
3. Click the Presentation Items tab, and update the details for the presentation items.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence #</td>
<td>Display only. Shows the sequence number for this presentation item.</td>
</tr>
<tr>
<td>Name</td>
<td>Display only. Shows the name for the literature record.</td>
</tr>
<tr>
<td>Display Name</td>
<td>When a messaging plan is selected in PCD Viewer, its presentation items are</td>
</tr>
<tr>
<td></td>
<td>displayed as tabs. The name appearing on these tabs depends on the value</td>
</tr>
<tr>
<td></td>
<td>in this Display Name field. You can enter a display name of your choice.</td>
</tr>
<tr>
<td></td>
<td>The default value is equal to the Name field value.</td>
</tr>
<tr>
<td>Status</td>
<td>Use the drop-down list to select Show or Hide status for this presentation</td>
</tr>
<tr>
<td></td>
<td>item.</td>
</tr>
<tr>
<td>Disclosure</td>
<td>Disclosure Message is the disclosure content that needs to be displayed</td>
</tr>
<tr>
<td>Message</td>
<td>before this messaging plan is presented. One of the presentation items in a</td>
</tr>
<tr>
<td></td>
<td>messaging plan can be set as Primary. This primary presentation item in a</td>
</tr>
<tr>
<td></td>
<td>plan is called the disclosure message and always has a sequence # equal to</td>
</tr>
<tr>
<td></td>
<td>0.</td>
</tr>
<tr>
<td></td>
<td>If a messaging plan is selected for presentation in PCD Viewer and the</td>
</tr>
<tr>
<td></td>
<td>disclosure mandatory flag for the plan is equal to Y, then this disclosure</td>
</tr>
<tr>
<td></td>
<td>message is automatically presented. If you add a new physician to the</td>
</tr>
<tr>
<td></td>
<td>messaging plan, the disclosure message is displayed. If the disclosure</td>
</tr>
<tr>
<td></td>
<td>mandatory flag for the messaging plan is equal to N, then the disclosure</td>
</tr>
<tr>
<td></td>
<td>message is shown only if the sales representative clicks on the Show Disclosure button in the PCD Viewer.</td>
</tr>
<tr>
<td>Questionnaire</td>
<td>Select the Template Name that you want to add to this presentation item.</td>
</tr>
<tr>
<td></td>
<td>Sales assessment templates for Messages are created in Data Administration</td>
</tr>
<tr>
<td></td>
<td>screen &gt; Sales Assessment Templates view, where assessment template type</td>
</tr>
<tr>
<td></td>
<td>must be set to Message.</td>
</tr>
<tr>
<td>Synopsis</td>
<td>Enter a brief description for the presentation item.</td>
</tr>
<tr>
<td>Speaker Notes</td>
<td>Add your notes for this presentation item.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a brief description of the contents for this presentation item.</td>
</tr>
<tr>
<td>Type</td>
<td>Display only. Shows the literature sub type field in Literature list applet</td>
</tr>
<tr>
<td></td>
<td>in Administration - Document &gt; Literature view.</td>
</tr>
<tr>
<td>Rating</td>
<td>Use the drop-down list to select a rating for this presentation item.</td>
</tr>
<tr>
<td>Audience</td>
<td>Enter the type of user for which the content is targeted.</td>
</tr>
</tbody>
</table>
Releasing a Messaging Plan

You can only revise a messaging plan if its status is equal to either Approved or Released. When you create a new messaging plan, its status is In Progress. The messaging plan must go through the approval process. You must set the status to Submitted and associate a required category with the messaging plan so that approvers have access to the messaging plan.

The approver can then set the status of the messaging plan to either Approved or Rejected. If the status is Approved, then you can release the messaging plan by setting the status to Released and by associating the required category with the messaging plan to make it visible to the required sales representatives.

*To release a messaging plan*

2. Select Submitted from the Status drop-down list to submit the messaging plan for approval.
3. Associate the category to make the messaging plan accessible to the approver.

   The approver approves the messaging plan by changing the status field to Approved.

Finally, the owner can release the messaging plan by setting the status to Released.

Providing Access to Messaging Plans

You can control access to the messaging plan, presentation items, related messages, and detailed messages.

*To assign access groups to a messaging plan*

2. In the Messaging Plan list, select a record, and drill down on the Name field.
3. Click the Access Group tab, and then click Add to add access group details for the messaging plan.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Name</td>
<td>Enter the category name associated with the messaging plan, presentation</td>
</tr>
<tr>
<td></td>
<td>items, related messages, and detailed messages.</td>
</tr>
<tr>
<td>Display Name</td>
<td>Enter the display name for the access group.</td>
</tr>
<tr>
<td>Catalog Name</td>
<td>Enter the catalog name used to control access to the messaging plan,</td>
</tr>
<tr>
<td></td>
<td>presentation items, related messages, and detailed messages.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the access group.</td>
</tr>
</tbody>
</table>
Select a record, and click Delete if you want to remove an access group.

Click Refresh Cache to view the recent changes to your messaging plans.

**Associating Help to Messaging Plans**

You can create help text for your messaging plan.

*To associate help text for a messaging plan*

2. In the Messaging Plan list, select a record, and drill down on the Name field.
3. Click the Help File tab, click New, and add the help text for the messaging plan.

Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the help file.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description of the help file.</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Use the drop-down list to select a sub type for the help file.</td>
</tr>
<tr>
<td>Literature Type</td>
<td>Use the drop-down list to select a literature type for the help file.</td>
</tr>
</tbody>
</table>

4. Select a record, and click Delete if you want to remove the help text for a specific messaging plan.

**Revising Messaging Plans**

You can only revise a messaging plan with status of Released. Revising a messaging plan creates a new copy of the original messaging plan and increments the version number. After you make modifications, the new version of the messaging plan can be released.
You can also specify a Start Date and an Expiry Date for a messaging plan. Release Date, Start Date and Expiry Date control when users with access to a messaging plan can start to use the messaging plan in PCD Viewer during calls with customers.

**NOTE:** When you revise a messaging plan, a new version number is created and the revised messaging plan must go through the same approval process before it become active. When the new version is active, the older version does not become inactive.

**To revise a messaging plan**

2. In the Messaging Plan list, select a record that has a status of Released.
3. Click Revise, and enter the revised information for the messaging plan.

Two or more versions of a messaging plan can be active simultaneously. A messaging plan is active if the release date is before or is today’s date, and is before the expiration date. When you load messaging plans in PCD Viewer, only the highest, active version of a messaging plan is loaded. For more information about loading messaging plans in PCD Viewer, see “Availability of Messaging Plans in the PCD Viewer” on page 496.

**Associating a Messaging Plans with an Objective**

You can define multiple objectives for your call plan period. You can associate messaging plans with these objectives. When associating messaging plans, you must provide a segment code for each association. The segment code indicates which messaging plan to recommended for which segments of the targeted contacts.

A single messaging plan can be associated with multiple objectives, and multiple messaging plans can be associated with a single objective. You can also have the same target segment code for multiple messaging plans.

**To specify a segment code for a target**

1. Navigate to Objectives > My Objectives screen.
2. Select a record, and drill down on the Objective field.
3. Click on Targets tab and click New to select the targeted contacts.
4. For each target, specify a Segment value, for example High, Medium, or Low.

**To associate a messaging plan with an objective**

1. Navigate to Objectives > My Objectives screen.
2. Select a record, and drill down on the Objective field.
3. Click the My Messaging Plans List tab, and then click New to select the messaging plan to associate with the objective.
For each associated messaging plan, specify a Segment field value equal to the value that you specified for the target, for example, High, Medium, Low. This action indicates which messaging plan to use with which segment of the target contacts.

When you create a new call on target contact, you can select the Objective for the call. When you click Detail in Call Detail View, PCD compares the segment code on the target to find the recommended messaging plans that are accessible to you. These messaging plans are displayed on the top in PCD Viewer. For more information about recommended messaging plans, see "Recommended Messaging Plans" on page 500.

**Associating a Messaging Plan with Contact Call Offers**

Brand teams create new Contact Call offers as part of the campaign planning and execution process. The Contact Call offers are marketing communications that can be delivered by sales representatives as part of their face to face calls. Once a messaging plan is created and released, you can navigate to Offers > Contact Call Offers view to associate a messaging plan with the Contact Call offer.

You can view the marketing communications (offers) targeted to a contact when planning a Contact Call. When you launch the PCD Viewer for a call on a target contact, PCD loads the messaging plan associated to the Contact Call offers accessible to you for the target contact as recommended messaging plans. You can use switch presentation and select the appropriate messaging plan.

**To associate messaging plans with contact call offers**

1. Navigate to Offers > Contact Call Offers screen.
2. Select a record, and drill down on the Name field.
3. Click the My Messaging Plans List tab, and then click New to create a new record.
4. Click on the Name field picklist to associate a messaging plan with the Contact Call Offer.

**Accessing and Delivering Messaging Plans**

PCD enables sales representatives to provide high impact presentations using multimedia visualization content created by the marketing teams. The PCD Viewer provides the mechanism to start an interaction session, switch between different product messages, show related collateral, show detailed level messages, or collect feedback.

PCD Viewer auto-loads the optimal set of messaging plans for each customer visit. You can capture electronic signatures for samples during a call or visit. PCD Viewer tracks the messages presented and the time spent on each message. You can indicate a physician’s response and add notes based on a call or conversation.

You can start an interactive customer interaction session in several ways by accessing the PCD Viewer from the Contact Call Detail screen, the Account Call detail screen or the Account Contact Call Detail screen.
To start the PCD Viewer from the Call Detail screen

1. Navigate to Activities > Contact Call Detail screen. Alternatively, navigate to Activities > Account Call Detail screen.
2. Create a New Call.
3. For Contact Calls, add any samples drops, if required.
   **NOTE:** You will need to pre-record the sample drops if signature needs to be captured from contact. Signatures for Samples can be captured only for contacts valid to receive and sign for samples. For more information about signature capture, see Chapter 9, “Recording Calls in Pharma.” For more information about samples, see Chapter 8, “Managing Pharma Samples.”
4. Click Detail to display the PCD Viewer.
   PCD viewer auto-loads the optimal set of messaging plans for each customer interaction.
5. Review the loaded messages and the various messages plans in preview mode.
6. Click the Click To begin button from the PCD Viewer toolbar when you are ready to meet your contact.
7. Present the various messages and message plans. For more information about presenting your message, see “Using the PCD Viewer” on page 476.
8. Click Open Questionnaire if a questionnaire is associated to a message.
   In PCD Viewer, if a presentation item has an associated Questionnaire, the toolbar displays a flashing (or glowing) button. You can click this flashing button to display the Questionnaire and capture a physician's response.
9. Capture the physician's response and click on Close to close the dialog box when complete.
10. Click Close or Sign from the PCD Viewer toolbar when you have completed the details.
    If you click Sign, the Signature Capture view is displayed when the call data is validated.
    If the validation for Signature Capture fails, an error message is displayed. Update the call data as directed by the error message, and then click Sign to try capturing the signature again. Once you successfully save the signature, you return to the Contact Call view.
    **NOTE:** For Account Call, the PCD Viewer toolbar does not display the Sign button.
    If you click Close, you return to the Contact Call view.

PCD automatically updates the:
- Presentation Details Applet with tracking information about your customer interaction, navigation path, content used and time spent on each asset.
- Products Detailed Applet based on the Messaging Plans for various products used by you during the customer interaction.
- Questionnaire applet based on the questions and response you captured during your customer interaction.
11. Update the call data as required and then submit the call.
Decompressing PCD Content

As part of remote synchronization based on catalog visibility, all new messaging plans and PCD content files are automatically downloaded to the remote client. Sales representatives must decompress and cache the PCD content before they can use the new PCD content and messaging plans for an interactive session during a call.

Click the Decompression button from the Siebel Application toolbar. Literature records have a calculated field called, NeedToSync. The value of this field is set to True if the record is modified after decompression.

If the value of the user property, CheckForNeedToSync, is set to Y, then the next time you click the Decompression button, only messages with the user property, NeedToSync, set to Y are decompressed. Otherwise, all messages are decompressed.

For more information about how PCD content decompression works, see “Setting System Preferences for PCD” on page 494.

Using Signature Control

With signature control, users can capture signatures for samples disbursement to qualified contacts.

This section contains the following topics:

■ ”About Loading Signature Control” on page 469
■ ”Configuring Signature Control Modes” on page 470
■ ”Signature Capable Messages” on page 471
■ ”Capturing a Signature” on page 473
■ ”Modifying Contacts in the Signature Component” on page 474
■ ”Deleting a Sample Row” on page 475
■ ”Cancelling a Transaction” on page 475
■ ”Viewing all Captured Signature Data” on page 475

About Loading Signature Control

There is a separate component for capturing signatures in Flex. This component is available in PCD as an SWF file called SignatureCtrl.swf.

Signature control can be loaded in PCD using three different modes:

■ **Mode 1.** A signature message is defined on the message plan and the current message has an allocated space for the signature control. For information about configuring this mode, see “Configuring Mode 1 Signature Control” on page 470.

■ **Mode 2.** A signature message is not defined on the message plan and the current message has an allocated space for the signature control. For information about configuring this mode, see “Configuring Mode 2 Signature Control” on page 470.
Mode 3. A signature message is not defined on the message plan and the current message does not have an allocated space for the signature control. This is the default configuration, no additional configuration is needed for this mode.

Configuring Signature Control Modes
This section outlines the required configuration steps for different signature control modes. For additional information about the modes available, see “About Loading Signature Control” on page 469.

Configuring Mode 1 Signature Control
This topic contains information about configuring signature control for mode 1. When the instructions in this section are applied to a messaging plan, the specified signature message will be displayed when the representative clicks Sign.

To configure mode 1 signature control
1. Navigate to Administration-Document > Literature screen.
2. Load the signature message in view, as explained in the “Loading Content for PCD Usage” section.
3. Set the value of field SubType to Signature Capable. For additional information about signature capable messages, see the “Signature Capable Messages” section.
5. Click the name of the messaging plan to which you want to associate the signature message.
6. Click the Signature Asset tab.
7. Click the New button and associate a signature message with the messaging plan.

Configuring Mode 2 Signature Control
This topic contains information about configuring signature control for mode 2. When the instructions in this section are applied to a messaging plan, the specified signature message will be embedded in the message that is being played at that moment.

To configure mode 2 signature control
1. Navigate to Administration-Document > Literature screen.
2. Load the signature message in view, as explained in the “Loading Content for PCD Usage” section.
3. Set the value of field SubType to Signature Capable. For additional information about signature capable messages, see the “Signature Capable Messages” section.
5. Click New to create a new plan or click edit button to edit a plan.
6. While creating or updating a plan, add the signature message to the plan as a presentation item.
Signature Capable Messages
A signature capable message is an SWF file that has a space allocated in it for displaying the PCD signature control: SignatureCtrl.swf. The file communicates with both the signature control and the PCD application.

To properly implement a signature capable message certain requirements are member variables must be set, and certain methods must be applied. Follow the requirements in the following sections before using signature control:

- “Member Variable Requirement for Signature Capable Messages” on page 471
- “Method Requirements for Signature Capable Messages” on page 471

Member Variable Requirement for Signature Capable Messages
In order to hold a pointer to the SignatureCtrl.swf embedded within the message set the following variable:

```javascript
private var m_signCtrl:SystemManager;
```

This pointer will be used to invoke methods in SignatureCtrl.swf

Method Requirements for Signature Capable Messages
The following method requirements must be met in order to properly implement signature control:

- The `appLoaded` method must be called on the `applicationComplete` event with the following predefined string:
  ```javascript
  Application.application.signAssetLoadComplete(this);
  ```
  For an example of this method requirement, see "FlexApp appLoaded Example" on page 472

- The `loadSignCtrl` method will be called by the Interactive Detailer to notify the Asset with the path of the SignatureCtrl.swf and asset will load.
  For an example of this method requirement, see "FlexApp LoadSignCtrl Example” on page 472

- The `InvokeSignCtrlMethod` method will be called by the Interactive Detailer to invoke a method in SignatureCtrl.swf by way of the Asset.
  For an example of this method requirement, see “FlexApp InvokeSignCtrlMethod Example” on page 473

FlexApp Examples
FlexApp is a sample signature asset created in Flex. This asset has the following minimum method requirements:

- Loading the SignatureCtrl.swf
- Enabling communication between the Interactive Detailer and the signature control, by way of the Signature Asset
**FlexApp appLoaded Example**

FlexApp.mxml has a method called appLoaded. The `appLoaded` method is called by the `applicationComplete` event. The call is shown in the following sample:

```xml
<mx:Application .................applicationComplete="appLoaded();"/>

...............public function appLoaded():void
{
    Application.application.signAssetLoadComplete(this);
}
```

The `appLoaded` method notifies the parent application -- in this case Interactive Detailer -- that the Signature Asset is loaded and ready to load `SignatureCtrl.swf`, using the following statement:

```java
Application.application.signAssetLoadComplete(this);
```

Where `Application.application` refers to Interactive Detailer and `signAssetLoadComplete` refers to a method in Interactive Detailer that receives a pointer to the Signature Asset as an input parameter. This pointer will be used by the Interactive Detailer to send data to the `SignatureCtrl.swf` embedded in the Asset.

**FlexApp LoadSignCtrl Example**

FlexApp.mxml has member variable of type `SystemManager`. This member variable holds a pointer to the `SignatureCtrl.swf` embedded within the asset. The pointer is shown in the following sample:

```java
private var m_signCtrl:SystemManager;

public function loadSignCtrl(strSignCtrl:String):void
{
    loader.autoLoad = true;
    loader.percentHeight = 100;
    loader.percentWidth = 100;
    loader.load(strSignCtrl);
    loader.addEventListener(Event.INIT, loadComplete);
    loaderBox.addChild(loader);
}

private function loadComplete (event:Event) : void
{
```
m_signCtrl = SystemManager(event.target.content);

The Interactive Detailer sends the path of SignatureCtrl.swf and notifies the Signature Asset to load the Signature Control by calling a method called loadSignCtrl. This is all implemented by the Asset.

The Signature Asset method, loadSignCtrl, will load SignatureCtrl.swf into an SWF loader. The pointer to SignatureCtrl.swf is stored in the member variable m_signCtrl, as displayed above in loadComplete function.

**FlexApp InvokeSignCtrlMethod Example**

FlexApp.mxml also implements a method called InvokeSignCtrlMethod. When the Interactive Detailer is required to send data to SignatureCtrl.swf, it does so by calling this method in the Asset. The following XML data is passed to the Asset:

```xml
class FlexApp
{
  public function InvokeSignCtrlMethod(strXMLData:String):void
  {
    if(m_signCtrl != null)
      Object(m_signCtrl.application).InvokeMethod(strXMLData);
  }
}
```

**Capturing a Signature**

With signature control, users can capture signatures for samples disbursement.

**To capture a signature**

1. Navigate to Activities > Contact Call Detail screen. Alternatively, navigate to Activities > Accounts Contacts Call Detail screen.

2. Select a sample from Samples Dropped.
   
   **NOTE:** You will need to pre-record the sample drops if the signature needs to be captured from contact. Signatures for Samples can be captured only for contacts valid to receive and sign for samples. Click Detail to display the PCD Viewer.

   The PCD viewer auto-loads the optimal set of messaging plans for each customer interaction.

3. Click Sign from the PCD Viewer toolbar.
   
   **NOTE:** The Sign button in the PCD viewer will only be visible if there is at least one sample drop record in the samples dropped applet in call detail view.

   

---

**Siebel Life Sciences Guide** Version 8.0, Rev. D

---
In the Signature Component, a white space is reserved for a signature. Sign within the white space reserved for the signature.

If the validation for Signature Capture fails, an error message is displayed. Update the call data as directed by the error message, and then click Sign to try capturing the signature again. Once you successfully save the signature, you return to the Contact Call view.

For additional information about signature validation, see “Configuring the Sign Button” on page 176.

Click Save to save the signature.

Modifying Contacts in the Signature Component
A representative can change the contact to another contact within the signature component.

For example, a representative is speaking with Dr. A. A Contact Call Record has already been created for Dr. A. The representative adds sample drop records to this call by clicking the Detail button in Call view. Now consider that the signature was captured for Dr. A and saved. The status of the record has been changed to Signed.

If instead of Dr. A, the representative selects a different contact: Dr. B. The signature control will then create a new contact call record in the Siebel database for Dr. B, and the sample records will be copied over to the new call. This new call will be validated, and the signature is captured and saved and the status of the call record will be set to Signed.

The module will only allow the representative to change the contact if the validation process confirms that the contact is eligible. Otherwise, an error message will appear.

To modify contacts in the signature component
1. Navigate to Activities > Contact Call Detail screen. Alternatively, navigate to Activities > Accounts Contacts Call Detail screen.
2. Select a sample from Samples Dropped.
3. Click Detail to display the PCD Viewer.
   The PCD viewer auto-loads the optimal set of messaging plans for each customer interaction.
4. Click Sign from the PCD Viewer toolbar.
5. Click the Change Professional button.
6. Select the desired contact.
7. Click Select.
   **NOTE:** If the contact does not have a license for the geographic region, a Sign Validation Failed message will appear indicating the following: *This contact does not have a license number for <region>*.
8. Click Save.
Deleting a Sample Row
A representative can delete a sample in signature component. For example, if the representative is speaking with Dr. A and discovers that the sample is not of use, the sample row can be deleted.

To delete the sample row in the signature component
1. Navigate to Activities > Contact Call Detail screen. Alternatively, navigate to Activities > Contact Call Detail screen.
2. Select a sample from Samples Dropped.
3. Click Detail to display the PCD Viewer.
   - The PCD viewer auto-loads the optimal set of messaging plans for each customer interaction.
4. Click Sign from the PCD Viewer toolbar.
5. Click the Delete button next to the sample that you want to delete.
6. Click Save.

Cancelling a Transaction
The following topic describes how to cancel a transaction. The Cancel button will cancel but will not delete all of the data associated with the transaction. When the Cancel button is clicked, it marks the transaction as voided, but is sent back to the system as a no signature activity.

To cancel a transaction
1. Navigate to Activities > Contact Call Detail screen. Alternatively, navigate to Activities > Accounts Contacts Call Detail screen.
2. Select a sample from Samples Dropped.
3. Click Detail to display the PCD Viewer.
   - The PCD viewer auto-loads the optimal set of messaging plans for each customer interaction.
4. Click Sign from the PCD Viewer toolbar.
5. Capture a signature.
6. Click Cancel.

When you click the Cancel button in signature control, a cancelled transaction record will be written to the Siebel database only if the transaction was valid. A transaction is valid only when it passes all the validation checks and the signature was captured but the action was cancelled.

Viewing all Captured Signature Data
Once a signature is captured, it is stored in the Siebel database for future reference. You can view all of the captured signature data in one location.
To view all captured a signature
1. Click the Site Map.
2. Navigate to Administration - Samples > Sample Audit Administration.
3. Scroll through the list to view all of the signatures. Sort the columns by the criteria that you want.
   **NOTE:** You can click Query to search for a signature.

Using the PCD Viewer
The PCD Viewer provides a mechanism to deliver interactive, digital-marketing content. It enables you to chat, present key messages, use highly-interactive content created using Adobe Flash, video and other formats.

The icons available from the PCD Viewer toolbar are described in **Table 41**.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟🌟🌟🌟🌟</td>
<td>You can quickly capture responses by selecting the right option. For example, click on the first star to denote Continue Discussion. Click the second star to denote Need Data, the third star might denote Accepted, the fourth star might denote Not Interested and the final star might denote that the customer has Rejected the message. <strong>NOTE:</strong> The number of stars and the associated values is controlled by a List of Values defined for <code>PCD_RESPONSE_TYPE</code>.</td>
<td>None</td>
</tr>
<tr>
<td>📝</td>
<td>Click to close and sign. Sign can immediately navigate you to Signature Capture for Samples screen.</td>
<td>CTRL + I</td>
</tr>
<tr>
<td>🔒</td>
<td>Click to save the session. PCD automatically tracks and updates all the interactions and responses along with duration and sectional information. It also automatically updates the products detailed.</td>
<td>None</td>
</tr>
<tr>
<td>✍️</td>
<td>Click to switch to markup mode where you may have access to markup capabilities to support the discussion.</td>
<td>CTRL + M</td>
</tr>
<tr>
<td>🗑️</td>
<td>Erase all markups.</td>
<td>CTRL + E</td>
</tr>
<tr>
<td>🎥</td>
<td>Click to add a contact to this session. For example, in group practices, you can easily add multiple physicians to a session.</td>
<td>CTRL + SHIFT + Y</td>
</tr>
</tbody>
</table>
### Table 41. PCD Viewer Toolbar Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>Click to switch between different product messages.</td>
<td>CTRL + 3</td>
</tr>
<tr>
<td>![Lock Icon]</td>
<td>Click to lock the PCD Viewer. A numeric keypad will appear with a prompt asking you to enter a number between 5 and 8 digits. This number will be required to unlock the PCD viewer.</td>
<td>CTRL + 8</td>
</tr>
<tr>
<td>![Question Mark Icon]</td>
<td>Click to view help associated with the message you are viewing.</td>
<td>CTRL + 1</td>
</tr>
<tr>
<td>![Questionnaire Icon]</td>
<td>Click to open questionnaire. You can also capture physician’s attitude, beliefs and needs using the questionnaires associated to different messages.</td>
<td>CTRL + 5</td>
</tr>
<tr>
<td>![Disclosed Icon]</td>
<td>Click to show disclosure message.</td>
<td>None</td>
</tr>
<tr>
<td>![Related Messages Icon]</td>
<td>Click to show related messages. You have access to related messages such as clinical reprints, case studies and so on.</td>
<td>CTRL + 7</td>
</tr>
<tr>
<td>![Drill Down Icon]</td>
<td>Click to drill down to detailed messages.</td>
<td>CTRL + 2</td>
</tr>
<tr>
<td></td>
<td>Move to previous slide.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>Move to next slide.</td>
<td>None</td>
</tr>
</tbody>
</table>
This appendix contains information on configuring the Siebel Life Sciences application using Siebel Tools. It assumes that you are familiar with the processes and conventions of working with Siebel Tools to change one or more user properties. For further information about changing user properties, see Configuring Siebel Business Applications.

This appendix contains information about the following topics:

- “Targeting Configuration” on page 480
- “New Visit Type Configuration” on page 481
- “Sequential Priority Configuration” on page 482
- “Enabling Inventory Reconciliation Without Lot Numbers” on page 482
- “Business Component User Properties” on page 483
- “Configuring the Visit Generation Buttons” on page 489
- “Editing the Labels of the LS Pharma HI Activity Calendar View Buttons” on page 491
- “Special MedEd Classes—User Properties” on page 491
- “Submitting Contact Details from Third-Party Applications” on page 491
- “Accounts Contacts Configuration” on page 493
- “Configuring Personalized Content Delivery” on page 493
Targeting Configuration

The Siebel Life Sciences targeting engine can be configured through the user properties found in Table 42 and Table 43. Table 42 details the TargetCategory user properties.

Table 42. TargetCategory User Property

<table>
<thead>
<tr>
<th>Field</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required</td>
<td>TargetCategory.</td>
</tr>
<tr>
<td>Changed</td>
<td>Read-only</td>
<td>An indicator of whether or not the user property is changed.</td>
</tr>
<tr>
<td>Value</td>
<td>Required</td>
<td>A value that the targeting engine uses to determine which saved lists are available to the business component. This value is strictly user-defined. Siebel Pharma ships with the default values, Contacts, for contact-related business components and, Accounts, for account-related business components. One TargetCategory can be active for each business component.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Optional</td>
<td>An indicator of whether the user property is active.</td>
</tr>
<tr>
<td>Comments</td>
<td>Optional</td>
<td>Comments describing the user property.</td>
</tr>
</tbody>
</table>

Table 43. TargetId User Property

<table>
<thead>
<tr>
<th>Field</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required</td>
<td>TargetId.</td>
</tr>
<tr>
<td>Changed</td>
<td>Read-only</td>
<td>An indicator of whether or not the user property is changed.</td>
</tr>
<tr>
<td>Value</td>
<td>Required</td>
<td>A value the targeting engine uses to determine the field in the business component that will be matched against the saved list ID. If the TargetId record is not defined as a user property for the business component, the targeting engine defaults to ROW_ID. One TargetId can be active for each business component.</td>
</tr>
<tr>
<td>Inactive</td>
<td>Optional</td>
<td>An indicator of whether the user property is active.</td>
</tr>
<tr>
<td>Comments</td>
<td>Optional</td>
<td>Comments describing the user property.</td>
</tr>
</tbody>
</table>
With these user properties, you can apply a target list in other business components and indicate what value in the business component will be stored for later retrieval. For example, to allow targeting functionality on opportunities, add the user property in Table 44 to each Opportunity business component.

Table 44. Example TargetCategory User Property

<table>
<thead>
<tr>
<th>Field</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required</td>
<td>TargetCategory.</td>
</tr>
<tr>
<td>Changed</td>
<td>Read-only</td>
<td>An indicator of whether the user property is changed (optional).</td>
</tr>
<tr>
<td>Value</td>
<td>Required</td>
<td>“Opportunity” (or any value you choose).</td>
</tr>
<tr>
<td>Inactive</td>
<td>Optional</td>
<td>An indicator of whether the user property is active.</td>
</tr>
<tr>
<td>Comments</td>
<td>Optional</td>
<td>Comments describing the user property.</td>
</tr>
</tbody>
</table>

Once active, this user property will allow users to save a target list of opportunities and apply the list across screens in any opportunity-related business component.

**New Visit Type Configuration**

Using Siebel Tools, you can configure buttons that allow you to generate specific visit-type activities based on predefined visit templates. The default configuration provides three default buttons: Screen, Rescreen, Enroll. It uses user properties found in Table 49 on page 489.

- Create a date field in the Clinical Subject business component, and create a date field with the same name in the LS Subject Status Date VBC business component. This date is used as a starting point for all your visit activities. Visits and Activities in the template belonging to the new visit type are calculated based upon the date entered in this date field and the lead time for the visit or activity.

- Put the user properties in this field. See Table 49 on page 489 for information on what to set for the user properties. You may need to create a new list of values for the Template Type Code and Subject Status Code.

- Create a new pop-up dialog box based on LS Subject Status Date VBC business component that displays when a button is clicked from the form. Base the pop-up dialog box on the CSSFramePopupVstTmpIdt class. The only required value in this pop-up dialog box is the VisitTemplateDate control. This date field maps to the date field in the LS Subject Status Date VBC created above. All fields in this dialog box are treated as required fields. The users must fill in data for each field.

- Add the button to the list or form.

**NOTE:** The best way to configure these buttons is to copy one of the default button configurations and apply the same properties to your new button.
Sequential Priority Configuration

As mentioned in Chapter 9, "Recording Calls in Pharma," the Siebel administrator can configure the Priority field in the Call Products Detailed list to allow each record added to the list to be sequentially and uniquely numbered, with the first record receiving 1. In the preconfigured application, more than one record can contain 1 in the Priority field.

To enable sequential numbering in the Priority field
1. In Siebel Tools, select the Business Component object in the Object Explorer.
2. Query for Pharma Account Call.
3. Lock the associated project, for example Pharma Call.
4. Expand the Business Component object and select the Business Component User Prop object.
5. Change the Value field to Y for the Validate Product Priority business component user property.
6. Repeat Step 1 through Step 5, running a query for the Pharma Professional Call business component in Step 2.
7. Compile the SRF file, selecting the Locked projects radio button.
8. Relaunch the application.

Enabling Inventory Reconciliation Without Lot Numbers

As discussed in Chapter 8, "Managing Pharma Samples," Siebel Pharma allows you to create sample products and associate lot numbers with the samples, then ship and disburse samples by lot numbers while maintaining and reconciling inventory without lot numbers.

Retaining Sample Product Visibility
To allow inventory without lot numbers while retaining sample product visibility, the administrator must do the following:

- Use Siebel Tools to reconfigure fields and replace business components
- Set the value of the Lots For Disperse Only system preference to TRUE
- Check the Lot# Tracking flag in the Administration - Product screen
- Use the newly complied SRF.

To reconfigure fields and replace business components
1. Open Siebel Tools.
2. Choose View > Object Explorer > Flat tab.
3 Select Fields, and in the Fields list, query in the Picklist Column for PickList Pharma Samples Stocked Lots.

4 Lock each project by choosing Tools > Lock Project.

5 In the Picklist column, replace each occurrence of PickList Pharma Samples Stocked Lots with Picklist Pharma All Unexpired Lots.

6 Choose View > Object Explorer > Types tab.

7 Select Applet, and in the Applet list, query for any applet with the value Pharma Stocked Lot Pick Applet.

8 For each occurrence, set the Business Component to Pharma Sample Lot for Picklist.

9 Compile the SRF.

**To change the system preferences and enable Lot# tracking:**

1 Logon to the Pharma web client as an administrator.

2 Navigate to the Administration - Application screen > System Preferences view.

3 Query for the following System Preference Name records:
   ■ Lots For Disperse Only
   ■ Samples Lots Enabled

4 Set the System Preference Value for each of these records to TRUE.

5 Navigate to the Administration - Product screen > Products view, and check the Lot# Tracking flag for each product that requires inventory reconciliation of samples without lot numbers.

6 Logoff the Pharma web client.

**To use the newly compiled SRF**

1 Stop the Siebel Server.

2 Copy the newly compiled SRF to the \siebsrvr\objects\enu folder.

3 Restart the Siebel Server.

**Business Component User Properties**

Siebel business components are based on the CSSBusComp class directly, or on a C++ class derived from CSSBusComp. Business component user properties allow Siebel configurators to control and adjust the behavior of Siebel Life Sciences using Siebel Tools.
General Business Component User Properties

Table 45 lists the user properties that are general and can apply to any business component.

Table 45. User Properties for All Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TargetCategory</td>
<td>Value</td>
<td>User-defined value that connects different business components together so that they interact for the targeting feature. Example: Contacts</td>
</tr>
<tr>
<td>TargetId</td>
<td>Field</td>
<td>Field from the business component you want to save as the ID of the list and use when applying a target list to this business component. Example: Contact Id</td>
</tr>
</tbody>
</table>

Specific Business Component User Properties

The following business component user properties are specific to a particular C++ class. This means that the properties are valid only for business components that are based on the C++ class implementing the user property or any of the related derived C++ classes.

Group 1 Business Components

Table 46 lists the user properties that are related to the following business components:

- Action (class CSSBCActivity)
Calendar (class CSSBCCalendar)

Table 46. User Properties Related to Group 1 Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read-only Activity Types</td>
<td>,ActivityType1, Activity Type2,..., Value must start and end with a comma, and no spaces between values. Example: ,Attendee Call, Meeting Invitee,</td>
<td>Tells the business component which activity types are to be read-only at the record level. Activity Type is the field category.</td>
</tr>
<tr>
<td>Read-only Fields for 'Activity Type' Activity Type is the category value. Example: Read-only Fields for 'Account Call'</td>
<td>,field1, field2,..., Value must start and end with a comma, and no spaces between values. Example: ,Contact Last Name, Opportunity,</td>
<td>Tells the business component which fields are to be read-only for a particular activity type. Activity Type is the field category.</td>
</tr>
<tr>
<td>Status Field</td>
<td>Field Field from the business component.</td>
<td>Tells the business component which field is to be used to indicate the status.</td>
</tr>
</tbody>
</table>

Group 2 Business Components

Table 47 on page 486 lists the user properties that are related to the following business components:

- Pharma Call Products Detailed (class CSSBCProductDetailed)
Table 47. User Properties Related to Group 2 Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Auto Generated Priority</td>
<td>Number</td>
<td>A numeric value.</td>
</tr>
<tr>
<td></td>
<td>Example: 3</td>
<td>Example: Name,Priority,Product Issue</td>
</tr>
<tr>
<td>Template Fields</td>
<td>Field1,field2,...</td>
<td>No start or end comma or spaces between values.</td>
</tr>
</tbody>
</table>

Group 3 Business Components

Table 48 on page 487 lists the user properties that are related to the following business components:

- Pharma Account Call
- Pharma Attendee Call
- Pharma Template Call
- Pharma Professional Call
- Pharma Promotional Items Dropped
- Pharma Professional Call Sample Dropped
- Pharma Activity Product Issues
- Pharma Call Sample Dropped
- Pharma Meeting
- Pharma Meeting Attendee
- Pharma Meeting Activity
- Pharma Meeting Speaker

**NOTE:** Not all properties are used in all business components. For example, Template Fields user property supports Pharma Promotional Items Dropped, Pharma Professional Call Sample Dropped, Pharma Activity Product Issues, and Pharma Call Sample Dropped. These BCs are not applicable to other user properties in Table 48.
Table 48. User Properties Related to Group 3 Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendee Call ReadOnly</td>
<td>,field1,field2,...</td>
<td>Tells the business component what fields are read-only when the Category is Attendee Call.</td>
</tr>
<tr>
<td></td>
<td>Value must start and end with a comma. Example: ,Start Date,Start Time,</td>
<td></td>
</tr>
<tr>
<td>Cascading Fields</td>
<td>,field1,field2,...</td>
<td>Tells the business component which fields should cascade values to a child call component. Make these fields Force Active in the child call. Works in combination with the SubCall Component user property.</td>
</tr>
<tr>
<td></td>
<td>Value must start and end with a comma. Example: ,Start Date,Start Time,</td>
<td></td>
</tr>
<tr>
<td>Must Detail Products</td>
<td>Y or N</td>
<td>Tells the business component whether detailed products are required for a call.</td>
</tr>
<tr>
<td>OnlySubmitByPosition</td>
<td>Y or N</td>
<td>Tells the business component whether the position that entered the record is the only one that can submit it.</td>
</tr>
<tr>
<td>Paper Reference Number Required</td>
<td>Y or N</td>
<td>If Y and the Paper Sign field is selected, then Ref # is a required field for call submission. Applies to the Pharma Professional Call business component.</td>
</tr>
<tr>
<td>Sample Disbursed Required</td>
<td>Y or N</td>
<td>If Y, at least once sample must be disbursed before a call is submitted. Applies to the Pharma Professional Call business component.</td>
</tr>
<tr>
<td>SRE Reference Number Required</td>
<td>Y or N</td>
<td>If Y and the signature is being captured electronically, Ref # is a required field for call submission. Applies to the Pharma Professional Call business component.</td>
</tr>
<tr>
<td>Status Field</td>
<td>Field</td>
<td>Tells the business component which field is to be used to indicate the status of the activity.</td>
</tr>
<tr>
<td></td>
<td>Field from the business component.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 48. User Properties Related to Group 3 Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SubCall Component</td>
<td><em>Business component name</em>&lt;br&gt;Any business component name.</td>
<td>Tells the business component the child component to which it should cascade values. Works in combination with the Cascading Fields user property.</td>
</tr>
<tr>
<td>Template Components</td>
<td><em>Business component name</em>&lt;br&gt;Any business component name.</td>
<td>Tells the business component what child components should be copied from the Smart Call template if a Smart Call is chosen.</td>
</tr>
<tr>
<td>Template Fields</td>
<td><em>Field1,field2,...</em>&lt;br&gt;No start or end comma.&lt;br&gt;Example: Name,Priority,Product Issue</td>
<td>Tells the business component what fields to copy from the Smart Call template if a Smart Call is chosen.</td>
</tr>
<tr>
<td>Update After Recreate Receipt</td>
<td>Last Name, Address, Start Date, Comment, Signature Captured&lt;br&gt;Value must start and end with a comma. You can add additional fields, but do not delete any of the default ones (preceding line).&lt;br&gt;Applies to the Pharma Professional Call business component.</td>
<td>Tells the business component what fields are editable after the Recreate Receipt button is clicked.</td>
</tr>
<tr>
<td>Update After Submit</td>
<td>,field1,field2,...&lt;br&gt;Value must start and end with a comma.&lt;br&gt;Example: ,Comment,&lt;br&gt;Generally this user property should be used only to make the Comment field editable.</td>
<td>Tells the business component what fields are editable after a call is submitted.</td>
</tr>
<tr>
<td>Update After Synch</td>
<td>,field1,field2,...&lt;br&gt;Value must start and end with a comma.&lt;br&gt;Example: ,Comment,&lt;br&gt;Generally this user property should be used only to make the Comment field editable.</td>
<td>Tells the business component what fields are editable after a call is synchronized (with Siebel Pharma Handheld on a PDA).</td>
</tr>
<tr>
<td>Validate Sample Ref #</td>
<td><em>Y or N</em></td>
<td>Tells the business component whether it should require a sample reference number when submitting a call.</td>
</tr>
</tbody>
</table>

**Group 4 Business Components**

Table 49 on page 489 lists the user properties that are related to the Clinical Subject (class CSSBCBCClinicalSubject) business components.
These properties, used within the Clinical application, allow you to configure new buttons in the application that relate to subject activity. These user properties are at the Field level (Business Component > Field > Field User Properties).

Table 49. User Properties Related to Group 4 Business Components

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Type Code</td>
<td>No default.</td>
<td>Defines the visit activity applied when the newly configured button is selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select CLNCL_SUBJ_VST_TMPL_TY_PE from the List of Values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Application Administration &gt; List of Values &gt; List of Values)</td>
</tr>
<tr>
<td>Subject Status Code</td>
<td>No default.</td>
<td>Defines the status for the subject that is applied when the newly configured button is selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select CLNCL_SUBJECT_STATUS from the List of Values</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Application Administration &gt; List of Values &gt; List of Values)</td>
</tr>
<tr>
<td>Template Version Field Name</td>
<td>No default.</td>
<td>The corresponding Version ID Field Name that is populated with the version ID of the template version that created the activity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Must be made Force Active in the Business Component.</td>
</tr>
<tr>
<td>Subject Consent Required</td>
<td>Y or N, Default=N</td>
<td>This flag indicates whether or not the subject has the Informed Consent Date filled in for the active template for your protocol site. If you set this to Y, and the date is not filled in correctly, an error occurs.</td>
</tr>
<tr>
<td>Append All Activities</td>
<td>Y or N, Default=N</td>
<td>When set to Y, activities are appended.</td>
</tr>
</tbody>
</table>

**Configuring the Visit Generation Buttons**

The standard Siebel Clinical application has three visit generation buttons (Screen, Rescreen, and Enroll) on the Subject form.

Using Siebel Tools, you can:

- Reconfigure the buttons to better suit your business needs
- Create new buttons for application of additional templates on the Subject form
The flow chart in Figure 25 illustrates the logic behind these buttons. The logic is the same for all three buttons, although content of the error messages does vary.

Figure 25. Siebel Clinical application visit generation button logic
Editing the Labels of the LS Pharma HI Activity Calendar View Buttons

In the Siebel Pharma application, the LS Pharma HI Activity Calendar View has three buttons displayed on the LS Pharma Activity HI Calendar Applet. These buttons are:

- **New Contact Call.** Creates a new contact call.
- **New Acct Call.** Creates a new account call.
- **New Meeting.** Creates a new meeting.

These buttons (or controls) are not configured at the applet level, but are generated by the specialized class of the applet, namely CSSWELSHICalendarFrame.

**NOTE:** You can modify the caption of the buttons using Siebel Tools by changing the Caption property or specifying an alternative name in the Caption - String Override property.

Special MedEd Classes—User Properties

There are two special C++ classes for MedEd:

- **CSSBCPharmaMEPlan**
- **CSSBCPharmaMESubPlan**

Both classes support EditMode user property. When the EditMode user property value is set to the value Admin, the data ownership (granting update or delete privilege to the user) is not checked. This means that anyone on the sales team, for example, can update the fields in this business component.

Two existing Buscomp classes, CSSBCPharmaMEActCost and CSSBCPharmaMEEEventPos, are classes without these user properties, and therefore require administrator privileges to update or delete.

Submitting Contact Details from Third-Party Applications

When you click the Submit button from the Contact Call Detail view, the C++ class CSSSubmitFrame validates the contact details data and then invokes the CSSBCSubmitBusComp class. This business component class is the great grandparent class of the CSSBCPharmaCall (BC [Pharma Professional Call]) class.
The Pharma Professional Call class wraps the SubmitImp method in a database transaction. The SubmitImp method contains a high-level call submission function that automates the entire submission process. If any part of the submission fails, then all transactions performed up to that point are rolled back. The SubmitImp method is a recursive process that calls itself for each child call (Attendee Calls) and then continues with the parent. The process contains the following four main steps:

- Create transactions for each sample dropped.
- Create transactions for each promotional item dropped.
- Set the status to Submitted.
- Update the Last Call Date for the current user.

### Invoking the Submit Functionality from Third-Party Applications

There are two ways to invoke the Submit functionality from third-party applications:

- **UI Layer**
- **Business Object Layer**

#### Working in the UI Layer

From your third-party application:

1. Invoke the CSSSubmitFrame class Submit on the Pharma Professional Call form applet.
2. Make sure that the property set is empty and contains no arguments.

**NOTE:** This is equivalent to pressing the Submit button in the Contact Call Detail view.

To suppress the Submit confirmation dialog box, make sure that the business component user property, SuppressSubmitConfirmation, has the value Y on the business component Pharma Professional Call.

#### Working in the Business Component Object Layer

If you have access only to the business component object layer, perform the following:

1. Invoke the CSSBCSubmitBusComp class BCSubmit on the Pharma Professional Call form applet.
2. To skip the check for reconciled inventory periods, specify a property with [Name] = "SkipCheck" in the input property set.
3. Specify a [Value] of Y or TRUE, for example, psIn.SetProperty("SkipCheck","Y").

**NOTE:** If you want to check for reconciled inventory periods, leave the input property set empty.

Perform the following step to access functionality that is equivalent to when a user clicks the Submit button from the Contact Call Detail view:
4  Invoke the Validate class on the BC [Pharma Professional Call] before invoking the CSSBCSubmitBusComp class "BCSubmit" on the Pharma Professional Call form applet. For this method to work correctly, you have to specify at least one property in the Input property set.

## Accounts Contacts Configuration

The user properties outlined in Table 50 must be defined before you can activate a targeting period. The columns displayed in Accounts Contacts List must be configured in the user properties.

Table 50.  User Properties Related to the Life Sciences Pharma Targeting Business Component

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CanMapColumnUpdate</td>
<td>Y</td>
<td>Set this to N to make targeting columns in Accounts Contacts List Read Only.</td>
</tr>
<tr>
<td></td>
<td>Default value: Y</td>
<td></td>
</tr>
<tr>
<td>MapColumn nn</td>
<td>Default value: name of targeting fields</td>
<td>Targeting fields in the Business Component. There are 72 fields defined with different field types. Targeting Data will be mapped and copied to these fields during activation. Only the fields that you define are used for product data mapping.</td>
</tr>
</tbody>
</table>

The user property outlined in Table 51 must be defined before you can generate and update the column mapping.

Table 51.  User Property Related to the Life Sciences Pharma Target Details Business Component

<table>
<thead>
<tr>
<th>User Property Name</th>
<th>User Property Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MapColumn nn</td>
<td>Default value: Name of product attribute fields.</td>
<td>Product data fields in the Business Component. Fields that contain data must be defined, so they can be used to generate column mapping, and can be updated by the Accounts Contacts List.</td>
</tr>
</tbody>
</table>

## Configuring Personalized Content Delivery

This section includes:

- "Setting System Preferences for PCD" on page 494
- "Availability of Messages in PCD Planner" on page 495
Setting System Preferences for PCD

The Server Uncompression Location system preference must have a value pointing to the Siebel file system path `<Siebel installation path>\public\enu`. This is the path where InteractiveDetailer.swf is located.

Table 52 lists the system preferences that apply to PCD.

Table 52. System Preferences for PCD

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Uncompression Location</td>
<td><code>&lt;Siebel installation path&gt;\public\enu</code></td>
<td>For the Siebel Server, the value of this system preference is concatenated with the value of the Decompressed Files Path system preference. The messages are decompressed and cached to this location. For Local setup, the system file system path is read from webclientsiteDir and it is configured in epharma.cfg.</td>
</tr>
<tr>
<td>Decompressed Files Path</td>
<td><code>filesystem\assets</code></td>
<td>Specifies the path of the decompressed messages. Do not use slash (<code>\</code>) at either end of the string.</td>
</tr>
</tbody>
</table>
Availability of Messages in PCD Planner

Your system administrator loads and verifies messages in the Document Administration > Literature view. The administrator can then associate categories to the messages to make them visible to users creating messaging plans. Users create new messaging plans using the PCD Planner. Messages that are loaded in PCD Planner appear in the Items tab. Access to the messages depends on the catalog visibility associated to the messages and the CanLoadInPlanner calculated field in the Admin Sales Tool business component. A message with the field, CanLoadInPlanner, set to Y is available to users and is loaded into PCD Planner.

The CanLoadInPlanner calculated field is set to Y if the following conditions apply:

- The Literature record is of type Message.
- The message has a status of Active; that is, the release date is before or is today’s date and the expiration date is greater than today.
- The message is a supported file type.

The fields used to controls the loading of messages in PCD Planner are listed in Table 53. For information about the user properties that control access visibility for loading messages in PCD Planner, see Table 55 on page 508.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CheckForNeedToSync</td>
<td>N</td>
<td>When you click the Decompression button in the Siebel toolbar, the decompression time stamp is recorded in the S_USER table. Literature records have a calculated field called, NeedToSync. The value of this field is set to True if the record is modified after decompression. If the value of the user property, CheckForNeedToSync, is set to Y, then the next time you click the Decompress button, only messages with the user property, NeedToSync, set to Y are decompressed. Otherwise, all messages are decompressed.</td>
</tr>
<tr>
<td>Skin</td>
<td>Default</td>
<td>Specifies the skin or theme mode for the PCD Viewer. If the Skin field is not populated, then the value for Skin system preference is used. If the Skin system preference has no value, then the value of the Skin user property in LS PCD Service is used.</td>
</tr>
</tbody>
</table>
Availability of Messaging Plans in the PCD Viewer

After the user creates a messaging plan, the messaging plan goes through an approval process. When the messaging plan is approved, the administrator sets the status of the messaging plan as Released and associates a category with it to make it visible to the required users. When you click the Detail button from the Account Call and Contact Call form applets, the messaging plans are automatically loaded in the PCD Viewer.

Access to the messaging plans depend on the catalog visibility associated to the messaging plans and on the CanLoadInDetailer calculated field in the LS Admin Messaging Plans business component. When making contact calls, messaging plans that have the CanLoadInDetailer field set to Y are available to those users who have catalog visibility.

The CanLoadInDetailer calculated field is set to Y when the messaging plan verification status is Successful. The Successful verification status depends on certain conditions.

All presentation items in the messaging plan must:

- Have a verification status of Successful.
- Be active, that is, the release date of the presentation items must be before or is today’s date and is before the expiration date.
- Contain supported file types.

All related messages and detail message content associated with each of the presentation items must:

- Contain products that are in the personal list of the sales representative
- Not have inactive messages
- Be the highest, active version

The calculated fields that control the loading of messaging plans in the PCD Viewer and PCD Planner are listed in Table 53. For information about user properties that control access visibility for loading messages in PCD Viewer and PCD Planner, see Table 55 on page 508.
## PCD Business Component Calculated Fields

Table 53 lists the calculated fields that apply to PCD business components.

### Table 53. Calculated Fields for PCD Business Components

<table>
<thead>
<tr>
<th>Business component</th>
<th>Calculated Field</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LS Admin Messaging Plans</td>
<td>CanLoadInDetailer</td>
<td>IIF (Max Version Num = Version AND Product Owner Id = LoginId() AND HasInactiveMessages = &quot;N&quot; AND IsVerified = &quot;Y&quot;), 'Y', 'N')</td>
<td>Messaging plans can be loaded in to the PCD Viewer if the messaging plan:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Is the highest, active version.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Contains a Product that is in the personal list of the sales representative.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Does not have inactive messages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>■ Is verified.</td>
</tr>
<tr>
<td>CanLoadInPlanner</td>
<td>Y</td>
<td></td>
<td>Load all messaging plans into PCD Planner, that is the Create Messaging Plan window.</td>
</tr>
<tr>
<td>IsVerified</td>
<td>IIF (Count(VerificationFailedMessages) &gt; 0,&quot;N&quot;,&quot;Y&quot;)</td>
<td></td>
<td>If messaging plan has verification failed presentation items, set verification status to failed. That is, IsVerified is equal to N.</td>
</tr>
</tbody>
</table>
### Calculated Fields for PCD Business Components

<table>
<thead>
<tr>
<th>Business component</th>
<th>Calculated Field</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LS MP Items</td>
<td>IsVerified</td>
<td>IIF([Verification Status] = LookupValue('VERIFICATION_STATUS', 'Successful') AND [IsSupportedFormat] = 'Y' AND [IsRelatedContentVerified] = 'Y' AND [IsDetailContentVerified] = 'Y', 'Y', 'N')</td>
<td>If the verification status (obtained from the join to the S_LIT_LSX table) of Message is Successful, and Message is of supported file type, and all the related and detail content associated with this presentation item is verified, then for this presentation item IsVerified is equal to Y.</td>
</tr>
<tr>
<td></td>
<td>IsDetailContentVerified</td>
<td>IIF (Count(Verified Detail Content) &gt; 0, 'N', 'Y')</td>
<td>Checks if all detail content associated with the presentation item is verified.</td>
</tr>
<tr>
<td></td>
<td>IsRelatedContentVerified</td>
<td>IIF (Count(Verified Related Content) &gt; 0, 'N', 'Y')</td>
<td>Checks if all related content associated with presentation item is verified.</td>
</tr>
<tr>
<td>LS Detail Messages</td>
<td>IsVerified</td>
<td>IIF([Verification Status] = LookupValue('VERIFICATION_STATUS', 'Successful') AND [IsSupportedFormat] = 'Y', 'Y', 'N')</td>
<td>If the verification status (obtained from the join to the S_LIT_LSX table) of Message is Successful, and Message is of supported file type, then for this related item IsVerified is equal to Y.</td>
</tr>
</tbody>
</table>
### Table 53. Calculated Fields for PCD Business Components

<table>
<thead>
<tr>
<th>Business component</th>
<th>Calculated Field</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LS Related Messages</td>
<td>IsVerified</td>
<td>IIF([Verification Status] = LookupValue('VERIFICATION _STATUS','Successful') AND [IsSupportedFormat] = &quot;Y&quot;, 'Y', 'N')</td>
<td>If the verification status (obtained from the join to the S_LIT_LSX table) of Message is Successful, and Message is of a supported file type, then for this related item, IsVerified is equal to Y.</td>
</tr>
<tr>
<td>Admin Sales Tool</td>
<td>CanLoadInPlanner</td>
<td>IIF ([[Sales Tool Type] = LookupValue (&quot;SALES_TOOL_TYPE&quot;, &quot;Message&quot;) AND [IsActive] = &quot;Y&quot; AND [IsSupportedFormat] = &quot;Y&quot;), 'Y', 'N')</td>
<td>Literature item can be loaded in PCD Planner if:  ■ The type is equal to Message  ■ Is active (release date is before or is today’s date and is before the expiration date)  ■ Is of supported file type.</td>
</tr>
<tr>
<td></td>
<td>CanLoadInDetailer</td>
<td>IIF ([[Sales Tool Type] = LookupValue (&quot;SALES_TOOL_TYPE&quot;, &quot;Message&quot;) AND [IsSupportedFormat] = &quot;Y&quot;), 'Y', 'N')</td>
<td>Literature Item can be verified if type is equal to Message and is of supported file type.</td>
</tr>
</tbody>
</table>
Recommended Messaging Plans

When a sales representative launches the PCD Viewer from the Contact Call Detail View, Account Contact Call View, or Account Call Detail View, all messaging plans available to the sales representative are loaded into the PCD Viewer by Life Sciences (LS) PCD Services. For more information about the user properties for the LS PCS Services, see “User Properties of LS PCD Business Service” on page 508.

In LS PCD Service, the OptimizeDetailingPlan method identifies messaging plans that are recommended for the call. These messaging plans are called Recommended Messaging Plans and have an asterisk (*) symbol suffixed to its name in the list of available messaging plans when displayed in the PCD Viewer.

By default, the OptimizedDetailingPlan functionality is configured to identify recommended messaging plans for Contact Call and Account Contact Call detailing only. If Objectives or Offers are associated to a Contact Call or Account Contact Call, recommended messaging plans are identified as outlined in this section.

However, if no Offer or Objective is associated to a Contact Call or Account Contact Call, fields for entering target segments, in the Contact Call or Account Contact Call views are available, and recommended messaging plans may be selected based on these field values.

Similarly, if no Objectives are associated to an Account Call, fields for entering target segments in the Account Call view are available, and recommended messaging plans may be selected based on these field values.

To configure fields for entering target segments in Contact Call view or Account Contact Call view

1. Add fields in Pharma Professional Call business component (BC) mapping to one or more extension columns in S_EVT_ACT_X. For example:
   - Field Name: Call Segment Code 1 Join: S_EVT_ACT_X Column: ATTRIB_01
   - Field Name: Call Segment Code 2 Join: S_EVT_ACT_X Column: ATTRIB_02

2. Configure the fields in Pharma Professional Call Form Applet.

3. In the Pharma Professional Call BC, update the BC user property Call Seg Code Fields with a list of segment code fields, with each segment code field separated by a comma. For example, Call Segment Code 1, Call Segment Code 2.

To configure fields for entering target segments in Account Call view

1. Add fields in Pharma Account Call business component (BC) mapping to one or more extension columns in S_EVT_ACT_X. For example:
   - Field Name: Call Segment Code 1 Join: S_EVT_ACT_X Column: ATTRIB_01
   - Field Name: Call Segment Code 2 Join: S_EVT_ACT_X Column: ATTRIB_02

2. Configure the fields in Pharma Account Call Form Applet.
3 In the Pharma Account Call BC, update the BC user property Call Seg Code Fields with a list of segment code fields, with each segment code field separated by a comma. For example, Call Segment Code 1, Call Segment Code 2.

By default, the OptimizedDetailingPlan functionality is not configured to identify recommended messaging plans for Account Call if an Objective is associated to the Account Call.

**To configure fields in Account Call view if Objectives are associated to an Account Call**

1 Create one or more extension columns in S_ACCNT_SRC (for example, X_SEG_CODE1, X_SEG_CODE2) and apply these changes in the Siebel Applications database.

2 Add fields in Pharma Campaign Target Account BC and map these fields to the columns created in S_ACCNT_SRC. For example:
   - Field Name: Segment Code 1 Join: S_ACCNT_SRC Column: X_SEG_CODE1
   - Field Name: Segment Code 2 Join: S_ACCNT_SRC Column: X_SEG_CODE2

3 Configure the fields in Pharma Campaign Target Account List Applet.

4 In the Pharma Account Call BC, update the BC user property Objective Seg Code Fields with a list of segment code fields, with each segment code field separated by a comma. For example, Segment Code 1, Segment Code 2.

**Optimize Detailing Plan Method**

Signature of the Optimize Detailing Plan method is as follows:

```cpp
ErrCode OptimizeDetailingPlan (const CCFPropertySet& inputArgs, CCFPropertySet& outputArgs)
```

The input parameters to this method are sent as an input property set (inputArgs).

The output of this method is an xml string, set in the output property set (outputArgs) with property name as RecommendedMsgPlans. For example:

```cpp
outputArgs.SetProperty("RecommendedMsgPlans", <xml string>);
```

The xml string in the output property set should be in the following format:

```xml
<OptimizedDetailingPlan>
```
You can use your own logic to identify recommended messaging plans by overriding the `OptimizeDetailingPlan` method using a script.

```xml
<ListOfRecommendedMessagingPlans>
  <MessagingPlan>
    <Id/>
    <SequenceNumber/>
    <OfferId/>
    <ObjectiveId/>
    <SegmentCode/>
  </MessagingPlan>
  <MessagingPlan>
    <Id/>
    <SequenceNumber/>
    <OfferId/>
    <ObjectiveId/>
    <SegmentCode/>
  </MessagingPlan>
</ListOfRecommendedMessagingPlans>
</OptimizedDetailingPlan>
```
To override OptimizeDetailingPlan

1. In Siebel tools query for LS PCD Service.
2. Right click LS PCD Service, and click Edit Server scripts.
3. Update the Service_PreInvokeMethod function to override logic for OptimizeDetailingPlan as shown:

```javascript
function Service_PreInvokeMethod (MethodName, Inputs, Outputs)
{
    if(MethodName == "OptimizeDetailingPlan")
    {
        ......
        User logic to identify Recommended messaging plans...
        set output property set...
        ......
        return (CancelOperation);
    }
    else
    {
        return (ContinueOperation);
    }
}
```

Identifying Recommended Messaging Plans

The default OptimizeDetailingPlan method identifies Recommended Messaging Plans as follows:

If an objective is selected for a call, the OptimizeDetailingPlan method provides a list of messaging plans to be loaded to the PCD Viewer based on messaging plans associated with an objective and have a Target Segment Code matching the objective's Contact Target Segment Code fields, that is one or ore fields from S_CAMP_CON table).

The field names from Action BC is configurable. If the Objective Id is null, then the segment code fields (one or more fields from Action BC) are used to match and search for Recommended Messaging Plans based on Target Segment Code field defined for each Messaging Plan.

For example, a sales representative (Sales Rep A) has an Objectives set up called Q1 Objective and has Dr. Adler as a target for this objective. The Target Record of Dr. Adler has two custom extension fields to hold SegCode1 and SegCode2 for two products, A1 and B2, that Sales Rep A deals with. The Sales Operation Manager has also five messaging plans, namely MP1, MP2, MP3, MP4, and MP5, associated with this Objective and each messaging plan has a Target Segment code specified as A1, B1, A2, B2, and A1.
Sales Rep A creates a call on Dr. Adler and selects Q1 Objective as Objective for the call. The OptimizeDetailingPlan finds matching messaging plans associated with Objective Q1 Objective that have Target Segment code as A1 and B2. This scenario results in MP1, MP4 and MP5 selected as recommended messaging plans.

Next, consider the situation where Sales Rep A creates another call on Dr. Adler and does not select Objective for the call. OptimizeDetailingPlan matches custom extension fields defined on the call business component (BC) to hold segment code values against Target Segment Code fields on the messaging plans to identify recommended messaging plans.

For Contact Calls with Marketing Communications, the LS PCD Service method provides a list of messaging plans to be loaded in the PCD Viewer based on messaging plans associated with Contact Call Offers for which the sales representative has access. For example, if Sales Rep A has access to three Contact Call Offers but is in the Access Group of only one of the messaging plans associated with the Contact Call Offer, then only that messaging plan can be loaded in the PCD Viewer.

**Using Skins**

Once a new skin becomes available for content, you can add the skin to the existing list of available skins as follows:

1. **Navigate to folder** 
   
   ```
   Siebel installation path\public\<language folder>\ISDData
   ```
2 Open the Make an entry in styles.xml file and include an entry as shown in bold below:

```xml
<?xml version="1.0" encoding="utf-8"?>
<styles>
  <style>
    <label>Default</label>
    <swfPath>styles/Oracle.swf</swfPath>
    <iconPath>styles/iconProject.swf</iconPath>
  </style>
  <style>
    <label>Oracle</label>
    <swfPath>styles/Oracle.swf</swfPath>
    <iconPath>styles/iconProject.swf</iconPath>
  </style>
  <style>
    <label>NewSkin</label>
    <swfPath>styles/MyNewSkin.swf</swfPath>
    <iconPath>styles/iconProject.swf</iconPath>
  </style>
</styles>
```

3 Copy MyNewSkin.swf to folder `Siebel installation path\public\<language folder>\styles`.

4 Add the NewSkin value to LOV Type PCD_SKIN in Administration – Data screen > List of Values Explorer view.

## Modifying a Tooltip in the PCD Viewer

You can customize the tooltips that are displayed when a user places the cursor over the buttons in the PCD Viewer.

1 Navigate to folder `Siebel installation path\public\<language folder>\ISDData\<language folder>`.

2 Open the lfs.xml file and enter the tooltip string as per the following example:

```xml
<IDS_NEW_TOOLTIP>New ToolTip</IDS_NEW_TOOLTIP>
```

3 Navigate to folder `Siebel installation path\public\<language folder>`.

4 Open the `toolbar_buttons.xml` file and locate the button tag for which tooltip is to be modified.
5 Update the `<toolTip>` tag for the selected button with the string tag created in `lfs.xml` as shown below:

```xml
<toolbars>
  <tool bar toolbarId="Detailer - Standard" defaultState="DEFAULT"
    firstChangeInternal="false" buttonId="1">
    <respectStates>
      <toolbar name="Detailer - Standard"/>
    </respectStates>
    <button buttonId="2">
      <label/>
      <toolTip>IDS_NEW_TOOLTIP</toolTip>
      <icon/>
      .......
    </button>
  </toolbar>
</toolbars>
```

**NOTE:** It is not recommended to remove buttons from the `toolbar_buttons.xml`. However, you can hide buttons by adding the DefaultState value to the `ReadOnlyStates` tag.

**User Properties of the PCD Applets**

Siebel business components are based on the CSSBusComp class, or on a C++ class derived from the CSSBusComp class. Business component user properties allow Siebel administrators to control and adjust the behavior of Siebel Life Sciences using Siebel Tools.

The following is a list of PCD applets that display the Flex application user properties. Flex is a third-party application used by PCD:

- LS Admin Edit Messaging Plan
- LS Admin New Messaging Plan
- LS Admin Preview Messaging Plan
- LS Edit Personalized Messaging Plan
- LS Personalize Messaging Plan
- LS Preview Messaging Plan
- LS Verify Message
Table 54 lists the user properties that apply to PCD popup applets that display Flex UI elements.

Table 54. User Properties for PCD popup applets

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| FlexAppMode     | MP-Admin                   | The Flex application launches PCD in the modes that determine the UI. For example, for preparing for a contact call, PCD is launched in ISDPreview mode. For message plan creation, the MP-Admin mode is launched.  
**NOTE:** Do not modify this user property.                                                                 |
| InitMethod      | EditMsgPlan                | The method name in LS PCD Service that initializes the Flex application.  
**NOTE:** Do not modify this user property.                                                                 |
| IntegrationObj  | AdminMessagingPlanIO       | Specifies the I/O (input/output) to be used for writing data to the database. For example, data is sent in XML format.  
**NOTE:** Do not modify this user property.                                                                 |
| CallIOBS        | Pharma Account Call IO BS  | Name of the business service that executes the I/O for extracting call data.                                                                                                                                                                                                       |
| CallType        | Account Call               | Specifies the type of call.                                                                                                                                                                                                                                                                                                                    |
|                 | Contact Call               |                                                                                                                                                                                                                                                                                                                                                               |
**User Properties of LS PCD Business Service**

Table 55 lists the user properties that apply to Life Sciences (LS) PCD Services.

**Table 55. User Properties for LS PCD Services**

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoadLOVTypes</td>
<td>PCD_RESPONSE_TYPE MSG_PLAN_ITEM_TYPE</td>
<td>Specifies the LOV type values that are extracted and sent to the Flex application.</td>
</tr>
<tr>
<td></td>
<td>VERIFICATION_STATUS MSG_DISPLAY_STATUS</td>
<td><strong>NOTE:</strong> Do not modify this user property.</td>
</tr>
<tr>
<td>Skin</td>
<td>Default</td>
<td>Specifies the skin mode to use for the PCD Viewer display (fields in Account Call and Contact Call form applets and PCD Planner field in Messaging Plan form applet). If these fields are not populated, then the value for Skin system preference is used. If the Skin system preference has no value, then this user property value is used.</td>
</tr>
<tr>
<td>SyncEndConfirmation</td>
<td>Y</td>
<td>If you click Uncompress, an asynchronous process starts and decompresses the messages. At the end of this decompression process, if the value of this user property is equal to Y, then the Siebel Business Application displays a message box to confirm the end of the decompression process. However, this user property value is ignored by the Siebel Server and no confirmation message dialog is displayed.</td>
</tr>
<tr>
<td>SyncStartConfirmation</td>
<td>Y</td>
<td>If you click Uncompress, an asynchronous process starts and decompresses the messages. At the start of this decompression process, if the value of this user property is equal to Y then the Siebel Business Application displays a message box to confirm the start of the decompression process. However, this user property value is ignored by the Siebel Server and no confirmation message dialog is displayed.</td>
</tr>
<tr>
<td>Verify Disabled Error Msg</td>
<td>Verification cannot be done for this Literature Record</td>
<td>In Administration - Document screen &gt; Literature view, verification is done only on literature records with type equal to Message. For records of type Message, clicking the Verify button displays the error message specified in this user property.</td>
</tr>
<tr>
<td>No Messaging Plan Error Msg</td>
<td>No Messages Available for Detail.</td>
<td>In Account Call and Contact Call form applets, if there are no messaging plans available, clicking the Detail button displays the error message specified in this user property.</td>
</tr>
</tbody>
</table>
API for Using Multi-file Content

The message can access its component files in the main Flash or Flex content by making a call to the getMessageFileName(filename) application programming interface (API).

The parameter filename must be the filename of the component file in the Siebel Business Application. The Siebel Business Application returns the path of the component file. The message can then use the component file path to add additional component files to the PCD content.

For example, to access and load component files, the main message must call the following functions:

```javascript
Application.application.getMessageFileName(fileName);
```

if using Flex for content creation

```javascript
root.parent.parent.parentApplication.getMessageFileName(fileName);
```

if using Flash for content creation

The syntax for childData API is as follows:

```javascript
getMessageFileName(filename:String):void
```

API for Recording Section Data

PCD Viewer tracks various information such as the duration for which each message (digital content) in a messaging plan was presented. It does this by recording the timestamp when the presentation of a message started and the timestamp when the presentation of the message ended.

The message (digital content) performs additional tracking and make calls to the PCD Viewer to pass tracking information. The PCD Viewer takes the combined information and make calls to Siebel Business Application to write back presentation data.

For example, consider a message that has three critical sections where the start and end time of each section needs to be tracked along with start and end time of the entire message. To track section data, the message must pass the section's tracking information to the PCD Viewer by calling the following function:

```javascript
Application.application.childData(sectionName, startTime, endTime); // if using Flex for content creation
```

```javascript
root.parent.parent.parentApplication.childData(strSectionName, startTimeStamp, endTimeStamp); // if using Flash for content creation
```

Table 55. User Properties for LS PCD Services

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ViewModeForLoadingMPInDetailer</td>
<td>Catalog</td>
<td>Specifies the access type to be used for loading messaging plans in the PCD Viewer.</td>
</tr>
<tr>
<td>ViewModeForLoadingMsgInPlanner</td>
<td>Catalog</td>
<td>Specifies the access type to be used for loading messages in PCD Planner.</td>
</tr>
</tbody>
</table>
The syntax for childData API is as follows:

```javascript
childData(name:String, start:Date, end:Date):void
```

When you close the PCD Viewer, data is written to the presentation detail applet. You can view the full section by section record of messages as per the following example:

<table>
<thead>
<tr>
<th>Message Name</th>
<th>Section Name</th>
<th>Messaging Plan Name</th>
<th>Start Name</th>
<th>End Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samp1</td>
<td>None</td>
<td>SampMP</td>
<td>7:30 pm</td>
<td>7:45 pm</td>
</tr>
<tr>
<td>Samp1</td>
<td>Sec1</td>
<td>SampMP</td>
<td>7:31 pm</td>
<td>7:35 pm</td>
</tr>
<tr>
<td>Samp1</td>
<td>Sec2</td>
<td>SampMP</td>
<td>7:36 pm</td>
<td>7:40 pm</td>
</tr>
<tr>
<td>Samp1</td>
<td>Sec3</td>
<td>SampMP</td>
<td>7:41 pm</td>
<td>7:45 pm</td>
</tr>
</tbody>
</table>
Configuring Data for Oracle Pharma Sales Analytics

This appendix contains information about how to populate data in the Siebel Pharma application to meet the requirements of Oracle Pharma Sales Analytics. The information is for Siebel Pharma and Oracle Pharma Sales Analytics implementation teams, Siebel Pharma application administrators and trainers. It assumes that you are familiar with the functionality and conventions of working with and administering the Siebel Pharma application.

For further information about transactional data extract, transform and load (ETL) rules of Pharma Sales Analytics, see Oracle Business Intelligence Applications Installation and Configuration Guide.

This appendix contains information about the following topics:

- “Transactional Data Requirements” on page 511
- “Configuring Product Hierarchies and Product Costs” on page 512
- “Configuring Product Catalog and Category Hierarchies” on page 513
- “Setting Up Sales Objectives” on page 515
- “Entering Call Activity Data” on page 516
- “Configuring Sales Territories for Pharma Sales Analytics” on page 517
- “Creating Target Lists Using Oracle Business Intelligence” on page 523

Transactional Data Requirements

Oracle Pharma Sales Analytics is a set of prebuilt analytical applications to support the analysis and reporting needs of sales and marketing users. The Oracle Pharma Sales Analytics applications are built on top of the Oracle Business Analytics Warehouse, which is a unified data repository for all customer-centric data to support the analytical requirements of Siebel Pharma Applications.

The Oracle Business Analytics Warehouse contains a number of Business Analytics Warehouse tables that are specific to Oracle Pharma Sales Analytics. These tables support the analysis of data stored in the Siebel Pharma application, as well as data from external syndicated data sources. The Oracle Business Analytics Warehouse contains a set of ETL (extract-transform-load) processes that take data from the Siebel Business Applications transactional data (OLTP) and loads this data into the Oracle Business Analytics Warehouse tables.

To implement Oracle Pharma Sales Analytics successfully you must understand the key entities and relationships in the Siebel Pharma application that Oracle Pharma Sales Analytics uses.

The Pharma Sales Analytics ETL processes impose some requirements on how the data must be configured and populated in the Siebel Pharma application in order to minimize the need for configuring data entities, relationships, and hierarchies within the Oracle Pharma Sales Analytics application.
The Oracle Pharma Sales Analytics ETL rules are configured to source data from specific, standard Siebel Pharma transactional database tables and columns. These database tables and columns are mapped to standard Siebel Pharma business components, screens and views. The Pharma Sales Analytics ETL rules require that data is populated in a standard way to make sure that data is successfully loaded into the Oracle Business Analytics Warehouse tables without the need for additional configuration.

The following key entities must be configured and populated correctly in the Siebel Pharma transactional system:

- Product hierarchies and product costs
- Product catalog and category hierarchies
- Sales objectives

## Configuring Product Hierarchies and Product Costs

This topic details the tasks performed by application administrators to configure product hierarchies and product costs. Oracle Pharma Sales Analytics provides a prebuilt product hierarchy that allows users to analyze and roll up call activity, medical events, sales and Rx data at the form strength, brand, submarket, and market levels. Oracle Pharma Sales Analytics also allows users to analyze sales and Rx data of competitor brands.

Table 56 shows the required relationships between each of the levels in the Product Level column.

<table>
<thead>
<tr>
<th>Pharma Sales Analytics Product Hierarchy</th>
<th>OLTP Product Type</th>
<th>OLTP Product Level</th>
<th>Example</th>
<th>Parent Product</th>
<th>Cardinality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form/Strength</td>
<td>Sample</td>
<td>3</td>
<td>Aracid 400 MG</td>
<td>Aracid</td>
<td>M:1</td>
</tr>
<tr>
<td>Product</td>
<td>Detail</td>
<td>2</td>
<td>Aracid</td>
<td>COPD</td>
<td>M:1</td>
</tr>
<tr>
<td>Product</td>
<td>Competitive Products</td>
<td>No Level</td>
<td>SimAir</td>
<td>Asthma or COPD</td>
<td>M:1</td>
</tr>
<tr>
<td>Submarket</td>
<td>Submarket</td>
<td>No Level</td>
<td>COPD</td>
<td>Asthma</td>
<td>M:1</td>
</tr>
<tr>
<td>Market</td>
<td>Market</td>
<td>1</td>
<td>Asthma</td>
<td>No Parent</td>
<td>None</td>
</tr>
</tbody>
</table>

Oracle Pharma Sales Analytics also allows users to analyze ROI of call detailing and sampling. The underlying cost information used in these ROI calculations is sourced from the product cost fields within the Siebel Pharma application.
Configuring Data for Oracle Pharma Sales Analytics

Configuring Product Catalog and Category Hierarchies

To configure product hierarchies and product costs

1. Navigate to the Administration - Product screen > Products view.
2. In the Products list, create a new record, and complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the form strength, product/brand, submarket, or market.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of product as listed in Table 56 on page 512.</td>
</tr>
<tr>
<td>Parent Product</td>
<td>The parent product of this product within the product hierarchy. The appropriate parent product must be selected for the current product level as listed in Table 56 on page 512. Market type products do not have a parent product.</td>
</tr>
</tbody>
</table>

3. Drill down on the product.
4. Click the More Info view tab.
5. In the Level field, select the correct numerical value for the level as listed in Table 56.
6. If the Product Type is Sample, then in the Sample Cost field enter the appropriate sample cost. If the Product Type is Detail, then in the Promo Cost field enter the appropriate promotional cost.
7. Repeat Step 2 through Step 6 for the remaining products in the product hierarchy.

For more information about managing products, see Chapter 6, “Managing Products for Life Sciences.”

Configuring Product Catalog and Category Hierarchies

This topic details the tasks required to configure product catalogs and category hierarchies performed by application administrators. Oracle Pharma Sales Analytics allows users to use a number of prebuilt alternate product hierarchies to analyze and roll up sales and Rx data. These prebuilt hierarchies are as follows:

- Manufacturer Product Category
- Application Form Product Category
- ATC (Anatomical Therapeutic Class) Product Category
- User Code (USC) Product Category
- Chemical Product Category
Table 57 shows the Standard Product Hierarchy along with the prebuilt alternative product hierarchies.

Table 57. Standard Product Hierarchy with Prebuilt Product Hierarchies

<table>
<thead>
<tr>
<th>Standard Product Hierarchy</th>
<th>Manufacturer Product Hierarchy</th>
<th>Application Form Product Category</th>
<th>ATC Product Category</th>
<th>User Code Product Category</th>
<th>Chemical Product Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>Market</td>
<td>Manufacturer</td>
<td>Application Form I</td>
<td>ATC I</td>
<td>USC I</td>
<td>Family</td>
</tr>
<tr>
<td>Submarket</td>
<td>Product</td>
<td>Application Form II</td>
<td>ATC II</td>
<td>USC II</td>
<td>Subfamily</td>
</tr>
<tr>
<td>Product</td>
<td></td>
<td>Application Form III</td>
<td>ATC III</td>
<td>USC III</td>
<td></td>
</tr>
<tr>
<td>Form/Strength</td>
<td></td>
<td></td>
<td>ATC IV</td>
<td>USC IV</td>
<td></td>
</tr>
</tbody>
</table>

The Oracle Pharma Sales Analytics ETL uses data stored in the standard Siebel Pharma Product Catalog and Category application screens to create these alternate hierarchies.

To configure product catalog and product hierarchies

1. Navigate to the Administration - Catalog screen > Catalogs view.
2. In the Catalogs list, create a new record, and complete the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the alternate Product hierarchy, for example, R-Respiratory for an ATC hierarchy for Asthma products.</td>
</tr>
<tr>
<td>Description</td>
<td>A general description of the catalog.</td>
</tr>
<tr>
<td>Effective Start Date</td>
<td>Current date.</td>
</tr>
<tr>
<td>Private</td>
<td>The product catalog is only used by the Oracle Pharma Sales Analytics ETL. Select this field to prevent the catalog from being visible to other users within the Siebel Pharma Application.</td>
</tr>
</tbody>
</table>

3. Drill down on the Catalog.
4 In the Category list, create a new record for the top level of the hierarchy, and complete the required fields as described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the hierarchy level (for example, R3-Bronchodilators and Anti-asthma Preparations for the top level in an ATC hierarchy for Asthma products).</td>
</tr>
<tr>
<td>Display Name</td>
<td>Display name of the hierarchy level (for example, R3-Bronchodilators and Anti-asthma Preparations for the top level in an ATC hierarchy for Asthma products).</td>
</tr>
<tr>
<td>Effective Start Date</td>
<td>Current date.</td>
</tr>
</tbody>
</table>
| Usage          | From the Pick Category Usage Type dialog box, select one of the following usage types to set the type of alternate Product Hierarchy, and then click OK:  
  - ATC  
  - Application Form  
  - Manufacturer  
  - USC  
  - Chemical |
| Private        | The Product Catalog is only used by the Oracle Pharma Sales Analytics ETL Check this flag to prevent the Catalog from being visible to other users within the Siebel Pharma Application. |

5 For each lower level in the hierarchy, create a new record in the Category list, and repeat Step 4.

6 Set the relationships between the levels by using the Demote level button.

7 For the lowest level in the hierarchy only, click the Products link under the Categories tab.

8 Create a new record in the Product list, and select the appropriate Product record, which is the Form/Strength level Product in the standard Product hierarchy. This action allows Oracle Pharma Sales Analytics to link the alternate product hierarchy to the standard product hierarchy.

### Setting Up Sales Objectives

This topic details the tasks that users must do to set up correctly the sales objectives in Oracle Pharma Sales Analytics. Oracle Pharma Sales Analytics allows users to analyze actual call activities, sales, and Rx results and compare them with their sales objective targets. Users must enter the sales objectives data correctly in the Siebel Pharma Application’s Objectives screens to enable this analysis.

**To set up sales objectives**

1 Navigate to the Objectives screen > Retail Objectives List view.
2 In the Retail Objectives list, create a new record, and complete the necessary fields. Some fields are described in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit</td>
<td>A unit can only be NRx, TRx, indirect sales, indirect units, sales amounts, sales units, or number (#) of calls.</td>
</tr>
<tr>
<td>Product</td>
<td>Select only one product at the appropriate product level. For a unit value of NRx, TRx, or number (#) of Calls, then the product value must be detail. For a unit of indirect sales, indirect units, sales amounts, or sales units, then the product level is form/strength.</td>
</tr>
<tr>
<td>Team</td>
<td>Only one team member can be the owner of each objective.</td>
</tr>
</tbody>
</table>

3 Drill down on the Objective.
4 Click the Target Contacts tab.
5 Click the New button, and select the appropriate Contact records.
6 For each Contact record that is added to the Target Contacts list, enter a value in the Target Value field.
7 In the Target Accounts list, click the New button, and select the appropriate Account records.
8 For each Account record that is added to the Target Accounts list, enter a value in the Target Value field.

**Entering Call Activity Data**

Oracle Pharma Sales Analytics allows users to analyze the Account Calls, Contact Calls, and Attendee Calls data entered in the Siebel Pharma application. The Oracle Pharma Sales Analytics ETL requires a number of key call activity fields to be populated and the data to be entered correctly so that the Oracle Business Analytics Warehouse is loaded.
Table 58 outlines which fields must be populated for Oracle Pharma Sales Analytics

Table 58. Fields that must be Populated for Oracle Pharma Sales Analytics

<table>
<thead>
<tr>
<th>Records</th>
<th>Fields That Must Be Populated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Call - Header Records</td>
<td>Status (set to Submitted)</td>
</tr>
<tr>
<td></td>
<td>Account</td>
</tr>
<tr>
<td></td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Start Date</td>
</tr>
<tr>
<td>Contact Call - Header Records</td>
<td>Status (set to Submitted)</td>
</tr>
<tr>
<td></td>
<td>Last Name, First Name</td>
</tr>
<tr>
<td></td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Start Date</td>
</tr>
<tr>
<td>Attendee Call - Header Records</td>
<td>Status (set to Submitted)</td>
</tr>
<tr>
<td></td>
<td>Last Name, First Name</td>
</tr>
<tr>
<td></td>
<td>Address</td>
</tr>
<tr>
<td></td>
<td>Start Date</td>
</tr>
<tr>
<td>Call Products Detailed - Child Records</td>
<td>Product</td>
</tr>
<tr>
<td></td>
<td>Priority</td>
</tr>
<tr>
<td></td>
<td>Indication</td>
</tr>
<tr>
<td>Samples Dropped - Child Records</td>
<td>Name</td>
</tr>
<tr>
<td></td>
<td>Quantity</td>
</tr>
<tr>
<td>Promotional Items Dropped - Child Records</td>
<td>Name</td>
</tr>
<tr>
<td>(Contact calls)</td>
<td>Quantity</td>
</tr>
</tbody>
</table>

Configuring Sales Territories for Pharma Sales Analytics

This topic describes how to perform the following tasks:

■ "Creating Primary Sales Force Hierarchies" on page 518
■ "Creating Sales Territories" on page 519
■ “Creating Alternate Sales Force Hierarchies” on page 521
Creating Primary Sales Force Hierarchies

Oracle Pharma Sales Analytics provides a prebuilt sales hierarchy configuration that determines the rollup and visibility of sales, Rx and call activity data for the different levels of users within a sales organization. This configuration includes prebuilt aggregation tables and de-duplication of data at each level of the sales hierarchy to support accurate analysis and improved performance. The primary sales force hierarchy is configured as a position hierarchy within the Siebel Pharma application, with the sales territory level position at the bottom of the position hierarchy. This topic details the tasks that application administrators must perform to configure the position hierarchy for use in Oracle Pharma Sales Analytics.

To create a primary sales force hierarchy

1. Navigate to the Administration - Group screen > Positions view.
2. In the Positions list, click New to create the Top level Position in the Sales Force Hierarchy.
3. Complete the fields in the following table for the new position.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Division</td>
<td>Division for the primary sales force hierarchy.</td>
</tr>
<tr>
<td>Position</td>
<td>Position associated with the primary sales force hierarchy.</td>
</tr>
<tr>
<td>Position Type</td>
<td>Select the position type from the drop-down list.</td>
</tr>
</tbody>
</table>

4. For the each of the levels that are below the sales hierarchy repeat Step 2 and Step 3 down to the sales territory level position.
5 In the Parent Position field for each of these records, select the Position for the level above the current Position.

The prebuilt Oracle Pharma Sales Analytics configuration supports the following sales hierarchy levels.

Table 59. Sales Hierarchy Levels

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
<th>Cardinality to Parent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>Top level of the sales organization that is sometimes referred to as Franchise. For example, Respiratory Franchise refers to a sales force commissioned to promote respiratory products. This level does not have any parents.</td>
<td>None</td>
</tr>
<tr>
<td>Sales Force</td>
<td>Child of Organization. Refers to a sales force promoting products within a sales organization.</td>
<td>M:1</td>
</tr>
<tr>
<td>Area</td>
<td>Child of Sales Force. Refers to a large geographic sales area, such as US East, US West, or US South.</td>
<td>M:1</td>
</tr>
<tr>
<td>Region</td>
<td>Child of Area. Refers to a sales geographic region.</td>
<td>M:1</td>
</tr>
<tr>
<td>District</td>
<td>Child of Region. Refers to a sales geographic district.</td>
<td>M:1</td>
</tr>
<tr>
<td>Territory</td>
<td>Child of District. Refers to a sales geographic territory composed of ZIP codes, bricks, contacts, or accounts.</td>
<td>M:1</td>
</tr>
</tbody>
</table>

All of these levels must be created as positions and linked to a position hierarchy to populate correctly the Oracle Business Analytics Warehouse.

6 The bottom territory level position in the hierarchy must be the position associated with the assignment rule definition for the sales territory alignment, as described in “Creating Sales Territories” on page 519.

Creating Sales Territories

Sales territory alignments are used within Oracle Pharma Sales Analytics to assign sales and Rx data to the appropriate sales territory level positions. A sales territory alignment is the relationship between each sales territory position and a set of ZIP codes, bricks or accounts, or contacts. This territory alignment relationship is created and managed as a set of assignment rules in the Administration - Assignment screens within the Siebel Pharma application.

The following procedure details the task that application administrators must perform to configure the assignment rules in Oracle Pharma Sales Analytics.

To create a new assignment rule

1 Navigate to the Administration - Assignment screen > Assignment Rules List view.

2 In the Assignment Rules list, click New to create a new assignment rule.
3 In the Objects to be Assigned field, select either Account or Contact from the Assignment Object dialog box, and click OK.

4 In the Rule Group field, select Default Rule Group from the Pick Rule dialog box, and click OK.

5 In the Activation field, enter the rule activation date.

6 In the Criteria list, click New to create a new Criteria.

7 In the Rule Criterion field, select one of the assignment criteria from the following table.

   **NOTE:** A territory can have one or more criteria defined for it, depending upon the territory alignment requirements (for example, you can assign both account ZIP code and contact ZIP code to the same territory).

<table>
<thead>
<tr>
<th>Assignment Criteria</th>
<th>Assignment Type</th>
<th>Description</th>
<th>Cardinality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account ZIP Code</td>
<td>ZIP Code</td>
<td>Assigns an account ZIP code or group of ZIP codes to a sales territory.</td>
<td>M:M</td>
</tr>
<tr>
<td>Contact ZIP Code</td>
<td>ZIP Code</td>
<td>Assigns a contact primary address ZIP code or group of primary address ZIP codes to a sales territory.</td>
<td>M:M</td>
</tr>
<tr>
<td>Account Brick</td>
<td>Brick</td>
<td>Assigns an account brick or group of bricks to a sales territory.</td>
<td>M:M</td>
</tr>
<tr>
<td>Contact Brick</td>
<td>Brick</td>
<td>Assigns a contact primary brick or group of bricks to a sales territory.</td>
<td>M:M</td>
</tr>
<tr>
<td>Account</td>
<td>Account</td>
<td>Assigns an account name or groups of contacts to a sales territory.</td>
<td>M:M</td>
</tr>
<tr>
<td>Contact</td>
<td>Contact</td>
<td>Assigns a contact name or group of contact names to a sales territory.</td>
<td>M:M</td>
</tr>
</tbody>
</table>

8 In the Comparison Method field, select Compare to Object.

9 For each assignment criterion entered, click New, and add the appropriate records for the criteria within the given territory.

   For example, for an account ZIP code criteria create a new record for each ZIP code range, and enter values in the ZIP Code Low and ZIP Code High fields.

10 Click the Position Candidate detail view tab.

11 In the Position Candidates list, click New, and select the appropriate position for the given territory.

12 Repeat the process for each sales territory that must be defined.
Creating Alternate Sales Force Hierarchies

Oracle Pharma Sales Analytics supports the ability to analyze Rx script data and compare it with alternate sales force organizational structures. These alternate sales force hierarchies can support co-marketing sales organizations where Rx scripts might be 100% allocated to both sales forces, as well as Mirror Sales Forces where Rx Script allocation may be shared between the Sales Forces.

You can assign scripts to each alternate sales representative by:

- Using a report or metadata calculation based on the attribute of the W_POSITION_D dimension table
- Creating a new set of aggregation tables to de-duplicate scripts

The alternate sales force hierarchies are configured as an additional set of positions and alignment rules within the Siebel Pharma application. This topic details the tasks that application administrators perform to configure these positions and alignment rules.

**NOTE:** The allocation of Rx scripts to alternate sales force positions uses an allocation percentage that is stored in the S_POSTN.OWNER_ALLOC_PCT column in the Siebel Pharma transactional database. This database column is not exposed in the standard Siebel Pharma Application. To complete the steps for creating the alternate sales force hierarchies, add the OWNER_ALLOC_PCT column to the position business component, and expose it in the Position List Applet using Siebel Tools.

To create an alternate sales force hierarchy

1. Navigate to the Administration - Group screen > Positions view.
2. In the Positions list, click New to create the top-level position in the sales force hierarchy.
3. Complete the fields in the following table for the new position.

<table>
<thead>
<tr>
<th>Field</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Division</td>
<td>Division for the alternate sales force hierarchy.</td>
</tr>
<tr>
<td>Position</td>
<td>Position associated with the alternate sales force hierarchy.</td>
</tr>
<tr>
<td>Position</td>
<td>Select the position type from the drop-down list.</td>
</tr>
<tr>
<td>Type</td>
<td></td>
</tr>
</tbody>
</table>

4. For each of the levels below the Sales Hierarchy, repeat Step 2 and Step 3 down to the Sales Territory level position.
5 In the Parent Position field for each of these records, select the Position for the level above the current Position.

The prebuilt Oracle Pharma Sales Analytics configuration supports the following sales hierarchy levels.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
<th>Cardinality to Parent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>The top level of the sales organization that is sometimes referred to as Franchise. For example, Respiratory Franchise refers to a sales force commissioned to promote respiratory products. This level does not have any parents.</td>
<td>None</td>
</tr>
<tr>
<td>Sales Force</td>
<td>Child of Organization. Refers to a sales forces promoting products within a sales organization.</td>
<td>M:1</td>
</tr>
<tr>
<td>Area</td>
<td>Child of Sales Force. Refers to a large geographic sales area, such as US East, US West, or US South.</td>
<td>M:1</td>
</tr>
<tr>
<td>Region</td>
<td>Child of Area. Refers to a sales geographic region.</td>
<td>M:1</td>
</tr>
<tr>
<td>District</td>
<td>Child of Region. Refers to a sales geographic district.</td>
<td>M:1</td>
</tr>
<tr>
<td>Territory</td>
<td>Child of District. Refers to a sales geographic territory composed of ZIP codes, bricks, contacts, or accounts.</td>
<td>M:1</td>
</tr>
</tbody>
</table>

6 Create all levels for the sales hierarchy as positions, and link them to a position hierarchy to populate the Oracle Business Analytics Warehouse correctly.

7 For the territory level position in this new alternate hierarchy, set the Position Type field to either mirror, swat, or job share as appropriate for the alternate sales force.

**NOTE:** Select these position types for the territory level positions in the alternate sales force.

8 In the new Owner Allocation field that has been exposed in the Position List Applet, enter the percentage allocation of scripts as a decimal for the alternate territory level position.

The Pharma Sales Analytics ETL populates the value from the Owner Allocation Percentage field to a column in the Position Dimension that can then be used to calculate measures and aggregates for Rx script allocations.

9 After the alternate sales force positions and hierarchy have been created, you must create an additional alignment rule for the alternate sales territory as an assignment rule.

For more information about creating these additional Assignment Rules, see “Creating Sales Territories” on page 519.

**NOTE:** The alternate sales force territory level position must be selected as the candidate position for these assignment rules.
Creating Target Lists Using Oracle Business Intelligence

Target List Creator enables the automatic import of customer lists derived from an Oracle BI query into Siebel List Management. This functionality is enabled through the Oracle Business Intelligence Presentation Services and can be used from Oracle BI Interactive Dashboards or Oracle BI Answers integrated with the Siebel Enterprise application.

**NOTE:** This functionality is certified and tested with the Siebel Pharma Mobile Web Client and Oracle Pharma Sales Disconnected Analytics application, as well as the Siebel Pharma Connected Client and Oracle Pharma Sales Analytics application.

This topic describes the following:

- “About Target List Creator” on page 523
- “Creating a Siebel Target List Using Oracle Pharma Sales Disconnected Analytics Answers” on page 525
- “Configuring Oracle Pharma Sales Disconnected Analytics Integration with Siebel Pharma Mobile Web Client” on page 526
- “Using Target List Creator with Siebel Pharma Applications in Connected Mode” on page 527

About Target List Creator

The following topics outline the components and functionality of the target list creator:

Components

The following components support the Target List Creator functionality:

- **Create Target List view.** Oracle Business Intelligence Presentation Services includes a report view called Create Target List that displays a link used to initiate a business service in the Siebel Pharma application.

- **LS Analytics Target Service business service.** The Siebel Pharma application includes a business service called LS Analytics Target Service that provides the data integration capability.

When Target List Creator is used in an offline mode, Oracle BI Disconnected Analytics Client and Oracle Pharma Sales Disconnected Analytics application need to be installed and configured along with the Siebel Pharma mobile web client and application.

When Target List Creator is used in connected mode, both the Oracle BI Presentation Services and Siebel Web Engine (SWE) must reside on the same machine so that the Create Target List link can be used within an Oracle BI report. The Oracle BI Open Intelligence Interface also needs to be installed and configured on the Siebel Pharma application server to enable connectivity between the Siebel Pharma business service and the Oracle BI Server. For more information, see *Siebel Analytics Installation and Configuration Guide*. 
Functional Overview and Process
The following outlines the functionality and general process steps of the Target List Creator components:

1. When a user clicks the Create Target List link in an Oracle BI Interactive Dashboard report, a JavaScript function prompts the user to enter a name for the new list. The function then passes this name and the logical SQL for the Oracle BI Query through the Siebel Pharma application's SWE to the LS Analytics Target Service business service.

2. The LS Analytics Target Service business service:
   a. Verifies that the field representing the row Id of the target object is the first column selected in the query. For example, if you create a target list for Contacts, then in the default configuration the Contacts.ROW_ID column must be the first column in the query.
   b. The Oracle BI presentation columns that represent the Row Id values are configured in user properties for the LS Analytics Target Service business service. The Account Row Id Fields user property maps to the Oracle BI presentation column for the Siebel Account Row Id. The Contact Row Id Fields user property maps to the Oracle BI presentation column for the Siebel Contact Row Id. If the Oracle BI presentation columns used to store the Row Id values differ from the default configuration, then the column mappings for the user properties can be changed through Siebel Tools.
   c. Then a new target list header record is created in the Siebel Pharma application's database. The List Name is set to the Name entered by the user in the Oracle Business Intelligence dialog box and passed from Oracle Business Intelligence to SWE.
   d. The LS Analytics Target Service business service then uses the Oracle BI ODBC DSN (OpenDataBase Connectivity Data Source Name) name defined in the Siebel Pharma application's AnalyticsDataSrc to connect back to the Oracle BI server.
   e. The business service executes the logical SQL passed from Oracle Business Intelligence, iterates through the results, and creates a new List Item for each record.
   f. The validate targets user property on the business service can be turned on to provide additional validation by ensuring that the record in Oracle Business Intelligence already exists in the user's local Siebel database. Possible values for the user property are N or Y. The default value is N.

**NOTE:** The business component used for the contact target items is List Mgmt List Member, while the business component used for account list items is SLM List Member - Account. Both of these business components must be present in the List Mgmt business object.

3. After the list is created, the application automatically navigates to the view set in the Business Service's Redirect View User Property. This view must be associated with the List Mgmt Business Object and must have the List Mgmt Lists Business Component as its primary business component. The default view is My List Mgmt Lists View.
Creating a Siebel Target List Using Oracle Pharma Sales Disconnected Analytics Answers

The Target List Creator functionality supports offline usage with Oracle Pharma Sales Disconnected Analytics. This topic details what you must do to create a target list and import it into list management from Oracle Pharma Sales Disconnected Analytics Answers, which is accessed from within the Siebel Pharma Mobile Web Client.

To be able to perform this task, make sure that:

- The integration between the Siebel Pharma Mobile Web Client and Oracle Pharma Sales Disconnected Analytics is set up correctly
- The Oracle Business Intelligence Disconnected Client is running
- The local data set for Pharma Sales Disconnected Analytics is synchronized

**To create a target list and import into list management**

1. In the Siebel Pharma Mobile Web Client, navigate to the Answers > Answers screen.
2. Select Pharma Promotional Effectiveness from the list of Subject Areas.
3. Create a query that contains ROW_ID in the first column. For example, select the following columns:
   a. From the Contacts folder: ROW_ID, Full Name.
   b. From the Contacts - Contact Profile folder: Market Potential, Primary Specialty.
4. Filter the contacts on the Market Potential and Primary Specialty columns as appropriate.
   
   **NOTE:** ROW_ID is mapped to the INTEGRATION_ID column in the underlying Data Warehouse dimension table. This column stores the value of the Siebel Pharma application’s Row Id for the Contact. This is a required field and must be the first field in the query. No other field is required to make the Create Target List work.
5. Click the Results tab to list all the contacts who meet the criteria.
6. From the Add View drop-down list, select Create Target List to add the Create Target list view to the report.
7. Save the report with the added Create Target List view.
8. While still in the Results screen, click the Create Target List to invoke a dialog box prompting for the name of the new Target list.
9 Enter a name for using this Target List in the Siebel Pharma Application, and click OK.

The Target List is created, and the application navigates to the Siebel Pharma Application's List Management screen to display the new Target List.

The new Target list can now be applied in multiple views within the Siebel Pharma Application. For more information about applying target lists, see Creating and Applying Target Lists (End User) on page 107.

**NOTE:** The name of the target list must be unique. If a target list already exists with the same name, the application returns an error when the Create Target List is used. To reuse an existing name, go to List Management in the Siebel Application, and delete the list that exists with that name.

**Configuring Oracle Pharma Sales Disconnected Analytics Integration with Siebel Pharma Mobile Web Client**

To use the Target List Creator with the Siebel Pharma application in offline mode, Oracle Pharma Sales Disconnected Analytics must be integrated correctly with the Siebel Pharma Mobile Web Client. The following tasks explain how to configure and verify the integration between Oracle Pharma Sales Disconnected Analytics and Siebel Pharma Mobile Web Client.

**Install Oracle Pharma Sales Disconnected Analytics**

To install Oracle Pharma Sales Disconnected Analytics, see Siebel Analytics Installation and Configuration Guide.

**Configure the Siebel Pharma Mobile Web Client .CFG Settings**

The Target List Creator functionality requires a number of settings to be configured correctly in the Siebel Pharma Mobile Web Client .CFG file.

Make the following changes to the Siebel Pharma Mobile Web Client .CFG file (ePharma.cfg):

- In the LOCAL section, change UseExternalCachedContent to FALSE.
- In the SIEBEL section, change EnableFQDN to FALSE.
- In the Datasources section, set AnalyticsDataSrc to the name of the ODBC DSN configured for the local Oracle BI Server being used with Oracle Pharma Sales Disconnected Analytics. The default name for this ODBC DSN is AnalyticsWeb.

**Configure the Oracle Pharma Sales Disconnected Analytics OLTP Database Connection**

Oracle Pharma Sales Disconnected Analytics uses an ODBC DSN to connect to the Siebel Pharma Mobile Web Client local database and authenticate users.
To configure ODBC DSN to connect to the Siebel Pharma Mobile Web Client and authenticate users

1. Create a new ODBC System DSN called SIEBEL_OLTP of type Adaptive Server Anywhere 8.0
2. Obtain the local SQL Anywhere server name by placing the mouse over the SQL Anywhere icon on the Windows task bar when the Siebel Pharma Mobile Web Client is open.
3. Enter the local server name in the Servername field under the Database tab of the System DSN ODBC configuration window.
4. Enter the path to the local Siebel Pharma DBF file in the Database File under the Database tab of the System DSN ODBC configuration window.

Verify Oracle Pharma Sales Analytics Host and Dashboard URL Configuration

Verify that the NQSHost hostname entry in Siebel Integration Administration is set up correctly to work with the integrated Siebel Pharma Mobile Web Client.

To verify NQSHost hostname entry in Siebel Integration Administration

1. Log in to the Siebel Pharma Mobile Web Client as an Administrator.
2. Navigate to the Administration - Integration screen > WI Symbolic URL List view.
3. Search for NQHOST in the Virtual Name field, and verify that the Name field contains the localhost:9762 value.
4. Verify that the Oracle Pharma Sales Disconnected Analytics dashboard screens have the correct values in the URL fields:
   - Click the View toggle drop-down list on the Host Administration list, and choose Symbolic URL Administration.
   - Search for the records with the following Names, and make sure that each of their URL fields has http://NQHOST/Analytics/sawd.dll correctly set:
     - ePharmaHomePageAnalytics1
     - ePharmaHomePageAnalytics2
     - ePharmaHomePageAnalytics3
     - ePharmaHomePageAnalytics4
     - SISMLSDistrictManagerDashboard1
     - SISMLSSalesRepDashboard1
     - SiebelAnswers

Using Target List Creator with Siebel Pharma Applications in Connected Mode

You can also use the Target List Creator with the Siebel Pharma application and Oracle Pharma Sales Analytics in connected mode. This topic lists the tasks that you must carry out to verify the Siebel Pharma application's configuration to support using the Target List creator in connected mode:
Install and Configure the Oracle Business Open Intelligence Interface
The LS Analytics Target Service business service uses an ODBC DSN to connect back to the Oracle BI Server and execute the Oracle BI logical SQL passed into it. This ODBC DSN needs to be setup using the Oracle BI Open Intelligence Interface (ODBC) client, and requires that this client be installed on the Siebel Pharma application server. To install and configure the Oracle BI Open Intelligence Interface, see Siebel Analytics Installation and Configuration Guide.

Configuration Changes to the Siebel Application
To enable the LS Analytics Target Service Business Service to be called from the Siebel Web Engine (SWE), the Business Service name has to be present as a ClientBusinessService user property for the Siebel application being used.

To verify the LS Analytics Target Service business service
The LS Analytics Target Service business service is configured as part of the Siebel Life Sciences application.

1. In Siebel Tools, find the Siebel Life Sciences application record in the Application objects list.
2. In the Application User Prop list verify that the following entry exists:
   
   ClientBusinessService10 = LS Analytics Target Service

Configuring the Application's Server Component Parameters and Enterprise Profile
The Oracle BI Open Intelligence Interface ODBC DSN connection must be configured as a new data source profile for the Siebel Enterprise and must be associated with the Siebel Application's Object Manager configuration.

To configure a new data source profile and associate with AnalyticsDataSrc
1. Log in to the Oracle’s Siebel Application as an administrator.
2. Navigate to the Administration - Server Configuration screen > Enterprises view.
3. Click the Profile Configuration view tab.
4. Search for the AnalyticsDataSrc in the list. If it does not exist, then copy the existing ServerDataSrc record, and rename the copy to AnalyticsDataSrc.
5 Update the following parameters with the values indicated:
   
   DSDLName = sscdsacon
   DSConnectString = AnalyticsWeb
   DSTableOwner = <blank>

6 Click the Component Definitions view tab.

7 In the Component list, search for the appropriate Application's Object Manager. For example, for Siebel Pharma, search for ePharmaObjMgr_ENU.

8 With the Component selected, click the Menu button on the Component List applet, and then click Start Reconfiguration.

9 Search for OM - Named Data Source name in the Component Parameters list applet.

10 Append the current list at the end with AnalyticsDataSrc.

11 Click the Menu button on the Component List applet, and then click Commit Reconfiguration.

12 Log out of the application.

13 Log in to the server manager, and restart the component by executing the following commands:

   shutdown comp ePharmaObjMgr_enu
   startup comp ePharmaObjMgr_enu

14 Log in to the application again.

   The Create Target List functionality is enabled.
Index

A
access groups, adding to catalogs and categories 97
account call activities
Account view tab, using to manually schedule an account call 121
Activities screen, creating from 120, 209
activity type, about 112
calendar, scheduling an account call in 121
creating, about 119, 209
details about the call, entering 121
New Call button, using to add an account 121
Scheduling button, using to automatically schedule account call 120, 213
account calls
contact calls, and 103
recording 172
recording, about 172
account hierarchies
aggregated activities for an account, viewing 69
aggregated coverage team for an account hierarchy, viewing 70
aggregated list of contacts for an account, viewing 70
aggregated opportunities for an account hierarchy, viewing 70
roll-up views, about viewing 69
account hierarchies, generating
about 65
default account hierarchies, about 65
default account hierarchy, generating 65
default account hierarchy, viewing if end users are using 66
dynamic account hierarchy of selected accounts, creating 66
account team
about visibility and Contact Denormalization process 43
Account view tab
account call, using to manually schedule an account call 121
route, using to add account to 110
accounts
clinical trial, adding for 298, 322
contact, indicating an affiliation between 56
projects, about associating with 351
routes, about adding to 110
routes, adding using the Accounts view tab 110
routes, adding using the Explorer view tab 110
Accounts Contacts 206, 207
Accounts screen and views 29
accounts, administering and managing
account address, about editing 67
account hierarchies in roll-up views, about viewing 69
account hierarchies, about 62
account hierarchies, generating 65
account profile information, adding for an account 68
account, adding 67
account, deleting 64
accounts, about 67
accounts, defined 61
affiliated contact, adding new role for 72
affiliation between a contact and a subaccount, indicating 74
affiliation between account, indicating 72
affiliation between and account and a contact, indicating 71
affiliations between accounts, about indicating and upward and downward affiliations 72
aggregated activities for an account, viewing 69
aggregated coverage team for an account hierarchy, viewing 70
aggregated list of contacts for an account, viewing 70
aggregated opportunities for an account hierarchy, viewing 70
brick, associating with an existing account address 67
bricks, about and how they work 62
business and SWOT analysis, performing 202
business plan, creating for a MCO account 200
business plan, entering formulary information 201
business plans, associating contacts and...
accounts 203

category information, creating 71

competitor, specifying an account as 64

contact information, associating to plan 199

default account hierarchy, generating 65

default account hierarchy, viewing if end user are using 66

departments and contacts information, viewing 75

documentation, tracking associated with an account 76

dynamic account hierarchy of selected accounts, creating 66

formulary information, adding to an account 198

Generate Hierarchy button, about configuring 77

plan designs and formularies, about 197

plan information, adding to an account 197

pre-call information, viewing 75

process for managing accounts example 63

scenario 63

subaccounts, about and affect to data access 73

subaccounts, adding 73

subaccounts, entering detailed information for 74

upward and downward account affiliations, viewing for an account 73

Activating New Targeting Data 209

Activating the New Accounts Contacts Targeting Data 212

active inventory period 131

activities

about and activity types 112

account call, about creating an 119, 209

account call, adding an account using the New Call button 121

account call, automatically scheduling using the Schedule button 120, 213

account call, creating from the Activities screen 120, 209

account call, entering details about the call 121

account call, manually schedule an account call in the Account view tab 121

account call, scheduling an account call in the calendar 121

contact call activities, automatically scheduling using the Schedule button 118

contact call activities, creating 117

contact call activities, creating from Activities screen 117

contact call activities, manually scheduling a call using the Calls view 119

contact call activities, scheduling in the calendar 119

defined and about 103

general activity, adding 113

general activity, creating in the Calendar view 114

meeting, about setting up and list of tasks 115

meeting, adding a meeting invitee 116

meeting, adding a meeting speaker 116

meeting, creating 115

meeting, creating a meeting activity 116

meeting, updating the Cost field in the Meeting Invitees list 117

project, adding to using a project activity template 353

specialized activities, creating in Calendar view 114

task, creating and associating activities 353

Activating the New Accounts Contacts Targeting Data 212

actual inventory period 131

actual activity payments

about 331

currencies and exchange rate dates, about setting 331

standard payment amounts, setting up in the

subject visit template 333

activity template

creating for MedEd event 237

Actual Amount fields

importing data for, about 258

loading, about using EIM 258

ad hoc payments

generating for sites 335

adding

account 67

accounts to a route using Accounts view tab 110

accounts to a route using the Explorer view tab 110

accounts to a route using the Target Accounts view tab 111

attachment to an contact 58

contact to a project 352

employees to project 352

formulary information for an account 198

general activities 113

images to products 91

literature item to the application 239

lot number of product to catalog 95
meeting invitee 116
meeting speaker 116
new clinical program 288
new protocol record 289
partner account to a project 352
product comparison information 90
product to a samples transaction 149
region records for a protocol 293
sites for clinical trial 300
time off territory record 228
adding component files 460
adjustment transaction
about submitting 143
administrator tasks
list 36
Manager List Mode user property, default settings 41
My Team’s filter, about 41
adverse event and complaints management
about 357
capturing adverse events and complaints, about 360
capturing as service requests 369
codes, about 365
codes, setting up 368
codes, setting up example 367
configuring 373
confirming setup for service requests 364
escalating as product issues 371
integration with other applications 359
lot numbers, setting 369
process workflow 363
product issue, changing fields copied to 373
product issues, adding patient information to 372
scenario 362
terms defined 360
adverse event and complaints, communicating
about 447
process workflow 448
product issues, creating correspondence for 450
product issues, creating presentation for 450
product issues, creating report for 449
proposals, correspondence, and presentations, setting up 449
scenario 447
adverse events and complaints, closing
about 439
Close and Reopen buttons, configuring 444
fields, reviewing changes made to 444
Lockdown fields, reviewing 443
process workflow 441
product issues, closing 441
product issues, reopening 442
product issues, reviewing approvals for 442
scenario 440
adverse events and complaints, investigating
about 375
adverse events, completing and complaints reviews 385
Create Related PI workflow 386
Create Related PI, changing which fields are copied 387
Customizing the LS Medical Product Issue Service 389
LS Medical Product Issue Review Complete workflow 387
LS Medical User Verification workflow 388
multiple product issues, creating 383
process workflow 377
product issue activity plans, creating 384
product issue activity templates, creating 377
product issue assessment templates, creating 377
product issue, accessing if reportable 385
product issues, reviewing and editing 378
scenario 376
affiliated contact data, modifying the routing of 59
affiliations
account and a contact, indicating between 71
accounts, about indicating between 72
affiliated contact, adding new role for 72
contact and a subcontact, indicating between 74
independent accounts, about using Account Sub Account view 73
aggregated activities for an account
viewing 69
Agreements screen and views 30
Analysis screen and views 30
analysis, using
brick-level syndicated data, analyzing 222
indirect sales by brick, correlating actual calls made with 222
prescription trends by brick, correlating actual calls made with 222
receiving data extracts, postponing 221
sales, Rx, and call data, about working with 223
sales, Rx, and call data, displaying data 223
Siebel Life Sciences views available from
Analysis screen (table) 224
syndicated data extracts, importing 221

API
recording section data 509

Applying Templates 300
Applying Templates to a Site 300

approval history
tracking to CAPA records 406

approvals
configuring CAPA approvals, about 407
LS Medical PA Submit workflow 398
LS Medical PA Withdraw workflow 399

approving product analysis records 397

Assess 462
Assess Group 462
assessment template
creating 316

Assets screen and views 30
assigning tasks
contact assignments, about and example 43
Contact Denormalization mode, rules, requirements, and exceptions 43
predefined assignment objects, about and table of 42
Siebel Assignment Manager, about using 41

Assignment Item Type Industry Name
about support of 42

Assignment Manager
See Siebel Assignment Manager

assignment objects
about and table of 42
opportunity 42

attachments
adding contact to 58

attendeecalls
sample transactions, attendees recorded for an account call 132
Submit button, attendees recorded for an account call 165

Pharma, about how used in 50

prescription trends by brick, correlating actual calls made with 222

business component user properties
about 483, 506
group 1 business components (table) 484
group 2 business components (table) 485
group 3 business components (table) 486
group 4 business components (table) 488
user properties for all business components (table) 484, 494, 497, 508
visit generation button, configuring 489

business functions, screen tabs 29

business plans
business and SWOT analysis, performing 202
contacts and accounts, associating with 203
formulary information, entering 201
MCO account, creating for 200
objectives, setting 204

Business Plans screen and views 30

business services
Customizing the LS Medical Product Issue Service 389

buttons
Close and Reopen buttons, configuring 444
Generate button, workflow initiated from 436
Populate button, workflow initiated from 436
Reopen button, workflow initiated from 438
reports, configuring in 435

C
calendar
account call, scheduling in 121
contact call, scheduling in 119
general activity, creating in Calendar view 114
specialized activities, creating in Calendar view 114
using to monitor site visits 319

Calendar screen and views 30
call data
displaying data 223
working with, about 223
calling
contact, specifying best time to 54
pre-call information, viewing 56

Calls view
using to manually schedule a contact call 119
calls, planning
activities, user create scenario 105
caution, about adjusting scheduling conflicts 112
personal lists, adding product to 106
personal lists, users set up scenario 103
process of planning calls 106
route plans, users define scenario 104
route, using to schedule calls 112
routes, about adding accounts to a route 110
routes, about creating and list of tasks 108
routes, adding accounts using the Accounts view tab 110
routes, adding accounts using the Explorer view tab 110
routes, adding accounts using the Target Accounts view tab 111
target lists, creating 107
target lists, user create scenario 103
tools for planning calls, list of 102
calls, recording
account call, recording 172
account calls, about recording 172
attendees calls, creating for each attendee 165
contact calls, recording 168
contact calls, recording offer responses 167
electronic signature capture, about 165
note about decision issues discussed during the call 170
process example 167
receipt, remaking 174
samples dropped, application activity 164
scenario 166
Sign button, configuring 176
Submit button, configuring 175
Submit button, effect on views 161
Submit button, effects when clicked 164
calls, scheduling
caution, about adjusting scheduling conflicts 112
route, using to schedule calls 112
Campaigns screen and views 30
CAPAs, creating 395
CAPAs, managing
about and terms defined 401
CAPA record, creating 404
codes, setting up 404
configuring CAPA approvals, about 407
corrective action and activity templates, creating 403
record, adding information to 406
scenario 402
tracking approval history and other changes 406
workflow processes 403
capturing adverse events and complaints
about 360
capturing as service requests 369
codes, about 365
codes, setting up 368
codes, setting up example 367
configuring 373
confirming setup for service requests 364
escalating as product issues 371
lot numbers, setting 369
process workflow 363
product issue, changing fields copied to 373
product issues, adding patient information to 372
scenario 362
terms defined 360
Capturing Different Types of Addresses for Each Site 329
Capturing Different Types of Addresses for Each Site (End User) 320
case report form tracking activity
creating 344
catalogs
adding product or lot number to a catalog 95
category
creating category information for an account 71
charts
graphical charts, creating for clinical trials 312
time off territory charts, viewing 229
checklist activities, about 112
clinical contract
associating with a site 317
clinical program
adding new clinical program 288
Clinical Programs screen and views 30
clinical projects, managing
activities, defined 353
activity, adding to a project using a project activity template 353
contact, adding to a project 352
employee profiles, setting up 349
managing, about 347
partner account, adding to a project 352
people and accounts, about associating with projects 351
position types and rate lists, about setting up for billing 350
process example 348
project activity template, creating 349
project costs, about and displaying cost items 354
project costs, viewing associated with a
Index

C

project 354
Project screen views 355
project, adding employees to 352
project, creating 351
risk and resolution activities, adding to a project 354
scenario 347
task, creating and associating activities to the task 353
task, defined 353

clinical protocol site
activities, about 112
template, creating 316

clinical trial, setting up and carrying out
account, adding 298, 322
contact, adding 299
documentation tracking activities, creating 324
existing documentation, updating and adding for tracking 325, 326
graphical charts, creating 312
hierarchical relationship of programs, protocols, regions, and sites 285
new clinical program, adding 288
new protocol record, adding 289
new protocol version, creating 292
process managing clinical trials example 287
regions, adding to a protocol 293
scenario 286
site visits, creating and managing 318
site, adding 300
subject enrollment information rollup, about 310
subject visit template, adding a subject visit template 296
subject visit template, applying a new version for an enrolled subject 307
subject visit template, applying new version to a site 307
subject visit template, examples 295
subject, enrolling in study 305
subject, entering and screening 303
subject, rescreening a subject 304
subject, terminating trial early 307
team assignment history, creating 291

clinical trip reports, administering and using
about 339
case report form tracking activity, creating 344
case report form tracking activity, creating 344
case report form tracking activity, creating 344
clinical research associates scenario 340
printing or emailing 343
process example 340
scenario 339
trip report template, creating 341

Close button
configuring 444
LS Medical Product Issue Close workflow 444
close complaint workflow
process steps 444
codes
about 365
CAPA, setting up for 404
codes, setting up 368
codes, setting up example 367
product analysis, setting up for 394

company features, defining 93
competitor
specifying an account as a 64
competitor information, managing
about 93
competitor features, defining 93
competitor comparison information, entering 94
product features, defining 93

complaints, investigating
about 375
adverse events, completing and complaints reviews 385
Create Related PI workflow 386
Create Related PI, changing which fields are copied 387
Customizing the LS Medical Product Issue Service 389
LS Medical Product Issue Review Complete workflow 387
LS Medical User Verification workflow 388
multiple product issues, creating 383
process workflow 377
product issue activity plans, creating 384
product issue activity templates, creating 377
product issue assessment templates, creating 377
product issue, accessing if reportable 385
product issues, reviewing and editing 378
scenario 376

Configuration 528
Configuration Changes to the Application .CFG File 528
Configuration Changes to the Application .cfg File 528
configuring
contact data routing, modifying 59
inventory and reconciliation of samples
without lot numbers, enabling 482
MedEd classes user properties, C++ classes created for 491
sequential numbering in the Priority field, enabling 482
TargetCategory user property (table) 480
visit generation buttons, configuring 489
visit-type activities, creating 481

Configuring Call Activities 516
Configuring Data for Oracle Pharma Sales Analytics 511
Configuring Product Catalogue and Category Hierarchies 513
Configuring Product Hierarchies and Product Costs 512
Configuring Sales Objectives 515
Configuring Sales Territories for Pharma Analytics 517
Configuring Siebel Pharma Analytics 511
Configuring the Application's Server Component Parameters and Enterprise Profile 528
configuring workflows 207
contact address, about editing 53
contact assessment, creating 59
contact assignments about and example 43
contact call activities about creating 117
Activities screen, creating from 117
activity type, about 112
calendar, scheduling a contact call in 119
Call view, using to manually schedule contact call 119
Schedule button, using to automatically schedule 118
contact calls account calls, and offer responses, recording 167
recordings 168

Contact Denormalization mode rules, requirements, and exceptions 43
Contact Id, deleted, consequences of 152
contact information associating to plans 199
contact records blank last and first name, about and troubleshooting 50
merging, about 49

contacts accessing contacts 329
affiliated contact, adding new role 72
affiliation between a contact and a subaccount, indicating 74
affiliation between an account and a contact, indicating 71
aggregated list of contacts for an account, viewing 70
business plans, associating with 203
clinical trial, adding for 299
MedEd event, inviting to 249
MedEd speaker, designating as 240
project, adding 352
projects, about associating with 351
viewing all regardless of assignment method 43

contacts, managing affiliations between contact and account, about 55
attachment, adding to a contact 58
best time to call a contact, specifying 54
brick, about administering 50
brick, about how used in Pharma 50
brick, associating a contact with 51
brick, defining 51
business scenario 47
contact address, about editing 53
contact and an account, indicating an affiliation between 56
contact assessment, creating 59
contact data routing, modifying 59
contact, adding 52
contact, defined 47
contact, indicating affiliations between 55
deleting a contact 50
deleting an employee from a contact’s team 50
documentation, tracking associated with a contact 58
merging contact records, about 49
pre-call information, viewing 56
primary speciality, about 48
speciality, defining 49
speciality, specifying 49
contracts clinical contacts, associating with a site 317
site, associating with 319
corrective action, defined 401
corrective actions and preventive actions See CAPAs, managing
Corrective Actions screen and views 30
corrective activity templates creating 403
correspondence generating for MedEd event invitees 250
product issue, creating for 450
setting up 449
### Cost Allocation field
- total of values entered 244

### Cost field
- updating in the Meeting Invitees list 117

### count adjustments
- creating and submitting 143

### Create Alternate Sales Force Hierarchies 521

### Create Primary Sales Force Hierarchies 518

### Create Related PI workflow
- about 386
- Create Related PI, changing which fields are copied 387

### Create Sales Territories 519

### Creating 523
### Creating a New Targeting Period 209

### Creating Accounts Contacts Call Detail Records 213

### Creating an Accounts Contacts 121

### Creating an Accounts Contacts (JPN) 121

### Creating Sales Territories 519

### Creating Target Lists Using Oracle Business Intelligence 523

### currencies
- setting for protocols 331

### customers, communicating with
- about 447
- process workflow 448
- product issues, creating correspondence for 450
- product issues, creating presentation for 450
- product issues, creating report for 449
- proposals, correspondence, and presentations, setting up 449
- scenario 447

### Customizing the LS Medical Product Issue Service 389

### data
- original data, maintaining 443
- types of 261

### Data Loading Matrix
- about 281
- S_SYND_DATA attribute by data source (table) 283
- table 281

### data, importing
- data, types of 261
- extracting data for mobile users, about 272
- extracting data for mobile users, about full and partial data extracts 278
- extracting data for mobile users, about possible data loss 278
- extracting data for mobile users, associating nodes with rule 273
- extracting data for mobile users, creating data extraction rule 273
- extracting data for mobile users, general steps for 272
- extracting data for mobile users, performing data extraction 278
- extracting data for mobile users, setting the environment 276
- extracting data for mobile users, specifying data routed to mobile users 274
- process for importing data 262
- Siebel EIM, importing data with 262
- SQL*Loader, using to load data 270
- summary records, about and loading into S_SYND_DATA table 272
- syndicated data loading, troubleshooting 279
- syndicated data, about importing, extracting and routing 269
- syndicated data, Data Loading Matrix for 281
- syndicated data, Data Loading Matrix for (table) 281
- syndicated data, importing 284
- syndicated data, loading data in database 270
- syndicated data, S_SYND_DATA attribute by data source (table) 283
- syndicated data, steps for loading and distributing to mobile users 269
- views requiring syndicated data import (table) 279
- Visual Basic and COM, using to load data 271

### decision issues, defining
- about 94
- creating a decision issue 95
- note about recording information 170

### decompress 469

### deleting
- account 64
- contact 50
- employees from a contact’s team 50
- objective, about 256
- Smart Call, about 188

### Departments and Contacts view tab
- account departments and contacts information, viewing 75

### Disburse on Signature Capture 162

### discrepancies, tracking 154

### Document Tracking screen and views 30

### documentation
account, tracking associated with 76
contact, attaching to 58
contact, tracking associated with 58
existing documentation, updating and adding for tracking 325, 326
MedEd session, associating with 239
MedEd session, specifying literature for 248
tracking activities, creating 324
documents
milestones, tracking 323
tracking and adding at sites 324
downward affiliations
account’s upward and downward affiliations, viewing 73
list, about 72
DTE maps
exporting from the server database to an XML file 44
importing to local client from an XML file 45
dynamic account hierarchies
creating for selected accounts 66
Dynamic mode
about running Contact Denormalization in 43
E
electronic signatures
about checking 151
new disclaimer text for signature display, creating 152
receipts, generating for calls with electronic signatures 152
Signature Audit Administration, displaying 152
Signature form, last name and first name fields empty 152
emailing
trip report 343
employees
MedEd event, inviting to 249
profiles, setting up 349
project, adding to 352
projects, associating with 351
site team, assigning 320
Entering 516
Entering Call Activity Data 516
Event term, defined 232
events, investigating adverse events
about 375
adverse events, completing and complaints reviews 385
Create Related PI workflow 386
Create Related PI, changing which fields are copied 387
Customizing the LS Medical Product Issue Service 389
LS Medical Product Issue Review Complete workflow 387
LS Medical User Verification workflow 388
multiple product issues, creating 383
process workflow 377
product issue activity plans, creating 384
product issue activity templates, creating 377
product issue assessment templates, creating 377
product issue, accessing if reportable 385
product issues, reviewing and editing scenario 376
exchange dates
setting for protocol 331
expense reports
including time off territory costs 229
Expense Reports screen and views 30
Explorer view tab
using to add accounts to a route 110
exporting
DTE data maps from the server database to an XML file 44
workflow processes to local client 44
external product table, about 80
extracting data for mobile users
about 272
data extraction rule, creating 273
data loss, about possibility 278
data, specifying that is routed to 274
environment, setting 276
full and partial data extracts, about 278
general steps for 272
nodes, associating with extraction rule 273
performing (procedure) 278
F
features, new in this release 20
fields, reviewing changes 444
follow-up activities, about 113
follow-up reports, creating 425
Forecasts screen and views 31
formularies
about 197
business plan, entering information into 201
formulary information, adding to an account 198
plan information, adding to an account 197
G
general activities
activity type, about 112
adding general activities 113
Calendar view, creating in 114
Calendar view, creating specialized activity in 114
meeting, about setting up and list of tasks 115
meeting, adding a meeting invitee 116
meeting, adding a meeting speaker 116
meeting, creating 115
meeting, creating a meeting activity 116
meeting, updating Cost field in the Meeting Invitees list 117
Generate button
workflow initiated 436
Generate Hierarchy button
about configuring 77
Global Harmonization Task Force
guidelines 410

H
Hierarchies
Generate Hierarchy button, about configuring 77
product hierarchies, capturing for handheld 98
Home screen and views 31
hospitals, accessing 329

I
importing
DTE maps to a local client from an XML file 45
syndicated data extracts, postponing 221
syndicated data files, importing 221
inactive inventory period 131
initial inventory
about establishing 141
initial inventory count, about establishing 152
products, adding and submitting an initial count 142
Install and Configure 528
interface tables
in data import process 263
internal products
additional product information, specifying 90
creating 85
defining 82
images, adding 91
internal product table, about 80
product categorization settings 83
product comparison information, adding 90
product inactive, making 89
related literature, associating 90
samples and promotional items settings 84
inventory counts
adjusting and common reasons for 155
discrepancies, identifying 157
inventory period, reconciling 159
multiple quantities, adjusting with a new adjustment transaction 158
inventory periods
about and types of (table) 131
creating and submitting 157
initial inventory period, reconciling 145
inventory counts, identifying discrepancies 157
inventory period, creating and submitting 157
multiple quantities, adjusting with a new adjustment transaction 158
reconciling 159
reconciling, about and prerequisites 155
inventory reconciliation
about and the Prescription Drug Marketing Act 130
inventory periods, about and types of (table) 131
PDMA compliance and lot numbers 131
inventory tracking
initial count adjustments, creating and submitting 143
initial inventory period, reconciling 145
managing without lot numbers, about 143
tracking and reconciling without lot numbers 143
investigators, accessing 329
invitee
calls, automatically scheduling 250
MedEd session, registering 250

L
lead time
for MedEd activity defined 237
note, for MedEd activity defined 378
List Management screen and views 31
literature
MedEd session, associating with 239
MedEd session, specifying literature for 248
product, associating to 90
Literature screen and views 31
local client
exporting workflow processes to 44
Lockdown fields, reviewing 443
loss, recording sample loss 155
lot numbers
  catalog, adding to 95
  defining lot numbers 139
  defining, about 138
  inventory and reconciliation of samples
    without lot numbers, enabling 482
  lot number tracking, disabling 140
  lot number tracking, enabling for a product 100
  multiple lot numbers, about defining 140
  Prescription Drug Marketing Act (PDMA) and lot numbers 131
  setting up 369
  Siebel Samples Management, implementation options 132
Lots for Disperse Only system preference
  about setting to TRUE 141
LS Medical PA Submit workflow 398
LS Medical PA Withdraw workflow 399
LS Medical Product Issue Close workflow
  Close button process steps 444
  product issues, closing 441
LS Medical Product Issue Populate report workflow 436
LS Medical Product Issue Reopen workflow
  product issues, reopening 442
  Reopen button process steps 445
LS Medical Product Issue Review Complete workflow 387
LS Medical Product Issue RR Reopen workflow 438
LS Medical Product Issue RR Submit workflow 436
LS Medical User Verification workflow 388
LS Pharma Activity HI Calendar View, editing button labels 491

M
managed care, managing
  about 193
  business and SWOT analysis, performing 202
  business plan, creating for a MCO account 200
  business plan, entering formulary information 201
  business plans, associating contacts and accounts with 203
  business plans, setting objectives 204
  formulary information for an account, create 198
  health plan and formulary information, entering 197
  health plan information for an account, creating 197
  health plans, associating contact information to 199
  process of using 196
scenario 196
Manager List Mode user property
  default settings 41
managing 206
Managing Accounts Contacts 206
Managing Accounts Contacts in Life Sciences 205
managing PCD content 454
market, creating 85
marketing goal
  See objectives
Master MedEd plans, creating 236
materials
  specifying for MedEd session 248
MDV report
  about 410
  entering and reviewing data 421
  field mapping 432
  running 422
MedEd activity, about 112
MedEd classes user properties
  C++ classes created for 491
MedEd events, managing
  about 231
  activity plan, creating from a MedEd event 245
  aggregated activity costs, viewing for a MedEd plan 246
  call to an invitee, automatically scheduling 250
  contact or employee, inviting to a MedEd event 249
  correspondence, generating for multiple invitees 250
  event types, about 232
  invitee, registering for a MedEd session 250
  lead time for MedEd activities, defined 237
  literature item, adding to the application 239
  MedEd activities, about tracking costs 244
  MedEd activity, recording cost of 245
  MedEd attendees, about inviting and registering 249
  MedEd event, creating an activity template for 237
  MedEd events, creating 242
  MedEd literature, about administering 239
  MedEd master plan, creating 236
  MedEd plan, about establishing funds 234
  MedEd plan, creating 240
MedEd plan, steps to establish a fund and associate with plan 235
MedEd plan, verifying that a fund is available for association with 236
MedEd settings, lists of values for (table) 238
MedEd speaker, designating a contact as 240
process for managing MedEd events example 233
scenario 233
sessions, about setting up within MedEd event 246
sessions, creating for MedEd event 247
sessions, specifying literature for a MedEd session 248
sessions, specifying material for a MedEd session 248
speakers, viewing all 246
subplan, creating 241
terminology 232
MedEd screen and views 31
MedEd Team term, defined 232
MedWatch 3500A report
about 410
creating 414
entering and reviewing data 414
field mapping 426
running 422
sections of the form filled in 423
meeting
activity type, about 112
Cost field, updating in the Meeting Invitees list 117
creating a meeting 115
invitee, adding 116
meeting activity, creating a 116
New Meeting button, note about using 115
setting up, about and list of tasks 115
speaker, adding 116
Messaging Plans
accessing and delivering 467
associate to an objective 466
associate to Contact Call Offers 467
associating help 465
configuring 462
creating 460
creating and editing 461
providing access 464
releasing 464
revising 465
updating 462
working with 460
product issue report, creating 449
product issues, creating correspondence for 450
product issues, creating presentation for 450
mobile users
data, specifying that is routed to 274
environment, setting 276
extracting data, about 272
extracting data, about full and partial data extracts 278
extracting data, about possible data loss 278
extracting data, creating data extraction rule 273
extracting data, general steps for 272
extracting data, performing (procedure) 278
nodes, associating with an extraction rule 273
Smart Call, about synchronizing before using 189
syndicated data, steps for loading and distributing 269
mobile Web clients
setting up for position rollup 44
Monitor and Retrieve Case Report Forms (CRFs) 329
My Routes view
using to schedule calls 112
My Team’s Contacts view
7.0.3 version contact changes 52
My Team’s filter, behavior of 41
N
Name field drop-down list
note about sample not appearing 169
New Call button
using to add account call 121
New Meeting button
note about using 115
New Sample Drop button 170
O
objectives
Actual Amount fields, about loading using EIM 258
business scenario 254
defined 253
deleting an objective, about 256
objective, creating 255
process of objectives 254
recommended activities, adding to objective 256
recurring objectives, about creating 256
reviewing objectives 258
status of an objective, checking using charts 259
target accounts or contacts, specifying for an objective 258
teams and individuals, about defining objectives for 253

Objectives screen and views 31
Opportunities screen and views 31
opportunity assignment object 42
Oracle Business Open Intelligence Interface 528
Orders screen and views 31
Organization Analysis view using to add a contact to a project 352

P
Package Insert Delivery see PID 122
partner account adding to a project 352
patient information adding to product issues 372
payer information creating 220
payment amounts ad hoc payments, generating 335
final adjustments, making and generate payment 336
final payments for sites, generating 337
subject visit activities, setting site-specific payment amounts 334
Payment Flag about using to indicate payment subject activities 331
payment subject activities about 331
Payments screen and views 31
PCD Content 469
decompression 469
PCD content 460
adding component files 460
verifying 459
PCD Viewer 476
access 467
using 476
PDMA See Prescription Drug Marketing Act (PDMA)
peer affiliations account’s upward and downward affiliations, viewing 73
list, about 72
personal lists about 102
product, adding to a personal list 106
scenario 103
Personalized Content Delivery verifying PCD content 459
PID about 122
creating an insert 126
managing 126
marking a call as complete 183
scheduling calls for 127
viewing upcoming calls 127
plan designs about 197
formulary information to an account, adding 198
plan information, adding to an account 197
Plan term, defined 232
planner availability of messages 497
PMS about 122
enabling a product 124
marking a call as complete 183
scheduling calls 124
viewing account attachments 126
viewing account products 125
viewing all contact attachments 126
viewing upcoming calls 125
visit timeline 123
Populate button workflow initiated 436
position rollup setting up for mobile Web clients 44
position types, setting up 350
Post Market Surveillance see PMS 122
PowerPoint creating presentation for product issues 450
Pre-Call view tab account pre-call information, viewing 75
contacts pre-call information, viewing 56
Pre-Explain PMS about 122
scheduling calls 124
viewing upcoming calls 125
Prescription Drug Marketing Act (PDMA) inventory reconciliation, and 130
PDMA compliance and lot numbers 131
process issues 130
presentations setting up 449
preventative action, defined 401
price lists creating 92
product, associating with 92

**Primary Specialty**
- data, about using EIM to load 49
- field, about 48

**printing**
- trip report 343

**Priority field**
- enabling sequential numbering 482

**product analysis activity templates**
- creating 393

**product analysis, recording**
- about 391
- codes, setting up 394
- LS Medical PA Submit workflow 398
- LS Medical PA Withdraw workflow 399
- process workflow 393
- product analysis activity templates, creating 393
- product analysis records, approving/rejecting 397
- product analysis records, completing 395
- product issue, creating records from root cause, adding and corrective actions 395
- scenario 392
- submitting 396

**product catalog**
- adding access groups 97
- adding products 97
- creating 96
- creating a category 96

**product categorization settings** 83

**product category**
- adding access groups 97
- adding products 97

**product issue activity templates**
- creating 377

**product issue assessment templates**
- creating 377

**product issues**
- accessing if reportable 385
- changing fields copied to product issue 373
- Close and Reopen buttons, configuring 444
- closing 441
- correspondence, creating 450
- escalating adverse events and complaints as 371
- fields, reviewing changes made to 444
- Lockdown fields, reviewing 443
- multiple product issues, creating 383
- patient information, adding 372
- presentation, creating 450
- product analysis records, creating 394
- product issue activity plans, creating 384
- reopening 442
- report, creating 449
- reviewing and editing 378
- reviewing approvals 442

**Product Issues screen and views** 31

**products**
- samples implementation options for using Siebel Samples Management 132
- adding products to catalogs and categories 97
- creating a catalog 96
- creating a catalog category 96

**Products screen and views** 31

**products, managing**
- about 79
- additional product information, specifying 90
- catalogs, adding product or lot number to 95
- competitor information, managing 93
- decision issues, about defining 94
- decision issues, creating 95
- external product table 80
- external products, defining 81
- images, adding 91
- internal product or a market, creating 85
- internal product table 80
- internal products, defining 82
- lot number tracking, enabling 100
- price list, associating with a product 92
- price list, creating 92
- process of managing products 81
- product categorization settings 83
- product change request record, creating 99
- product comparison information, adding 90
- product features, defining 93
- product hierarchies, capturing for handheld 98
- product inactive, making 89
- product information, about 80
- product information, viewing 99
- related literature, associating 90
- samples and promotional items settings 84
- scenario 80

**Professionals screen and views** 30

**project activities, about** 113

**project activity template**
- activity, using to add to a project 353
- creating 349

**project costs, monitoring**
- about and displaying cost items 354
- costs, viewing associated with a project 354

**Project screen view** 355

**projects**
- activity, adding to project using a project
activity template 353
contact, adding 352
creating 351
employees, adding to project 352
partner account, adding to 352
people and accounts, about associating with projects 351
promotion items and samples settings 84
proposals
product issues, creating for 449
setting up 449
proprietary data, about 261
protocols
currencies and exchange rate dates, about setting 331
new protocol record, adding 289
new protocol version, creating 292
project, about associating with 351
regions, adding to 293
team assignment history, creating and revising 291
Protocols screen and views 32
Q
Quotes screen and views 32
R
rate lists, setting up 350
receipt, remaking 174
received quantities
tracking discrepancies 154
Receiving screen and views 32
reconciled inventory period 131
Recording a Contact Call for a Different Contact at Time of Signature Capture 170
Recording and Submitting Account Calls 172
recording calls
See calls, recording
records
CAPA record, adding information to 406
CAPA record, creating 404
product analysis records, approving/rejecting 397
product analysis records, completing 395
product issue, creating product analysis records from 394
Regions screen and views 32
regions, setting up
protocol, adding regions to 293
regulatory reporting
3500A and MDV reports, running 422
3500A reports, entering and reviewing data for 414
about 409
configuring buttons, about 435
Generate button, workflow initiated from 436
MDV report, field mapping for 432
MDV reports, about 410
MDV reports, entering and reviewing data for 421
MedWatch form, sections filled in 423
MedWatch report, field mapping for 426
MedWatch reports, about 410
Populate button, workflow initiated from 436
process workflow 412
regulator report numbers, generating 423
regulatory reports, about 410
regulatory reports, creating and populating 413
Reopen button, workflow initiated from 438
report numbers, setting up 412
report types 410
report, generating 424
report, reopening 424
scenario 411
supplemental, creating or follow-up reports 425
regulatory reports
See regulatory reporting
Regulatory Reports screen and views 32
rejecting product analysis records 397
release, new features 20
Reopen button
configuring 444
reopen complaint workflow process steps 445
workflow initiated 438
reopening a regulatory report 424
Rep Specialty drop-down list
about adding additional values to 49
Repairs screen and views 32
report numbers
regulatory report numbers, generating 423
report, generating 424
setting up 412
reporting
3500A and MDV reports, running 422
3500A reports, entering and reviewing data for 414
about 409
buttons, about configuring 435
Generate button, workflow initiated from 436
MDV report, field mapping for 432
MDV reports, about 410
S

S_SYND_DATA table
   about using to import syndicated data 269

sales data
   displaying data, about 223
   working with, about 223

sales goal
   See objectives

Sales Objectives 515

sales objectives
   setting up 515

Sample Event Administration, displaying 152

Sample Management
   See Siebel Samples Management

sample theft or loss, recording 155

samples
   captured signatures 151
   inventory and reconciliation of samples
      without lot numbers, enabling 482
   inventory, about active and inactive period 131
   note, sample does not appear in Name field
      drop-down list 169
   recorded for the call, application activity 164
   returns, about 146
   samples activities, monitoring 147
   Siebel Samples Management, implementation options 132

samples and promotional items settings 84

samples order, creating 153

Samples screen and views 32

samples transaction
   Add, Adjust, and Submit buttons, about enabling or disabling 138
   how it works 137
   impact on inventory counts, list of 138
   past samples transaction, about adjusting 149
   prerequisites for managing samples 137
   product, adding to samples transaction 149
   quantity, adjusting in 150

samples transfer
   creating 146
   creating, about 145
   receipt of, acknowledging 154

samples, managing
   electronic signatures, about checking 151
   electronic signatures, generating receipts for calls with 152
   initial count adjustments, creating and submitting 143
   initial inventory count, about
establishing 152
initial inventory period, reconciling 145
initial inventory, about establishing 141
inventory count, adjusting and common reasons for 155
inventory count, creating and submitting 157
inventory counts, identifying discrepancies 157
inventory period, about reconciling and prerequisites 155
inventory period, reconciling 159
inventory reconciliation, about 130
inventory tracking and reconciliation, about managing without lot numbers 143
inventory, adding products and submitting an initial count 142
inventory, tracking and reconciling without lot numbers 143
lot number tracking, disabling 140
lot numbers, about defining 138
lot numbers, about defining multiple lot numbers 140
lot numbers, defining 139
master inventory, administrator and end users establish scenario 135
master samples inventory, administrator establishes scenario 134
multiple quantities, adjusting with a new adjustment transaction 158
new disclaimer text for signature display, creating 152
prerequisites for managing samples 137
sample theft or loss, recording 155
sample transactions, about 130
samples activities, monitoring 147
samples order, creating 153
samples transaction, about adjusting a past transaction 149
samples transaction, adding a product to 149
samples transaction, adjusting a quantity in 150
samples transaction, how it works 137
samples transfer, about creating 145
samples transfer, acknowledging receipt of 154
samples transfer, creating 146
scenarios, about and list of 133
Siebel Samples Management, about working with calls 131
Signature Audit Administration, displaying 152
Signatures form, last name and first name fields empty 152
users transfer samples to one another scenario 137
Schedule button
account call, using to automatically schedule 120, 213
contact call, using to automatically schedule 118
screen tabs, business functions 29
Service Request Workflow
product issue, changing fields copied to as 373
product issue, creating from 373
service requests
capturing adverse events and complaints as 369
confirming standard setup 364
Service Requests screen and views 32
session freeze, fixing 279
Session term, defined 232
sessions, setting up within MedEd event about 246
literature, specifying for a MedEd session 248
materials, specifying for a MedEd session 248
MedEd event, creating for 247
Setting 515
Setting up 515
Setting Up Sales Objectives 515
Setting Up Targeting Data for a New Period 209
shipped quantities tracking discrepancies 154
Shipping screen and views 32
sick days
recording as time off territory 227
Siebel Assignment Manager
about 41
contact assignments, about and example 43
Contact Denormalization mode, rules, requirements, and exceptions 43
predefined assignment objects, about and table of 42
Siebel Clinical
setting up mobile Web clients for position rollup 44
Siebel EIM, using to import data
about 262
data and related interface tables 269
data and related interface tables (table) 264
import order, recommended 263
interface tables 263
Siebel Literature 454
Siebel Samples Management
calls, about working with 131
implementation options 132
Siebel Tools
visit generation buttons, configuring 489
visit-type activities, creating 481
Sign button
about 176
LS Pharma Call Signature form applet, configuring 181
signature capture, about 165
signatures
electronic signatures, checking 151
new disclaimer text for signature display, creating 152
receipts, generating for calls with electronic signatures 152
Signature Audit Administration, displaying 152
Signature form, last name and first name fields empty 152
site activity plans
creating 321
Site Management screen and views 32
site team
assigning employees 320
Site Visits screen and views, described 32
sites
ad hoc payments, generating 335
clinical trial, adding for 300
document milestones, tracking 323
documents, tracking and adding 324
final payments for sites, generating 337
payment amounts for subject visit activities, setting site-specific 334
payment amounts, making final adjustments and generating payments 336
subject visit template, applying new version to a site 307
trip report template, selecting before visit 341
sites and clinical contacts, managing
administrator and end user tasks 313
assessment template, creating 316
clinical contract, associating with a site 317
clinical protocol site template, creating 316
contracts, associating with a site 319
document milestones, tracking 323
documents, tracking and adding at sites 324
employees, assigning to the site team 320
information, process of maintaining 317
information, process of managing 315
investigators and hospitals, accessing 329
scenario 314
site activity plans, creating 321
sites visits
creating a site visit 318
creating and managing, about 318
monitoring using the calendar 319
Smart Calls screen and views 32
Smart Calls templates, about 118
Smart Calls, creating
administering Smart Call, process of 187
defined 185
deleting a Smart Call, about 188
note, about entering dates and reference numbers for samples 190
scenario 185
Smart Call information, entering as an administrator 188
Smart Call information, entering as an end user 190
Smart Call template, applying to a call 190
Smart Call template, making available to users 189
Smart Call, adding as an administrator 188
Smart Call, adding as an end user 189
SmartScript screen and views 33
Solutions screen and views 33
speakers
MedEd event speakers, viewing all 246
MedEd speaker, designating a contact as 240
meeting, adding a meeting speaker 116
SQL*Loader, using to load data 270
standalone activities, about 353
Status field
note about changing status to Submitted 119
subaccounts
about and affect to account data access 73
adding subaccounts 73
affiliation between a contact and a subaccount, indicating 74
detailed information for, entering 74
subject activities, about 112
subject activity payments, setting up and making
activity payment amounts, about 331
ad hoc payments, generating 335
currency and exchange rate dates, about setting 331
final payments for sites, generating 337
payment amounts, making final adjustments and generate payments 336
scenario 332
setting up and making payments, process of 333
standard payment amounts, setting up in the
subject visit template 333
subject activities, marking as completed 335
subject visit activities, setting site-specific
payment amounts 334

**subject visit template**
adding a subject visit template 296
examples 295
new version, applying for an enrolled
subject 307
new version, applying to a site 307
setting up standard payment amounts 333

**subjects**
enrolling in study 305
enrollment information rollup, about 310
entering and screening 303
rescreening a subject 304
subject activities, marking as completed 335
subject visit template, applying new version
for an enrolled subject 307
terminating trial early 307

**Subjects screen and views** 33

**Submit button**
Contact Call Detail or Account Call Detail view,
effects when clicked on 164
LOVs required for submit process 176
read-only fields, changing 303
requirements, changing 175
views, effect on 161

**submitting**
product analysis records 396

**Submitting Contact Details from Third-Party Applications** 491

**summary records**
about and loading into S_SYND_DATA
table 272

**supplemental reports, creating** 425

**SWOT analysis, performing** 202

**syndicated data**
about 261
Data Loading Matrix (table) 281
Data Loading Matrix, about 281
Data Loading Matrix, S_SYND_DATA attribute
by data source (table) 283
importing syndicated data files 284
importing, extracting, and routing, about 269
loading data into database 270
mobile users, steps for loading and
distributing 269
SQL*Loader, using to load data 270
troubleshooting loading 279
views requiring syndicated data import
(table) 279
Visual Basic and COM, using to load data 271

**syndicated data extracts**
receiving data extracts, postponing 221

**syndicated data, analyzing**
about 219
brick, displaying all contacts associated
with 222
files, importing 221
indirect sales by brick, correlating actual calls
made with 222
payer, defining and plan information 220
prescription trends by brick, correlating actual
calls made with 222
process of analysis example 220
sales, Rx, and call data, about working
with 223
sales, Rx, and call data, displaying data 223
scenario 219
Siebel Life Sciences views available from
Analysis screen (table) 224

**system preferences**
note about setting 133

**T**

**Tansactional Data Requirements** 511

**target accounts**
routes, adding using the Target Accounts view
tab 111

**target accounts or contacts**
specifying for an objective 258

**Target Accounts view tab**
route, using to add account to 111

**Target List**
create using Oracle Business
Intelligence 523

**target lists**
creating 107
scenario 103
targeting, about 102

**TargetCategory user property** 480

**tasks**
creating and associating activities to the
task 353
defined 353

**templates**
assessment template, creating 316
clinical protocol site template, creating 316
corrective action activity templates,
creating 403
MedEd event, creating activity template
for 237
note, making Smart Call template available to
users 189
product analysis activity templates,
creating 393
product issue activity templates, creating 377
product issue assessment templates, creating 377
project activity template, creating 349
project activity template, using to add an activity to a project 353
site activity plans, creating 321
Smart Call template, about 118
Smart Call template, applying to a call 190
subject visit template, adding 296
subject visit template, applying new version for an enrolled subject 307
subject visit template, applying new version to a site 307
subject visit template, examples 295
subject visit template, setting up standard payment amounts 333
trip report template, creating 341
trip report template, printing or emailing 343
trip report template, selecting before site visit 341
termination, fixing 279
Territory Management 206
theft, recording sample theft 155
Time off territory activity, about 112
Time Off Territory screen and views 33
time off territory, tracking about 227
completed time off territory record, submitting 229
configuring 230
process tracking time off territory example 228
scenario 227
time off territory charts, viewing 229
time off territory record, adding 228
Time Sheets screen and views 33
To 214
To create a new assignment rule 519
To create Contact Call Details for a new Contact 214
To plan a call in the Weekly Call Planning screen 215
To set up accounts contacts period 209, 215
TOT by Creator chart display described 229
TOT by Reason chart display described 229
Tracking Case Report Forms (CRFs) 329
Transactional Data Requirements 511
trip report template creating 341
printing or emailing 343
site visit, selecting before 341

trip reports
administering and using, about 339
approving 345
case report form tracking activity, creating 344
clinical research associates scenario 340
completing a trip report 343
distributing and archiving 345
printing or emailing 343
process example 340
scenario 339
trip report template, creating 341
trip report template, selecting before site visit 341
troubleshooting
loading syndicated data 279

U
upward affiliations
account’s upward and downward affiliations, viewing 73
list, about 72
using 476
Using Target List Creator with Siebel Pharma Applications in Connected Mode 527

V
vacation
recording as time off territory 227

version 7.7
rev B, new features 20
visit generation buttons, configuring 489
Visual Basic and COM
using to load data 271

W
Word
product issue report, creating 449
product issues, creating correspondence for 450
product issues, creating presentation for 450
workflow processes, exporting to local client 44
workflows
Close Complaint workflow 444
Create Related PI workflow, about 386
Create Related PI workflow, changing which fields are copied 387
LS Medical PA Submit workflow 398
LS Medical PA Withdraw workflow 399
LS Medical Product Issue Populate
Index

Report  436
LS Medical Product Issue Review Complete workflow  387
LS Medical Product Issue RR Reopen workflow  438
LS Medical Product Issue RR Submit workflow  436
LS Medical User Verification workflow  388
Reopen Complaint workflow  445
Service Request workflow, changing fields copied to product issue  373
Service Request workflow, creating product issue from  373

X

XML file
DTE maps, exporting from the server database to an XML file  44
DTE maps, importing from a local client  45